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SoftMax Pro License Agreement and Warranty 
Important: Please read this license agreement carefully before opening this package. The right to use 
this Molecular Devices Corporation ("MDC") software is sold only on the condition that the user 
agrees to the terms of this license agreement. If you do not agree to the terms of this license, you may 
return the unopened package to MDC or its authorized agent for a full refund. However, opening 
this package indicates your acceptance of these terms and conditions. 

License Agreement 
In consideration of payment of the license fee, which is part of the purchase price you paid for this 
product, Molecular Devices Corporation ("MDC"), the licensor, hereby grants a non-exclusive license 
to you the Licensee ("User"), to use SoftMax Pro and its utilities ("Software") included with SoftMax 
Pro upon license. The user is licensed to copy the software for a backup or archival copy as necessary. 
Simultaneous use of the software with more than one MDC Microplate Reader system per license 

is expressly prohibited. Simultaneous use of the software on three (3) computers solely for the 
purpose of analyzing already acquired data, is expressly permitted. This copy can only be installed 
on a total of four (4) computers, unless SoftMax Pro Enterprise edition is purchased.  If you have 
purchased SoftMax Pro Enterprise edition, you may install and use the software on one (1) computer 
for each Enterprise edition license you have purchased.  The user is expressly prohibited from using 
thesoftware to control any other instrument, computing hardware, or peripherals other than MDC's 
Microplate Reader systems. 

This license agreement does not grant the user title to the software, or any copyrights of proprietary 
rights in the software. The user may not sublicense, rent, lease, modify, translate, decompile, or 
disassemble the software for any purpose. The user, however, does own the media on which the 
software is originally or subsequently recorded or fixed. MDC retains title and ownership of the 
software recorded on the original disc and all subsequent copies of the software, regardless of the 
form or media in or on which the original and other copies may exist. This license is not a sale of the 
original software or any copy. 

LIMITED WARRANTY 
MDC warrants that the disc on which the program is furnished is free of defects in materials and 
workmanship and will operate under normal use for a period of 90 days from the date of delivery. 
Except as provided above, the Software is provided "as is" without additional warranties of any kind, 
either express or implied, including, but not limited to any implied warranty of merchantability or 
fitness for a particular purpose. The entire risk as to the quality and performance of the Software is 
the User's. MDC does not warrant that the functions contained in the Software will meet the User's 
requirements nor that the operation of the program will be uninterrupted or error free. Some states 
do not allow the exclusion of implied warranties and, therefore, the above exclusion may not apply to 
you. 
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LIMITATION OF REMEDIES 
MDC's entire liability and the User's only remedy with respect to the Limited Warranty set forth 
above is: 

1. The replacement of any discs not meeting the Limited Warranty set forth above, provided such 
discs are returned to MDC with evidence of date of purchase; or 

2. If MDC is unable to deliver a replacement disc which is free of defects in materials and 
workmanship, the user may terminate this license agreement upon return of all materials 
including manual and disc(s) to MDC for a full refund of purchase price. 

In no event will MDC be liable to the user for any damages, including any lost profits, lost savings, or 
other incidental or consequential damages arising out of the use or inability to use the software even 
if MDC has been advised of the possibility of such damages, or for any claim by another party. Some 
states do not allow the limitation or exclusion of liability for incidental or consequential damages so 
the above limitations or exclusions may not apply to you. 

Duration and Termination 
The License is effective from the date of the first use of the Software by the User until terminated or 
until the expiration of fifty years, whichever occurs first. The User may terminate the License by 
returning to MDC all Software documentation, the original Software, all backup and archival copies 
of the Software, and all demonstration copies of the Software. The License agreement will terminate 
automatically without notice from MDC if the User fails to comply with any provision of this License 
Agreement. It is incumbent upon the User to take all reasonable measures to effect termination only 
in accordance with this License Agreement. 

General 
1. This License Agreement shall be governed by the laws of the State of California. 

2. The provisions of this License Agreement are severable and if any one or more of such provisions 
are judicially determined to be illegal or otherwise unenforceable whether in whole or in part, 
those remaining provisions or portions of the License Agreement unaffected by such 
determination shall be binding on and enforceable by and between the User and MDC. 

3. In the event it becomes necessary to retain the services of an attorney to enforce any provisions of 
this License Agreement, the non-prevailing party to such legal action and/or litigation agrees to 
pay the prevailing party's costs, including reasonable attorney's fees and court costs, if any. 

4. The User acknowledges that by opening the media package, the User has read this License 
Agreement, understands it, and agrees to be bound by its terms and conditions. 

5. To the extent this License Agreement includes any additional or different terms from those 
provided in any other document or agreement provided with this SoftMax Pro, the terms of this 
License Agreement shall control. 

The User further agrees that this License Agreement constitutes the full and complete agreement 
between the User and MDC with respect to the Software and the License, which agreement 
supersedes any proposal or prior agreement, whether oral or written, and any other communication 
between the User and MDC relating to this License Agreement. 
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Introduction 
SoftMax Pro is designed to control and collect data from Molecular Devices' microplate readers 
(EMax™, VMax®, UVMax™, ThermoMax™, and VersaMax™), microplate spectrophotometers 
(SpectraMax®), microplate spectrofluorometers (Gemini fluorescence readers and FlexStation 
instruments), and microplate multi-detection instruments (SpectraMax M2 and M5). 

SoftMax Pro allows you to acquire and analyze data from these instruments. You may also import 
data from FLIPR and Analyst instruments for display and analysis. 

SoftMax Pro is available for Power Macintosh computers using OS 9.2 or greater and PC-compatible 
computers using Windows 2000 and XP. 

Major Functions of SoftMax Pro 
 Instrument Control  

SoftMax Pro allows you to set up and run a complete assay for all instruments. Instrument 
settings can be saved as a protocol file and used repeatedly for reading different microplates or 
cuvettes. All stand-alone instrument functions can be controlled using the software. In addition, 
SoftMax Pro provides capabilities that are not available when using an instrument in stand-
alone mode (for example, user-defined Kinetic run times, read intervals, Automix parameters, 
and more). 

 Data Collection and Display  
SoftMax Pro collects and stores all raw data received from the instrument. Data is displayed on 
the computer screen in a grid format that corresponds to the wells in a microplate (all 
instruments) or individual cuvettes (using SpectraMax Plus, Plus384, M2, or M5). How the data is 
displayed depends on other settings made using the software. In addition to displaying data 
collected from a Molecular Devices microplate system instrument, you may import, display, and 
analyze data collected from either a FLIPR® or Analyst instrument. 

 Data Reduction and Plotting  
You can reduce the data using built-in formulas or define custom reduction formulas. More than 
one reduction can be shown, and results from different microplates and/or cuvettes can be 
compared within the same experiment. 

SoftMax Pro can collect data from one or more microplates and/or cuvettes and store it in a single 
data file, using the same or different instrument settings for different microplates or cuvettes. For 
example, microplates containing different samples can be read using the same or different modes, all 
within the same experiment. 

Read Modes 
Several read modes are possible using SoftMax Pro. Which read modes are available depend upon 
which instrument you are using. 

 Endpoint 
A single reading is made at one or more wavelengths (up to six separate wavelengths can be 
chosen using SpectraMax instruments). Default values reported are optical density (OD), 
relative fluorescence units (RFU), or relative luminescence units (RLU), depending on the 
instrument type and options selected. 

 Kinetic 
Data is collected over time and the default display is OD, RFU, or RLU versus time. Multiple 



Chapter 1: Welcome  

4 SoftMax Pro User’s Manual 

readings are made at regular intervals which you define. Default data reductions for Kinetic 
data are Vmax, Vmax per Sec, Time to Vmax, or Onset Time. 

 Spectrum 
Absorbance or fluorescence data is collected across a spectrum of wavelengths and displayed as 
OD, RFU, or RLU versus wavelength. The default reduction displays the wavelength that 
corresponds to the maximum signal. 

 Well Scan 
Fluorescence data is collected from a single well in a microplate using one of several scan 
patterns up to a maximum number of points. Data is displayed in grayscale by default; readings 
from multiple wavelength pairs may be shown separately or together in different colors. 

 FLEX 
Fluorescence data is collected from a single well in a microplate over time. Readings from 
multiple wavelength pairs can be shown separately or together in different colors. 

 Dual Read: 
Also an endpoint reading, this mode is designed to perform two separate integrations, one after 
each of two possible injections in any or all wells of a microplate. 

 Fast Kinetic: 
Repeated integrations are made for a specified number of data points, up to a 100-point 
maximum integration, in a single well of a 96- or 384-well microplate.  This process is then 
repeated for each of the rest of the selected wells. 

New to SoftMax Pro? 
If you have not used SoftMax Pro before, Molecular Devices recommends that you install the 
software and then follow the tutorials that will guide you through the basics of using SoftMax Pro. 
Sample files which demonstrate the advanced capabilities of SoftMax Pro are explained in Chapter 5 
of the SoftMax Pro Formula Reference Guide (and in the help files accompanying that software). 
 

What's New in SoftMax Pro 4.8 

New Reader Support 
 SoftMax Pro v4.8 is required to operate the new SpectraMax® M5 reader and its five read types: 

Fluorescence, Absorbance, Luminescence, Time-Resolved Fluorescence (TRF) and Fluorescence 
Polarization. Three data types for FP read types are also being introduced with v4.8: the 
calculation of Polarization (mP), Anisotropy (r) and Raw (S&P).  

Modifications 
 A Plate Type Editor has been added for some readers. Accessible from the “Plate/Edit Plate 

Type…” menu item, this feature allows users to modify five primary microplate measurements 
(the distance from the left edge of the plate to the center of well A1, the distance from the top 
edge of the plate to the center of well A1, the horizontal distance between wells, the vertical 
distance between wells and the well diameter), and to save these custom plate types. More 
details can be found in Chapter 5 of the SoftMax Pro User Manual. 

 Modification of Plate Blank subtraction for FP: the plate blank subtraction will be done on the 
uncalculated raw perpendicular (S) & parallel (P) fluorescence polarization data, respectively. 
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 File/Set Password menu item has been changed to support the notation of both the Author 
Name and Password to allow users of SoftMax Pro Standard edition to protect any single 
experiment file. 

 SpeedRead and Column/Wavelength Priority options have been added for Kinetic read mode 
for SpectraMax® Plus 384 users. 

 The Formula textbox limit in the Calculation dialog has been increased from 200 to 255 
characters. 

 A Settling Time option has been added. Users can enable/disable the Settling Time option and, if 
enabled, specify the duration of settling between 100 and 1000 milliseconds.  In FP read mode, 
the settling time specify the well-to-well delay for FP read type, and column-to-column delay for 
all other read types.  

Enterprise Edition Changes 
 The saved file path recorded in the Audit Trail has been corrected and no longer truncates.  

 Save As… no longer allows users to modify a protocol. 

 Selected Statement sections now print properly (some did not print in specific cases previously). 

Fixed Bugs 
 Highlighted summary lines now properly appear on the printed copy. 

 Crashing bug has been fixed whereby expanding a Cuvette section when the plate template 
includes a 384-well specific group previously caused a crash. 

 Pasting data into Cuvette section no longer erases the current Template setting. 

 Exporting “All” Group sections now properly includes the Note section delimiter (~End), which 
also facilitates proper re-importing of Note section(s) back into SoftMax Pro software. 

 The default kinetic interval can no longer be less than the minimum kinetic interval.  

 SpectraMax M2 – Instrument Settings | fluorescence read | Spectrum.  A range check was added 
to the Excitation text box to now accept only valid numbers. 

 SpectraMax M2 – Instrument Settings | Column Wavelength Priority now allows the user to 
properly select either Column Priority or Wavelength Priority for multi-wavelength reads.  

 SpectraMax M2 – The Step text box in Spectrum read mode now checks for a valid Step value 
within the limits of the scan (i.e., if 350-370, step values can be between 1-20; no greater than a 
max of 490.) 

 LMax™ II & LMax™ II 384 – Instrument settings | Wells to Read.  The option text now properly 
updates when well selection changes. 

 LMax II & LMax II 384 – Plate section now displays the correct reader information after a read is 
completed. 

 LMax II – now displays the correct error message for the Integration Time value. 

 LMax II – users are no longer able to open the drawer when washing or priming is in progress. 

 SpectraMax Plus 384 – SpeedRead is now functioning properly. 

 FlexStation™ II and FlexStation™ II 384 – the Cutoff Filter manual setting value no longer 
decrements in its menu window from the previously selected value in Wavelength Setup menu. 
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 All Gemini readers – the Step text box in Spectrum read mode now checks for a valid Step value 
within the limits of the scan (i.e. if 350-370, step values can be between 1-20). 

 Gemini EM – PMT info has been added to the plate section. 

New Protocols 
 M5 Assays folder: LDL Determination 

This protocol is used to determine the Lower Detection Limit from a dilution series or 
calibration curve of a fluorophore read in fluorescence intensity; to be used with M5 or other 
SpectraMax fluorescence readers. 

 M5 Assays folder: Basic FP 
This fluorescence polarization protocol allows subtraction of average raw background signals 
from eight (8) matched sample wells before mP is calculated; to be used with SpectraMax M5 
only. 

 M5 Assays folder: FPIA 
This fluorescence polarization protocol is used to set up a calibration curve and assign groups 
needed to determine binding in a Fluorescence Polarization (FP)-based immunoassay (e.g., 
TKXtra); to be used with SpectraMax M5 only. 

 M5 Assays folder: G Factor Determination 
This protocol is used to determine the correct "G factor" for a given fluorophore for fluorescence 
polarization (FP) assays; to be used with SpectraMax M5 only. 

 M5 Assays folder: HTRF 
This time-resolved FRET protocol performs two TRF readings on a plate, then calculates the 
ratio of donor and acceptor signals and performs CISbio International’s patented deltaF% 
calculations for controls; to be used with SpectraMax M5 only. 

  ADME folder: MultiScreen PAMPA 
The Parallel Artificial Membrane Permeability Assay (PAMPA) determines the rate at which a 
compound in an aqueous solution passes from the donor compartment to the acceptor 
compartment through a chemically treated filter membrane. 

Modified Protocols 
 Basic Protocol folder: All Kinetic ODs for Export 

Missing columns were added back to the RowA Group Section. 

 LAL Kinetic Chromogenic folder: Routine Testing simple 
This protocol is now is properly set as Kinetic read type. 

 LAL Kinetic Chromogenic folder: Routine Testing complete 
This protocol is now is properly set as Kinetic read type. 

New Formula Accessors 
 !StdDevPlateBlank – returns the standard deviation value of the plate blank group. 

 !StdDevPlateBlankLmX – specifies the wavelength LmX (i.e., Lm1, Lm2) of the plate blank group. 

 !WellLmXSRaw (i.e., !WellLm1SRaw) – returns perpendicular polarized data of specific 
wavelength LmX (i.e., Lm1 or 1st wavelength set) for a given Template group. (in Group 
Section) 
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 !WellLmXPRaw (i.e., !WellLm2PRaw) – returns parallel polarized data of specific wavelength 
LmX (i.e., Lm2 or 2nd wavelength set) for a given Template group. (in Group Section)  

 !WellIDLmXSRaw (i.e., !A2Lm1SRaw) – returns perpendicular (or an array of perpendicular) 
data for the specified wavelength LmX (i.e., Lm1 or 1st wavelength set) in the specified WellID 
(i.e., A2). 

 !WellIDLmXPRaw (i.e., !B1Lm2PRaw) – returns parallel (or an array of parallel) for the specified 
and wavelength LmX (i.e., Lm2 or 2nd wavelength set) in the specified WellID (i.e., B1). 

 !Gfactor – returns the current G factor value set in the Display dialog. 

 !PlateBlankS and !PlateBlankLmXS (i.e., !PlateBlankLm1S) – returns perpendicular (or S) plate 
blank raw value(s) for the given wavelength LmX in a plate section (i.e., Lm2 or 2nd wavelength 
set). 

 !PlateBlankP and !PlateBlankLmXP (i.e., !PlateBlankLm1P) – returns parallel (or P) plate blank 
raw value(s) for the given wavelength LmX in a plate section (i.e., Lm1 or 1st wavelength set). 

About the Documentation and the Help Files 
The SoftMax Pro printed documentation set consists of the SoftMax Pro User Manual (that includes 
written tutorials) and a Formula Reference Guide. Additional documents on CD-ROM may also be 
provided to cover the latest information regarding the software.  

� NOTE: Screens represented in the help system and the manuals may depict either the Macintosh or the 
Windows version of the software. The two interfaces are quite similar, but show subtle differences. 
Depending upon which computer platform and operating system you are using, your screen may look 
different from the one shown. 

This Manual 
 Chapter 1, "Welcome" provides introductory information regarding the program and its features. 
 Chapter 2, "Installation," describes how to install SoftMax Pro on your computer and how to 

connect the computer and the instrument correctly. 
 Chapter 3, "Overview," explains how the SoftMax Pro software program is organized and how it 

is used with various instruments. 
 Chapter 4, "Tutorials," provides two written tutorials that will help you learn the basics of 

working with SoftMax Pro if you are a new user. Note: this information is not included in the 
Help system. 

 Chapter 5, "Data Collection" discusses how to prepare for and conduct a reading using SoftMax 
Pro. This chapter is organized by instrument. 

 Chapter 6, "Data Analysis," describes how data is displayed during and after a reading and how 
you can customize the display using the various software preferences. This chapter also describes 
data reduction and the different means for analyzing the raw data received from the different 
instruments. 

 Chapter 7, "File Management and Printing," explains how to customize reports and manage the 
files created by SoftMax Pro. Other topics include importing, exporting, copying, pasting, and 
duplicating data, both within SoftMax Pro and to and from other external programs, and details 
about how to import FLIPR and Analyst System files. 

 Chapter 8, "Enterprise," deals specifically with the Enterprise Administrator version of SoftMax 
Pro. 
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 Chapter 9, "Automation and Robotics," describes the commands that can be used with Windows-
compatible PCs to control the various functions of the instruments that work with SoftMax Pro. 

 Chapter 10, "Troubleshooting," describes alert messages that may appear while using SoftMax 
Pro and what to do should they occur. Other information in this chapter discusses possible 
communication problems with the instrument and other computer-related issues. 

 Appendix A, “SoftMax Pro Version Specifications,” details the updates and enhancements made 
in each software release from version 3.1 to the present. 

 Appendix B, “Glossary of Terms,” provides a list of terms used in this manual and their 
meanings. 

Formula Reference Guide 
 Chapter 1, “Introduction to Formulas,” provides a general introduction to SoftMax Pro 

formulas. 

 Chapters 2, “Operators,” 3, “Functions,” and 4, “Accessors,” list the building blocks used in 
SoftMax Pro formulas and give brief examples of how to use them. 

 Chapter 5, “Sample Protocols,” contains detailed examples of complex custom data analyses 
requiring interaction between the Template Editor, Group, and Graph sections, and the formulas 
themselves. 

Creating a Default Protocol 
While some previous versions of SoftMax Pro defaulted to open a specific “Tutorial” template, the 
current version opens to a blank protocol that reflects the instrument connected to the computer. If no 
instrument is connected to the computer, SoftMax Pro will use the instrument chosen in the 
Preferences to create a new protocol if no Default Protocol file exists. 

To have SoftMax Pro open a customized default protocol, simply: 

1. Create a new protocol file 

2. Modify any preferences/settings as necessary. 

3. Add any desired Notes, sections ,etc. 

4. Save it with the exact title: "Default Protocol" 

5. Ensure this Default Protocol file is saved/located in the Assays folder within the SoftMax Pro 
folder on your hard drive. 

It is not mandatory to create a default protocol since the software will sense the instrument connected 
to the computer and automatically create a new file based on the capabilities of that instrument 
(e.g., if a fluorescence instrument with a cuvette port, the software window will show fluorescence 
units on both a Plate section and a CuvetteSet section; if an absorbance instrument with no cuvette 
port, the software window will show absorbance units on a Plate section only). In addition to these 
sections will be a Notes section that is blank. If you want to have other sections (Graph, Group, etc.) 
be created automatically, or if you wish to customize the protocol to include summaries and/or other 
information in the Notes section, you can create a protocol file, save it under the name "Default 
Protocol," and place it in the Assays folder within the SoftMax Pro folder on your computer. Then, 
when you start SoftMax Pro or create a new file, the window that appears will be based on this 
Default Protocol. 
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Connect the Hardware 

� CAUTION: Turn OFF the power to both the instrument and the computer before connecting or 
disconnecting any components or cables. Not doing so could potentially result in damage to 
components in either or both the Molecular Devices instrument and/or the computer. 

The type of cable used to connect the computer to the instrument depends upon the type of computer 
and also the particular instrument you are connecting. SpectraMax and VersaMax instruments have 
8-pin DIN serial ports; EMax, VMax, UVMax, and ThermoMax instruments have 25-pin serial ports. 
Most older Macintosh models have 8-pin DIN (round) modem ports; newer Macintosh models may 
not have a serial port but instead have a USB port. PC models vary but typically have either a 9-pin 
or 25-pin serial port (check your particular computer to determine the type of serial connection 
needed). If your computer does not have a serial port or existing ports are in use, you may need to 
add a serial port through the use of a USB to Serial adapter cable. 

Connecting to a Macintosh 

� NOTE: If your Macintosh has a single serial port, see the "Troubleshooting” section for information 
regarding connection to the instrument. 

Serial Connection 

Older Macintoshes are equipped with the proper 8-pin serial port. Newer Macintoshes will require 
the use of a USB to Serial adapter cable to connect to the instrument properly.  

Connecting the end of the cable to the 8-pin modem port of the Macintosh is preferred since this 
allows the printer port to remain available. If you do connect to the Macintosh printer port, first 
deactivate AppleTalk using the AppleTalk Control Panel or the Chooser desk accessory in the Apple 
( ) menu. 

� NOTE: If you are running other applications that use AppleTalk, it may be necessary to quit them before 
making AppleTalk inactive. 

USB Connection 

iMac and Macintosh G4 (or greater) computers only have a USB port (no serial port). You can connect 
a serial cable to all newer Macintosh systems and the instrument through the use of a USB-to-serial 
adapter. Currently, Molecular Devices has tested adapters supplied by Keyspan without problems. 
Adapters from other manufacturers may work equally well. More information is available at 
http://www.keyspan.com/ 



Chapter 2: Installation  

12 SoftMax Pro User’s Manual 

 
Serial Cables for USB Macintosh. 

Left: USB serial adapter; Right Top: 8-Pin DIN to 8-Pin DIN Serial Cable  
(not the same as a Macintosh printer cable);  

and Right Bottom: 8-pin DIN to DB-25 Modem (Serial) Cable. 

1. Plug the USB connector on the serial adapter into the USB port on the back of the Macintosh 
computer. 

2. Plug one end of the 8-pin DIN cable into the USB-to-serial adapter (see the figure above). 
Plug the other end of the 8-pin DIN cable into the serial port of the instrument. 

USB-to-serial adapters generally require that you install software for them to function properly. 

After you have installed and are running SoftMax Pro (described in a later section), access 
Preferences from the Edit menu. Set the serial port to any open port available with your computer 
(typically you will choose the “Printer” port as most contemporary Macintosh computers have a 
built-in modem that uses the “Modem” port), then choose the appropriate instrument, and finally 
close the dialog box. 

Windows-Compatible Computer 

The type of cable required to connect your computer to an instrument will depend upon the type of 
instrument and the type of serial port(s) available on your computer. SoftMax Pro supports up to 
nine connections (serial ports). SpectraMax, VersaMax, and FlexStation instruments have 8-pin DIN 
serial ports; EMax, VMax, UVMax, and ThermoMax instruments have 25-pin serial ports. The cable 
should be a straight-through serial cable. The serial connector for your computer may be a 9-pin or 
25-pin connector (or you can use an adapter that converts from 9-pins to 25-pins—see the figure 
below. 
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Serial Cables for PC.  

 Top left: 8-pin DIN to 9-pin Serial Cable; top right: 9-pin to 25-Pin Adapter;  
bottom left: 25-pin DIN to 9-pin Serial Cable; bottom right: 25-pin to 25-Pin Serial Cable. 

Computer System Requirements 
See below for  the recommended and minimum computer hardware and operating system software 
specifications that will ensure proper operation of SoftMax Pro. 

� NOTE: Enterprise Administrator 1.1 is a Windows-only software program. However, users of the 
Macintosh version of SoftMax Pro 4.8 Enterprise Edition can communicate with Enterprise Administrator 
over a network (LAN). 

 

 

 
 

Macintosh Specifications  
Recommended System Configuration 

 PowerPC processor (G4, G5)  

 Macintosh OS version 9.2.2 (or OS X in 
Classic mode) 

 Color monitor capable of 1024 x 768 
resolution display 

 256 MB RAM 

 150 MB of available hard disk space 

 CDROM drive 

 USB-to-serial adapter and required 
drivers 

Windows Specifications  
Recommended System Configuration 

 Intel Pentium IV processor (1.8 GHz) 

 Microsoft Windows® 2000 or XP 

 Color monitor capable of 1024 x 768 
resolution display 

 256 MB RAM 

 150 MB of available hard disk space 

 CD-ROM drive 

 Available serial port (COM1 – COM9) 
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� NOTE: If you plan to use SoftMax Pro with a FlexStation instrument, or if you will be creating large files 
(in excess of 20 plates per file) with any instrument, or if you will be using any robotic applications, 
Molecular Devices recommends that you increase the amount of RAM in your computer to a minimum of 
256 MB. 

 

Install SoftMax Pro 
Two versions of SoftMax Pro are available: Standard edition, and Enterprise edition. The Standard 
Edition provides instrument control and analysis functions for all SpectraMax, FlexStation, Gemini, 
and earlier instruments as well as import and analysis of data files from FLIPR and Analyst 
instruments. In addition to all features found in the Standard edition, the Enterprise edition also 
contains powerful features that support a wide variety of regulatory compliance requirements. 

Follow these instructions to install SoftMax Pro. 

1. Insert the SoftMax Pro CD into the CD-ROM drive. 

2. Macintosh: Double-click the CD-ROM drive icon to display its contents. 
Windows: Open “My Computer” and then double-click the CD-ROM drive icon to display 
its contents. 

3. Double-click the Installer icon (Macintosh) or Setup icon (Windows) and follow the screen 
prompts. 

4. After an initial splash screen, clicking next will bring up a welcome screen. Click Next to 
continue.  

5. The "Software License Agreement" screen requires that you read and understand the license 
agreement. After you have read the agreement carefully, click Yes if you agree.  

6. The screen named “Choose Destination Location” asks you to select the drive where the 
software will be installed. A default location will be shown on the screen. You may browse 
for a specific folder on your computer using the Browse button. When the preferred directory 
has been selected, click Next.  

7. The “Setup Type” screen asks you to choose between "Typical" (the default), "Compact," or 
“Custom.” Choose "Typical" to install SoftMax Pro with the most common options, 
"Compact" to install SoftMax Pro with the minimum options, or "Custom" to choose which 
options to include or exclude during setup. If you have selected "Custom," Clicking next will 
prompt you with a list of options to choose. All other selections will advance to the next step.  

� NOTE: The [Back] button is available on all but the first screen, allowing you to go back to previous 
screens and review or change information that you have entered. 

8. The "Ready to Install" screen lists information about the installation process. Verify that the 
information on this screen is accurate and click Next.  

9. Click [Next] to start the actual installation of SoftMax Pro files. 

10. When installation is complete, the “Finished” screen will appear. Click [Close] to end the 
installer/setup program. On the Macintosh, remove the CD by dragging its icon to the Trash. 
On the PC, close the window for the CD and “My Computer” and then press the CD eject 
button on the CD-ROM drive. Replace the CD in its holder and store it in a safe place. 

� NOTE: During installation, an “Assays” folder is created which contains protocol files for all instrument 
types, regardless of the choice made above. Some of these protocols will not be appropriate for your 
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particular instrument (they might have reductions that are appropriate only for absorbance or 
fluorescence instruments, for example). Nevertheless, all protocols can be opened, run, and/or 
customized to be appropriate for any instrument. 

An open folder named “SoftMax Pro” (followed by the version number) will be visible on your 
screen. This folder contains the SoftMax Pro program. To ensure that SoftMax Pro will be able to 
communicate with your instrument, be sure to turn the instrument on prior to starting the SoftMax 
Pro program. After the instrument is powered on and has completed its start-up sequence, double-
click the icon to start SoftMax Pro. 

� NOTE: In Windows, a shortcut for the program will be available in the Start menu under "SoftMax Pro."  

� NOTE: An uninstall program is available for Windows computers. Should you need to remove older 
versions of SoftMax Pro from your hard drive, using the uninstall program is recommended since it also 
removes information regarding SoftMax Pro from the Windows Registry. To remove SoftMax Pro from a 
Macintosh computer, simply drag the SoftMax Pro folder and any other SoftMax Pro files you may have 
on your hard drive to the trash.  

� CAUTION: When you uninstall the program, make sure to backup your data and/or any saved 
files to a folder outside of the SoftMax Pro folder, because the SoftMax Pro folder will be deleted. 
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Communicating with the Instrument 
After installation of SoftMax Pro, if the instrument is properly connected and turned on, you should 
see the corresponding icon in the upper-left corner of the SoftMax Pro window. The type of 
instrument connected will also be reflected in the Preferences. 

If the instrument is not properly connected or is turned off, the instrument icon in the upper left-hand 
corner of the window will appear with an X through it. Check that the connection is secure and that 
the instrument is powered on.  

� NOTE: LMax II and LMax II384 requires manual selection of the instrument (in the Preference dialog) in 
order to establish communication.  This is due to the different baud rate requirement for LMax II 
instruments. 

You can configure SoftMax Pro to use protocols and settings for various instruments regardless of 
which instrument is connected (if any). You may access the Preferences settings (from the Edit menu, 
choose the Preferences command) to select the desired instrument.  

Note: this is sometimes done if you wish to create protocol files on a computer that is running 
SoftMax Pro but is not connected to an instrument or if you wish to create protocols for an instrument 
other than the one connected to the computer. 

� NOTE: If you are experiencing problems communicating with a connected instrument, access the 
Preferences (from the Edit menu, choose the Preferences command) and select the proper 
communications port (which port depends on the configuration of your computer—typically either 
modem or printer for the Macintosh and COM1 through COM9 for the PC). Serial ports that are not 
available will be dimmed. An additional setting (the factory default) is Neither. This selection is used 
when you do not have an instrument connected to the computer but wish to use SoftMax Pro or when the 
port connection must be disabled for other reasons. Choose the appropriate setting for your computer’s 
physical serial port connection and click [OK]. The instrument icon should now appear normally 
(without an X through it). 

 
Preferences Dialog Box 
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If the serial port setting is correct and the instrument is on, yet communication is still not functioning 
properly, quit SoftMax Pro, turn off power to both the computer and the instrument, and check that 
the cable connections between the instrument and computer are secure. Turn both machines on again 
and restart SoftMax Pro. 

What Is Installed 
A folder called “SoftMax Pro” (followed by the version number) will be installed in the location you 
specified on your computer’s hard drive. Within that folder are a number of separate files and 
subfolders as shown in the table below. Commonly used protocol files are grouped within subfolders 
that describe the type of assay (e.g., “Kinetic ELISA”). 

Certain data files are also included, some of which appear within the Tutorials folder. Some of these 
data files assist with learning basic operation of SoftMax Pro and are linked to written tutorials found 
later in this manual; others are included for you to open and continue learning on your own. . 

Note that folder and filenames are the same for Windows and Macintosh except that Windows files 
have the extension “.ppr” or “.pda” (.epr or .eda in the Enterprise version) appended to the file name 
for protocol or data files, respectively. 

All of the protocol files that are on the software CD are installed as shown in the table below and can 
be seen in the Assays menu within SoftMax Pro.  

� NOTE: The data files for the tutorial are in *.pda Format. You can access them by choosing File>Open and 
locating the Tutorial folder in your SoftMax Pro folder. Only *.ppr files can be seen through the Assays 
menu.  

Enter Registration Information 
Turn the instrument on and allow it to complete its start-up sequence (approximately 30-90 seconds, 
depending on the instrument type). 

Double-click the SoftMax Pro program icon inside the SoftMax Pro folder (Mac) or click the desktop 

icon [  ]or choose SoftMax Pro from the Start menu (Windows) to start the software program. The 
first time you open SoftMax Pro, a registration dialog box will appear, asking that you enter your 
name, company, and the serial numbers of the software program and instrument. The software serial 
number can be found on the original SoftMax Pro CD, on the inside cover of this manual, and on the 
software Warranty Registration Card (please remember to fill out this card and return it to Molecular 
Devices Corporation). The instrument serial number (S/N) is located on a label affixed to the back of 
the instrument. Type the information in the spaces provided and then click [OK]. Note that the option 
to click [OK] will not be available until all information has been entered. 
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Registration Dialog Box 

After all information has been entered correctly and you click [OK], a title screen will appear showing 
the registration information you entered. 
  

 

 
Example SoftMax Pro Title Screens 



 Chapter 2: Installation 

SoftMax Pro User’s Manual  19 

After a few seconds, the title screen will be replaced by an untitled SoftMax Pro window. The screen 
you see may not look exactly like the one below since its appearance depends on the type of 
instrument and computer you are using. 

 
SoftMax Pro Default Protocol Untitled Window 

Assays Folder 
The Assays menu is used to choose the folder that will contain protocol files you wish to access most 
often. After installation of SoftMax Pro, the protocol files shown under the Assays menu will be the 
basic protocols shipped with the software. Other folders are installed with SoftMax Pro containing 
protocol files for other types assays—you may select one of these folders instead, if desired. 

To change the default folder, choose Assays and then choose Set Folder... . A dialog box will appear, 
asking you to choose the folder or directory containing the protocol files you wish to have appear in 
the Assays menu. Select one of the other folders within the SoftMax Pro directory/folder or, if you 
have other protocol files in a different location, choose that location and then click [Select]. 

� NOTE: If you do not see any files in the Assays menu or if the files shown are not correct, it may be that a 
previous version of SoftMax Pro was not uninstalled prior to installation of a newer version. This can 
cause SoftMax Pro to default to using the old directory for assay files rather than the directory associated 
with the most current program version. Follow the instructions given above to choose the correct folder 
for the default assays folder. 
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Set Preferences 
It is a good idea to set the SoftMax Pro preferences before starting to user SoftMax Pro. The 
preferences include configuration settings, such as which port is used for the connection to the 
instrument, filters used with some instruments, settings for automatic printing and saving of files, 
and the format for exported data. To make these selections, choose Preferences from the Edit menu to 
open the Preferences dialog box. 

 
Preferences Window (Windows) 

Serial Port 
Check that the setting for the serial port matches the physical port used to connect the computer and 
the instrument. 

� NOTE: If you are using a Keyspan serial adapter with a Macintosh computer, set the port to “Printer.” 

 
Serial Port Selection in Preferences Dialog Box.  

Note that COM ports from 1 through 9 that are not available for your particular computer will be shown dimmed. 
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� NOTE: A selection of “None” can be made if communication with an instrument is not required or if no 
instrument is connected to the computer. When this option is selected, the Status Bar in SoftMax Pro will 
show an instrument icon with an “X” through it, along with the words “No port selected.” This selection 
allows you to use the serial ports for other purposes (modem connection, network connection, or 
printing, for example) but does not allow you to communicate with the instrument. 

� NOTE: When the FlexStation is selected in the Preferences, another option becomes available regarding 
Serial Comm Speed: 
 

 
Preferences Window (Windows) 

SoftMax Pro automatically detects the baud rate of the instrument to which the computer is 
connected and establishes a communication rate accordingly. This option allows you to view the 
baud rate that is being used and to manually set a different rate. This should not be done unless a 
serial communications problem occurs (see Communication Problems for more information). 
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Export Format 

 
Export Format selection in Preferences dialog box 

Data collected by SoftMax pro can be exported for use with other software programs or for archiving 
purposes. 

The preferences settings regarding the Export Format allow you to choose whether to export data as 
it appears in plate format or linearly (over time). The option to include text labels along with 
numerical data and/or to add the filename and date can be activated by clicking the checkboxes next 
to those items. (The option for "Interpolate Wells" is available only with the FlexStation instrument.)  

Autosave 
Enabling the Autosave feature in the Preferences dialog box will cause a data file to be saved 
automatically each time a plate is read. This reduces the likelihood of lost data.  

 
Autosave portion of the Preferences Dialog Box 

Autosave saves a copy of the file that is currently open. If the file that is open is a protocol file, note 
that the file will still be “Untitled” (i.e., not yet named) even after an Autosave has occurred. This 
allows you to Autosave to a text file format and then save manually as a SoftMax Pro file. 

You can Autosave to one of two different file formats: 

• SoftMax Pro—used to save your data automatically in SoftMax Pro format. 

• Text File—used when you want to have the data available for use with a spreadsheet 
or other program for data analysis external to SoftMax Pro. 
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� NOTE: If you Autosave as a text file, the SoftMax Pro version of the data WILL NOT BE SAVED 
AUTOMATICALLY and you will not be able to automatically re-open the data file in SoftMax Pro. If you choose to 
save to this format, you will need to save your data manually, using the Save or Save As... commands in the 
File menu if you also want to save a SoftMax Pro file. If you attempt to quit SoftMax Pro before saving a 
file containing data that has not yet been saved, a message box will appear asking if you want to save the 
file. You can assign any name to a file you save manually. 

� NOTE: If your protocol contains more than one experiment section when you Autosave to SoftMax Pro 
file format, each experiment will be saved to a separate data file. 

When Autosave is enabled, the box below the Autosave option becomes active, allowing you to 
choose the folder within which data files will be saved and the type of file to be saved. You may 
choose to Autosave as a SoftMax Pro file (default) or as a text file and, when saving as a text file, you 
may choose to append to the same file. 

The default folder for saving files is the SoftMax Pro folder. To save data files in a different folder, 
click the [Set] button. A dialog box will open, allowing you to choose a new location for saved files. 

 
Autosave Location Dialog Box (Windows) 

Highlight the folder where files should be saved. The [Select] button at the bottom of the dialog box 
will reflect this choice; clicking the [Select] button will set this folder as the default location for saved 
data files. You can change the location at any time by repeating this process. 

To change the file format from SoftMax Pro to ASCII text, select the appropriate radio button. 

� NOTE: If the Autosave function is reporting an error, or if files are saved in the wrong location, it may be 
that a previous version of SoftMax Pro was not uninstalled prior to installing a newer version. 

Create New File (when saving as Text file only) 
After each Plate section or CuvetteSet section is read, the data will be saved in a new file. This file will 
contain all the data from the current and previous readings (for example, if you read a Plate section, then 
another Plate section, followed by a CuvetteSet section, File1 will contain data for Plate1; File2 will 
contain data for Plate1 and Plate2; and File3 will contain data for both plates and the cuvette). This 
option is available for both file formats (SoftMax Pro and text).  

� CAUTION: If you Autosave to text format, you will not have a SoftMax Pro version of the file 
unless you also manually save the file using the Save as... command. 
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Append to File (when saving as Text file only) 
If you are saving data to a text file, you may choose to save all data to a single file for all plates and/or 
cuvettes by choosing “Append to File.” This option is dimmed (not available) if you are saving to a 
SoftMax Pro file. 

File Prefix 
The information entered into the “File Prefix” field is automatically inserted at the beginning of the 
filenames of new files that are saved automatically. The default prefix is “Data.” Accepting this 
default saves files starting with the name “Data” followed by a sequential number beginning with 
"1.” For example, the first microplate read would be saved under the file name “Data 1.” 

 
File Prefix Field (Windows) 

You can change this default prefix to any other prefix (up to 15 characters). To change the default file 
name prefix, click within the File Prefix field, highlight the existing information, and type over the 
word to enter a new prefix. 

If the File Prefix field is left blank, the date of the run will be used as the file prefix. 

Append Date 
Enabling the checkbox for Append Date will cause the date to be included in the automatic file name 
for the saved data file. If a time is not appended (see the next item), SoftMax Pro indexes the runs for 
that day starting with “1” and incrementing with each successive run. For example, using the File 
Prefix “Data,” the first file saved on November 18, 2003, would have the name “Data 11-18-03 1.”  

Append Time 
Enabling the checkbox for Append Time will include the time in the Autosaved file name for the 
saved data file in the format hhmmss. For example, using the file prefix “Data,” the file saved at 
10:12:38 a.m. would have the name “Data 101238.” 



 Chapter 2: Installation 

SoftMax Pro User’s Manual  25 

Reader 
The Reader pop-up menu indicates which instrument is currently connected to the computer. When 
an instrument is connected to the computer, this selection will automatically be the connected 
instrument. . 

 
Reader selection in Preferences dialog box 

If the computer is not connected to an instrument, the Reader type defaults to the last reader 
connected, but you can choose a different instrument from the this dialog. 

� NOTE: A protocol file can be written even if an instrument is neither connected to the computer nor 
selected in the preferences. Choosing an instrument first can be useful, however, since the options 
available in the Instrument Setup dialog box depend on the choice of instrument (for example, with a 
SpectraMax, you can choose up to six wavelengths, but you cannot do this with a VMax). 

Autoprint 
Checking this box will enable automatic printing of a report after each plate is read. This report will 
contain information from each section that is designated to be included in the report. For more 
information on reports, and including or excluding sections, see Printing. 

Filters 
The use of this button applies only to EMax, VMax, UVMax, and ThermoMax instruments (this 
button is dimmed when a different instrument is selected). Clicking the [Filters] button brings up a 
dialog box showing six filter positions. 
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Filters Dialog Box 

� CAUTION: Check that the filter wavelength displayed for each position accurately reflects the 
wavelength of the filter installed in each position of the filter wheel. Highlight and change (type 
over) incorrect values. If the settings in this dialog box are not correct, subsequent readings will 
generate incorrect data. 

� NOTE: The SpectraMax 250 accepts two optional filters, but the wavelengths for these filters are entered 
using the instrument's front panel. For specific information regarding how to install optional filters in the 
SpectraMax 250, refer to the instrument manual. 

� NOTE: The minimum configuration may not provide enough memory for creating or working with large 
files (more than one plate or cuvette per file) and/or the use of robotics. If you are using a Macintosh and 
your computer “freezes” or stops functioning, try increasing the amount of memory allocated to the 
SoftMax Pro program. 

Serial Cable 

Either configuration above requires a straight-through, serial cable (either an 8-pin DIN to 8-pin DIN 
for SpectraMax, VersaMax, and FlexStation, or 8-pin DIN to DB 25 cable for EMax, VMax, UVMax, 
and ThermoMax). Molecular Devices recommends using only high-quality, double-shielded, straight-
through serial cables.
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Introduction 
Molecular Devices assumes that you are familiar with the basic operation of your computer. If you 
need help with the basic functionality of your computer, please consult your computer's 
documentation.  

SoftMax Pro Window 
When you start SoftMax Pro, a splash or title screen will appear, showing the information entered 
during registration, along with the SoftMax Pro version, the instrument type (if connected), the 
instrument, and copyright information. 

 
SoftMax Pro Title Screen 

After a few seconds, the title screen will be replaced by a new SoftMax Pro experiment data file 
window. The figure below shows the window for the Macintosh above the window for the PC. 

The SoftMax Pro display contains these major elements: 

 A menu and status bar located at the top of the screen; 

 An untitled window showing an experiment data file containing various sections, depending 
upon the configuration of the default protocol used and the type of instrument chosen in the 
Preferences or connected to the computer. 

The menu and status bars are always visible while you are using SoftMax Pro, no matter where you 
are within the program. 
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The Main Window 

Window Size 
� NOTE: Because SoftMax Pro has been designed to provide you with a WYSIWYG preview of printed 

reports, the width of the experiment and sections shown in the window is constrained by the width set 
for the printed page size. The dimensions and orientation of the printed page (and, consequently, the 
display size) may be changed by selecting either Page Setup... (Macintosh) or Print Setup... (Windows) 
from the File menu. 

� NOTE: If you move the SoftMax Pro window such that the title bar is under the status bar, you will have 
to hide the status bar before you can move the window to see the title bar again. 
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Status Bar 
Near the top of the SoftMax Pro window is a status bar that shows the type of instrument that is 
connected to the computer or selected as the Reader type via the Preferences menu. 

 
Status bars for various instruments 

The status bar shows some or all of the following items, depending on the type of instrument 
connected or chosen (from left to right): 

   Instrument icon. Indicates that the instrument is communicating properly with the computer. 
If an “X” appears on top of the icon, the computer is not making proper contact with the instrument 
(see Communication Problems). 

� NOTE: Double-clicking the instrument icon opens the Preferences dialog box. 
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   Temperature display. Shows the current temperature within the microplate chamber in 
degrees Celsius. 

� NOTE: With the SpectraMax M2, M5, Plus, and Plus384, the SoftMax Pro status bar shows the temperature 
within the microplate chamber. This is different from the front panel of the instrument which displays the 
temperature within the cuvette chamber. The readings should be very similar to one another after both 
chambers have reached equilibrium. During warm-up, however, you may notice a discrepancy in 
temperatures, which is normal. 

    Read Button. If a plate or cuvette section is active or if only a single Plate or CuvetteSet 
section has been created in the experiment window, clicking the [Read] button starts the reading. This 
reading is based on the settings chosen in the Instrument Settings dialog box (refer to “Instrument 
Setup”) for the plate. 

If more than one Plate or CuvetteSet section has been created in the experiment window and no Plate 
or CuvetteSet section is currently active, clicking the [Read] button opens a dialog box asking you to 
select which plate (or cuvette) to read. 

� NOTE: If Autoread is selected in the preferences, all of the plates/cuvettes will be read in order 
automatically. 

    Reference Button. References a cuvette based on information entered in the Instrument 
Settings dialog box. The reference reading may be taken before or after the sample reading. This 
setting applies only to the SpectraMax M2, M5, Plus, and Plus384. 

   Incubator Button. Displays the “Incubator” dialog box, allowing you to set and regulate the 
temperature of the microplate/cuvette chamber. The temperature setting can be left at the default or 
can be specified by typing a different value in the box. 

� NOTE: The incubator setting is independent of the protocol being run. Running an assay does not 
automatically set the temperature set point. After a reading, however, the temperature set point, range, 
and average temperature are recorded in the saved file. 

   Automix Button. Shakes the microplate. (Note: This is a “manual” shaking of the plate as 
opposed to an “automatic” shaking that can be chosen in the instrument settings and is not available 
for the EMax.) 

   Drawer Button. Opens or closes the microplate drawer. 

� NOTE: The status bar can be hidden from view by selecting Hide Status from the View menu. Selecting 
Show Status from the view menu will restore it to view. 

Experiments 
SoftMax Pro collects data from one or more microplates and/or cuvettes and stores it in a single data 
file, using the same or different instrument settings for different microplates or cuvettes. For example, 
microplates containing different samples can be read using the same or different modes, all within 
the same experiment. 

Each SoftMax Pro file contains at least one experiment. Within an experiment are one or more 
sections. Experiments define a naming scope for the sections within them and provide quick access to 
different types of information without the need to open or refer to multiple files. 

An experiment can be selected by clicking the experiment tool bar (the area that shows the experiment 
number) with the mouse. Selecting an experiment causes its tool bar to change from light gray to 
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white. Selecting is different from activating an experiment. Selecting an experiment allows you to 
perform actions on the entire experiment (such as deleting or duplicating it). Multiple experiments 
can be selected by holding down the [Shift] key while clicking the individual tool bars of the 
experiments. 

A single click anywhere within an inactive experiment activates it. Activating an experiment allows 
you to add new sections to it or to perform other operations within that experiment. (With sections, 
however, selecting and activating are identical functions. Clicking anywhere within an inactive section 
activates and selects it.) 

You can create a new experiment by choosing New from the Edit menu. Choosing Duplicate from the 
Edit menu creates an identical copy of the currently selected experiment (excluding data). The new 
experiment retains the same name as the original, with the word “Copy” appended when you choose 
to Duplicate (e.g., the duplication of “Experiment1” produces “Experiment1 Copy”) and an 
increment of number when you choose New (e.g., “Experiment1” becomes “Experiment2”). 

An experiment can be deleted if it is no longer needed. The Delete command in the Edit menu 
changes depending upon which experiment is active. For example, if the experiment labeled 
“Experiment #1” is active, the Edit menu will show Delete Experiment #1. Using the Macintosh, you 
can also delete the selected experiment by pressing  – (hyphen); within Windows, you can press 
[CTRL]+[–] (hyphen). Take care before deleting experiments that they do not contain information you 
wish to save as deletion cannot be undone. 

You may delete multiple experiments simultaneously by holding down the [Shift] key and activating 
the tool bars of the experiments you wish to delete. Having done this, the Edit menu will now show 
Delete Selection instead of Delete Experiment. 

You can add new sections to the active experiment using the New Section command under the Edit 
menu. 

Sections 
A section is a part of the SoftMax Pro experiment window intended to perform a specific set of 
functions. There are five types of sections: Notes, Plate, CuvetteSet, Group, and Graph. A brief 
synopsis of these sections is given below. 

     Notes sections are used to record information pertaining to the experiment. 
You can enter text in this section as you desire; in addition, you can create summaries containing 
formulas for displaying reduced data. Text in Notes sections can be formatted (font, size, and style 
any way you choose). 

    Each Plate section shows a grid of cells which corresponds to the wells of the 
microplate. To the right of or underneath this grid is a box showing the current instrument settings 
(except incubator settings, which are always shown at the bottom of the Plate section after data is 
acquired). In the Plate section, you define a template to be used for analysis, determine the 
instrument settings, choose how the data will be displayed, and define the type of reduction (if any) 
that will be performed on the raw data received from the instrument. 

    CuvetteSet sections determine how the cuvette will be read, define templates to 
be used for analysis, display data as it is acquired from the instrument, define how the data will be 
displayed, and define the type of data reduction. The CuvetteSet section can display samples in three 
different ways: three samples per row, one sample per row, and in a grid of cells which is similar to a 
microplate format. To the right of the data display in the section is a box showing the current 
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instrument settings, except incubator settings (these are shown at the bottom of the CuvetteSet 
section after the first cuvette in the set is read). 

   Group sections are created automatically when groups are defined in the 
Template Editor. The example shown at left is for a group named “Standard.” Protocol files generally 
contain default groups; you can create others as needed. Each Group section contains default 
columns of data which can also be changed, if desired. Within a Group section, you can resize 
columns, modify existing columns to use different analysis formulas, add columns containing new 
formulas, and/or add one or more summaries at the bottom of the section. 

  Graph sections are used to plot information from groups (defined in the 
Template Editor). Values associated with the X- or Y-axes depend on the type of group selected for 
graphing. 
 

General Information about Sections 
Sections are either active or inactive. When active, the section title bar is colored dark gray. Multiple 
sections can be active at the same time. The tool bars of inactive sections are color coded to make it 
easier to discern a section’s type: 

Inactive Sections and their Colors 

Inactive Experiment or Section Color (Pastel Shade) 
Experiment Gray 

Notes Yellow 
Plate Purple 

CuvetteSet Green 
Group Pink 
Graph Blue 

 

Clicking anywhere in an inactive section makes it active. Selecting an experiment deactivates any 
individual section within it that may have been active and vice versa. Activating a section also 
activates the experiment containing that section. To activate multiple sections at the same time, hold 
down the [Shift] key and click in the tool bars of the sections you wish to activate. Doing this allows 
you to move, copy, duplicate, print, and delete multiple sections simultaneously. 

The “section” item in the SoftMax Pro menu bar is shown when a changes to reflect the type of 
section that is active. If a Plate section is active, for example, this menu item will show Plate. If an 
experiment or multiple sections are selected, this menu item will not be shown. 

New Plate, Cuvette, Notes, or Graph sections can be created whenever you need them and more than 
one of each type of section can exist in a single SoftMax Pro experiment section. (Group sections are 
created automatically when you define new groups in the Template Editor or may be created with 
the Duplicate command.)  

A section can be deleted if it is no longer needed. The Delete command in the Edit menu changes 
depending upon which section is active. For example, if the section titled “Plate #1” is active, the Edit 
menu will show Delete Plate #1. Using the Macintosh, you can also delete the active section by 
pressing [–]; within Windows, you can press [CTRL]+[–]. Take care when deleting sections that they 
do not contain information you wish to save. You may also delete multiple sections simultaneously 
by making them active—the Delete command in the Edit menu will change to show Delete Selection. 
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� NOTE: Deleting a Group section automatically deletes references to that group from the Template. 

Section tool bars contain buttons and pull-down menus. Buttons in the tool bar are only enabled 
when that section is active (the section does not need to be open). Menu equivalents exist for all tool 
bar functions. The figure below shows the active tool bar from a Graph section.  

 
If you scroll the window vertically so that part of an open/active section is hidden, its tool bar “sticks” 
to the top of the window. This feature prevents the active tool bar from becoming unavailable if you 
are viewing the bottom of a section that is longer than the window size. When the next section scrolls 
to the top of the window, its tool bar replaces the previous one but is not active, even if the section is 
open. If you scroll back so that even a small part of the previous (active) section is visible, its tool bar 
returns to the top of the window. 
  

 
Sections example 
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Opening and Closing Sections 
Newly created experiments and sections are initially shown in their full size (expanded) form. To 
facilitate navigation within an experiment data file, you can collapse Sections to show just their tool 
bars, if desired. Sections that are created automatically by SoftMax Pro may be shown initially either 
expanded or collapsed , depending on the default protocol file in use. 

To expand or collapse a single section within SoftMax Pro, click its indicator  located in the top left 
corner of the tool bar. When an experiment or section is collapsed, the indicator points to the right 

( ); when expanded, the indicator points down ( ). The figure below shows an open experiment 
containing three sections—the first two are collapsed and the last one is expanded. 

 

 
Opening and closing sections 

To expand or collapse multiple sections within an experiment (or multiple experiments in a file) 
simultaneously, use the Expand and Minimize commands in the View menu. Selecting Minimize 
( M for Macintosh; [CTRL]+[M] for Windows) will collapse all sections (leaving experiments open) 
to show only section title bars. Selecting Expand ( E; [CTRL]+[E]) will expand all sections. 

� NOTE: If you expand or minimize an experiment, the section tool bars in that experiment will be hidden. 
If all sections are presently expanded, the Expand command will be dimmed (unavailable). 
 

 
Opening a section in a separate window 

You may also open a section in a separate window. Double-clicking the section icon (in the tool bar) 
or selecting New Window from the active section menu (either Plate, CuvetteSet, Graph, Notes, or 
Group) causes the currently active section to open as a separate window (a copy of the tool bar still 
remains in the original experiment, but the section is closed; clicking the closed section places the 
new window behind the main window (the original section remains closed). Clicking on the triangle 
in the section tool bar closes the new window and causes the section in the experiment to open (and 
closing the separate window opens the section within the experiment again). All of the tool bar 
options applicable to the section are available in the separate window (except the triangle indicator). 
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Expanded Section 

Notes Section   

 
Notes Section 

The Notes section is used to record textual information and calculated summaries that pertain to an 
experiment. You can enter text of any kind and add summaries containing reduction formulas. 

The Notes section is divided into: 1) The Tool Bar; 2) The Body 

You may create multiple Notes sections within the same experiment. 

The tool bar contains the following items (shown with their tool bar or mouse equivalents). These 
menu items and buttons are active only when a Notes section is active. 
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Menu Items and Their Button Equivalents 

Menu Command/ 
Mouse Equivalent 

Description Tool Bar Button 

Notes section icon Opens the Notes section in a new 
window   (double-click) 

Name of Notes section Opens the Section dialog box  
(double-click) 

New Window in the Notes menu Opens the section in a new window  
Section Name in the Notes menu  Opens the Section Name dialog box  
Create Summary in the Notes 
menu 

Opens the Calculation dialog box, 
allowing you to create a summary  

 

Edit Summary in the Notes menu 
or double-click the summary 
(pointer changes to double-
headed arrow)  

Opens the Calculation dialog box, 
allowing you to edit the summary  

 

Show/Hide Formulas in the 
Notes menu  

Shows/hides the calculations used to 
derive summaries  

 

Printer icon Includes/excludes section from 
printed report  
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Plate Section 

 
The Plate Section 

The Plate section is used to collect data from the instrument, define how the data is displayed, and 
what the initial reduction of the data will be. In addition, the Template Editor in the Plate section is 
used to create a “map” of the contents of the microplate. 

Choosing a particular function or command in the Plate section can be done in several ways. You can 
use the mouse to click on a button, choose a command from one of the drop-down menus in the 
menu bar, or press a keystroke combination to activate a command or function. 

The Plate section is divided into the following areas: 

 Tool bar 

 Data display (shown in a microplate grid format) 

 Instrument settings, shown to the right of or below the data display, depending on the plate 
type and printer settings 

 Reduction settings, shown to the right of or below the data display, depending on the plate type 
and printer settings 

 Fluid transfer and checksum status for the FlexStation instrument 

When the grid in the Plate section shows colors, this means that a template has been defined for this 
Plate section. Each group defined in the template has a different color (the icon of the corresponding 
group table will have the same color). 

If your experiment requires multiple plates, you can create as many Plate sections as needed. 

The Plate menu contains the items shown below (shown with their tool bar or mouse equivalents). 
These menu items and buttons are active only when a Plate section is active. 
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Menu Items and Their Button Equivalents 

Menu Command/ 
Mouse Equivalent 

Description Tool Bar Button 

Plate section icon  Opens the Plate section in a new 
window   

 (double-click) 

Name of Plate section  Opens the Section dialog box    (double-click) 
Instrument Setup... in the 
Control menu  

Opens the Instrument Settings 
dialog box for this plate  

 

Template... in the Plate menu Opens the Template dialog box 
allowing you to create or edit the 
template  

 

Reduction... in the Plate 
menu  

Opens the Reduction dialog box 
containing reduction settings 
where you an modify wavelength 
combination settings as well as the 
data mode.  

 

Double-click in a single well 
or when several wells are 
selected; Graph in the Plate 
menu  

Enlarges selected well(s) to a Well 
Graph display (Kinetic and 
Spectrum modes only); choosing 
Graph again returns to regular 
display (toggle)  

 

Display... in the Plate menu  Opens the Display dialog box 
containing display choices   

Mask in the Plate menu  Masks the selected wells   
Printer icon  Includes/excludes section from 

printed report   

Section Name... in the Plate 
menu  

Opens the Section dialog box, 
allowing you to rename the section  

 

New Window in the Plate 
menu  

Opens the section in a new 
window  

 

Copy Template in the Plate 
menu  

Copies the template, allowing it to 
be pasted to another Plate section  

 

Paste Template in the Plate 
menu  

Pastes a previously copied 
template to a new Plate section  

 

Export Template in the Plate 
menu  

Opens the Export Template to... 
dialog, allowing you to export a 
template to an ASCII text file  

 

Import Template in the Plate 
menu  

Opens the Import Template to... 
dialog, allowing you to import a 
template from an ASCII text file  
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CuvetteSet Section 
The CuvetteSet section allows you to collect data from the cuvette port of the SpectraMax M2, M5, 
Plus or Plus384, define a template to be used for analysis, define how the data will be displayed, and 
define the type of data reduction. The Template Editor in the CuvetteSet section is used to describe 
the contents of the Cuvette. 

 
The CuvetteSet Section 

Choosing a particular function or command in the CuvetteSet section can be done in several ways. 
You can use the mouse to click on a button, choose a command from one of the drop-down menus in 
the menu bar, or press a keystroke combination to activate a command or function. 

The CuvetteSet section is divided into the following areas: 

 Tool bar 

 Data display (can be shown in three different ways: three samples per row, one sample per row, 
and in a grid of cells which is similar to a microplate format) 

 Instrument settings, shown to the right of the data display 

 Reduction settings, shown at the bottom of the data display 

When colors appear in the name labels above individual cuvettes (when displayed as one or three 
cuvettes per row) or when colored areas appear when the CuvetteSet section is displayed as a grid, 
this means a template has been defined for the CuvetteSet section. Each group defined in the 
template has a different color (the icon of the corresponding group table will have the same color). 

If your experiment requires multiple cuvettes, you can add up to 96 cuvettes in a single CuvetteSet 
section and/or create more than one CuvetteSet section. 

The CuvetteSet menu contains the items shown below (shown with their tool bar or mouse 
equivalents). These menu items and buttons are active only when a CuvetteSet section is active. 
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Menu Items and Their Button Equivalents 

Menu Command/ 
Mouse Equivalent 

Description Tool Bar Button 

CuvetteSet section icon  Opens the CuvetteSet section in 
a new window   

 (double-click) 

Name of CuvetteSet section  Opens the Section dialog box    (double-click) 

Instrument Setup... in the 
Control menu  

Opens the Instrument Settings 
dialog box for this CuvetteSet 
section  

 

Template... in the CuvetteSet 
menu  

Opens the Template dialog box 
allowing you to create or edit 
the template  

 

Reduction... in the CuvetteSet 
menu  

Opens the Reduction dialog box 
containing reduction settings   

Double-click in a single well 
or when several wells are 
selected; Graph in the 
CuvetteSet menu  

Enlarges selected well(s) to a 
Well Graph display (Kinetic and 
Spectrum modes only); 
choosing Graph again returns 
to regular display (toggle)  

 

Display... in the CuvetteSet 
menu  

Opens the Display dialog box 
containing display choices   

Mask in the CuvetteSet menu  Masks the selected wells   
Printer icon  Includes/excludes section from 

printed report   

Section Name... in the 
CuvetteSet menu  

Opens the Section dialog box, 
allowing you to rename the 
section  

 

New Window in the 
CuvetteSet menu  

Opens the section in a new 
window  

 

Copy Template in the 
CuvetteSet menu  

Copies the template, allowing it 
to be pasted to another 
CuvetteSet section  

 

Paste Template in the 
CuvetteSet menu  

Pastes a previously copied 
template to a new CuvetteSet 
section  

 

Export Template in the 
CuvetteSet menu  

Opens the Export Template to... 
dialog, allowing you to export a 
template to an ASCII text file  

 

Import Template in the 
CuvetteSet menu  

Opens the Import Template to... 
dialog, allowing you to import a 
template from an ASCII text file  
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Group Section 

 
The Group Section 

Group sections are created automatically when you create or select groups for the experiment in the 
Template Editor. A Group section is a table which shows all of the information for a particular 
sample group. A group is a set of associated samples which have been created in the Template. 
Depending on the default assay chosen, certain group types (such as Standard or Unknown) may 
have been created; you can create others as required. Group sections may also be created by 
duplicating existing Group sections. 

The Group section is divided into the following areas: 

 The tool bar 

 The body of the Group table 

 The summaries 

The Group menu contains the following items (shown with their tool bar or mouse equivalents). 
These menu items and buttons are active only when a Group section is active. 
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Menu Items and Their Button Equivalents 

Menu Command/ 
Mouse Equivalent 

Description Tool Bar Button 

New Window in the Group 
menu 

Opens the Group section in a new 
window    (double-click) 

Name of Group section  Opens the Group Settings dialog 
box   

 
(double-click) 

Group Settings in the 
Group menu  

Opens the Group Settings dialog 
box   

 

Create Summary in the 
Plate menu  

Opens the Calculation dialog box, 
allowing you to edit the summary 

 
Create Column. in the Plate 
menu  

Opens the Calculation dialog box, 
allowing you to edit the summary  

Edit Summary in the 
Group menu or double-
click the summary (pointer 
changes to double-headed 
arrow) 

Opens the Calculation dialog box, 
allowing you to edit the summary 

 

Edit Column in the Group 
menu or double-click the 
column 

Opens the Display dialog box 
containing display choices  

 

Show/Hide Formulas in the 
Group menu 

Masks the selected wells   

Autosize in the Group 
menu 

Enlarges or reduces column size 
to fit the largest piece of text 

 

Hide/Show All in the 
Group menu  

Hides one or more selected 
columns or shows all columns 
that were hidden 

 

Hide Replicates in the 
Group menu  

Hides data from all replicates  

Printer 
icon  

Includes/excludes 
section from 
printed report  
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Graph Section 

 
The Graph Section 

To create a graph section, choose New Graph from the Experiment menu. The Plots dialog box opens 
automatically and a default plot called “Plot#1” is selected. The plot will default to the first group 
available in the experiment. 

Once a graph has been created, new plots can be added and deleted, the axes can be customized, and 
the size (displayed area) of the graph can be changed. Grid lines can be enabled or disabled (default 
is enabled). Graphs may be displayed as bar graphs or scatter plots. 

The Graph section is divided into the following areas: 

 The tool bar 

 The body of the Graph section 

 Plots information below the graph 

You may create more than one Graph section within an experiment data file. Plots in the Graph 
section must be defined from groups within the same experiment section as the graph, with one 
exception: if you duplicate an experiment that contains data in the Plate section and has a plot defined 
in a Graph section, that plot will remain in the duplicated Graph section (and new plots may be 
added). 

The Graph menu contains the following items (shown with their tool bar or mouse equivalents). 
These menu items and buttons are active only when a Graph section is active. 
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Menu Items and Their Button Equivalents 

Menu Command/ 
Mouse Equivalent 

Description Tool Bar Button 

New Window in the Graph 
menu  

Opens the Graph section in a 
new window  (double-click) 

Name of Graph section  Opens the Section dialog box  
(double-click) 

Graph Settings in the Graph 
menu  

Opens the Graph Settings dialog 
box 

 

 Drop-down menu allows you to 
choose a curve fit 

 

X Axis... in the Graph menu  Opens the X Axis Settings 
dialog box 

 

Y Axis... in the Graph menu  Opens the Y Axis Settings 
dialog box  

Printer icon  Includes/excludes section from 
printed report   

Graph Options in the Graph 
menu  

Opens the Graph Options 
dialog box 

 

Export Graph in the Graph 
menu  

Opens the Export Graph As... 
dialog box 

 

 

SoftMax Pro Application Window for Macintosh 

 
SoftMax Pro Application Window for Macintosh 
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SoftMax Pro Application Window for Windows 

 
SoftMax Pro Application Window for Windows 
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Menus and Commands 
The menu bar for SoftMax Pro is located at the top of the window (just beneath the Title Bar). 

 
   

While working with SoftMax Pro, you may access its tools and features through several means: 
menus, tool bars, dialog boxes, and keystrokes.  

File. Items in this menu relate to entire SoftMax Pro experiment data files. Commands to open, print, 
apply password protection, and save files are located here. 

Edit. Commands to select, copy/paste, delete and duplicate items are located here. This menu also 
contains the Preferences command, which allows you to set options regarding printing, 
communication with the instrument, and saving files. 

View. Choices regarding what is shown and how it is shown are available here. The last section in 
this menu provides a navigational tool, allowing you to choose the particular section you would like 
to view (a section chosen in this manner will open if it was closed and will be brought into view 
within the window). 

Experiment. Choices in this menu allow you to create new sections within the current experiment, as 
well as to create a completely new experiment. 

Control. Items in this menu allow you to set up and activate instrument functions. 

Assays. This menu allows you to choose the folder containing the protocols you have saved and 
shows those protocols below the divider, making it easy to open one or more of them. A second level 
of folders can be stored within the Assays folder and will appear on the Assays menu, allowing you 
to separate protocols further, as desired. 

The last menu item (farthest right on the menu bar) changes to reflect the section type that is currently 
active (either Plate, Notes, Group, or Graph). If a Plate section is active, for example, the right-most 
menu item will be Plate. An active Graph section causes this menu to show Graph. If an experiment 
is selected, this menu will not be shown. 

Menus function differently depending upon whether you are using Windows- or Macintosh-based 
computer. On the Macintosh, clicking and holding the mouse button down while the cursor is on any 
of the main menu items causes a drop-down list to appear. To choose a menu item from a list, drag 
the mouse until the choice is highlighted and then release the mouse button. Within Windows and 
with some versions of the Macintosh OS, clicking on the main menu item causes the drop-down 
menu to remain, allowing you to click once on any menu item to choose it. 
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All Menus 

 
All of the menus in SoftMax Pro 
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Apple Menu  
About SoftMax Pro 

(Macintosh only) Displays the SoftMax Pro version, registration information, ROM version, and 
copyright information. If an instrument is connected to the Macintosh running SoftMax Pro, the 
instrument type will also be displayed. You will need to know this information if you call for 
technical support. Other items will appear in the Apple Menu, but these depend on the settings of 
your Macintosh. 

File Menu 

 
New 

Opens a new file window, allowing you to begin a new or different data file. Information from each SoftMax 
Pro window (which can consist of one or more experiments with their sub-sections) is saved to a separate file. 

Open... 
Opens an existing SoftMax Pro file (or an older SoftMax file). When you choose Open from the File 
menu, a dialog box appears. To open a file from the list of available files, double-click the filename to 
be opened, or click once on the filename and then click the [Open] button. 

Close 
Closes the front-most (active) window. If you have only one file open, this file will be closed. If you 
have changed the file in any way since it was opened, a dialog box will open asking if you want to 
save the file before closing. (This menu item is dimmed if no window is open.) 

Save 
Saves the active window to a file. The active file name is shown at the top of the status window 
(protocol files are always shown as “Untitled”). To save the file in a different folder/subdirectory or 
under a different name, use Save As.... If the file has not yet been saved and given a name (is 
“Untitled”), the Save As... dialog box will appear and you will be asked to name the file. (This menu 
item is dimmed if the file has already been saved and no changes have been made.) 

Save As... 
Saves a file with a new file name or into a new folder or subdirectory.  
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Import.../Export... 
A submenu offers the following choices: 

Import brings tab-delimited ASCII text file information into SoftMax PRO.  
Export creates a file of Plate section data, CuvetteSet section data, and/or Group table section data. 
All information from SoftMax Pro can be saved as tab-delimited ASCII (or text) format, which is 
suitable for importing into word processing or spreadsheet programs.   
Import Analyst allows you to import verbose reports generated using Criterion Host or 
SCREENPLAY software for all instrument modes.  
Import FLIPR allows you to import “FPD” files exported from FLIPR software. 

For more information: 

Page Setup/Print Setup 
You should access this command after you select a different printer in the Chooser (Macintosh), if 
you choose a different printer using Windows, or if you want to use a different paper size or printing 
option. Choosing Page Setup/Print Setup opens a dialog box with various options for printing. More 
about this function can be found in the documentation that accompanies your computer and/or 
printer. 

� NOTE: The Page Setup/Print Setup command also controls how SoftMax Pro sections are displayed on 
your monitor (the width of the display corresponds to the width of the page size). 

Print (Section name/Selection) 
Allows you to print just the active section(s). 

Print... 
With the Macintosh, choose this command and then click either “Print all” or “Print report.” Print all 
sends all sections to the printer in the order they appear in the window. Print report sends those 
sections selected to be in the report to the printer in the order they appear in the window.  

From Windows, choose Print and then specify a page range or leave the default to print all pages. 

� NOTE: Make sure you have selected the correct printer prior to choosing one of the Print options in the 
File menu. If you start to print and discover the wrong printer is selected, choose [Cancel] to exit from the 
Print dialog box, select the correct printer (using the Chooser or the Print Setup command), and then 
repeat the printing process. 

Quit 
Closes SoftMax Pro as well as any SoftMax Pro files you may have open. If you have open files that 
have changed and have not yet been saved, a dialog box will ask if you want to save them before 
quitting. 
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Edit Menu 

 
Undo 

Restores the last text operation to the condition that existed before the editing was done (used 
primarily when entering text in Notes sections). This menu item is dimmed if no actions have been 
taken or if undoing the last action is not possible. 

Cut 
Removes highlighted text or data from the document and stores it on the clipboard so it can be pasted 
elsewhere. This menu item is dimmed if no selection has been made or if the selection cannot be cut. 

Copy 
Copies selected text or data and stores it on the clipboard so it can be pasted elsewhere. This menu 
item is dimmed if no selection has been made or if the selection cannot be copied. 
Parts of an experiment can be copied within the same experiment or to another application using the 
Copy and Paste commands. You may also use this command to copy information from SoftMax Pro 
into other programs. 

Paste 
Pastes information from the clipboard just to the right of the insertion point in the document. Can 
also be used to import tab-delimited data into SoftMax Pro. This menu item is dimmed if nothing has 
been copied to the clipboard. 

Clear 
Clears or erases highlighted text or data without storing it on the clipboard. (This menu item is 
dimmed if nothing has been selected.) You can remove one or more columns from a Group table, or 
text or formulas from a Notes section, by highlighting the column or text/formula and then choosing 
Clear from the Edit menu. Columns and text or formulas can also be removed by highlighting them 
and pressing the [Delete] key on the Macintosh or [Backspace] key on the PC. 

Select All 
The Select All command can be used in Notes, Plate, Cuvette, and Group sections when a section is 
active (it is not available in Graph sections). 

 In a Notes section, if no summaries are present, it will select all text. If summaries are present at 
the top or bottom of the Notes section, this command will select all text but not the summaries 
(which must be selected individually). If the text is broken up by summaries, this command will 
select the largest block of text that it can (bounded by summaries). 

 In a Plate section, this command will select all wells, if one or more wells in the grid array has 
already been selected. If no wells have been selected, this command will be dimmed. 
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 In a CuvetteSet section, this command will select all cuvettes if one or more cuvettes has already 
been selected. If no cuvettes have been selected, this command will be dimmed. 

 In a Group section, this command will select all columns in the group table but will not include 
any summaries at the bottom of the group table (summaries must be selected individually). 

Delete Section/Selection 
Deletes the currently active section(s) or experiment(s). A warning dialog box will appear asking if 
you really want to delete the section(s) or experiment(s). 

Duplicate Section/Experiment 
Creates new section(s) or experiment(s) that are exactly like the active section(s) or experiment(s)and 
positions the duplicated selection(s) after the currently active section(s). The names of the new 
section(s) or experiment(s) will have the word “Copy” appended to their name(s). For example, if 
you duplicate a section named “Plate#1,” the duplicate section will be called “Plate#1Copy.” 
Subsequent duplications will append an incremented number after the name (e.g., "Plate#1Copy#2").  

Text Style... 
Allows you to change the attributes of selected text. (This command is dimmed if no text has been 
selected.) 

Preferences... (or double-click the instrument icon) 
It is a good idea to set the SoftMax Pro preferences before starting to use SoftMax Pro. The 
preferences include configuration settings, such as which port is used for the connection to the 
instrument, filters used with some instruments, settings for automatic printing and saving of files, 
and the format for exported data. To make these selections, choose Preferences from the Edit menu to 
open the Preferences dialog box. 
Through the Preferences dialog box, you can choose settings for the following options: 

 Serial port connection (modem port or printer port for the Macintosh; COM1 or COM2 for the 
PC) that will be used to connect to the instrument. A third option, “Neither,” should be used 
when no instrument is connected to the computer. 

 Export format (Time versus Plate, and whether or not to include labels and the name of the user 
who read the plate). 

 The instrument connected to the computer or, if none is connected, the type of instrument for 
which the software should be configured. 

 Whether or not files will be saved automatically, as well as the location where saved files will be 
stored and the automatic naming conventions that will be used (Autosave). 

 Whether or not reports should be printed automatically and print settings that will be used 
(Autoprint). 

 Wavelengths of filters installed in the EMax, VMax, UVMax, or ThermoMax instruments (not 
used with SpectraMax, FlexStation, or VersaMax instruments). 

Suspend Recalculation 
Stops SoftMax Pro from performing calculations based on changes you make to the settings or other 
program information. This command is used most often when you want to make a number of 
changes to the settings without having to wait while the results of each change are recalculated. 

Recalculate Now 
Causes SoftMax Pro to recalculate data based on the current settings. This command is used most 
often when you have suspended automatic recalculation. 
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View Menu 

 
The View menu provides three commands: Minimize ( M; [CTRL]+[M]), Expand ( E; [CTRL]+[E]), 
and Hide Status. 

In addition to these choices, the names of the open experiments appear at the bottom of the menu 
(sections within experiments are shown as submenus), allowing you to go to a specific experiment or 
section within an experiment by choosing the item. If the section was closed, selecting it from the 
View menu will open and activate it. The currently active section is shown in the menu with a 
checkmark next to it. 

Minimize 
If you select Minimize while a section within an experiment is active, the sections within that 
experiment are minimized. If you choose Minimize while an experiment tool bar is active, all 
experiments will be minimized (sections within are hidden and only the experiment tool bars are 
visible). 

Expand 
If you select Expand while a section within an experiment is active, the sections within that 
experiment are expanded. If you choose Expand while an experiment tool bar is active, all sections 
within all experiments become visible (the sections may be minimized or expanded). 

Hide Status/Show Status 
Hides or displays the status bar. 

Experiment Menu 

 
The Experiment menu provides five possible commands: New Experiment, New Notes, New Plate, 
New CuvetteSet, and New Graph. Which commands are shown depends upon which instrument is 
connected to the computer or chosen in the Preferences. 

New CuvetteSet 
Creates a new CuvetteSet section below the active section The new CuvetteSet section will be a copy 
of the active CuvetteSet section or, if no CuvetteSet section currently exists, the new CuvetteSet 
section will use SoftMax Pro default settings. 
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New 
Creates a new experiment directly following the active experiment (the new experiment then becomes 
the active experiment). All sections shown in the experiment that was active when this command is 
chosen are duplicated in the new experiment. 

New Graph 
Creates a new Graph section below the active section and brings up the Plots dialog box, allowing 
you to select the graph options. 

New Notes 
Creates a new Notes section below the active section. 

New Plate 
Creates a new Plate section below the active section. The new Plate section will be a copy of the active 
Plate section or, if no Plate section currently exists, the new Plate section will use SoftMax Pro default 
settings. 

Control Menu 

 
Instrument Setup... 

This command is available only if a Plate section or CuvetteSet section is active. Choosing Instrument 
Setup opens the Instrument Settings dialog box which allows you to enter the mode for the run 
(Endpoint, Kinetic, Spectrum, Well Scan, or FLEX), the wavelength settings, Automix parameters, 
pre-read blanking, strips, PathCheck, AutoRead, timing for Kinetic runs, Speed Read for Spectrum 
scans, read type, and plate type. 

� NOTE: Not all options are available for all instruments. The options that are visible depend on the type of 
instrument that is connected to the computer (or selected in the Preferences). 

Button Equivalent:  in the Plate section or CuvetteSet Section Tool Bar. 

Read ( R; [CTRL]+[R]) 
In a single plate experiment, the Read command reads the plate or cuvette immediately. If no Plate 
section or CuvetteSet section is active in an experiment containing multiple Plate sections or 
CuvetteSet sections, the Read command displays a dialog box asking you to select which Plate section 
or CuvetteSet section to read. The default Plate section or CuvetteSet section, selected by pressing the 
[Return] key, is chosen on these criteria: 

 The selected Plate or CuvetteSet section, if one is selected. 

 The next unread Plate or CuvetteSet section. 

 The first plate or cuvette, if all have been read. 
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Once a reading is in progress, menu items are no longer available until the reading is finished. 

Button Equivalent:  in the Status bar. 

Close Drawer 
Closes the drawer, at which time the menu item changes to Open Drawer. The drawer opens or 
closes immediately. 
Button Equivalent:  in the Status bar. 

Incubator 
(Available with ThermoMax, VersaMax, SpectraMax, and FlexStation instruments only) Allows you 
to turn the incubator on or off. When on, you can enter a setting for regulation of the temperature in 
the microplate chamber. 

Button Equivalent:  in the Status bar. 

Ref 
Available only when a CuvetteSet section is active and a SpectraMax M2, M5, Plus, or Plus384 is 
connected or chosen in the Preferences. This command causes the SpectraMax M2, M5, Plus, or 
Plus384 to read the cuvette in the cuvette port and applies the reading as a reference to all cuvettes in 
the CuvetteSet section. 

Button Equivalent:  in the Status bar. 

Assays Menu 

 
Set Folder... 

Allows you to select a folder or subdirectory containing commonly used protocol files. In addition to 
any protocol files residing within this folder (which will be listed below the dividing line and may be 
opened by clicking them), an additional level of subfolders (if any) will be shown below a center 
division. Protocol files can be used repeatedly (for specific types of assays, for example). These files 
can be named in any way you choose.  

File name(s) after dividing line 
The files that appear here are protocol files that reside within the folder determined using the Set 
Folder... command. You can quickly open and use one of these protocol files by selecting it from the 
Assays menu. 

Folder name(s) after dividing line 
Choosing any of these folders will open a submenu showing protocol files residing in this subfolder. 
Select one of the protocol files to open it. 
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Plate Menu 

 
This menu item changes to show CuvetteSet, Plate, Notes, Graph, or Group, depending on the type of section 
that is currently active. If no section is active, this menu item does not appear. 

Copy Template 
While a Plate section is open and active, choosing this command allows you to copy the template 
from this Plate section to the Clipboard, allowing you to paste it into a different Plate section (in the 
same or in a different experiment or into a Plate section in another SoftMax Pro file). 

Display... 
Opens the Display dialog box. Allows you to decide how the information in the Plate section will be 
displayed. More information regarding display options can be found in Display Dialog Box.  

Button Equivalent:  in the Plate section Tool Bar. 

Export Template 
Opens the Export Template to... dialog, allowing you to export a template to a tab-delimited ASCII 
text file. 

Graph... 
The Well Graph command is modal, so it can be activated both during data collection and after data 
has been acquired for a Kinetic, Spectrum, Well Scan, or FLEX reading. You can get a “close up” view 
of the plot shown in one or more wells by first selecting the well(s) and then choosing the Graph... 
command. (This command is dimmed if the instrument settings are for an Endpoint reading or if no 
well in the Plate display has been selected.) 
 
Button Equivalent:  in the Plate Section Tool Bar. 

Import Template 
Opens the Import Template to... dialog, allowing you to import a template from a tab-delimited 
ASCII text file. 

Mask 
Allows you to “hide” certain wells so that they will not be taken into account when performing 
analyses. (This command is dimmed if no data has been acquired or if no wells in the plate have been 
selected.) 
Button Equivalent:  in the Plate Section Tool Bar. 
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New Window 
Opens the active section in a separate window. 

Mouse Equivalent: double click the  icon in the Plate section tool bar. 

Paste Template 
If you have copied a template from a Plate section, you can then create or activate/open another Plate 
section and choose Paste Template. In this way, you can use the same template for more than one 
Plate section or you can modify the pasted template as desired. 

If you are pasting a template into a new experiment and groups from the source template do not exist 
in the destination experiment, pasting the template will create them. Existing groups of the same 
name will not be changed by the pasting process. For example, if the template being copied contains 
the groups “Standards” and “Unknown,” and the group “Standards” already exists in the destination 
experiment, the group “Unknown” will be created but all information regarding the group 
“Standards” in the destination experiment will remain unchanged. If you copy and paste the 
template with the same experiment, no new groups are created. Group names can be edited in the 
pasted template (these changes will be reflected in the original template also). 

Reduction... 
Opens the Reduction dialog box. Options available in the Reduction dialog box depend on the type of 
reading performed (Endpoint, Kinetic, Spectrum, Well Scan, or FLEX) and the instrument used to 
collect the data. The Reduction dialog box is used for initial reduction of the data collected from the 
microplate reader. The optical density information collected is reduced to a single number per well.  

Button Equivalent:  in the Plate section tool bar. 

Section Name... 
Allows you to change the name of the Plate section. 
Double click the name of the Plate ( Plate #1 )in the Plate Section Tool Bar (to the right of the Plate 
section icon) to edit or change the plate section name. 

Template... 
Opens the Template Editor. 
The Template Editor allows you to describe the samples that are in the wells, thus providing the link 
between the raw data and the analysis groups. You can create new groups in the template or assign 
wells to already established groups. 

If your experiment contains multiple Plate sections, the template for each Plate section must be 
defined using the Template Editor in that section. You can create a new template or modify an 
existing one using the Template Editor. 

� NOTE: Each Plate section requires that a template be created in order to identify groups within that plate. 
However, two or more Plate sections may use the same template, or the same groups may be used in 
different templates. 

After groups are defined in the template and you return to the Plate section, the data display will 
show the group areas in different colors. 

   Button Equivalent:  in the Plate Section Tool Bar. 
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CuvetteSet Menu 

 
This menu item changes to show CuvetteSet, Plate, Notes, Graph, or Group, depending on the type of 
section that is currently active. If no section is active, this menu item does not appear. 

Template... 
Opens the Template Editor. 
The Template Editor allows you to describe the samples that are in the wells, thus providing the link 
between the raw data and the analysis groups. You can create new groups in the template or assign 
cuvettes to already established groups. 
If your experiment contains multiple CuvetteSet sections, the template for each CuvetteSet section 
must be defined using the Template Editor in that section. You can create a new template or modify 
an existing one using the Template Editor. 
After groups are defined in the template and you return to the CuvetteSet section, the data display 
will show the cuvettes that are assigned to groups by means of colors in their locator headings (if 
viewing by one or three cuvettes per row) or as colored outlines (if viewing in a grid), if you have a 
color monitor, or in shades of gray on a monochrome monitor. 

Button Equivalent:  in the CuvetteSet Section Tool Bar. 

Reduction... 
Opens the Reduction dialog box. Options available in the Reduction dialog box depend on the type of 
reading performed (Endpoint, Kinetic, Spectrum, Well Scan, or FLEX) and the instrument used to 
collect the data. The Reduction dialog box is used for initial reduction of the data collected from the 
microplate reader. The optical density information collected is reduced to a single number per well.  

Button Equivalent:  in the Plate section tool bar. 

Display... 
Opens the Display dialog box. Allows you to decide how the information in the CuvetteSet section 
will be displayed. 

Button Equivalent:  in the CuvetteSet Section Tool Bar. 

Graph... 
During data collection and after data has been acquired for a Kinetic or Spectrum reading, you can 
get a “close up” view of the plot shown in one or more cuvettes by first selecting the cuvette(s) and 
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then choosing this command. (This command is dimmed if the instrument settings are for an 
Endpoint reading or if no well in the Plate display has been selected.) 

Button Equivalent:  in the CuvetteSet Section Tool Bar. 

Mask 
Allows you to “hide” certain cuvettes so that they will not be taken into account when performing 
analyses. (This command is dimmed if no data has been acquired or if no cuvettes in the set have 
been selected.) 

Button Equivalent:  in the CuvetteSet section. 

Copy Template 
While a CuvetteSet section is open and active, choosing this command allows you to copy the 
template from this CuvetteSet section to the Clipboard, allowing you to paste it into a different 
CuvetteSet section (in the same or in a different experiment or into a CuvetteSet section in another 
SoftMax Pro file). 

Paste Template 
If you have copied a template from a CuvetteSet section, you can then create or activate/open another 
CuvetteSet section and choose Paste Template. In this way, you can use the same template for more 
than one CuvetteSet section or you can modify the pasted template as desired. 
If you are pasting a template into a new experiment and groups from the source template do not exist 
in the destination experiment, pasting the template will create them. Existing groups of the same 
name will not be changed by the pasting process. For example, if the template being copied contains 
the groups “Standards” and “Unknown,” and the group “Standards” already exists in the destination 
experiment, the group “Unknown” will be created but all information regarding the group 
“Standards” in the destination experiment will remain unchanged. If you copy and paste the 
template with the same experiment, no new groups are created. Group names can be edited in the 
pasted template (these changes will be reflected in the original template also). 

Export Template 
Opens the Export Template to... dialog, allowing you to export a template to a tab-delimited ASCII 
text file. 

Import Template 
Opens the Import Template to... dialog, allowing you to import a template from a tab-delimited 
ASCII text file. 

Section Name... 
Allows you to change the name of the CuvetteSet section. 

Mouse Equivalent: double-click the name of the CuvetteSet section ( )to the right of the 
CuvetteSet section icon. 

New Window 
Opens the active section in a separate window. 

Mouse Equivalent: double-click the  icon in the CuvetteSet section. 
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Notes Menu 

 
This menu item changes to show CuvetteSet, Plate, Notes, Graph, or Group, depending on the type of section 
that is currently active. If no section is active, this menu item does not appear. 

Create Summary... 
When the Notes section is active, choosing Create Summary opens a dialog box allowing you to give 
a title to a new summary and then enter a formula to be used for the summary. 

Button Equivalent:  in the Notes section. 

Edit Summary... 
If you have created a summary and need to change it, you can do so by first highlighting the 
summary you wish to edit and then choosing Edit Summary. (This command is dimmed if you have 
not yet created a summary or if the summary has not been selected.) The dialog box then appears 
showing the name and formula. 

Mouse Equivalent: Double-clicking the summary performs the same function. 

Button Equivalent:  in the Notes section. 

New Window 
Opens the active section in a separate window. 

Mouse Equivalent: double-click the  icon in the Notes section. 

Section Name... 
Allows you to change the name of the Notes section. 

Mouse Equivalent: double-click the name of the Notes section ( Standard Curve ) to the right of the 
Notes section icon. 

Show Formulas 
Choosing this command shows the formulas associated with the summaries you have created in the 
Notes section. After choosing Show Formulas, the menu name changes to Hide Formulas. (This 
command is dimmed if you have not created any summaries.) 
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Graph Menu 

 
This menu item changes to show CuvetteSet, Plate, Notes, Graph, or Group, depending on the type of section 
that is currently active. If no section is active, this menu item does not appear. 

Graph Options... 
You can select from three types of graphs: Scatter (with symbols plotted and/or the points connected), 
Cluster Bar, or Stack Bar and you can set the height of the graph to be something other than the 
default percentage (100%). The font used for the title, legend, and/or axes can be changed and/or 
modified in size and style. Plots can be added, deleted, or edited. Editing plots allows you to change 
the plot name, its source (from which experiment and group), as well as the items to be plotted (for 
example, concentration vs. values). 

Button Equivalent: in the Graph section. 

X-axis... 
Sets the X-axis parameters (tick marks, scale, label, gridlines, and autorange). 
Button Equivalent:  in the Graph section. 

Y-axis... 
Sets the Y-axis parameters (tick marks, scale, label, gridlines, and autorange). 
Button Equivalent:  in the Graph section. 

Export Graph 
Creates a file containing a picture of the graph with a filename of your choice. On the Macintosh, the 
graphic is in PICT format; in Windows, the graphic is in EMF (Enhanced MetaFile) format. 

Section Name... 
Allows you to change the name of the Graph section. 

Mouse Equivalent: double-click the name of the Graph section ( ) to the right of the 
Graph section icon. 

New Window 
Opens the active section in a separate window. 
Mouse Equivalent: double-click the  icon in the Graph section. 
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Group Menu 

 
This menu item changes to show CuvetteSet, Plate, Notes, Graph, or Group, depending on the type of section 
that is currently active. If no section is active, this menu item does not appear. 

Create Column 
If a Group section is currently active, you can add a column to the display by choosing this 
command. If no columns are highlighted, the column will be added at the end of the group. If you 
select a column first, the new column will be added to the right of the highlighted column.  

Button Equivalent: in the Group section. 

Create Summary 
Allows you to create a summary and enter a formula for this summary for the Group. Summaries 
appear at the bottom of the group table. 

Button Equivalent:  in the Group section. 

Edit Column 
Selecting a column makes this command active. Choosing Edit Column allows you to change the 
formula associated with the column and to change the column name. 
Mouse Equivalent: Double-clicking the column performs the same function. 

Button Equivalent:  in the Group section. 

Edit Summary 
Allows you to edit the formula associated with the summary, as well as to change the summary 
name. (This command is dimmed if a summary has not yet been created.) First highlight the 
summary and then select this command. 
Mouse Equivalent: Double-clicking a summary performs the same function. 

Button Equivalent:  in the Group section. 

Autosize 
Choosing this command expands or shrinks the width of selected columns to accommodate the 
largest piece of text in the column. 
Mouse Equivalent: Double-clicking the line to the right of the column heading performs the same 
function. 
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Hide 
Hides the selected column from view. (This command is dimmed if a column has not been selected.) 
Mouse Equivalent: Dragging the line to the right of the column heading until it is on top of the line to 
the left of the column performs the same function. 

Hide Replicates 
Hides data for all replicates (if any) from view. 

Show All 
Shows all columns or replicates that were hidden previously. 

Show Formulas 
Causes a new row to appear beneath the headings of each column showing the formulas used to 
determine the data in the columns. After choosing this command, the menu name changes to Hide 
Formulas. 

Group Settings 
Opens the Group Settings dialog box, allowing you to rename a group and/or change the sample or 
group descriptors used, as well as to modify the units used with each descriptor. 
Mouse Equivalent: double-click the name of the Group section ( Standards ) to the right of the Group 
section icon. 

New Window 
Opens the active section in a separate window. 
Mouse Equivalent: double-click the  icon in the Graph section. 
 

Window Menu (Windows only ) 

 
Tile 

If you have several windows open, choosing the Tile command will resize and arrange all open 
windows side by side. 

Cascade 
If you have several windows open, choosing the Cascade command will resize and layer the open 
windows so that each title bar will be visible. 

Arrange Icons 
If you have several files open but reduced to icons, choosing the Arrange Icons command will move 
all icons to the bottom of the SoftMax Pro window and put them in order. 

Beneath the line will appear the names of all open files within SoftMax Pro. The active file will have a 
checkmark next to it. Choosing one of the file names shown here will cause that file to come to the 
forefront of the screen (and will restore the file to its previous size if it had been minimized). 
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Help Menu -- Macintosh 

 
About Help... 

Brings up a dialog box explaining how to use the Apple Guide which gives detailed information 
about the help function on the Macintosh. 

Show/Hide Balloons 
Depending upon whether or not you have balloon help turned on or off, this menu presents the 
choice to reverse the setting. 

SoftMax Pro Help... 
Opens the help section devoted to SoftMax Pro. Items are presented in alphabetical order. 

Formula Help... 
Opens the formula help section which provides information about how to use formulas, including 
formula examples. 

Help Menu -- Windows 

 
SoftMax PRO Help 

Displays the Help screens, allowing you to choose from a list of topics or by using an index. Clicking 
a topic or an index entry opens the help screen associated with it. 

About SoftMax Pro 
Opens the About screen which gives the serial number, ROM version, and the instrument type 
connected to the computer, as well as the software version for SoftMax Pro. 

 



  

  

Chapter 4: Tutorials 
 

Introduction.........................................................................................................................................68 
Tutorial 1: Quantitative Endpoint Assay Tutorial........................................................................68 

Hard and Soft Parameters ...........................................................................................................68 
Description of the Assay Example .............................................................................................69 
Define the Protocol.......................................................................................................................69 
Step 1: Start SoftMax Pro (Create a New  Experiment data file)............................................69 
Step 2: Define the Instrument Settings ......................................................................................71 
Step 3: Define the Template ........................................................................................................73 
Step 4: Set the Reduction Parameters ........................................................................................81 
Step 5: Set the Display Parameters.............................................................................................81 
Step 6: Save the File......................................................................................................................82 
Step 7: Read the Plate...................................................................................................................83 
Step 8: Data Analysis—Group Sections.....................................................................................86 
Step 9: Data Analysis—Standard Curve....................................................................................91 

Tutorial 2: EC 50 Assay Tutorial (FLEX mode only).....................................................................95 
Hard and Soft Parameters ...........................................................................................................95 
Define the Protocol.......................................................................................................................96 
Step 1: Launch SoftMax Pro (Create a New File) .....................................................................96 
Step 2: Define the Instrument Settings ......................................................................................98 
Step 3: Define the Template ......................................................................................................105 
Step 4: Set the Reduction Parameters ......................................................................................108 
Step 5: Set the Display Parameters...........................................................................................109 
Step 6: Save the File....................................................................................................................110 
Step 7: Read the Plate.................................................................................................................111 
Step 8: Data Analysis—Group Sections...................................................................................114 
Step 9: Data Analysis—Graph ..................................................................................................121 
Step 10: Data Analysis—Summary Formula ..........................................................................122 
Step 11: Print a Report ...............................................................................................................124 
 



 Chapter 4: Tutorials 

SoftMax Pro User’s Manual  67 

 



Chapter 4: Tutorials  

68 SoftMax Pro User’s Manual 

Introduction 
The “hands-on” written tutorials included here are designed to take you through the basic features of 
the SoftMax Pro program. If you are new to SoftMax Pro, we suggest that you read and follow the 
steps in one of the tutorials before using SoftMax Pro for the first time since it will help you learn the 
basic features quickly.  

� NOTE: If you have not yet installed SoftMax Pro, see the section on  Installation, and follow the steps 
listed there to install the software before proceeding with the tutorial. 

Tutorial 1: Quantitative Endpoint Assay Tutorial 
This tutorial section will lead you through the steps required to create and run a quantitative assay 
utilizing a standard curve. This tutorial is designed to be used by both absorbance and fluorescence 
instruments. 

Hard and Soft Parameters 
The only settings that must be defined before reading a microplate are the instrument settings (found 
in the Instrument Setup dialog box). These settings tell the instrument what conditions should be in 
place in order to collect data. They include the read mode (Endpoint, Kinetic, Spectrum, or Well 
Scan), the number of wavelengths, specific wavelength settings, and so on. These settings, called hard 
parameters, define the conditions under which the data is obtained. Once a microplate has been read, 
the instrument settings cannot be changed without deleting the data. 

Soft parameters include the template definition and data reduction settings. These parameters can be 
defined prior to reading a microplate, but they are applied only after the plate is read and can be 
changed at any time. 

In this tutorial, you will build a complete protocol (based on the settings found in the Tutorial file; see 
Note below) which will include both hard and soft parameters. You will save the completed protocol 
file prior to collecting data (this file could then be used to generate future data files). 

� NOTE: When you install SoftMax Pro, you are asked to choose between absorbance, fluorescence, or 
FlexStation installation. The choice made at that time will determine the type of default protocol file that 
is installed. Tutorial 1 pertains to users of either absorbance or fluorescence instruments; Tutorial 2 deals 
with the FlexStation instrument. 

� NOTE: You should ensure that the instrument that is connected to the computer is chosen in the 
Preferences before proceeding: in the Edit menu, choose Preferences. In the dialog box that appears, 
choose your instrument (if it is not already chosen) and then close the dialog box. 

A synopsis of the steps you will take during the tutorial is given below. 

1. Create a new file 
2. Instrument setup 
3. Template setup 
4. Set reduction parameters 
5. Set display parameters 
6. Save the protocol 
7. Read the plate (start the simulator and then open the Tutorial file) 
8. Analyze data—Standard Curve 
9. Analyze data—Standard section 
10. Print the report 
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Description of the Assay Example 
Following are the details about the quantitative assay settings we will use to create a protocol file 
using SoftMax Pro. 

Quantitative Assay Settings 

Read Mode:  Endpoint 
Standards in µg/ml:  0, 0.1, 0.25, 0.5, 0.75, 1.0, and 

1.4 (each standard run in 
duplicate) 

Standard  Curve Fit: Linear 
Blanks:  Plate blank run in duplicate 
Auto Mix:  On 
AutoCalibrate: On 
Instrument Settings Specific to Absorbance Instruments: 
Wavelengths:  One: 405 nm 
Strips:  Read entire plate 
Instrument Settings Specific to Fluorescence Instruments: 
Wavelengths:  One: Excitation: 485; 

Emission: 538; Auto Cutoff 
Sensitivity:  6 readings; Auto PMT 
Assay Plate Type:  96 Well Standard 
Wells to Read:  Read entire plate 
AutoRead:  Off 

 
Define the Protocol 

The following steps will guide you through the process of creating a protocol file for a quantitative 
assay. Reading an actual plate will not be required you will use a simulator to read a plate and 
generate data. 

Step 1: Start SoftMax Pro (Create a New  Experiment data file) 
Double-click the SoftMax Pro icon to start the program. If SoftMax Pro is already running, choose 
New... from the File menu. You should see a new experiment file labeled Untitled. The figure below 
shows an example of both the absorbance (bottom left) and fluorescence (upper right) Default 
Protocol file. 
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Default Protocol/Tutorial 1 Notes and Plate#1 Sections Open 

If you are using an absorbance instrument, CuvetteSet#1 (shown in the absorbance file above, bottom 
left) can be deleted since the use of a cuvette is not covered in this tutorial. To delete this section: 

1. Click in the title bar of the CuveteSet#1 section (it will turn gray and the title will become 
bold). From the Edit menu, choose Delete CuvetteSet#1. A small dialog box will appear, 
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asking you to confirm deletion of this section. Click the [Delete] button and the section will 
be deleted. 

2. The experiment should now have a Plate section (Plate#1), a Graph section (Graph#1), and 
two other group sections (Controls and Unknowns) that will be used in this tutorial. 

 

Step 2: Define the Instrument Settings 
Click the Plate#1 section to make it active (its tool bar will become gray) and then click the [Setup] 
button in the tool bar to open the Instrument Settings dialog box. At the top of the dialog box, 
Endpoint is selected by default as the read mode; no change is required. 

Clicking the setting name (bold heading) on the left side of the Instrument Settings dialog box shows 
the choices available for that setting in the right pane, allowing you to make changes. The table below 
shows the settings that should be chosen for this tutorial example for both absorbance and 
fluorescence instruments. Following the table are instructions regarding how to choose those specific 
settings. 

Settings Tutorial 

For Absorbance Instruments For Fluorescence Instruments 

  

 
Read Type: Fluorescence is the default and is correct for 
this tutorial example. 

Wavelengths: 1 450 nm (default) 
Wavelengths: 1 Excitation: 485 
Emission: 538 
Auto Cutoff enabled 

PathCheck: Off (default) (this setting only available with 
certain instruments) 

Sensitivity: Readings: 6 (default) 
PMT: Auto (default) 

Automix and Blanking: 
Automix Before: Off (default) 
Pre-Read Plate: Off (default) 

Automix: Automix Before: Off (default) 

 AutoCalibrate: On (default) 
 Assay Plate Type: 96 Well Standard (default) 
Strips: Read entire plate (default) Wells to Read: Read entire plate (default) 
AutoRead: Off (default) AutoRead: Off (default) 
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Read Type (Fluorescence instruments only) 
Choices are fluorescence, luminescence, or time-resolved fluorescence. The default setting, 
fluorescence, is used in this tutorial so no change is necessary. 

Wavelengths 
Click the word Wavelengths on the left side of the Instrument Settings dialog box to make it the 
active tab. A black bar will appear over the word and the right side of this dialog box will then show 
the specific settings for the wavelengths selection. If the settings are not correct as shown, click the 
arrow next to the number of wavelengths and choose 1 from the drop-down list; then click the arrow 
next to the wavelength shown and choose the appropriate value(s) for your instrument (see the table 
above). The figure below shows what the Instrument Settings dialog box might look like at this point 
(depending upon which instrument is connected to your computer). 

 
Instrument Settings Dialog Box Showing Wavelengths Settings. Top left: absorbance instrument; bottom right: 

fluorescence instrument. 

Sensitivity (Fluorescence instruments only) 
Now check the settings for Sensitivity by clicking that heading on the left side of the dialog box: the 
defaults shown on the right side (6 Readings, Automatic PMT Sensitivity) are fine and do not need to 
be changed for this tutorial. 

Automix or Automix and Blanking 
Now check the settings for Automix (fluorescence) or Automix & Blanking (absorbance) by clicking 
the heading on the left side of the dialog box: on the right, Automix Before should be set to Off; Pre-
Read Plate should be set to Off. If not, click the appropriate checkbox to turn the setting on or off. 
When you are finished, the dialog box should look similar to the one shown below. 
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Instrument Settings Dialog Box Showing Automix & Blanking (Absorbance) or Automix (Fluorescence) 

� NOTE: Assay Plate Type, Wells To Read, Strips, AutoRead, etc. The online Help index can be used to 
learn more about these features. For example, to learn about AutoCalibrate shown in this dialog box, 
choose Index from the Help menu. Then type “autocalibrate” in the first field and double-click the result 
showing Autocalibrate in the second field. A description of AutoCalibrate should now be displayed. 

   

Instrument settings are now complete. Click [OK] to accept the settings and close the dialog box. 

Step 3: Define the Template 
A. Click the [Template] button in the Plate Section Tool Bar. This will open the Template Editor, 

showing all wells empty. Drag the mouse (or [Shift]-click) to select the first two wells, A1 and 
A2. Click the Group pull-down menu on the Template Editor to see the group selections. 
Choose Blank. The two selected wells in the template will now be defined as the plate blank. 
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Template with Plate Blank Wells Assigned 

B. Now select the two wells B1 and B2. Select Standards from the Group menu. The selected 
wells will now show the default first sample name for the Standards group, St01. The area in 
the top center of the Template Editor will become active, showing the default values for 
concentration and units. 

 
Template with First Standards Entered 

In this tutorial, the concentration for the first Standard should be set to 0 µg/ml. If a value 
other than 0 is shown, highlight the existing value and enter 0 in this box. Click the [Assign] 
key or press either the [Tab] or [Return] key on the keyboard to assign this concentration to 
the selected wells in the template. You can quickly check the concentrations you have 
assigned to the template by pressing and holding the [CTRL]+[Shift] keys (Macintosh or 
Windows). This causes the display to show only group names and values assigned to specific 
wells. 
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Template showing First Standards Concentrations 

C. Now select wells C1 and C2. Standards is still showing as the default group name, but a new 
sample descriptor is created automatically (St02), so all you need to do is assign a 
concentration value of 0.1 µg/ml to these wells. After entering the value, click the [Assign] 
box (or press the [Tab] or [Return] key) to assign this value to the selected wells. 

D. A total of seven standards will be assigned in duplicate in this template. You can use the 
Series function to assign the next four standards. Select wells D1/D2 through G1/G2. Click 
the [Series] button. In the dialog box that appears, leave the default values for the sample 
descriptor (Std03), starting from the top, and the concentration in µg/ml. Enter 0.25 for the 
starting value, choose the Step by function + and enter 0.25 for the increment of the series. 
These choices will cause the series of wells you have selected to be assigned concentrations of 
0.25, 0.5, 0.75, and 1.0 µg/ml, respectively. The choices you have made should look like this: 

 
Series Dialog Box 

Click the [OK] button to close the dialog box and return to the Template Editor. The four sets 
of wells you selected should now be assigned the values entered for the series. You can check 
the concentrations assigned to these wells by pressing and holding the [CTRL]+[Shift] keys. 
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Template with [CTRL]+[Shift] Keys Depressed 

E. The last standards need to be entered manually. Select wells H1 and H2. A new sample 
descriptor is created automatically (St07), so all you need to do is assign a concentration 
value of 1.4 µg/ml to these wells. After entering the value, click the [Assign] box (or press the 
[Tab] or [Return] key) to assign this value to the selected wells. 
The template should look like the one below when you are finished entering the Standards. 
  

 
Template Filled with Blanks and Standards 

F. This tutorial example uses seven separate unknown samples, with each unknown being 
placed in four wells. The unknown samples should be entered on the template as follows: 
"Sa01wells A5 through D5·Sa05wells E7 through H7 

"Sa02wells A6 through D6·Sa06wells A8 through D8 

"Sa03wells E6 through H6·Sa07wells E8 through H8 
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"Sa04wells A7 through D7 

Start by highlighting wells A5 through D5. Select Samples from the Group menu. The 
selected wells will now show the default first sample name for the Samples group, Sa01. The 
template should look like the one below. 
  

 
First Samples Added to the Template 

Continue highlighting the wells as described above, assigning new unknown sample 
descriptors to each subsequent group. When all seven unknown samples have been added to 
the template, it should look like this: 
  

 
Samples Added 

G. This tutorial example uses two controls, with each control being placed in three wells. The 
controls should be entered on the template as follows: 
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"Co01wells A9 through C9·Co02wells D9 through F9 

Start by highlighting wells A9 through C95. Select Controls from the Group menu. The 
selected wells will now show the default first sample name for the Controls group, Co01. Do 
the same for wells D9 through F9, assigning the default second sample name, Co02 to these 
wells. The template should look like the one below. 

 
Controls Added 

H. The last items to be added to the template are samples with dilution. To do this, you will 
need to create a new group. First choose the wells of the template that will contain these 
samples: A11 through G12. Click the Group pull-down menu and choose New... from the 
bottom of the list. This causes a dialog box to appear, allowing you to choose the attributes 
for the new group. Name the group Sam w/dil and choose Unknowns (dilution) for the 
Column Format. This causes a checkmark to appear in the Sample Descriptor box and puts 
Dilution Factor into the text box automatically. To the right of this text box, define the units 
by clicking the arrow next to the drop-down menu and choose µg/ml. The dialog box should 
look like the one below. 

 
Samples with Dilution Added 
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When you click the [OK] button to close the dialog box, the template should look similar to 
the one below. 

 
Samples with Dilution Added 

The samples with dilution need to be changed to be part of a series, however, since we really 
want to include six different samples with replicates. Highlight wells A11 through G12 again 
and click the [Series] button. Leave the default direction from the top down and leave the 
default operator of divided by 1. Enter 10 for the starting dilution. The Series dialog box 
should look like this: 

 
Series Dialog Box for Samples with Dilution 

Clicking [OK] in the Series dialog box causes the template to look like this: 
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Samples with Dilution Made into a Series 

1. The template is now complete. Click the [OK] button to accept the entries and close the 
Template Editor. The outlines of the groups you have defined in the Template Editor will 
now be shown in the Plate section. 

 
The Plate Section Showing Group Boundaries 
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Step 4: Set the Reduction Parameters 
Click the [Reduction] button in the Plate Section Tool Bar to open the Reduction dialog box. 

 
Reduction Dialog Box (Single-Wavelength Endpoint) 

The default reduction settings for a single measurement wavelength, !Lm1, are acceptable and no 
changes are required. For absorbance instruments, make sure the radio button next to Absorbance is 
chosen and that the checkboxes next to next to the options for using a plate blank, etc., are not 
checked. Click [OK] to close the dialog box. 

Step 5: Set the Display Parameters 
Click the [Display] button to open the Display dialog box. 

 
Display Dialog Box 

The default display for Endpoint readings is raw OD for absorbance instruments and raw RFU for 
fluorescence instruments. It is not necessary for the purposes of this tutorial to show a reduced 
number, so make sure the check boxes next to the options under Show are not checked. If you 
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decided later that you would like to view the reduced data, you can change the display options after 
the reading since this does not affect the actual data—only how it appears on the screen and printout. 

Click [OK] to close the dialog box. 

Step 6: Save the File 
Choose Save from the File menu. Because the file has not been saved before and is not named, the 
Save As... dialog box will open. 

 
Save As... Dialog Box Macintosh 

 
Save As... Dialog Box Windows 

On the Macintosh, click the option button next to Protocol File. In Windows, click in the box under 
Save File as Type: and choose Pro Protocol Files (*.ppr). Type the name you are giving to the file in 
the text box (highlighted over Untitled). In this example, type Tutorial. When you have finished 
entering information in this dialog box, click [Save] to save a copy of the protocol file to the hard disk. 
  

� NOTE: The title bar of the window will still show Untitled, rather than Tutorial after saving. This does 
not mean the protocol has not been saved. When you create a protocol file, SoftMax Pro saves a copy of the 
current file under that file name but does not display the name on the screen. Protocol files are saved as 
template files (on the Macintosh, these are known as stationery files). When you open a protocol file, an 
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Untitled window appears, containing all the protocol information saved previously, so that you can 
collect data and save the resulting data file under a different name. 

Congratulations! You have just created a SoftMax Pro protocol file. Now would be the time to read 
the plate and then save the data file. In this tutorial example, however, you will not perform an actual 
plate reading but will use a simulator program built into SoftMax Pro to generate data that you will 
manipulate as if it had been obtained from an actual reading. The same data is also contained in a file 
provided with the original software from Molecular Devices called Endtut.pda. The data in this file 
was generated using the parameters you have just created in this protocol file. 

Step 7: Read the Plate 
If you were reading an actual microplate at this time, you would prepare the microplate as it is 
defined in the Template Editor. (Before an actual reading, you might find it helpful to print a copy of 
the template to assist in properly filling the plate.) You would then place the filled microplate in the 
drawer of the instrument. Since we are using a simulator, you don't need to load anything in the 
instrument. To enable the simulator, hold down the [CTRL] and [Shift] keys and then choose Enable 
Simulator from the extended menu choices that appear in the Control menu (see the figure below). 

 
Extended Choices in the Control Menu 

Now that the simulator is active, click the [Read] button in the SoftMax Pro status bar at the top of the 
screen to initiate the simulated reading. 

Values will appear in the data display in the Plate section as if they were being read by the 
instrument (faster than in real time). (Note that these same values are contained in a file called 
Endtut.pda in the Tutorial folder within the SoftMax Pro folder on your hard drive. If you wish, you 
can open and use the data in that file instead from this point forward.) 

The plate section of either file should look similar to the figure below. 



Chapter 4: Tutorials  

84 SoftMax Pro User’s Manual 

 
Plate Section with Simulated Data (Absorbance instrument example) 

The display for each well that is defined by a group boundary shows a raw value. The reduction 
formula is shown at the bottom of the display: Wavelength Combination: !Lm1. 
 

I. Click the [Display] button in the Plate Section Tool Bar. The Display dialog box will open. 
 

 
Display Dialog Box 

The current display selection is shown as a depressed button (raw values without a reduced 
number). 
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Click the [Reduced] button. The following options will appear: 

 
Display Options for Reduced Displays (Absorbance shown) 

Choose Grayscale from the drop-down menu that appears when you click the Display 
options menu. The dialog box will update to show the low and high limits for grayscale 
display values (which are automatically set to the minimum and maximum data values). 

 
Display Dialog Box Updated with Low and High Limit Settings (Absorbance shown) 

Click [OK]. The dialog box will close, and the data display in the Plate section will update to 
show the data represented by shades of gray as shown below. 
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Plate Display with Data Displayed as Gray Scale (Absorbance shown) 

Step 8: Data Analysis—Group Sections 
Group sections are created automatically by SoftMax Pro when you define groups in the Template 
Editor. In this tutorial, some groups were already created when you started the new file and a new 
one was added when you created the new group, Sam w/dil. The content of Group sections changes 
depending on the wells that are assigned to these groups in the Template Editor. Before a plate is 
read, these sections show no data for the wells. After a reading, Group sections contain information 
about the values for the wells contained within the groups. 

Scroll down until the Standards Group is visible. It should look similar to this: 
  

 
The Group Section for Standards (Absorbance shown) 

The columns in this group are set up as follows, from left to right: 

 Sample: the seven sample names assigned for the Standards group 

 Concentration: the concentrations assigned to each sample in the template 

 BackCalcConc: Returns the curve fit associated with the plot of Standards from the Standard 
Curve against the Values column. 

 Values: raw OD values obtained for each sample 

 MeanValue: the mean of data from the Value column for each sample 
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 StdDev: standard deviation for each sample value 

 CV%: coefficient variation percent for each sample value 

In the following part of this tutorial, you will view formulas associated with columns and summaries, 
resize individual columns, autosize all the columns, add a column, and hide replicates. 

Viewing Formulas. To view the formulas associated with all columns in the Standards Group section, 
hold down the [CTRL]+[Shift] keys while this group is active. A second row will appear beneath the 
column titles, showing the formulas for each column. Depending on the size of the column, all or 
only part of the formula may be shown. 

 
A Portion of the Standard Group Section with Formulas Shown (by Pressing the [CTRL]+[Shift] Keys) 

If column formulas are long, as in this tutorial example, they may not be seen in their entirety in the 
default column size. To see the complete formula for a particular column, click once on a column to 
highlight it. The formula for that column will be shown in the tool bar. 

 
Standards Group Section with Formula Shown for Highlighted Column (BackCalcConc).  

Click the button to modify or change a formula. 

Resize and then Autosize a Column. Position the pointer on the line dividing the columns named 
Concentration and BackCalcConc. The pointer will change to a double-headed arrow. Click and drag 
the line dividing these columns to the right. The figure below shows these actions and the resulting 
wider Concentration column. 
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Sizing the Standard Value Column Wider 

To shrink this column to the minimum size needed to display the complete title, click once in the 
Concentration column to highlight it. Then choose Autosize from the Group menu. The column will 
be reduced in width as shown below. 

� NOTE: Several columns can be Autosized at one time by highlighting (dragging across) multiple columns 
in the Group and then choosing Autosize. 

 
Columns Before and After Autosize 
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Add a Column. The columns that are created by default with various Group sections may not always 
meet all the needs of a particular experiment. You can add a column to any Group section and define 
the purpose of this column in your data analysis. By default, new columns are added to the right of 
any selected (highlighted) column or, if no columns are selected, after the last column in the Group. 

To add a new column to the right side of the Standards Group, make sure this section is active. Then 
deselect any highlighted columns by clicking outside the column area. Click the Create Column 

button ( ) or choose Create Column from the Group menu. A dialog box will open, asking you to 
enter information for the new column. 

 
Calculation Dialog Box 

In this tutorial example, the new column will show the maximum value obtained for each sample. 
Type over the default column name, entering MaxValue in the box next to Name. Now enter 
Max(Values) in the box next to Formula and click [OK]. (Be sure to enter the formula exactly as 
shown.) The dialog box will close and a new column will be shown at the right of the previous 
columns, showing the maximum value obtained for each sample. 

 
New MaxValue Column Appended to Group Section 

View an If Statement in a Column Formula. The Samples section contains a column called Outliers. 
This column is made up of an If statement that calls upon data from another Group section to report 
when data points lie outside the range of the minimum and maximum Standard values. 

An If statement in a formula defines a condition that, if found to be true, causes a certain result and, if 
not true, causes a different result. The basic structure of an If statement is: 

If (condition,result1,result2) 

Lets take a closer look at the individual elements that make up the Outliers formula: 

If(Values>=MinStd@Standards and Values<=MaxStd@Standards,,Outlier) 
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This statement says that, if the data shown in the Values column is greater than or equal to the 
calculation of MinStd found in the Standards group section and less than or equal to the calculation 
of MaxStd found in the Standards Group section, then show nothing (signified by two quotation 
marks with nothing between them); otherwise show the word Outlier. 

Looking at the Standards section, you will not immediately see the MinStd or MaxStd calculations 
used by this If statement. They are there, but their names are hidden. Look at the bottom of the 
Standards section and you will see two summaries as shown in the following figure. 

 
Summaries in the Standards Section 

Double-click the first summary, Smallest standard value:. A Calculation dialog box will appear: 

 
Calculation Dialog Box from Summary in Standards Section 

This dialog box contains a checkbox for Hide Name which is currently enabled. Unchecking the box 
will allow you to view the name of the summary to the left of its text in the Standards section. 

The formulas for MinStd and MaxStd are: 

Min(MeanValue)  Max(MeanValue) 

The MeanValue column is derived from the average of the well values found in the Values column 
(the Standard replicates). The minimum and maximum values from the MeanValue column in the 
Standards Group are used to create the summaries which is what the Outliers column formula uses 
to name its Outliers. Such a formula might be useful in finding points that might be better masked 
(not used in the calculations), for example. 

Basic information regarding formulas and the information they can contain can be found in "Data 
Display and Analysis" (choose the section for absorbance or fluorescence, depending on the 
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instrument you are using). For a complete discussion of writing formulas in SoftMax Pro, as well as 
detailed examples of formulas and customized protocols, see the Formula Reference Guide. 

Hide Replicates. While the Standards section is active, choose Hide Replicates from the Group menu. 
The display before and after hiding replicates is shown below. 

 
Standard Section Before and After Hide Replicates 

More information about modifying group sections can be found in "Data Display and Analysis." 

Step 9: Data Analysis—Standard Curve 
The Default Protocol used to create this tutorial example file contains the predefined groups 
Standards, Samples, and Controls; during the course of this tutorial, you also created a new group 
called Sam w/dil (with dilution). In addition, it contains a Graph section which has been created to 
display a standard curve. 

Scroll down within the SoftMax Pro window until you see the section tool bar for Graph #1. This 
section is closed; click the indicator on the left side of the tool bar to open it. This graph contains a 
single plot as shown below. 
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Standard Curve Graph Section—No Fit Applied 

This graph is set to show concentration on the X-axis and mean value on the Y-axis. If you are 
continuing with simulated data, no fit will have been applied; the Endtut.pdf file has a linear fit 
applied. With simulated data, apply a linear fit by clicking in the menu next to Fit: and choosing 
Linear. Releasing the mouse button causes SoftMax Pro to redraw the graph based on its evaluation 
of the fit of the data to the new curve choice. The figures below show a linear fit followed by a 4-
parameter fit. 

 
Standard Curve Graph Section with Linear and 4-Parameter Fits Applied 

You can also display the data in a bar-graph or another format by clicking the graph options button 

which opens a dialog box like that shown in the following figure. 
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Graph Options Dialog Box 

This dialog box allows you to choose rename the graph, choose the type of graph that will be shown, 
and to format the text used in the graph. You can add or remove plots (click the [New] or [Delete] 
buttons) and you can also edit existing plots. The "Data Display and Analysis" sections provide more 
information regarding the graphing options that are available. 

Step 10:Print a Report 

SoftMax Pro allows you to print your experiment data and results in several different ways. In 
addition to printing a copy of the template, you can print the active section, the sections that have 
been designated to be included in the report, or all sections of an experiment data file. 

The default setting in SoftMax Pro is for all experiment sections to be included in the printed report. 
You can exclude sections from printing; otherwise, choosing Print... from the File menu and choosing 
Print report will print all of the sections that are designated to be included in the report, regardless of 
whether or not they are open. 

A standard Print dialog box will appear. The appearance of this box depends upon the type of 
computer and printer you are using. Select the appropriate settings for your printer and then click 
[Print] or [OK] to print the experiment report. 
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Print Dialog Box Example 

Congratulations! You have successfully completed this tutorial. 
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Tutorial 2: EC 50 Assay Tutorial (FLEX mode only) 
This second tutorial will lead you through the steps required to create and run an EC50 assay 
utilizing a graph of concentration vs. RFU. This tutorial is designed to be used with a FlexStation 
instrument to learn more about using FLEX mode. 

Hard and Soft Parameters 
The only settings that must be defined before reading a microplate are the instrument settings (found 
in the Instrument Setup dialog box). These settings tell the instrument what conditions should be in 
place in order to collect data. They include the read mode (Endpoint, Kinetic, Spectrum, Well Scan, or 
FLEX), the number of wavelengths, specific wavelength settings, and so on. These settings, called 
hard parameters, define the conditions under which the data is obtained. Once a microplate has been 
read, the instrument settings cannot be changed without deleting the data. 

Soft parameters include the template definition and data reduction settings. These parameters can be 
defined prior to reading a microplate, but they are applied only after the plate is read and can be 
changed at any time. 

In this tutorial, you will build a complete protocol (based on the settings found in the Default 
Protocol file) which will include both hard and soft parameters. You will save the completed protocol 
file prior to collecting data (this protocol file could then be used to generate future data files). 

� NOTE: You should ensure that the instrument that is connected to the computer is chosen in the 
Preferences before proceeding: in the Edit menu, choose Preferences. In the dialog box that appears, 
choose your instrument (if it is not already chosen) and then close the dialog box. 

A synopsis of the steps you will take during the tutorial is given below. 

1. Create a new file 

2. Setup and configure your instrument 

3. Design and establish your microplate Template 

4. Set reduction parameters 

5. Set display parameters 

6. Save the protocol 

7. Read the plate (you won't actually do this—instead, open a saved file) 

8. Analyze the data—Graph Concentration vs. RFU 

9. Print the report 
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Assay Example Settings 

Following are the details 
about the EC50 assay 
settings we will use to create 
a protocol file using SoftMax 
Pro. 
 Samples in units/ml: 

0, 0.01, 0.05, 0.5, 1, 5, 10, and 100 
(each standard run in duplicate) 

Curve Fit: 4-Parameter 
Instrument Settings:  
Read Mode: FLEX 
Blanks:  Plate blank run in duplicate 
Automix:  Off 
Autocalibrate: Once 
Wavelengths:  One: Excitation: 485; Emission: 525 
Auto Cutoff: Enabled at 515 
Sensitivity:  3 readings; PMT set to High 
Timing: Time: 200 seconds; Interval: 2 seconds 

Total number of readings: 101 
Minimum interval: 1.28 seconds 

Assay Plate Type:  96 Well Standard clrbtm 
Wells to Read:  A1-H10 
Compound Source: Beckman 96 2.3 mL 
Compound Transfer: None (initial volume 0 µL) 
Triturate: Not Used 
Pipette Tips Layout: Full Rack 
Compound & Tip Columns: None 

 
Define the Protocol 

The following steps will guide you through the process of creating a protocol file for an EC50 assay 
using FLEX mode. Reading an actual plate will not be required—you will run a simulator program to 
create data and also open a saved data file to compare your file setup and results. 

Step 1: Launch SoftMax Pro (Create a New File) 
Double-click the SoftMax Pro icon to start the program. If SoftMax Pro is already running, choose 
New... from the File menu. You should see a new file labeled Untitled. The figure below shows an 
example of the Default Protocol file. 
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Example of a default protocol file  

Default Protocol with Notes Section Open 

The experiment should have a Notes section (Notes #1), followed by a Plate section (Plate#1), one 
group section (Data), and a Graph section (Graph#1) that will be used in this tutorial. For this tutorial, 
you will recreate the settings in this file. To start with a clean slate, you must first delete some of the 
existing sections. Scroll down so that you can see the rest of the sections in the experiment. Hold 
down the [Shift] key and click on the Plate#1, Controls, and Data sections. From the Edit menu, 
choose Delete Selection. A message box will appear, asking you to confirm that you wish to delete 
these sections. Choose Delete and the sections will be removed from the experiment. 

Now you must create a new Plate section. Choose New Plate from the Experiment menu. A new 
section, named Plate#1, will be created. 
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Step 2: Define the Instrument Settings 
Scroll down and click the Plate#1 section to make it active (its tool bar will become gray). Then click 
the [Setup] button in the tool bar to open the Instrument Settings dialog box. Endpoint is selected by 
default. This tutorial uses FLEX mode so you must click the FLEX icon button to select that mode. 

Clicking the setting name (bold heading) on the left side of the Instrument Settings dialog box shows 
the choices available for that setting in the right pane, allowing you to make changes. The table below 
shows the settings that should be chosen for this tutorial example for the FlexStation. Following the 
table are instructions regarding how to choose those specific settings. 
  

 
Wavelengths: 1 Excitation: 485 
Emission: 525 
Auto Cutoff enabled (515) 

Sensitivity: Readings: 3 
PMT: High (default) 

Automix: Automix Before: Off (default); Between: Off (default) 

AutoCalibrate: Once (default) 

Assay Plate Type: 96 Well Standard clrbtm (default) 

Wells to Read: A1-H10 

Compound Source: Beckman 96 2.3 mL (default) 

Compound Transfer: None 

Triturate: Not Used (default) 

Pipette Tips Layout: Full rack (default) 

Compound and Tip Columns: None 
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Wavelengths 
Click the word Wavelengths on the left side of the Instrument Settings dialog box to make it the 
active tab. A black bar will appear over the word and the right side of this dialog box will then show 
the specific settings for the wavelengths selection. If the settings are not correct as shown, click the 
arrow next to the number of wavelengths and choose 1 from the drop-down list; then click the arrow 
next to the wavelength shown and choose the appropriate value(s) for the FlexStation. The figure 
below shows how the Instrument Settings dialog box should appear at this point. 

 
Instrument Settings Dialog Box Showing Wavelengths Settings. 

Sensitivity 
Now check the settings for Sensitivity by clicking that heading on the left side of the dialog box: you 
need to change the default shown on the right side for the number of readings from the default of 6 to 
our setting of 3. The default setting of High for PMT Sensitivity is fine and does not need to be 
changed. 

 
Instrument Settings Dialog Box Showing Sensitivity Settings. 
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Timing 
Check the settings for Timing by clicking the heading on the left side of the dialog box. Enter the 
following data into the text boxes on the right pane: 

 Run Time (secs):  200 

 Interval (secs):  2 

The last two items will change to show the Number of Reads: as 101 and the Minimum Interval: as 
1.28 seconds. When you are finished, the dialog box should look like the one shown below. 

 
Instrument Settings Dialog Box Showing Timing 

Automix 
Check the settings for Automix by clicking the heading on the left side of the dialog box: on the right, 
Automix Before should be set to Off; Between Reads should also be Off. If not, click the appropriate 
checkbox to turn the setting on or off. When you are finished, the dialog box should look like the one 
shown below. 
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Instrument Settings Dialog Box Showing Automix 

AutoCalibrate 
The default setting (Once) is fine and does not need to be changed. 

Assay Plate Type 
The default setting (96 Well Standard clrbtm) is fine and does not need to be changed. 

Wells To Read 
In this Tutorial, we will not be reading all the wells in the plate. Click on the Wells To Read heading 
on the left pane to show the grid of wells on the right. Click in well A1 and drag the mouse cursor 
diagonally to well H10. Columns 1 through 10 should now be highlighted (shown in blue), indicating 
that these wells will be read by the FlexStation. When you are finished highlighting wells, the dialog 
box should appear as shown below. 
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Instrument Settings Dialog Box Showing Wells To Read 

Compound Source 
This setting is used to describe the type of source plate that is used for compound transfers. For this 
tutorial, choose Beckman 96-Well 2.3 mL. When you are finished, the dialog box should appear as 
shown below. 

 
Instrument Settings Dialog Box Showing Compound Source 
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Compound Transfer 
The Compound Transfer settings are used to describe the fluid transfers that will occur during the 
assay. The settings in this portion of the dialog box work in conjunction with those in the Compound 
Source and Compound & Tip Columns settings. 

This tutorial does not make use of compound transfers. Leave this set to "None."  

Triturate 
Trituration is a mixing step that can be set individually for fluids in the compound source plate and 
the assay plate. Trituration is achieved by aspirating and dispensing fluid out of and back into the 
same well of a plate. You can set the volume of fluid to be aspirated, the number of times to perform 
this cycle, and also the height of the pipette tip above the bottom of the well of the assay plate. 

It is not necessary to perform trituration during the Tutorial assay, however, so ensure that neither 
box (for Compound Source or Assay Plate) is checked and proceed to the next item.  

Pipette Tips Layout 

� CAUTION: Molecular Devices recommends that you use a full rack of tips each time you 
perform a transfer of fluid in FLEX mode since this prevents potentially serious errors from 
occurring when partial tip racks are used. For example, if you should mistakenly enable a 
pipetting function from a tip that is not present, or if you enable more or fewer tips than are 
actually available, the instrument can malfunction, potentially causing serious damage. While it 
is possible to use a partial rack of tips and to choose which tips are available in the Pipette Tips 
Layout setting, do so with caution, ensuring that the layout described in the software matches the 
actual tips inserted in the tip drawer. 

This setting allows you to set the location of the pipette tips that will be used for the assay. For this 
tutorial, a full set of tips will be used (the default), so no change in settings is required. 

 
Instrument Settings Dialog Box Pipette Tips Layout (Full Rack Chosen) 
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Compound & Tip Columns 
These settings allow you to define the tips that will be used for the transfer of compounds that are 
also chosen here. However, this tutorial is not making any compound transfers so this setting is not 
used. 

Final Check of Instrument Settings 
Instrument settings are now complete. Verify that your settings agree with those shown below: 

 
Instrument Settings Completed 

Click [OK] to accept the settings and close the dialog box. 
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Step 3: Define the Template 
A. Click the [Template] button in the Plate Section Tool Bar. This will open the Template Editor, 

showing all wells empty. Drag the mouse (or shift-click) to select the first column of wells, 
A1 through H1. The Group pull-down menu on the Template Editor shows Blank as a 
default and the only other choice is New... . Choose New.... to create a new group. In the 
dialog box that appears, enter Data in the highlighted text box to name the new group. Then 
click the drop-down menu in the Column Format section and choose Unknowns (dilution) 
from the list. Doing this will cause a checkmark to appear in the box next to Sample 
Descriptor and automatically enter the word Dilution Factor in the text box below that. The 
dialog box should appear as shown below. 

 
Group Settings Dialog Box for Data Group 

Click [OK] to close the dialog box. The template should now look like the illustration below. 

 
Template with First Samples Entered 

The selected wells should now show the default first sample name for the Data group, 
Data01. The area in the top center of the Template Editor will become active, showing the 
default values for Sample name and Dilution Factor. 
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In this tutorial, the dilution factor for the first column of samples in the Data group should be 
set to 0.0 µg/mL (the default value of 0 is correct). Click the [Assign] key or press the [Return] 
key on the keyboard to ensure that this concentration is assigned to the selected wells in the 
template. You can check the concentrations you have assigned to the template by pressing 
and holding the [CTRL]+[Shift] keys (on either Macintosh or Windows). This causes the 
display to show only group names and values assigned to specific wells. 

B. Now select wells A2 through H2. Data is still showing as the default group name, but a new 
sample descriptor is created automatically (Data02), so all you need to do is assign a dilution 
factor of 0.01 µg/mL to these wells. After entering the value, click the [Assign] box (or press 
the [Return] key) to assign this value to the selected wells. The dialog box should now look 
like the illustration below. 

 
Template showing First Samples (Data) Concentrations 

C. A total of eight samples will be assigned to columns in this template. Continue to highlight 
subsequent columns of wells and enter the following dilution factors: 
 
Column A3 through H4:0.05 
Column A5 through H5:0.5 
Column A6 through H6:1 
Column A7 through H7:5 
Column A8 through H9:10 
Column A10 through H10:100 
 
The template should look like the one below when you are finished entering the samples. 
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Template Filled with Samples 

D. The template is now complete. Click the [OK] button to accept the entries and close the 
Template Editor. The outlines of the groups you have defined in the Template Editor will 
now be shown in the Plate section. 

 
The Plate Section Showing Group Boundaries 
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Step 4: Set the Reduction Parameters 
Click the [Reduction] button in the Plate Section Tool Bar to open the Reduction dialog box. The 
default reduction setting for a single measurement wavelength at the top of the dialog box, !Lm1, is 
acceptable. Beneath this is a choice for Kinetic Reduction. Here, the default choice should be changed. 
Click in the drop-down menu and choose Max - Min as shown in the illustration below. 

 
Reduction Dialog Box 

The other values in this dialog box should be set as follows: 

Limits: 

 Min RFU:0 

 Max RFU:50000 

 Lag Time:0 

 End Time:200 

Display Options: 

 Zero Baseline:3 Pts. 

Smoothing: Moving Average 1 point (no smoothing) 
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Reduction Dialog Box Showing All Values 

Click [OK] to close the dialog box. 

 

Step 5: Set the Display Parameters 
Click the [Display] button to open the Display dialog box. 

 
Display Dialog Box 

The default display for FLEX readings is raw RFU. This tutorial example shows a reduced number, so 
make sure the checkbox under Show is checked. If you decided later that you would like to view 
reduced data, you can change the display options after the reading since this does not affect the 
actual data—only how it appears on the screen and printout. 

Click [OK] to close the dialog box. 
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Step 6: Save the File 
Choose Save from the File menu. 

 
Save As... Dialog Box—Macintosh 

 
Save As... Dialog Box—Windows 

On the Macintosh, choose SoftMax Pro Protocol from the drop-down menu next to Format:. In 
Windows, click in the box under Save File as Type: and choose Pro Protocol Files (*.ppr). Enter the 
name for the file in the text box (highlighted over Untitled): in this example, type My Tutorial. Then 
click [Save] to save a copy of the protocol file on the hard disk. 

� NOTE: While you have successfully saved this experiment data file as “My Tutorial”, the title bar of the 
current window will still show Untitled, rather than My Tutorial after saving. When you create a protocol 
file, SoftMax Pro saves a copy of the current file under that file name but does not display the name on 
the screen. Protocol files are saved as template files (on the Macintosh, these are known as stationery 
files). When you open a protocol file, an Untitled window appears, containing all the protocol 
information saved previously, so that you can collect data and save the resulting data file under a 
different name. 

Congratulations! You have just created a SoftMax Pro protocol file. Now would be the time to read 
the plate and then save the data file. In this tutorial example, however, you will not perform an actual 
plate reading but will open a saved file to simulate the generation of data that you will manipulate as 
if it had been obtained from an actual reading. 
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Step 7: Read the Plate 
If you were reading an actual microplate at this time, you would prepare the microplate as it is 
defined in the Template Editor. (Before an actual reading, you might find it helpful to print a copy of 
the template to assist in properly filling the plate.) You would then place that microplate, along with 
the appropriate compound transfer plate, in the appropriate drawers of the FlexStation. A new set of 
tips would also be loaded in the tip drawer. Since we are using a saved file, it is not necessary to load 
anything in the actual instrument. 

Instead, choose Open from the File menu and navigate to the Tutorial folder. Open the file named 
Tutorial2.pda. The data in this file was generated using the parameters you have just created in this 
protocol file. 

After clicking the [Read] button, values would begin to appear in the data display in the Plate section 
as they were read by the instrument. 

The plate section of the Tutorial2.pda file should look like the figure below. 

 
Plate Section with Data from Saved File 

The display for each well that is defined by a group boundary shows a raw value with a reduced 
number. The wavelength reduction formula is shown at the bottom of the display: Wavelength 
Combination: !Lm1; the kinetic reduction formula is shown at the top of the Plate section: Max - Min. 

Click the [Display] button in the Plate Section Tool Bar. The Display dialog box will open. 
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Display Dialog Box 

The current display selection is shown as a depressed button (raw values with a reduced number). 

Click the [Reduced] button. The following options will appear: 

 
Display Options for Reduced Displays 

Choose Grayscale from the drop-down menu that appears when you click the Display options menu. 
The dialog box will update to show the low and high limits for grayscale display values (which are 
automatically set to the minimum and maximum data values). 
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Display Dialog Box Updated with Low and High Limit Settings 

Click [OK]. The dialog box will close, and the data display in the Plate section will update to show 
the data represented by shades of gray as shown below. 

 
Plate Display with Data Displayed as Gray Scale 
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Step 8: Data Analysis—Group Sections 
Group sections are created automatically by SoftMax Pro when you define groups in the Template 
Editor. In this tutorial, new group sections were added when you created the new groups Data and 
Control. The content of Group sections changes depending on the wells that are assigned to these 
groups in the Template Editor. Before a plate is read, these sections show no data for the wells. After 
a reading, Group sections contain information about the values for the wells contained within the 
groups. 

Scroll down and click the small triangle on the tool bar of the Data Group (it opens and is active). It 
should look similar to this: 
  

 
The Group Section for Data 

The columns in this group are set up as follows, from left to right: 

 Sample: the nine sample names assigned for the Data group 

 Wells: the wells that are assigned to the individual sample names (these correspond to the 
individual columns in the template) 

 Concentration: the concentration assigned to each sample in the template 

 Values: raw RFU values obtained for each sample 

 MeanValue: the mean of data from the Value column for each sample 

 % Activation: sample activation relative to selected control group 

 CV%: coefficient variation percent for each sample value 

A. Viewing Formulas. To view the formulas associated with all columns in the Data Group 
section, hold down the [CTRL]+[Shift] keys while this group is active. A second row will 
appear beneath the column titles, showing the formulas for each column. Depending on the 
size of the column, all or only part of the formula may be shown. 
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A Portion of the Data Group Section with Formulas Shown (by Pressing the [CTRL]+[Shift] Keys) 

If column formulas are long, as in this tutorial example, they may not be seen in their entirety 
in the default column size. To see the complete formula for a particular column, click once on a 
column to highlight it. The formula for that column will be shown in the tool bar. 

 
Data Group Section with Formula Shown for Highlighted Column (% Activation).  

Click the button to modify or change a formula. 

Let's look more closely at the formula for % Activation to see how it works. 

Double-click the % Activation column. A dialog box called Calculation will appear showing 
the formula used to derive the data for this column: 

MeanValue/(Summary#1)*100 

This formula divides the numbers from the MeanValue column by the value of Summary#1, 
and then multiplies the result by 100 to achieve a percentage. Close this dialog box by 
clicking either [OK] or [Cancel] and return to the Data section to continue with the Tutorial. 

B. Resize and then Autosize a Column. Position the pointer on the line dividing the columns 
named Concentration and Values. The pointer will change to a double-headed arrow. Click 
and drag the line dividing these columns to the right. The figure below shows these actions 
and the resulting wider Concentration column. 
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Sizing the Data Groups Concentration Column Wider 

To shrink this column to the minimum size needed to display the complete title, click once in 
the Concentration column to highlight it. Then choose Autosize from the Group menu. The 
column will be reduced in width as shown below. 

� NOTE: Several columns can be Autosized at one time by highlighting (dragging across) multiple columns 
in the Group and then choosing Autosize. 
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Columns Before and After Autosize 

C. Add a Column. The columns that are created by default with various Group sections may 
not always meet all the needs of a particular experiment. You can add a column to any 
Group section and define the purpose of this column in your data analysis. By default, new 
columns are added to the right of any selected (highlighted) column or, if no columns are 
selected, after the last column in the Group. 

To add a new column to the right side of the Standards Group, make sure this section is 
active. Then deselect any highlighted columns by clicking outside the column area. Click the 

Create Column button ( ) or choose Create Column from the Group menu. A dialog box 
will open, asking you to enter information for the new column. 

 
Calculation Dialog Box 
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In this tutorial example, the new column will show the maximum value obtained for each 
sample. Type over the default column name, entering MaxValue in the box next to Name. 
Now enter Max(Values) in the box next to Formula and click [OK]. (Be sure to enter the 
formula exactly as shown.) The dialog box will close and a new column will be shown at the 
right of the previous columns, showing the maximum value obtained for each sample. 

 
  

New MaxValue Column Appended to Group Section 

D. View an If Statement in a Column Formula. 

� NOTE: No conditional statements are used in the FLEX mode tutorial for the EC 50 analysis. To learn 
more about writing an "if statement," you will be asked to open a different data file. 

Open the file named Endtut.pda located in the Tutorial folder. 

The Samples section of this file contains a column called Outliers. This column is made up of 
an If statement that calls upon data from another Group section to report when data points 
lie outside the range of the minimum and maximum Standard values. 

An If statement in a formula defines a condition that, if found to be true, causes a certain 
result and, if not true, causes a different result. The basic structure of an If statement is: 

If (condition,result1,result2) 

Lets take a closer look at the individual elements that make up the Outliers formula: 

If(Values>=MinStd@Standards and Values<=MaxStd@Standards,,Outlier) 

This statement says that, if the data shown in the Values column is greater than or equal to 
the calculation of MinStd found in the Standards group section and less than or equal to the 
calculation of MaxStd found in the Standards Group section, then show nothing (signified by 
two quotation marks with nothing between them); otherwise show the word Outlier. 

Looking at the Standards section, you will not immediately see the MinStd or MaxStd 
calculations used by this If statement. They are there, but their names are hidden. Look at the 
bottom of the Standards section and you will see two summaries as shown in the following 
figure. 
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Summaries in the Standards Section 

Double-click the first summary, Smallest standard value:. A Calculation dialog box will 
appear: 

 
Calculation Dialog Box from Summary in Standards Section 

This dialog box contains a checkbox for Hide Name which is currently enabled. Unchecking 
the box will allow you to view the name of the summary to the left of its text in the Standards 
section. 

The formulas for MinStd and MaxStd are: 

Min(MeanValue)  Max(MeanValue) 

The MeanValue column is derived from the average of the well values found in the Values 
column (the Standard replicates). The minimum and maximum values from the MeanValue 
column in the Standards Group are used to create the summaries which is what the Outliers 
column formula uses to name its Outliers. Such a formula might be useful in finding points 
that might be better masked (not used in the calculations), for example. 

E. Hide Replicates. 

� NOTE: No replicates are used in the FLEX mode tutorial for the EC 50 analysis. To view and learn about 
showing and hiding replicates, you will be asked to open a different data file. 
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F. Open the file named Endtut.pda located in the Tutorial folder. 

Click in the Standards section to make it active. Choose Hide Replicates from the Group 
menu. The display before and after hiding replicates is shown below. 

 
Standard Section Before and After Hide Replicates 

Close the Endtut.pda file and return to the FLEX tutorial data file you opened earlier. 
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Step 9: Data Analysis—Graph 
Scroll down within the SoftMax Pro window until you see the section tool bar for Graph #1. If this 
section is closed, click the triangle indicator on the left side of the tool bar to open it. This graph 
contains a single plot as shown below. 

 
Graph Section4-Paramter Fit Applied 

This graph is set to show concentration on the X-axis and % Activation on the Y-axis. A 4-Parameter 
curve fit has been applied. You can apply other fits by selecting one in the menu next to Fit:. 
Releasing the mouse button causes SoftMax Pro to redraw the graph based on its evaluation of the fit 
of the data to the new curve choice. 

You can also display the data in a bar graph or another format by clicking the graph options button 

 which opens a dialog box like that shown in the following figure. 

 
Graph Options Dialog Box 
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This dialog box allows you to choose rename the graph, choose the type of graph that will be shown, 
and to format the text used in the graph. You can add or remove plots (click the [New] or [Delete] 
buttons) and you can also edit existing plots.  

In this example, choose the option for Cluster bar and then click [OK]. The resulting graph should 
look similar to the one below: 

 
Cluster Bar Graph Displayed 

Step 10: Data Analysis—Summary Formula 
Scroll down to the bottom of the Data Group section. Shown there in large format type is a summary 
that states: Summary #1 = EC 50% 0.03101. Click this summary to highlight it. If you look up in the 
gray tool bar at the top of the window, you will see the formula used to create this summary is shown 
there: Summary #1 : InterpX(Plot#1@Graph#1,50). Lets examine this formula further to understand 
how it was derived. 

Formulas can be simple or quite complex and are composed of elements that perform mathematical 
operations, statistical analysis functions, and/or refer to other elements contained within SoftMax Pro. 
Complete information about the possible choices for creating formulas can be found in the Formula 
Reference Guide. 

The formula from the Summary in the Data section of this Tutorial file uses a function, InterpX, 
which interpolates data from the curve fit in the Graph section. The InterpX function returns the X 
values of the specified plot interpolated using the Y values and curve fit. The complete formula is 
written in this manner: InterpX(Plot@Graph,Yvalues). In this particular summary formula, 
Plot#1@Graph#1  describes the plot from which the data is derived. Yvalues in this example is 50 
which describes the number to be interpolated. So, looking at the graph, the Y-value at 50% activation 
appears at an approximate concentration of 0.031. 
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Detail from Graph Section Showing 50% Location on Plot 

A summary formula is created by either clicking the summary button in the tool bar or choosing 
Create Summary from the Group menu. A Calculation dialog box opens, allowing you to enter the 
formula for the summary and to set the options for how the summary is displayed. 

The same Calculation dialog box appears when you edit an existing formula. Double-click the 
summary at the bottom of the Data section (just above the Graph section). The Calculation dialog box 
that appears should look like the one below: 

 
Calculation Dialog Box for EC 50 Summary Formula 

If you wanted to interpolate a value at a different percentage, you could enter a different number at 
the end of the formula in place of the 50 there. You could also reverse the formula to show the 
percent activation that is interpolated for a certain concentration (0.1 in this example) by writing the 
formula this way: 

InterpY(Plot#1@Graph#1,0.1) 

The result would be: 69.494 (to three decimal places). The summary can be shown with different 
accuracy (up to nine decimal places, if desired) by changing the number in the box next to Decimal 
Places: at the bottom of the box. 
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Step 11: Print a Report 
SoftMax Pro allows you to print several types of information. In addition to printing a copy of the 
template, you can print the active section, the sections that have been designated to be included in the 
report, or all sections. 

The default setting in SoftMax Pro is for all sections to be included in the report. You can exclude 
sections from printing as described in File Management and Printing. Otherwise, choosing Print... 
from the File menu and choosing Print report will print all of the sections that are designated to be 
included in the report, regardless of whether or not they are open. 

A standard Print dialog box will appear (the appearance of this box depends upon the type of 
computer and printer you are using). Select the appropriate settings for your printer and then click 
[Print] or [OK]. 

 
Print Dialog Box for Macintosh 

 
Print Dialog Box for Windows 

Congratulations! You have successfully completed this tutorial. 
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Data Collection: EMax, VMax, UVMax, ThermoMax, VersaMax 

Introduction to Data Collection 
Data Collection using SoftMax Pro is a three-part process: 

1. Prepare SoftMax Pro to collect data; 

2. Prepare and load the microplate(s) to be read; and 

3. Read the microplate(s). 

Before reading a microplate, you must create the Plate section(s) and define the instrument settings 
for the reading. Instrument Settings must be defined prior to collecting data and may NOT be 
changed after data is collected. In addition, it is recommended that you define a template and set the 
reduction and display parameters prior to reading the microplate, since these parameters determine 
how data is displayed and analyzed, but these last parameters may be set up and/or modified after 
data collection. 

A typical process for preparing, collecting, and analyzing data is as follows: 

1. Launch SoftMax Pro software. 

2. Create Plate section(s) as needed. 

3. Define the Instrument Setup settings from the Control menu. 

4. Define the template, reduction parameters, and display parameters. 

5. Prepare the microplate(s) to be read and place them in the instrument. 

6. Initiate the reading. 

7. Save the data file. 

8. Modify the template, reduction parameters, or display parameters (optional). 

9. Analyze the data using the Group section tables and Graph sections. 

10. Save the data file again when you are finished. 
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Instrument Settings 

� NOTE: Not all instrument settings are available with all instruments. Only the settings that pertain to the 
instrument that is connected to the computer or the one chosen in the Preferences will be shown in the 
Instrument Settings dialog box. 

You must specify the instrument settings prior to reading a microplate. Settings for the reading are 
made in the Instrument Settings dialog box, which can be accessed in three ways: 

1. Choose Instrument Setup... from the Control menu; 

2. Click the [Setup] button in the tool bar of the active, expanded Plate section; or 

3. Double-click anywhere in the settings box (located to the right of the well grid) in the 
active, expanded Plate section. 

� NOTE: You may create more than one Plate section in a single experiment, and the instrument settings 
associated with each Plate section can be different. Instrument Setup... can only be chosen while a Plate 
section is active, and the settings you choose will affect only that section. A new Plate section that is 
created in an experiment that contains an active Plate section will contain the same instrument settings 
found in the previously active section. The settings for the new section can be modified as desired. 

When you have defined the instrument settings, click the [OK] button to close the Instrument Settings 
dialog box. After closing, a summary of the instrument settings will appear in the box to the right of 
the data display in the Plate section. The instrument will use these settings to read the plate. 

Instrument Settings Chart 
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� NOTE: Incubator control is an instrument setup parameter that is not found in the Instrument Settings 
dialog box. 
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Read Mode 
Endpoint 

A single reading of the microplate taken at a single or multiple wavelength(s). Values reported are 
optical density or %Transmittance (if this has been selected in the Reduction dialog box). The default 
reduced values are !Lm1 (or !Lm2-!Lm6, depending upon whether or not multiple wavelengths were 
chosen) and !Pathlength. 

 

 
Endpoint instrument settings with all options shown 
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Kinetic 

Data is collected over time with multiple readings taken at regular intervals. The default reduced 
values calculated for Kinetic data are Vmax (mOD/min), Time to Vmax (seconds), Onset Time 
(seconds), Time at Minimum, Time at Maximum, Time at 1/2 Maximum, Slope, and Area Under 
Curve. 

 
Kinetic instrument settings with all options shown 

Timing—When Kinetic mode is chosen, the Timing parameter is active, allowing you to enter the 
total Kinetic run time and the time interval between readings.  

After entering a total run time and an interval between readings, the total number of readings that 
will result is shown below the run time. The minimum read interval is determined by which 
instrument is connected to the computer or, if no instrument is connected, by which instrument has 
been chosen in the Reader section of the Preferences dialog box and the particular settings chosen for 
that instrument. The minimum interval depends on the number of wavelengths, the Automix status, 
the number of strips, and the distance the filter wheel of the instrument must move. The minimum 
interval for VMax, UVMax, and ThermoMax instruments depends on the number of wavelengths 
and the Automix status. If you set the interval time to be shorter than the instrument’s minimum read 
interval, the program will alert you with a message. Additionally, with VersaMax instruments, an 
interval that is too short will cause a warning message to appear telling you that no calibration can 
occur between reads. 
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� NOTE: If you are writing a protocol that will be used with a different instrument (other than the one 
connected to the computer or chosen in the Reader preferences), you can disregard the alert and save the 
setup. However, if you attempt a reading using a protocol which has settings that are not correct for the 
particular instrument you are using, an error message will instruct you to change any setting that is out 
of range before a reading can be initiated. 

� NOTE: To achieve the shortest possible interval for Kinetic readings, choose wavelengths in ascending 
order. 

Wavelengths 
For Endpoint or Kinetic Readings 

Choose whether to read at one or two wavelengths. At least one wavelength must always be 
specified. Selecting two wavelengths will cause two wavelength setting boxes to appear. 

 
Wavelength Settings 

The wavelengths specified previously (or the defaults) will be shown in the boxes. You can choose a 
wavelength from the choices in the pull-down menu or simply type any wavelength (within the 
available range of the instrument) over an existing setting. The pull-down menu will show only 
common monochromator settings. 

Automix 
The Automix function is a patented feature that allows you to set automated shaking of the 
microplate. The options available for Automix depend on the read mode chosen and the type of 
instrument connected or chosen in the Preferences. 

 
Left: Endpoint Mode; Right: Kinetic Mode 

Before First Read 

This setting can be used with any read mode. Click the checkbox next to “Before First Read” to shake 
the microplate automatically for five seconds prior to the first reading. Whether you read at a single 
wavelength or at multiple wavelengths, enabling Automix for “Before First Read” will shake the 
plate for the set amount of time before the first wavelength reading only. You can accept the default value 
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shown for the amount of time to shake the plate or enter a different value (up to 999 seconds) in the 
box to the right.  

Between Reads 

This option is applicable only to Kinetic readings and is displayed only when Kinetic mode is 
selected. To enable automatic mixing of the microplate between readings during a Kinetic assay, click 
the checkbox next to this setting. For readings at a single wavelength, “Between Reads” will shake the 
plate for the set amount of time prior to each reading at that wavelength. For readings at multiple 
wavelengths, enabling “Between Reads” will shake the plate for the set amount of time before each 
reading at the first wavelength only. You can accept the default value shown for the amount of time 
to shake the plate or enter a different value (up to 999 seconds) in the box to the right. 

Wells to Read/Strips Selection  
You may choose to read only certain wells or columns (or strips) of wells in the microplate or to read 
the entire plate. Partial-plate reading is available for all reading modes, although it is most useful for 
fast Kinetic analyses. The time required for Kinetic readings may be significantly reduced using this 
setting since the instrument does not have to read the entire plate.  

To enable a partial-plate read, highlight the desired columns (see the figure below). Columns do not 
need to start with “1” but must be contiguous. 
  

 
Wells to read/Strips selection 

If you enable a partial-plate reading, only the wells to be read will be visible in the data display, 
indicating that no data will be collected for the other wells (all wells will be present in the Template 
Editor, however). 

AutoCalibrate 
This checkbox allows you to disable or enable automatic calibration for all instruments. The default 
setting is checked (enabled). Turning AutoCalibrate off allows the instrument to complete readings 
more quickly or to begin the first reading of a Kinetic plate faster. However, you should allow the 
instrument to perform autocalibration of at least one plate prior to disabling this function: calibration 
settings for the last plate which included an autocalibration are maintained in the instrument 
memory (NVRAM) until another autocalibration is performed. 
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AutoRead 
This feature enables the automatic reading of subsequent Plate sections in the order in which they 
appear within an experiment. By entering a value in the “Delay” text field, you can set the delay time 
interval between the plate reads. 

Blanking (Pre-Read Plate) 
The blanking selection found in the Instrument Settings dialog box is known as pre-read plate blanking, 
but pre-reading the plate is only one of five types of blanking available in SoftMax Pro. 
Understanding the differences between the types of blanking functions will enable you to choose the 
type of blanking that is appropriate for your assay. Note that blanks can be used in combination and 
have cumulative effects.  

If pre-read plate blanking is chosen, SoftMax Pro will prompt you to first read the blank plate after 
you click the [Read] button. 

 
Automix and Blanking 

The pre-read values will be stored in the data file and the individual well values collected during the pre-
reading of the plate will be subtracted from the individual well values obtained during the actual reading of 
samples. This is particularly useful for readings in the UV. Pre-read blanking may be turned off in the 
Reduction dialog box (click on the [Reduction] button) so the data may be seen with and without pre-
read blanking subtracted. This option is only available within the Reduction dialog box if pre-read 
blanking was chosen in the instrument setup. 

The purpose of pre-read plate blanks is to correct for well-to-well variability. Pre-read blanking is 
available for all read modes but is most useful for Endpoint readings. If pre-read is selected using 
Kinetic mode (not generally recommended), a pre-read with the same Kinetic read interval and 
duration as the “normal” reading will be done and the ODs at each time point of the pre-read will be 
subtracted from the OD of the corresponding time point of the “normal” reading. 

� NOTE: Molecular Devices recommends that the wells of the pre-read plate be filled with the appropriate 
buffer for the assay or with water when performing pathlength correction. 

Template Editor 
The Template Editor is available for Plate sections. In both cases, it is used to describe the location of 
samples, either in the wells of the microplate, providing the link between the raw data and the 
analysis groups. The Template Editor is used to create a template which provides SoftMax Pro with a 
map of what is in the microplates. 

When you first open the Template Editor for a new Plate section, the grid or display is empty. After 
selecting wells, you can assign groups, and indicate the type of samples they will contain. 
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Depending upon the default protocol you are using, certain group names (and associated sample 
descriptions) may have been created. You can use these predefined groups and/or create new groups 
to suit your needs. When creating new groups, you may enter any name you wish. Once entered, this 
name will be available for use in that experiment thereafter. New groups can be created 
independently from selecting or assigning any wells in the Template Editor. 

Each well designated as being part of a group has associated with it a group name, a sample name (or 
replicate ID), a sample descriptor (optional), and a default column format (group type, such as 
Standards, for example). When a group is applied to selected wells, the group name is displayed in 
bold type over the wells and the wells bear the same color. 

  

Template Editor features explanation 

Groups are always visible, both in the Template and in the data display of the Plate section. Even 
though they are grouped, single wells are still selectable in either the Template Editor or the data 
display. 

Samples and groups may exist across multiple Plate sections as well as within a single Plate section. 

Each template is built upon a hierarchy as follows: the template is composed of samples and groups. 
A set of one or more replicate wells makes up a sample. A set of related samples forms a group. For 
example, you may have a group named Standards that consists of seven samples named STD01, 
STD02 ... STD07. Group names may be up to 32 characters long, while sample names may be 300+ 
characters long. Samples may be assigned one at a time using the [Assign] button or several at the 
same time using the [Series] button. 

If you create a group in the Template Editor but do not assign any wells to the group, a section for 
that group will still be created automatically when you close the template. You can remove the group 
(both its section in the window and its group name in the template) by making that Group section 
active and choosing Delete Groupname (where “Groupname” is the name assigned to that group in 
the template) from the Edit menu. Using the Macintosh, you can also delete the selected Group by 
pressing –; within Windows, you can press [CTRL]+[–]. Note that deleting the wells assigned to a 
group from the template does not delete the corresponding Group name from the drop-down list. The 
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only way to remove a group name from this list in the Template Editor is to delete the corresponding 
Group section from the experiment. 

Selecting Wells in the Template Editor 
In the Template Editor for a Plate section, you can select one or more wells by clicking or dragging on 
the grid. Multiple (contiguous) wells can be selected by dragging across them. Non-contiguous 
selections can be made by holding down the [Shift] key and clicking individual wells. Clicking a row 
label will select the entire row; clicking a column label will select the entire column. Contiguous 
columns or rows (1-12 or A-H, for a 96-well plate, for example) can also be selected by dragging. 
Non-contiguous columns or rows can be selected by holding the  (command) key on the Macintosh 
or the [CTRL] key in Windows and clicking in labels. 

 Double-clicking anywhere within a group will select the entire group. 

 To deselect all wells quickly, click in the empty border around the Template. 

 When you leave the Template Editor (by clicking the [OK] button), the Plate section will show 
the boundaries of the groups created in the template. Group labels and sample descriptors will 
not be visible—you can see them by holding down the [CTRL]+[Shift] keys. When you release 
the key(s), the original view of the Plate section will return.  

Template Editor Tool Bar 
The tool bar will appear differently depending upon what type of group is selected in the Group 
drop-down list. The following illustration shows how the tool bar will appear under various 
circumstances. 

 
The tool bar 

The tool bar is divided into three areas: the Group area, the Sample area, and the Assign area. 

The Group Area 

The Group area contains the Group drop-down list which allows you to assign wells to existing 
groups, create new groups, or modify (using the [Edit] button) existing groups. In addition, it 
contains the [Clear] button which allows you to clear well assignments in the template. 



 Chapter 5: Data Collection: EMax, VMax, UVMax, ThermoMax, VersaMax 

SoftMax Pro User’s Manual  137 

Group Drop-Down List 

This drop-down list consists of two areas, divided by a horizontal gray line. The two items below the 
gray line (Blank and New) are always available. Items above the gray line are custom groups that 
may be created as you wish. 

The Group drop-down list will appear differently depending upon the custom groups that have been 
created (by default or by the user). The figure below shows two different instances of the appearance 
of the Group list. 

 
The Group Area 

� NOTE: Depending on the default template used when opening SoftMax Pro, initially no groups may 
appear above the gray line. As you create new groups, they will be positioned above the line. 

 Blank—Creates a plate blank in the active section. Note: the name “blank” is reserved for use by 
the SoftMax Pro program and should not be used when creating custom groups. 

 New—Creates a new group. The Group Settings dialog box will appear (see the image below) 
showing default settings. This dialog box allows you to define the name for a group of related 
samples, what type of descriptor will be associated with these samples, and the initial column 
format for the Group section. Whenever a new group is created (whether or not wells are 
selected in the template), a Group section (table) will also be created. To delete a group, you 
must delete the Group section. Simply clearing a group from the Template Editor will remove 
the assignment of wells to that group name, but the name will still show in the group pull-down 
menu and the Group section will still exist. 

 
Group Settings 
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Name: Use either the default name, “Group#X,” where “X” is an integer that is initially set to “1” and 
increments (i.e., “1,” “2,” “3,” etc.) as other groups are created, or enter a custom name (up to 32 
characters in length). 

In the Sample Descriptor area of the Group Settings dialog box, you can enable the application of the 
sample descriptor, if appropriate by clicking the checkbox. You may also choose the units used for 
the sample descriptor by selecting an option from the Units drop-down list or by typing the units you 
wish to use into the list box. 

The Sample Descriptor is automatically enabled when either the Standards or Unknowns(Dilution) 
column format (see below) is selected. The descriptor defaults to Concentration with the Standards 
column format and to Dilution with the Unknowns(Dilution) column format. The Sample Descriptor 
may also be used for time or fraction number information. 

� NOTE: No sample descriptor is assigned automatically for the Basic or Unknowns column format. You 
may assign a sample descriptor to these column formats manually but, if you choose to do this, the 
information will not appear automatically in the Group section. To see it, you will need to create a new 
column containing the formula !Sampledescriptor. For more information about creating columns, see 
“Adding Columns”. 

Column Format defines the default column types that will be created for a new group or shows the 
original column format setting that was used to create the group you are editing. 

Four selections are offered: Basic, Standard, Unknowns, and Unknowns (Dilution). Different types of 
columns will be created for a new group, or changed in an existing group, depending on which of 
these column format settings you select. The table below shows the default columns created with 
each selection type. 
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Columns Created and Their Formulas 

 Basic Standard Unknown Unknown(Dilution) 

Name Sample Sample Sample Sample 

Formula !SampleNames !SampleNames !SampleNames !SampleNames 

Name Wells Wells Wells Wells 

Formula !WellIDs !WellIDs !WellIDs !WellIDs 

Name Sample# Concentration Values Values 

Formula Index !Concentration* !WellValues !WellValues 

Name Values Values 
R (Outside Standard 
Range) 

R (Outside Standard 
Range) 

Formula !WellValues !WellValues 

If(Values)>=‘MinStd@ 
Standards’ and  
Values<=‘MaxStd@Standar
ds’,“”,“R” 

If(Values)>=‘MinStd@ 
Standards’ and Values<=
‘MaxStd@Standards’, 
“”,“R” 

Name Mean Value MeanValue Result Result 

Formula Average(Values) Average(Values) 
InterpX(STD@ 
StandardCurve,Values) 

InterpX(STD@ 
StandardCurve,Values) 

Name Std.Dev. MeanResult MeanResult 

Formula Stdev(Values) Average(Result) Average(Result) 

Name CV% Std.Dev. Std.Dev. 

Formula Cv(Values) Stdev(Result) Stdev(Result) 

Name CV% CV% 

Formula Cv(Result) Cv(Result) 

Name Dilution 

Formula !Factor* 

Name Adj.Result 

Formula 

 

 

 

MeanResult*!Factor 
 

* !Concentration and !Factor are from SoftMax Pro version 1.x. !Concentration, !Factor, and 
!SampleDescriptor return identical information. 
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The [Edit] Button 

When you click the [Edit] button, the Group Settings dialog box will appear, reflecting the settings for 
the active group (currently visible in the group drop-down list). If you wish to edit a group that is not 
currently active, first choose the group from the drop-down list and then click the [Edit] button. The 
figure below shows the Group Settings dialog box for the active group called “Patient#1.”  

 
Group settings with all options shown 

The name, sample descriptors, and column format can be changed for the group that you are editing. 

When you edit a group, you will notice that the information shown for the Column Format in the 
Group Settings dialog box changes to show the name of the original group used to define the group 
columns (see the figure below). 

 
Group settings options 

� CAUTION: Changing the column format will cause the columns in the group to revert to their 
original defaults as shown in the table above. If you have added columns or changed column 
information within the existing section for the group you are editing, these changes will be 
removed. 



 Chapter 5: Data Collection: EMax, VMax, UVMax, ThermoMax, VersaMax 

SoftMax Pro User’s Manual  141 

The [Clear] Button 

Allows you to deselect, or clear the selected items. Highlight what you wish to clear and then click 
the [Clear] button. 

The Sample Area 

The Sample area contains the Sample drop-down list and sample descriptor values (active if defined 
in the Group Settings dialog box or if assigned automatically by SoftMax Pro). 
  

 

� CAUTION: When changing sample names or descriptors, be sure all wells  are replicates of the 
same sample and group or that you want them to become replicates of the same sample and 
group. SoftMax Pro does not prohibit selecting individual wells from different samples and/or 
groups, for example, and changing their descriptions—and they will change to become the same. 

Sample Drop-Down List 

The sample drop-down list consists of two areas divided by a horizontal gray line. Before other 
sample names have been defined, a single, pre-defined name (“BL”) appears below the gray line (the 
sample name “BL” is the name reserved by SoftMax Pro for group-associated blanks). The item above 
the gray line is the sample ready to be or currently being assigned. After being assigned, it will be 
shown below “BL” below the gray line. 

 
When this list first appears, the only selection shown below the dividing line is “BL”; the active 
sample name that is ready to be assigned appears above the line. 

When samples are assigned to a group, the default name is the first 3 letters of the group name 
followed by a number. For a group called “Standard,” for example, the default sample names would 
be Sta01, Sta02, Sta03, and so on. Sample names can be 300+ characters long; however, only the first 
five or six characters will be displayed in the template and in the Plate section. 

� NOTE: You can type a sample name directly into the box next to the arrow for the drop-down list by 
highlighting and typing over the existing sample name. If one or more wells were highlighted, typing a 
different name will replace the sample name shown in the template with the name you have typed and, if 
the name is new, will add this name to those that can be chosen in the drop-down list. 

When wells have been selected in the template and sample names have been defined, the sample 
menu will look like the one below. The checkmark indicates the sample that is currently being 
named. 

 
Sample Drop-Down List—Sample Names Defined and Wells Selected 
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Sample Descriptor Field 

The field associated with the sample descriptor only appears in the Template Editor tool bar if the 
group column type that has been selected requires this type of information. Generally the information 
entered in this field is a dilution or concentration. Position the cursor in this field and enter a number. 
The label and units assigned to the sample descriptor in the Group Settings dialog box are shown on 
either side of the field. 

Assign Area 

The Assign area contains the [Series] and [Assign] buttons. 

 
Assign Area of the Template Editor Tool Bar 

Assign Button and Function 

Click this button to apply a sample name to one or more wells that have been selected in the 
template. You may also perform this operation by using the [Enter] key on your keyboard. 

Series Button and Function 

This button is used to define several samples as a series, allowing you to easily enter incremental 
sample descriptors (for example, dilutions or concentrations) and sample names to the template as 
long as the increment can be expressed as a mathematical operation.  

Replicate Samples and Samples in a Series 

You can assign the same group or sample definition (same sample name and description within a 
group) to multiple wells to create replicates. For example, you might want to read standards in 
replicate to ensure that anomalies can be excluded prior to generating a standard curve. Replicates 
can be created using the [Assign] button or with the series function. 

Creating a series is faster than assigning replicates individually. The series option can be used as long 
as the replicate values conform to a pattern that can be described by a mathematical operator 
(multiply by 2 or add 5, for example). 

A series is defined in one direction (starting from left, right, top, or bottom) and therefore samples 
must be arranged sequentially in either ascending or descending order. 

To create a series, do the following: 

1. In the Template Editor, highlight the wells to be part of the series. The wells must be in the 
shape of a rectangle. 

 
Template with Wells Selected for a Series 
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2. Click the [Series] button to open the Series dialog box. 

 
Series Dialog Box 

3. Specify the name of the first sample in the series in the box (or accept the default provided by 
SoftMax Pro). Subsequent replicates use this name as a base and either increment the number 
within the name or append a number to it. In the example above, the sample name provided 
by SoftMax Pro describes the first sample (“01”) in a group named “Standard,” here 
shortened to “Sta.” 

4.  The information shown in the box labeled Sample Descriptor is derived from the 
information entered in the Group Settings dialog box. If the information for sample 
descriptor or units is not correct, you may change it here. If you did not already do so, 
specify the starting value for the first sample in the series. Values for subsequent samples are 
calculated from this starting value. 

5. Choose the operator for the series (+, -, *, or /) from the Step by: drop-down list. Enter the 
starting value for the series in the Starting value: box. The increment is entered in the box to 
the right of the Step by: box and below the Starting value: box. The figure above shows a 
starting value of “0.5” with the operator being division (“/”) and the increment being “2.” 
Thus the series will start with a value of “.5” and divide each subsequent sample by 2 to 
produce the following series values: .5, .25, .125, etc. 

6. You must assign a fill direction (from the top, bottom, left, or right—to describe how the 
series will fill the wells) and a number of replicates. Various options are diagrammed in the 
figure below using a 4 x 4 block of wells (for more information about replicates, see Replicate 
Samples and Samples in a Series, above). The maximum number of replicates depends on the 
selection of wells: if you are filling down from the top, for example, and you have chosen a 
block of wells that is 4 wells wide by 8 wells high, the maximum number of replicates will be 
four; with the same block of wells selected, filling from the left would allow eight replicates. 
If the number of replicates you choose does not divide evenly into the number of rows or 
columns you select, depending on the filling direction, the remaining wells that cannot 
contain replicates will be labeled as additional individual wells in the series. For example, if 
you fill a block of 4 x 4 wells from the top, and choose three replicates, then the first three 
columns will contain the replicates and the last column will contain the additional wells in 
the series (see the last diagram in the figure below). This replicate feature allows you to 
quickly define the number of replicates and, in cases where the series has more samples than 
a single row or column, to name them simultaneously. To create a series with all 96 samples, 
highlight all the wells in the plate, select the fill direction, and set the replicates to 1. 
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Fill Options and Replicate Settings 

7. Click [OK] to save the series and close the dialog box. While still in the Template Editor, you 
can view the value assigned to any well by clicking that well. The value will be displayed at 
the top of the Template Editor. Holding down the [CTRL]+[Shift] keys will display the values 
for all wells. 

� NOTE: Sometimes you may wish the names of a series of samples to increment but may not have a 
concentration or dilution factor that you wish to enter, or you want the concentration or dilution factor to 
remain constant. This can be done using the [Series] button, setting the starting value to 1 or another 
constant value, and either multiplying by 1 or dividing by 1. In this way, the names will increment but 
the value of concentration or dilution will not change. If you don’t have a concentration or dilution factor, 
simply deselect the sample descriptor checkbox if it is selected. 

� NOTE: If sample names are set to increment automatically using the Series function, be aware that 
SoftMax Pro will automatically truncate the sample name to three or four characters, including the 
incrementing number if the sample name starts with letters. If the sample name is entirely numeric, it will 
not be truncated. If sample names are very long, and they must be kept long for reference, you will have 
to set up your replicates manually and will not be able to use the series function. 

Blanking 
In addition to the pre-read plate blanking selection found in the Instrument Settings dialog box, four 
more types of blanking are available in SoftMax Pro. Understanding the differences between the 
types of blanking functions will enable you to choose the type of blanking that is appropriate for your 
assay. Note that blanks can be used in combination and have cumulative effects. 

The five types of blanking that are defined in SoftMax Pro are: 

Plate Blanks 

Wells can be assigned to a “Blank” group in the Template Editor. Unlike pre-read plate blanks, the 
average value of all the wells in a plate blank group is subtracted from all individual well values obtained 
during the reading of microplates. Plate Blank subtraction may be turned off in the Reduction dialog 
box so that the data may be seen with or without plate blank subtraction. 
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� NOTE: Plate blanks are only subtracted from wells on the same plate to which they are assigned. The 
checkbox for Plate Blank subtraction only appears in the Reduction dialog box after data has been 
collected. 

For Kinetic data, the blank value is averaged and subtracted on a point-by-point basis. The example 
below shows a graphic representation of original and average plate blank data, followed by the 
resulting data with average subtracted. 

 
Graphic representation of original and average plate blank data 

Group-Associated Blanks 

Blank wells can be assigned within any group (other than the “Blank” group) in the Template Editor. 
The average reduced value of the blank wells within that group will be subtracted from individual reduced 
values within that group only. This blanking function uses the reduced number (example: !Lm1-!Lm2, 
Vmax, etc.) only—it does not subtract on a point-by-point basis. When a group blank has been 
assigned, it is automatically subtracted. To see the reduced number without the group blank 
subtracted, mask the group blank wells. 

Group blanks apply to all wells in a group and thus may be subtracted from wells in more than one 
Plate section. 

Blanking (Pre-Read Plate) 

The blanking selection found in the Instrument Settings dialog box is known as pre-read plate blanking, 
but pre-reading the plate is only one of five types of blanking available in SoftMax Pro. 
Understanding the differences between the types of blanking functions will enable you to choose the 
type of blanking that is appropriate for your assay. Note that blanks can be used in combination and 
have cumulative effects.  

If pre-read plate blanking is chosen, SoftMax Pro will prompt you to first read the blank plate after 
you click the [Read] button. 
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Automix and Blanking 

The pre-read values will be stored in the data file and the individual well values collected during the pre-
reading of the plate will be subtracted from the individual well values obtained during the actual reading of 
samples. This is particularly useful for readings in the UV. Pre-read blanking may be turned off in the 
Reduction dialog box (click on the [Reduction] button) so the data may be seen with and without pre-
read blanking subtracted. This option is only available within the Reduction dialog box if pre-read 
blanking was chosen in the instrument setup. 

The purpose of pre-read plate blanks is to correct for well-to-well variability and, in the case of 
PathCheck, to subtract plate background before applying pathlength correction. 

� NOTE: A background constant subtraction setting is also available for instruments capable of using 
PathCheck (in the Instrument Settings > PathCheck option). If you pre-read a plate, you should not use a 
background constant subtraction and vice versa. 

Pre-read blanking is available for all read modes but is most useful for Endpoint readings. If pre-read 
is selected using Kinetic mode (not generally recommended), a pre-read with the same Kinetic read 
interval and duration as the “normal” reading will be done and the ODs at each time point of the pre-
read will be subtracted from the OD of the corresponding time point of the “normal” reading. 

� NOTE: Molecular Devices recommends that the wells of the pre-read plate be filled with the appropriate 
buffer for the assay or with water when performing pathlength correction. 

Blanks in Combination 

It is possible to use blanking functions in combination. You could perform a pre-read plate blanking, 
assign a blank group in the template, and also include blank wells within different groups. The 
effects of the different blanking functions are cumulative, so it is important to understand the function 
of each before using more than one type of blanking in a single assay. Pre-read blanking, plate 
blanking, Ref, and template blanking are applied to the raw data acquired from the instrument, 
whereas group blanks are applied to the reduced number. Group blank subtraction is only visible in 
the Plate section when the reduced number is displayed. The figure below shows the last two types of 
blanks in the Template Editor. 
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Blanks in combination 

In the figure above, note that the plate blank in the upper left appears as a separate group named 
“Blank” and individual samples within this group are named “BL.” The group-associated blank 
wells, shown in the upper right, are not a separate group—the samples, also named “BL,” are 
contained within the boundaries of the large group called “Unknowns” and are the same color as that 
group. 

� NOTE: In order to save changes you have made to the template in the Windows version of the Template 
Editor, be sure to click the [OK] button to close the window rather than clicking the Control Menu box. 
Clicking the Control Menu box (located in the upper left of the window) performs the same function as 
the [Cancel] button: the window will close but any changes you have made to the template will not be 
saved. 

Copying/Pasting Templates 
Copying Template Information 

Two template actions—Copy and Paste—can only be activated from the Plate menu (when a Plate 
section is active) rather than from the Template Editor. If you have created a template in a Plate 
section and wish to use it in another Plate section, you may copy that template and paste it into the 
new section. The results of copying and pasting a template depend upon whether the action is 
performed within the same experiment or between experiment sections. 

Copying and Pasting within the Same Experiment Section 
To copy a template, make the section containing that template active and choose Copy Template from 
the Plate menu. Then activate the destination Plate section and choose Paste Template from the Plate 
menu. 
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The group names and sample names of the pasted template are identical to those of the source 
template. In effect, the destination template is considered an extension of the original template and all 
wells on the destination plate are considered replicates of the wells on the source plate (same group 
and sample names). Any changes made to the template on the destination plate will also be made on 
the source plate. Data from the two Plate sections will be analyzed together. 

Copying and Pasting between Different Experiment Sections 
To copy a template, make the section containing that template active and choose Copy Template from 
the Plate menu (the menu name changes to reflect the type of active section). Then activate the 
destination Plate section and choose Paste Template from the Plate menu. 

The group names and sample names of the pasted template will be identical to those of the source 
template but, since they are in different experiments, the full name will be different (for example: 
group@experiment#2 instead of group@experiment#1). Any changes made to the template of the 
destination Plate section will not affect the source section. Data from the two Plate sections will not be 
analyzed together. 

Copying and Pasting Template Regions 

Contiguous regions of templates can be copied and pasted to other regions of templates (within the 
same or to a different experiment). All template settings are pasted into the new template except the 
group name: the new group is given the name “Group#X” where X is the next greater number than 
that used already for group names. 

To copy a region of a template, highlight the region and then select Copy from the Edit menu or press 
C (Macintosh) or [CTRL]+[C] (Windows). Only the highlighted wells will be copied. 

To paste the region into another area of a template, highlight the region and select Paste from the Edit 
menu or press V (Macintosh) or [CTRL]+[V] (Windows). 

Only the highlighted wells will have template information pasted into them. Data is pasted using 
row priority: all wells in a row of highlighted wells have information pasted into them before 
proceeding to the next row, from left to right. If fewer wells are highlighted for pasting than were 
copied, the data will be pasted until all paste-highlighted wells are filled. If more wells are 
highlighted for pasting than were highlighted for copying, the extra wells are left empty. 

Exporting/Importing Templates 
Templates can be exported or imported by opening the Plate section and choosing the appropriate 
command on the Plate menu.  
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Template files can be prepared “outside of” SoftMax Pro and then imported as needed when ready to 
run samples. How your particular templates should appear depends on the type of samples you will 
run, whether or not you will run them in replicate, etc. An example template, containing two wells 
with blanks, one column of standards, and the rest of the wells containing unknowns with replicates 
and serial dilutions, is shown below as it would appear in SoftMax Pro followed by a portion of the 
exported version of the same template as seen in a spreadsheet program. 

 
Above: Template Example Showing Two Blanks, One Column of Standards, and the Rest Unknowns Run with 

Replicates and with Serial Dilution. 
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Above: Export of the Template Example Shown in the Previous Figure 

Templates can be set up in many different ways. If replicates are used, as with the example above, 
they can be set up horizontally from left to right (as this example shows) or right to left, or vertically 
from top to bottom or bottom to top. If you are generating template data by means of import from a 
bar code reader or other source, noting the manner in which the data is imported will be helpful in 
determining the best manner to set up the template. 

Examining the exported information from your individual template files will help you determine the 
best method for template creation outside of SoftMax Pro in order for the data to be acquired in the 
correct manner. 
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Reading a Microplate 
Data Collection Introduction 

When you read, the information sent by the instrument to SoftMax Pro is absorbance (optical density) 
data. 

Optical density is defined as: 

log (I0/I) 

where: 
I = the light intensity after it passes through the sample, 

I0 = initial light intensity (generally light traveling through air). 

When reading a microplate, there are two ways in which the instrument can obtain an I0 value: with 
the air reference information programmed into the NVRAM (non-volatile memory) of the instrument, 
or through instrument autocalibration (a reading of an air reference prior to reading samples). In 
early versions of SoftMax and SoftMax Pro, a selection was available in the Instrument Settings 
dialog box to turn autocalibration on or off. In SoftMax Pro version 2.4 and above but prior to version 
3.0, autocalibration could not be enabled or disabled by the user. Instead, the software made the 
determination regarding whether or not to autocalibrate. Version 3.0 again made it possible to choose 
whether or not autocalibration will occur (via a choice on the Instrument Settings dialog box). 

Data Collection from a Microplate 
You can start a reading at any time after defining instrument settings. It is not necessary to define 
groups and assign wells within the Template Editor first. The values received from the instrument 
are raw absorbance readings and are not affected by settings in the Template Editor. Only instrument 
settings must be defined prior to reading a microplate.  

To read a microplate, open the drawer of the instrument (click the drawer button in the status bar, or 
choose Open Drawer from the Control menu) and insert the prepared microplate. Then simply click 
the [Read] button in the status bar or choose Read from the Command menu. 

If you have created more than one Plate section, and no Plate section is active, choosing the Read 
command will cause a dialog box to appear asking you to choose which section to read (see the figure 
below). Select the correct section and then click [OK] to close the dialog box. If a Plate section is 
active, choosing the Read command will read that plate. 

 
Select Section Dialog Box 

A similar dialog box will appear if you have chosen to pre-read the plate for blanking. At the bottom 
of this dialog box, however, are two option (radio) buttons, allowing you to proceed with the pre-
read plate blank or to override this and read the “normal” plate. After reading the blank plate, you 
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must start the read process again for the normal plate. The same dialog box will appear, but the 
default option button choice will be “Normal.” 

 
If you select a Plate section that already contains data and choose to Read again, an alert appears, 
asking you to confirm replacing data in the destination plate.  

 
If you select [Replace], the reading will proceed and the previous data will be replaced with new 
data. 

After beginning a reading, the status bar will show the actions that are occurring in the instrument, 
along with a box showing the elapsed time for each action in minutes and seconds. The [Read] button 
will change to [Stop], allowing you to terminate a reading, if necessary. An example of the 
appearance of the status bar during a reading is shown below. 

 
General Information about Reading 

Data Display During a Reading 

The values read by the instrument will appear in the data display as they are received from the 
instrument (in real time). Depending upon the read mode , the number of wavelengths, the plate 
type, and the display options selected, the data display will show one or more numbers or plots. 

Double-click a single well to enlarge its display to a Well Graph or hold the [Shift] key while selecting 
more than one well, and then choose Graph... from the Plate menu or click the graph button on the 
tool bar to display the data from multiple wells in one enlarged Well Graph. The data in the enlarged 
Well Graph will update to show new data points as they are received from the instrument. 

Other choices and settings within SoftMax Pro affect the way in which data is displayed—the type of 
reduction, specific time settings, and so on.  



  

  

Data Collection: SpectraMax (except SpectraMax M2 and M5) 

Introduction to Data Collection 
Data Collection using SoftMax Pro is a three-part process: 

1. Prepare SoftMax Pro to collect data; 

2. Prepare and load the microplate(s) and/or cuvette(s) to be read; and 

3. Read the microplate(s) and/or cuvette(s). 

Before acquiring data from (reading) a microplate or cuvette, you must create the Plate section(s) 
and/or CuvetteSet section(s) and define the instrument settings for the reading. Instrument Settings 
must be defined prior to collecting data and may NOT be changed after data is collected. In addition, 
it is recommended that you define a template and set the reduction and display parameters prior to 
reading the microplate or cuvette, since these parameters determine how data is displayed and 
analyzed, but these last parameters may be set up and/or modified after data collection. 

A typical process for preparing, collecting, and analyzing data is as follows: 

1. Launch SoftMax Pro software. 

2. Create Plate and/or CuvetteSet section(s) as needed. 

3. Define the Instrument Setup settings from the Control menu. 

4. Define the template, reduction parameters, and display parameters. 

5. Prepare the microplate(s) and/or cuvette(s) to be read and place them in the instrument. 

6. Initiate the reading. 

7. Save the data file. 

8. Modify the template, reduction parameters, or display parameters (optional). 

9. Analyze the data using the Group section tables and Graph sections. 

10. Save the data file again when you are finished. 

Instrument Settings 
Instrument Setup 

� NOTE: Not all instrument settings are available with all instruments. Only the settings that pertain to the 
instrument that is connected to the computer or the one chosen in the Preferences will be shown in the 
Instrument Settings dialog box. 

You must specify the instrument settings prior to actually reading a microplate or cuvette. Settings 
for the reading are made in the Instrument Settings dialog box, which can be accessed in three ways: 

1. Choose Instrument Setup... from the Control menu; 

2. Click the [Setup] button in the tool bar of the active, expanded Plate or CuvetteSet section; or 

3. Double-click anywhere in the settings box (located to the right of the well grid) in the active, 
expanded Plate or CuvetteSet section. 

� NOTE: You may create more than one Plate or CuvetteSet section in a single experiment, and the 
instrument settings associated with each Plate/CuvetteSet section can be different. Instrument Setup... can 
only be chosen while a Plate/CuvetteSet section is active, and the settings you choose will affect only that 
section. A new Plate or CuvetteSet section that is created in an experiment that contains an active Plate or 
CuvetteSet section will contain the same instrument settings found in the previously active section. The 
settings for the new section can be modified as desired. 
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When you have defined the instrument settings, click the [OK] button to close the Instrument Settings 
dialog box. After closing, a summary of the instrument settings will appear in the box to the right of 
the data display in the Plate/CuvetteSet section. The instrument will use these settings to read the 
plate or cuvette. 

 Instrument Settings Chart 
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Endpoint • • • •
Kinetic • • • • • •
Spectrum • • • •

Endpoint Plate • • • • •
Kinetic Plate • • • • • •
Spectrum Plate • • • • •
Endpoint Cuvette •
Kinetic Cuvette • •
Spectrum Cuvette • •

Endpoint Plate • • • • • • • •
Kinetic Plate • • • • • • •
Spectrum Plate • • • • • •
Endpoint Cuvette •
Kinetic Cuvette • •
Spectrum Cuvette • •

Endpoint • • • • •
Kinetic • • • • • •
Spectrum • • • • •

Endpoint • • • • • •
Kinetic • • • • • • • • •
Spectrum • • • • • •

SpectraMax

SpectraMax Plus

Spectramax Plus384

SpectraMax 190, 340PC

SpectraMax 340PC384

  

� NOTE: Incubator control is an instrument setup parameter that is not found in the Instrument Settings 
dialog box. 
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Read Mode 
Choices for the read mode are Endpoint, Kinetic, or Spectrum.  

� NOTE: Available read modes depend on the type of instrument connected or selected in the Preferences. 

To select a read mode, click the appropriate section in the Instrument Settings dialog box. 

Endpoint 

A single reading of the microplate taken at a single or multiple wavelength(s). Values reported are 
optical density or %Transmittance (if this has been selected in the Reduction dialog box). The default 
reduced values are !Lm1 (or !Lm2-!Lm6, depending upon whether or not multiple wavelengths were 
chosen) and !Pathlength. 

 
Endpoint instrument settings with all options shown 
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Kinetic 

Data is collected over time with multiple readings taken at regular intervals. The default reduced 
values calculated for Kinetic data are Vmax (mOD/min), Time to Vmax (seconds), Onset Time 
(seconds), Time at Minimum, Time at Maximum, Time at 1/2 Maximum, Slope, and Area Under 
Curve. 

Timing—When Kinetic mode is chosen, the Timing parameter is active, allowing you to enter the 
total Kinetic run time and the time interval between readings. 

After entering a total run time and an interval between readings, the total number of readings that 
will result is shown below the run time. The minimum read interval is determined by which 
instrument is connected to the computer or, if no instrument is connected, by which instrument has 
been chosen in the Reader section of the Preferences dialog box and the particular settings chosen for 
that instrument. The minimum interval depends on the number of wavelengths, the Automix status, 
the number of strips, and the distance the monochromator and/or filter wheel of the instrument must 
move. If you set the interval time to be shorter than the instrument’s minimum read interval, the 
program will alert you with a message. Additionally, an interval that is too short will cause a 
warning message to appear telling you that no calibration can occur between reads. 

� NOTE: If you are writing a protocol that will be used with a different instrument (other than the one 
connected to the computer or chosen in the Reader preferences), you can disregard the alert and save the 
setup. However, if you attempt a reading using a protocol which has settings that are not correct for the 
particular instrument you are using, an error message will instruct you to change any setting that is out 
of range before a reading can be initiated. 

� NOTE: To achieve the shortest possible interval for Kinetic readings, choose wavelengths in ascending 
order. 
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Kinetic instrument settings with all options shown 
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Spectrum 

Measures absorbance (optical density) or %Transmittance across a Spectrum of wavelengths. The 
default reduced value reported for each well is the wavelength of maximum absorbance when optical 
density is displayed or the wavelength of minimum absorbance when %Transmittance is shown. All 
Spectrum readings are made using the scanning monochromator of the instrument. 

 
Spectrum Instrument settings with all options shown 



 Chapter 5: Data Collection: SpectraMax (except SpectraMax M2 & M5) 

SoftMax Pro User’s Manual  159 

Wavelengths 
For Endpoint or Kinetic Readings 

Choose the number of different wavelengths to be read. At least one wavelength must always be 
specified. Selecting more than one wavelength will cause a corresponding number of wavelength 
setting boxes to appear (maximum six wavelengths). 

 
Wavelength Settings for Endpoint or Kinetic readings 

The wavelengths specified previously (or the defaults) will be shown in the boxes. You can choose a 
wavelength from the choices using the pull-down menu or simply highlight the wavelength you 
would like to replace and type a new wavelength (within the available range of the SpectraMax 
instrument) over the previous one. Note that the pull-down menu shows only common 
monochromator settings. 

For Spectrum Readings 

When Spectrum is selected, the Wavelengths section of the dialog box changes to request a 
wavelength scanning range and a wavelength increment (Step) between the start and stop settings. 

The minimum selectable increment is 1 nm. 

 
Wavelength Selection for a Spectrum Reading 

Speed Read 
Speed Read performs a fast Spectrum scan of Plate sections or CuvetteSet sections. Speed Read does 
not measure the total amount of light available at each wavelength (I0) but uses the values stored in 
NVRAM of the instrument. As a result, Speed Read may not provide as accurate an absorbance 
measurement of each wavelength in the scan as with the normal mode. 
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PathCheck Pathlength Correction  
The Instrument Settings dialog box includes a section for PathCheck (pathlength correction—see the 
figure below). When enabled, this feature can be used to normalize the data acquired from microplate 
readings to a 1 cm pathlength, thereby correcting each OD to the value expected if the sample were 
read in a 1 cm cuvette, achieving significantly greater precision. Enable or disable pathlength 
correction by clicking in the checkbox at the top of this section. When enabled, a checkmark will 
appear in the box. 

   
PathCheck instrument settings 

The Instrument Settings dialog box for the SpectraMax Plus or Plus384 (left) allows a choice between 
using a water constant or reading a cuvette reference; the Instrument Settings dialog box for the 
SpectraMax 190 and 340PC (right) allows only a choice to enable PathCheck because these 
instruments only use a water constant. 

Pathlength correction is used to report OD or percent transmittance for each microplate well with the 
depth of the fluid in the well normalized to 1 cm. Two methods for pathlength correction are 
available when using the SpectraMax Plus, or Plus384: one involves cuvette measurements (cuvette 
reference) and the other involves a pathlength correction constant stored in the instrument (water 
constant). Pathlength correction for the SpectraMax 190 and 340PC uses the water constant. The 
actual pathlength, d, of a solvent is found from the following equation: 

 
When a cuvette reference is used for pathlength correction, the value of k is obtained by taking OD 
measurements on the fluid in the cuvette at two wavelengths, 1000 and 900 nm: 
  

 
When using the pathlength correction constant (water constant), the value of k is obtained from the 
instrument. This constant is recorded into nonvolatile memory when the instrument is manufactured 
and may differ slightly from instrument to instrument. 

Once the actual pathlength, d, in cm is found, the following equation is used to perform the 
pathlength correction: 
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Pre-Read Blanking vs. Background Constant Subtraction 

In previous versions of SoftMax Pro, selecting PathCheck automatically enabled the Pre-Read Plate 
(blanking) function which is used to subtract the absorbance due to the plate material on a well-by-
well basis before pathlength correction is applied. Now, however, the program default enables 
subtraction of a background constant (default is 0.0) from the absorbance values that are read. Often 
users do not take the time to pre-read plates (which provides the most accurate method for reducing 
background signal from absorbance readings). Subtracting a background offset provides a better 
result if no pre-read blanking is chosen. 

� NOTE: If you choose to pre-read a plate, be sure to disable the background constant subtraction (both 
choices are available in the Instrument Settings dialog box). 

To pre-read a plate, place water in the wells. Wells pre-read with water generally have less 
absorbance than do dry wells (e.g., at 426 nm, Nunc microplates read with and without water in the 
wells give absorbance values of approximately 0.037 and 0.049, respectively). Thus, pre-reading a dry 
plate results in pathlength-corrected absorbance values that are lower than the cuvette values. If the 
pre-read step is omitted entirely, the pathlength corrected results are overcorrected. 

If the plates are sufficiently transparent at the wavelength(s) of interest and have low well-to-well 
variability, the pre-read doesn’t have to be made on the same plate that will contain samples—
another clean plate from the same lot will be adequate. More conveniently, a single plate can be pre-
read and that pre-read data can be stored for subsequent use. SoftMax Pro allows you to copy and 
paste pre-read plate data from one plate section to another, provided the instrument settings are 
identical in the two plate sections.  

If the plates are inherently variable at the wavelength(s) of interest, however, it may be necessary to 
use the same plate for pre-reading and reading samples to ensure that adequate well-by-well 
correction is achieved. 

If you are using a SpectraMax Plus or Plus384 and PathCheck is enabled, you can choose to “Read 
Cuvette Reference” or to use the “Water Constant.” “Read Cuvette Reference” requires that you place 
a standard 1 cm cuvette containing water or aqueous buffer in the cuvette port. The instrument then 
takes readings of the cuvette at 900 and 1000 nm and uses those values for pathlength correction. 
“Water Constant” uses parameters stored in non-volatile instrument memory at the factory (based on 
readings of deionized water). The SpectraMax 190 and 340PC also use the “water constant” when 
performing pathlength correction. 

To determine a number for use as a background constant, pre-read an entire microplate at the 
wavelengths of interest. Average these numbers and use the average as the background constant. 

PathCheck on SpectraMax Plus or Plus384: Cuvette Reference or Water Constant— 
Which Should I Use? 

The PathCheck measurement is based on the absorbance of water at 1000 and 900 nm. If the sample is 
completely aqueous, has no turbidity, has a low salt concentration, and has no interfering color or 
compounds, then using the water constant is fine. The cuvette reference (using the sample buffer or 
diluent) must be used if there is any turbidity, more than 5% organic solvent (PathCheck should be 
accurate up to about 5%), high salt concentration, or interference in the 900 to 1000 nm range. [To 
determine possible color or compound interference: measure the OD at 900 and 1000 nm (both 
measured with air reference); subtract the 900 nm value from the 1000 nm value; and then do the 
same for pure water. If the delta OD for the sample differs from the delta OD for water, then the 
cuvette reference must be used.] If the buffer is clear but the sample is turbid, the error associated 
with PathCheck will not meet specification (2.5% for SpectraMax Plus or Plus384). PathCheck should 
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not be used with high levels of turbidity since the light scatter from turbidity cannot be subtracted 
out from the absorbance reading of the sample. 

� NOTE: With the SpectraMax Plus or Plus384, choosing “Read Cuvette Reference” for the PathCheck option 
is different from a reference reading of a cuvette in a CuvetteSet section (by clicking the [Ref] button in 
the CuvetteSet section tool bar). The cuvette reference used for PathCheck calculations (measurements at 
900 and 1000 nm) does not produce data that can be viewed in a CuvetteSet section and is used only with 
data in microplates, not cuvettes. 

PathCheck and SpectraMax 190 and 340PC 

PathCheck on the SpectraMax 190 and 340PC instruments uses only the water constant. Therefore, 
samples must be completely aqueous (no solvents), clear, nonturbid, and have no interfering 
contaminants in the wavelength range of 900 to 1000 nm (not highly colored in the upper wavelength 
range as in Lowry assays). 

PathCheck must be chosen in the Instrument Settings dialog box before reading a plate in order for 
this feature to be active. After reading, you can choose whether or not to apply the correction in the 
Reduction dialog box for that Plate section; you can also choose to view the data as percent 
transmittance (%T) or absorbance (OD). PathCheck cannot be applied after a reading, nor can you 
change “Water Constant” to “Read Cuvette Reference” after a reading—doing so will require that 
you replace the existing data with that from a new reading (of both the cuvette and the microplate).  

Automix 
The Automix function is a patented feature that allows you to set automated shaking of the 
microplate. The options available for Automix depend on the read mode chosen and the type of 
instrument connected or chosen in the Preferences. 

 
Left: Endpoint or Spectrum Modes; Right: Kinetic Mode 

Before First Read 

This setting can be used with any read mode. Click the checkbox next to “Before First Read” to shake 
the microplate automatically for five seconds prior to the first reading. Whether you read at a single 
wavelength or at multiple wavelengths, enabling Automix for “Before First Read” will shake the 
plate for the set amount of time before the first wavelength reading only. You can accept the default value 
shown for the amount of time to shake the plate or enter a different value (up to 999 seconds) in the 
box to the right.  

Between Reads 

This option is applicable only to Kinetic readings and is displayed only when Kinetic mode is 
selected. To enable automatic mixing of the microplate between readings during a Kinetic assay, click 
the checkbox next to this setting. For readings at a single wavelength, “Between Reads” will shake the 
plate for the set amount of time prior to each reading at that wavelength. For readings at multiple 
wavelengths, enabling “Between Reads” will shake the plate for the set amount of time before each 
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reading at the first wavelength only. You can accept the default value shown for the amount of time 
to shake the plate or enter a different value (up to 999 seconds) in the box to the right. 

Wells to Read/Strips Selection  
You may choose to read only certain wells or columns (or strips) of wells in the microplate or to read 
the entire plate. Partial-plate reading is available for all reading modes, although it is most useful for 
fast Kinetics and limited Spectrum analyses. The time required for Kinetic and Spectrum readings 
may be significantly reduced using this setting since the instrument does not have to read the entire 
plate.  

To enable a partial-plate read, highlight the desired columns (see the figure below). Columns do not 
need to start with “1” but must be contiguous. 
  

 
Strips/wells to read 

If you enable a partial-plate reading, only the wells to be read will be visible in the data display, 
indicating that no data will be collected for the other wells (all wells will be present in the Template 
Editor, however). 

AutoCalibrate 
This checkbox allows you to disable or enable automatic calibration for all instruments. The default 
setting is checked (enabled). Turning AutoCalibrate off allows the instrument to complete readings 
more quickly or to begin the first reading of a Kinetic plate faster. However, you should allow the 
instrument to perform autocalibration of at least one plate prior to disabling this function: calibration 
settings for the last plate which included an autocalibration are maintained in the instrument 
memory (NVRAM) until another autocalibration is performed. 

AutoRead 
This feature enables the automatic reading of subsequent Plate sections in the order in which they 
appear within an experiment. By entering a value in the “Delay” text field, you can set the delay time 
interval between the plate reads. 
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Blanking (Pre-Read Plate) 
The blanking selection found in the Instrument Settings dialog box is known as pre-read plate blanking, 
but pre-reading the plate is only one of five types of blanking available in SoftMax Pro. 
Understanding the differences between the types of blanking functions will enable you to choose the 
type of blanking that is appropriate for your assay. Note that blanks can be used in combination and 
have cumulative effects.  

If pre-read plate blanking is chosen, SoftMax Pro will prompt you to first read the blank plate after 
you click the [Read] button. 

 
Automix and Blanking 

The pre-read values will be stored in the data file and the individual well values collected during the pre-
reading of the plate will be subtracted from the individual well values obtained during the actual reading of 
samples. This is particularly useful for readings in the UV. Pre-read blanking may be turned off in the 
Reduction dialog box (click on the [Reduction] button) so the data may be seen with and without pre-
read blanking subtracted. This option is only available within the Reduction dialog box if pre-read 
blanking was chosen in the instrument setup. 

The purpose of pre-read plate blanks is to correct for well-to-well variability and, in the case of 
PathCheck, to subtract plate background before applying pathlength correction. 

� NOTE: A background constant subtraction setting is also available for instruments capable of using 
PathCheck (in the Instrument Settings > PathCheck option). If you pre-read a plate, you should not use a 
background constant subtraction and vice versa. 

Pre-read blanking is available for all read modes but is most useful for Endpoint readings. When 
used in Spectrum scan mode, the pre-read scan is subtracted on a point-by-point basis from the 
normal scan. If pre-read is selected using Kinetic mode (not generally recommended), a pre-read with 
the same Kinetic read interval and duration as the “normal” reading will be done and the ODs at 
each time point of the pre-read will be subtracted from the OD of the corresponding time point of the 
“normal” reading. 

� NOTE: Molecular Devices recommends that the wells of the pre-read plate be filled with the appropriate 
buffer for the assay or with water when performing pathlength correction. 
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Assay Plate Type 
This setting determines the display of wells in the microplate—it should be set to match the type and 
number of wells in the actual microplate that will be read.  

 
Assay Plate Type 

� NOTE: Changing the Plate Type within a Plate section causes well assignments stored in the previous 
template to be discarded. The groups created previously remain, however, so you can select new wells 
and simply apply existing groups to these wells. 

Defining New Plate Types 

The Plate Type list includes entries for microplates with standard dimensions and additional entries 
for plates that work best with custom settings. For both 96- and 384-well plates, the Standard plate 
should be used unless a custom setting is shown for the microplate you are using. 

Column vs. Wavelength Priority During a Reading 
Depending upon the type of instrument connected to the computer or chosen in the Reader 
Preferences, a priority is given to reading by “column” or “wavelength.” It is most important to 
understand this priority with multi-wavelength readings. 

In column priority, an instrument will read the entire microplate (or chosen number of strips) at the 
first wavelength, and will then go back and read the microplate at the second and subsequent 
wavelengths. 

In wavelength priority, the instrument will read all wavelengths for the first column of wells in the 
microplate, and will then read all wavelengths for the second column, etc. 

The table below shows the priority settings by instrument for the different read modes. 

Column vs. Wavelength Priority 

 Endpoint Kinetic Spectrum 

SpectraMax Plus, Plus384 User Choice1 Wavelength Column 

SpectraMax 190, 190PC, 
340PC, 340PC384 

Column Wavelength Column 

SpectraMax 250, 340 Column Column Column 

                                                           
1 You may choose between wavelength and column priority readings in the Instrument Settings 
dialog box. 
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Template Editor 
The Template Editor is available for Plate and CuvetteSet sections. In both cases, it is used to describe 
the location of samples, either in the wells of the microplate or in a cuvette, providing the link 
between the raw data and the analysis groups. The Template Editor is used to create a template 
which provides SoftMax Pro with a map of what is in the microplates and/or cuvettes. 
When you first open the Template Editor for a new Plate section or CuvetteSet section, the grid or 
display is empty. After selecting wells or cuvettes, you can assign groups, and indicate the type of 
samples they will contain. 
Depending upon the default protocol you are using, certain group names (and associated sample 
descriptions) may have been created. You can use these predefined groups and/or create new groups 
to suit your needs. When creating new groups, you may enter any name you wish. Once entered, this 
name will be available for use in that experiment thereafter. New groups can be created 
independently from selecting or assigning any wells/cuvettes in the Template Editor. 
Each well/cuvette designated as being part of a group has associated with it a group name, a sample 
name (or replicate ID), a sample descriptor (optional), and a default column format (group type, such 
as Standards, for example). When a group is applied to selected wells or cuvettes, the group name is 
displayed in bold type over the wells/cuvettes and the wells/cuvettes bear the same color. 

  

Template editor window with explanations 

Groups are always visible, both in the Template and in the data display of the Plate section or 
CuvetteSet section. Even though they are grouped, single wells or cuvettes are still selectable in either 
the Template Editor or the data display. 
Samples and groups may exist across multiple Plate sections or CuvetteSet sections as well as within 
a single Plate section or CuvetteSet section. 
Each template is built upon a hierarchy as follows: the template is composed of samples and groups. 
A set of one or more replicate wells makes up a sample. A set of related samples forms a group. For 
example, you may have a group named Standards that consists of seven samples named STD01, 
STD02 ... STD07. Group names may be up to 32 characters long, while sample names may be 300+ 
characters long. Samples may be assigned one at a time using the [Assign] button or several at the 
same time using the [Series] button. 
If you create a group in the Template Editor but do not assign any wells to the group, a section for 
that group will still be created automatically when you close the template. You can remove the group 
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(both its section in the window and its group name in the template) by making that Group section 
active and choosing Delete Groupname (where “Groupname” is the name assigned to that group in 
the template) from the Edit menu. Using the Macintosh, you can also delete the selected Group by 
pressing –; within Windows, you can press [CTRL]+[–]. Note that deleting the wells assigned to a 
group from the template does not delete the corresponding Group name from the drop-down list. The 
only way to remove a group name from this list in the Template Editor is to delete the corresponding 
Group section from the experiment. 

Selecting Wells or Cuvettes in the Template Editor 
In the Template Editor for a Plate section or a CuvetteSet section, you can select one or more wells or 
cuvettes by clicking or dragging on the grid. Multiple (contiguous) wells or cuvettes can be selected 
by dragging across them. Non-contiguous selections can be made by holding down the [Shift] key 
and clicking individual wells or cuvettes. Clicking a row label will select the entire row; clicking a 
column label will select the entire column. Contiguous columns or rows (1-12 or A-H, for a 96-well 
plate, for example) can also be selected by dragging. Non-contiguous columns or rows can be 
selected by holding the  (command) key on the Macintosh or the [CTRL] key in Windows and 
clicking in labels. 

 Double-clicking anywhere within a group will select the entire group. 
 To deselect all wells quickly, click in the empty border around the Template. 
 When you leave the Template Editor (by clicking the [OK] button), the Plate/CuvetteSet section 

will show the boundaries of the groups created in the template. Group labels and sample 
descriptors will not be visible—you can see them by holding down the [CTRL]+[Shift] keys. 
When you release the key(s), the original view of the Plate section or CuvetteSet section will 
return.  

Template Editor Tool Bar 
The tool bar will appear differently depending upon what type of group is selected in the Group 
drop-down list. The following illustration shows how the tool bar will appear under various 
circumstances. 

 
Template Editor Tool Bar 
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The tool bar is divided into three areas: the Group area, the Sample area, and the Assign area. 

The Group Area 

The Group area contains the Group drop-down list which allows you to assign wells to existing 
groups, create new groups, or modify (using the [Edit] button) existing groups. In addition, it 
contains the [Clear] button which allows you to clear well assignments in the template. 

Group Drop-Down List 

This drop-down list consists of two areas, divided by a horizontal gray line. The two items below the 
gray line (Blank and New) are always available. Items above the gray line are custom groups that 
may be created as you wish. 

The Group drop-down list will appear differently depending upon the custom groups that have been 
created (by default or by the user). The figure below shows two different instances of the appearance 
of the Group list. 

 
Group drop-down list 

� NOTE: Depending on the default template used when opening SoftMax Pro, initially no groups may 
appear above the gray line. As you create new groups, they will be positioned above the line. 

 Blank—Creates a plate blank in the active section. Note: the name “blank” is reserved for use by 
the SoftMax Pro program and should not be used when creating custom groups. 

 New—Creates a new group. The Group Settings dialog box will appear (see the image below) 
showing default settings. This dialog box allows you to define the name for a group of related 
samples, what type of descriptor will be associated with these samples, and the initial column 
format for the Group section. Whenever a new group is created (whether or not wells are 
selected in the template), a Group section (table) will also be created. To delete a group, you 
must delete the Group section. Simply clearing a group from the Template Editor will remove 
the assignment of wells to that group name, but the name will still show in the group pull-down 
menu and the Group section will still exist. 
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Group Settings 

Name: Use either the default name, “Group#X,” where “X” is an integer that is initially set to “1” and 
increments (i.e., “1,” “2,” “3,” etc.) as other groups are created, or enter a custom name (up to 32 
characters in length). 
In the Sample Descriptor area of the Group Settings dialog box, you can enable the application of the 
sample descriptor, if appropriate by clicking the checkbox. You may also choose the units used for 
the sample descriptor by selecting an option from the Units drop-down list or by typing the units you 
wish to use into the list box. 
The Sample Descriptor is automatically enabled when either the Standards or Unknowns(Dilution) 
column format (see below) is selected. The descriptor defaults to Concentration with the Standards 
column format and to Dilution with the Unknowns(Dilution) column format. The Sample Descriptor 
may also be used for time or fraction number information. 

� NOTE: No sample descriptor is assigned automatically for the Basic or Unknowns column format. You 
may assign a sample descriptor to these column formats manually but, if you choose to do this, the 
information will not appear automatically in the Group section. To see it, you will need to create a new 
column containing the formula !Sampledescriptor. For more information about creating columns, see 
“Adding Columns”. 

Column Format defines the default column types that will be created for a new group or shows the 
original column format setting that was used to create the group you are editing. 
Four selections are offered: Basic, Standard, Unknowns, and Unknowns (Dilution). Different types of 
columns will be created for a new group, or changed in an existing group, depending on which of 
these column format settings you select. The table below shows the default columns created with 
each selection type. 
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Columns Created and Their Formulas 

 Basic Standard Unknown Unknown(Dilution) 

Name Sample Sample Sample Sample 

Formula !SampleNames !SampleNames !SampleNames !SampleNames 

Name Wells Wells Wells Wells 

Formula !WellIDs !WellIDs !WellIDs !WellIDs 

Name Sample# Concentration Values Values 

Formula Index !Concentration* !WellValues !WellValues 

Name Values Values R (Outside Standard Range) 
R (Outside Standard 
Range) 

Formula !WellValues !WellValues 

If(Values)>=‘MinStd@ 
Standards’ and  
Values<=‘MaxStd@Standards’, 
“”,“R” 

If(Values)>=‘MinStd@ 
Standards’ and Values<=
‘MaxStd@Standards’, 
“”,“R” 

Name Mean Value MeanValue Result Result 

Formula Average(Values) Average(Values) 
InterpX(STD@ 
StandardCurve,Values) 

InterpX(STD@ 
StandardCurve,Values) 

Name Std.Dev. MeanResult MeanResult 

Formula Stdev(Values) Average(Result) Average(Result) 

Name CV% Std.Dev. Std.Dev. 

Formula Cv(Values) Stdev(Result) Stdev(Result) 

Name CV% CV% 

Formula Cv(Result) Cv(Result) 

Name Dilution 

Formula !Factor* 

Name Adj.Result 

Formula 

 

 

 

MeanResult*!Factor 

 

* !Concentration and !Factor are from SoftMax Pro version 1.x. !Concentration, !Factor, and 
!SampleDescriptor return identical information. 



 Chapter 5: Data Collection: SpectraMax (except SpectraMax M2 & M5) 

SoftMax Pro User’s Manual  171 

The [Edit] Button 

When you click the [Edit] button, the Group Settings dialog box will appear, reflecting the settings for 
the active group (currently visible in the group drop-down list). If you wish to edit a group that is not 
currently active, first choose the group from the drop-down list and then click the [Edit] button. The 
figure below shows the Group Settings dialog box for the active group called “Patient#1.”  

 
The name, sample descriptors, and column format can be changed for the group that you are editing. 

When you edit a group, you will notice that the information shown for the Column Format in the 
Group Settings dialog box changes to show the name of the original group used to define the group 
columns (see the figure below). 

 

� CAUTION: Changing the column format will cause the columns in the group to revert to their 
original defaults as shown in the table above. If you have added columns or changed column 
information within the existing section for the group you are editing, these changes will be 
removed. 

The [Clear] Button 

Allows you to deselect, or clear the selected items. Highlight what you wish to clear and then click 
the [Clear] button. 
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The Sample Area 

The Sample area contains the Sample drop-down list and sample descriptor values (active if defined 
in the Group Settings dialog box or if assigned automatically by SoftMax Pro). 
  

 

� CAUTION: When changing sample names or descriptors, be sure all wells  are replicates of the 
same sample and group or that you want them to become replicates of the same sample and 
group. SoftMax Pro does not prohibit selecting individual wells from different samples and/or 
groups, for example, and changing their descriptions—and they will change to become the same. 

Sample Drop-Down List 

The sample drop-down list consists of two areas divided by a horizontal gray line. Before other 
sample names have been defined, a single, pre-defined name (“BL”) appears below the gray line (the 
sample name “BL” is the name reserved by SoftMax Pro for group-associated blanks). The item above 
the gray line is the sample ready to be or currently being assigned. After being assigned, it will be 
shown below “BL” below the gray line. 

 
When this list first appears, the only selection shown below the dividing line is “BL”; the active 
sample name that is ready to be assigned appears above the line. 

When samples are assigned to a group, the default name is the first 3 letters of the group name 
followed by a number. For a group called “Standard,” for example, the default sample names would 
be Sta01, Sta02, Sta03, and so on. Sample names can be 300+ characters long; however, only the first 
five or six characters will be displayed in the template and in the Plate section. 

� NOTE: You can type a sample name directly into the box next to the arrow for the drop-down list by 
highlighting and typing over the existing sample name. If one or more wells or cuvettes were 
highlighted, typing a different name will replace the sample name shown in the template with the name 
you have typed and, if the name is new, will add this name to those that can be chosen in the drop-down 
list. 

When wells or cuvettes have been selected in the template and sample names have been defined, the 
sample menu will look like the one below. The checkmark indicates the sample that is currently being 
named. 

 
Sample Drop-Down List—Sample Names Defined and Wells Selected 
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Sample Descriptor Field 

The field associated with the sample descriptor only appears in the Template Editor tool bar if the 
group column type that has been selected requires this type of information. Generally the information 
entered in this field is a dilution or concentration. Position the cursor in this field and enter a number. 
The label and units assigned to the sample descriptor in the Group Settings dialog box are shown on 
either side of the field. 

Assign Area 

The Assign area contains the [Series] and [Assign] buttons. 

 
Assign Area of the Template Editor Tool Bar 

Assign Button and Function 

Click this button to apply a sample name to one or more wells that have been selected in the 
template. You may also perform this operation by using the [Enter] key on your keyboard. 

Series Button and Function 

This button is used to define several samples as a series, allowing you to easily enter incremental 
sample descriptors (for example, dilutions or concentrations) and sample names to the template as 
long as the increment can be expressed as a mathematical operation.  

Replicate Samples and Samples in a Series 

You can assign the same group or sample definition (same sample name and description within a 
group) to multiple wells to create replicates. For example, you might want to read standards in 
replicate to ensure that anomalies can be excluded prior to generating a standard curve. Replicates 
can be created using the [Assign] button or with the series function. 

Creating a series is faster than assigning replicates individually. The series option can be used as long 
as the replicate values conform to a pattern that can be described by a mathematical operator 
(multiply by 2 or add 5, for example). 

A series is defined in one direction (starting from left, right, top, or bottom) and therefore samples 
must be arranged sequentially in either ascending or descending order. 

To create a series, do the following: 

1. In the Template Editor, highlight the wells to be part of the series. The wells must be in the 
shape of a rectangle. 
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Template with Wells Selected for a Series 

2. Click the [Series] button to open the Series dialog box. 

 
Series Dialog Box 

3. Specify the name of the first sample in the series in the box (or accept the default provided by 
SoftMax Pro). Subsequent replicates use this name as a base and either increment the number 
within the name or append a number to it. In the example above, the sample name provided 
by SoftMax Pro describes the first sample (“01”) in a group named “Standard,” here 
shortened to “Sta.” 

4.  The information shown in the box labeled Sample Descriptor is derived from the 
information entered in the Group Settings dialog box. If the information for sample 
descriptor or units is not correct, you may change it here. If you did not already do so, 
specify the starting value for the first sample in the series. Values for subsequent samples are 
calculated from this starting value. 

5. Choose the operator for the series (+, -, *, or /) from the Step by: drop-down list. Enter the 
starting value for the series in the Starting value: box. The increment is entered in the box to 
the right of the Step by: box and below the Starting value: box. The figure above shows a 
starting value of “0.5” with the operator being division (“/”) and the increment being “2.” 
Thus the series will start with a value of “.5” and divide each subsequent sample by 2 to 
produce the following series values: .5, .25, .125, etc. 

6. You must assign a fill direction (from the top, bottom, left, or right—to describe how the 
series will fill the wells) and a number of replicates. Various options are diagrammed in the 
figure below using a 4 x 4 block of wells (for more information about replicates, see Replicate 
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Samples and Samples in a Series, above). The maximum number of replicates depends on the 
selection of wells: if you are filling down from the top, for example, and you have chosen a 
block of wells that is 4 wells wide by 8 wells high, the maximum number of replicates will be 
four; with the same block of wells selected, filling from the left would allow eight replicates. 
If the number of replicates you choose does not divide evenly into the number of rows or 
columns you select, depending on the filling direction, the remaining wells that cannot 
contain replicates will be labeled as additional individual wells in the series. For example, if 
you fill a block of 4 x 4 wells from the top, and choose three replicates, then the first three 
columns will contain the replicates and the last column will contain the additional wells in 
the series (see the last diagram in the figure below). This replicate feature allows you to 
quickly define the number of replicates and, in cases where the series has more samples than 
a single row or column, to name them simultaneously. To create a series with all 96 samples, 
highlight all the wells in the plate, select the fill direction, and set the replicates to 1. 

 
Fill Options and Replicate Settings 

7. Click [OK] to save the series and close the dialog box. While still in the Template Editor, you 
can view the value assigned to any well by clicking that well. The value will be displayed at 
the top of the Template Editor. Holding down the [CTRL]+[Shift] keys will display the values 
for all wells. 

� NOTE: Sometimes you may wish the names of a series of samples to increment but may not have a 
concentration or dilution factor that you wish to enter, or you want the concentration or dilution factor to 
remain constant. This can be done using the [Series] button, setting the starting value to 1 or another 
constant value, and either multiplying by 1 or dividing by 1. In this way, the names will increment but 
the value of concentration or dilution will not change. If you don’t have a concentration or dilution factor, 
simply deselect the sample descriptor checkbox if it is selected. 

� NOTE: If sample names are set to increment automatically using the Series function, be aware that 
SoftMax Pro will automatically truncate the sample name to three or four characters, including the 
incrementing number if the sample name starts with letters. If the sample name is entirely numeric, it will 
not be truncated. If sample names are very long, and they must be kept long for reference, you will have 
to set up your replicates manually and will not be able to use the series function. 
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Blanking 
In addition to the pre-read plate blanking selection found in the Instrument Settings dialog box, four 
more types of blanking are available in SoftMax Pro. Understanding the differences between the 
types of blanking functions will enable you to choose the type of blanking that is appropriate for your 
assay. Note that blanks can be used in combination and have cumulative effects. 

The five types of blanking that are defined in SoftMax Pro are: 

Ref (CuvetteSet section only) 

Performing a reference reading of the cuvette causes the SpectraMax Plus or Plus384 to take a reading 
of the cuvette in the cuvette port. A single reference reading can be used with one or more cuvettes in 
a CuvetteSet section (the default applies to all cuvettes in the set) or different reference readings can 
be taken and applied to different cuvettes in the set. This reference read is then applied to sample 
reading.  

Plate Blanks (Plate section only) 

Wells can be assigned to a “Blank” group in the Template Editor. Unlike pre-read plate blanks, the 
average value of all the wells in a plate blank group is subtracted from all individual well values obtained 
during the reading of microplates. When PathCheck is selected for the SpectraMax Plus, Plus384, 190, 
or 340PC, the Plate Blank is subtracted after pathlength correction. Plate Blank subtraction may be 
turned off in the Reduction dialog box so that the data may be seen with or without plate blank 
subtraction. 

� NOTE: Plate blanks are only subtracted from wells on the same plate to which they are assigned. The 
checkbox for Plate Blank subtraction only appears in the Reduction dialog box after data has been 
collected. 

For Kinetic and Spectrum data, the blank value is averaged and subtracted on a point-by-point basis. 
The example below shows a graphic representation of original and average plate blank data, 
followed by the resulting data with average subtracted. 

 
Template Blanks (CuvetteSet section only) 

Similar in function to the Plate Blank used with Plate sections, Template Blanking occurs when 
cuvettes are assigned to a Blank group in the Template Editor of the CuvetteSet section. The average 
value of all the cuvettes in a template blank group will be subtracted from individual cuvette readings. For 
Kinetic and Spectrum data, the blank value is averaged and subtracted on a point-by-point basis. 
Template blanks are subtracted after the reference reading, if any, is subtracted. 

� NOTE: Template blanks are only subtracted from cuvettes within the same CuvetteSet section. 
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Group-Associated Blanks (Plates and Cuvettes) 

Blank wells or cuvettes can be assigned within any group (other than the “Blank” group) in the 
Template Editor. The average reduced value of the blank wells or cuvettes within that group will be subtracted 
from individual reduced values within that group only. This blanking function uses the reduced number 
(example: !Lm1-!Lm2, Vmax, etc.) only—it does not subtract on a point-by-point basis. When a group 
blank has been assigned, it is automatically subtracted. To see the reduced number without the group 
blank subtracted, mask the group blank wells or cuvettes. 

Group blanks apply to all wells or cuvettes in a group and thus may be subtracted from wells or 
cuvettes in more than one Plate section or CuvetteSet section. 

Blanking (Pre-Read Plate) 

The blanking selection found in the Instrument Settings dialog box is known as pre-read plate blanking, 
but pre-reading the plate is only one of five types of blanking available in SoftMax Pro. 
Understanding the differences between the types of blanking functions will enable you to choose the 
type of blanking that is appropriate for your assay. Note that blanks can be used in combination and 
have cumulative effects.  

If pre-read plate blanking is chosen, SoftMax Pro will prompt you to first read the blank plate after 
you click the [Read] button. 

 
Automix and Blanking 

The pre-read values will be stored in the data file and the individual well values collected during the pre-
reading of the plate will be subtracted from the individual well values obtained during the actual reading of 
samples. This is particularly useful for readings in the UV. Pre-read blanking may be turned off in the 
Reduction dialog box (click on the [Reduction] button) so the data may be seen with and without pre-
read blanking subtracted. This option is only available within the Reduction dialog box if pre-read 
blanking was chosen in the instrument setup. 

The purpose of pre-read plate blanks is to correct for well-to-well variability and, in the case of 
PathCheck, to subtract plate background before applying pathlength correction. 

� NOTE: A background constant subtraction setting is also available for instruments capable of using 
PathCheck (in the Instrument Settings > PathCheck option). If you pre-read a plate, you should not use a 
background constant subtraction and vice versa. 

Pre-read blanking is available for all read modes but is most useful for Endpoint readings. When 
used in Spectrum scan mode (SpectraMax instruments only), the pre-read scan is subtracted on a 
point-by-point basis from the normal scan. If pre-read is selected using Kinetic mode (not generally 
recommended), a pre-read with the same Kinetic read interval and duration as the “normal” reading 
will be done and the ODs at each time point of the pre-read will be subtracted from the OD of the 
corresponding time point of the “normal” reading. 
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� NOTE: Molecular Devices recommends that the wells of the pre-read plate be filled with the appropriate 
buffer for the assay or with water when performing pathlength correction. 

Blanks in Combination 

It is possible to use blanking functions in combination. You could perform a pre-read plate blanking, 
assign a blank group in the template, and also include blank wells within different groups. The 
effects of the different blanking functions are cumulative, so it is important to understand the function 
of each before using more than one type of blanking in a single assay. Pre-read blanking, plate 
blanking, Ref, and template blanking are applied to the raw data acquired from the instrument, 
whereas group blanks are applied to the reduced number. Group blank subtraction is only visible in 
the Plate section/CuvetteSet section when the reduced number is displayed. The figure below shows 
the last two types of blanks in the Template Editor. 

 
Blanks in Combination 

In the figure above, note that the plate blank in the upper left appears as a separate group named 
“Blank” and individual samples within this group are named “BL.” The group-associated blank 
wells, shown in the upper right, are not a separate group—the samples, also named “BL,” are 
contained within the boundaries of the large group called “Unknowns” and are the same color as that 
group. 

 

� NOTE: (Windows version only) In order to save changes you have made to the template in the Template 
Editor, be sure to click the [OK] button to close the window rather than clicking the Control Menu box. 
Clicking the Control Menu box (located in the upper left of the window) performs the same function as 
the [Cancel] button: the window will close, but any changes you have made to the template will not be 
saved. 

Copying/Pasting Templates 
Copying Template Information 

Two template actions—Copy and Paste—can only be activated from the Plate or CuvetteSet menu 
(when a Plate section or CuvetteSet section is active) rather than from the Template Editor. If you 
have created a template in a Plate section or CuvetteSet section and wish to use it in another Plate 
section or CuvetteSet section, you may copy that template and paste it into the new section. The 
results of copying and pasting a template depend upon whether the action is performed within the 
same experiment or between experiment sections. 
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Copying and Pasting within the Same Experiment Section 
To copy a template, make the section containing that template active and choose Copy Template from 
either the Plate or CuvetteSet menu (the menu name changes to reflect the type of active section). 
Then activate the destination Plate section or CuvetteSet section and choose Paste Template from the 
Plate or CuvetteSet menu. 

 
Copy and Paste commands (CuvetteSet menu shown) 

The group names and sample names of the pasted template are identical to those of the source 
template. In effect, the destination template is considered an extension of the original template and all 
wells on the destination plate are considered replicates of the wells on the source plate (same group 
and sample names). Any changes made to the template on the destination plate will also be made on 
the source plate. Data from the two Plate sections/CuvetteSet sections will be analyzed together. 

 

Copying and Pasting between Different Experiment Sections 
To copy a template, make the section containing that template active and choose Copy Template from 
either the Plate or CuvetteSet menu (the menu name changes to reflect the type of active section). 
Then activate the destination Plate section or CuvetteSet section and choose Paste Template from the 
Plate or CuvetteSet menu. 

The group names and sample names of the pasted template will be identical to those of the source 
template but, since they are in different experiments, the full name will be different (for example: 
group@experiment#2 instead of group@experiment#1). Any changes made to the template of the 
destination Plate section/CuvetteSet section will not affect the source section. Data from the two Plate 
sections/CuvetteSet sections will not be analyzed together. 

Copying and Pasting Template Regions 

Contiguous regions of templates can be copied and pasted to other regions of templates (within the 
same or to a different experiment). All template settings are pasted into the new template except the 
group name: the new group is given the name “Group#X” where X is the next greater number than 
that used already for group names. 

To copy a region of a template, highlight the region and then select Copy from the Edit menu or press 
C (Macintosh) or [CTRL]+[C] (Windows). Only the highlighted wells will be copied. 
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To paste the region into another area of a template, highlight the region and select Paste from the Edit 
menu or press V (Macintosh) or [CTRL]+[V] (Windows). 

Only the highlighted wells will have template information pasted into them. Data is pasted using 
row priority: all wells in a row of highlighted wells have information pasted into them before 
proceeding to the next row, from left to right. If fewer wells are highlighted for pasting than were 
copied, the data will be pasted until all paste-highlighted wells are filled. If more wells are 
highlighted for pasting than were highlighted for copying, the extra wells are left empty. 
 

Exporting/Importing Templates 
Templates can be exported or imported by opening the Plate section and choosing the appropriate 
command on the Plate or CuvetteSet menu.  

 
Template files can be prepared “outside of” SoftMax Pro and then imported as needed when ready to 
run samples. How your particular templates should appear depends on the type of samples you will 
run, whether or not you will run them in replicate, etc. An example template, containing two wells 
with blanks, one column of standards, and the rest of the wells containing unknowns with replicates 
and serial dilutions, is shown below as it would appear in SoftMax Pro followed by a portion of the 
exported version of the same template as seen in a spreadsheet program. 
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Above: Template Example Showing Two Blanks, One Column of Standards, and the Rest Unknowns Run with 

Replicates and with Serial Dilution. 

 
Above: Export of the Template Example Shown in the Previous Figure 
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Templates can be set up in many different ways. If replicates are used, as with the example above, 
they can be set up horizontally from left to right (as this example shows) or right to left, or vertically 
from top to bottom or bottom to top. If you are generating template data by means of import from a 
bar code reader or other source, noting the manner in which the data is imported will be helpful in 
determining the best manner to set up the template. 

Examining the exported information from your individual template files will help you determine the 
best method for template creation outside of SoftMax Pro in order for the data to be acquired in the 
correct manner. 

Reading a Microplate or Cuvette 
Data Collection Introduction 

When you read, the information sent by the instrument to SoftMax Pro is absorbance (optical density) 
data. 

Optical density is defined as: 

log (I0/I) 

where: 
I = the light intensity after it passes through the sample, 

I0 = initial light intensity (generally light traveling through air). 

When reading a microplate, there are two ways in which the instrument can obtain an I0 value: with 
the air reference information programmed into the NVRAM (non-volatile memory) of the instrument, 
or through instrument autocalibration (a reading of an air reference prior to reading samples). In 
early versions of SoftMax and SoftMax Pro, a selection was available in the Instrument Settings 
dialog box to turn autocalibration on or off. In SoftMax Pro version 2.4 and above but prior to version 
3.0, autocalibration could not be enabled or disabled by the user. Instead, the software made the 
determination regarding whether or not to autocalibrate. Version 3.0 again made it possible to choose 
whether or not autocalibration will occur (via a choice on the Instrument Settings dialog box). 

Data Collection from a Microplate 
You can start a reading at any time after defining instrument settings. It is not necessary to define 
groups and assign wells within the Template Editor first. The values received from the instrument 
are raw absorbance readings and are not affected by settings in the Template Editor. Only instrument 
settings must be defined prior to reading a microplate.  

To read a microplate, open the drawer of the instrument (click the drawer button in the status bar, or 
choose Open Drawer from the Control menu) and insert the prepared microplate. Then simply click 
the [Read] button in the status bar or choose Read from the Command menu. 

If you have created more than one Plate section, and no Plate section is active, choosing the Read 
command will cause a dialog box to appear asking you to choose which section to read (see the figure 
below). Select the correct section and then click [OK] to close the dialog box. If a Plate section is 
active, choosing the Read command will read that plate. 
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A similar dialog box will appear if you have chosen to pre-read the plate for blanking. At the bottom 
of this dialog box, however, are two option (radio) buttons, allowing you to proceed with the pre-
read plate blank or to override this and read the “normal” plate. After reading the blank plate, you 
must start the read process again for the normal plate. The same dialog box will appear, but the 
default option button choice will be “Normal.” 

 
If you select a Plate section that already contains data and choose to Read again, an alert appears, 
asking you to confirm replacing data in the destination plate.  

 
If you select [Replace], the reading will proceed and the previous data will be replaced with new 
data. 

After beginning a reading, the status bar will show the actions that are occurring in the instrument, 
along with a box showing the elapsed time for each action in minutes and seconds. The [Read] button 
will change to [Stop], allowing you to terminate a reading, if necessary. An example of the 
appearance of the status bar during a reading is shown below. 
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Reading a Cuvette 
Data Collection from a Cuvette  

With the SpectraMax Plus and Plus348 series instruments, two types of Data Collection are possible 
using a cuvette: a reference and a sample reading. 

Data Collection from a Cuvette 

You can highlight any cuvette in the CuvetteSet section and choose to read it. If you select more than 
one cuvette, the software looks for the leftmost-selected cuvette that does not contain sample read 
data. When one is found, the reading begins with that cuvette. 

If you select a cuvette that already contains data and choose to Read again, an alert appears, asking 
you to confirm replacing data in the destination sample (see left side of the figure below). Similarly, if 
you choose Reference while a sample that has already had a reference reading performed is selected, 
the alert shown on the right side of the figure below appears. A similar alert is shown if you choose 
either read function with more than one cuvette selected (asking if you wish to replace the data or 
reference for all cuvettes). 

       
For Kinetic and Spectrum modes, the raw data plot is automatically displayed as a graph in the 
cuvette. You can also enlarge the view of selected samples by double-clicking, by using the Well 
Graph button on the CuvetteSet section tool bar, or by choosing Graph... from the CuvetteSet menu. 

The instrument settings table shown on the right of a CuvetteSet section is similar to the one in a 
Plate section. Automix is not available for cuvettes. Instrument settings must be the same for all 
cuvettes in a CuvetteSet section. 

CuvetteSet sections have a limit of 96 cuvettes. Should this limit be reached, the New Sample sub-
menu of the CuvetteSet menu and the corresponding tool bar button will become unavailable 
(dimmed) and it will be necessary to create a new CuvetteSet section. 

After beginning a reading, the status bar will show the actions that are occurring in the instrument, 
along with a box showing the elapsed time for each action in minutes and seconds. The [Read] button 
will change to [Stop], allowing you to terminate a reading, if necessary. An example of the 
appearance of the status bar during a reading is shown below. 

 
Reference Reading 

As in a spectrophotometer, taking a reference reading can be done either on air or using a cuvette 
containing the buffer of your sample. The reading taken using [Ref] (using the button in the 
CuvetteSet Section Tool Bar or the Reference command from the Control menu) will be used as I0 to 
calculate the absorbance of the sample. If no reference reading is taken, the SpectraMax Plus or Plus384 
will use the I0 values stored in the NVRAM of the instrument. 

A reference reading of the cuvette in the SpectraMax Plus or Plus384 can be made at any time by 
choosing Reference from the Control menu or from the CuvetteSet section status bar. The Reference 
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button is available when the active section is a CuvetteSet section. It is not visible when the active 
section is not a CuvetteSet section or if multiple sections are selected. 

If no reference has been taken in a CuvetteSet section and you then read a reference, SoftMax Pro 
assumes that this reference will be used with all cuvettes in the CuvetteSet section. Therefore, the 
time and date of the reading are displayed under each cuvette in the section (three cuvettes per row 
and one cuvette per row displays only). The reference will also be applied to any new cuvettes 
created in that section. The reference may be read before or after reading samples. 

You may have more than one reference per CuvetteSet section. If you have a single cuvette to which 
you want to apply a different reference, highlight that cuvette in the CuvetteSet section, place the 
second reference in the cuvette port, and click [Ref]. The time/date stamp of the reference for that 
cuvette (and only that cuvette in the set) will change. 

� NOTE: Any new cuvettes created in the CuvetteSet section after reading a second reference will use that 
new reference reading. 

When a reference is read, the system assumes that it will be used with all empty samples. Therefore, 
the date and time of the reference reading are displayed with each empty sample (including the 
destination sample) currently in the CuvetteSet section. If you wish to use a different reference 
reading with one or more cuvettes in a section, click (or shift-click) the cuvette(s) and then click the 
[Ref] button. A dialog will appear, asking if you wish to replace the reference reading for the 
cuvette(s). Choosing [OK] will enable a new reference reading to be used for those cuvette(s). 

The reference read is automatically applied to the normal read. The reference value is not displayed 
in SoftMax Pro. If you wish to see the reference value, you can choose one of the following 
procedures: 

Procedure 1: 

1. Create a cuvette in the CuvetteSet section and [Ref] on air (empty cuvette port). 

2. Read a cuvette containing the blanking solution. 

If you wish to have both reference and read values available, do the following: 

1. Create a cuvette set with up to the maximum of 96 cuvettes. 

2. Define a template blank in the CuvetteSet section. 

3. Place buffer in the cuvette and [Read]. 

4. [Read] the remaining samples. 

The optical density of the cuvette designated as the template blank will be subtracted from the optical 
density of all the other cuvettes in the CuvetteSet section. 

Procedure 2: 

1. Create a cuvette set with up to the maximum of 96 cuvettes. 

2. Reference and read the cuvette. 

3. Create a template with the appropriate groups. 

4. Create a column in each Group table with the formula !wellpreread!Lm1. 

� NOTE: If you have a multiple-wavelength reading and wish to see the reference at each wavelength, 
create additional columns with the formula !wellprereadLx where “x” is 2, 3, or 4, corresponding to the 
wavelength for which you want to see a reference. 
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The optical density with the reference subtracted will be displayed in the Values column. The 
reference value for each sample will be displayed in the custom column you have created. 

General Information about Reading 
Calibration 

When the instrument is connected (or chosen in the preferences), a Calibration command is available 
in the Control menu. Choosing this command opens the Calibration dialog box. The dialog box also 
shows the date of the most recent calibration. 

 
Calibration dialog box 

Instrument calibration performs an air reading at all available wavelengths and stores those values in 
the non-volatile instrument memory (NVRAM). For plate readings, these air calibration values are 
used whenever a Spectrum reading is performed using the Speed Read option, thus reducing the 
time it takes to complete a Spectrum reading.  

� NOTE: Molecular Devices recommends that you update the air reference information that is stored in 
NVRAM periodically. This is particularly important if you are using Speed Read, reading cuvettes 
without a reference, or running Kinetics in microplates with read intervals that are too short to allow 
autocalibration. 

Data Display During a Reading 

The values read by the instrument will appear in the data display as they are received from the 
instrument (in real time). Depending upon the read mode , the number of wavelengths, the plate 
type, and the display options selected, the data display will show one or more numbers or plots. 

Double-click a single well to enlarge its display to a Well Graph or hold the [Shift] key while selecting 
more than one well, and then choose Graph... from the Plate menu or click the graph button on the 
tool bar to display the data from multiple wells in one enlarged Well Graph. The data in the enlarged 
Well Graph will update to show new data points as they are received from the instrument. 

Other choices and settings within SoftMax Pro affect the way in which data is displayed—the type of 
reduction, specific time settings, and so on.  



  

  

Data Collection: SpectraMax M2 and M5 

Introduction to Data Collection 
Data Collection using SoftMax Pro is a three-part process: 

1. Prepare SoftMax Pro to collect data; 

2. Prepare and load the microplate (s) to be read; and 

3. Read the microplate(s). 

Before reading a microplate, you must create the Plate section(s) and define the instrument settings 
for the reading. Instrument Settings must be defined prior to collecting data and may NOT be 
changed after data is collected. In addition, it is recommended that you define a template and set the 
reduction and display parameters prior to reading the microplate, since these parameters determine 
how data is displayed and analyzed, but these last parameters may be set up and/or modified after 
data collection. 

A typical process for preparing, collecting, and analyzing data is as follows: 

1. Launch SoftMax Pro software. 

2. Create Plate section(s) as needed. 

3. Define the Instrument Setup settings from the Control menu. 

4. Define the template, reduction parameters, and display parameters. 

5. Prepare the microplate(s) to be read and place them in the instrument. 

6. Initiate the reading. 

7. Save the data file. 

8. Modify the template, reduction parameters, or display parameters (optional). 

9. Analyze the data using the Group section tables and Graph sections. 

10. Save the data file again when you are finished. 

Instrument Settings 
Instrument Setup 

 You must specify the instrument settings prior to actually reading a microplate. Settings for the 
reading are made in the Instrument Settings dialog box, which can be accessed in three ways: 

1. Choose Instrument Setup... from the Control menu; 

2. Click the [Setup] button in the tool bar of the active, expanded Plate section; or 

3. Double-click anywhere in the settings box (located to the right of the well grid) in the active, 
expanded Plate section. 

� NOTE: You may create more than one Plate section in a single experiment, and the instrument settings 
associated with each Plate section can be different. Instrument Setup... can only be chosen while a Plate 
section is active, and the settings you choose will affect only that section. A new Plate section that is 
created in an experiment that contains an active Plate section will contain the same instrument settings 
found in the previously active section. The settings for the new section can be modified as desired. 

When you have defined the instrument settings, click the [OK] button to close the Instrument Settings 
dialog box. After closing, a summary of the instrument settings will appear in the box to the right of 
the data display in the Plate section. The instrument will use these settings to read the plate. 



Chapter 5: Data Collection: SpectraMax M2 & M5  

188 SoftMax Pro User’s Manual 

Absorbance Instrument Settings Chart 
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Fluorescence Instrument Settings Chart 
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� NOTE: Incubator control is an instrument setup parameter that is not found in the Instrument Settings 
dialog box. 

� NOTE: Settling time is available for the SpectraMax M5 only.  
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Read Mode 
Choices for the read mode are Endpoint, Kinetic, Spectrum, or Well Scan. To select a read mode, click 
the appropriate section in the Instrument Settings dialog box. 
 

Endpoint 

A single reading of the microplate taken at a single or multiple wavelength(s). Values reported are 
optical density,  %Transmittance (if this has been selected in the Reduction dialog box), relative 
fluorescence units (RFU), or relative luminescence units (RLU), depending on the read type selected.  
 

 
Endpoint instrument settings with all options shown 
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Kinetic 

Data is collected over time with multiple readings taken at regular intervals. The default reduced 
values calculated for Kinetic data are Vmax, Time to Vmax (seconds), Onset Time (seconds), Time at 
Minimum, Time at Maximum, Time at 1/2 Maximum, Slope, and Area Under Curve. 

 
Kinetic instrument settings with all options shown 
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Timing—When Kinetic mode is chosen, the Timing parameter is active, allowing you to enter the 
total Kinetic run time and the time interval between readings. A default value will be shown for the 
run time; to change this value, click in the box. Up and down arrows will appear, enabling you to 
increase or decrease the value shown. Highlight the hours, minutes, or seconds shown and then click 
the up or down arrow until the desired value is reached. You can also select an existing value and 
enter a new value using the keyboard. 

 
Timing 

After entering a total run time and an interval between readings, the total number of readings that 
will result is shown below the run time. The minimum read interval is determined by which 
instrument is connected to the computer or, if no instrument is connected, by which instrument has 
been chosen in the Reader section of the Preferences dialog box and the particular settings chosen for 
that instrument. The minimum interval depends on the number of wavelengths, the Automix status, 
the number of strips, and the distance the monochromator and filter wheel of the instrument must 
move. If you set the interval time to be shorter than the instrument’s minimum read interval, the 
program will alert you with a message. Additionally, an interval that is too short will cause a 
warning message to appear telling you that no calibration can occur between reads. 

� NOTE: If you are writing a protocol that will be used with a different instrument (other than the one 
connected to the computer or chosen in the Reader preferences), you can disregard the alert and save the 
setup. However, if you attempt a reading using a protocol which has settings that are not correct for the 
particular instrument you are using, an error message will instruct you to change any setting that is out 
of range before a reading can be initiated. 

� NOTE: To achieve the shortest possible interval for Kinetic readings, choose wavelengths in ascending 
order. 
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Spectrum 

Values reported are optical density,  %Transmittance (if this has been selected in the Reduction dialog 
box), relative fluorescence units (RFU), or relative luminescence units (RLU). All Spectrum readings 
are made using the scanning monochromator of the instrument. 

 
Spectrum instrument settings with all options shown 
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Well Scan 

One or more readings of a single well of a microplate can be taken at a single or multiple 
wavelength(s). Values reported are optical density,  %Transmittance (if this has been selected in the 
Reduction dialog box), relative fluorescence units (RFU), or relative luminescence units (RLU). 

 
Instrument settings for a Well Scan reading 
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Read Type 
Choices for the read type are fluorescence, luminescence, or time-resolved fluorescence. Also 
included in this group of settings is bottom read. To select a read type, click the appropriate section in 
the Instrument Settings dialog box. All read modes are available for all read types. 

Fluorescence 

The light emitted by certain substances resulting from the absorption of incident radiation. To 
measure fluorescence accurately, it is necessary to reduce light scatter. The governing equation for 
fluorescence is: 

Fluorescence = extinction coefficient * concentration * quantum yield * excitation intensity * 
pathlength * emission collection efficiency 

Absorbance 

Measures the amount of light absorbed by a solution. To measure absorbance accurately, it is 
necessary to eliminate light scatter. In the absence of turbidity, absorbance = optical density - 
reflection. 

Luminescence 

The emission of light by processes that derive energy from essentially non-thermal changes, the 
motion of subatomic particles, or the excitation of an atomic system by radiation. 

Time-Resolved Fluorescence 

Most fluorescence substances are not suitable for this type of reading. However, the fluorescence 
emitted by lanthanide dyes is delayed long enough to measure fluorescence after the lamp is turned 
off. Time-resolved fluorescence is used to reduce the amount of background noise which interferes 
with fluorescence. The excitation lamp flashes and, after it is off, the delayed emission is collected for 
a set period of time before the lamp is flashed again. 

� NOTE: With the M5, selecting the Luminescence read type displays the integration time box next to the 
Read Type selection. 

 

� NOTE: With the M5, Time Resolved Fluorescence read type displays “Integration Delay” and 
“Integration” next to the read type selection instead of “Start” and “End.” 

 
Fluorescence Polarization 

By using a fluorescent dye to label a small molecule, its binding to another molecule of equal or 
greater size can be monitored through its speed of rotation. 

SpectraMax M5 Fluorescence Polarization read type returns two sets of data: one for fluorescence 
intensity parallel (P) to the excitation plane, and the other for fluorescence intensity perpendicular (S) 
to the excitation plane.  These S and P values are used to calculate the Polarization (mP) and 
Anisotropy (r) values in SoftMax Pro.  Although the Raw S&P value is the true raw data returned 
from the instrument, the calculated Polarization (mP) and Anisotropy (r) values are treated as raw 
data in SoftMax Pro, since these values become the basis for further reduction calculations.  You can 
select which data type to display by selecting the desired menu item in the Polarization Display pane 
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in the Display dialog on each plate section. The upper-right corner of the plate section will display 
the currently selected “raw” data type. 

  
All reduction calculations are based on either mP or r values and will not be calculated using the Raw 
(S&P) values. When the Raw (S&P) is selected, the mP value will be the base for all reduction 
calculations by default.  When exporting, the current raw values will be exported, for example, mP, r, 
or Raw (S&P).  The formula for the Polarization and Anisotropy calculations are: 

Polarization (mP) calculation: 

 
Anisotropy (r) calculation 

 
Wavelengths 

For Endpoint or Kinetic Readings 

Choose the number of different wavelengths to be read. At least one wavelength must always be 
specified. Selecting more than one wavelength will cause a corresponding number of wavelength 
setting boxes to appear (maximum six wavelengths). 

 
The wavelengths specified previously (or the defaults) will be shown in the boxes. You can choose a 
wavelength from the choices using the pull-down menu or simply highlight the wavelength you 
would like to replace and type a new wavelength (within the available range of the instrument) over 
the previous one. Note that the pull-down menu shows only common monochromator settings. 

For Spectrum Readings 

When Spectrum is selected, the Wavelengths section of the dialog box changes to request a 
wavelength scanning range and a wavelength increment (Step) between the start and stop settings. 

The minimum selectable increment is 1 nm. 
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Speed Read 

Speed Read performs a fast Spectrum scan of Plate sections or CuvetteSet sections. Speed Read does 
not measure the total amount of light available at each wavelength (I0) but uses the values stored in 
NVRAM of the instrument. As a result, Speed Read may not provide as accurate an absorbance 
measurement of each wavelength in the scan as with the normal mode. 

 
Speed Read 

Automix 
The Automix function is a patented feature that allows you to set automated shaking of the 
microplate. The options available for Automix depend on the read mode chosen and the type of 
instrument connected or chosen in the Preferences. 

 
Left: Endpoint or Spectrum Modes; Right: Kinetic Mode 

Before First Read 

This setting can be used with any read mode. Click the checkbox next to “Before First Read” to shake 
the microplate automatically for five seconds prior to the first reading. Whether you read at a single 
wavelength or at multiple wavelengths, enabling Automix for “Before First Read” will shake the 
plate for the set amount of time before the first wavelength reading only. You can accept the default value 
shown for the amount of time to shake the plate or enter a different value (up to 999 seconds) in the 
box to the right.  

Between Reads 

This option is applicable only to Kinetic readings and is displayed only when Kinetic mode is 
selected. To enable automatic mixing of the microplate between readings during a Kinetic assay, click 
the checkbox next to this setting. For readings at a single wavelength, “Between Reads” will shake the 
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plate for the set amount of time prior to each reading at that wavelength. For readings at multiple 
wavelengths, enabling “Between Reads” will shake the plate for the set amount of time before each 
reading at the first wavelength only. You can accept the default value shown for the amount of time 
to shake the plate or enter a different value (up to 999 seconds) in the box to the right. 

Blanking (Pre-Read Plate) 
The blanking selection found in the Instrument Settings dialog box is known as pre-read plate blanking, 
but pre-reading the plate is only one of five types of blanking available in SoftMax Pro. 
Understanding the differences between the types of blanking functions will enable you to choose the 
type of blanking that is appropriate for your assay. Note that blanks can be used in combination and 
have cumulative effects.  

If pre-read plate blanking is chosen, SoftMax Pro will prompt you to first read the blank plate after 
you click the [Read] button. 

 
Automix and Blanking 

The pre-read values will be stored in the data file and the individual well values collected during the pre-
reading of the plate will be subtracted from the individual well values obtained during the actual reading of 
samples. This is particularly useful for readings in the UV. Pre-read blanking may be turned off in the 
Reduction dialog box (click on the [Reduction] button) so the data may be seen with and without pre-
read blanking subtracted. This option is only available within the Reduction dialog box if pre-read 
blanking was chosen in the instrument setup. 

The purpose of pre-read plate blanks is to correct for well-to-well variability and, in the case of 
PathCheck, to subtract plate background before applying pathlength correction. 

� NOTE: A background constant subtraction setting is also available for the SpectraMax M2 or M5 in 
Endpoint mode (using the Instrument Settings > PathCheck option). If you pre-read a plate, you should 
not use a background constant subtraction and vice versa. 

Pre-read blanking is available for all read modes but is most useful for Endpoint readings. When 
used in Spectrum scan mode, the pre-read scan is subtracted on a point-by-point basis from the 
normal scan. If pre-read is selected using Kinetic mode (not generally recommended), a pre-read with 
the same Kinetic read interval and duration as the “normal” reading will be done and the 
OD/RFU/RLU at each time point of the pre-read will be subtracted from the OD/RFU/RLU of the 
corresponding time point of the “normal” reading. 

� NOTE: Molecular Devices recommends that the wells of the pre-read plate be filled with the appropriate 
buffer for the assay or with water when performing pathlength correction. 
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PathCheck Pathlength Correction  
The Instrument Settings dialog box includes a section for PathCheck (pathlength correction). When 
enabled, this feature can be used to normalize the data acquired from microplate readings to a 1 cm 
pathlength, thereby correcting each OD/RFU/RLU to the value expected if the sample were read in a 
1 cm cuvette, achieving significantly greater precision. Enable or disable pathlength correction by 
clicking in the checkbox at the top of this section. When enabled, a checkmark will appear in the box. 

   
PathCheck instrument settings 

Pathlength correction is used to report OD or percent transmittance for each microplate well with the 
depth of the fluid in the well normalized to 1 cm. Two methods for pathlength correction are 
available: one involves cuvette measurements (cuvette reference) and the other involves a pathlength 
correction constant stored in the instrument (water constant). The actual pathlength, d, of a solvent is 
found from the following equation: 

 
When a cuvette reference is used for pathlength correction, the value of k is obtained by taking OD 
measurements on the fluid in the cuvette at two wavelengths, 1000 and 900 nm: 
  

 
When using the pathlength correction constant (water constant), the value of k is obtained from the 
instrument. This constant is recorded into nonvolatile memory when the instrument is manufactured 
and may differ slightly from instrument to instrument. 

Once the actual pathlength, d, in cm is found, the following equation is used to perform the 
pathlength correction: 

 
Pre-Read Blanking vs. Background Constant Subtraction 

In previous versions of SoftMax Pro, selecting PathCheck automatically enabled the Pre-Read Plate 
(blanking) function which is used to subtract the absorbance due to the plate material on a well-by-
well basis before pathlength correction is applied. Now, however, the program default enables 
subtraction of a background constant (default is 0.0) from the absorbance values that are read. Often 
users do not take the time to pre-read plates (which provides the most accurate method for reducing 
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background signal from absorbance readings). Subtracting a background offset provides a better 
result if no pre-read blanking is chosen. 

� NOTE: If you choose to pre-read a plate, be sure to disable the background constant subtraction (both 
choices are available in the Instrument Settings dialog box). 

To pre-read a plate, place water in the wells. Wells pre-read with water generally have less 
absorbance than do dry wells (e.g., at 426 nm, Nunc microplates read with and without water in the 
wells give absorbance values of approximately 0.037 and 0.049, respectively). Thus, pre-reading a dry 
plate results in pathlength-corrected absorbance values that are lower than the cuvette values. If the 
pre-read step is omitted entirely, the pathlength corrected results are overcorrected. 

If the plates are sufficiently transparent at the wavelength(s) of interest and have low well-to-well 
variability, the pre-read doesn’t have to be made on the same plate that will contain samples—
another clean plate from the same lot will be adequate. More conveniently, a single plate can be pre-
read and that pre-read data can be stored for subsequent use. SoftMax Pro allows you to copy and 
paste pre-read plate data from one plate section to another, provided the instrument settings are 
identical in the two plate sections.  

If the plates are inherently variable at the wavelength(s) of interest, however, it may be necessary to 
use the same plate for pre-reading and reading samples to ensure that adequate well-by-well 
correction is achieved. 

Wells to Read/Strips Selection  
You may choose to read only certain wells or columns (or strips) of wells in the microplate or to read 
the entire plate. Partial-plate reading is available for all reading modes, although it is most useful for 
fast Kinetics and limited Spectrum analyses. The time required for Kinetic and Spectrum readings 
may be significantly reduced using this setting since the instrument does not have to read the entire 
plate.  

To enable a partial-plate read, highlight the desired columns (see the figure below). Columns do not 
need to start with “1” but must be contiguous. 
  

 
Strips/Wells to Read 

If you enable a partial-plate reading, only the wells to be read will be visible in the data display, 
indicating that no data will be collected for the other wells (all wells will be present in the Template 
Editor, however). 



Chapter 5: Data Collection: SpectraMax M2 & M5  

200 SoftMax Pro User’s Manual 

AutoCalibrate 
This checkbox allows you to disable or enable automatic calibration for all instruments. The default 
setting is checked (enabled). Turning AutoCalibrate off allows the instrument to complete readings 
more quickly or to begin the first reading of a Kinetic plate faster. However, you should allow the 
instrument to perform autocalibration of at least one plate prior to disabling this function: calibration 
settings for the last plate which included an autocalibration are maintained in the instrument 
memory (NVRAM) until another autocalibration is performed. 

AutoRead 
This feature enables the automatic reading of subsequent Plate sections in the order in which they 
appear within an experiment. By entering a value in the “Delay” text field, you can set the delay time 
interval between the plate reads. 
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Assay Plate Type 
This setting determines the display of wells in the microplate—it should be set to match the type and 
number of wells in the actual microplate that will be read.  

 
Assay Plate Type 

� NOTE: Changing the Plate Type within a Plate section causes well assignments stored in the previous 
template to be discarded. The groups created previously remain, however, so you can select new wells 
and simply apply existing groups to these wells. 

Defining New Plate Types 

The Plate Type list includes entries for microplates with standard dimensions and additional entries 
for plates that work best with custom settings. For both 96- and 384-well plates, the Standard plate 
should be used unless a custom setting is shown for the microplate you are using. 

 
Sensitivity (Fluorescence/Luminescence Only) 

 
Sensitivity 

Readings 

This setting determines the number of readings that will be performed on each well of the microplate 
(readings are averaged and the average reading is displayed). In the figure below, the left side shows 
the default setting for fluorescence; the right shows changing this setting for more precision with a 
greater number of readings per well. 
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The default number of readings per well varies with the read type: for fluorescence, the default is 6; 
for luminescence, the default is 30; for time-resolved fluorescence, the default is 20. The number of 
readings is variable from 1 to 30.  

� NOTE: With the luminescence read mode, the integration time is directly proportional to the number of 
readings per well determined by this setting. Each reading per well is equal to 3.2 milliseconds of 
integration time. 

PMT Sensitivity 

The PMT (photomultiplier tube) is a vacuum tube that detects light, especially from dim sources, 
through the use of photoemission and successive instances of secondary emission to produce enough 
electrons to generate a useful current. Clicking in the box causes a menu of choices to appear. 
Automatic is present only when Endpoint mode is chosen. Otherwise, settings are manual and 
limited to High, Medium, or Low. 
  

 
PMT sensitivity 

The voltage of the photomultiplier tube may be set to low (for samples having a higher 
concentration), medium, or high (samples having lower concentration) in all read modes. In Endpoint 
mode, an additional setting, automatic, is available. This setting allows the instrument to adjust the 
PMT voltage automatically for varying concentrations of sample in the plate. 

� NOTE: The Automatic option is not available in Fluorescence Polarization read mode. If Automatic was 
previously selected, Medium will be selected by default. 

� With the SpectraMax M5, the PMT Sensitivity is always set to Automatic for Luminescence and TRF read 
types.   

Well Scan Editor 
The Well Scan read mode allows readings to be taken at more than one location within a well. In the 
Instrument Settings dialog, all the options that are included for Endpoint reads are available for Well 
Scans. One additional option is available: the Well Scan Editor allows the user to specify how a Well 
Scan is performed. Four patterns are provided: a horizontal line, a vertical line, a cross (which is a 
combination of a horizontal and vertical line), and a grid pattern. The user also specifies a density 
setting, which determines the number of points read in the line patterns or the maximum number of 
horizontal and vertical points included in the grid pattern. With the grid pattern, points that land too 
close to the edges of the well are excluded. All points that land within 2.8 mm of an edge are 
excluded. Only odd numbers of points are included in density settings. The minimum number of 
points is 3 for all plate sizes. The maximum number of points depends on the well diameter. To 
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determine the maximum number of points included in density settings, 5.6 mm is subtracted from 
the well diameter, the remainder is divided by 0.8 mm and the largest odd integer that is less than 
this number used. 

 
Well Scan Editor 

The Well Scan Editor provides information on the number of points to be read, the point spacing and 
the approximate read time depending on the pattern and density settings. Point spacing is 
determined by subtracting 5.6 mm from the well diameter and dividing the remainder by the density. 
The minimum point spacing is 0.8 mm. 

In the Display dialog for Well Scan plates, the user can choose between a gray scale display, showing 
reduced values or showing both. With multiple wavelength pair Well Scans, the user can choose 
between viewing the data from different wavelengths separately or together. The default reduction is 
the average of all points in a scan. The minimum value, maximum value, and Custom reductions are 
included as in the reduction drop-down list. Plate Sections default to presenting the points read in a 
Well Scan in gray scale. For multiple wavelength pair Well Scans, the readings from different 
wavelength pairs are shown in different colors. The first wavelength pair is shown in black. The 
second wavelength pair is shown in blue. The third wavelength pair is shown in read. The fourth 
wavelength pair is shown in yellow. For each position in a Well Scan, the color for the wavelength 
pair with the highest reading is shown. Well scan data can also be viewed in well graphs. 

The SoftMax Pro export format has been extended to include Well Scans. Well scan has been added to 
the read mode field (field 5). The number of points read is reported in field 9. The Well Scan pattern 
is reported in field 10. The Well Scan density is reported in field 11. The data from each position is 
output in subsequent rows or plates starting with the top, left point and proceeding with horizontal 
priority.  

Settling Time 
This option helps to reduce sloshing in microplate wells.  

When Fluorescence Polarization read type is chosen, settling time adds a delay between the reading 
of each well in a column.  

For all other read types, the selected delay is added between the reading of each column (no delay 
between each well). 
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Column vs. Wavelength Priority During a Reading 
Depending upon the type of instrument connected to the computer or chosen in the Reader 
Preferences, a priority is given to reading by “column” or “wavelength.” It is most important to 
understand this priority with multi-wavelength readings. 

In column priority, an instrument will read the entire microplate (or chosen number of strips) at the 
first wavelength, and will then go back and read the microplate at the second and subsequent 
wavelengths. 

In wavelength priority, the instrument will read all wavelengths for the first column of wells in the 
microplate, and will then read all wavelengths for the second column, etc. 

The table below shows the priority settings by instrument for the different read modes. 

Column vs. Wavelength Priority 

 Endpoint Kinetic Spectrum 

SpectraMax M2 or M5 Column Wavelength Column 

 

Edit Plate Type 
When your plate section has been properly configured (See Instrument Setup) you may customize the 
plate type in SoftMax Pro. With the plate section selected, select Edit Plate Type... from the Plate 
menu. 

 
The Plate Type Editor includes five fields for entering, in millimeters, the distance from the left edge 
of the plate to the center of well A1, the distance from the top edge of the plate to the center of well 
A1, the horizontal distance between wells, the vertical distance between wells and the well diameter.  
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� NOTE: The number entered into the field for the distance from the left edge of the plate to the center of 
well A1 must also include an offset to accommodate the angle of the optics. Appropriate measurements 
should be taken in the lab to determine the correct settings for these fields.   

When the Plate Type Editor dialog is opened, the currently selected plate is shown with an asterisk 
(*) added to the end.  This name can be changed as desired. The plate settings shown will also be 
determined by the currently selected plate.   

When all data has been entered and the save button is selected, the plate information will be stored in 
a file named Custom Plates in the SoftMax Pro folder.   

� NOTE: When a file with a custom plate is opened on another computer, a warning will be displayed 
indicating that the plate type will be changed to the standard plate type.  

Template Editor 
The Template Editor is available for Plate and CuvetteSet sections. In both cases, it is used to describe 
the location of samples, either in the wells of the microplate or in a cuvette, providing the link 
between the raw data and the analysis groups. The Template Editor is used to create a template 
which provides SoftMax Pro with a map of what is in the microplates and/or cuvettes. 

When you first open the Template Editor for a new Plate section or CuvetteSet section, the grid or 
display is empty. After selecting wells or cuvettes, you can assign groups, and indicate the type of 
samples they will contain. 

Depending upon the default protocol you are using, certain group names (and associated sample 
descriptions) may have been created. You can use these predefined groups and/or create new groups 
to suit your needs. When creating new groups, you may enter any name you wish. Once entered, this 
name will be available for use in that experiment thereafter. New groups can be created 
independently from selecting or assigning any wells/cuvettes in the Template Editor. 

Each well/cuvette designated as being part of a group has associated with it a group name, a sample 
name (or replicate ID), a sample descriptor (optional), and a default column format (group type, such 
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as Standards, for example). When a group is applied to selected wells or cuvettes, the group name is 
displayed in bold type over the wells/cuvettes and the wells/cuvettes bear the same color. 

  

Groups are always visible, both in the Template and in the data display of the Plate section or 
CuvetteSet section. Even though they are grouped, single wells or cuvettes are still selectable in either 
the Template Editor or the data display. 

Samples and groups may exist across multiple Plate sections or CuvetteSet sections as well as within 
a single Plate section or CuvetteSet section. 

Each template is built upon a hierarchy as follows: the template is composed of samples and groups. 
A set of one or more replicate wells makes up a sample. A set of related samples forms a group. For 
example, you may have a group named Standards that consists of seven samples named STD01, 
STD02 ... STD07. Group names may be up to 32 characters long, while sample names may be 300+ 
characters long. Samples may be assigned one at a time using the [Assign] button or several at the 
same time using the [Series] button. 

If you create a group in the Template Editor but do not assign any wells to the group, a section for 
that group will still be created automatically when you close the template. You can remove the group 
(both its section in the window and its group name in the template) by making that Group section 
active and choosing Delete Groupname (where “Groupname” is the name assigned to that group in 
the template) from the Edit menu. Using the Macintosh, you can also delete the selected Group by 
pressing –; within Windows, you can press [CTRL]+[–]. Note that deleting the wells assigned to a 
group from the template does not delete the corresponding Group name from the drop-down list. The 
only way to remove a group name from this list in the Template Editor is to delete the corresponding 
Group section from the experiment. 

Selecting Wells or Cuvettes in the Template Editor 
In the Template Editor for a Plate section or a CuvetteSet section, you can select one or more wells or 
cuvettes by clicking or dragging on the grid. Multiple (contiguous) wells or cuvettes can be selected 
by dragging across them. Non-contiguous selections can be made by holding down the [Shift] key 
and clicking individual wells or cuvettes. Clicking a row label will select the entire row; clicking a 
column label will select the entire column. Contiguous columns or rows (1-12 or A-H, for a 96-well 
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plate, for example) can also be selected by dragging. Non-contiguous columns or rows can be 
selected by holding the  (command) key on the Macintosh or the [CTRL] key in Windows and 
clicking in labels. 

 Double-clicking anywhere within a group will select the entire group. 

 To deselect all wells quickly, click in the empty border around the Template. 

 When you leave the Template Editor (by clicking the [OK] button), the Plate/CuvetteSet section 
will show the boundaries of the groups created in the template. Group labels and sample 
descriptors will not be visible—you can see them by holding down the [CTRL]+[Shift] keys. 
When you release the key(s), the original view of the Plate section or CuvetteSet section will 
return.  

Template Editor Tool Bar 
The tool bar will appear differently depending upon what type of group is selected in the Group 
drop-down list. The following illustration shows how the tool bar will appear under various 
circumstances. 

 
The Template Editor Tool Bar 

The tool bar is divided into three areas: the Group area, the Sample area, and the Assign area. 

The Group Area 

The Group area contains the Group drop-down list which allows you to assign wells to existing 
groups, create new groups, or modify (using the [Edit] button) existing groups. In addition, it 
contains the [Clear] button which allows you to clear well assignments in the template. 

Group Drop-Down List 

This drop-down list consists of two areas, divided by a horizontal gray line. The two items below the 
gray line (Blank and New) are always available. Items above the gray line are custom groups that 
may be created as you wish. 

The Group drop-down list will appear differently depending upon the custom groups that have been 
created (by default or by the user). The figure below shows two different instances of the appearance 
of the Group list. 
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� NOTE: Depending on the default template used when opening SoftMax Pro, initially no groups may 
appear above the gray line. As you create new groups, they will be positioned above the line. 

 Blank—Creates a plate blank in the active section. Note: the name “blank” is reserved for use by 
the SoftMax Pro program and should not be used when creating custom groups. 

 New—Creates a new group. The Group Settings dialog box will appear (see the image below) 
showing default settings. This dialog box allows you to define the name for a group of related 
samples, what type of descriptor will be associated with these samples, and the initial column 
format for the Group section. Whenever a new group is created (whether or not wells are 
selected in the template), a Group section (table) will also be created. To delete a group, you 
must delete the Group section. Simply clearing a group from the Template Editor will remove 
the assignment of wells to that group name, but the name will still show in the group pull-down 
menu and the Group section will still exist. 

 
Group Settings 

Name: Use either the default name, “Group#X,” where “X” is an integer that is initially set to “1” and 
increments (i.e., “1,” “2,” “3,” etc.) as other groups are created, or enter a custom name (up to 32 
characters in length). 

In the Sample Descriptor area of the Group Settings dialog box, you can enable the application of the 
sample descriptor, if appropriate by clicking the checkbox. You may also choose the units used for 
the sample descriptor by selecting an option from the Units drop-down list or by typing the units you 
wish to use into the list box. 

The Sample Descriptor is automatically enabled when either the Standards or Unknowns(Dilution) 
column format (see below) is selected. The descriptor defaults to Concentration with the Standards 
column format and to Dilution with the Unknowns(Dilution) column format. The Sample Descriptor 
may also be used for time or fraction number information. 
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� NOTE: No sample descriptor is assigned automatically for the Basic or Unknowns column format. You 
may assign a sample descriptor to these column formats manually but, if you choose to do this, the 
information will not appear automatically in the Group section. To see it, you will need to create a new 
column containing the formula !Sampledescriptor. For more information about creating columns, see 
“Adding Columns”. 

Column Format defines the default column types that will be created for a new group or shows the 
original column format setting that was used to create the group you are editing. 

Four selections are offered: Basic, Standard, Unknowns, and Unknowns (Dilution). Different types of 
columns will be created for a new group, or changed in an existing group, depending on which of 
these column format settings you select. The table below shows the default columns created with 
each selection type. 
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Columns Created and Their Formulas 

 Basic Standard Unknown Unknown(Dilution) 

Name Sample Sample Sample Sample 

Formula !SampleNames !SampleNames !SampleNames !SampleNames 

Name Wells Wells Wells Wells 

Formula !WellIDs !WellIDs !WellIDs !WellIDs 

Name Sample# Concentration Values Values 

Formula Index !Concentration* !WellValues !WellValues 

Name Values Values R (Outside Standard Range) 
R (Outside Standard 
Range) 

Formula !WellValues !WellValues 

If(Values)>=‘MinStd@ 
Standards’ and  
Values<=‘MaxStd@Standards’, 
“”,“R” 

If(Values)>=‘MinStd@ 
Standards’ and Values<=
‘MaxStd@Standards’, 
“”,“R” 

Name Mean Value MeanValue Result Result 

Formula Average(Values) Average(Values) 
InterpX(STD@ 
StandardCurve,Values) 

InterpX(STD@ 
StandardCurve,Values) 

Name Std.Dev. MeanResult MeanResult 

Formula Stdev(Values) Average(Result) Average(Result) 

Name CV% Std.Dev. Std.Dev. 

Formula Cv(Values) Stdev(Result) Stdev(Result) 

Name CV% CV% 

Formula Cv(Result) Cv(Result) 

Name Dilution 

Formula !Factor* 

Name Adj.Result 

Formula 

 

 

 

MeanResult*!Factor 

 

* !Concentration and !Factor are from SoftMax Pro version 1.x. !Concentration, !Factor, and 
!SampleDescriptor return identical information. 
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The [Edit] Button 

When you click the [Edit] button, the Group Settings dialog box will appear, reflecting the settings for 
the active group (currently visible in the group drop-down list). If you wish to edit a group that is not 
currently active, first choose the group from the drop-down list and then click the [Edit] button. The 
figure below shows the Group Settings dialog box for the active group called “Patient#1.”  

 
Group settings with all options shown 

The name, sample descriptors, and column format can be changed for the group that you are editing. 

When you edit a group, you will notice that the information shown for the Column Format in the 
Group Settings dialog box changes to show the name of the original group used to define the group 
columns (see the figure below). 

 
Group settings options 

� CAUTION: Changing the column format will cause the columns in the group to revert to their 
original defaults as shown in the table above. If you have added columns or changed column 
information within the existing section for the group you are editing, these changes will be 
removed. 
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The [Clear] Button 

Allows you to deselect, or clear the selected items. Highlight what you wish to clear and then click 
the [Clear] button. 

The Sample Area 

The Sample area contains the Sample drop-down list and sample descriptor values (active if defined 
in the Group Settings dialog box or if assigned automatically by SoftMax Pro). 
  

 

� CAUTION: When changing sample names or descriptors, be sure all wells  are replicates of the 
same sample and group or that you want them to become replicates of the same sample and 
group. SoftMax Pro does not prohibit selecting individual wells from different samples and/or 
groups, for example, and changing their descriptions—and they will change to become the same. 

Sample Drop-Down List 

The sample drop-down list consists of two areas divided by a horizontal gray line. Before other 
sample names have been defined, a single, pre-defined name (“BL”) appears below the gray line (the 
sample name “BL” is the name reserved by SoftMax Pro for group-associated blanks). The item above 
the gray line is the sample ready to be or currently being assigned. After being assigned, it will be 
shown below “BL” below the gray line. 

 
When this list first appears, the only selection shown below the dividing line is “BL”; the active 
sample name that is ready to be assigned appears above the line. 

When samples are assigned to a group, the default name is the first 3 letters of the group name 
followed by a number. For a group called “Standard,” for example, the default sample names would 
be Sta01, Sta02, Sta03, and so on. Sample names can be 300+ characters long; however, only the first 
five or six characters will be displayed in the template and in the Plate section. 

� NOTE: You can type a sample name directly into the box next to the arrow for the drop-down list by 
highlighting and typing over the existing sample name. If one or more wells or cuvettes were 
highlighted, typing a different name will replace the sample name shown in the template with the name 
you have typed and, if the name is new, will add this name to those that can be chosen in the drop-down 
list. 

When wells or cuvettes have been selected in the template and sample names have been defined, the 
sample menu will look like the one below. The checkmark indicates the sample that is currently being 
named. 

 
Sample Drop-Down List—Sample Names Defined and Wells Selected 
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Sample Descriptor Field 

The field associated with the sample descriptor only appears in the Template Editor tool bar if the 
group column type that has been selected requires this type of information. Generally the information 
entered in this field is a dilution or concentration. Position the cursor in this field and enter a number. 
The label and units assigned to the sample descriptor in the Group Settings dialog box are shown on 
either side of the field. 

Assign Area 

The Assign area contains the [Series] and [Assign] buttons. 

 
Assign Area of the Template Editor Tool Bar 

Assign Button and Function 

Click this button to apply a sample name to one or more wells that have been selected in the 
template. You may also perform this operation by using the [Enter] key on your keyboard. 

Series Button and Function 

This button is used to define several samples as a series, allowing you to easily enter incremental 
sample descriptors (for example, dilutions or concentrations) and sample names to the template as 
long as the increment can be expressed as a mathematical operation.  

Replicate Samples and Samples in a Series 

You can assign the same group or sample definition (same sample name and description within a 
group) to multiple wells to create replicates. For example, you might want to read standards in 
replicate to ensure that anomalies can be excluded prior to generating a standard curve. Replicates 
can be created using the [Assign] button or with the series function. 

Creating a series is faster than assigning replicates individually. The series option can be used as long 
as the replicate values conform to a pattern that can be described by a mathematical operator 
(multiply by 2 or add 5, for example). 

A series is defined in one direction (starting from left, right, top, or bottom) and therefore samples 
must be arranged sequentially in either ascending or descending order. 
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To create a series, do the following: 

1. In the Template Editor, highlight the wells to be part of the series. The wells must be in the 
shape of a rectangle. 

 
Template with Wells Selected for a Series 

2. Click the [Series] button to open the Series dialog box. 

 
Series Dialog Box 

3. Specify the name of the first sample in the series in the box (or accept the default provided by 
SoftMax Pro). Subsequent replicates use this name as a base and either increment the number 
within the name or append a number to it. In the example above, the sample name provided by 
SoftMax Pro describes the first sample (“01”) in a group named “Standard,” here shortened to 
“Sta.” 

4.  The information shown in the box labeled Sample Descriptor is derived from the information 
entered in the Group Settings dialog box. If the information for sample descriptor or units is not 
correct, you may change it here. If you did not already do so, specify the starting value for the 
first sample in the series. Values for subsequent samples are calculated from this starting value. 

5. Choose the operator for the series (+, -, *, or /) from the Step by: drop-down list. Enter the 
starting value for the series in the Starting value: box. The increment is entered in the box to the 
right of the Step by: box and below the Starting value: box. The figure above shows a starting 
value of “0.5” with the operator being division (“/”) and the increment being “2.” Thus the series 
will start with a value of “.5” and divide each subsequent sample by 2 to produce the following 
series values: .5, .25, .125, etc. 
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6. You must assign a fill direction (from the top, bottom, left, or right—to describe how the series 
will fill the wells) and a number of replicates. Various options are diagrammed in the figure 
below using a 4 x 4 block of wells (for more information about replicates, see Replicate Samples 
and Samples in a Series, above). The maximum number of replicates depends on the selection of 
wells: if you are filling down from the top, for example, and you have chosen a block of wells 
that is 4 wells wide by 8 wells high, the maximum number of replicates will be four; with the 
same block of wells selected, filling from the left would allow eight replicates. If the number of 
replicates you choose does not divide evenly into the number of rows or columns you select, 
depending on the filling direction, the remaining wells that cannot contain replicates will be 
labeled as additional individual wells in the series. For example, if you fill a block of 4 x 4 wells 
from the top, and choose three replicates, then the first three columns will contain the replicates 
and the last column will contain the additional wells in the series (see the last diagram in the 
figure below). This replicate feature allows you to quickly define the number of replicates and, 
in cases where the series has more samples than a single row or column, to name them 
simultaneously. To create a series with all 96 samples, highlight all the wells in the plate, select 
the fill direction, and set the replicates to 1. 

 
Fill Options and Replicate Settings 

7. Click [OK] to save the series and close the dialog box. While still in the Template Editor, you can 
view the value assigned to any well by clicking that well. The value will be displayed at the top 
of the Template Editor. Holding down the [CTRL]+[Shift] keys will display the values for all 
wells. 

� NOTE: Sometimes you may wish the names of a series of samples to increment but may not have a 
concentration or dilution factor that you wish to enter, or you want the concentration or dilution factor to 
remain constant. This can be done using the [Series] button, setting the starting value to 1 or another 
constant value, and either multiplying by 1 or dividing by 1. In this way, the names will increment but 
the value of concentration or dilution will not change. If you don’t have a concentration or dilution factor, 
simply deselect the sample descriptor checkbox if it is selected. 

� NOTE: If sample names are set to increment automatically using the Series function, be aware that 
SoftMax Pro will automatically truncate the sample name to three or four characters, including the 
incrementing number if the sample name starts with letters. If the sample name is entirely numeric, it will 
not be truncated. If sample names are very long, and they must be kept long for reference, you will have 
to set up your replicates manually and will not be able to use the series function. 
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Blanking 
In addition to the pre-read plate blanking selection found in the Instrument Settings dialog box, four 
more types of blanking are available in SoftMax Pro. Understanding the differences between the 
types of blanking functions will enable you to choose the type of blanking that is appropriate for your 
assay. Note that blanks can be used in combination and have cumulative effects. 

The five types of blanking that are defined in SoftMax Pro are: 

Ref (CuvetteSet section only) 

Performing a reference reading of the cuvette causes the Instrument to take a reading of the cuvette in 
the cuvette port. A single reference reading can be used with one or more cuvettes in a CuvetteSet 
section (the default applies to all cuvettes in the set) or different reference readings can be taken and 
applied to different cuvettes in the set. This reference read is then applied to sample reading.  

Plate Blanks (Plate section only) 

Wells can be assigned to a “Blank” group in the Template Editor. Unlike pre-read plate blanks, the 
average value of all the wells in a plate blank group is subtracted from all individual well values obtained 
during the reading of microplates. When PathCheck is selected for the Instrument, the Plate Blank is 
subtracted after pathlength correction. Plate Blank subtraction may be turned off in the Reduction 
dialog box so that the data may be seen with or without plate blank subtraction. 

� NOTE: Plate blanks are only subtracted from wells on the same plate to which they are assigned. The 
checkbox for Plate Blank subtraction only appears in the Reduction dialog box after data has been 
collected. 

For Kinetic and Spectrum data, the blank value is averaged and subtracted on a point-by-point basis. 
The example below shows a graphic representation of original and average plate blank data, 
followed by the resulting data with average subtracted. 

 
Graphic representation of original and average plate blank data 

Template Blanks (CuvetteSet section only) 

Similar in function to the Plate Blank used with Plate sections, Template Blanking occurs when 
cuvettes are assigned to a Blank group in the Template Editor of the CuvetteSet section. The average 
value of all the cuvettes in a template blank group will be subtracted from individual cuvette readings. For 
Kinetic and Spectrum data, the blank value is averaged and subtracted on a point-by-point basis. 
Template blanks are subtracted after the reference reading, if any, is subtracted. 

� NOTE: Template blanks are only subtracted from cuvettes within the same CuvetteSet section. 
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Group-Associated Blanks (Plates and Cuvettes) 

Blank wells or cuvettes can be assigned within any group (other than the “Blank” group) in the 
Template Editor. The average reduced value of the blank wells or cuvettes within that group will be subtracted 
from individual reduced values within that group only. This blanking function uses the reduced number 
(example: !Lm1-!Lm2, Vmax, etc.) only—it does not subtract on a point-by-point basis. When a group 
blank has been assigned, it is automatically subtracted. To see the reduced number without the group 
blank subtracted, mask the group blank wells or cuvettes. 

Group blanks apply to all wells or cuvettes in a group and thus may be subtracted from wells or 
cuvettes in more than one Plate section or CuvetteSet section. 

Blanking (Pre-Read Plate) 

The blanking selection found in the Instrument Settings dialog box is known as pre-read plate blanking, 
but pre-reading the plate is only one of five types of blanking available in SoftMax Pro. 
Understanding the differences between the types of blanking functions will enable you to choose the 
type of blanking that is appropriate for your assay. Note that blanks can be used in combination and 
have cumulative effects.  

If pre-read plate blanking is chosen, SoftMax Pro will prompt you to first read the blank plate after 
you click the [Read] button. 

 
Automix and Blanking 

The pre-read values will be stored in the data file and the individual well values collected during the pre-
reading of the plate will be subtracted from the individual well values obtained during the actual reading of 
samples. This is particularly useful for readings in the UV. Pre-read blanking may be turned off in the 
Reduction dialog box (click on the [Reduction] button) so the data may be seen with and without pre-
read blanking subtracted. This option is only available within the Reduction dialog box if pre-read 
blanking was chosen in the instrument setup. 

The purpose of pre-read plate blanks is to correct for well-to-well variability and, in the case of 
PathCheck, to subtract plate background before applying pathlength correction. 

� NOTE: A background constant subtraction setting is also available for instruments capable of using 
PathCheck (in the Instrument Settings > PathCheck option). If you pre-read a plate, you should not use a 
background constant subtraction and vice versa. 

Pre-read blanking is available for all read modes but is most useful for Endpoint readings. When 
used in Spectrum scan mode (SpectraMax instruments only), the pre-read scan is subtracted on a 
point-by-point basis from the normal scan. If pre-read is selected using Kinetic mode (not generally 
recommended), a pre-read with the same Kinetic read interval and duration as the “normal” reading 
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will be done and the ODs at each time point of the pre-read will be subtracted from the OD of the 
corresponding time point of the “normal” reading. 

� NOTE: Molecular Devices recommends that the wells of the pre-read plate be filled with the appropriate 
buffer for the assay or with water when performing pathlength correction. 

Blanks in Combination 

It is possible to use blanking functions in combination. You could perform a pre-read plate blanking, 
assign a blank group in the template, and also include blank wells within different groups. The 
effects of the different blanking functions are cumulative, so it is important to understand the function 
of each before using more than one type of blanking in a single assay. Pre-read blanking, plate 
blanking, Ref, and template blanking are applied to the raw data acquired from the instrument, 
whereas group blanks are applied to the reduced number. Group blank subtraction is only visible in 
the Plate section/CuvetteSet section when the reduced number is displayed. The figure below shows 
the last two types of blanks in the Template Editor. 

 
Blanks in combination 

In the figure above, note that the plate blank in the upper left appears as a separate group named 
“Blank” and individual samples within this group are named “BL.” The group-associated blank 
wells, shown in the upper right, are not a separate group—the samples, also named “BL,” are 
contained within the boundaries of the large group called “Unknowns” and are the same color as that 
group. 

� NOTE: In order to save changes you have made to the template in the Windows version of the Template 
Editor, be sure to click the [OK] button to close the window rather than clicking the Control Menu box. 
Clicking the Control Menu box (located in the upper left of the window) performs the same function as 
the [Cancel] button: the window will close but any changes you have made to the template will not be 
saved. 
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Copying/Pasting Templates 
Copying Template Information 

Two template actions—Copy and Paste—can only be activated from the Plate or CuvetteSet menu 
(when a Plate section or CuvetteSet section is active) rather than from the Template Editor. If you 
have created a template in a Plate section or CuvetteSet section and wish to use it in another Plate 
section or CuvetteSet section, you may copy that template and paste it into the new section. The 
results of copying and pasting a template depend upon whether the action is performed within the 
same experiment or between experiment sections. 

Copying and Pasting within the Same Experiment Section 
To copy a template, make the section containing that template active and choose Copy Template from 
either the Plate or CuvetteSet menu (the menu name changes to reflect the type of active section). 
Then activate the destination Plate section or CuvetteSet section and choose Paste Template from the 
Plate or CuvetteSet menu. 

 
Copy and Paste Template Commands (CuvetteSet menu shown) 

The group names and sample names of the pasted template are identical to those of the source 
template. In effect, the destination template is considered an extension of the original template and all 
wells on the destination plate are considered replicates of the wells on the source plate (same group 
and sample names). Any changes made to the template on the destination plate will also be made on 
the source plate. Data from the two Plate sections/CuvetteSet sections will be analyzed together. 

Copying and Pasting between Different Experiment Sections 
To copy a template, make the section containing that template active and choose Copy Template from 
either the Plate or CuvetteSet menu (the menu name changes to reflect the type of active section). 
Then activate the destination Plate section or CuvetteSet section and choose Paste Template from the 
Plate or CuvetteSet menu. 

The group names and sample names of the pasted template will be identical to those of the source 
template but, since they are in different experiments, the full name will be different (for example: 
group@experiment#2 instead of group@experiment#1). Any changes made to the template of the 
destination Plate section/CuvetteSet section will not affect the source section. Data from the two Plate 
sections/CuvetteSet sections will not be analyzed together. 
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Copying and Pasting Template Regions 

Contiguous regions of templates can be copied and pasted to other regions of templates (within the 
same or to a different experiment). All template settings are pasted into the new template except the 
group name: the new group is given the name “Group#X” where X is the next greater number than 
that used already for group names. 

To copy a region of a template, highlight the region and then select Copy from the Edit menu or press 
C (Macintosh) or [CTRL]+[C] (Windows). Only the highlighted wells will be copied. 

To paste the region into another area of a template, highlight the region and select Paste from the Edit 
menu or press V (Macintosh) or [CTRL]+[V] (Windows). 

Only the highlighted wells will have template information pasted into them. Data is pasted using 
row priority: all wells in a row of highlighted wells have information pasted into them before 
proceeding to the next row, from left to right. If fewer wells are highlighted for pasting than were 
copied, the data will be pasted until all paste-highlighted wells are filled. If more wells are 
highlighted for pasting than were highlighted for copying, the extra wells are left empty. 
 

Exporting/Importing Templates 
Templates can be exported or imported by opening the Plate section and choosing the appropriate 
command on the Plate or CuvetteSet menu.  

 
Template files can be prepared with other software applications, and then imported into SoftMax Pro 
when ready to run samples. How your particular templates should appear depends on the type of 
samples you will run, whether or not you will run them in replicate, etc. An example template, 
containing two wells with blanks, one column of standards, and the rest of the wells containing 
unknowns with replicates and serial dilutions, is shown below as it would appear in SoftMax Pro 
followed by a portion of the exported version of the same template as seen in a spreadsheet program. 
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Above: Template Example Showing Two Blanks, One Column of Standards, and the Rest Unknowns Run with 

Replicates and with Serial Dilution. 

 
Above: Export of the Template Example Shown in the Previous Figure 
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Templates can be set up in many different ways. If replicates are used, as with the example above, 
they can be set up horizontally from left to right (as this example shows) or right to left, or vertically 
from top to bottom or bottom to top. If you are generating template data by means of import from a 
bar code reader or other source, noting the manner in which the data is imported will be helpful in 
determining the best manner to set up the template. 

Examining the exported information from your individual template files will help you determine the 
best method for template creation outside of SoftMax Pro in order for the data to be acquired in the 
correct manner. 

Reading a Microplate or Cuvette 
Data Collection from a Microplate 

You can start a reading at any time after defining instrument settings. It is not necessary to define 
groups and assign wells within the Template Editor first. The values received from the instrument 
are raw absorbance readings and are not affected by settings in the Template Editor. Only instrument 
settings must be defined prior to reading a microplate.  

To read a microplate, open the drawer of the instrument (click the drawer button in the status bar, or 
choose Open Drawer from the Control menu) and insert the prepared microplate. Then simply click 
the [Read] button in the status bar or choose Read from the Command menu. 

If you have created more than one Plate section, and no Plate section is active, choosing the Read 
command will cause a dialog box to appear asking you to choose which section to read (see the figure 
below). Select the correct section and then click [OK] to close the dialog box. If a Plate section is 
active, choosing the Read command will read that plate. 

 
Plate selection dialog box 

A similar dialog box will appear if you have chosen to pre-read the plate for blanking. At the bottom 
of this dialog box, however, are two option (radio) buttons, allowing you to proceed with the pre-
read plate blank or to override this and read the “normal” plate. After reading the blank plate, you 
must start the read process again for the normal plate. The same dialog box will appear, but the 
default option button choice will be “Normal.” 
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If you select a Plate section that already contains data and choose to Read again, an alert appears, 
asking you to confirm replacing data in the destination plate.  

 
Replace data dialog box 

If you select [Replace], the reading will proceed and the previous data will be replaced with new 
data. 

After beginning a reading, the status bar will show the actions that are occurring in the instrument, 
along with a box showing the elapsed time for each action in minutes and seconds. The [Read] button 
will change to [Stop], allowing you to terminate a reading, if necessary. An example of the 
appearance of the status bar during a reading is shown below. 

 
Reading a Cuvette 

Data Collection from a Cuvette 

You can highlight any cuvette in the CuvetteSet section and choose to read it. If you select more than 
one cuvette, the software looks for the leftmost-selected cuvette that does not contain sample read 
data. When one is found, the reading begins with that cuvette. 

If you select a cuvette that already contains data and choose to Read again, an alert appears, asking 
you to confirm replacing data in the destination sample (see left side of the figure below). Similarly, if 
you choose Reference while a sample that has already had a reference reading performed is selected, 
the alert shown on the right side of the figure below appears. A similar alert is shown if you choose 
either read function with more than one cuvette selected (asking if you wish to replace the data or 
reference for all cuvettes). 
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For Kinetic and Spectrum modes, the raw data plot is automatically displayed as a graph in the 
cuvette. You can also enlarge the view of selected samples by double-clicking, by using the Well 
Graph button on the CuvetteSet section tool bar, or by choosing Graph... from the CuvetteSet menu. 

The instrument settings table shown on the right of a CuvetteSet section is similar to the one in a 
Plate section. Automix is not available for cuvettes. Instrument settings must be the same for all 
cuvettes in a CuvetteSet section. 

CuvetteSet sections have a limit of 96 cuvettes. Should this limit be reached, the New Sample sub-
menu of the CuvetteSet menu and the corresponding tool bar button will become unavailable 
(dimmed) and it will be necessary to create a new CuvetteSet section. 

After beginning a reading, the status bar will show the actions that are occurring in the instrument, 
along with a box showing the elapsed time for each action in minutes and seconds. The [Read] button 
will change to [Stop], allowing you to terminate a reading, if necessary. An example of the 
appearance of the status bar during a reading is shown below. 

 
Reference Reading 

As in a spectrophotometer, taking a reference reading can be done either on air or using a cuvette 
containing the buffer of your sample. The reading taken using [Ref] (using the button in the 
CuvetteSet Section Tool Bar or the Reference command from the Control menu) will be used as I0 to 
calculate the absorbance of the sample. If no reference reading is taken, the Instrument will use the I0 
values stored in the NVRAM of the instrument. 

A reference reading of the cuvette in the Instrument can be made at any time by choosing Reference 
from the Control menu or from the CuvetteSet section status bar. The Reference button is available 
when the active section is a CuvetteSet section. It is not visible when the active section is not a 
CuvetteSet section or if multiple sections are selected. 

If no reference has been taken in a CuvetteSet section and you then read a reference, SoftMax Pro 
assumes that this reference will be used with all cuvettes in the CuvetteSet section. Therefore, the 
time and date of the reading are displayed under each cuvette in the section (three cuvettes per row 
and one cuvette per row displays only). The reference will also be applied to any new cuvettes 
created in that section. The reference may be read before or after reading samples. 

You may have more than one reference per CuvetteSet section. If you have a single cuvette to which 
you want to apply a different reference, highlight that cuvette in the CuvetteSet section, place the 
second reference in the cuvette port, and click [Ref]. The time/date stamp of the reference for that 
cuvette (and only that cuvette in the set) will change. 

� NOTE: Any new cuvettes created in the CuvetteSet section after reading a second reference will use that 
new reference reading. 

When a reference is read, the system assumes that it will be used with all empty samples. Therefore, 
the date and time of the reference reading are displayed with each empty sample (including the 
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destination sample) currently in the CuvetteSet section. If you wish to use a different reference 
reading with one or more cuvettes in a section, click (or shift-click) the cuvette(s) and then click the 
[Ref] button. A dialog will appear, asking if you wish to replace the reference reading for the 
cuvette(s). Choosing [OK] will enable a new reference reading to be used for those cuvette(s). 

The reference read is automatically applied to the normal read. The reference value is not displayed 
in SoftMax Pro. If you wish to see the reference value, you can choose one of the following 
procedures: 

Procedure 1: 

1. Create a cuvette in the CuvetteSet section and [Ref] on air (empty cuvette port). 

2. Read a cuvette containing the blanking solution. 

If you wish to have both reference and read values available, do the following: 

1. 1. Create a cuvette set with up to the maximum of 96 cuvettes. 

2. Define a template blank in the CuvetteSet section. 

3. Place buffer in the cuvette and [Read]. 

4. [Read] the remaining samples. 

The optical density, relative fluorescence, or relative luminescence of the cuvette designated as the 
template blank will be subtracted from the optical density, relative fluorescence, or relative 
luminescence of all the other cuvettes in the CuvetteSet section. 

Procedure 2: 

1. Create a cuvette set with up to the maximum of 96 cuvettes. 

2. Reference and read the cuvette. 

3. Create a template with the appropriate groups. 

4. Create a column in each Group table with the formula !wellpreread!Lm1. 

� NOTE: If you have a multiple-wavelength reading and wish to see the reference at each wavelength, 
create additional columns with the formula !wellprereadLx where “x” is 2, 3, or 4, corresponding to the 
wavelength for which you want to see a reference. 

The OD/RFU/RLU with the reference subtracted will be displayed in the Values column. The 
reference value for each sample will be displayed in the custom column you have created. 

General Information about Reading 
Calibration 

When the instrument is connected (or chosen in the preferences), a Calibration command is available 
in the Control menu. Choosing this command opens the Calibration dialog box. The dialog box also 
shows the date of the most recent calibration. 
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Calibration dialog box 

Instrument calibration performs an air reading at all available wavelengths and stores those values in 
the non-volatile instrument memory (NVRAM). For plate readings, these air calibration values are 
used whenever a Spectrum reading is performed using the Speed Read option, thus reducing the 
time it takes to complete a Spectrum reading.  

� NOTE: Molecular Devices recommends that you update the air reference information that is stored in 
NVRAM periodically. This is particularly important if you are using Speed Read, reading cuvettes 
without a reference, or running Kinetics in microplates with read intervals that are too short to allow 
autocalibration. 

Column vs. Wavelength Priority During a Reading 

Depending upon the type of instrument connected to the computer or chosen in the Reader 
Preferences, a priority is given to reading by “column” or “wavelength.” It is most important to 
understand this priority with multi-wavelength readings. 

In column priority, an instrument will read the entire microplate (or chosen number of strips) at the 
first wavelength, and will then go back and read the microplate at the second and subsequent 
wavelengths. 

In wavelength priority, the instrument will read all wavelengths for the first column of wells in the 
microplate, and will then read all wavelengths for the second column, etc. 

The table below shows the priority settings by instrument for the different read modes. 

Column vs. Wavelength Priority 

 Endpoint Kinetic Spectrum 

SpectraMax M2 or M5 User choice1 Wavelength Column 

 

You can choose between wavelength and column (default) priority readings in the Instrument 
Settings dialog box. 
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Data Display During a Reading 

The values read by the instrument will appear in the data display as they are received from the 
instrument (in real time). Depending upon the read mode , the number of wavelengths, the plate 
type, and the display options selected, the data display will show one or more numbers or plots. 

Double-click a single well to enlarge its display to a Well Graph or hold the [Shift] key while selecting 
more than one well, and then choose Graph... from the Plate menu or click the graph button on the 
tool bar to display the data from multiple wells in one enlarged Well Graph. The data in the enlarged 
Well Graph will update to show new data points as they are received from the instrument. 

Other choices and settings within SoftMax Pro affect the way in which data is displayed—the type of 
reduction, specific time settings, and so on.  





  

  

Data Collection: LMax II and LMax II384 
Before reading a microplate, you must create the Plate section(s) and define the instrument settings 
for the reading. Instrument Settings must be defined prior to collecting data and may NOT be 
changed after data is collected. In addition, it is recommended that you define a template and set the 
reduction and display parameters prior to reading the microplate, since these parameters determine 
how data is displayed and analyzed, but these last parameters may be set up and/or modified after 
data collection. 

A typical process for preparing, collecting, and analyzing data is as follows: 

1. Launch SoftMax Pro software. 
2. Create Plate section(s) as needed. 
3. Define the Instrument Setup Settings from the Control menu. 
4. Define the template, reduction parameters, and display parameters. 
5. Prepare the microplate(s) to be read and place them in the instrument. 
6. Initiate the reading. 
7. Save the data file. 
8. Modify the template, reduction parameters, or display parameters (optional). 
9. Analyze the data using the Group section tables and Graph sections. 
10. Save the data file again when you are finished. 

Instrument Settings 
Instrument Setup 

� NOTE: Not all instrument settings are available with all instruments. Only the settings that pertain to the 
instrument that is connected to the computer or the one chosen in the Preferences will be shown in the 
Instrument Settings dialog box. 

You must specify the instrument settings prior to actually reading a microplate. Settings for the reading 
are made in the Instrument Settings dialog box, which can be accessed in three ways: 

1. Choose Instrument Setup... from the Control menu; 
2. Click the [Setup] button in the tool bar of the active, expanded Plate section; or 
3. Double-click anywhere in the settings box (located to the right of the well grid) in the active, 

expanded Plate section. 

� NOTE: You may create more than one Plate section in a single experiment, and the instrument settings 
associated with each Plate section can be different. Instrument Setup... can only be chosen while a Plate 
section is active, and the settings you choose will affect only that section. A new Plate section that is 
created in an experiment that contains an active Plate section will contain the same instrument settings 
found in the previously active section. The settings for the new section can be modified as desired. 

When you have defined the instrument settings, click the [OK] button to close the Instrument Settings 
dialog box. After closing, a summary of the instrument settings will appear in the box to the right of 
the data display in the Plate section. The instrument will use these settings to read the plate.  
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Instrument Settings Chart 

W
av

el
en

gt
h

Bl
an

ki
ng

 (P
re

-R
ea

d 
Pl

at
e)

Au
to

C
al

ib
at

e,
 A

ut
oR

ea
d,

 A
ut

om
ix

 B
ef

or
e

Ti
m

in
g

Au
to

m
ix

 B
et

w
ee

n

St
rip

s/
W

el
ls

 to
 R

ea
d

Pa
th

C
he

ck

Sp
ee

d 
R

ea
d

As
sa

y 
Pl

at
e 

Ty
pe

C
ol

um
n 

W
av

el
en

gt
h 

Pr
io

rit
y

In
te

gr
at

io
n

Sh
ak

e

Po
in

t C
ou

nt

In
je

ct
io

n 
an

d 
D

el
ay

In
je

ct
io

n 
W

el
ls

Endpoint • • • •
Kinetic • • • •
Fast Kinetic • • • •

Endpoint • • • • • • •
Dual Read • • • • • •
Kinetic • • • • • • •
Fast Kinetic • • • • • • •

Lmax II

Lmax II384

 
Read Mode 

Choices for the read mode are Endpoint, Dual Read, Kinetic, or Fast Kinetic. Available read modes 
depend on which type of instrument is connected or selected in the Preferences. To select a read 
mode, click the appropriate button in the Instrument Settings dialog box. 

Endpoint 

A single integration of samples in 96- or 384-well plates with two injections possible, if desired, in any 
or all wells of a 96-well plate (no injection possible in 384-well plates). The minimum integration time 
is 0.1 second. A pre-read of the microplate may be made before injection of buffer or reagent and/or 
reading of the samples. The signal is integrated for each well over a user-selectable reading time 
(maximum 5000 seconds). You can program a delay after each injection, if desired (up to 1000 
seconds with a minimum of 1.6 seconds for the P injection), and you can read all or only some of the 
wells in the plate. Values are reported as relative luminescence units (RLU); the default reduced 
value is !MValue. 
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Endpoint Instrument Settings with all options shown 

 

Dual Read (LMax II384 only) 

Also an endpoint reading, this mode is designed to perform two separate integrations, one after each 
of two possible injections in any or all wells of a 96-well plate. Integration times for both readings will 
be the same, unless otherwise selected (minimum integration time is 0.1 second; maximum is 9,999 
seconds). 
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Dual Read Instrument Settings with all options shown 

You may program a delay after each injection, if desired (from 0 to 9,999 seconds for the M injection 
and from 1.6 to 9,999 seconds for the P injection), and you can read all or only some of the wells in the 
plate. Pre-reading of the microplate is not possible with this mode. Default values reported are 
relative luminescence units (RLU). The default reduced value is !MValue. 
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Kinetic 

Data is collected over time with multiple readings taken at regular intervals. The default reduced 
values calculated for Kinetic data are Vmax (mOD/min), Time to Vmax (seconds), Onset Time 
(seconds), Time at Minimum, Time at Maximum, Time at 1/2 Maximum, Slope, and Area Under 
Curve. 

 

Kinetic instrument settings with all options shown 

 

Fast Kinetic 

This mode allows repeated readings of one or more wells of a 96- or 384-well microplate up to a 100-
point maximum integration. All readings of a single well are made, after which the next well is read, 
and so on. One or two injections can be made in each well of a 96-well microplate at the start of the 
reading. Pre-reading of the microplate is not possible with this mode. Integration time can be set from 
0.1 to 100 seconds. Default data reductions for kinetic data are Vmax per Sec, Vmax, Time to Vmax, or 
Onset Time. 
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Fast Kinetic instrument settings with all options shown 

 

Integration 
Enter the amount of time to perform a single integration (from 0.1 to 100 seconds). Dual Read mode 
allows the choice of “special”: enter a separate integration time for P and M injections. In Kinetic 
mode, enter the total run time and the desired interval between readings. After entering this 
information, the total number of Kinetic readings that will result will be shown below the run time. If 
you set the interval time to be shorter than the instrument’s minimum read interval, the program will 
alert you with a warning message. In Fast Kinetic mode, enter the integration time followed by the 
number of times this integration should be repeated for each well before moving to the next well. 
After entering this information, the total time to read the selected wells will be shown. 
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Pre-Read Plate Blanking (Endpoint mode only) 
The blanking selection found in the Instrument Settings dialog box is known as pre-read plate blanking, 
but pre-reading the plate is only one of five types of blanking available in SoftMax Pro. 
Understanding the differences between the types of blanking functions will enable you to choose the 
type of blanking that is appropriate for your assay. Note that blanks can be used in combination and 
have cumulative effects.  

If pre-read plate blanking is chosen, SoftMax Pro will prompt you to first read the blank plate after 
you click the [Read] button. 

 
Integration and Pre-read 

The pre-read values will be stored in the data file and the individual well values collected during the pre-
reading of the plate will be subtracted from the individual well values obtained during the actual reading of 
samples. This is particularly useful for readings in the UV. Pre-read blanking may be turned off in the 
Reduction dialog box (click on the [Reduction] button) so the data may be seen with and without pre-
read blanking subtracted (this option is only available within the Reduction dialog box if pre-read 
blanking was chosen in the instrument setup). 

The purpose of pre-read plate blanks is to correct for well-to-well variability and, in the case of 
PathCheck, to subtract plate background before applying pathlength correction. 

� NOTE: Molecular Devices recommends that the wells of the pre-read plate be filled with the appropriate 
buffer for the assay or with water when performing pathlength correction. 

Wells to Read/Strips Selection  
You may choose to read only certain wells in the microplate or to read the entire plate. Partial-plate 
reading is available for all read modes; the time required for readings may be significantly reduced 
using this setting if the instrument does not have to read the entire plate. To configure the settings for 
a partial-plate read, choose the Wells to Read setting. 
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Wells to read/Strips selection 

Highlight the wells to be read. Wells must be contiguous but do not need to start in any particular 
place. If you enable a partial-plate reading, only the wells to be read will be visible in the data 
display, indicating that no data will be collected for the other wells (all wells will be present in the 
Template Editor, however). 

Assay Plate Type 
This setting determines the display of wells in the microplate—it should be set to match the type and 
number of wells in the actual microplate that will be read. 

 
Assay Plate Type 

� NOTE: Changing the Plate Type within a Plate section causes well assignments stored in the previous 
template to be discarded. The groups that were created previously remain, however, so you can select 
new wells and simply apply existing groups to these wells. 

� NOTE: Switching between 96- and 384-well plates requires a hardware reconfiguration on the LMax as 
well as the designation of Plate Type in the software. Choosing a different plate type will cause a message 
to appear on the screen reminding you that the physical setup must be altered and that you must also 
choose an additional setting in the Control menu to ensure that the proper hardware for that plate type 
has been configured. 
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Shake 
This function shakes the plate to mix the injected reagent with the solution in the microplate. You 
may specify a duration in seconds. Shaking begins upon clicking the Read button. 

 
Shake 

Injection and Delay 
Allows you to specify the volume and delay between P and M Injections or between injection and 
measurement.  

 
Injection and Delay 

Injection Wells 
The injection system can only be used with 96- and 384- well plates. The LMax II384 is equipped with 
two injectors having variable volumes: one (labeled “M” for measurement) injects directly in the 
reading position; the other (labeled “P” for pre-injection) injects into the preceding position. The 
injector volume can be set from 10 to 100 mL (determined in the Instrument Settings in SoftMax Pro 
software). The precision of the injected volume is ±3 µL. The LMax II384 allows free selection of the 
number and position of injections into the wells in 96-well plates. With 384-well plates, injection is 
only possible with the P injector. You can define delay times between injections and also between the 
last injection and the start of the reading. No instrument hardware changes are required to switch 
between injections into 96- and 384-well plates.  

High-precision pumps are used to carry out the injections. The SoftMax Pro software allows selection 
of one or both injectors for any well of a 96-well plate or the P injector when 384-well plates are used. 
Flexible delay times can be defined between the injections and also between the second injection and 
the start of the measurement. The injectors were specifically designed for this purpose and ensure 
both instantaneous sample mixing after injection and high precision of injection volume. The injector 
pumps, located on the right-hand side of the instrument below the reagent bottles, are covered by a 
metal plate.   
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Injector Configuration 
The respective injector number is always assigned to the same well position into which the respective 
injector injects. 

P Injector 2     Injection into well 1 position before measurement position. 

M Injector 3    Injection into well in measurement position. 

 
Injection well diagram 

Microplates 
White, opaque microplates yield optimum results for most applications. The light reflection with 
white microplates provides a high signal-to-noise ratio with very low crosstalk from adjacent plate 
positions. Clear-bottom microplates also give low crosstalk values, although the signal efficiency is 
reduced in comparison to white microplates. Transparent sample plates can not be used with the 
LMax II series instruments due to extremely high crosstalk. Black microplates are superior when used 
with “glow-type” luminescence measurements since extremely high dynamic measuring range and 
minimum crosstalk are required. The reading efficiency and the signal-to-noise ratio are lower in 
black plates because of the decreased light reflection. 

Template Editor 
The Template Editor is used to describe the location of samples, either in the wells of the microplate, 
providing the link between the raw data and the analysis groups. The Template Editor is used to 
create a template which provides SoftMax Pro with a map of what is in the microplates. 

When you first open the Template Editor for a new Plate section, the grid or display is empty. After 
selecting wells, you can assign groups, and indicate the type of samples they will contain. 

Depending upon the default protocol you are using, certain group names (and associated sample 
descriptions) may have been created. You can use these predefined groups and/or create new groups 
to suit your needs. When creating new groups, you may enter any name you wish. Once entered, this 
name will be available for use in that experiment thereafter. New groups can be created 
independently from selecting or assigning any wells in the Template Editor. 

Each well designated as being part of a group has associated with it a group name, a sample name (or 
replicate ID), a sample descriptor (optional), and a default column format (group type, such as 
Standards, for example). When a group is applied to selected wells, the group name is displayed in 
bold type over the wells and the wells bear the same color. 
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Template Editor window explanation 

Groups are always visible, both in the Template and in the data display of the Plate section. Even 
though they are grouped, single wells are still selectable in either the Template Editor or the data 
display. 

Samples and groups may exist across multiple Plate sections as well as within a single Plate section. 

Each template is built upon a hierarchy as follows: the template is composed of samples and groups. 
A set of one or more replicate wells makes up a sample. A set of related samples forms a group. For 
example, you may have a group named Standards that consists of seven samples named STD01, 
STD02 ... STD07. Group names may be up to 32 characters long, while sample names may be 300+ 
characters long. Samples may be assigned one at a time using the [Assign] button or several at the 
same time using the [Series] button. 

If you create a group in the Template Editor but do not assign any wells to the group, a section for 
that group will still be created automatically when you close the template. You can remove the group 
(both its section in the window and its group name in the template) by making that Group section 
active and choosing Delete Groupname (where “Groupname” is the name assigned to that group in 
the template) from the Edit menu. Using the Macintosh, you can also delete the selected Group by 
pressing –; within Windows, you can press [CTRL]+–. Note that deleting the wells assigned to a 
group from the template does not delete the corresponding Group name from the drop-down list. The 
only way to remove a group name from this list in the Template Editor is to delete the corresponding 
Group section from the experiment. 

Selecting Wells in the Template Editor 
In the Template Editor for a Plate section, you can select one or more wells by clicking or dragging on 
the grid. Multiple (contiguous) wells can be selected by dragging across them. Non-contiguous 
selections can be made by holding down the Shift key and clicking individual wells. Clicking a row 
label will select the entire row; clicking a column label will select the entire column. Contiguous 
columns or rows (1-12 or A-H, for a 96-well plate, for example) can also be selected by dragging. 
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Non-contiguous columns or rows can be selected by holding the  (command) key on the Macintosh 
or the [CTRL] key in Windows and clicking in labels. 

 Double-clicking anywhere within a group will select the entire group. 

 To deselect all wells quickly, click in the empty border around the Template. 

 When you leave the Template Editor (by clicking the [OK] button), the Plate section will show 
the boundaries of the groups created in the template. Group labels and sample descriptors will 
not be visible—you can see them by holding down the [CTRL]+Shift keys. When you release the 
key(s), the original view of the Plate section will return.  

Template Editor Tool Bar 
The tool bar will appear differently depending upon what type of group is selected in the Group 
drop-down list. The following illustration shows how the tool bar will appear under various 
circumstances. 

 

 
Template Editor Tool Bar 

The tool bar is divided into three areas: the Group area, the Sample area, and the Assign area. 

The Group Area 

The Group area contains the Group drop-down list which allows you to assign wells to existing 
groups, create new groups, or modify (using the [Edit] button) existing groups. In addition, it 
contains the [Clear] button which allows you to clear well assignments in the template. 

Group Drop-Down List 

This drop-down list consists of two areas, divided by a horizontal gray line. The two items below the 
gray line (Blank and New) are always available. Items above the gray line are custom groups that 
may be created as you wish. 

The Group drop-down list will appear differently depending upon the custom groups that have been 
created (by default or by the user). The figure below shows two different instances of the appearance 
of the Group list. 
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Group drop-down list 

� NOTE: Depending on the default template used when opening SoftMax Pro, initially no groups may 
appear above the gray line. As you create new groups, they will be positioned above the line. 

 Blank—Creates a plate blank in the active section. Note: the name “blank” is reserved for use by 
the SoftMax Pro program and should not be used when creating custom groups. 

 New—Creates a new group. The Group Settings dialog box will appear (see the image below) 
showing default settings. This dialog box allows you to define the name for a group of related 
samples, what type of descriptor will be associated with these samples, and the initial column 
format for the Group section. Whenever a new group is created (whether or not wells are 
selected in the template), a Group section (table) will also be created. To delete a group, you 
must delete the Group section. Simply clearing a group from the Template Editor will remove 
the assignment of wells to that group name, but the name will still show in the group pull-down 
menu and the Group section will still exist. 

 
Group settings dialog box 

Name: Use either the default name, “Group#X,” where “X” is an integer that is initially set to “1” and 
increments (i.e., “1,” “2,” “3,” etc.) as other groups are created, or enter a custom name (up to 32 
characters in length). 

In the Sample Descriptor area of the Group Settings dialog box, you can enable the application of the 
sample descriptor, if appropriate by clicking the checkbox. You may also choose the units used for 
the sample descriptor by selecting an option from the Units drop-down list or by typing the units you 
wish to use into the list box. 

The Sample Descriptor is automatically enabled when either the Standards or Unknowns(Dilution) 
column format (see below) is selected. The descriptor defaults to Concentration with the Standards 
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column format and to Dilution with the Unknowns(Dilution) column format. The Sample Descriptor 
may also be used for time or fraction number information. 

� NOTE: No sample descriptor is assigned automatically for the Basic or Unknowns column format. You 
may assign a sample descriptor to these column formats manually but, if you choose to do this, the 
information will not appear automatically in the Group section. To see it, you will need to create a new 
column containing the formula !Sampledescriptor. For more information about creating columns, see 
“Adding Columns”. 

Column Format defines the default column types that will be created for a new group or shows the 
original column format setting that was used to create the group you are editing. 

Four selections are offered: Basic, Standard, Unknowns, and Unknowns (Dilution). Different types of 
columns will be created for a new group, or changed in an existing group, depending on which of 
these column format settings you select. The table below shows the default columns created with 
each selection type. 
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Columns Created and Their Formulas 

 Basic Standard Unknown Unknown(Dilution) 

Name Sample Sample Sample Sample 

Formula !SampleNames !SampleNames !SampleNames !SampleNames 

Name Wells Wells Wells Wells 

Formula !WellIDs !WellIDs !WellIDs !WellIDs 

Name Sample# Concentration Values Values 

Formula Index !Concentration* !WellValues !WellValues 

Name Values Values R (Outside Standard Range) 
R (Outside Standard 
Range) 

Formula !WellValues !WellValues 

If(Values)>=‘MinStd@ 
Standards’ and  
Values<=‘MaxStd@Standards’, 
“”,“R” 

If(Values)>=‘MinStd@ 
Standards’ and Values<=
‘MaxStd@Standards’, 
“”,“R” 

Name Mean Value MeanValue Result Result 

Formula Average(Values) Average(Values) 
InterpX(STD@ 
StandardCurve,Values) 

InterpX(STD@ 
StandardCurve,Values) 

Name Std.Dev. MeanResult MeanResult 

Formula Stdev(Values) Average(Result) Average(Result) 

Name CV% Std.Dev. Std.Dev. 

Formula Cv(Values) Stdev(Result) Stdev(Result) 

Name CV% CV% 

Formula Cv(Result) Cv(Result) 

Name Dilution 

Formula !Factor* 

Name Adj.Result 

Formula 

 

 

 

MeanResult*!Factor 

 

* !Concentration and !Factor are from SoftMax Pro version 1.x. !Concentration, !Factor, and 
!SampleDescriptor return identical information. 
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The [Edit] Button 

When you click the [Edit] button, the Group Settings dialog box will appear, reflecting the settings for 
the active group (currently visible in the group drop-down list). If you wish to edit a group that is not 
currently active, first choose the group from the drop-down list and then click the [Edit] button. The 
figure below shows the Group Settings dialog box for the active group called “Patient#1.”  

 
Group settings with all options shown 

The name, sample descriptors, and column format can be changed for the group that you are editing. 

When you edit a group, you will notice that the information shown for the Column Format in the 
Group Settings dialog box changes to show the name of the original group used to define the group 
columns (see the figure below). 

 
Group settings options 

� CAUTION: Changing the column format will cause the columns in the group to revert to their 
original defaults as shown in the table above. If you have added columns or changed column 
information within the existing section for the group you are editing, these changes will be 
removed. 



 Chapter 5: Data Collection: LMax II and LMax II384 

SoftMax Pro User’s Manual  245 

The [Clear] Button 

Allows you to deselect, or clear the selected items. Highlight what you wish to clear and then click 
the [Clear] button. 

The Sample Area 

The Sample area contains the Sample drop-down list and sample descriptor values (active if defined 
in the Group Settings dialog box or if assigned automatically by SoftMax Pro). 
  

 

� CAUTION: When changing sample names or descriptors, be sure all wells  are replicates of the 
same sample and group or that you want them to become replicates of the same sample and 
group. SoftMax Pro does not prohibit selecting individual wells from different samples and/or 
groups, for example, and changing their descriptions—and they will change to become the same. 

Sample Drop-Down List 

The sample drop-down list consists of two areas divided by a horizontal gray line. Before other 
sample names have been defined, a single, pre-defined name (“BL”) appears below the gray line (the 
sample name “BL” is the name reserved by SoftMax Pro for group-associated blanks). The item above 
the gray line is the sample ready to be or currently being assigned. After being assigned, it will be 
shown below “BL” below the gray line. 

 
When this list first appears, the only selection shown below the dividing line is “BL”; the active 
sample name that is ready to be assigned appears above the line. 

When samples are assigned to a group, the default name is the first 3 letters of the group name 
followed by a number. For a group called “Standard,” for example, the default sample names would 
be Sta01, Sta02, Sta03, and so on. Sample names can be 300+ characters long; however, only the first 
five or six characters will be displayed in the template and in the Plate section. 

� NOTE: You can type a sample name directly into the box next to the arrow for the drop-down list by 
highlighting and typing over the existing sample name. If one or more wells or cuvettes were 
highlighted, typing a different name will replace the sample name shown in the template with the name 
you have typed and, if the name is new, will add this name to those that can be chosen in the drop-down 
list. 

When wells or cuvettes have been selected in the template and sample names have been defined, the 
sample menu will look like the one below. The checkmark indicates the sample that is currently being 
named. 

 
Sample Drop-Down List—Sample Names Defined and Wells Selected 
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Sample Descriptor Field 

The field associated with the sample descriptor only appears in the Template Editor tool bar if the 
group column type that has been selected requires this type of information. Generally the information 
entered in this field is a dilution or concentration. Position the cursor in this field and enter a number. 
The label and units assigned to the sample descriptor in the Group Settings dialog box are shown on 
either side of the field. 

Assign Area 

The Assign area contains the [Series] and [Assign] buttons. 

 
Assign Area of the Template Editor Tool Bar 

Assign Button and Function 

Click this button to apply a sample name to one or more wells that have been selected in the 
template. You may also perform this operation by using the Enter key on your keyboard. 

Series Button and Function 

This button is used to define several samples as a series, allowing you to easily enter incremental 
sample descriptors (for example, dilutions or concentrations) and sample names to the template as 
long as the increment can be expressed as a mathematical operation.  

Replicate Samples and Samples in a Series 

You can assign the same group or sample definition (same sample name and description within a 
group) to multiple wells to create replicates. For example, you might want to read standards in 
replicate to ensure that anomalies can be excluded prior to generating a standard curve. Replicates 
can be created using the [Assign] button or with the series function. 

Creating a series is faster than assigning replicates individually. The series option can be used as long 
as the replicate values conform to a pattern that can be described by a mathematical operator 
(multiply by 2 or add 5, for example). 

A series is defined in one direction (starting from left, right, top, or bottom) and therefore samples 
must be arranged sequentially in either ascending or descending order. 

To create a series, do the following: 

1. In the Template Editor, highlight the wells to be part of the series. The wells must be in the 
shape of a rectangle. 
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Template with Wells Selected for a Series 

2. Click the [Series] button to open the Series dialog box. 

 
Series Dialog Box 

3. Specify the name of the first sample in the series in the box (or accept the default provided by 
SoftMax Pro). Subsequent replicates use this name as a base and either increment the number 
within the name or append a number to it. In the example above, the sample name provided 
by SoftMax Pro describes the first sample (“01”) in a group named “Standard,” here 
shortened to “Sta.” 

4.  The information shown in the box labeled Sample Descriptor is derived from the 
information entered in the Group Settings dialog box. If the information for sample 
descriptor or units is not correct, you may change it here. If you did not already do so, 
specify the starting value for the first sample in the series. Values for subsequent samples are 
calculated from this starting value. 

5. Choose the operator for the series (+, -, *, or /) from the Step by: drop-down list. Enter the 
starting value for the series in the Starting value: box. The increment is entered in the box to 
the right of the Step by: box and below the Starting value: box. The figure above shows a 
starting value of “0.5” with the operator being division (“/”) and the increment being “2.” 
Thus the series will start with a value of “.5” and divide each subsequent sample by 2 to 
produce the following series values: .5, .25, .125, etc. 

6. You must assign a fill direction (from the top, bottom, left, or right—to describe how the 
series will fill the wells) and a number of replicates. Various options are diagrammed in the 
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figure below using a 4 x 4 block of wells (for more information about replicates, see Replicate 
Samples and Samples in a Series, above). The maximum number of replicates depends on the 
selection of wells: if you are filling down from the top, for example, and you have chosen a 
block of wells that is 4 wells wide by 8 wells high, the maximum number of replicates will be 
four; with the same block of wells selected, filling from the left would allow eight replicates. 
If the number of replicates you choose does not divide evenly into the number of rows or 
columns you select, depending on the filling direction, the remaining wells that cannot 
contain replicates will be labeled as additional individual wells in the series. For example, if 
you fill a block of 4 x 4 wells from the top, and choose three replicates, then the first three 
columns will contain the replicates and the last column will contain the additional wells in 
the series (see the last diagram in the figure below). This replicate feature allows you to 
quickly define the number of replicates and, in cases where the series has more samples than 
a single row or column, to name them simultaneously. To create a series with all 96 samples, 
highlight all the wells in the plate, select the fill direction, and set the replicates to 1. 

 
Fill Options and Replicate Settings 

7. Click [OK] to save the series and close the dialog box. While still in the Template Editor, you 
can view the value assigned to any well by clicking that well. The value will be displayed at 
the top of the Template Editor. Holding down the [CTRL]+Shift keys will display the values 
for all wells. 

� NOTE: Sometimes you may wish the names of a series of samples to increment but may not have a 
concentration or dilution factor that you wish to enter, or you want the concentration or dilution factor to 
remain constant. This can be done using the [Series] button, setting the starting value to 1 or another 
constant value, and either multiplying by 1 or dividing by 1. In this way, the names will increment but 
the value of concentration or dilution will not change. If you don’t have a concentration or dilution factor, 
simply deselect the sample descriptor checkbox if it is selected. 

� NOTE: If sample names are set to increment automatically using the Series function, be aware that 
SoftMax Pro will automatically truncate the sample name to three or four characters, including the 
incrementing number if the sample name starts with letters. If the sample name is entirely numeric, it will 
not be truncated. If sample names are very long, and they must be kept long for reference, you will have 
to set up your replicates manually and will not be able to use the series function. 
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Blanking 
In addition to the pre-read plate blanking selection found in the Instrument Settings dialog box, other 
types of blanking are available in SoftMax Pro. Understanding the differences between the types of 
blanking functions will enable you to choose the type of blanking that is appropriate for your assay. 
Note that blanks can be used in combination and have cumulative effects. 

Plate Blanks (Plate section only) 

Wells can be assigned to a “Blank” group in the Template Editor. Unlike pre-read plate blanks, the 
average value of all the wells in a plate blank group is subtracted from all individual well values obtained 
during the reading of microplates. Plate Blank subtraction may be turned off in the Reduction dialog 
box so that the data may be seen with or without plate blank subtraction. 

� NOTE: Plate blanks are only subtracted from wells on the same plate to which they are assigned. The 
checkbox for Plate Blank subtraction only appears in the Reduction dialog box after data has been 
collected. 

For Kinetic data, the blank value is averaged and subtracted on a point-by-point basis. The example 
below shows a graphic representation of original and average plate blank data, followed by the 
resulting data with average subtracted. 

 
Group-Associated Blanks 

Blank wells can be assigned within any group (other than the “Blank” group) in the Template Editor. 
The average reduced value of the blank wells or cuvettes within that group will be subtracted from individual 
reduced values within that group only. This blanking function uses the reduced number (example: !Lm1-
!Lm2, Vmax, etc.) only—it does not subtract on a point-by-point basis. When a group blank has been 
assigned, it is automatically subtracted. To see the reduced number without the group blank 
subtracted, mask the group blank wells or cuvettes. 

Group blanks apply to all wells in a group and thus may be subtracted from wells in more than one 
Plate section. 
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Blanking (Pre-Read Plate) 

 
Automix and Blanking 

The blanking selection found in the Instrument Settings dialog box is known as pre-read plate blanking, 
but pre-reading the plate is only one of five types of blanking available in SoftMax Pro. 
Understanding the differences between the types of blanking functions will enable you to choose the 
type of blanking that is appropriate for your assay. Note that blanks can be used in combination and 
have cumulative effects.  

If pre-read plate blanking is chosen, SoftMax Pro will prompt you to first read the blank plate after 
you click the [Read] button. 

The pre-read values will be stored in the data file and the individual well values collected during the pre-
reading of the plate will be subtracted from the individual well values obtained during the actual reading of 
samples. This is particularly useful for readings in the UV. Pre-read blanking may be turned off in the 
Reduction dialog box (click on the [Reduction] button) so the data may be seen with and without pre-
read blanking subtracted (this option is only available within the Reduction dialog box if pre-read 
blanking was chosen in the instrument setup). 

The purpose of pre-read plate blanks is to correct for well-to-well variability. 

Pre-read blanking is available only for Endpoint readings with the LMax II series instruments. 

� NOTE: Molecular Devices recommends that the wells of the pre-read plate be filled with the appropriate 
buffer for the assay or with water when performing pathlength correction. 

Blanks in Combination 

It is possible to use blanking functions in combination. You could perform a pre-read plate blanking, 
assign a blank group in the template, and also include blank wells within different groups. The 
effects of the different blanking functions are cumulative, so it is important to understand the function 
of each before using more than one type of blanking in a single assay. Pre-read blanking, plate 
blanking, and template blanking are applied to the raw data acquired from the instrument, whereas 
group blanks are applied to the reduced number. Group blank subtraction is only visible in the Plate 
section when the reduced number is displayed. The figure below shows the last two types of blanks 
in the Template Editor. 
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Blanks in combination 

In the figure above, note that the plate blank in the upper left appears as a separate group named 
“Blank” and individual samples within this group are named “BL.” The group-associated blank 
wells, shown in the upper right, are not a separate group—the samples, also named “BL,” are 
contained within the boundaries of the large group called “Unknowns” and are the same color as that 
group. 

 

� NOTE: In order to save changes you have made to the template in the Windows version of the Template 
Editor, be sure to click the [OK] button to close the window rather than clicking the Control Menu box. 
Clicking the Control Menu box (located in the upper left of the window) performs the same function as 
the [Cancel] button: the window will close but any changes you have made to the template will not be 
saved. 
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Copying/Pasting Templates 
Copying Template Information 

Two template actions—Copy and Paste—can only be activated from the Plate menu (when a Plate 
section is active) rather than from the Template Editor. If you have created a template in a Plate 
section and wish to use it in another Plate section, you may copy that template and paste it into the 
new section. The results of copying and pasting a template depend upon whether the action is 
performed within the same experiment or between experiment sections. 

Copying and Pasting within the Same Experiment Section 

To copy a template, make the section containing that template active and choose Copy Template from 
the Plate menu. Then activate the destination Plate section and choose Paste Template from the Plate 
menu. 

 
The group names and sample names of the pasted template are identical to those of the source 
template. In effect, the destination template is considered an extension of the original template and all 
wells on the destination plate are considered replicates of the wells on the source plate (same group 
and sample names). Any changes made to the template on the destination plate will also be made on 
the source plate. Data from the two Plate sections will be analyzed together. 

Copying and Pasting between Different Experiment Sections 

To copy a template, make the section containing that template active and choose Copy Template from 
the Plate menu (the menu name changes to reflect the type of active section). Then activate the 
destination Plate section and choose Paste Template from the Plate menu. 

The group names and sample names of the pasted template will be identical to those of the source 
template but, since they are in different experiments, the full name will be different (for example: 
group@experiment#2 instead of group@experiment#1). Any changes made to the template of the 
destination Plate section will not affect the source section. Data from the two Plate sections will not be 
analyzed together. 

Copying and Pasting Template Regions 

Contiguous regions of templates can be copied and pasted to other regions of templates (within the 
same or to a different experiment). All template settings are pasted into the new template except the 
group name: the new group is given the name “Group#X” where X is the next greater number than 
that used already for group names. 

To copy a region of a template, highlight the region and then select Copy from the Edit menu or press 
C (Macintosh) or [CTRL]+[C] (Windows). Only the highlighted wells will be copied. 
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To paste the region into another area of a template, highlight the region and select Paste from the Edit 
menu or press V (Macintosh) or [CTRL]+[V] (Windows). 

Only the highlighted wells will have template information pasted into them. Data is pasted using 
row priority: all wells in a row of highlighted wells have information pasted into them before 
proceeding to the next row, from left to right. If fewer wells are highlighted for pasting than were 
copied, the data will be pasted until all paste-highlighted wells are filled. If more wells are 
highlighted for pasting than were highlighted for copying, the extra wells are left empty. 

Exporting/Importing Templates 
Templates can be exported or imported by opening the Plate section and choosing the appropriate 
command on the Plate menu.  

 
Template files can be prepared “outside of” SoftMax Pro and then imported as needed when ready to 
run samples. How your particular templates should appear depends on the type of samples you will 
run, whether or not you will run them in replicate, etc. An example template, containing two wells 
with blanks, one column of standards, and the rest of the wells containing unknowns with replicates 
and serial dilutions, is shown below as it would appear in SoftMax Pro followed by a portion of the 
exported version of the same template as seen in a spreadsheet program. 
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Above: Template Example Showing Two Blanks, One Column of Standards, and the Rest Unknowns Run with 
Replicates and with Serial Dilution. 

 
Above: Export of the Template Example Shown in the Previous Figure 

Templates can be set up in many different ways. If replicates are used, as with the example above, 
they can be set up horizontally from left to right (as this example shows) or right to left, or vertically 
from top to bottom or bottom to top. If you are generating template data by means of import from a 
bar code reader or other source, noting the manner in which the data is imported will be helpful in 
determining the best manner to set up the template. 

Examining the exported information from your individual template files will help you determine the 
best method for template creation outside of SoftMax Pro in order for the data to be acquired in the 
correct manner. 

Reading a Microplate 
Data Collection from a Microplate 

You can start a reading at any time after defining instrument settings. It is not necessary to define 
groups and assign wells within the Template Editor first. The values received from the instrument 
are raw absorbance readings and are not affected by settings in the Template Editor. Only instrument 
settings must be defined prior to reading a microplate.  
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To read a microplate, open the drawer of the instrument (click the drawer button in the status bar, or 
choose Open Drawer from the Control menu) and insert the prepared microplate. Then simply click 
the [Read] button in the status bar or choose Read from the Command menu. 

If you have created more than one Plate section, and no Plate section is active, choosing the Read 
command will cause a dialog box to appear asking you to choose which section to read (see the figure 
below). Select the correct section and then click [OK] to close the dialog box. If a Plate section is 
active, choosing the Read command will read that plate. 

 
Plate selection dialog box 

A similar dialog box will appear if you have chosen to pre-read the plate for blanking. At the bottom 
of this dialog box, however, are two option (radio) buttons, allowing you to proceed with the pre-
read plate blank or to override this and read the “normal” plate. After reading the blank plate, you 
must start the read process again for the normal plate. The same dialog box will appear, but the 
default option button choice will be “Normal.” 

 
If you select a Plate section that already contains data and choose to Read again, an alert appears, 
asking you to confirm replacing data in the destination plate.  

 
If you select [Replace], the reading will proceed and the previous data will be replaced with new 
data. 

After beginning a reading, the status bar will show the actions that are occurring in the instrument, 
along with a box showing the elapsed time for each action in minutes and seconds. The [Read] button 
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will change to [Stop], allowing you to terminate a reading, if necessary. An example of the 
appearance of the status bar during a reading is shown below. 

 
 
Data Display During a Reading 

The values read by the instrument will appear in the data display as they are received from the 
instrument (in real time). Depending upon the read mode , the number of wavelengths, the plate 
type, and the display options selected, the data display will show one or more numbers or plots. 

Double-click a single well to enlarge its display to a Well Graph or hold the Shift key while selecting 
more than one well, and then choose Graph... from the Plate menu or click the graph button on the 
tool bar to display the data from multiple wells in one enlarged Well Graph. The data in the enlarged 
Well Graph will update to show new data points as they are received from the instrument. 

Other choices and settings within SoftMax Pro affect the way in which data is displayed—the type of 
reduction, specific time settings, and so on.  



  

  

Data Collection: Gemini, Gemini XS, Gemini XPS, Gemini EM 

Introduction to Data Collection 
Data Collection using SoftMax Pro is a three-part process: 

1. Prepare SoftMax Pro to collect data; 

2. Prepare and load the microplate(s) and/or cuvette(s) to be read, along with any other solutions 
or pipette tips needed; and 

3. Read the microplate(s) and/or cuvette(s). 

Before reading a microplate, you must create the Plate section(s) and define the instrument settings 
for the reading. Instrument Settings MUST be defined prior to collecting data and may NOT be 
changed after data is collected. In addition, it is recommended that you define a template and set the 
reduction and display parameters prior to reading the microplate, since these parameters determine 
how data is displayed and analyzed, but these last parameters may be set up and/or modified after 
data collection. 

A typical process for preparing, collecting, and analyzing data is as follows: 

1. Launch SoftMax Pro software. 

2. Create Plate section(s) as needed. 

3. Define the Instrument Setup settings from the Control menu. 

4. Define the template, reduction parameters, and display parameters. 

5. Prepare the microplate(s) to be read and place them in the instrument. 

6. Initiate the reading. 

7. Save the data file. 

8. Modify the template, reduction parameters, or display parameters (optional). 

9. Analyze the data using the Group section tables and Graph sections. 

10. Save the data file again when you are finished. 

Instrument Settings 
Instrument Setup 

� NOTE: Not all instrument settings are available with all instruments. Only the settings that pertain to the 
instrument that is connected to the computer or the one chosen in the Preferences will be shown in the 
Instrument Settings dialog box. 

You must specify the instrument settings prior to actually reading a microplate. Settings for the 
reading are made in the Instrument Settings dialog box, which can be accessed in three ways: 

1. Choose Instrument Setup... from the Control menu; 

2. Click the [Setup] button in the tool bar of the active, expanded Plate section; or 

3.  Double-click anywhere in the settings box (located to the right of the well grid) in the active, 
expanded Plate section. 

� NOTE: You may create more than one Plate section in a single experiment, and the instrument settings 
associated with each Plate section can be different. Instrument Setup... can only be chosen while a Plate 
section is active, and the settings you choose will affect only that section. A new Plate section that is 
created in an experiment that contains an active Plate section will contain the same instrument settings 
found in the previously active section. The settings for the new section can be modified as desired. 
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When you have defined the instrument settings, click the [OK] button to close the Instrument Settings 
dialog box. After closing, a summary of the instrument settings will appear in the box to the right of 
the data display in the Plate section. The instrument will use these settings to read the plate. 

 Instrument Settings Chart 
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SpectraMax Gemini, EM, XS, XPS

 

� NOTE: Incubator control is an instrument setup parameter that is not found in the Instrument Settings 
dialog box. 
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Read Mode 
Endpoint 

A single reading of the microplate can be taken at a single or multiple wavelength(s). Values reported 
are relative fluorescence units (RFU) or relative luminescence units (RLU). The default reduced value 
is !Lm1 (or !Lm2-!Lm4 if multiple wavelengths were chosen). 

 
Endpoint instrument settings with all options shown 
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Kinetic 

Data is collected over time with multiple readings taken at regular intervals. The default reduced 
values calculated for Kinetic data are Vmax per Sec (RFU/Sec or RLU/Sec), Time to Vmax (seconds), 
Onset Time (seconds), Time at Minimum, Time at Maximum, Time at 1/2 Maximum, Slope, and Area 
Under Curve. 

 

Kinetic instrument settings with all options shown 

Timing—When Kinetic mode is chosen, the Timing area becomes active, allowing you to enter the 
total Kinetic run time and the time interval between readings. A default value will be shown for the 
run time; to change this value, click in the box. Up and down arrows will appear, enabling you to 
increase or decrease the value shown. Highlight the hours, minutes, or seconds shown and then click 
the up or down arrow until the desired value is reached. Alternatively, you can type over an existing 
value using the keyboard. 

After choosing a total run time and an interval between readings, the total number of readings that 
will result is shown below the run time. If you set the interval time to be shorter than the instrument’s 
minimum read interval, the program will alert you with a warning message. An interval that is too 
short will cause a warning message to appear telling you that no calibration can occur between reads. 

The minimum read interval is determined by the instrument that is connected to the computer or, if 
no instrument is connected, by which instrument has been chosen in the Reader section of the 
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Preferences dialog box and the particular settings chosen for that instrument. The minimum interval 
depends on the number of wavelengths, the Automix status, the wells to read, and the distance the 
monochromator and filter wheel of the instrument must move. 

� NOTE: If you are writing a protocol that will be used with an instrument other than the one connected to 
the computer or chosen in the Reader preferences, you can disregard the alert and save the setup. 
However, if you attempt a reading using a protocol which has settings that are not correct for the 
particular instrument you are using, an error message will instruct you to change the setting that is out of 
range before you can initiate a reading. 

� NOTE: To achieve the shortest possible interval for Kinetic readings using the Gemini fluorescence 
readers, choose wavelengths in ascending order. 
 

Spectrum 

Measures relative fluorescence or luminescence units across a Spectrum of wavelengths. The default 
reduced value reported for each well is the wavelength of maximum fluorescence or luminescence, 
depending on the read type chosen. 

All Spectrum readings are made using the scanning monochromator of the Gemini fluorescence 
readers. 

 
Instrument settings for a Spectrum reading with all options shown 
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Well Scan 

One or more readings of a single well of a microplate can be taken at a single or multiple 
wavelength(s). Values reported are relative fluorescence units (RFU) or relative luminescence units 
(RLU). The default reduced value is !Lm1 (or !Lm2-!Lm4 if multiple wavelengths were chosen). 

 
Instrument settings for a Well Scan reading 



 Chapter 5: Data Collection: Gemini, Gemini XS, Gemini XPS, Gemini EM 

SoftMax Pro User’s Manual  263 

Read Type 
Choices for the read type are fluorescence, luminescence, or time-resolved fluorescence. Also 
included in this group of settings is bottom read. To select a read type, click the appropriate section in 
the Instrument Settings dialog box. All read modes are available for all read types. 

Two types of scans are possible when either fluorescence or time-resolved fluorescence read type is 
chosen: you can select a fixed wavelength for excitation and scan emission or vice versa.  

Fluorescence 

The light emitted by certain substances resulting from the absorption of incident radiation. To 
measure fluorescence accurately, it is necessary to reduce light scatter. The governing equation for 
fluorescence is: 

Fluorescence = extinction coefficient * concentration * quantum yield * excitation intensity * 
pathlength * emission collection efficiency 

Luminescence 

The emission of light by processes that derive energy from essentially non-thermal changes, the 
motion of subatomic particles, or the excitation of an atomic system by radiation. 

Time-Resolved Fluorescence 

Most fluorescence substances are not suitable for this type of reading. However, the fluorescence 
emitted by lanthanide dyes is delayed long enough to measure fluorescence after the lamp is turned 
off. Time-resolved fluorescence is used to reduce the amount of background noise which interferes 
with fluorescence. The excitation lamp flashes and, after it is off, the delayed emission is collected for 
a set period of time before the lamp is flashed again. 

Bottom Read (Gemini EM Only) 

When a Gemini EM instrument is connected to the computer or chosen in the Preferences, a checkbox 
next to “Bottom Read” appears below the Read Type choices. By default, this setting is enabled for 
Well Scan mode and off for the others. This setting is dimmed if a plate type having an opaque 
bottom is chosen. 

Wavelengths 
For Endpoint, Kinetic, or Well Scan Readings 

Choose the number of different wavelengths to be read. At least one wavelength must always be 
specified. Selecting more than one wavelength will cause a corresponding number of wavelength 
setting boxes to appear (maximum four wavelengths). 

 
Wavelengths 
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The wavelengths specified previously (or the defaults) will be shown in the boxes. You can choose a 
wavelength from the choices in the pull-down menu or simply type any wavelength (within the 
available range of the scanning monochromator in the instrument) over an existing setting. The pull-
down menu will show common monochromator settings. 

For Spectrum Readings 

When Spectrum is selected, the Wavelengths section of the dialog box changes to request a 
wavelength scanning range and a wavelength increment (Step) between the start and stop settings 
(see the Figure below). 

 
The minimum selectable increment is 1 nm. 

For fluorescence and time-resolved fluorescence readings, you must also choose whether to read 
excitation at a fixed wavelength and scan emission wavelengths, or vice versa within the range of the 
instrument (250-850 nm). A procedure to optimize excitation and emission wavelengths for a given 
assay is outlined in the instrument manuals for the Gemini fluorescence readers. Please see those 
manuals for more information. 

When luminescence is chosen, you must also select a start and end wavelength and a step (minimum 
step increment is 1 nm). 

With certain instruments, when reading using fluorescence and time-resolved fluorescence, you must 
also choose whether to read excitation at a fixed wavelength and scan emission wavelengths, or vice 
versa, within the range of the instrument. A procedure to optimize excitation and emission 
wavelengths for a given assay is outlined in the instrument manuals for the readers that support this 
function. Please see those manuals for more information. 

Cutoffs 
The choices in this portion of the Wavelengths setting depend upon the selections for read mode 
(Endpoint, Kinetic, Spectrum, or Well Scan) and read type (fluorescence, luminescence, or time-
resolved fluorescence). The term “cutoff” refers to filters used to condition the light entering or 
exiting the monochromators in order to reduce stray light and minimize background interference. 

 
Above: Cutoff Settings Window.   

The choices you see depend upon the setting for the read mode. 

No emission cutoff filter is used when luminescence is selected. With other read types, choices are to 
enable or disable “Auto Cutoff” with specific filter settings available if it is disabled (manual cutoff 
selection). When Auto Cutoff is enabled, the instrument sets the cutoffs based upon the 
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wavelength(s) chosen for reading; when Spectrum is selected as the read mode, however, a manual 
setting for the emission monochromator is required, with the default being no cutoff filter. 

Determining a manual setting for a cutoff filter is done based upon the known value of the “Stokes 
shift”: the difference between the wavelengths of the excitation and emission maxima. If the Stokes 
shift is small, it may be advisable to choose an excitation wavelength that is as far as possible from 
the emission maximum while still being capable of exciting the fluorophore. Doing this causes less of 
the excited light to overlap the emission Spectrum, allowing better selection and quantitation of the 
emitted light. See the instrument manual for the Gemini fluorescence reader for more information 
regarding cutoff filter settings.  

Sensitivity 

 
Sensitivity 

Readings 

This setting determines the number of readings that will be performed on each well of the microplate 
(readings are averaged and the average reading is displayed). In the figure below, the left side shows 
the default setting for fluorescence; the right shows changing this setting for more precision with a 
greater number of readings per well. 

 
The default number of readings per well varies with the read type: for fluorescence, the default is 6; 
for luminescence, the default is 30; for time-resolved fluorescence, the default is 20. The number of 
readings is variable from 1 to 30.  

� NOTE: With the luminescence read mode, the integration time is directly proportional to the number of 
readings per well determined by this setting. Each reading per well is equal to 3.2 milliseconds of 
integration time. 

PMT Sensitivity 

The PMT (photomultiplier tube) is a vacuum tube that detects light, especially from dim sources, 
through the use of photoemission and successive instances of secondary emission to produce enough 
electrons to generate a useful current. Clicking in the box causes a menu of choices to appear. 
Automatic is present only when Endpoint mode is chosen. Otherwise, settings are manual and 
limited to High, Medium, or Low. 
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PMT sensitivity 

The voltage of the photomultiplier tube may be set to low (for samples having a higher 
concentration), medium, or high (samples having lower concentration) in all read modes. In Endpoint 
mode (and also Spectrum mode when using the Gemini XS or EM), an additional setting, automatic, 
is available. This setting allows the instrument to adjust the PMT voltage automatically for varying 
concentrations of sample in the plate. 

Assay Plate Type 
This setting determines the display of wells in the microplate—it should be set to match the type and 
number of wells in the actual microplate that will be read.  

 
Assay plate type 

� NOTE: Changing the Plate Type within a Plate section causes well assignments stored in the previous 
template to be discarded. The groups created previously remain, however, so you can select new wells 
and simply apply existing groups to these wells. 

Defining New Plate Types 

The Plate Type list includes entries for microplates with standard dimensions and additional entries 
for plates that work best with custom settings. For both 96- and 384-well plates, the Standard plate 
should be used unless a custom setting is shown for the microplate you are using. 

Automix 
The Automix function is a patented feature that allows you to set automated shaking of the 
microplate. The options available for Automix depend on the read mode chosen and the type of 
instrument connected or chosen in the Preferences. 
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Automix and Blanking 

Before First Read 

This setting can be used with any read mode. Click the checkbox next to “Before First Read” to shake 
the microplate before the first reading. Whether you read at a single wavelength or at multiple 
wavelengths, enabling Automix for “Before First Read” will shake the plate for the set amount of 
time before the first wavelength reading only. You can accept the default value shown for the amount of 
time to shake the plate or enter a different value (up to 999 seconds) in the box to the right.  

Between Reads 

This option is applicable only to Kinetic readings and will be displayed only when Kinetic mode is 
selected. To enable automatic mixing of the microplate between readings during a Kinetic assay, click 
the checkbox next to this setting. For readings at a single wavelength, “Between Reads” will shake the 
plate for the set amount of time prior to each reading at that wavelength. For readings at multiple 
wavelengths, enabling “Between Reads” will shake the plate for the set amount of time before each 
reading at the first wavelength only. You can accept the default value shown for the amount of time 
to shake the plate or enter a different value (up to 999 seconds) in the box to the right. 

AutoCalibrate 
This checkbox allows you to disable or enable automatic calibration. The default setting is checked 
(enabled). Turning AutoCalibrate off allows the instrument to complete readings more quickly or to 
begin the first reading of a Kinetic plate faster. However, you should allow the instrument to perform 
autocalibration of at least one plate prior to disabling this function: calibration settings for the last 
plate which included an autocalibration are maintained in the instrument memory (NVRAM) until 
another autocalibration is performed. 

AutoRead 
This feature enables the automatic reading of subsequent Plate sections in the order in which they 
appear within an experiment. You can set intervals (delay time) between the plate readings, if 
desired. 

Wells to Read 
You may choose to read the entire plate or only certain wells in the microplate. Partial-plate reading 
is available for all read modes, and the time required for some readings may be significantly reduced 
using this setting since the instrument does not have to read the entire plate.  

To configure the settings for a partial-plate read, choose the Wells to Read setting. 
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Wells to Read/Strips 

Highlight the wells to be read. Wells must be contiguous but can be located anywhere in the microplate. 
If you enable a partial-plate reading, only the wells to be read will be visible in the data display, 
indicating that no data will be collected for the other wells (all wells will be visible in the Template 
Editor, however). 

Well Scan Editor 
The Well Scan read mode provides the ability to take readings at more than one location within a 
well. In the Instrument Settings dialog, all the options that are included for Endpoint reads are 
available for Well Scans. One additional option, the Well Scan Editor, allows the user to specify how a 
Well Scan is performed. Four patterns are provided: a horizontal line, a vertical line, a cross (which is 
a combination of a horizontal and vertical line), and a grid pattern. The user also specifies a density 
setting, which determines the number of points read in the line patterns or the maximum number of 
horizontal and vertical points included in the grid pattern. With the grid pattern, points that land too 
close to the edges of the well are excluded. All points that land within 2.8 mm of an edge are 
excluded. Only odd numbers of points are included in density settings. The minimum number of 
points is 3 for all plate sizes. The maximum number of points depends on the well diameter. To 
determine the maximum number of points included in density settings, 5.6 mm is subtracted from 
the well diameter, the remainder is divided by 0.8 mm and the largest odd integer that is less than 
this number used. 

 
Well Scan Editor 

The Well Scan Editor provides information on the number of points to be read, the point spacing and 
the approximate read time depending on the pattern and density settings. Point spacing is 
determined by subtracting 5.6 mm from the well diameter and dividing the remainder by the density. 
The minimum point spacing is 0.8 mm. 

In the Display dialog for Well Scan plates, the user can choose between a gray scale display, showing 
reduced values or showing both. With multiple wavelength pair Well Scans, the user can choose 
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between viewing the data from different wavelengths separately or together. The default reduction is 
the average of all points in a scan. The minimum value, maximum value, and Custom reductions are 
included as in the reduction drop-down list. Plate Sections default to presenting the points read in a 
Well Scan in gray scale. For multiple wavelength pair Well Scans, the readings from different 
wavelength pairs are shown in different colors. The first wavelength pair is shown in black. The 
second wavelength pair is shown in blue. The third wavelength pair is shown in read. The fourth 
wavelength pair is shown in yellow. For each position in a Well Scan, the color for the wavelength 
pair with the highest reading is shown. Well scan data can also be viewed in well graphs. 

The SoftMax Pro export format has been extended to include Well Scans. Well scan has been added to 
the read mode field (field 5). The number of points read is reported in field 9. The Well Scan pattern 
is reported in field 10. The Well Scan density is reported in field 11. The data from each position is 
output in subsequent rows or plates starting with the top, left point and proceeding with horizontal 
priority.  
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Template Editor 
The Template Editor is used to describe the location of samples in the wells of the microplate, 
providing the link between the raw data and the analysis groups. 

When you first open the Template Editor for a new Plate section, the grid or display is empty. The 
number of wells shown depends upon the type of plate selected in the Instrument Settings. After 
selecting wells, you can assign groups, and indicate the type of samples the wells will contain. 

Depending upon the default protocol you are using, certain group names (and associated sample 
descriptions) may have been created. You can use these predefined groups and/or create new groups 
to suit your needs. When creating new groups, you may enter any name you wish. Once entered, this 
name will be available for use in that experiment thereafter. New groups can be created 
independently from selecting or assigning any wells in the Template Editor. 

Each well designated as being part of a group has associated with it a group name, a sample name (or 
replicate ID), a sample descriptor (optional), and a default column format (group type, such as 
Standards, for example). When a group is applied to selected wells, the group name is displayed in 
bold type over the wells and the well bear the same color. 

  

Breakdown of the various features of the Template Editor 

Groups are always visible, both in the Template and in the data display of the Plate section. Even 
though they are grouped, single wells are still selectable in either the Template Editor or the data 
display. 

Samples and groups may exist across multiple Plate sections as well as within a single Plate section. 

Each template is built upon a hierarchy as follows: the template is composed of samples and groups. 
A set of one or more replicate wells makes up a sample. A set of related samples forms a group. For 
example, you may have a group named Standards that consists of seven samples named STD01, 
STD02 ... STD07. Group names may be up to 32 characters long, while sample names may be 300+ 
characters long. Samples may be assigned one at a time using the [Assign] button or several at the 
same time using the [Series] button. 
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If you create a group in the Template Editor but do not assign any wells to the group, a section for 
that group will still be created automatically when you close the template. You can remove the group 
(both its section in the window and its group name in the template) by making that Group section 
active and choosing Delete Groupname (where “Groupname” is the name assigned to that group in 
the template) from the Edit menu. Using the Macintosh, you can also delete the selected Group by 
pressing  -; within Windows, you can press [CTRL]+[-]. Note that deleting the wells assigned to a 
group from the template does not delete the corresponding Group name from the drop-down list. The 
only way to remove a group name from this list in the Template Editor is to delete the corresponding 
Group section from the experiment. 

Selecting Wells in the Template Editor 
In the Template Editor for a Plate section, you can select one or more wells by clicking or dragging on 
the grid. Multiple (contiguous) wells can be selected by dragging across them. Non-contiguous 
selections can be made by holding down the [Shift] key and clicking individual wells. Clicking a row 
label will select the entire row; clicking a column label will select the entire column. Contiguous 
columns or rows (1-12 or A-H, for a 96-well plate, for example) can also be selected by dragging. 
Non-contiguous columns or rows can be selected by holding the  (command) key on the Macintosh 
or the [CTRL] key in Windows and clicking in labels. 

 Double-clicking anywhere within a group will select the entire group. 

 To deselect all wells quickly, click in the empty border around the Template. 

 When you leave the Template Editor (by clicking the [OK] button), the Plate section will show 
the boundaries of the groups created in the template. Group labels and sample descriptors will 
not be visible—you can see them by holding down the [CTRL]+[Shift] keys. When you release 
the key(s), the original view of the Plate section will return.  

Template Editor Tool Bar 
The tool bar will appear differently depending upon what type of group is selected in the Group 
drop-down list. The following illustration shows how the tool bar will appear under various 
circumstances. 
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Template Editor Tool Bar 

The tool bar is divided into three areas: the Group area, the Sample area, and the Assign area. 

The Group Area 

The Group area contains the Group drop-down list which allows you to assign wells to existing 
groups, create new groups, or modify (using the [Edit] button) existing groups. In addition, it 
contains the [Clear] button which allows you to clear well assignments in the template. 

Group Drop-Down List 

This drop-down list consists of two areas, divided by a horizontal gray line. The two items below the 
gray line (Blank and New) are always available. Items above the gray line are custom groups that 
may be created as you wish. 

The Group drop-down list will appear differently depending upon the custom groups that have been 
created (by default or by the user). The figure below shows two different instances of the appearance 
of the Group list. 

 
Group drop-down list 
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� NOTE: Depending on the default template used when opening SoftMax Pro, initially no groups may 
appear above the gray line. As you create new groups, they will be positioned above the line. 

 Blank—Creates a plate blank in the active section. Note: the name “blank” is reserved for use by 
the SoftMax Pro program and should not be used when creating custom groups. 

 New—Creates a new group. The Group Settings dialog box will appear (see the image below) 
showing default settings. This dialog box allows you to define the name for a group of related 
samples, what type of descriptor will be associated with these samples, and the initial column 
format for the Group section. Whenever a new group is created (whether or not wells are 
selected in the template), a Group section (table) will also be created. To delete a group, you 
must delete the Group section. Simply clearing a group from the Template Editor will remove 
the assignment of wells to that group name, but the name will still show in the group pull-down 
menu and the Group section will still exist. 

 
Group settings dialog box 

Name: Use either the default name, “Group#X,” where “X” is an integer that is initially set to “1” and 
increments (i.e., “1,” “2,” “3,” etc.) as other groups are created, or enter a custom name (up to 32 
characters in length). 

In the Sample Descriptor area of the Group Settings dialog box, you can enable the application of the 
sample descriptor, if appropriate by clicking the checkbox. You may also choose the units used for 
the sample descriptor by selecting an option from the Units drop-down list or by typing the units you 
wish to use into the list box. 

The Sample Descriptor is automatically enabled when either the Standards or Unknowns(Dilution) 
column format (see below) is selected. The descriptor defaults to Concentration with the Standards 
column format and to Dilution with the Unknowns(Dilution) column format. The Sample Descriptor 
may also be used for time or fraction number information. 

� NOTE: No sample descriptor is assigned automatically for the Basic or Unknowns column format. You 
may assign a sample descriptor to these column formats manually but, if you choose to do this, the 
information will not appear automatically in the Group section. To see it, you will need to create a new 
column containing the formula !Sampledescriptor. For more information about creating columns, see 
“Adding Columns”. 

Column Format defines the default column types that will be created for a new group or shows the 
original column format setting that was used to create the group you are editing. 
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Four selections are offered: Basic, Standard, Unknowns, and Unknowns (Dilution). Different types of 
columns will be created for a new group, or changed in an existing group, depending on which of 
these column format settings you select. The table below shows the default columns created with 
each selection type. 

Columns Created and Their Formulas 

 Basic Standard Unknown Unknown(Dilution) 

Name Sample Sample Sample Sample 

Formula !SampleNames !SampleNames !SampleNames !SampleNames 

Name Wells Wells Wells Wells 

Formula !WellIDs !WellIDs !WellIDs !WellIDs 

Name Sample# Concentration Values Values 

Formula Index !Concentration* !WellValues !WellValues 

Name Values Values R (Outside Standard Range) R (Outside Standard 
Range) 

Formula !WellValues !WellValues 

If(Values)>=‘MinStd@ 
Standards’ and 
Values<=‘MaxStd@ 
Standards’,“”,“R” 

If(Values)>=‘MinStd@ 
Standards’ and Values<=
‘MaxStd@Standards’, 
“”,“R” 

Name Mean Value MeanValue Result Result 

Formula Average(Values) Average(Values) InterpX(STD@ 
StandardCurve,Values) 

InterpX(STD@ 
StandardCurve,Values) 

Name Std.Dev. MeanResult MeanResult 

Formula Stdev(Values) Average(Result) Average(Result) 

Name CV% Std.Dev. Std.Dev. 

Formula Cv(Values) Stdev(Result) Stdev(Result) 

Name CV% CV% 

Formula Cv(Result) Cv(Result) 

Name Dilution 

Formula !Factor* 

Name Adj.Result 

Formula 

 

 

 

MeanResult*!Factor 
 

* !Concentration and !Factor are from SoftMax Pro version 1.x. !Concentration, !Factor, and 
!SampleDescriptor return identical information. 
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The [Edit] Button 

When you click the [Edit] button, the Group Settings dialog box will appear, reflecting the settings for 
the active group (currently visible in the group drop-down list). If you wish to edit a group that is not 
currently active, first choose the group from the drop-down list and then click the [Edit] button. The 
figure below shows the Group Settings dialog box for the active group called “Patient#1.”  

 
Group Settings with all options shown 

The name, sample descriptors, and column format can be changed for the group that you are editing. 

When you edit a group, you will notice that the information shown for the Column Format in the 
Group Settings dialog box changes to show the name of the original group used to define the group 
columns (see the figure below). 

 

� CAUTION: Changing the column format will cause the columns in the group to revert to their 
original defaults as shown in the table above. If you have added columns or changed column 
information within the existing section for the group you are editing, these changes will be 
removed. 

The [Clear] Button 

Allows you to deselect, or clear the selected items. Highlight what you wish to clear and then click 
the [Clear] button. 
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The Sample Area 

The Sample area contains the Sample drop-down list and sample descriptor values (active if defined 
in the Group Settings dialog box or if assigned automatically by SoftMax Pro). 
  

 

� CAUTION: When changing sample names or descriptors, be sure all wells  are replicates of the 
same sample and group or that you want them to become replicates of the same sample and 
group. SoftMax Pro does not prohibit selecting individual wells from different samples and/or 
groups, for example, and changing their descriptions—and they will change to become the same. 

Sample Drop-Down List 

The sample drop-down list consists of two areas divided by a horizontal gray line. Before other 
sample names have been defined, a single, pre-defined name (“BL”) appears below the gray line (the 
sample name “BL” is the name reserved by SoftMax Pro for group-associated blanks). The item above 
the gray line is the sample ready to be or currently being assigned. After being assigned, it will be 
shown below “BL” below the gray line. 

 
When this list first appears, the only selection shown below the dividing line is “BL”; the active 
sample name that is ready to be assigned appears above the line. 

When samples are assigned to a group, the default name is the first 3 letters of the group name 
followed by a number. For a group called “Standard,” for example, the default sample names would 
be Sta01, Sta02, Sta03, and so on. Sample names can be 300+ characters long; however, only the first 
five or six characters will be displayed in the template and in the Plate section. 

� NOTE: You can type a sample name directly into the box next to the arrow for the drop-down list by 
highlighting and typing over the existing sample name. If one or more wells or cuvettes were 
highlighted, typing a different name will replace the sample name shown in the template with the name 
you have typed and, if the name is new, will add this name to those that can be chosen in the drop-down 
list. 

When wells or cuvettes have been selected in the template and sample names have been defined, the 
sample menu will look like the one below. The checkmark indicates the sample that is currently being 
named. 

 
Sample Drop-Down List—Sample Names Defined and Wells Selected 

Sample Descriptor Field 

The field associated with the sample descriptor only appears in the Template Editor tool bar if the 
group column type that has been selected requires this type of information. Generally the information 
entered in this field is a dilution or concentration. Position the cursor in this field and enter a number. 
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The label and units assigned to the sample descriptor in the Group Settings dialog box are shown on 
either side of the field. 

Assign Area 

The Assign area contains the [Series] and [Assign] buttons. 

 
Assign Area of the Template Editor Tool Bar 

Assign Button and Function 

Click this button to apply a sample name to one or more wells that have been selected in the 
template. You may also perform this operation by using the [Enter] key on your keyboard. 

Series Button and Function 

This button is used to define several samples as a series, allowing you to easily enter incremental 
sample descriptors (for example, dilutions or concentrations) and sample names to the template as 
long as the increment can be expressed as a mathematical operation.  

Replicate Samples and Samples in a Series 

You can assign the same group or sample definition (same sample name and description within a 
group) to multiple wells to create replicates. For example, you might want to read standards in 
replicate to ensure that anomalies can be excluded prior to generating a standard curve. Replicates 
can be created using the [Assign] button or with the series function. 

Creating a series is faster than assigning replicates individually. The series option can be used as long 
as the replicate values conform to a pattern that can be described by a mathematical operator 
(multiply by 2 or add 5, for example). 

A series is defined in one direction (starting from left, right, top, or bottom) and therefore samples 
must be arranged sequentially in either ascending or descending order. 

To create a series, do the following: 

1. In the Template Editor, highlight the wells to be part of the series. The wells must be in the 
shape of a rectangle. 

 
Template with Wells Selected for a Series 
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2. Click the [Series] button to open the Series dialog box. 

 
Series Dialog Box 

3. Specify the name of the first sample in the series in the box (or accept the default provided by 
SoftMax Pro). Subsequent replicates use this name as a base and either increment the number 
within the name or append a number to it. In the example above, the sample name provided by 
SoftMax Pro describes the first sample (“01”) in a group named “Standard,” here shortened to 
“Sta.” 

4.  The information shown in the box labeled Sample Descriptor is derived from the information 
entered in the Group Settings dialog box. If the information for sample descriptor or units is not 
correct, you may change it here. If you did not already do so, specify the starting value for the 
first sample in the series. Values for subsequent samples are calculated from this starting value. 

5. Choose the operator for the series (+, -, *, or /) from the Step by: drop-down list. Enter the 
starting value for the series in the Starting value: box. The increment is entered in the box to the 
right of the Step by: box and below the Starting value: box. The figure above shows a starting 
value of “0.5” with the operator being division (“/”) and the increment being “2.” Thus the series 
will start with a value of “.5” and divide each subsequent sample by 2 to produce the following 
series values: .5, .25, .125, etc. 

6. You must assign a fill direction (from the top, bottom, left, or right—to describe how the series 
will fill the wells) and a number of replicates. Various options are diagrammed in the figure 
below using a 4 �4 block of wells (for more information about replicates, see Replicate Samples 
and Samples in a Series, above). The maximum number of replicates depends on the selection of 
wells: if you are filling down from the top, for example, and you have chosen a block of wells 
that is 4 wells wide by 8 wells high, the maximum number of replicates will be four; with the 
same block of wells selected, filling from the left would allow eight replicates. If the number of 
replicates you choose does not divide evenly into the number of rows or columns you select, 
depending on the filling direction, the remaining wells that cannot contain replicates will be 
labeled as additional individual wells in the series. For example, if you fill a block of 4 x 4 wells 
from the top, and choose three replicates, then the first three columns will contain the replicates 
and the last column will contain the additional wells in the series (see the last diagram in the 
figure below). This replicate feature allows you to quickly define the number of replicates and, 
in cases where the series has more samples than a single row or column, to name them 
simultaneously. To create a series with all 96 samples, highlight all the wells in the plate, select 
the fill direction, and set the replicates to 1. 
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Fill Options and Replicate Settings 

7. Click [OK] to save the series and close the dialog box. While still in the Template Editor, you can 
view the value assigned to any well by clicking that well. The value will be displayed at the top 
of the Template Editor. Holding down the [CTRL]+[Shift] keys will display the values for all 
wells. 

� NOTE: Sometimes you may wish the names of a series of samples to increment but may not have a 
concentration or dilution factor that you wish to enter, or you want the concentration or dilution factor to 
remain constant. This can be done using the [Series] button, setting the starting value to 1 or another 
constant value, and either multiplying by 1 or dividing by 1. In this way, the names will increment but 
the value of concentration or dilution will not change. If you don’t have a concentration or dilution factor, 
simply deselect the sample descriptor checkbox if it is selected. 

� NOTE: If sample names are set to increment automatically using the Series function, be aware that 
SoftMax Pro will automatically truncate the sample name to three or four characters, including the 
incrementing number if the sample name starts with letters. If the sample name is entirely numeric, it will 
not be truncated. If sample names are very long, and they must be kept long for reference, you will have 
to set up your replicates manually and will not be able to use the series function. 

Copying/Pasting Templates 
Copying Template Information 

Two template actions—Copy and Paste—can only be activated from the Plate menu (when a Plate 
section is active) rather than from the Template Editor. If you have created a template in a Plate 
section and wish to use it in another Plate section, you may copy that template and paste it into the 
new section. The results of copying and pasting a template depend upon whether the action is 
performed within the same experiment or between experiment sections. 

Copying and Pasting within the Same Experiment Section 

To copy a template, make the section containing that template active and choose Copy Template from 
the Plate menu. Then activate the destination Plate section and choose Paste Template from the Plate 
menu. 
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The group names and sample names of the pasted template are identical to those of the source 
template. In effect, the destination template is considered an extension of the original template and all 
wells on the destination plate are considered replicates of the wells on the source plate (same group 
and sample names). Any changes made to the template on the destination plate will also be made on 
the source plate. Data from the two Plate sections will be analyzed together. 

Copying and Pasting between Different Experiment Sections 

To copy a template, make the section containing that template active and choose Copy Template from 
the Plate menu (the menu name changes to reflect the type of active section). Then activate the 
destination Plate section and choose Paste Template from the Plate menu. 

The group names and sample names of the pasted template will be identical to those of the source 
template but, since they are in different experiments, the full name will be different (for example: 
group@experiment#2 instead of group@experiment#1). Any changes made to the template of the 
destination Plate section will not affect the source section. Data from the two Plate sections will not be 
analyzed together. 

Copying and Pasting Template Regions 
Contiguous regions of templates can be copied and pasted to other regions of templates (within the 
same or to a different experiment). All template settings are pasted into the new template except the 
group name: the new group is given the name “Group#X” where X is the next greater number than 
that used already for group names. 

To copy a region of a template, highlight the region and then select Copy from the Edit menu or press 
C (Macintosh) or [CTRL]+[C] (Windows). Only the highlighted wells will be copied. 

To paste the region into another area of a template, highlight the region and select Paste from the Edit 
menu or press V (Macintosh) or [CTRL]+[V] (Windows). 

Only the highlighted wells will have template information pasted into them. Data is pasted using 
row priority: all wells in a row of highlighted wells have information pasted into them before 
proceeding to the next row, from left to right. If fewer wells are highlighted for pasting than were 
copied, the data will be pasted until all paste-highlighted wells are filled. If more wells are 
highlighted for pasting than were highlighted for copying, the extra wells are left empty. 

If you try to paste template information between Plate sections having different plate format settings, 
an error will result. Plates must be of the same type to copy and paste template information. 
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Reading a Microplate 

Reading a Microplate 
Fluorescence is defined as the measurement of light that is emitted after absorption or excitation from 
radiant activation of a compound. 

Luminescence is the measurement of light given off by a chemical or biochemical reaction. 

When reading a microplate, the Gemini fluorescence readers perform autocalibration (if enabled in 
the Instrument Settings) by reading from an internal reference chip in order to determine the 
appropriate scaling for RFU or RLU.  

You can start a reading at any time after defining instrument settings. It is not necessary to define 
groups and assign wells within the Template Editor first. The values received from the instrument 
are raw fluorescence, luminescence, or time-resolved fluorescence readings and are not affected by 
settings in the Template Editor. Only instrument settings must be defined prior to reading a 
microplate.  

To read a microplate, open the drawer of the instrument (click the drawer button in the status bar, or 
choose Open Drawer from the Control menu) and insert the prepared microplate. Then simply click 
the [Read] button in the status bar or choose Read from the Command menu. 

If you have created more than one Plate section, and no Plate section is active, choosing the Read 
command will cause a dialog box to appear asking you to choose which section to read. Select the 
correct section and then click [OK] to close the dialog box. If a Plate section is active, choosing the 
Read command will read that plate. 

 
Plate Selection dialog box 

If you select a Plate section that already contains data and choose to Read again, an alert appears, 
asking you to confirm replacing data in the destination plate. If you select [Replace], the reading will 
proceed and the previous data will be replaced with new data. 

 
After beginning a reading, the status bar will show the actions that are occurring in the instrument, 
along with a box showing the elapsed time for each action in minutes and seconds. The [Read] button 
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will change to [Stop], allowing you to terminate a reading, if necessary. An example of the 
appearance of the status bar during a reading is shown below. 

 
Column vs. Wavelength Priority During a Reading 

Depending upon the type of instrument connected to the computer or chosen in the Reader 
Preferences, a priority is given to reading by “column” or “wavelength.” It is most important to 
understand this priority with multi-wavelength readings. 

In column priority, an instrument will read the entire microplate (or chosen number of strips) at the 
first wavelength, and will then go back and read the microplate at the second and subsequent 
wavelengths. 

In wavelength priority, the instrument will read all wavelengths for the first column of wells in the 
microplate, and will then read all wavelengths for the second column, etc. 

The table below shows the priority settings by instrument for the different read modes. 

Column vs. Wavelength Priority 

 Endpoint Kinetic Spectrum 

Gemini Readers Column Wavelength Column 

 
Data Display During a Reading 

The values read by the instrument will appear in the data display of the Plate section as they are 
received from the instrument (in real time). Depending upon the read mode (Endpoint, Kinetic, 
Spectrum, or Well Scan), the number of wavelengths, the plate type, and the display options selected, 
the data display will show one or more numbers or plots. 

You can enlarge the display of one or more wells while the a Kinetic or Spectrum reading is in 
progress. Double-click a single well to enlarge its display to a Well Graph or hold the [Shift] key 
while selecting more than one well, and then choose Graph... from the Plate menu or click the graph 
button on the tool bar to display the data from multiple wells in one enlarged Well Graph. The data 
in the enlarged Well Graph will update to show new data points as they are received from the 
instrument. 

Other choices and settings within SoftMax Pro affect the way in which data is displayed—the type of 
reduction, specific time settings, and so on.  



  

  

Data Collection: FlexStation, FlexStation II, FlexStation II384 

Introduction to Data Collection 
Data Collection using SoftMax Pro is a three-part process: 

1. Prepare SoftMax Pro to collect data; 

2. Prepare and load the microplate(s) to be read, along with any other solutions or pipette tips 
needed; and 

3. Read the microplate(s)). 

� IMPORTANT: Not all instrument settings are available with all instruments. Only the settings that 
pertain to the instrument that is connected to the computer (or the one chosen in the Preferences) will be 
shown in the Instrument Settings dialog box. 

Before reading a microplate, you must create the Plate section(s) and define the instrument settings 
for the reading. Instrument Settings must be defined prior to collecting data and may NOT be 
changed after data is collected. In addition, it is recommended that you define a template and set the 
reduction and display parameters prior to reading the microplate, since these parameters determine 
how data is displayed and analyzed, but these last parameters may be set up and/or modified after 
data collection. 

A typical process for preparing, collecting, and analyzing data is as follows: 

1. Start SoftMax Pro. 
2. Create Plate section(s) as needed. 
3. Define instrument settings (use buttons in the Plate Section Tool Bar or the Control menu). 

� CAUTION Regarding FLEX Mode: Molecular Devices recommends that you follow the order 
of the settings choices from top to bottom when working in FLEX mode since some choices 
determine the settings that will be available in subsequent choices. Following the settings in 
order is also recommended to avoid problems that could potentially damage the instrument. 
Especially important are the settings for the Pipette Tips Layout and Compound & Tip Columns 
settings. If you change earlier settings after choosing the parameters for either of these, make sure 
to check the settings in these tabs to ensure that the changes are reflected there. 

4. Define the template, reduction parameters, and display parameters. 
5. Prepare the microplate(s) to be read and place them in the instrument. Prepare any additional 

compounds to be used and load the required pipette tips. 

� CAUTION Regarding FLEX Mode: Molecular Devices recommends that you use a full rack of 
tips each time you perform a transfer of fluid in FLEX mode since this prevents potentially 
serious errors from occurring when partial tip racks are used. For example, if you should 
mistakenly enable a pipetting function from a tip that is not present, or if you enable more or 
fewer tips than are actually available, the instrument could malfunction, potentially causing 
serious damage. While it is possible to use a partial rack of tips and to choose which tips are 
available in the Pipette Tips Layout setting, do so with caution, ensuring that the layout 
described in the software matches the actual tips inserted in the tip drawer. 

6. Initiate the reading. 
7. Save the data file. 
8. Modify the template, reduction parameters, or display parameters as you wish (or, if you didn't 

set them up in Step 4, do so now). 
9. Save the data file. 
10. Analyze the data using the Group section tables and Graph sections. 
11. Save the data file when you are finished. 
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Instrument Settings 
Instrument Setup 

� NOTE: No information is provided here regarding operation of the FlexStation instrument. For 
information about the function of the instrument or how to set it up for a reading, consult the instrument 
manual. This manual describes only the SoftMax Pro interface and how to use the software to perform a 
reading. 

� NOTE: Only the settings that pertain to the instrument that is connected to the computer or the one 
chosen in the Preferences will be shown in the Instrument Settings dialog box. 

You must specify the instrument settings prior to actually reading a microplate. Settings for the 
reading are made in the Instrument Settings dialog box, which can be accessed in three ways: 
1. Choose Instrument Setup... from the Control menu; 

2. Click the [Setup] button in the tool bar of the active, expanded Plate section; or 

3. Double-click anywhere in the settings box (located to the right of the well grid) in the active, 
expanded Plate section. 

� NOTE: You may create more than one Plate section in a single experiment, and the instrument settings 
associated with each Plate section can be different. Instrument Setup... can only be chosen while a Plate 
section is active, and the settings you choose will affect only that section. A new Plate section that is 
created in an experiment that contains an active Plate section will contain the same instrument settings 
found in the previously active section. The settings for the new section can be modified as desired. 

Instrument Settings Chart 
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FlexStation, II, II384

 

� NOTE: Incubator control is an instrument setup parameter that is not found in the Instrument Settings 
dialog box. 
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Read Mode 
Endpoint 

A single reading of the microplate can be taken at a single or multiple wavelength(s). Values reported 
are relative fluorescence units (RFU) or relative luminescence units (RLU). The default reduced value 
is !Lm1 (or !Lm2-!Lm4 if multiple wavelengths were chosen). 

 
Endpoint instrument settings with all options shown 



Chapter 5: Data Collection: FlexStation, FlexStation II, FlexStation II384  

286 SoftMax Pro User’s Manual 

Kinetic 

Data is collected over time with multiple readings taken at regular intervals. The default reduced 
values calculated for Kinetic data are Vmax per Sec (RFU/Sec or RLU/Sec), Time to Vmax (seconds), 
Onset Time (seconds), Time at Minimum, Time at Maximum, Time at 1/2 Maximum, Slope, and Area 
Under Curve. 

 
Kinetic Mode instrument settings with all options shown 

Timing—When Kinetic mode is chosen, the Timing area becomes active, allowing you to enter the 
total Kinetic run time and the time interval between readings. A default value will be shown for the 
run time; to change this value, click in the box. Up and down arrows will appear, enabling you to 
increase or decrease the value shown. Highlight the hours, minutes, or seconds shown and then click 
the up or down arrow until the desired value is reached. Alternatively, you can type over an existing 
value using the keyboard. 

After choosing a total run time and an interval between readings, the total number of readings that 
will result is shown below the run time. If you set the interval time to be shorter than the instrument’s 
minimum read interval, the program will alert you with a warning message. An interval that is too 
short will cause a warning message to appear telling you that no calibration can occur between reads. 

The minimum read interval is determined by the instrument that is connected to the computer or, if 
no instrument is connected, by which instrument has been chosen in the Reader section of the 
Preferences dialog box and the particular settings chosen for that instrument. The minimum interval 
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depends on the number of wavelengths, the Automix status, the wells to read, and the distance the 
monochromator and filter wheel of the instrument must move. 

� NOTE: If you are writing a protocol that will be used with an instrument other than the one connected to 
the computer or chosen in the Reader preferences, you can disregard the alert and save the setup. 
However, if you attempt a reading using a protocol which has settings that are not correct for the 
particular instrument you are using, an error message will instruct you to change the setting that is out of 
range before you can initiate a reading. 

� NOTE: To achieve the shortest possible interval for Kinetic readings using the FlexStation instruments, 
choose wavelengths in ascending order. 

Spectrum 

Measures relative fluorescence or luminescence units across a spectrum of wavelengths. The default 
reduced value reported for each well is the wavelength of maximum fluorescence or luminescence, 
depending on the read type chosen. 

All Spectrum readings are made using the scanning monochromator of the FlexStation instrument. 

 
Instrument settings for a spectrum reading with all options shown 
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Well Scan 

One or more readings of a single well of a microplate can be taken at a single or multiple 
wavelength(s). Values reported are relative fluorescence units (RFU) or relative luminescence units 
(RLU). The default reduced value is !Lm1 (or !Lm2-!Lm4 if multiple wavelengths were chosen). 

 
Instrument settings for a Well Scan reading with all options shown 
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Well Scan Editor 
A new read mode is provided for a Well Scan. This read mode provides the ability to take readings at 
more than one location within a well. In the Instrument Settings dialog, all the options that are 
included for Endpoint reads are available for Well Scans. One additional option is available, the Well 
Scan Editor shown in Figure 1. The Well Scan Editor allows the user to specify how a Well Scan is 
performed. Four patterns are provided: a horizontal line, a vertical line, a cross (which is a 
combination of a horizontal and vertical line), and a grid pattern. The user also specifies a density 
setting, which determines the number of points read in the line patterns or the maximum number of 
horizontal and vertical points included in the grid pattern. With the grid pattern, points that land too 
close to the edges of the well are excluded. All points that land within 2.8 mm of an edge are 
excluded. Only odd numbers of points are included in density settings. The minimum number of 
points is 3 for all plate sizes. The maximum number of points depends on the well diameter. To 
determine the maximum number of points included in density settings, 5.6 mm is subtracted from 
the well diameter, the remainder is divided by 0.8 mm and the largest odd integer that is less than 
this number used. 

 
Well Scan Editor 

The Well Scan Editor provides information on the number of points to be read, the point spacing and 
the approximate read time depending on the pattern and density settings. Point spacing is 
determined by subtracting 5.6 mm from the well diameter and dividing the remainder by the density. 
The minimum point spacing is 0.8 mm. 

In the Display dialog for Well Scan plates, the user can choose between a gray scale display, showing 
reduced values or showing both. With multiple wavelength pair Well Scans, the user can choose 
between viewing the data from different wavelengths separately or together. The default reduction is 
the average of all points in a scan. The minimum value, maximum value, and Custom reductions are 
included as in the reduction drop-down list. Plate Sections default to presenting the points read in a 
Well Scan in gray scale. For multiple wavelength pair Well Scans, the readings from different 
wavelength pairs are shown in different colors. The first wavelength pair is shown in black. The 
second wavelength pair is shown in blue. The third wavelength pair is shown in read. The fourth 
wavelength pair is shown in yellow. For each position in a Well Scan, the color for the wavelength 
pair with the highest reading is shown. Well scan data can also be viewed in well graphs. 

The SoftMax Pro export format has been extended to include Well Scans. Well scan has been added to 
the read mode field (field 5). The number of points read is reported in field 9. The Well Scan pattern 
is reported in field 10. The Well Scan density is reported in field 11. The data from each position is 
output in subsequent rows or plates starting with the top, left point and proceeding with horizontal 
priority.  
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FLEX Mode 

 
Instrument setting for FLEX read mode with all options shown 

� CAUTION: Molecular Devices recommends that you follow the order of the settings choices from 
top to bottom when working in FLEX mode since some choices determine the settings that will be 
available in subsequent choices. Following the settings in order is also recommended to avoid 
problems that could potentially damage the instrument. Especially important are the settings for 
the Pipette Tips Layout and Compound & Tip Columns settings. If you change earlier settings 
after choosing the parameters for either of these, make sure to check the settings in these tabs to 
ensure that the changes are reflected there. 
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� NOTE: In FLEX mode, it is essential that the settings for compound sources and dispensing are correct for 
the operation of the instrument. In particular, when a plate is selected for a compound source, the 
selected wells must cover an area that is appropriate for the dispensation. Also, selections for Assay Plate 
Types, Compound Source plates, and Pipette Tips Layout must correlate. 
 
SoftMax Pro will cross check these settings when you click [OK] to close the Instrument Settings dialog 
box. If the settings do not correlate, a warning message will be shown and you must correct the settings 
before you will be allowed to proceed and close the Instrument Settings. 

Reading Using the FlexStation 
The FlexStation performs readings using fluorescence, the light emitted by certain substances 
resulting from the absorption of incident radiation. To measure fluorescence accurately, it is 
necessary to reduce light scatter. The governing equation for fluorescence is: 

Fluorescence = extinction coefficient * concentration * quantum yield * excitation intensity * 
pathlength * emission collection efficiency 

Two types of scans are possible: you can select a fixed wavelength for excitation and scan emission or 
vice versa.  

The FlexStation instrument automatically reads up through the bottom of clear-bottom microplates. 

Wavelengths 
Choose the number of different wavelengths to be read. At least one wavelength must always be 
specified. Selecting more than one wavelength will cause a corresponding number of wavelength 
setting boxes to appear (maximum four wavelengths). 

 
Wavelength Settings 

The wavelengths specified previously (or the defaults) will be shown in the boxes. You can choose a 
wavelength from the choices in the pull-down menu or simply type any wavelength (within the 
available range of the scanning monochromator in the FlexStation instrument) over an existing 
setting. The pull-down menu will show common monochromator settings. 

Timing 
Enter the total run time and the time interval between readings. A default value will be shown for the 
run time; to change this value, click in the box and type a new value using the keyboard. Acceptable 
ranges are from 0.1 to 1000 seconds. The minimum interval for FLEX mode is dependent on the 
Compound Transfer settings and the number of wells to be read per column. 
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FLEX Timing Settings Box 

When you have made the choices above, the total number of readings that will result is shown below 
the run time. If you set the interval time to be shorter than the instrument’s minimum read interval, a 
warning message will appear, requiring that you choose a different interval. 

AutoCalibrate 
This checkbox allows you to disable or enable automatic calibration. The default setting is checked 
(enabled). Turning Autocalibrate off allows the instrument to complete readings more quickly or to 
begin the first reading of a plate faster. However, you should allow the instrument to perform 
autocalibration of at least one plate prior to disabling this function: calibration settings for the last 
plate which included an autocalibration are maintained in the instrument memory (NVRAM) until 
another autocalibration is performed. 

Sensitivity 
Readings 

This setting determines the number of readings that will be performed on each well of the microplate 
(readings are averaged and the average reading is displayed). 

 
The illustration on the left shows the default setting for fluorescence; the right shows changing this 
setting for more precision with a greater number of readings per well. 

The default number of readings per well varies with the read type: for fluorescence, the default is 6; 
for luminescence, the default is 30; for time-resolved fluorescence, the default is 20. The number of 
readings is variable from 1 to 30.  

� NOTE: With the luminescence read mode, the integration time is directly proportional to the number of 
readings per well determined by this setting. Each reading per well is equal to 3.2 milliseconds of 
integration time. 

PMT Sensitivity 

The PMT (photomultiplier tube) is a vacuum tube that detects light, especially from dim sources, 
through the use of photoemission and successive instances of secondary emission to produce enough 
electrons to generate a useful current. 
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Sensitivity 

Clicking in the box causes a menu of choices to appear. Settings are manual and limited to High, 
Medium, or Low. 

The voltage of the photomultiplier tube may be set to low (for samples having a higher 
concentration), medium, or high (samples having lower concentration) in all read modes. 

Assay Plate Type 
This setting determines the display of wells in the microplate—it should be set to match the type and 
number of wells in the actual microplate that will be read.  

 
Assay Plate Type 

� NOTE: Changing the Plate Type within a Plate section causes well assignments stored in the previous 
template to be discarded. The groups created previously remain, however, so you can select new wells 
and simply apply existing groups to these wells. 

Defining New Plate Types 

The Plate Type list includes entries for microplates with standard dimensions and additional entries 
for plates that work best with custom settings. For both 96- and 384-well plates, the Standard plate 
should be used unless a custom setting is shown for the microplate you are using. 

Automix 
The Automix function is a patented feature that allows you to set automated shaking of the 
microplate. The options available for Automix depend on the read mode chosen and the type of 
instrument connected or chosen in the Preferences. 
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Automix Settings Box 

Before First Read 

Click the checkbox next to “Before First Read” to shake the microplate before the first reading. 
Enabling Automix will shake the plate for the set amount of time before the first wavelength reading 
only. You can accept the value shown for the amount of time to shake the plate or enter a different 
value (from 1 to 999 seconds) in the box to the right.  

Between Reads 

To shake the microplate between readings, click the checkbox next to this setting. For readings at a 
single wavelength, “Between Reads” will shake the plate for the set amount of time prior to each 
reading at that wavelength. For readings at multiple wavelengths, enabling “Between Reads” will 
shake the plate for the set amount of time before each reading at the first wavelength only. You can 
accept the value shown for the amount of time to shake the plate or enter a different value (from 1 to 
999 seconds) in the box to the right. 

Wells to Read 
You may choose to read only certain wells or groups of wells in the microplate or to read the entire 
plate. Partial-plate reading is available for all read modes. The time required for a number of different 
types of readings may be significantly reduced using this setting since the instrument does not have 
to read the entire plate.  

To configure the settings for a partial-plate read, choose the Wells to Read setting. 

 
Wells to read/Strips 

Highlight the wells to be read. Wells must be contiguous but do not need to start with strip “1” and 
do not need to be complete rows or columns (and a single well may be chosen, if desired). If you 
enable a partial-plate reading, only the wells to be read will be visible in the data display, indicating 
that no data will be collected for the other wells (all wells will be present in the Template Editor, 
however). 
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Compound Source 
This allows you to select from various types of plates used to store fluid compounds that can be 
withdrawn and then injected into plate wells during the run. The type of plate that is chosen for this 
setting should match the actual plate used in the Compound Source drawer and the number of wells 
selected in the Assay Plate Type. 

 
Compound Source 

Compound Transfer 

 
Assay Plate Fluid 

The entry in this box should be equal to the largest initial volume for any well in the plate. SoftMax 
Pro assumes all wells hold the same initial volume. This setting is used to compute the total volume 
that will result in each well after all fluids have been dispensed. This calculation is made in order to 
warn you regarding potential overflow of fluid from the wells. 

The initial volume entry has an integer range of 0 to 999 in microliters. You are not required to enter 
anything in this field. Any value entered is saved with the file but the value is not displayed 
anywhere except in the Compound Transfer Tab setting. 



Chapter 5: Data Collection: FlexStation, FlexStation II, FlexStation II384  

296 SoftMax Pro User’s Manual 

Transfers 

You may enable up to three compound transfers during a reading (or choose none). 

When transfers are enabled, color-coded transfer buttons appear on the Instrument Settings dialog 
box. Selecting one of these buttons allows you to set the parameters for that transfer. Settings for each 
transfer include: 

Pipette Height—from 1 to 999 µL 
This setting determines the amount of fluid (in microliters, measured from the bottom of the 
microplate well) above which the tip of the pipette will remain. This setting helps to ensure that the 
tip of the pipette does not engage the fluid in the well to avoid cross-contamination and to allow re-
use of tips. Note that subsequent transfers will require that you calculate the amount of fluid added 
and set the pipette height accordingly higher to avoid touching the fluid in the well. 

Rate—from 1 to 8 
This setting determines the rate at which the fluid is pipetted into the well of the microplate. A setting 
of 1 is equal to 26 microliters/second and each subsequent number increases in increments of 26 
microliters. Therefore, a setting of 2 is equal to 52 microliters, etc. A setting of 3 to 4 may help to 
minimize cell damage or splashing. 

Volume—from 1 to 200 µL 
This setting determines the volume of material that will be pipetted from the source to each 
individual well chosen to receive that transfer. 

Time Point—from 5 to 9999 seconds 
This setting determines the time after the start of the run when the fluid is scheduled to be dispensed. 

Minimum time—This information line lists the minimum time required before a pipetting event 
can occur. The “Time Point” setting above cannot be set to a number of seconds smaller than this 
value. 
This minimum time value is cumulative (not an interval between pipetting events). The value is the 
minimum number of seconds of elapsed time from the beginning of the read. It takes into account the 
mechanical speed of the pipetter head, the time needed to aspirate and dispense fluids, trituration, 
and Automixing. 
The minimum time for the second pipetting event depends on when the first pipetting event 
occurred. The calculation for the second event starts at the end of the first event and adds to that the 
total time that will be necessary to perform actions prior to aspirating new fluids from the compound 
plate and dispense them into the assay plate. 

The Compound Transfer setting works in conjunction with the Compound & Tip Columns setting 
described below. Until well assignments are made in the Compound & Tip Columns setting, the 
Compound Transfer setting will show “No targets assigned.” 

Triturate 

� NOTE: The choices shown in this section are derived from the number of compound transfers specified. If 
no transfers are enabled, no triturate settings are possible. 

This setting is used to enable a “mixing” of the contents of the wells in either or both the compound 
source and assay plates. You can set the volume of fluid to be withdrawn from the well and the 
number of times (cycles) it will be pipetted back into that well. With the Assay Plate setting, you are 
also asked to enter a value for the height at which the transfer occurs. The height setting should take 
into account the amount of fluid currently in the well in order for the pipette tip to either remain out 
of contact with the fluid in the well (to avoid cross-contamination) or to engage the fluid. 
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Triturate 

Pipette Tips Layout 
Molecular Devices recommends that you always use a full rack of tips (the default). If you use less 
than a full rack of tips, it is imperative that you change this setting to match the correct number and 
positions of the actual tips inserted in the tips drawer (see the Caution below). 

 
Pipette tips layout 

If you change the Assay Plate Type setting from a 96-well plate type or vice versa after making 
selections in the Pipette Tips Layout tab, the selection of pipette tips will need to be redone as it will 
no longer match. The Assay Plate setting takes precedence over all other fluidics module settings. 

� CAUTION: Molecular Devices recommends that you use a full rack of tips each time you 
perform a transfer of fluid in FLEX mode since this prevents potentially serious errors from 
occurring when partial tip racks are used. For example, if you should mistakenly enable a 
pipetting function from a tip that is not present, or if you enable more or fewer tips than are 
actually available, the instrument can malfunction, potentially causing serious damage. While it 
is possible to use a partial rack of tips and to choose which tips are available in the Pipette Tips 
Layout setting, do so with caution, ensuring that the layout described in the software matches the 
actual tips inserted in the tip drawer. 
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Compound & Tip Columns 
The choices in this window depend upon the number of transfers chosen in the Compound Transfer 
tab. When one or more transfers are enabled, these settings allow you to choose the tips and 
compounds that will be used for transfers. 

 
Compound tips and columns 

SoftMax Pro automatically enters information in the Compound and Tip Columns tab using a best-fit 
algorithm that uses the number of transfers, the Wells to Read section, and the Pipette Tips Layout 
selected area. The algorithm assumes fluid will be aspirated from the compound plate starting with 
the first available column indicated in the Pipette Tip Layout. That fluid will then be dispensed to the 
first available column indicated in the Wells to Read selection.  

The algorithm assumes: 

 All columns in the Wells to Read selection should receive fluid; 

 The fluids are dispensed from left to right; 

 The fluid transfer targets are cumulative from transfer to transfer (that is, the second transfer’s 
targets start with the next available clean tip and untargeted compound column rather than 
reusing tips and compound columns targeted by the preceding fluid transfer); and 

 Each fluid transfer will use a new tip. 

The algorithm assumes that all of the columns in the Wells to Read area will receive fluid during the 
initial transfer so the Tips target grid will be filled from left to right starting with the first available tip 
column and incrementing the Tip target by one until all columns in the Wells to Read selection have 
been filled. 

In the illustration above, the Wells to Read selection includes columns 1 through 4 with an 8-column 
compound plate and a full rack of tips. From those settings, SoftMax Pro derives the first transfer’s 
Tips and Compound targets at 1-4. The second transfer targets the first unused Tips and Compound 
columns used during the first transfer, and the third transfer targets the first unused Tips and 
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Compound columns used during the second transfer. So, in this example, the second transfer event’s 
targets for both Tips and Compound are 5-8, the third transfer’s events are 9-12. 

When the number of columns in the Wells to Read area is the same or greater than the number of 
columns of both Tips and Columns, the algorithm fills the Tips and Columns targets as before (that is, 
each assay plate column is targeted with a new tip column and new compound column until all tips 
and columns have been targeted). SoftMax Pro does not fill beyond the limitations of the available 
Tips and Compound columns. Once all available tips and compound columns have been assigned, 
SoftMax Pro simply stops assigning targets. 

This tab section will show one, two, or three transfers (with blue, pink, and green color-coded tips to 
match the setting made in the Compound Transfer tab) and two pop-up menus: Tips Column and 
Compound Column. The Tips Column menu will show a sequence of numbers that match the 
selected columns in the Pipette Tips tab. The Compound Column menu will show numbers from 1 
through the number of columns of the compound plate or the number of troughs selected in the 
Compound Source tab. 

A Tips or Compound row will have potentially 12 columns to represent the number of columns in a 
96-well assay plate. The actual number of columns and their placement further depends on the 
number of columns and their locations as selected in the Wells to Read tab.  

To assign a tip to an assay plate well, highlight one or more tip cells and select one of the items 
available in the Tips pop-up menu. The tip column selected in the pop-up menu will be shown as a 
number in the selected Tip row(s). Choosing the “Fill” option at the top of the menu will fill the 
selected cells with the tip numbers that correspond to the same column numbers (tip 3 with column 
3, etc.). Note that “Fill” does not take into account the actual tips that are available if less than a full 
rack is used, whereas the choices in the menu beneath “Fill” represent the actual tip numbers that are 
listed as being available in the Pipette Tips Layout tab. 

Similarly, to assign a compound, highlight one or more compound cells and select one of the items 
from the Compound pop-up menu. 

The wells shown in this tab setting convey graphically the volumes of liquid in the assay plate for 
each pipetting event. Using the color associated with each event, the compound settings will display 
the dispensed compound volume as a percentage of the total assay well volume. If you entered an 
initial volume (on the Compound Transfer tab setting), that will be shown as a gray fill. As the 
liquids are cumulative, the first event’s volume is shown above the initial liquid volume (if any), the 
second event’s volume will be shown above the first, and the third event’s volume above the second. 

To deselect a tip or compound assignment, first select the appropriate cell(s) and then press 
Backspace on the PC or Delete on the Macintosh. To change an assignment, select the well(s) and 
choose new values or type a value on the keyboard. Note that, if you have multiple wells selected 
and you type a value, that value will be shown in the first selected well and subsequent wells will 
increment to the next higher value. Again, this does NOT take into account the actual pipette tips 
shown to be available in the Pipette Tips Layout selection. 

AutoRead 
This feature enables the automatic reading of subsequent Plate sections in the order in which they 
appear within an experiment. You can set intervals (delay time) between the plate readings, if 
desired.  
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Template Editor 
The Template Editor is used to describe the location of samples in the wells of the microplate, 
providing the link between the raw data and the analysis groups. 

When you first open the Template Editor for a new Plate section, the grid or display is empty. The 
number of wells shown depends upon the type of plate selected in the Instrument Settings. After 
selecting wells, you can assign groups, and indicate the type of samples the wells will contain. 

Depending upon the default protocol you are using, certain group names (and associated sample 
descriptions) may have been created. You can use these predefined groups and/or create new groups 
to suit your needs. When creating new groups, you may enter any name you wish. Once entered, this 
name will be available for use in that experiment thereafter. New groups can be created 
independently from selecting or assigning any wells in the Template Editor. 

Each well designated as being part of a group has associated with it a group name, a sample name (or 
replicate ID), a sample descriptor (optional), and a default column format (group type, such as 
Standards, for example). When a group is applied to selected wells, the group name is displayed in 
bold type over the wells and the well bear the same color. 

  

Template Editor features 

Groups are always visible, both in the Template and in the data display of the Plate section. Even 
though they are grouped, single wells are still selectable in either the Template Editor or the data 
display. 

Samples and groups may exist across multiple Plate sections as well as within a single Plate section. 

Each template is built upon a hierarchy as follows: the template is composed of samples and groups. 
A set of one or more replicate wells makes up a sample. A set of related samples forms a group. For 
example, you may have a group named Standards that consists of seven samples named STD01, 
STD02 ... STD07. Group names may be up to 32 characters long, while sample names may be 300+ 
characters long. Samples may be assigned one at a time using the [Assign] button or several at the 
same time using the [Series] button. 
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If you create a group in the Template Editor but do not assign any wells to the group, a section for 
that group will still be created automatically when you close the template. You can remove the group 
(both its section in the window and its group name in the template) by making that Group section 
active and choosing Delete Groupname (where “Groupname” is the name assigned to that group in 
the template) from the Edit menu. Using the Macintosh, you can also delete the selected Group by 
pressing  -; within Windows, you can press [CTRL]+[-]. Note that deleting the wells assigned to a 
group from the template does not delete the corresponding Group name from the drop-down list. The 
only way to remove a group name from this list in the Template Editor is to delete the corresponding 
Group section from the experiment. 

Selecting Wells in the Template Editor 
In the Template Editor for a Plate section, you can select one or more wells by clicking or dragging on 
the grid. Multiple (contiguous) wells can be selected by dragging across them. Non-contiguous 
selections can be made by holding down the [Shift] key and clicking individual wells. Clicking a row 
label will select the entire row; clicking a column label will select the entire column. Contiguous 
columns or rows (1-12 or A-H, for a 96-well plate, for example) can also be selected by dragging. 
Non-contiguous columns or rows can be selected by holding the  (command) key on the Macintosh 
or the [CTRL] key in Windows and clicking in labels. 

 Double-clicking anywhere within a group will select the entire group. 

 To deselect all wells quickly, click in the empty border around the Template. 

 When you leave the Template Editor (by clicking the [OK] button), the Plate section will show 
the boundaries of the groups created in the template. Group labels and sample descriptors will 
not be visible—you can see them by holding down the [CTRL]+[Shift] keys. When you release 
the key(s), the original view of the Plate section will return.  

Template Editor Tool Bar 
The tool bar will appear differently depending upon what type of group is selected in the Group 
drop-down list. The following illustration shows how the tool bar will appear under various 
circumstances. 

 
Template Editor Tool Bar 
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The tool bar is divided into three areas: the Group area, the Sample area, and the Assign area. 

The Group Area 

The Group area contains the Group drop-down list which allows you to assign wells to existing 
groups, create new groups, or modify (using the [Edit] button) existing groups. In addition, it 
contains the [Clear] button which allows you to clear well assignments in the template. 

Group Drop-Down List 

This drop-down list consists of two areas, divided by a horizontal gray line. The two items below the 
gray line (Blank and New) are always available. Items above the gray line are custom groups that 
may be created as you wish. 

The Group drop-down list will appear differently depending upon the custom groups that have been 
created (by default or by the user). The figure below shows two different instances of the appearance 
of the Group list. 

 

� NOTE: Depending on the default template used when opening SoftMax Pro, initially no groups may 
appear above the gray line. As you create new groups, they will be positioned above the line. 

 Blank—Creates a plate blank in the active section. Note: the name “blank” is reserved for use by 
the SoftMax Pro program and should not be used when creating custom groups. 

 New—Creates a new group. The Group Settings dialog box will appear (see the image below) 
showing default settings. This dialog box allows you to define the name for a group of related 
samples, what type of descriptor will be associated with these samples, and the initial column 
format for the Group section. Whenever a new group is created (whether or not wells are 
selected in the template), a Group section (table) will also be created. To delete a group, you 
must delete the Group section. Simply clearing a group from the Template Editor will remove 
the assignment of wells to that group name, but the name will still show in the group pull-down 
menu and the Group section will still exist. 
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Group Settings Dialog Box 

Name: Use either the default name, “Group#X,” where “X” is an integer that is initially set to “1” and 
increments (i.e., “1,” “2,” “3,” etc.) as other groups are created, or enter a custom name (up to 32 
characters in length). 

In the Sample Descriptor area of the Group Settings dialog box, you can enable the application of the 
sample descriptor, if appropriate by clicking the checkbox. You may also choose the units used for 
the sample descriptor by selecting an option from the Units drop-down list or by typing the units you 
wish to use into the list box. 

The Sample Descriptor is automatically enabled when either the Standards or Unknowns(Dilution) 
column format (see below) is selected. The descriptor defaults to Concentration with the Standards 
column format and to Dilution with the Unknowns(Dilution) column format. The Sample Descriptor 
may also be used for time or fraction number information. 

� NOTE: No sample descriptor is assigned automatically for the Basic or Unknowns column format. You 
may assign a sample descriptor to these column formats manually but, if you choose to do this, the 
information will not appear automatically in the Group section. To see it, you will need to create a new 
column containing the formula !Sampledescriptor. For more information about creating columns, see 
“Adding Columns”. 

Column Format defines the default column types that will be created for a new group or shows the 
original column format setting that was used to create the group you are editing. 

Four selections are offered: Basic, Standard, Unknowns, and Unknowns (Dilution). Different types of 
columns will be created for a new group, or changed in an existing group, depending on which of 
these column format settings you select. The table below shows the default columns created with 
each selection type. 
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Columns Created and Their Formulas. 

 Basic Standard Unknown Unknown(Dilution) 

Name Sample Sample Sample Sample 

Formula !SampleNames !SampleNames !SampleNames !SampleNames 

Name Wells Wells Wells Wells 

Formula !WellIDs !WellIDs !WellIDs !WellIDs 

Name Sample# Concentration Values Values 

Formula Index !Concentration* !WellValues !WellValues 

Name Values Values R (Outside Standard Range) 
R (Outside Standard 
Range) 

Formula !WellValues !WellValues 

If(Values)>=‘MinStd@ 
Standards’ and  
Values<=‘MaxStd@Standards’, 
“”,“R” 

If(Values)>=‘MinStd@ 
Standards’ and Values<=
‘MaxStd@Standards’, 
“”,“R” 

Name Mean Value MeanValue Result Result 

Formula Average(Values) Average(Values) 
InterpX(STD@ 
StandardCurve,Values) 

InterpX(STD@ 
StandardCurve,Values) 

Name Std.Dev. MeanResult MeanResult 

Formula Stdev(Values) Average(Result) Average(Result) 

Name CV% Std.Dev. Std.Dev. 

Formula Cv(Values) Stdev(Result) Stdev(Result) 

Name CV% CV% 

Formula Cv(Result) Cv(Result) 

Name Dilution 

Formula !Factor* 

Name Adj.Result 

Formula 

 

 

 

MeanResult*!Factor 

 

* !Concentration and !Factor are from SoftMax Pro version 1.x. !Concentration, !Factor, and 
!SampleDescriptor return identical information. 
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The [Edit] Button 

When you click the [Edit] button, the Group Settings dialog box will appear, reflecting the settings for 
the active group (currently visible in the group drop-down list). If you wish to edit a group that is not 
currently active, first choose the group from the drop-down list and then click the [Edit] button. The 
figure below shows the Group Settings dialog box for the active group called “Patient#1.”  

 
The name, sample descriptors, and column format can be changed for the group that you are editing. 

When you edit a group, you will notice that the information shown for the Column Format in the 
Group Settings dialog box changes to show the name of the original group used to define the group 
columns (see the figure below). 

 
Group Settings dialog box options 

� CAUTION: Changing the column format will cause the columns in the group to revert to their 
original defaults as shown in the table above. If you have added columns or changed column 
information within the existing section for the group you are editing, these changes will be 
removed. 

The [Clear] Button 

Allows you to deselect, or clear the selected items. Highlight what you wish to clear and then click 
the [Clear] button. 
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The Sample Area 

The Sample area contains the Sample drop-down list and sample descriptor values (active if defined 
in the Group Settings dialog box or if assigned automatically by SoftMax Pro). 
  

 

� CAUTION: When changing sample names or descriptors, be sure all wells  are replicates of the 
same sample and group or that you want them to become replicates of the same sample and 
group. SoftMax Pro does not prohibit selecting individual wells from different samples and/or 
groups, for example, and changing their descriptions—and they will change to become the same. 

Sample Drop-Down List 

The sample drop-down list consists of two areas divided by a horizontal gray line. Before other 
sample names have been defined, a single, pre-defined name (“BL”) appears below the gray line (the 
sample name “BL” is the name reserved by SoftMax Pro for group-associated blanks). The item above 
the gray line is the sample ready to be or currently being assigned. After being assigned, it will be 
shown below “BL” below the gray line. 

 
When this list first appears, the only selection shown below the dividing line is “BL”; the active 
sample name that is ready to be assigned appears above the line. 

When samples are assigned to a group, the default name is the first 3 letters of the group name 
followed by a number. For a group called “Standard,” for example, the default sample names would 
be Sta01, Sta02, Sta03, and so on. Sample names can be 300+ characters long; however, only the first 
five or six characters will be displayed in the template and in the Plate section. 

� NOTE: You can type a sample name directly into the box next to the arrow for the drop-down list by 
highlighting and typing over the existing sample name. If one or more wells or cuvettes were 
highlighted, typing a different name will replace the sample name shown in the template with the name 
you have typed and, if the name is new, will add this name to those that can be chosen in the drop-down 
list. 

When wells or cuvettes have been selected in the template and sample names have been defined, the 
sample menu will look like the one below. The checkmark indicates the sample that is currently being 
named. 

 
Sample Drop-Down List—Sample Names Defined and Wells Selected 

Sample Descriptor Field 

The field associated with the sample descriptor only appears in the Template Editor tool bar if the 
group column type that has been selected requires this type of information. Generally the information 
entered in this field is a dilution or concentration. Position the cursor in this field and enter a number. 
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The label and units assigned to the sample descriptor in the Group Settings dialog box are shown on 
either side of the field. 

Assign Area 

The Assign area contains the [Series] and [Assign] buttons. 

 
Assign Area of the Template Editor Tool Bar 

Assign Button and Function 

Click this button to apply a sample name to one or more wells that have been selected in the 
template. You may also perform this operation by using the [Enter] key on your keyboard. 

Series Button and Function 

This button is used to define several samples as a series, allowing you to easily enter incremental 
sample descriptors (for example, dilutions or concentrations) and sample names to the template as 
long as the increment can be expressed as a mathematical operation.  

Replicate Samples and Samples in a Series 

You can assign the same group or sample definition (same sample name and description within a 
group) to multiple wells to create replicates. For example, you might want to read standards in 
replicate to ensure that anomalies can be excluded prior to generating a standard curve. Replicates 
can be created using the [Assign] button or with the series function. 

Creating a series is faster than assigning replicates individually. The series option can be used as long 
as the replicate values conform to a pattern that can be described by a mathematical operator 
(multiply by 2 or add 5, for example). 

A series is defined in one direction (starting from left, right, top, or bottom) and therefore samples 
must be arranged sequentially in either ascending or descending order. 

To create a series, do the following: 

1. In the Template Editor, highlight the wells to be part of the series. The wells must be in the 
shape of a rectangle. 

 
Template with Wells Selected for a Series 
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2. Click the [Series] button to open the Series dialog box. 

 
Series Dialog Box 

3. Specify the name of the first sample in the series in the box (or accept the default provided by 
SoftMax Pro). Subsequent replicates use this name as a base and either increment the number 
within the name or append a number to it. In the example above, the sample name provided by 
SoftMax Pro describes the first sample (“01”) in a group named “Standard,” here shortened to 
“Sta.” 

4.  The information shown in the box labeled Sample Descriptor is derived from the information 
entered in the Group Settings dialog box. If the information for sample descriptor or units is not 
correct, you may change it here. If you did not already do so, specify the starting value for the 
first sample in the series. Values for subsequent samples are calculated from this starting value. 

5. Choose the operator for the series (+, -, *, or /) from the Step by: drop-down list. Enter the 
starting value for the series in the Starting value: box. The increment is entered in the box to the 
right of the Step by: box and below the Starting value: box. The figure above shows a starting 
value of “0.5” with the operator being division (“/”) and the increment being “2.” Thus the series 
will start with a value of “.5” and divide each subsequent sample by 2 to produce the following 
series values: .5, .25, .125, etc. 

6. You must assign a fill direction (from the top, bottom, left, or right—to describe how the series 
will fill the wells) and a number of replicates. Various options are diagrammed in the figure 
below using a 4 x 4 block of wells (for more information about replicates, see Replicate Samples 
and Samples in a Series, above). The maximum number of replicates depends on the selection of 
wells: if you are filling down from the top, for example, and you have chosen a block of wells 
that is 4 wells wide by 8 wells high, the maximum number of replicates will be four; with the 
same block of wells selected, filling from the left would allow eight replicates. If the number of 
replicates you choose does not divide evenly into the number of rows or columns you select, 
depending on the filling direction, the remaining wells that cannot contain replicates will be 
labeled as additional individual wells in the series. For example, if you fill a block of 4 x 4 wells 
from the top, and choose three replicates, then the first three columns will contain the replicates 
and the last column will contain the additional wells in the series (see the last diagram in the 
figure below). This replicate feature allows you to quickly define the number of replicates and, 
in cases where the series has more samples than a single row or column, to name them 
simultaneously. To create a series with all 96 samples, highlight all the wells in the plate, select 
the fill direction, and set the replicates to 1. 
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Fill Options and Replicate Settings 

7. Click [OK] to save the series and close the dialog box. While still in the Template Editor, you can 
view the value assigned to any well by clicking that well. The value will be displayed at the top 
of the Template Editor. Holding down the [CTRL]+[Shift] keys will display the values for all 
wells. 

� NOTE: Sometimes you may wish the names of a series of samples to increment but may not have a 
concentration or dilution factor that you wish to enter, or you want the concentration or dilution factor to 
remain constant. This can be done using the [Series] button, setting the starting value to 1 or another 
constant value, and either multiplying by 1 or dividing by 1. In this way, the names will increment but 
the value of concentration or dilution will not change. If you don’t have a concentration or dilution factor, 
simply deselect the sample descriptor checkbox if it is selected. 

� NOTE: If sample names are set to increment automatically using the Series function, be aware that 
SoftMax Pro will automatically truncate the sample name to three or four characters, including the 
incrementing number if the sample name starts with letters. If the sample name is entirely numeric, it will 
not be truncated. If sample names are very long, and they must be kept long for reference, you will have 
to set up your replicates manually and will not be able to use the series function. 

Blanking 
Two types of blanking are available in SoftMax Pro for fluorescence instruments. Understanding the 
differences between the types of blanking functions will enable you to choose the type of blanking 
that is appropriate for your assay. Note that blanks can be used in combination and have cumulative 
effects. 

The types of blanking that are defined in SoftMax Pro are: 

Plate Blanks (Plate section only) 

Wells can be assigned to a “Blank” group in the Template Editor. Unlike pre-read plate blanks, the 
average value of all the wells in a plate blank group is subtracted from all individual well values obtained 
during the reading of microplates. When PathCheck is selected for the SpectraMax M2, M5, Plus, 
Plus384, 190, or 340PC, the Plate Blank is subtracted after pathlength correction. Plate Blank 
subtraction may be turned off in the Reduction dialog box so that the data may be seen with or 
without plate blank subtraction. 
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� NOTE: Plate blanks are only subtracted from wells on the same plate to which they are assigned. The 
checkbox for Plate Blank subtraction only appears in the Reduction dialog box after data has been 
collected. 

For Kinetic and Spectrum data, the blank value is averaged and subtracted on a point-by-point basis. 
The example below shows a graphic representation of original and average plate blank data, 
followed by the resulting data with average subtracted. 

 
Graphical representation of original and average plate blank data 

Group-Associated Blanks (Plates and Cuvettes) 

Blank wells or cuvettes can be assigned within any group (other than the “Blank” group) in the 
Template Editor. The average reduced value of the blank wells or cuvettes within that group will be subtracted 
from individual reduced values within that group only. This blanking function uses the reduced number 
(example: !Lm1-!Lm2, Vmax, etc.) only—it does not subtract on a point-by-point basis. When a group 
blank has been assigned, it is automatically subtracted. To see the reduced number without the group 
blank subtracted, mask the group blank wells or cuvettes. 

Group blanks apply to all wells or cuvettes in a group and thus may be subtracted from wells or 
cuvettes in more than one Plate section or CuvetteSet section. 

Blanks in Combination 

It is possible to use blanking functions in combination. You could perform a pre-read plate blanking, 
assign a blank group in the template, and also include blank wells within different groups. The 
effects of the different blanking functions are cumulative, so it is important to understand the function 
of each before using more than one type of blanking in a single assay. Pre-read blanking, plate 
blanking, Ref, and template blanking are applied to the raw data acquired from the instrument, 
whereas group blanks are applied to the reduced number. Group blank subtraction is only visible in 
the Plate section/CuvetteSet section when the reduced number is displayed. The figure below shows 
the last two types of blanks in the Template Editor. 
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Blanks in combination 

In the figure above, note that the plate blank in the upper left appears as a separate group named 
“Blank” and individual samples within this group are named “BL.” The group-associated blank 
wells, shown in the upper right, are not a separate group—the samples, also named “BL,” are 
contained within the boundaries of the large group called “Unknowns” and are the same color as that 
group. 

� NOTE: In order to save changes you have made to the template in the Windows version of the Template 
Editor, be sure to click the [OK] button to close the window rather than clicking the Control Menu box. 
Clicking the Control Menu box (located in the upper left of the window) performs the same function as 
the [Cancel] button: the window will close but any changes you have made to the template will not be 
saved. 

Copying/Pasting Templates 
Copying Template Information 

Two template actions—Copy and Paste—can only be activated from the Plate menu (when a Plate 
section is active) rather than from the Template Editor. If you have created a template in a Plate 
section and wish to use it in another Plate section, you may copy that template and paste it into the 
new section. The results of copying and pasting a template depend upon whether the action is 
performed within the same experiment or between experiment sections. 

Copying and Pasting within the Same Experiment Section 

To copy a template, make the section containing that template active and choose Copy Template from 
the Plate menu. Then activate the destination Plate section and choose Paste Template from the Plate 
menu. 
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The group names and sample names of the pasted template are identical to those of the source 
template. In effect, the destination template is considered an extension of the original template and all 
wells on the destination plate are considered replicates of the wells on the source plate (same group 
and sample names). Any changes made to the template on the destination plate will also be made on 
the source plate. Data from the two Plate sections will be analyzed together. 

Copying and Pasting between Different Experiment Sections 

To copy a template, make the section containing that template active and choose Copy Template from 
the Plate menu (the menu name changes to reflect the type of active section). Then activate the 
destination Plate section and choose Paste Template from the Plate menu. 

The group names and sample names of the pasted template will be identical to those of the source 
template but, since they are in different experiments, the full name will be different (for example: 
group@experiment#2 instead of group@experiment#1). Any changes made to the template of the 
destination Plate section will not affect the source section. Data from the two Plate sections will not be 
analyzed together. 

Copying and Pasting Template Regions 

Contiguous regions of templates can be copied and pasted to other regions of templates (within the 
same or to a different experiment). All template settings are pasted into the new template except the 
group name: the new group is given the name “Group#X” where X is the next greater number than 
that used already for group names. 

To copy a region of a template, highlight the region and then select Copy from the Edit menu or press 
C (Macintosh) or [CTRL]+[C] (Windows). Only the highlighted wells will be copied. 

To paste the region into another area of a template, highlight the region and select Paste from the Edit 
menu or press V (Macintosh) or [CTRL]+[V] (Windows). 

Only the highlighted wells will have template information pasted into them. Data is pasted using 
row priority: all wells in a row of highlighted wells have information pasted into them before 
proceeding to the next row, from left to right. If fewer wells are highlighted for pasting than were 
copied, the data will be pasted until all paste-highlighted wells are filled. If more wells are 
highlighted for pasting than were highlighted for copying, the extra wells are left empty. 

Exporting/Importing Templates 
Templates can be exported or imported by opening the Plate section and choosing the appropriate 
command on the Plate menu.  
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Template files can be prepared “outside of” SoftMax Pro and then imported as needed when ready to 
run samples. How your particular templates should appear depends on the type of samples you will 
run, whether or not you will run them in replicate, etc. An example template, containing two wells 
with blanks, one column of standards, and the rest of the wells containing unknowns with replicates 
and serial dilutions, is shown below as it would appear in SoftMax Pro followed by a portion of the 
exported version of the same template as seen in a spreadsheet program. 

 
Above: Template Example Showing Two Blanks, One Column of Standards, and the Rest Unknowns Run with 

Replicates and with Serial Dilution. 



Chapter 5: Data Collection: FlexStation, FlexStation II, FlexStation II384  

314 SoftMax Pro User’s Manual 

 
Above: Export of the Template Example Shown in the Previous Figure 

Templates can be set up in many different ways. If replicates are used, as with the example above, 
they can be set up horizontally from left to right (as this example shows) or right to left, or vertically 
from top to bottom or bottom to top. If you are generating template data by means of import from a 
bar code reader or other source, noting the manner in which the data is imported will be helpful in 
determining the best manner to set up the template. 

Examining the exported information from your individual template files will help you determine the 
best method for template creation outside of SoftMax Pro in order for the data to be acquired in the 
correct manner. 

Reading a Microplate 
The FlexStation instrument sends fluorescence data to SoftMax Pro. Fluorescence is defined as the 
measurement of light that is emitted after absorption or excitation from radiant activation of a 
compound. 

You can start a reading at any time after defining instrument settings. It is not necessary to define 
groups and assign wells within the Template Editor first. The values received from the instrument 
are raw absorbance, fluorescence, luminescence, or time-resolved fluorescence readings and are not 
affected by settings in the Template Editor. Only instrument settings must be defined prior to reading 
a microplate.  
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To read a microplate, open the microplate drawer of the instrument (click the drawer button in the 
status bar, or choose Open Drawer from the Control menu) and insert the prepared microplate. Then 
simply click the [Read] button in the status bar or choose Read from the Command menu. 

If you have created more than one Plate section, and no Plate section is active, choosing the Read 
command will cause a dialog box to appear asking you to choose which section to read. Select the 
correct section and then click [OK] to close the dialog box. If a Plate section is active, choosing the 
Read command will read that plate. 

 
If you select a Plate section that already contains data and choose to Read again, an alert appears, 
asking you to confirm replacing data in the destination plate.  

 
If you select [Replace], the reading will proceed and the previous data will be replaced with new 
data. 

After beginning a reading, the status bar will show the actions that are occurring in the FlexStation 
along with a box showing the elapsed time for each action in minutes and seconds. The [Read] button 
will change to [Stop], allowing you to terminate a reading, if necessary. An example of the 
appearance of the status bar during a reading is shown below. 

 
Data Display During a Reading 

The values read by the instrument will appear in the data display of the Plate section as they are 
received from the instrument (in real time). Depending upon the read mode, the number of 
wavelengths, the plate type, and the display options selected, the data display will show one or more 
numbers or plots. 

You can enlarge the display of one or more wells while the Kinetic or Spectrum reading is in 
progress. Double-click a single well to enlarge its display to a Well Graph or hold the [Shift] key 
while selecting more than one well, and then choose Graph... from the Plate menu or click the graph 
button on the tool bar to display the data from multiple wells in one enlarged Well Graph. The data 
in the enlarged Well Graph will update to show new data points as they are received from the 
instrument. 

Other choices and settings within SoftMax Pro affect the way in which data is displayed—the type of 
reduction, specific time settings, and so on.  
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Displaying and Analyzing Data: EMax, VMax, UVMax, ThermoMax, VersaMax 

Introduction 
Initial display and reduction of the data received from the instrument is performed in the Plate 
section in which the data has been collected. Display and reduction parameters can be set up either 
prior to or after collecting data. The display and reduction parameters may be modified at any time. 

Data analysis and the display of analyzed data is also performed in the Group sections (created when 
wells are assigned to groups in the Template Editor) and the Graph section(s). 

Notes sections may be used in conjunction with any other section to provide text commentary and/or 
a display of data through the use of summaries. Notes sections are used most commonly to provide 
an introduction to or summary of results for a data file. 

All data files have a minimum of one Plate section with data in it. Multiple Plate sections may be 
present. Most files will have a template and Group, Graph, and Notes sections. However, depending 
upon the assay and how you wish to report the data, only some of these sections may be (or need to 
be) present in every file. . 

Many common assays consist of data acquired in a Plate section. Standards and unknowns are 
defined in a template. Unknowns are then interpolated from a standard curve. The following 
diagram shows the relationship between the different sections in SoftMax Pro: 

� NOTE: Not all instrument settings are available with all instruments. Only the settings that pertain to the 
instrument that is connected to the computer or the one chosen in the Preferences will be shown in the 
Instrument Settings dialog box. 

 

Initial Data Display and Reduction: Plate Section 
The manner in which data is displayed in a Plate section depends on the type of reading that was 
performed, but can be customized by choices made in the data display and reduction settings. 
Depending on the type of reading performed, display options include: 

 Number or plot displays for raw OD or %T (with or without reduced number). 

� NOTE: The number format (use of commas or periods in numeric notation) chosen for the computer 
operating system is reflected in the way that SoftMax Pro displays data. 

 Number, Plot, Threshold, Ranged, or Grayscale (with or without reduced number) 
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Default displays are shown automatically unless you choose a different display option. 

Reduction options allow you to display the raw data received from the instrument in a reduced 
(analyzed) form. Which reduction options are available depend on the read mode, instrument, and 
read type used; custom settings, using formulas you create, are available for all read modes, 
instruments, and read types. 

Reduction settings do not affect the raw data but simply cause it to be displayed differently, allowing 
you to change reduction settings without affecting the raw data from the plate reading in any way. 

Custom reduction formulas require the use of accessors and operators that are understood by 
SoftMax Pro. A list of such accessors and operators can be found in The Formula Reference Guide. 

The Data Display 
After a plate has been read, the information sent from the instrument is shown in the data display in 
the active Plate section. The default display for data from Endpoint readings is raw OD numeric 
values. Data from Kinetic or Spectrum readings is displayed in plots format (raw OD values with 
respect to time or wavelength). While a Kinetic or Spectrum reading is in progress, the display 
updates dynamically to show the data collected so far. If the instrument is reading more than one 
wavelength in Kinetic mode, plots for the different wavelengths are overlaid in each well. 

All choices except those defined in the Instrument Settings affect only the manner in which the data is 
displayed—the raw data is not changed—permitting you to optimize the display after data is 
collected. 

� NOTE: Data reduction changes the way in which data is displayed and also affects the values used in 
calculations within SoftMax Pro. While the raw values remain unchanged, calculations will use reduced 
values, if any, and are, therefore, affected by settings chosen in the Reduction dialog box.  

The Display Dialog Box 

Before or after a reading, you can click the [Display] button to open the Display dialog box 
which allows you to change the way the data is presented. Choices available in this dialog box 
depend on whether a section is currently active, which instrument is chosen in the Preferences or is 
connected to the computer, and which read mode you have chosen (for example, the choice for 
“Plots” is not shown if Endpoint mode is selected). The figures below show the default Display 
dialog boxes for the different read modes. 

The Display dialog box is divided into two parts (left and right): the default display, “Raw OD” is 
shown to the left of a dividing line; the choices for reduced data displays are shown to the right of the 
dividing line. Note: data reduction itself is performed separately; settings here simply determine how 
the reduced data will be displayed in the data section. 

The dialog boxes below show the default display choices for the three modes (if applicable): 

 raw optical density values (numbers) for Endpoint; 

 the change in raw OD values over time for Kinetic; and 

 raw OD values for the range of wavelengths, displayed as a plot, for Spectrum. 

Other choices available in this dialog box include displaying the data as a single reduced value 
(number), in threshold, ranged, or gray scale formats, or any combination of display choices with the 
reduced number (the reduced number display choice cannot be used with the reduced number 
checkbox). 

Data in the Plate section is displayed in a grid array (microplate format).  
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 Normal: shows the data in standard left-to-right format, with well A1 in the upper left corner. 
Columns 1 through 24 are along the top and rows A through P are shown from top to bottom. 
The wells are smaller and data is shown with fewer digits (less precision). 

 Vertical: the plate is shown in the same orientation as Normal except that columns 1 through 12 
(all rows) are shown above columns 13 through 24 (all rows). 

 Rotated: Same as the Normal view except that it is rotated 90 degrees clockwise (well A1 is in 
the upper right corner). 

 Large: Same as the Normal view except larger. This display can be seen in its entirety only if you 
have the page size set for legal paper (8.5 x 14 inches) in landscape orientation (set this in Page 
Setup or Preferences under the File menu). In the example shown in the figure below, the 
display is shown as it appears if you do not change the page size from letter-size to legal. 

 Interleaved: In this display, the wells are shown in a format that “skips” every other well as 
follows: all odd columns and rows begin in the upper left corner of the plate display and are 
followed by all even columns and rows. So well A1 is still in the upper left corner, but it is 
followed horizontally by well A3, A5, ... A23, A2, A4, etc., and vertically by well C1, E1, ... O1, 
B1, D1, etc. This display is most useful when the 384-well plate is composed of 4 daughter plates 
of 96 wells each. 

Reduced Number 
The reduced number is based on the settings defined in the Reduction dialog box. It is a combination 
of blank subtraction, wavelength reduction, and Spectrum scan or Kinetic reduction. The information 
acquired from the microplate reader is reduced to a single number or value. The reduced number will 
be reported in the Group section when a template has been defined. 

To view by reduced number alone, select the Number option (the first choice to the right of the 
default, just after the dividing line); to see a reduced number as well as another type of display, click 
the box next to the option that says “With reduced number” in the lower left of the dialog box to 
enable it. Changing the reduction parameters after choosing a reduced data display mode will cause 
the display to update accordingly. More information about reduction formulas and how to customize 
them follows later in this chapter.  

Threshold, Ranged, and Gray Scale 
To display Threshold, Ranged, or Gray Scale data, high and low values must be entered. When you 
choose one of these display options, SoftMax Pro provides default values for the high and low limits 
by means of an autoranging function (encompassing all the data from lowest to highest value). You 
can change the high and low limits by highlighting the existing value and entering a new value. An 
example of the Display dialog box for a Kinetic reading (Plate section) with the Threshold display 
option chosen is shown below. 
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Display Dialog Box 

Threshold 

The Threshold display shows the raw data as a plus (+) for values above the high limit, an asterisk (*) 
for values within the limits, and a minus (-) for values below the low limit. The figure below shows a 
Kinetic reading displayed using the Threshold option along with the reduced number. 

 
Threshold Display 
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Ranged 

When the Ranged display is chosen, raw data that falls between the high and low limits is assigned 
proportionally to integer values from 0 through 9. Values above the high limit are displayed as a 
plus (+) and values below the low limit are displayed as a minus (-). The figure below shows reduced 
Kinetic data displayed in Ranged format. 

 
Ranged display 

Gray Scale 

The Gray Scale option presents the raw data in eight shades of gray, changing from light (for values 
less than or equal to the low limit) to dark (for values greater than or equal to the high limit). The 
figure below shows reduced Endpoint data displayed as Gray Scale. 

 
Gray Scale Display 

Graphing Wells 

You can enlarge the display of the wells shown with Kinetic, Spectrum, or Well Scan modes to get 
a close-up view of the data. This is done by either double-clicking the particular well in the data 
display or by selecting the well and then clicking the Well Graph button in the Plate Section Tool Bar. 
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Kinetic Well Graphs 
Well Graphs plot the data for the individual wells in a microplate and show the well ID and 
reduction information, including the goodness of fit (R^2 value), if appropriate. The default display 
for the X-axis shows time for Kinetic plots; OD or %T is displayed on the Y-axis for both plots. 

Positioning the cursor within a Well Graph shows X and Y values for the cursor location, allowing 
you to determine more precisely the location of data points. 

Well Graph Options 
Along the bottom of each Well Graph dialog box are eight buttons that perform the following 
functions: 

 [Print] 
Opens the Print dialog box. 

 [Reduction] 
Opens the Reduction dialog box. 
By default, the ranges on the enlarged plot are set to the limits defined in the Reduction dialog 
box, and the information included near the bottom of the window is based on the reduction 
settings currently in use. You may change these settings (wavelength combination and type of 
reduction used, minimum and maximum OD limits, lag time and end time, and number of 
Vmax Points. More information about the reduction options can be found later in this chapter. 

� NOTE: Changes to the reduction settings made within well graphs will be applied to all wells in the Plate 
section. When viewing Raw data, you can scale the graph to see data outside the reduction limits [line(s) 
are included on the graph indicating the limits and the area outside of them will be shaded slightly]. This 
view should assist you in determining the best limits for the reduced data. 

Show Raw/Show Reduced Button 

 This button toggles the Well Graph between views of raw and reduced data. When the Well Graph is 
opened, the initial view depends on the Display settings for the Plate section. If raw data is being 
displayed in the Plate, the initial view in the Well Graph will be raw data and the button will be set to 
“Show Reduced.” If reduced data is being displayed in the Plate section, the initial view in the Well 
Graph will be reduced data and the button will be set to “Show Raw.” 

Scale to Data/Scale to Limits Button 

This button toggles between a view of the data within the reduction limits and a view of the entire 
data set. Switching between these views helps to visualize how the limit settings affect data 
reduction. If raw data is being viewed in the Plate section, the display in the Well Graph is set 
initially to show the plot scaled to the reduction limits. If reduced data is being viewed in the Plate 
section, the Well Graph display is set initially to show the plot scaled to the data. 

� NOTE: If you are viewing raw data and click the Scale to Limits or Scale to Data button, only the display 
of raw data in the Well Graph will be affected (the button will not affect the view of reduced data). The 
same is true if you click this button while viewing reduced data. To produce comparable scaling of both 
raw and reduced displays, this button must be set to either Scale to Limits or Scale to Data for both raw 
and reduced views of the Well Graph. 

Graph Options Button 

Opens the Well Graph Options dialog box which allows you enable or disable connected points or 
plotted symbols the graph. 
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X-Axis Settings Button  

Y-Axis Settings Button  

Opens the Well Graph Axis Settings dialog box for the particular axis, allowing you to set Auto 
Range parameters, choose the minimum and maximum values for the selected axis, cause the axis to 
be auto-ranged, add or remove gridlines, and add or remove axis tick marks. When a Well Graph is 
opened, the default settings are to show the reduction limits for that axis with Auto Ranging off and 
gridlines and tick marks selected. Only the Well Graph being viewed is affected by changes in these 
dialog boxes. 

 [Done] 
Closes the Well Graph dialog box. 

 
Above: Well Graph for a Single Kinetic Microplate Well (Raw Data) 

Multiple wells from the same Plate section can be graphed together in one enlarged window. Select 
the well(s) in the data display (hold the [Shift] key if you are selecting non-contiguous wells; you can 
drag across contiguous wells) and then click the Graph button or double-click in one of the selected 
wells. 
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Above: Well Graph for Three Kinetic Wells of a Microplate (Raw Data) 

The choices you make for viewing the data in the Plate section also affect the way the Well Graph 
appears. The first and third figures above show Well Graphs for raw data displays. If you display one 
of the reduced options (reduced number, Threshold, Ranged, or Gray Scale), the Well Graph will show 
the plot with an indicator of the reduced value and will include the word “Reduced” in the window 
title. 

Zoom Box 
You can enlarge the Well Graph even further by clicking the zoom box in the upper right-hand corner 
of the window (the center box of three in the upper right corner in Windows). Clicking the zoom box 
once will cause the window to fill the total display on your monitor; clicking the zoom box again will 
return the window to its previous size. 

Size Box 
Clicking and dragging the size box located in the lower-right corner (Macintosh) or clicking and 
dragging the lower right corner of the window (Windows) allows you to make the Well Graph any 
size desired. 

Printing the Well Graph 
You can print the Well Graph window, if desired, by clicking the [Print] button at the bottom left 
corner of the dialog box. 

� NOTE: If you enlarge the Well Graph to greater than 12 inches, the graph will not fit on an 8.5- by 11-inch 
page and the printout will be truncated. 

Masking Wells    

If you find data in certain wells that should be excluded from the calculations to be performed by 
data reduction, you can mask these wells. Select the well(s) to be masked and then click the Mask 
button in the Plate section Tool Bar or choose Mask... from the Plate menu. Masked wells are shown 
with an overlay of diagonal lines. 
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The masking function can be used as a “what if?” tool. For example, you could suppress or enable 
certain functional groups within the experiment. Suppose you have included a group blank in the 
template and want to see the data with and without the blank. Masking the group blank wells would 
suppress the blanking function; unmasking them would enable it again. 

 
Above: Masked Wells in a Plate Section 

To remove masking from one or more wells, highlight the masked well(s) and click the Mask button 
in the Plate Section Tool Bar (toggles masking on and off) or choose Mask... from the Plate menu 
again. The diagonal lines covering those wells (and masking function) will be removed. 
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Data Reduction 

� NOTE: Because this chapter deals with more than one instrument, not all of the information found here 
may apply to your particular instrument. 

 
Raw data received from the instrument can be displayed in an analyzed (or reduced) form. The 
reduction process within SoftMax Pro is based on formulas that reduce the raw data to show a single 
number for each well. Further analysis of this reduced number then takes place in the Group and 
Graph sections. 

SoftMax Pro performs calculations hierarchically when reducing the optical density information 
collected from the instrument. Calculations in the Plate section are performed in the order shown 
below. If an option has either not been selected in the Instrument Settings dialog box, is not available 
for the instrument you are using, or has not been defined in the template and/or Reduction dialog 
box, SoftMax Pro starts/continues with the next listed calculation. 

Plate Section 

1. Convert OD to %T (and vice versa) 

2. Pre-read plate blank or plate background constant subtraction (or division for %T) 

3. Plate blank subtraction 

4. Wavelength reduction 

5. Kinetic reduction 

6. Group blank subtraction 

   

� CAUTION: Separate mathematical calculations are used for handling OD and %T calculations for 
Pre-read plate blanking because OD calculations are performed on a linear scale whereas %T 
calculations are performed on a logarithmic scale. Other calculations, however, are not calculated 
differently by SoftMax Pro for absorbance and %T modes. Because of this, Molecular Devices 
recommends that %T be used only for raw OD or raw OD with Pre-read plate blank subtraction. Use 
caution when using %T on reduced numbers or any readings that apply other calculations since 
the data may not accurately reflect proper calculations. 

You can access the Reduction dialog box in several ways: by clicking the [Reduction] button in the 
tool bar of the active plate section, by choosing Reduction from the Plate menu, or by clicking the 
[Reduction] button in the Well Graph display. The appearance of the Reduction dialog box will be 
different depending on the type of read mode you have chosen, and the options you have chosen in 
the Instrument Settings dialog box. The figure below shows the Reduction dialog boxes for a Plate 
section in Endpoint, Kinetic, and Spectrum modes, along with the default reductions for each of those 
modes. 
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Above: Reduction Dialog Boxes for Endpoint, and Kinetic Modes (Plate Section). 
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The pre-read plate reduction parameter checkboxes will not be displayed in the Plate section 
Reduction dialog box unless it has been selected in the Instrument Settings dialog box. The figure 
below shows the Reduction dialog box with the “Use plate blank”, “Use pre-read plate,” and “Switch 
normal and pre-read” options available. 

  

Above: Example Reduction Dialog Box Showing Pre-Read and Plate Blank Options 

All of the read modes offer one or more predefined choices for reduction. The predefined reductions 
are described below under the appropriate read mode heading. In addition, with any read mode, you 
can create a custom reduction formula to better suit your needs. Since all custom reduction formulas 
are defined the same way, regardless of read mode, they are described together after the individual 
read mode sections. 

Endpoint 
Wavelength Combination 

The default reductions for Endpoint readings are !Lm1 and Custom for all instruments when you 
read at a single wavelength or if you choose “1-Ref” (for all instruments except VersaMax). For any 
instrument, you can choose Custom and create different reduction formulas. The wavelength 
combinations available in the drop-down menu show the correct format of the formulas that produce 
these reductions. 
  

Kinetic 
Wavelength Combination 

The default wavelength combination for Kinetic readings is !Lm1 and is the only choice 
(besides Custom) for all instruments except the VersaMax. With the VersaMax, choices depend on 
whether you are reading the plate at either one or two wavelengths. For any instrument, if you do not 
wish to use the default reduction, you can choose Custom and create a different reduction formula. 

Kinetic Limits 

The Limits settings for the display of Kinetic data are MaxOD, MinOD, Lag Time, and End Time. 
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� NOTE: The display of OD values is shown relative to the first point measured for each well. Negative 
Kinetic values decrease with time, and limits should be set accordingly (below 0) to view negative Kinetic 
data. Limits define the data that will be viewed and included in data reduction, but do not affect data 
collection. If you alter a limit to show less data, you can always display the “hidden” data again by 
changing the limit. 

MaxOD 

The limit for the maximum value you wish to report. Any values from the reading that are above this 
limit will not be shown and will be excluded from data reduction. The default for MaxOD is 1.0. 

The MaxOD reduction parameter can be used to exclude the non-linear portion of the reaction from 
data analysis. This type of data reduction is most useful in reactions where the initial portion of the 
data is linear. You might also adjust the End Time setting to remove a non-linear portion after a 
certain time point in the reaction. Using MaxOD allows the use of the maximum number of linear 
points to calculate the slope of the line and, thus, to determine the rate for each well. 

 

 
Above: Different Reductions of the Same Data Using Different MaxOD Points 

Both of the Well Graphs shown above display different reductions of the same data (these examples 
use optical density readings). In the figure on the top, the MaxOD is set to 2.0 for the display of wells 
B4, C6, and D8. In the figure on the bottom, the MaxOD has been reset to 0.5. Alternatively, you could 
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leave the Maximum OD and decrease the number of Vmax Points used to determine the slope of the 
line. 

MinOD 

The limit for the minimum value you wish to report. Any values from the reading that are under this 
limit will not be shown and will be excluded from data reduction. The default is 0 OD. To display 
negative Kinetics, the value should be set below 0 (zero).  

Lag Time 

Specifies how many initial data points are excluded from the calculation of Vmax Rate. Lag Time 
truncates the data used in the calculation. It does not prevent data from being collected. The Kinetic 
plots will not display the data collected prior to the set Lag Time. The value for Lag Time can be 
changed after the plate is read. The default is 0. 

 
In the figure on the top left, well C5 has a lag time: the data is not linear until approximately 80 
seconds after the start of data collection. Thus, the linear curve fit is not good and the slope of the line 
does not reflect the maximal rate. In the figure on the bottom right, a lag time of 80 seconds has been 
set and the linear curve fit for both wells is good, allowing the slope of the lines to reflect the maximal 
rate in each well. Alternatively, you could leave the Lag Time and decrease the number of Vmax 
Points used to determine the slope of the line. 
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End Time 

This setting specifies the time at which you wish to stop showing data in the display. Any values 
occurring after this limit will not be reported in the display. The default setting is the total assay time. 
The value for end time may not be greater than the total assay time. 

Absolute Values 

This setting causes the plots shown in the data display to be drawn at their absolute OD as opposed 
to the default (with the box unchecked) which offsets the first point to the (0,0) coordinate. Enabling 
Absolute Values may cause some data points that do not fall within the default limits for the plots to 
“disappear” (see the figure below). 

 
Above: Kinetic Reduction with Absolute Values Enabled.  

Note that the limits in this example (MinOD=0, MaxOD=0.5) do not allow all of the data to be visible. 

To see more data, yet still display absolute values, increase the limits for MinOD and/or MaxOD 
found in the Reduction dialog box. 
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If you increase the MaxOD setting to be at least as large as the largest absorbance value expected, 
most or all of the data plots should appear in the data display. In the Kinetic Reduction example 
shown above, if the MaxOD value is increased from 0.5 to 2.0, the plots then appear as shown below. 

 
Above: Kinetic Reduction with Absolute Values Enabled and MaxOD Value Increased 

Kinetic Reduction 
Kinetic reductions are applied to the list of numbers (the value at each timepoint) after the 
wavelength combination formula is applied. Vmax per min and Vmax per sec reductions are 
available for all instruments that are capable of Kinetics; the default Kinetic reduction is Vmax. Other 
reductions available from the pop-up menu are Time to Vmax, Onset Time, Time at Minimum, Time 
at Maximum, Time at 1/2 Maximum, Slope, Area Under Curve, or you can choose Custom and then 
create a different reduction formula. 

Vmax 

The maximum slope of the Kinetic display of optical density versus time. The default value displayed 
is in milli-optical density units per minute (mOD/min). The rate is calculated with the use of  Vmax 
Points (see below) which determines the number of contiguous points over which Vmax is calculated. 
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The number of Vmax Points defaults to the maximum taken during the reading; you can change this 
number in the Reduction dialog box if desired. 

� NOTE: Vmax = Vmax/sec • 60,000 

A linear regression is performed to determine the slope of the line using the equation: 

   y = m*X + B 

where m is the slope of the line. 

The reaction rate is reported in milliOD/min (color change in milliOD per minute of reaction time). 

Vmax Points 

This setting defines the maximum size of the line segment used to determine the slope of the line 
used in calculating the rate of the reaction. The default is the total number of points taken in the 
reading, with the data normalized to a starting point of 0,0 (as opposed to starting from the optical 
density of the first time point). The first slope is calculated for a line drawn beginning at the first 
reading as defined by Lag Time (described below) and ending at a total number of readings equal to 
the Vmax Points setting. The second and any subsequent slopes are calculated beginning at the 
second time point and ending at a total number of readings equal to Vmax Points. The steepest slope 
is reported as Vmax Rate. If the data plot displays fewer time points (data points) than the number of 
time points chosen for Vmax Points, then all of the time points will be used to determine the slope of 
the data. 

Using Vmax Points (Example) 

 Well 1 Well 2 Well 3 

Time points visible in 
the well (data plot) 25 10 2 

Number of Points Used for Data Analysis: 

Vmax Points set to 25/25 
(default) 25 10 2 

Vmax Points set to 5/25 
Overlapping 
5-point line 
segments* 

Overlapping 
5-point line 
segments* 

2 

* SoftMax Pro will perform a linear regression on as many overlapping 5-point line segments as possible in the 
analysis window. The slope will be determined for each line segment and then the steepest slope will be reported 
as the reaction rate. Thus, in well 2 of the example in the table above, the slope will be determined for line 
segments consisting of time points 1 to 5, 2 to 6, 3 to 7, 4 to 8, 5 to 9, and 6 to 10, and then the slope of the line 
segment with the steepest slope will be reported as the Vmax Rate. 

The progressive slope calculations are repeated until the last included data point is reached (as 
defined by the End Time or MaxOD — see below). The maximum positive or negative slope is 
reported as Vmax (mOD/min). Vmax Points can be set from 2 to the total number of points in the 
curve. The number of Vmax Points can be set before the plate is read and can be changed after the 
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plate is read. The data display will update automatically each time. The Vmax Points setting does not 
affect data collection. 

� NOTE: The height of the Y axis in the raw data plots or plate display is controlled using MinOD and 
MaxOD. The default settings are: 
      MinOD = 0 
      MaxOD = 1.0 
The width of the X-axis in the raw data plots or plate display is controlled using Lag Time and End Time. 
If either the MaxOD or End Time setting excludes points such that a total number of readings equal to 
Vmax Points cannot be used, then the maximum included points will be used. 

Time to Vmax 

This is an alternative method for analyzing non-linear Kinetic reactions which reports the elapsed 
time until the maximum reaction rate is reached, rather than reporting the maximum rate itself. Used 
in conjunction with Vmax Points, Time to Vmax is the time to the midpoint of the line defined by 
Vmax Points and used to calculate Vmax. This elapsed time data is useful for applications including 
coagulation chemistry where the changing concentration of the reagents does not change Vmax, but 
rather will change the time at which the reaction reaches the maximum rate. 

Onset Time 

This is another method for analyzing non-linear Kinetic reactions. Onset Time reports the time 
required for a Kinetic reaction to change by a specified optical density (onset OD above the initial OD 
reading for the well). This elapsed time data is useful for cascade reactions including clot formation 
(endotoxin testing, for example) and clot lysis applications where the change in reagent concentration 
does not affect the maximum optical density change but changes the time required for the reaction to 
reach completion.  

Time at Minimum 

This setting reports the time at the minimum OD or %T that falls within the reduction limits. 

Time at Maximum 

This setting reports the time at the maximum OD or %T that falls within the reduction limits. 

Time at 1/2 Maximum 

This setting reports the time at the half of the maximum OD or %T that falls within the reduction 
limits. To calculate this reduction, SoftMax Pro first determines the Kinetic point (within the 
reduction limits) that has the maximum signal level (OD or %T). It then scans the Kinetic plot from 
left to right until it finds two points having signals that bracket half of that value. A linear 
interpolation between these two points is used to estimate the Time at 1/2 Maximum. 

Slope 

This setting determines the slope of the combined plot (i.e., the slope of the line using linear 
regression after the wavelength combination reduction). This setting uses all visible time points in the 
reduction window. Slope is the same as Vmax Rate when Vmax Rate is set to the same number of 
points as the run (i.e., the default). Slope is not the same as Vmax Rate if you have modified the Vmax 
Points. 

Area Under Curve 

This reduction estimates the area under the curve as defined by the data plots (within the reduction 
limits). The data plots are treated as a series of trapezoids with vertices at successive data points and 
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at the X-axis coordinates of the data points. The areas defined by each of the trapezoids are then 
computed and summed. 

Custom Reduction Formulas 
If the predefined reduction formulas do not meet your needs, you can create one or more different 
reduction formulas for any or all read modes (Endpoint, Kinetic, Spectrum, or Well Scan). Choosing 
“Custom” from any of the menus or dialog boxes causes a Formula button to appear (an example of 
this button in an Endpoint Reduction dialog box is shown in the figure below). Custom reduction 
formulas may contain other operators and terms in addition to wavelengths. 

 
Above: “Custom” Selected Showing Formula Button (Endpoint) 

Clicking the Formula button opens the Calculation dialog box in which you can name and define a 
new reduction formula. 

 
Above: Wavelength Calculation Dialog Box (Endpoint) 

Examples of some formulas that might be used when combining multiple wavelengths in the 
Calculation dialog box are given in the table below. 
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Wavelength Reduction Formula Examples 

2 λ 3 λ 4 λ to 6 λ 

!Lm1 + !Lm2 !Lm1 + !Lm2 + !Lm3 !Lm1 + !Lm2 + ... + !Lmn 

!Lm1 - !Lm2 
(!Lm1 - !Lm3) / (!Lm2 - 
!Lm3) 

(!Lm1 - !Lm6) /(!Lm2 - !Lm5) / 
(!Lm3 - !Lm4) 

!Lm1 / !Lm2 !Lm1 / !Lm3 !Lm1 / !Lmn 

!Lm1 * !Lm2 !Lm1 * !Lm3 !Lm1 * !Lmn 

Log10(!Lm1/!Lm2) Log10(!Lm1/!Lm3) Log10(!Lm1/!Lmn) 

!Pathlength !Pathlength !Pathlength 

!Lmx/constant 
For example, Lm1/1.44 for quantitating a polyclonal 
antibody by measuring the absorbance at A280. 

Average(!allvalues) 
This formula will average together the optical densities 
for multiple readings at the same wavelength (for 
example, if you read the well six times at 280 nm). 

Min(!allvalues) 
This formula will report the minimum OD recorded for 
multiple wavelength readings in each well. 

Max(!allvalues) 
This formula will report the maximum OD recorded for 
multiple wavelength readings in each well. 

If(!Lmz<A,makeerr(118), 
(if(!Lmx>B,makeerr(117),!Lm1))) 

This formula will report “low” for any well with an OD 
less than A, “high” for any OD greater than B, and the 
OD of any well that lies between A and B. 

� NOTE: For EMax, VMax, UVMax, or ThermoMax instruments, the choice available for reading at two 
wavelengths is designated “1-Ref.” While the instrument performs a reading at the two wavelengths you 
designate (one for the measurement and one for the reference), data regarding these individual 
wavelength readings is automatically reduced to a single value in the data display: the value obtained 
from the reading at the reference wavelength is subtracted from the reading at the measurement 
wavelength and only the resulting value is displayed. When you choose 1-Ref, you cannot view the data 
associated with the readings at the individual measurement or reference wavelengths. 

Custom reduction formulas utilizing mathematical operators or terms can be used to obtain specific 
types of data. The table below provides some examples of such formulas for Kinetic and Spectrum 
readings. 
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Kinetic Reduction Formula Examples 

Kinetic 

Vmaxcorr(!combinedplot, 
!vmaxpoints,!readinterval) 

Reports Vmax correlation coefficient for plots in all 96 
wells. 

Vmax(Delta(!combinedplot), 
!vmaxpoints,!readinterval) 

Will report the Vmax Rate of the delta between each 
time point. 

Nthitem(!Lm1,X) 

Will report the optical density at item X in the list of 
readings. For example, if you have a Kinetic run with 
20 time points and X is 10, it will report the OD of the 
10th time point.  

For a full discussion of custom formulas, see the Formula Reference Guide. 

When you finish your entry in the Calculation dialog box and click [OK], the formula you have 
entered then appears to the right of the word “Custom” and becomes the default selection for the 
Custom option. You may subsequently edit this formula or enter a new one by clicking the Formula 
button again. 

Recalculation Options 
By default, SoftMax Pro performs continuous recalculation of the data when you read plates, create 
or change formulas, and so on. At certain times, it would be useful to disable the recalculation feature 
so that you can make alterations to the experiment without waiting for individual recalculations to be 
completed. Two commands are available in the Edit menu that allow you to modify the way in which 
SoftMax Pro performs recalculation: Suspend Recalculation and Recalculate Now (  =; [CTRL]+[=]). 

Choosing Suspend Recalculation disables the automatic recalculation feature of the program and 
places a checkmark to the left of the command in the menu to indicate that it has been selected. While 
this function is enabled, no recalculation will occur, regardless of what you may change, add, or 
delete from the experiment. This is especially useful when creating or changing column formulas 
within Group sections, for example, as it can speed up the process greatly. 

When recalculation has been suspended, you may wish to see the results of the changes you have 
made but may still not wish to enable continuous recalculation. Choosing Recalculate Now (  =; 
[CTRL]+[=]) from the Edit menu will cause SoftMax Pro to examine all elements of the experiment 
and perform complete recalculation of the data. Choosing this command does not enable continuous 
recalculation but simply causes the program to perform recalculation once. 

To return to continuous recalculation, choose Suspend Recalculation again. The checkmark next to 
the command will disappear, indicating that the function is no longer in use. 

� NOTE: Recalculate Now (  =; [CTRL]+[=]) can be used to see intermediate results during long Kinetic 
readings. At any time, you can choose Suspend Recalculation to delay calculations until a later time. 
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Displaying Data in Group, Graph, and Notes Sections 
Group Sections 

The manner in which data is displayed in a Group section depends on the type of reading that was 
performed (Endpoint, Kinetic, Spectrum, or Well Scan), but can be customized by choices made in the 
data display, reduction settings, and the Edit menu. 

Default displays for Group sections are shown automatically unless you choose a different display 
option. 

The particular font to be used in a Group section table, as well as its size and style, can be changed by 
first selecting one or more columns in the Group section table and then choosing the Text command 
from the Edit menu and making the desired choices from the dialog box that appears. 

Settings from the Plate Section Affect Data Display in Group Section Tables 

Reduction options in the Plate section allow you to display the raw data received from the instrument 
in a reduced (analyzed) form. Which reduction options are available depend on the read mode used 
and reduction settings chosen. Reduced numbers from the read section are displayed in the Values 
column of the Group section tables by default. 

Reduction settings do not affect the raw data but simply cause it to be displayed differently. You can 
change reduction settings without affecting the raw data from the reading in any way. 

Custom reduction formulas require the use of accessors and operators that are understood by 
SoftMax Pro. For a list of these accessors and operators see the Formula Reference Guide. 

Resizing and Hiding Columns 
The columns in a Group section can be resized in several ways. One of the simplest methods is to 
drag the line dividing the columns to another position (moving it horizontally). When you point to a 
line between columns, the cursor changes to a double arrow with a vertical line through it, showing 
that it is ready to move left or right 
. 

 
Above: Cursor Positioned on a Line between Columns 

Reducing Column Size and Hiding Columns 

You can reduce a column to a size smaller than the width of its title, in which case the title will not be 
completely visible. You can also hide a column by reducing its size completely (drag one edge of the 
column on top of the other) or by selecting that column and choosing Hide from the Group menu. 
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� NOTE: If you hide a column in this way and then wish to view it again, use the Show All command in the 
Group menu. All columns that were hidden will again be visible. There is no way to show only one 
hidden column. 

Enlarging Column Size 

You can enlarge the width of columns to any size. Increasing the size of columns may make the width 
of the Group section increase beyond the page width boundary. If this occurs, the columns will 
“disappear” off the edge of the screen but are really still there. To bring these columns back into 
view, reduce the width of the columns that are still visible until the others reappear. 

 

� NOTE: If the width of a section extends beyond the page width boundary, the portion that is not visible 
will not be printed. 

To size two or more columns to the same width, highlight those columns and then drag one of the 
dividing lines to the desired width. The width of all highlighted columns will be sized the same as 
the column to the left of the dividing line you are moving. 

Columns can also be resized to the minimum amount of space required by choosing Autosize from 
the Group menu. By highlighting the entire table or individual columns and then choosing Autosize, 
the amount of space each column requires will be reduced to the minimum size required by the 
largest piece of text in that column. 

Double-clicking the line dividing two columns causes the single column to the left of the divider to be 
sized according to the largest amount of text in that column. 
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Showing and Editing Existing Column Formulas 
When group sections are first created, the formulas used to calculate the data are not displayed. 

These formulas can be shown (until you choose to hide them again) by making a Group section active 
and then choosing Show Formulas from the Group menu. (Note that the command in the menu 
changes to Hide Formulas after they are shown.) 

 
Choosing this option causes an additional row to appear (beneath the heading for each column) 
which shows the formula used to calculate the data in each column. To see formulas briefly, hold 
down the Shift and [CTRL] keys. 

 
Modifying Column Formulas 

To modify the formula for an existing column, double-click the column or click the column once and 
then click the formula button in the section tool bar. The dialog box associated with the column 
formula will open, allowing you to edit the formula (and the name) associated with the column. 
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For a complete discussion, see the Formula Reference Guide. 

Adding Columns 
You can add a new column to a Group section by clicking the Create Column button in the Group 
Tool Bar or by choosing Create Column from the Group menu which will open the Column Formula 
dialog box. 

 
Calculation dialog box 

In the Column Formula dialog box, you can change the name of the new column (from the default 
which simply lists the column by number) to reflect the data that it will contain. 

If no existing column is selected when you click the Create Column button, the new column will be 
created to the right of all existing ones. If you select (highlight) a column and then add a new column, 
it will be positioned to the right of the one you selected. If the table is currently as wide as the sheet of 
paper specified in Page Setup when a new column is added, the columns will “disappear” off the 
right side of the window but are still there. To bring these columns back into view, resize visible 
columns smaller. 

New columns can contain references to other columns, both in the current section or in a different 
one within the same experiment. For example, if you wanted to subtract the mean values in one 
group from those in another, you could create a new column (in either group) to do this. If the two 
groups were named “Group 1” and “Group 2,” for example, and both groups contained a column 
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entitled “Mean,” you could create a column within “Group 1” that would subtract the mean values in 
“Group 2” from those in “Group 1.” The column formula needed to do this would be: 

Mean-Mean@Group2 

Numerous possibilities exist for creating and editing column formulas to display the data you desire. 
For a complete discussion of formulas and operators, see the accompanying Formula Reference Guide. 

� NOTE: To delete a column, highlight it and press the [Delete] key or choose Cut from the Edit menu. 

Adding or Editing a Summary in a Group Section 
To add a summary at the bottom of a Group section, click the Create Summary button in the tool bar 
or choose Create Summary from the Group menu. The Calculation dialog box will appear, allowing 
you to change the name of the summary or hide the name, if desired, as well as to enter a description 
of the summary and to create a formula for it (including the number of decimal places for the result, 
if appropriate). Double-clicking an existing summary causes the same dialog box to appear, allowing 
you to modify summary information. 

 
Information entered in this dialog box will be placed at the bottom of the Group section as follows: 

Name = Description     Formula Result 

You can click the checkbox next to Hide Name, which will change the way the summary appears to 
show: 

Description     Formula Result 
  

� NOTE: The name assigned to a summary is important since you can reference the summary by name in 
other formulas (building one upon another). The summary name can be referenced even if it is hidden. 

   

If you wish to see the formulas associated with summaries without opening the Calculation dialog 
box for each one, you can choose Show Formulas from the Group menu. To see these formulas only 
briefly, hold down the shift and [CTRL] keys while that Group section is active. The summaries will 
“expand” to show the complete formula along with the title. They will resume their previous 
appearance when you release the [Option] key. 

Summaries in Group sections can be moved horizontally, if desired, by dragging them left or right. 
When you position the pointer over a Group summary, the cursor changes to show a double-headed 
horizontal arrow. Clicking once highlights the summary; dragging and then releasing the summary 
leaves it in the position where the mouse button was released. 

To have summaries line up with particular columns in the Group, hold down the [CTRL] key while 
dragging the summary. When you release the control [CTRL] key, the summary will “snap back” so 
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that it begins flush to the left side of the column under which it was released. Each summary can be 
positioned in a different place in the Group section, if desired. 

� NOTE: To delete a summary, highlight it and press the [Delete] key or choose Cut from the Edit menu. A 
summary can also be copied or cut and then pasted in a different location. 

You can also change the format of the text in Group section columns and/or summaries. By selecting 
the column or summary and then choosing Edit and then Text Style ([CTRL]+[T]), you can change the 
font, size, and/or style of the text. 

Notes Sections 
The Notes section allows you to enter text describing the experiment and one or more summary lines 
that contain formulas. To create a summary, click the Create Summary button in the tool bar or 
choose Create Summary... from the Notes menu. 

The Calculation dialog box that appears allows you to enter a description of the summary, accept the 
default title for the summary, change it or hide it, and enter a formula (including the number of 
decimal places the reduction should show, if appropriate). For detailed information regarding 
operators and accessors, see the Formula Reference Guide. 

If you wish to see the formulas associated with the summaries without calling up the Calculation 
dialog box for each one, you can choose Show Formulas from the Notes menu. To see these formulas 
only briefly, hold down the shift and [CTRL] keys while that Notes section is active. The summaries 
will “expand” to show the complete formula along with the other summary information. They will 
resume their previous appearance when you release the [Option] key. 

Graph Section 
The Plot#X Dialog Box 

Whenever you create a new Graph section or add a plot to an existing graph, the Plot#X dialog box 
opens automatically (“X” starts with “1” and increments each time a new plot is added to a Graph 
section). In this dialog box, you can rename the plot, assign specific information to be plotted on the 
X- and Y- axes, and choose which icon and color will be used. If you rename the plot, the title of the 
dialog box will change to show the new plot name. 

All groups that have been created or assigned within the file are listed on the left side of the “Source:” 
field in the Plot#X dialog box. The first group in the file is automatically selected. Other groups can be 
selected by highlighting them. When a group is selected, the pull-down menus in the X-axis and Y-
axis subfields change to show the group columns that are available for graphing. Group columns can 
be assigned for both the values to be plotted and any error bars to be included for both axes. 

Summaries and user-defined formulas can also be graphed. Pushing the  button for either the X-
axis or Y-axis opens a dialog box which allows you to enter formulas. To plot a summary, enter the 
summary name in this dialog box. Formulas can be plotted for comparison with other data. For 
example, if the data is assumed to follow a specific model, the model formula can be entered as a plot 
and then the data can be chosen for another plot within the same graph. You can also use this feature 
to plot Kinetic or Spectrum data in Graph sections. For example, to plot Kinetic data from well A1 in 
a Graph section, you can enter the formula !A1Lm1 for the Y-Axis and the !TimeRun accessor for the 
X-axis. The entered formulas are also shown in the “Source:” field of this dialog box. 

The size, color, and style of the icon used for a plot can be selected on the right side of this dialog box. 
Four sizes, nine colors, and nine styles are available from drop-down menus. 
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The Graph Options Dialog Box 

The Graph Options dialog box allows you to change the name of the Graph section, change the height 
of a graph, select the type of graph to be displayed, change the fonts used on the title, legend, and 
axes, access the Plot#X dialog box for editing plots, entering new plots, and/or to delete plots. This 
dialog box is opened after pressing [OK] in the Plot#X dialog box when a new Graph section is being 

created. This dialog can also be accessed by pressing the Graph Options button  on the Graph 
section toolbar or by choosing Graph Options from the Graph menu. 

Scatter plots, cluster bar charts and stack bar charts can be created. Error bars can be used with all 
graph types. You can also choose whether to connect the points and/or plot the symbols in the graph. 

Each of the plots that have been created for this Graph section are listed in the “Plots:” field of this 
dialog box. Choosing any of these plots provides an indication of the data to be used for the X- and Y- 
axis data points and error bars on the right side of this field. Plots can be deleted by highlighting the 
plot name and clicking the [Delete] button. Clicking the [New] button opens the Plot#X dialog box, 
allowing you to create a new plot for the graph. Existing plots can be edited by highlighting the plot 
name and clicking the [Edit] button which opens the Plot#X dialog box containing all the information 
for the selected plot. 

When creating a new Graph section, the Graph Options dialog box opens after choosing either [OK] 
or [Cancel] in the Plot#X dialog. The new Graph section is not created, however, until you click [OK] 
in the Graph Options dialog box. 

 
Creating Multiple Plots 

SoftMax Pro makes it possible to create multiple plots within a graph. Each plot will represent data 
from a group that has been created in the Template Editor or data from a summary or custom 
formula. You may plot data from any group or from several groups on a graph, even if the groups are 
in separate experiments. It is possible, for example, to plot multiple dilution series of an unknown, to 
graph together a series of patient samples, or to plot several controls that have been run over time. 

Following is a summary of the steps required to create multiple plots within a single graph, after 
which is an example that provides more detail. 

Multiple Plots Step Summary 

 Create all required groups in the Template Editor. 

 Read the microplate to obtain data. 
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 Create a graph section. 

 Add plots to the graph and choose the group and the X and Y values to be shown for each plot. 

Example of Creating Multiple Plots 

This example shows how three groups, all of which are Standards, were plotted on the same graph.  

1. Groups are created in the Template Editor. For this example, four groups are created: three for 
standards (Standard1, Standard2, and Standard3) and one for Unknowns (Unknown1). 

 
Standards and Unknowns Groups Created 

2. The associated Group sections are created using the Standards column format which, by default, 
generates columns for concentration and optical density values. The example below shows the 
Group section for Standard2. 

 
Standard2 Group Section 

3. A new Graph section is created by selecting New Graph from the Experiment menu. This causes 
the Plots dialog box to open automatically. The default name for the first plot, “Plot#1,” is then 
changed (by typing a new name over it) to “Standard#1.” Clicking [OK] opens the Graph 
Options dialog box which allows you to choose the graph type, modify the fonts used for the 
graph, and so on. Choices should be made as follows: Standard1 for the group to be plotted, the 
concentration of Standard1 for the X-axis, and values of Standard1 for the Y-axis. No error bars 
are added. 
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Graph Options Dialog Box with Plot Name Changed to “Standard#1” 

4. A second plot is added to this graph by clicking the [New] button in the Graph Options dialog 
box. After clicking [New], a dialog labeled Plot #2 is opened. The second plot name defaults to 
“Plot#1,” which now shows beneath the first plot. Change this second plot name to 
“Standard#2,” choose Standard2 for the group, and change the X- and Y-axes to show 
concentration and values, respectively, for Standard2. 

 
Graph Options Dialog Box with Second Plot Added for Standard#2 

5. This process is repeated for a third plot, labeled “Standard#3.” 

6. Now that all plots information is complete, clicking [OK] in the Graph Option dialog box will 
close it, and the resulting graph will show the three plots created. 
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Graph Displaying Three Standards Plots 

You can add as many plots to a graph as you wish, and these can be of the same or different types of 
groups. If you create a graph and later wish to add one or more plots to it, simply click the [Graph 
Options] button on the Graph section Tool Bar and then click the [New] button. This will reopen the 
Plots dialog box, allowing you to add or modify the plot information. 

Error Bars 

When data is displayed as a scatter or bar graph, you can choose to display error bars for the plot of 
the data for the X- and/or Y-axis. Error bars are lines that extend beyond a plotted value in either or 
both directions and graphically represent some amount of error in plotted data. 

  
Plot Showing Error Bars 

Choices for displaying error bars relative to a particular axis are the same as those available for 
displaying data on that axis: any column from that group that contains numerical information (not 
columns with text). To display error bars, click and hold the box next to “Error Bars” in the Plot#X 



Chapter 6: Data Analysis: EMax, VMax, UVMax, ThermoMax, VersaMax  

350 SoftMax Pro User’s Manual 

dialog and drag to select one of the choices in the menu. To disable error bars, choose “No Error” for 
the X- and/or Y-axis. 

Error bars show both positive and negative error. Depending on the range settings for the graph, 
portions of the error bars may not be visible. 

Curve Fitting 

When you first create a graph of the data, it does not have a fit associated with it. The graph might 
appear something like this: 

 
Graph with No Fit 

You can fit any plot to one of nine curve-fitting algorithms: Linear, Semi-Log, Log-Log, Quadratic, 4-
Parameter (logistic), Log-Logit, Point-to-Point, Exponential, and Cubic Spline. These selections are 
shown in the Fits pop-up menu in the Graph section toolbar (click on the box next to “Fit”). 

Typically, a standard curve refers to the curve fitted to the plot of concentration versus mean value 
for the Standard group. 

Once you have selected a Fit type, SoftMax Pro determines the parameter values that best fit the data. 
The function with these parameters is then drawn on the graph. Ideally, the type of fit used should be 
determined by the underlying chemistry of the assay and could be set before data is read. 

NOTES: A good discussion of curve fitting appears in “Data Analysis and Quality Control of Assays: 
A Practical Primer” by R. P. Channing Rogers in Practical Immuno Assay, edited by Wilfrid R. Butt 
(published by Marcel Dekker, Inc., New York, 1984). 

When a fit is chosen, the Graph section is updated to show the coefficients describing the fit when 
applicable. These values are displayed in the legend at the bottom of the graph. Figures below show 
the same graph with the different fit algorithms applied. Note that the legend information changes 
(along with the formula for the fit) at the bottom of each Graph section for each different fit. 

� NOTE: All plots on a graph must have the same type of fit. 

When a curve fit is chosen, the values for the coefficients of the equation (A, B, C, etc.) will be shown 
as will the square of the correlation coefficient (R^2). The correlation coefficient describes how well a 
change in x values correlates with a change in the y values. The R^2 value should only be used for 
curve fits having linear axes. 
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Linear 

The linear function fits the best straight line to the data. The equation for this fit has the form of: 

Y = A + (B * X) 

where A is the y-intercept of the line and B is the slope. A linear fit should be used whenever the 
values appear to lie on or scattered around a straight line. 

This equation is shown on the screen as: 

y = A + Bx 

A linear fit should be used whenever the standard values appear to lie on or are scattered around a 
straight line. The figure below shows an example of a linear fit. 

 
Graph with Linear Fit 

Semi-Log 

The semi-log function fits the best straight line to a set of data for log(X) plotted against Y. The 
resulting curve displayed will be a straight line with the X-axis drawn in logarithmic scale. The 
equation for a semi-log fit is: 

Y = A + [B * log10(X)] 

and is shown on the screen as: 

y = A + B * log(x) 

where A is the y-intercept of the line and B is the slope (note: log in this equation is the common or 
base-10 logarithm). 
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Graph with Semi-Log Fit 

Log-Log 

The log-log function fits the best straight line to the set of data which consists of the logarithm of the 
readings on the Y-axis (the response) and the logarithm of the dose on the X-axis. The resulting 
display will be a straight line with both axes drawn in logarithmic scale. The equation for the log-log 
fit is: 

log10(Y) = A + [B * log10(X)] 

and is shown on the screen as: 

log(y) = A + B * log(x) 

where A is the log10Y-intercept of the line for log10(X) = 0 and B is the slope (note: log in this 
equation is the common or base-10 logarithm). 
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Graph with Log-Log Fit 

Quadratic 

The quadratic function fits the best parabola to the data. The parabola is a curved line based on the 
equation: 

y = A + (B * x) + (C * x2) 

which is shown on the screen as: 

y = A + B*x + C*x^2 

where A is the intercept, B is the slope of the curve at the intercept, and C is the measure of the 
curvature of the parabola. 

The quadratic fit is most appropriate when the standard curve has a tendency to curve up or down. 
An example of a quadratic fit is shown below. 

 
Graph with Quadratic Fit 
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4-Parameter Logistic and Log-Logit 

If the standard curve has a sigmoidal shape when plotted on the semi-log axes, it may be appropriate 
to use either the log-logit or 4-parameter fit. Both fits are based on the equation 

 
where D is the Y-value corresponding to the asymptote (i.e., the flat part of the curve) at high values 
of the X-axis and A is the Y-value corresponding to the asymptote at low values of the X-axis. The 
coefficient C is the X-value corresponding to the midpoint between A and D. The coefficient B 
describes how rapidly the curve makes its transition from the asymptotes in the center of the curve. A 
large value of B describes a sharper transition. Typically, B has a magnitude of about 1. 

Both the log-logit and 4-parameter equations are shown on the screen as: 

y = (A - D) / (1 + (x / C) ^ B) + D 

 
Graph with 4-Parameter Fit 
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Graph with Log-Logit Fit 

Some publications show the log-logit equation in another form: 

 
where 

 
A different algebraic expression of these is: 

 
The difference between the log-logit fit and the 4-parameter fit are in the way the coefficients A and D 
are calculated. For the log-logit method, the standard values for the lowest and highest values of x are 
used. The corresponding y values are assigned to A and D, respectively. Based on these fixed values 
for A and D, the algorithm then computes values for B and C. This technique works well if there are 
standard points along the upper and lower asymptotes. If this is not true, the log-logit fit should be 
avoided in favor of the 4-parameter logistic. 

� NOTE: The curve-fitting algorithm for the 4-parameter equation was based on the Levenberg-Marquardt 
Method. Discussion of this method can be found in Numerical Recipes in C: The Art of Scientific Computing 
by William H. Press, Brian P. Flannery, Saul A. Teukolski, and William T. Vetterling, published by 
Cambridge University Press, New York, 1988. 

Point-to-Point 

A linear equation is fit to each pair of data points. Fit parameters are not given. The point-to-point 
curve fit is a linear fit composed of pieces that assume a linear relationship between each pair of data 
points. The line segment defined by each pair is used to interpolate data between those points. Since 
there are multiple line segments, fit parameters are not shown on the graph. 
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Graph with Point-to-Point Fit 

Cubic Spline 

This curve fit generates a fit to a cubic equation between each pair of data points. The general form of 
a cubic equation is: 

y = A + Bx + Cx2 + Dx3 

The equations are computed with the requirement that the first and second derivatives of the 
equations are continuous throughout the range of the data. As multiple curve fits are performed with 
this routine, fit parameters are not shown with the graph. 

 
Graph with Cubic Spline Fit 

Exponential 

The exponential function used to generate this curve fit is: 

y = A + B * (1 - exp^(-x / C)) 
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Graph with Exponential Fit 

� NOTE: SoftMax Pro does not plot samples with descriptor values of zero (0) on a log axis. Curve fits 
affected by this are the semi-log, log-log, log-logit, and 4-parameter curve fits. 

Minimum Number of Standards 

The number of standards used in a standard curve depends on the particular curve fit selected and 
on the judgment of the operator. The table below gives the minimum number of standards required 
mathematically by each of the curve fitting algorithms. 

Minimum Number of Standards Required for Curve Fits 

Curve Minimum Number of Standards 

Linear 2 

Quadratic 3 

Semi-Log 2 

Log-Log 2 

Log-Logit 4 

4-Parameter 4 

Point-to-Point 2 

Exponential 3 

Cubic Spline 4 
For optimal results, you should always exceed the minimum number of standards required for any 
given fit. 

There are other requirements on the standards for the log-logit and 4-parameter logistic curves. The 
fits for the 4-parameter logistic curve are based on the assumption that the curve has a high and a low 
asymptote and a certain “steepness” for the linear portion around the inflection point between the 
asymptotes. If a sufficient number of points do not define the inflection point and the asymptotes, 
you will receive a “no fit” error message or an inappropriate fit. For best results, make sure that the 4-
parameter fit is appropriate for your assay and that the entire range of the assay is represented in 
your standards. 
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If your standards do not clearly define both a high and low asymptote, the spline fit may be more 
appropriate for your assay. 

Judging a Good Curve Fit 

The correlation coefficient is also known as the goodness of fit value because it shows how good a fit 
exists between the computer curve and the standard data points. It measures the degree to which the 
points fall on the computer curve and may give an indication as to what residuals are to be expected. 
The correlation coefficient is popularly known as R and is between -1 and 1, inclusive. When the data 
points lie on a perfectly straight line with negative slope, then R = -1. If the correlation coefficient is 
not suitably close to 1 or -1 (a perfect fit), you can simply apply one of the other types of curves 
without having to reread the plate.  

For nonlinear curve fits, SoftMax Pro performs transformations that cause the curve to become more 
linear. The correlation coefficients are derived from that transformed data. Because of this, you 
should be cautious about using correlation coefficients as an indicator of goodness of fit. Do not let 
this single value for goodness of fit sway your intuition about which fit is best. Some curve fits may 
seemingly give a good fit (e.g., fit values close to 1) but, when inspected by eye, show a poor fit along 
a major portion of the plot. 

Graph Options    

Graphs can be customized further through the Graph Options dialog box which is accessed by choosing Graph 

Type... from the Graph menu or by clicking the Graph button ( ) in the section tool bar. 

 
Graph Options Dialog Box 

The default options are shown above, but you can alter these as desired: you may change the font and 
type size used for the title, legend, and/or axes of the graph, and you can choose the color and type of 
symbol used on a scatter graph to show the plot. The graphs shown in preceding Figures reflect the 
default graph options. Connecting the points of a scatter graph can be useful in determining the 
closeness of the fit. The figure below shows a scatter graph with points connected compared to a 
linear fit. 
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� NOTE: The Connect Points option connects the points in order of appearance by sample name—not the 
appearance of points from left to right on the graph. 

 
Scatter Graph with Points Connected (Linear Fit Applied) 

Other options in this dialog box allow you to plot the data as a bar graph with data shown in clusters 
or stacked. The figure below shows both of these bar graph options. 

 
Bar Graphs—Cluster and Stack 

� NOTE: Bar graph options for multiple plot graphs are only available when each plot contains the same 
number of data points and has matching X-axis coordinates. 

� NOTE: When choosing the Connect Points option, the order in which points are connected is sample 
name dependent. 
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Axes Options    

Double-clicking either graph axis, clicking the X-axis or Y-axis button in the Graph section toolbar, or 
selecting either X-axis... or Y-axis... from the Graph menu opens a dialog box concerning the 
configuration of that axis. The figure below shows the dialog box for the X-axis. 

 
X-Axis Dialog Box 

The default settings are shown in the Figure above. You can change these as desired for either or both 
axes. 

Axis Settings 

Enabling the Auto-range option causes the graph to be drawn such that all data points are shown (by 
automatically adjusting the minimum and maximum range settings to encompass the data). You can 
disable the Auto-range function by clicking the checkbox or by changing either or both values for the 
Min and/or Max settings. 



  

  

Displaying and Analyzing Data: SpectraMax (except SpectraMax M2 and M5) 

Introduction 
Initial display and reduction of the data received from the instrument is performed in the Plate 
section or CuvetteSet section in which the data has been collected. Display and reduction parameters 
can be set up either prior to or after collecting data. The display and reduction parameters may be 
modified at any time. 

Data analysis and the display of analyzed data is also performed in the Group sections (created when 
wells or cuvettes are assigned to groups in the Template Editor) and the Graph section(s). 

Notes sections may be used in conjunction with any other section to provide text commentary and/or 
a display of data through the use of summaries. Notes sections are used most commonly to provide 
an introduction to or summary of results for a data file. 

All data files have a minimum of one Plate section or one CuvetteSet section with data in it. Multiple 
Plate sections and/or CuvetteSet sections may be present. Most files will have a template and Group, 
Graph, and Notes sections. However, depending upon the assay and how you wish to report the 
data, only some of these sections may be (or need to be) present in every file. Some simple assays, 
such as reading the absorbance of proteins at 280 nm in a cuvette (or in a microplate with PathCheck), 
allow you to calculate concentration in the Plate or CuvetteSet sections. In such an example, Group 
and Graph sections are necessary only if you wish to display the data graphically. 

Many common assays consist of data acquired in a Plate section or CuvetteSet section. Standards and 
unknowns are defined in a template. Unknowns are then interpolated from a standard curve. The 
following diagram shows the relationship between the different sections in SoftMax Pro: 

 

Initial Data Display and Reduction: Plate/CuvetteSet Section 
The manner in which data is displayed in a Plate section or CuvetteSet section depends on the type of 
reading that was performed (Endpoint, Kinetic, or Spectrum), but can be customized by choices made 
in the data display and reduction settings. Depending on the type of reading performed, display 
options include: 

 Number or plot displays for raw OD or %T (with or without reduced number). 

� NOTE: The number format (use of commas or periods in numeric notation) chosen for the computer 
operating system is reflected in the way that SoftMax Pro displays data. 
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 Number, Plot, Threshold, Ranged, or Grayscale (with or without reduced number) 

 Display as one or three samples per row or display as microplate layout (CuvetteSet section 
only) 

 (SpectraMax Plus384 or 340PC384 only): If you have chosen 384-well plates from the Instrument 
Settings, you can display the wells in different ways: Normal, Vertical, Rotated, Large, or 
Interleaved. 

Default displays are shown automatically unless you choose a different display option. 

Reduction options allow you to display the raw data received from the instrument in a reduced 
(analyzed) form. Which reduction options are available depend on the read mode, instrument, and 
read type used; custom settings, using formulas you create, are available for all read modes, 
instruments, and read types. 

Reduction settings do not affect the raw data but simply cause it to be displayed differently, allowing 
you to change reduction settings without affecting the raw data from the plate or cuvette reading in 
any way. 

Custom reduction formulas require the use of accessors and operators that are understood by 
SoftMax Pro. A list of such accessors and operators can be found in The Formula Reference Guide. 

The Data Display 
After a plate or cuvette has been read, the information sent from the instrument is shown in the data 
display in the active Plate or CuvetteSet section. The default display for data from Endpoint readings 
is raw OD numeric values. Data from Kinetic or Spectrum readings is displayed in plots format (raw 
OD values with respect to time or wavelength). While a Kinetic or Spectrum reading is in progress, 
the display updates dynamically to show the data collected so far. If the instrument is reading more 
than one wavelength in Kinetic mode, plots for the different wavelengths are overlaid in each well. 

All choices except those defined in the Instrument Settings affect only the manner in which the data is 
displayed—the raw data is not changed—permitting you to optimize the display after data is 
collected. 

� NOTE: Data reduction changes the way in which data is displayed and also affects the values used in 
calculations within SoftMax Pro. While the raw values remain unchanged, calculations will use reduced 
values, if any, and are, therefore, affected by settings chosen in the Reduction dialog box.  

� NOTE: With the SpectraMax, Plus, Plus384, 190, and 340PC, data comes from the instrument to SoftMax 
Pro with four digits to the right of the decimal point (instead of three digits for all other instruments). 
Only three of the four digits are displayed in the Plate section or CuvetteSet section for Endpoint data, 
however: the fourth digit is rounded up or down (0.0045 rounds up to 0.005; 0.0044 rounds down to 
0.004, for example). You can view all four digits of data, if desired, by displaying the raw OD in a Group 
section table and increasing the number of decimal places showing. 

The Display Dialog Box 

Before or after a reading, you can click the [Display] button to open the Display dialog box 
which allows you to change the way the data is presented. Choices available in this dialog box 
depend on whether a section is currently active, which instrument is chosen in the Preferences or is 
connected to the computer, and which read mode you have chosen (for example, the choice for 
“Plots” is not shown if Endpoint mode is selected). The figures below show the default Display 
dialog boxes for the different read modes. 
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The Display dialog box is divided into two parts (left and right): the default display, “Raw OD” is 
shown to the left of a dividing line; the choices for reduced data displays are shown to the right of the 
dividing line. Note: data reduction itself is performed separately; settings here simply determine how 
the reduced data will be displayed in the data section. 

The dialog boxes below show the default display choices for the three modes (if applicable): 

 raw optical density values (numbers) for Endpoint; 

 the change in raw OD values over time for Kinetic; and 

 raw OD values for the range of wavelengths, displayed as a plot, for Spectrum. 

Other choices available in this dialog box include displaying the data as a single reduced value 
(number), in threshold, ranged, or gray scale formats, or any combination of display choices with the 
reduced number (the reduced number display choice cannot be used with the reduced number 
checkbox). 

 

Data in the Plate section is displayed in a grid array (microplate format).  

 Normal: shows the data in standard left-to-right format, with well A1 in the upper left corner. 
Columns 1 through 24 are along the top and rows A through P are shown from top to bottom. 
The wells are smaller and data is shown with fewer digits (less precision). 

 Vertical: the plate is shown in the same orientation as Normal except that columns 1 through 12 
(all rows) are shown above columns 13 through 24 (all rows). 

 Rotated: Same as the Normal view except that it is rotated 90 degrees clockwise (well A1 is in 
the upper right corner). 

 Large: Same as the Normal view except larger. This display can be seen in its entirety only if you 
have the page size set for legal paper (8.5 x 14 inches) in landscape orientation (set this in Page 
Setup or Preferences under the File menu). In the example shown in the figure below, the 
display is shown as it appears if you do not change the page size from letter-size to legal. 

 Interleaved: In this display, the wells are shown in a format that “skips” every other well as 
follows: all odd columns and rows begin in the upper left corner of the plate display and are 
followed by all even columns and rows. So well A1 is still in the upper left corner, but it is 
followed horizontally by well A3, A5, ... A23, A2, A4, etc., and vertically by well C1, E1, ... O1, 
B1, D1, etc. This display is most useful when the 384-well plate is composed of 4 daughter plates 
of 96 wells each. 

Reduced Number 
The reduced number is based on the settings defined in the Reduction dialog box. It is a combination 
of blank subtraction, wavelength reduction, and Spectrum scan or Kinetic reduction. The information 
acquired from the microplate reader is reduced to a single number or value. The reduced number will 
be reported in the Group section when a template has been defined. 

To view by reduced number alone, select the Number option (the first choice to the right of the 
default, just after the dividing line); to see a reduced number as well as another type of display, click 
the box next to the option that says “With reduced number” in the lower left of the dialog box to 
enable it. Changing the reduction parameters after choosing a reduced data display mode will cause 
the display to update accordingly. More information about reduction formulas and how to customize 
them follows later in this chapter.  
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Threshold, Ranged, and Gray Scale 
To display Threshold, Ranged, or Gray Scale data, high and low values must be entered. When you 
choose one of these display options, SoftMax Pro provides default values for the high and low limits 
by means of an autoranging function (encompassing all the data from lowest to highest value). You 
can change the high and low limits by highlighting the existing value and entering a new value. An 
example of the Display dialog box for a Kinetic reading (Plate section) with the Threshold display 
option chosen is shown below. 

 
Display Dialog Box 

Threshold 

The Threshold display shows the raw data as a plus (+) for values above the high limit, an asterisk (*) 
for values within the limits, and a minus (-) for values below the low limit. The figure below shows a 
Kinetic reading displayed using the Threshold option along with the reduced number. 
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Threshold display 

Ranged 

When the Ranged display is chosen, raw data that falls between the high and low limits is assigned 
proportionally to integer values from 0 through 9. Values above the high limit are displayed as a 
plus (+) and values below the low limit are displayed as a minus (-). The figure below shows reduced 
Kinetic data displayed in Ranged format. 

 
Ranged display 

Gray Scale 

The Gray Scale option presents the raw data in eight shades of gray, changing from light (for values 
less than or equal to the low limit) to dark (for values greater than or equal to the high limit). The 
figure below shows reduced Endpoint data displayed as Gray Scale. 
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Gray Scale Display 

Data Reduction 

� NOTE: Because this chapter deals with more than one instrument, not all of the information found here 
may apply to your particular instrument. 

 
Raw data received from the instrument can be displayed in an analyzed (or reduced) form. The 
reduction process within SoftMax Pro is based on formulas that reduce the raw data to show a single 
number for each well or cuvette. Further analysis of this reduced number then takes place in the 
Group and Graph sections. 

SoftMax Pro performs calculations hierarchically when reducing the optical density information 
collected from the instrument. Calculations in the Plate section or CuvetteSet section are performed in 
the order shown below. If an option has either not been selected in the Instrument Settings dialog 
box, is not available for the instrument you are using, or has not been defined in the template and/or 
Reduction dialog box, SoftMax Pro starts/continues with the next listed calculation. 

Plate Section 

1. Convert OD to %T (and vice versa) 

2. Pre-read plate blank or plate background constant subtraction (or division for %T) 

3. PathCheck pathlength correction (different equations for OD and %T) 

4. Plate blank subtraction 

5. Wavelength reduction 

6. Kinetic or Spectrum reduction 

7. Group blank subtraction 

CuvetteSet Section 

1. Convert OD to %T (and vice versa) 

2. Reference is subtracted from the reading (optical density mode) or the read data is divided by 
the reference (%T mode—see Caution below) 

3. Template blank subtraction 
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4. Wavelength reduction 

5. Kinetic or Spectrum reduction 

6. Group blank subtraction 

� CAUTION: Separate mathematical calculations are used for handling OD and %T calculations for 
Pre-read plate blanking, PathCheck, and Reference because OD calculations are performed on a 
linear scale, whereas %T calculations are performed on a logarithmic scale. Other calculations, 
however, are not calculated differently by SoftMax Pro for absorbance and %T modes. Because of 
this, Molecular Devices recommends that %T be used only for raw OD, raw OD with Pre-read plate blank 
subtraction, or PathCheck-corrected raw OD readings. Use caution when using %T on reduced 
numbers or any readings that apply other calculations since the data may not accurately reflect 
proper calculations. 

You can access the Reduction dialog box in several ways: by clicking the [Reduction] button in the 
tool bar of the active plate/cuvette section, by choosing Reduction from the Plate/CuvetteSet menu, or 
by clicking the [Reduction] button in the Well Graph display. The appearance of the Reduction dialog 
box will be different depending on the type of read mode you have chosen, and the options you have 
chosen in the Instrument Settings dialog box. The figures below show the Reduction dialog boxes for 
a Plate section and a CuvetteSet section, respectively, in Endpoint, Kinetic, and Spectrum modes, 
along with the default reductions for each of those modes. 
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Above: Reduction Dialog Boxes for Endpoint, Kinetic, and Spectrum Modes (Plate Section). 
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Above: Reduction Dialog Boxes for Endpoint, Kinetic, and Spectrum Modes (CuvetteSet Section) 

For those instruments that support these functions, the PathCheck and pre-read plate reduction 
parameter checkboxes will not be displayed in the Plate section Reduction dialog box unless they 
have been selected in the Instrument Settings dialog box. The figure below shows the Reduction 
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dialog box with the “Use plate blank,” “Use pre-read plate,” “Switch normal and pre-read,” and 
“Apply PathCheck” options available. 

  

Above: Example Reduction Dialog Box Showing PathCheck, Pre-Read and Plate Blank Options 

All of the read modes offer one or more predefined choices for reduction. The predefined reductions 
are described below under the appropriate read mode heading. In addition, with any read mode, you 
can create a custom reduction formula to better suit your needs. Since all custom reduction formulas 
are defined the same way, regardless of read mode, they are described together after the individual 
read mode sections. 

Endpoint 
Wavelength Combination 

The default reductions for Endpoint readings are !Lm1, !Pathlength,1 and Custom for all instruments 
when you read at a single wavelength or if you choose “1-Ref” (for all instruments except the 
SpectraMax). The !Pathlength reduction reports the pathlength in each well. With all SpectraMax 
instruments, additional wavelength combinations become available depending on the number of 
wavelengths chosen. For any instrument, you can choose Custom and create different reduction 
formulas. The wavelength combinations available in the drop-down menu show the correct format of 
the formulas that produce these reductions. 
  

                                                           
1 The !Pathlength option is only applicable to Plate or CuvetteSet sections when using the SpectraMax 
190, 340PC, 340PC384, Plus, or Plus384; however, the wavelength reduction display is not instrument-
dependent in SoftMax Pro, so this choice is always shown, regardless of which instrument 
is connected or chosen in the Preferences. Choosing !Pathlength with any other instrument or for 
CuvetteSet sections in the SpectraMax Plus, or Plus384 will cause an error. The Plate section will not 
display a reduced number and, consequently, no values will be reported in the Group section table. 
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PathCheck 
Pathlength correction allows microplate data in Endpoint mode (for those instruments that support 
PathCheck) to be normalized to a 1-cm pathlength. When PathCheck is turned on in the Instrument 
Settings dialog box for the plate, “Apply PathCheck” appears in the associated Reduction dialog box. 

Kinetic 
Wavelength Combination 

The default wavelength combination for Kinetic readings is !Lm1 and is the only choice 
(besides Custom) for all instruments except the SpectraMax. For the SpectraMax, the choices depend 
on the number of wavelengths chosen (for example, if you will read at two wavelengths, choices 
default to !Lm1 and !Lm2, along with Custom). If you do not wish to use the default reduction, you 
can choose Custom and create a different reduction formula. 

Kinetic Limits 

The Limits settings for the display of Kinetic data are MaxOD, MinOD, Lag Time, and End Time. 

� NOTE: The display of OD values is shown relative to the first point measured for each well. Negative 
Kinetic values decrease with time, and limits should be set accordingly (below 0) to view negative Kinetic 
data. Limits define the data that will be viewed and included in data reduction, but do not affect data 
collection. If you alter a limit to show less data, you can always display the “hidden” data again by 
changing the limit. 

MaxOD 

The limit for the maximum value you wish to report. Any values from the reading that are above this 
limit will not be shown and will be excluded from data reduction. The default for MaxOD is 1.0. 

The MaxOD reduction parameter can be used to exclude the non-linear portion of the reaction from 
data analysis. This type of data reduction is most useful in reactions where the initial portion of the 
data is linear. You might also adjust the End Time setting to remove a non-linear portion after a 
certain time point in the reaction. Using MaxOD allows the use of the maximum number of linear 
points to calculate the slope of the line and, thus, to determine the rate for each well. 
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Above: Different Reductions of the Same Data Using Different MaxOD Points 

Both of the Well Graphs shown above display different reductions of the same data (these examples 
use optical density readings). In the figure on the top, the MaxOD is set to 2.0 for the display of wells 
B4, C6, and D8. In the figure on the bottom, the MaxOD has been reset to 0.5. Alternatively, you could 
leave the Maximum OD and decrease the number of Vmax Points used to determine the slope of the 
line. 

MinOD 

The limit for the minimum value you wish to report. Any values from the reading that are under this 
limit will not be shown and will be excluded from data reduction. The default is 0 OD. To display 
negative Kinetics, the value should be set below 0 (zero).  

Lag Time 

Specifies how many initial data points are excluded from the calculation of Vmax Rate. Lag Time 
truncates the data used in the calculation. It does not prevent data from being collected. The Kinetic 
plots will not display the data collected prior to the set Lag Time. The value for Lag Time can be 
changed after the plate is read. The default is 0. 
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In the figure on the top left, well C5 has a lag time: the data is not linear until approximately 80 
seconds after the start of data collection. Thus, the linear curve fit is not good and the slope of the line 
does not reflect the maximal rate. In the figure on the bottom right, a lag time of 80 seconds has been 
set and the linear curve fit for both wells is good, allowing the slope of the lines to reflect the maximal 
rate in each well. Alternatively, you could leave the Lag Time and decrease the number of Vmax 
Points used to determine the slope of the line. 

End Time 

This setting specifies the time at which you wish to stop showing data in the display. Any values 
occurring after this limit will not be reported in the display. The default setting is the total assay time. 
The value for end time may not be greater than the total assay time. 

Absolute Values 

This setting causes the plots shown in the data display to be drawn at their absolute OD as opposed 
to the default (with the box unchecked) which offsets the first point to the (0,0) coordinate. Enabling 
Absolute Values may cause some data points that do not fall within the default limits for the plots to 
“disappear” (see the figure below). 
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Above: Kinetic Reduction with Absolute Values Enabled. Note that the limits in this example (MinOD=0, 

MaxOD=0.5) do not allow all of the data to be visible. 

To see more data, yet still display absolute values, increase the limits for MinOD and/or MaxOD 
found in the Reduction dialog box. 

 
If you increase the MaxOD setting to be at least as large as the largest absorbance value expected, 
most or all of the data plots should appear in the data display. In the Kinetic Reduction example 
shown above, if the MaxOD value is increased from 0.5 to 2.0, the plots then appear as shown below. 
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Above: Kinetic Reduction with Absolute Values Enabled and MaxOD Value Increased 

Kinetic Reduction 
Kinetic reductions are applied to the list of numbers (the value at each timepoint) after the 
wavelength combination formula is applied. Vmax per min and Vmax per sec reductions are 
available for all instruments that are capable of Kinetics; the default Kinetic reduction is Vmax. Other 
reductions available from the pop-up menu are Time to Vmax, Onset Time, Time at Minimum, Time 
at Maximum, Time at ½ Maximum, Slope, Area Under Curve, or you can choose Custom and then 
create a different reduction formula. 

Vmax 

The maximum slope of the Kinetic display of optical density versus time. The default value displayed 
is in milli-optical density units per minute (mOD/min). The rate is calculated with the use of  Vmax 
Points (see below) which determines the number of contiguous points over which Vmax is calculated. 
The number of Vmax Points defaults to the maximum taken during the reading; you can change this 
number in the Reduction dialog box if desired. 

� NOTE: Vmax = Vmax/sec • 60,000 

A linear regression is performed to determine the slope of the line using the equation: 

y = m*X + B 

where m is the slope of the line. 

The reaction rate is reported in milliOD/min (color change in milliOD per minute of reaction time). 

Vmax Points 

This setting defines the maximum size of the line segment used to determine the slope of the line 
used in calculating the rate of the reaction. The default is the total number of points taken in the 
reading, with the data normalized to a starting point of 0,0 (as opposed to starting from the optical 
density of the first time point). The first slope is calculated for a line drawn beginning at the first 
reading as defined by Lag Time (described below) and ending at a total number of readings equal to 
the Vmax Points setting. The second and any subsequent slopes are calculated beginning at the 
second time point and ending at a total number of readings equal to Vmax Points. The steepest slope 
is reported as Vmax Rate. If the data plot displays fewer time points (data points) than the number of 
time points chosen for Vmax Points, then all of the time points will be used to determine the slope of 
the data. 
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Using Vmax Points (Example) 

 Well 1 Well 2 Well 3 

Time points visible in 
the well (data plot) 25 10 2 

Number of Points Used for Data Analysis: 

Vmax Points set to 25/25 
(default) 25 10 2 

Vmax Points set to 5/25 
Overlapping 
5-point line 
segments* 

Overlapping 
5-point line 
segments1 

2 

 

The progressive slope calculations are repeated until the last included data point is reached (as 
defined by the End Time or MaxOD — see below). The maximum positive or negative slope is 
reported as Vmax (mOD/min). Vmax Points can be set from 2 to the total number of points in the 
curve. The number of Vmax Points can be set before the plate is read and can be changed after the 
plate is read. The data display will update automatically each time. The Vmax Points setting does not 
affect data collection. 

� NOTE: The height of the Y axis in the raw data plots or plate display is controlled using MinOD and 
MaxOD. The default settings are: 
      MinOD = 0 
      MaxOD = 1.0 
The width of the X-axis in the raw data plots or plate display is controlled using Lag Time and End Time. 
If either the MaxOD or End Time setting excludes points such that a total number of readings equal to 
Vmax Points cannot be used, then the maximum included points will be used. 

Time to Vmax 

This is an alternative method for analyzing non-linear Kinetic reactions which reports the elapsed 
time until the maximum reaction rate is reached, rather than reporting the maximum rate itself. Used 
in conjunction with Vmax Points, Time to Vmax is the time to the midpoint of the line defined by 
Vmax Points and used to calculate Vmax. This elapsed time data is useful for applications including 
coagulation chemistry where the changing concentration of the reagents does not change Vmax, but 
rather will change the time at which the reaction reaches the maximum rate. 

                                                           
1 SoftMax Pro will perform a linear regression on as many overlapping 5-point line segments as possible in the 
analysis window. The slope will be determined for each line segment and then the steepest slope will be reported 
as the reaction rate. Thus, in well 2 of the example in the table above, the slope will be determined for line 
segments consisting of time points 1 to 5, 2 to 6, 3 to 7, 4 to 8, 5 to 9, and 6 to 10, and then the slope of the line 
segment with the steepest slope will be reported as the Vmax Rate. 
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Onset Time 

This is another method for analyzing non-linear Kinetic reactions. Onset Time reports the time 
required for a Kinetic reaction to change by a specified optical density (onset OD above the initial OD 
reading for the well). This elapsed time data is useful for cascade reactions including clot formation 
(endotoxin testing, for example) and clot lysis applications where the change in reagent concentration 
does not affect the maximum optical density change but changes the time required for the reaction to 
reach completion.  

Time at Minimum 

This setting reports the time at the minimum OD or %T that falls within the reduction limits. 

Time at Maximum 

This setting reports the time at the maximum OD or %T that falls within the reduction limits. 

Time at ½ Maximum 

This setting reports the time at the half of the maximum OD or %T that falls within the reduction 
limits. To calculate this reduction, SoftMax Pro first determines the Kinetic point (within the 
reduction limits) that has the maximum signal level (OD or %T). It then scans the Kinetic plot from 
left to right until it finds two points having signals that bracket half of that value. A linear 
interpolation between these two points is used to estimate the Time at ½ Maximum. 

Slope 

This setting determines the slope of the combined plot (i.e., the slope of the line using linear 
regression after the wavelength combination reduction). This setting uses all visible time points in the 
reduction window. Slope is the same as Vmax Rate when Vmax Rate is set to the same number of 
points as the run (i.e., the default). Slope is not the same as Vmax Rate if you have modified the Vmax 
Points. 

Area Under Curve 

This reduction estimates the area under the curve as defined by the data plots (within the reduction 
limits). The data plots are treated as a series of trapezoids with vertices at successive data points and 
at the X-axis coordinates of the data points. The areas defined by each of the trapezoids are then 
computed and summed. 

Spectrum 
Spectrum Limits 

The Limits settings for the display of Spectrum data are MaxOD, MinOD, Starting Wavelength in nm, 
and Ending Wavelength in nm. 

� NOTE: The display of values is shown relative to the first point measured for each well. Limits define the 
data that will be viewed and included in data reduction, but do not affect data collection. If you alter a limit 
to show less data, you can always display the “hidden” data again by changing the limit. 

MinOD 

The limit for the minimum value you wish to report. Any values from the reading that are under this 
limit will not be shown and will be excluded from data reduction. The default is 0 OD. 

MaxOD 

The limit for the maximum value you wish to report. Any values from the reading that are above this 
limit will not be shown and will be excluded from data reduction. The default is 1.0 OD. 
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Start (Wavelength) nm 

Specifies the limit for the minimum wavelength setting you wish to report. Any values from the 
reading that are under this limit will not be shown and will be excluded from data reduction. 

End (Wavelength) nm  

Specifies the limit for the maximum wavelength setting you wish to report. Any values from the 
reading that are above this limit will not be shown and will be excluded from data reduction. 

� NOTE: The settings for the Start and End wavelength settings cannot be below the lowest wavelength or 
above the highest wavelength entered in the Instrument Settings for the Spectrum reading. 

Spectrum Reduction 

The Spectrum reduction formula is applied to the list of numbers in each well (values at each 
wavelength) after the wavelength combination formula is applied. The default reduction for 
Spectrum readings is Lambda at Maximum. You can choose Lambda at Minimum, Maximum, 
Minimum, or Area Under Curve instead from the pop-up menu, or you can choose Custom and 
create a different reduction formula. 

Maximum 

Reports the maximum absorbance (optical density) or percent transmittance (%T) (within the 
reduction parameters of MinOD and MaxOD. 

Minimum 

Reports the minimum absorbance (optical density) or percent transmittance (%T) (within the 
reduction parameters of MinOD and MaxOD). 

Lambda at Maximum 

Reports the wavelength at which maximum absorbance (optical density) or percent transmittance 
(%T) (within the reduction parameters of MinOD and MaxOD). 

Lambda at Minimum 

Reports the wavelength of minimum absorbance (optical density) or percent transmittance (%T) 
(within the reduction parameters of MinOD and MaxOD). 

Area Under Curve 

This reduction estimates the area under the curve as defined by the data plots (within the reduction 
limits). The data plots are treated as a series of trapezoids with vertices at successive data points and 
at the X-axis coordinates of the data points. The areas defined by each of the trapezoids are then 
computed and summed. 

Data Mode (%Transmittance/Absorbance) 

For all read modes, you can choose whether to view data as %Transmittance or Absorbance (OD). As 
with all reduction or display options, these choices do not affect the raw data acquired from the 
instrument but rather only how it is shown in SoftMax Pro. If %T is chosen, all values including raw 
data are displayed in %T. 

� CAUTION: When the data mode is switched from %T to Absorbance or vice versa, SoftMax Pro 
recalculates all of the values based upon the new data mode. Separate mathematical calculations 
are used for handling OD and %T calculations for Pre-read plate blanking, and PathCheck 
because OD calculations are performed on a linear scale, whereas %T calculations are performed 
on a logarithmic scale. However, other calculations are not calculated differently by SoftMax Pro 
for absorbance and %T modes. Therefore, switching from %T to Absorbance or vice versa is not 
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recommended. Additionally, Molecular Devices recommends that %T be used only for raw OD, 
raw OD with Pre-read plate blank subtraction, or PathCheck-corrected raw OD readings. Use 
caution when using %T on reduced numbers or any readings that apply other calculations since 
the data may not accurately reflect proper calculations 

� NOTE: If you switch from one mode to the other, note that settings for the two modes are not “linked”—
settings chosen for one mode are not reflected if you switch to the other mode. For example, if data from 
a Spectrum scan is displayed with a MinOD of 0 and a MaxOD of 1 (absorbance), and you then switch to 
%Transmittance and change the limits to 0 and 50%, respectively, switching back to absorbance will not 
change the limits set previously (the Min- and MaxOD limits will still be 0 and 1). 

Custom Reduction Formulas 
If the predefined reduction formulas do not meet your needs, you can create one or more different 
reduction formulas for any or all read modes (Endpoint, Kinetic, or Spectrum). Choosing “Custom” 
from any of the menus or dialog boxes causes a Formula button to appear (an example of this button 
in an Endpoint Reduction dialog box is shown in the figure below). Custom reduction formulas may 
contain other operators and terms in addition to wavelengths. 

 
Above: “Custom” Selected Showing Formula Button (Endpoint) 

Clicking the Formula button opens the Calculation dialog box in which you can name and define a 
new reduction formula. 

 
Above: Wavelength Calculation Dialog Box (Endpoint) 

Examples of some formulas that might be used when combining multiple wavelengths in the 
Calculation dialog box are given in the table below. 
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Wavelength Reduction Formula Examples 

2 λ 3 λ 4 λ to 6 λ 

!Lm1 + !Lm2 !Lm1 + !Lm2 + !Lm3 !Lm1 + !Lm2 + … + !Lmn 

!Lm1 - !Lm2 
(!Lm1 - !Lm3) / (!Lm2 - 
!Lm3) 

(!Lm1 - !Lm6) /(!Lm2 - !Lm5) / 
(!Lm3 - !Lm4) 

!Lm1 / !Lm2 !Lm1 / !Lm3 !Lm1 / !Lmn 

!Lm1 * !Lm2 !Lm1 * !Lm3 !Lm1 * !Lmn 

Log10(!Lm1/!Lm2) Log10(!Lm1/!Lm3) Log10(!Lm1/!Lmn) 

!Pathlength !Pathlength !Pathlength 

!Lmx/constant 
For example, Lm1/1.44 for quantitating a polyclonal 
antibody by measuring the absorbance at A280 with 
PathCheck on. 

Average(!allvalues) 
This formula will average together the optical densities 
for multiple readings at the same wavelength (for 
example, if you read the well six times at 280 nm). 

Min(!allvalues) 
This formula will report the minimum OD recorded for 
multiple wavelength readings in each well. 

Max(!allvalues) 
This formula will report the maximum OD recorded for 
multiple wavelength readings in each well. 

If(!Lmz<A,makeerr(118), 
(if(!Lmx>B,makeerr(117),!Lm1))) 

This formula will report “low” for any well with an OD 
less than A, “high” for any OD greater than B, and the 
OD of any well that lies between A and B. 

 
Custom reduction formulas utilizing mathematical operators or terms can be used to obtain specific 
types of data. The table below provides some examples of such formulas for Kinetic and Spectrum 
readings. 
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Kinetic and Spectrum Reduction Formula Examples 

Kinetic 

Vmaxcorr(!combinedplot, 
!vmaxpoints,!readinterval) 

Reports Vmax correlation coefficient for plots in all 96 
wells. 

Vmax(Delta(!combinedplot), 
!vmaxpoints,!readinterval) 

Will report the Vmax Rate of the delta between each 
time point. 

Spectrum or Kinetic 

Nthitem(!Lm1,X) 

Will report the optical density at item X in the list of 
readings. For example, if you have a Kinetic run with 
20 time points and X is 10, it will report the OD of the 
10th time point. Similarly, if you have a Spectrum scan 
with 20 measurements and X is 10, it will report the 
OD of the 10th wavelength measured. 

For a full discussion of custom formulas, see the Formula Reference Guide. 

When you finish your entry in the Calculation dialog box and click [OK], the formula you have 
entered then appears to the right of the word “Custom” and becomes the default selection for the 
Custom option. You may subsequently edit this formula or enter a new one by clicking the Formula 
button again. 

Recalculation Options 
By default, SoftMax Pro performs continuous recalculation of the data when you read plates, create 
or change formulas, and so on. At certain times, it would be useful to disable the recalculation feature 
so that you can make alterations to the experiment without waiting for individual recalculations to be 
completed. Two commands are available in the Edit menu that allow you to modify the way in which 
SoftMax Pro performs recalculation: Suspend Recalculation and Recalculate Now (  =; [CTRL]+[=]). 

Choosing Suspend Recalculation disables the automatic recalculation feature of the program and 
places a checkmark to the left of the command in the menu to indicate that it has been selected. While 
this function is enabled, no recalculation will occur, regardless of what you may change, add, or 
delete from the experiment. This is especially useful when creating or changing column formulas 
within Group sections, for example, as it can speed up the process greatly. 

When recalculation has been suspended, you may wish to see the results of the changes you have 
made but may still not wish to enable continuous recalculation. Choosing Recalculate Now (  =; 
[CTRL]+[=]) from the Edit menu will cause SoftMax Pro to examine all elements of the experiment 
and perform complete recalculation of the data. Choosing this command does not enable continuous 
recalculation but simply causes the program to perform recalculation once. 

To return to continuous recalculation, choose Suspend Recalculation again. The checkmark next to 
the command will disappear, indicating that the function is no longer in use. 

� NOTE: Recalculate Now (  =; [CTRL]+[=]) can be used to see intermediate results during long Kinetic 
readings. At any time, you can choose Suspend Recalculation to delay calculations until a later time. 
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Displaying Data in Group, Graph, and Notes Sections 
Group Sections 

The manner in which data is displayed in a Group section depends on the type of reading that was 
performed (Endpoint, Kinetic, Spectrum, or Well Scan), but can be customized by choices made in the 
data display, reduction settings, and the Edit menu. 

Default displays for Group sections are shown automatically unless you choose a different display 
option. 

The particular font to be used in a Group section table, as well as its size and style, can be changed by 
first selecting one or more columns in the Group section table and then choosing the Text command 
from the Edit menu and making the desired choices from the dialog box that appears. 

Settings from the Plate Section Affect Data Display in Group Section Tables 

Reduction options in the Plate section allow you to display the raw data received from the instrument 
in a reduced (analyzed) form. Which reduction options are available depend on the read mode used 
and reduction settings chosen. Reduced numbers from the read section are displayed in the Values 
column of the Group section tables by default. 

Reduction settings do not affect the raw data but simply cause it to be displayed differently. You can 
change reduction settings without affecting the raw data from the reading in any way. 

Custom reduction formulas require the use of accessors and operators that are understood by 
SoftMax Pro. For a list of these accessors and operators see the Formula Reference Guide. 

Resizing and Hiding Columns 
The columns in a Group section can be resized in several ways. One of the simplest methods is to 
drag the line dividing the columns to another position (moving it horizontally). When you point to a 
line between columns, the cursor changes to a double arrow with a vertical line through it, showing 
that it is ready to move left or right 
. 

 
Above: Cursor Positioned on a Line between Columns 

Reducing Column Size and Hiding Columns 

You can reduce a column to a size smaller than the width of its title, in which case the title will not be 
completely visible. You can also hide a column by reducing its size completely (drag one edge of the 
column on top of the other) or by selecting that column and choosing Hide from the Group menu. 
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� NOTE: If you hide a column in this way and then wish to view it again, use the Show All command in the 
Group menu. All columns that were hidden will again be visible. There is no way to show only one 
hidden column. 

Enlarging Column Size 

You can enlarge the width of columns to any size. Increasing the size of columns may make the width 
of the Group section increase beyond the page width boundary. If this occurs, the columns will 
“disappear” off the edge of the screen but are really still there. To bring these columns back into 
view, reduce the width of the columns that are still visible until the others reappear. 

 

� NOTE: If the width of a section extends beyond the page width boundary, the portion that is not visible 
will not be printed. 

To size two or more columns to the same width, highlight those columns and then drag one of the 
dividing lines to the desired width. The width of all highlighted columns will be sized the same as 
the column to the left of the dividing line you are moving. 

Columns can also be resized to the minimum amount of space required by choosing Autosize from 
the Group menu. By highlighting the entire table or individual columns and then choosing Autosize, 
the amount of space each column requires will be reduced to the minimum size required by the 
largest piece of text in that column. 

Double-clicking the line dividing two columns causes the single column to the left of the divider to be 
sized according to the largest amount of text in that column. 

Showing and Editing Existing Column Formulas 
When group sections are first created, the formulas used to calculate the data are not displayed. 

These formulas can be shown (until you choose to hide them again) by making a Group section active 
and then choosing Show Formulas from the Group menu. (Note that the command in the menu 
changes to Hide Formulas after they are shown.) 
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Choosing this option causes an additional row to appear (beneath the heading for each column) 
which shows the formula used to calculate the data in each column. To see formulas briefly, hold 
down the Shift and [CTRL] keys. 

 
Modifying Column Formulas 

To modify the formula for an existing column, double-click the column or click the column once and 
then click the formula button in the section tool bar. The dialog box associated with the column 
formula will open, allowing you to edit the formula (and the name) associated with the column. 
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For a complete discussion, see the Formula Reference Guide. 

Adding Columns 
You can add a new column to a Group section by clicking the Create Column button in the Group 
Tool Bar or by choosing Create Column from the Group menu which will open the Column Formula 
dialog box. 

 
In the Column Formula dialog box, you can change the name of the new column (from the default 
which simply lists the column by number) to reflect the data that it will contain. 

If no existing column is selected when you click the Create Column button, the new column will be 
created to the right of all existing ones. If you select (highlight) a column and then add a new column, 
it will be positioned to the right of the one you selected. If the table is currently as wide as the sheet of 
paper specified in Page Setup when a new column is added, the columns will “disappear” off the 
right side of the window but are still there. To bring these columns back into view, resize visible 
columns smaller. 

New columns can contain references to other columns, both in the current section or in a different 
one within the same experiment. For example, if you wanted to subtract the mean values in one 
group from those in another, you could create a new column (in either group) to do this. If the two 
groups were named “Group 1” and “Group 2,” for example, and both groups contained a column 
entitled “Mean,” you could create a column within “Group 1” that would subtract the mean values in 
“Group 2” from those in “Group 1.” The column formula needed to do this would be: 
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Mean-Mean@Group2 

Numerous possibilities exist for creating and editing column formulas to display the data you desire. 
For a complete discussion of formulas and operators, see the accompanying Formula Reference Guide. 

� NOTE: To delete a column, highlight it and press the [Delete] key or choose Cut from the Edit menu. 

Adding or Editing a Summary in a Group Section 
To add a summary at the bottom of a Group section, click the Create Summary button in the tool bar 
or choose Create Summary from the Group menu. The Calculation dialog box will appear, allowing 
you to change the name of the summary or hide the name, if desired, as well as to enter a description 
of the summary and to create a formula for it (including the number of decimal places for the result, 
if appropriate). Double-clicking an existing summary causes the same dialog box to appear, allowing 
you to modify summary information. 

 
Information entered in this dialog box will be placed at the bottom of the Group section as follows: 

Name = Description     Formula Result 

You can click the checkbox next to Hide Name, which will change the way the summary appears to 
show: 

Description     Formula Result 
  

� NOTE: The name assigned to a summary is important since you can reference the summary by name in 
other formulas (building one upon another). The summary name can be referenced even if it is hidden. 

If you wish to see the formulas associated with summaries without opening the Calculation dialog 
box for each one, you can choose Show Formulas from the Group menu. To see these formulas only 
briefly, hold down the shift and [CTRL] keys while that Group section is active. The summaries will 
“expand” to show the complete formula along with the title. They will resume their previous 
appearance when you release the [Option] key. 

Summaries in Group sections can be moved horizontally, if desired, by dragging them left or right. 
When you position the pointer over a Group summary, the cursor changes to show a double-headed 
horizontal arrow. Clicking once highlights the summary; dragging and then releasing the summary 
leaves it in the position where the mouse button was released. 

To have summaries line up with particular columns in the Group, hold down the [CTRL] key while 
dragging the summary. When you release the control [CTRL] key, the summary will “snap back” so 
that it begins flush to the left side of the column under which it was released. Each summary can be 
positioned in a different place in the Group section, if desired. 

� NOTE: To delete a summary, highlight it and press the [Delete] key or choose Cut from the Edit menu. A 
summary can also be copied or cut and then pasted in a different location. 
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You can also change the format of the text in Group section columns and/or summaries. By selecting 
the column or summary and then choosing Edit and then Text Style ([CTRL]+[T]), you can change the 
font, size, and/or style of the text. 

Notes Sections 
The Notes section allows you to enter text describing the experiment and one or more summary lines 
that contain formulas. To create a summary, click the Create Summary button in the tool bar or 
choose Create Summary... from the Notes menu. 

The Calculation dialog box that appears allows you to enter a description of the summary, accept the 
default title for the summary, change it or hide it, and enter a formula (including the number of 
decimal places the reduction should show, if appropriate). For detailed information regarding 
operators and accessors, see the Formula Reference Guide. 

If you wish to see the formulas associated with the summaries without calling up the Calculation 
dialog box for each one, you can choose Show Formulas from the Notes menu. To see these formulas 
only briefly, hold down the shift and [CTRL] keys while that Notes section is active. The summaries 
will “expand” to show the complete formula along with the other summary information. They will 
resume their previous appearance when you release the [Option] key. 

Graph Section 
The Plot#X Dialog Box 

Whenever you create a new Graph section or add a plot to an existing graph, the Plot#X dialog box 
opens automatically (“X” starts with “1” and increments each time a new plot is added to a Graph 
section). In this dialog box, you can rename the plot, assign specific information to be plotted on the 
X- and Y- axes, and choose which icon and color will be used. If you rename the plot, the title of the 
dialog box will change to show the new plot name. 

All groups that have been created or assigned within the file are listed on the left side of the “Source:” 
field in the Plot#X dialog box. The first group in the file is automatically selected. Other groups can be 
selected by highlighting them. When a group is selected, the pull-down menus in the X-axis and Y-
axis subfields change to show the group columns that are available for graphing. Group columns can 
be assigned for both the values to be plotted and any error bars to be included for both axes. 

Summaries and user-defined formulas can also be graphed. Pushing the  button for either the X-
axis or Y-axis opens a dialog box which allows you to enter formulas. To plot a summary, enter the 
summary name in this dialog box. Formulas can be plotted for comparison with other data. For 
example, if the data is assumed to follow a specific model, the model formula can be entered as a plot 
and then the data can be chosen for another plot within the same graph. You can also use this feature 
to plot Kinetic or Spectrum data in Graph sections. For example, to plot Kinetic data from well A1 in 
a Graph section, you can enter the formula !A1Lm1 for the Y-Axis and the !TimeRun accessor for the 
X-axis. The entered formulas are also shown in the “Source:” field of this dialog box. 

The size, color, and style of the icon used for a plot can be selected on the right side of this dialog box. 
Four sizes, nine colors, and nine styles are available from drop-down menus. 
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The Graph Options Dialog Box 

The Graph Options dialog box allows you to change the name of the Graph section, change the height 
of a graph, select the type of graph to be displayed, change the fonts used on the title, legend, and 
axes, access the Plot#X dialog box for editing plots, entering new plots, and/or to delete plots. This 
dialog box is opened after pressing [OK] in the Plot#X dialog box when a new Graph section is being 

created. This dialog can also be accessed by pressing the Graph Options button  on the Graph 
section toolbar or by choosing Graph Options from the Graph menu. 

Scatter plots, cluster bar charts and stack bar charts can be created. Error bars can be used with all 
graph types. You can also choose whether to connect the points and/or plot the symbols in the graph. 

Each of the plots that have been created for this Graph section are listed in the “Plots:” field of this 
dialog box. Choosing any of these plots provides an indication of the data to be used for the X- and Y- 
axis data points and error bars on the right side of this field. Plots can be deleted by highlighting the 
plot name and clicking the [Delete] button. Clicking the [New] button opens the Plot#X dialog box, 
allowing you to create a new plot for the graph. Existing plots can be edited by highlighting the plot 
name and clicking the [Edit] button which opens the Plot#X dialog box containing all the information 
for the selected plot. 

When creating a new Graph section, the Graph Options dialog box opens after choosing either [OK] 
or [Cancel] in the Plot#X dialog. The new Graph section is not created, however, until you click [OK] 
in the Graph Options dialog box. 

 
Creating Multiple Plots 

SoftMax Pro makes it possible to create multiple plots within a graph. Each plot will represent data 
from a group that has been created in the Template Editor or data from a summary or custom 
formula. You may plot data from any group or from several groups on a graph, even if the groups are 
in separate experiments. It is possible, for example, to plot multiple dilution series of an unknown, to 
graph together a series of patient samples, or to plot several controls that have been run over time. 

Following is a summary of the steps required to create multiple plots within a single graph, after 
which is an example that provides more detail. 
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Multiple Plots Step Summary 

 Create all required groups in the Template Editor. 

 Read the microplate to obtain data. 

 Create a graph section. 

 Add plots to the graph and choose the group and the X and Y values to be shown for each plot. 

Example of Creating Multiple Plots 

This example shows how three groups, all of which are Standards, were plotted on the same graph.  

1. Groups are created in the Template Editor. For this example, four groups are created: three for 
standards (Standard1, Standard2, and Standard3) and one for Unknowns (Unknown1). 

 
Standards and Unknowns Groups Created 

2. The associated Group sections are created using the Standards column format which, by default, 
generates columns for concentration and optical density values. The example below shows the 
Group section for Standard2. 

 
Standard2 Group Section 
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3. A new Graph section is created by selecting New Graph from the Experiment menu. This causes 
the Plots dialog box to open automatically. The default name for the first plot, “Plot#1,” is then 
changed (by typing a new name over it) to “Standard#1.” Clicking [OK] opens the Graph 
Options dialog box which allows you to choose the graph type, modify the fonts used for the 
graph, and so on. Choices should be made as follows: Standard1 for the group to be plotted, the 
concentration of Standard1 for the X-axis, and values of Standard1 for the Y-axis. No error bars 
are added. 

 
Graph Options Dialog Box with Plot Name Changed to “Standard#1” 

4. A second plot is added to this graph by clicking the [New] button in the Graph Options dialog 
box. After clicking [New], a dialog labeled Plot #2 is opened. The second plot name defaults to 
“Plot#1,” which now shows beneath the first plot. Change this second plot name to 
“Standard#2,” choose Standard2 for the group, and change the X- and Y-axes to show 
concentration and values, respectively, for Standard2. 

 
Graph Options Dialog Box with Second Plot Added for Standard#2 

5. This process is repeated for a third plot, labeled “Standard#3.” 
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6. Now that all plots information is complete, clicking [OK] in the Graph Option dialog box will 
close it, and the resulting graph will show the three plots created. 

 
Graph Displaying Three Standards Plots 

You can add as many plots to a graph as you wish, and these can be of the same or different types of 
groups. If you create a graph and later wish to add one or more plots to it, simply click the [Graph 
Options] button on the Graph section Tool Bar and then click the [New] button. This will reopen the 
Plots dialog box, allowing you to add or modify the plot information. 

Error Bars 

When data is displayed as a scatter or bar graph, you can choose to display error bars for the plot of 
the data for the X- and/or Y-axis. Error bars are lines that extend beyond a plotted value in either or 
both directions and graphically represent some amount of error in plotted data. 

  
Plot Showing Error Bars 
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Choices for displaying error bars relative to a particular axis are the same as those available for 
displaying data on that axis: any column from that group that contains numerical information (not 
columns with text). To display error bars, click and hold the box next to “Error Bars” in the Plot#X 
dialog and drag to select one of the choices in the menu. To disable error bars, choose “No Error” for 
the X- and/or Y-axis. 

Error bars show both positive and negative error. Depending on the range settings for the graph, 
portions of the error bars may not be visible. 

Curve Fitting 

When you first create a graph of the data, it does not have a fit associated with it. The graph might 
appear something like this: 

 
Graph with No Fit 

You can fit any plot to one of nine curve-fitting algorithms: Linear, Semi-Log, Log-Log, Quadratic,  
4-Parameter (logistic), Log-Logit, Point-to-Point, Exponential, and Cubic Spline. These selections are 
shown in the Fits pop-up menu in the Graph section toolbar (click on the box next to “Fit”). 

Typically, a standard curve refers to the curve fitted to the plot of concentration versus mean value 
for the Standard group. 

Once you have selected a Fit type, SoftMax Pro determines the parameter values that best fit the data. 
The function with these parameters is then drawn on the graph. Ideally, the type of fit used should be 
determined by the underlying chemistry of the assay and could be set before data is read. 

NOTES: A good discussion of curve fitting appears in “Data Analysis and Quality Control of Assays: 
A Practical Primer” by R. P. Channing Rogers in Practical Immuno Assay, edited by Wilfrid R. Butt 
(published by Marcel Dekker, Inc., New York, 1984). 

When a fit is chosen, the Graph section is updated to show the coefficients describing the fit when 
applicable. These values are displayed in the legend at the bottom of the graph. Figures below show 
the same graph with the different fit algorithms applied. Note that the legend information changes 
(along with the formula for the fit) at the bottom of each Graph section for each different fit. 

� NOTE: All plots on a graph must have the same type of fit. 

When a curve fit is chosen, the values for the coefficients of the equation (A, B, C, etc.) will be shown 
as will the square of the correlation coefficient (R^2). The correlation coefficient describes how well a 
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change in x values correlates with a change in the y values. The R^2 value should only be used for 
curve fits having linear axes. 

Linear 

The linear function fits the best straight line to the data. The equation for this fit has the form of: 

Y = A + (B * X) 

where A is the y-intercept of the line and B is the slope. A linear fit should be used whenever the 
values appear to lie on or scattered around a straight line. 

This equation is shown on the screen as: 

y = A + Bx 

A linear fit should be used whenever the standard values appear to lie on or are scattered around a 
straight line. The figure below shows an example of a linear fit. 

 
Graph with Linear Fit 

Semi-Log 

The semi-log function fits the best straight line to a set of data for log(X) plotted against Y. The 
resulting curve displayed will be a straight line with the X-axis drawn in logarithmic scale. The 
equation for a semi-log fit is: 

Y = A + [B * log10(X)] 

and is shown on the screen as: 

y = A + B * log(x) 

where A is the y-intercept of the line and B is the slope (note: log in this equation is the common or 
base-10 logarithm). 
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Graph with Semi-Log Fit 

Log-Log 

The log-log function fits the best straight line to the set of data which consists of the logarithm of the 
readings on the Y-axis (the response) and the logarithm of the dose on the X-axis. The resulting 
display will be a straight line with both axes drawn in logarithmic scale. The equation for the log-log 
fit is: 

log10(Y) = A + [B * log10(X)] 

and is shown on the screen as: 

log(y) = A + B * log(x) 

where A is the log10Y-intercept of the line for log10(X) = 0 and B is the slope (note: log in this 
equation is the common or base-10 logarithm). 
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Graph with Log-Log Fit 

Quadratic 

The quadratic function fits the best parabola to the data. The parabola is a curved line based on the 
equation: 

y = A + (B * x) + (C * x2) 

which is shown on the screen as: 

y = A + B*x + C*x^2 

where A is the intercept, B is the slope of the curve at the intercept, and C is the measure of the 
curvature of the parabola. 

The quadratic fit is most appropriate when the standard curve has a tendency to curve up or down. 
An example of a quadratic fit is shown below. 

 
Graph with Quadratic Fit 
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4-Parameter Logistic and Log-Logit 

If the standard curve has a sigmoidal shape when plotted on the semi-log axes, it may be appropriate 
to use either the log-logit or 4-parameter fit. Both fits are based on the equation 

 
where D is the Y-value corresponding to the asymptote (i.e., the flat part of the curve) at high values 
of the X-axis and A is the Y-value corresponding to the asymptote at low values of the X-axis. The 
coefficient C is the X-value corresponding to the midpoint between A and D. The coefficient B 
describes how rapidly the curve makes its transition from the asymptotes in the center of the curve. A 
large value of B describes a sharper transition. Typically, B has a magnitude of about 1. 

Both the log-logit and 4-parameter equations are shown on the screen as: 

y = (A - D) / (1 + (x / C) ^ B) + D 

 
Graph with 4-Parameter Fit 
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Graph with Log-Logit Fit 

Some publications show the log-logit equation in another form: 

 
where 

 
A different algebraic expression of these is: 

 
The difference between the log-logit fit and the 4-parameter fit are in the way the coefficients A and D 
are calculated. For the log-logit method, the standard values for the lowest and highest values of x are 
used. The corresponding y values are assigned to A and D, respectively. Based on these fixed values 
for A and D, the algorithm then computes values for B and C. This technique works well if there are 
standard points along the upper and lower asymptotes. If this is not true, the log-logit fit should be 
avoided in favor of the 4-parameter logistic. 

� NOTE: The curve-fitting algorithm for the 4-parameter equation was based on the Levenberg-Marquardt 
Method. Discussion of this method can be found in Numerical Recipes in C: The Art of Scientific Computing 
by William H. Press, Brian P. Flannery, Saul A Teukolski, and William T. Vetterling, published by 
Cambridge University Press, New York, 1988. 

Point-to-Point 

A linear equation is fit to each pair of data points. Fit parameters are not given. The point-to-point 
curve fit is a linear fit composed of pieces that assume a linear relationship between each pair of data 
points. The line segment defined by each pair is used to interpolate data between those points. Since 
there are multiple line segments, fit parameters are not shown on the graph. 
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Graph with Point-to-Point Fit 

Cubic Spline 

This curve fit generates a fit to a cubic equation between each pair of data points. The general form of 
a cubic equation is: 

y = A + Bx + Cx2 + Dx3 

The equations are computed with the requirement that the first and second derivatives of the 
equations are continuous throughout the range of the data. As multiple curve fits are performed with 
this routine, fit parameters are not shown with the graph. 

 
Graph with Cubic Spline Fit 

Exponential 

The exponential function used to generate this curve fit is: 

y = A + B * (1 - exp^(-x / C)) 
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Graph with Exponential Fit 

� NOTE: SoftMax Pro does not plot samples with descriptor values of zero (0) on a log axis. Curve fits 
affected by this are the semi-log, log-log, log-logit, and 4-parameter curve fits. 

Minimum Number of Standards 

The number of standards used in a standard curve depends on the particular curve fit selected and 
on the judgment of the operator. The table below gives the minimum number of standards required 
mathematically by each of the curve fitting algorithms. 

Minimum Number of Standards Required for Curve Fits 

Curve Minimum Number of Standards 

Linear 2 

Quadratic 3 

Semi-Log 2 

Log-Log 2 

Log-Logit 4 

4-Parameter 4 

Point-to-Point 2 

Exponential 3 

Cubic Spline 4 
For optimal results, you should always exceed the minimum number of standards required for any 
given fit. 

There are other requirements on the standards for the log-logit and 4-parameter logistic curves. The 
fits for the 4-parameter logistic curve are based on the assumption that the curve has a high and a low 
asymptote and a certain “steepness” for the linear portion around the inflection point between the 
asymptotes. If a sufficient number of points do not define the inflection point and the asymptotes, 
you will receive a “no fit” error message or an inappropriate fit. For best results, make sure that the 4-
parameter fit is appropriate for your assay and that the entire range of the assay is represented in 
your standards. 
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If your standards do not clearly define both a high and low asymptote, the spline fit may be more 
appropriate for your assay. 

Judging a Good Curve Fit 

The correlation coefficient is also known as the goodness of fit value because it shows how good a fit 
exists between the computer curve and the standard data points. It measures the degree to which the 
points fall on the computer curve and may give an indication as to what residuals are to be expected. 
The correlation coefficient is popularly known as R and is between -1 and 1, inclusive. When the data 
points lie on a perfectly straight line with negative slope, then R = -1. If the correlation coefficient is 
not suitably close to 1 or -1 (a perfect fit), you can simply apply one of the other types of curves 
without having to reread the plate.  

For nonlinear curve fits, SoftMax Pro performs transformations that cause the curve to become more 
linear. The correlation coefficients are derived from that transformed data. Because of this, you 
should be cautious about using correlation coefficients as an indicator of goodness of fit. Do not let 
this single value for goodness of fit sway your intuition about which fit is best. Some curve fits may 
seemingly give a good fit (e.g., fit values close to 1) but, when inspected by eye, show a poor fit along 
a major portion of the plot. 

Graph Options    

Graphs can be customized further through the Graph Options dialog box which is accessed by 

choosing Graph Type... from the Graph menu or by clicking the Graph button ( ) in the section 
tool bar. 

 
Graph Options Dialog Box 

The default options are shown above, but you can alter these as desired: you may change the font and 
type size used for the title, legend, and/or axes of the graph, and you can choose the color and type of 
symbol used on a scatter graph to show the plot. The graphs shown in preceding Figures reflect the 
default graph options. Connecting the points of a scatter graph can be useful in determining the 
closeness of the fit. The figure below shows a scatter graph with points connected compared to a 
linear fit. 
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� NOTE: The Connect Points option connects the points in order of appearance by sample name—not the 
appearance of points from left to right on the graph. 

 
Scatter Graph with Points Connected (Linear Fit Applied) 

Other options in this dialog box allow you to plot the data as a bar graph with data shown in clusters 
or stacked. The figure below shows both of these bar graph options. 

 
Bar Graphs—Cluster and Stack 

� NOTE: Bar graph options for multiple plot graphs are only available when each plot contains the same 
number of data points and has matching X-axis coordinates. 

� NOTE: When choosing the Connect Points option, the order in which points are connected is sample 
name dependent. 
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Axes Options    

Double-clicking either graph axis, clicking the X-axis or Y-axis button in the Graph section toolbar, or 
selecting either X-axis... or Y-axis... from the Graph menu opens a dialog box concerning the 
configuration of that axis. The figure below shows the dialog box for the X-axis. 

 
X-Axis Dialog Box 

The default settings are shown in the Figure above. You can change these as desired for either or both 
axes. 

Axis Settings 

Enabling the Auto-range option causes the graph to be drawn such that all data points are shown (by 
automatically adjusting the minimum and maximum range settings to encompass the data). You can 
disable the Auto-range function by clicking the checkbox or by changing either or both values for the 
Min and/or Max settings. 



  

  

Displaying and Analyzing Data: SpectraMax M2 and M5 

Introduction 
Initial display and reduction of the data received from the reader is performed in the Plate section or 
CuvetteSet section in which the data has been collected. Display and reduction parameters can be set 
up either prior to or after collecting data. The display and reduction parameters may be modified at 
any time. 

Data analysis and the display of analyzed data is also performed in the Group sections (created when 
wells or cuvettes are assigned to groups in the Template Editor) and the Graph section(s). 

Notes sections may be used in conjunction with any other section to provide text commentary and/or 
a display of data through the use of summaries. Notes sections are used most commonly to provide 
an introduction to or summary of results for a data file. 

All data files have a minimum of one Plate section or one CuvetteSet section with data in it. Multiple 
Plate sections and/or CuvetteSet sections may be present. Most files will have a template and Group, 
Graph, and Notes sections. However, depending upon the assay and how you wish to report the 
data, only some of these sections may be (or need to be) present in every file. Some simple assays, 
such as reading the absorbance of proteins at 280 nm in a cuvette (or in a microplate with PathCheck), 
allow you to calculate concentration in the Plate or CuvetteSet sections. In such an example, Group 
and Graph sections are necessary only if you wish to display the data graphically. 

Many common assays consist of data acquired in a Plate section or CuvetteSet section. Standards and 
unknowns are defined in a template. Unknowns are then interpolated from a standard curve. The 
following diagram shows the relationship between the different sections in SoftMax Pro: 

 

Initial Data Display and Reduction: Plate/CuvetteSet Section 
The manner in which data is displayed in a Plate section or CuvetteSet section depends on the type of 
reading that was performed (Endpoint, Kinetic, Spectrum, or Well Scan), but can be customized by 
choices made in the data display and reduction settings. Depending on the type of reading 
performed, display options include: 

 Number or plot displays for raw OD, RFU/RLU, or %T (with or without reduced number). 

� NOTE: The number format (use of commas or periods in numeric notation) chosen for the computer 
operating system is reflected in the way that SoftMax Pro displays data. 
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 Number, Plot, Threshold, Ranged, or Grayscale (with or without reduced number) 

 Display as one or three samples per row or display as microplate layout (CuvetteSet section 
only) 

 If you have chosen 384-well plates from the Instrument Settings, you can display the wells in 
different ways: Normal, Vertical, Rotated, Large, or Interleaved. 

 For Well Scan data only: gray scale plot of the well scan for raw data; reduced data can be 
shown as a number, threshold, ranged, gray scale, or as a plot. 

Default displays are shown automatically unless you choose a different display option. 

Reduction options allow you to display the raw data received from the instrument in a reduced 
(analyzed) form. Which reduction options are available depend on the read mode, instrument, and 
read type used; custom settings, using formulas you create, are available for all read modes, 
instruments, and read types. 

Reduction settings do not affect the raw data but simply cause it to be displayed differently, allowing 
you to change reduction settings without affecting the raw data from the plate or cuvette reading in 
any way. 

Custom reduction formulas require the use of accessors and operators that are understood by 
SoftMax Pro. A list of such accessors and operators can be found in The Formula Reference Guide. 

The Data Display 
After a plate or cuvette has been read, the information sent from the instrument is shown in the data 
display in the active Plate or CuvetteSet section. The default display for data from Endpoint readings 
is raw OD or RFU/RLU numeric values. Data from Kinetic or Spectrum readings is displayed in plots 
format (raw OD or RFU/RLU values with respect to time or wavelength). While a Kinetic or 
Spectrum reading is in progress, the display updates dynamically to show the data collected so far. If 
the instrument is reading more than one wavelength in Kinetic mode, plots for the different 
wavelengths are overlaid in each well. 

All choices except those defined in the Instrument Settings affect only the manner in which the data is 
displayed—the raw data is not changed—permitting you to optimize the display after data is 
collected. 

� NOTE: Data reduction changes the way in which data is displayed and also affects the values used in 
calculations within SoftMax Pro. While the raw values remain unchanged, calculations will use reduced 
values, if any, and are, therefore, affected by settings chosen in the Reduction dialog box.  

� NOTE: With the SpectraMax M2 or M5, data comes from the instrument to SoftMax Pro with four digits 
to the right of the decimal point (instead of three digits for all other instruments). Only three of the four 
digits are displayed in the Plate section or CuvetteSet section for Endpoint data, however: the fourth digit 
is rounded up or down (0.0045 rounds up to 0.005; 0.0044 rounds down to 0.004, for example). You can 
view all four digits of data, if desired, by displaying the raw OD or RFU/RLU in a Group section table 
and increasing the number of decimal places showing. 
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The Display Dialog Box 

Before or after a reading, you can click the [Display] button to open the Display dialog box 
which allows you to change the way the data is presented. Choices available in this dialog box 
depend on whether a section is currently active, which instrument is chosen in the Preferences or is 
connected to the computer, and which read mode you have chosen (for example, the choice for 
“Plots” is not shown if Endpoint mode is selected). The figures below show the default Display 
dialog boxes for the different read modes. 

The Display dialog box is divided into two parts (left and right): the default display, “Raw OD” or 
“Raw RFU/RLU” is shown to the left of a dividing line; the choices for reduced data displays are 
shown to the right of the dividing line. Note: data reduction itself is performed separately; settings 
here simply determine how the reduced data will be displayed in the data section. 

The dialog boxes below show the default display choices for the three modes (if applicable): 

 raw optical density values (numbers) for Endpoint; 

 the change in raw OD or RFU/RLU values over time for Kinetic; 

 raw OD or RFU/RLU values for the range of wavelengths, displayed as a plot, for Spectrum; and 

 raw gray scale plots for Well Scan. 

Other choices available in this dialog box include displaying the data as a single reduced value 
(number), in threshold, ranged, gray scale, or plots formats (the last for Well Scan mode only) or any 
combination of display choices with the reduced number (the reduced number display choice cannot 
be used with the reduced number checkbox). 

Data in the Plate section is displayed in a grid array (microplate format).  

 Normal: shows the data in standard left-to-right format, with well A1 in the upper left corner. 
Columns 1 through 24 are along the top and rows A through P are shown from top to bottom. 
The wells are smaller and data is shown with fewer digits (less precision). 

 Vertical: the plate is shown in the same orientation as Normal except that columns 1 through 12 
(all rows) are shown above columns 13 through 24 (all rows). 

 Rotated: Same as the Normal view except that it is rotated 90 degrees clockwise (well A1 is in 
the upper right corner). 

 Large: Same as the Normal view except larger. This display can be seen in its entirety only if you 
have the page size set for legal paper (8.5 x 14 inches) in landscape orientation (set this in Page 
Setup or Preferences under the File menu). In the example shown in the figure below, the 
display is shown as it appears if you do not change the page size from letter-size to legal. 

 Interleaved: In this display, the wells are shown in a format that “skips” every other well as 
follows: all odd columns and rows begin in the upper left corner of the plate display and are 
followed by all even columns and rows. So well A1 is still in the upper left corner, but it is 
followed horizontally by well A3, A5, ... A23, A2, A4, etc., and vertically by well C1, E1, ... O1, 
B1, D1, etc. This display is most useful when the 384-well plate is composed of 4 daughter plates 
of 96 wells each. 



Chapter 6: Data Analysis: SpectraMax M2 & M5  

406 SoftMax Pro User’s Manual 

Reduced Number 
The reduced number is based on the settings defined in the Reduction dialog box. It is a combination 
of blank subtraction, wavelength reduction, and Spectrum scan or Kinetic reduction. The information 
acquired from the microplate reader is reduced to a single number or value. The reduced number will 
be reported in the Group section when a template has been defined. 

To view by reduced number alone, select the Number option (the first choice to the right of the 
default, just after the dividing line); to see a reduced number as well as another type of display, click 
the box next to the option that says “With reduced number” in the lower left of the dialog box to 
enable it. Changing the reduction parameters after choosing a reduced data display mode will cause 
the display to update accordingly. More information about reduction formulas and how to customize 
them follows later in this chapter.  

Threshold, Ranged, and Gray Scale 
To display Threshold, Ranged, or Gray Scale data, high and low values must be entered. When you 
choose one of these display options, SoftMax Pro provides default values for the high and low limits 
by means of an autoranging function (encompassing all the data from lowest to highest value). You 
can change the high and low limits by highlighting the existing value and entering a new value. An 
example of the Display dialog box for a Kinetic reading (Plate section) with the Threshold display 
option chosen is shown below. 

 
Display Dialog Box 

Threshold 

The Threshold display shows the raw data as a plus (+) for values above the high limit, an asterisk (*) 
for values within the limits, and a minus (-) for values below the low limit. The figure below shows a 
Kinetic reading displayed using the Threshold option along with the reduced number. 
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Threshold Display 

Ranged 

When the Ranged display is chosen, raw data that falls between the high and low limits is assigned 
proportionally to integer values from 0 through 9. Values above the high limit are displayed as a 
plus (+) and values below the low limit are displayed as a minus (-). The figure below shows reduced 
Kinetic data displayed in Ranged format. 

 
Ranged display 

Gray Scale 

The Gray Scale option presents the raw data in eight shades of gray, changing from light (for values 
less than or equal to the low limit) to dark (for values greater than or equal to the high limit). The 
figure below shows reduced Endpoint data displayed as Gray Scale. 
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Gray Scale display 

Plots (Well Scan mode only) 

The Plots option presents the raw data in eight shades of gray, changing from light to dark 
depending upon the amount of whole cells detected during the scan. The figure below shows 
reduced Well Scan data represented in Plots format. 

 
Plots display 

 

Graphing Wells 

You can enlarge the display of the wells shown with Kinetic, Spectrum, or Well Scan modes to get 
a close-up view of the data. This is done by either double-clicking the particular well or cuvette in the 
data display or by selecting the well or cuvette and then clicking the Well Graph button in the Plate 
section or CuvetteSet Section Tool Bar. 
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Polarization 
When Fluorescence Polarization read mode is selected in the Instrument Settings dialog box, 
Polarization Display will be available in the Display dialog box.  

The G-factor in the Polarization and Anisotropy calculations (default is 1) can manually be adjusted 
for calculating different mP or Anisotropy values.  The valid range for G-factor will be from 0.01 to 
99. 

 

 
Kinetic and Spectrum Well Graphs 

Well Graphs plot the data for the individual wells in a microplate or for individual cuvettes and show 
the well ID and reduction information, including the goodness of fit (R^2 value), if appropriate. The 
default display for the X-axis shows time for Kinetic plots and wavelength for Spectrum plots; OD, 
RFU/RLU, or %T is displayed on the Y-axis for both plots. 

Positioning the cursor within a Well Graph shows X and Y values for the cursor location, allowing 
you to determine more precisely the location of data points. 

Well Scan Well Graphs 
Well Graphs in Well Scan mode default to displaying raw data in a grayscale plot. The manner in 
which the data is displayed in a Well Graph for a Well Scan depends on the reduction options that 
have been chosen, the display options (raw or reduced, for example), the number of points read, and 
whether the Well Graph is scaled to the data or to the limits of the entire plate. 

Well Graph Options 
Along the bottom of each Well Graph dialog box are eight buttons (five when using Well Scan mode) 
that perform the following functions: 

 [Print] 
Opens the Print dialog box. 

 [Reduction] 
Opens the Reduction dialog box. 
By default, the ranges on the enlarged plot are set to the limits defined in the Reduction dialog 
box, and the information included near the bottom of the window is based on the reduction 
settings currently in use. You may change these settings (wavelength combination and type of 
reduction used, minimum and maximum OD or RFU/RLU limits, lag time and end time, and 
number of Vmax Points; for a cuvette, whether or not to use a template blank, absolute values, 
or to show the data as absorbance or percent transmittance). More information about the 
reduction options can be found later in this chapter. 
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� NOTE: Changes to the reduction settings made within well graphs will be applied to all wells or cuvettes 
in the Plate or CuvetteSet section. When viewing Raw data, you can scale the graph to see data outside 
the reduction limits [line(s) are included on the graph indicating the limits and the area outside of them 
will be shaded slightly]. This view should assist you in determining the best limits for the reduced data. 

Show Raw/Show Reduced Button 

This button toggles the Well Graph between views of raw and reduced data. When the Well Graph is 
opened, the initial view depends on the Display settings for the Plate section. If raw data is being 
displayed in the Plate, the initial view in the Well Graph will be raw data and the button will be set to 
“Show Reduced.” If reduced data is being displayed in the Plate section, the initial view in the Well 
Graph will be reduced data and the button will be set to “Show Raw.” 

Scale to Data/Scale to Limits Button 

This button toggles between a view of the data within the reduction limits and a view of the entire 
data set. Switching between these views helps to visualize how the limit settings affect data 
reduction. If raw data is being viewed in the Plate section, the display in the Well Graph is set 
initially to show the plot scaled to the reduction limits. If reduced data is being viewed in the Plate 
section, the Well Graph display is set initially to show the plot scaled to the data. 

� NOTE: If you are viewing raw data and click the Scale to Limits or Scale to Data button, only the display 
of raw data in the Well Graph will be affected (the button will not affect the view of reduced data). The 
same is true if you click this button while viewing reduced data. To produce comparable scaling of both 
raw and reduced displays, this button must be set to either Scale to Limits or Scale to Data for both raw 
and reduced views of the Well Graph. 

Graph Options button 

Opens the Well Graph Options dialog box which allows you enable or disable connected points or 
plotted symbols the graph. 

 

X-Axis Settings button  

Y-Axis Settings button  

Opens the Well Graph Axis Settings dialog box for the particular axis, allowing you to set Auto 
Range parameters, choose the minimum and maximum values for the selected axis, cause the axis to 
be auto-ranged, add or remove gridlines, and add or remove axis tick marks. When a Well Graph is 
opened, the default settings are to show the reduction limits for that axis with Auto Ranging off and 
gridlines and tick marks selected. Only the Well Graph being viewed is affected by changes in these 
dialog boxes. 

 [Done] 
Closes the Well Graph dialog box. 
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Above: Well Graph for a Single Kinetic Microplate Well (Raw Data) 

 
Above: Well Graph for a Single Kinetic Cuvette (Reduced Data) 

Multiple wells from the same Plate section or cuvettes from the same CuvetteSet section can be 
graphed together in one enlarged window. Select the well(s) or cuvette(s) in the data display (hold 
the [Shift] key if you are selecting non-contiguous wells or cuvettes; you can drag across contiguous 
wells) and then click the Graph button or double-click in one of the selected wells or cuvettes. 
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Above: Well Graph for Three Kinetic Wells of a Microplate (Raw Data) 

The choices you make for viewing the data in the Plate or CuvetteSet section also affect the way the 
Well Graph appears. The first and third figures above show Well Graphs for raw data displays. If you 
display one of the reduced options (reduced number, Threshold, Ranged, or Gray Scale), the Well 
Graph will show the plot with an indicator of the reduced value and will include the word 
“Reduced” in the window title (see the middle figure above which shows the Well Graph for a single 
Kinetic cuvette viewed in a reduced plots format). 

Zoom Box 
You can enlarge the Well Graph even further by clicking the zoom box in the upper right-hand corner 
of the window (the center box of three in the upper right corner in Windows). Clicking the zoom box 
once will cause the window to fill the total display on your monitor; clicking the zoom box again will 
return the window to its previous size. 

Size Box 
Clicking and dragging the size box located in the lower-right corner (Macintosh) or clicking and 
dragging the lower right corner of the window (Windows) allows you to make the Well Graph any 
size desired. 

Printing the Well Graph 
You can print the Well Graph window, if desired, by clicking the [Print] button at the bottom left 
corner of the dialog box. 

� NOTE: If you enlarge the Well Graph to greater than 12 inches, the graph will not fit on an 8.5- by 11-inch 
page and the printout will be truncated. 

Masking Wells or Cuvettes    
If you find data in certain wells or cuvettes (outliers) that should be excluded from the calculations to 
be performed by data reduction, you can mask these wells or cuvettes. Select the well(s) or cuvette(s) 
to be masked and then click the Mask button in the Plate section or CuvetteSet section Tool Bar or 
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choose Mask... from the Plate or CuvetteSet menu. Masked wells/cuvettes are shown with an overlay 
of diagonal lines. 

The masking function can be used as a “what if?” tool. For example, you could suppress or enable 
certain functional groups within the experiment. Suppose you have included a group blank in the 
template and want to see the data with and without the blank. Masking the group blank wells would 
suppress the blanking function; unmasking them would enable it again. 

 
Above: Masked Wells in a Plate Section and a CuvetteSet Section 

To remove masking from one or more wells, highlight the masked well(s) and click the Mask button 
in the Plate Section Tool Bar (toggles masking on and off) or choose Mask... from the Plate or 
CuvetteSet menu again. The diagonal lines covering those wells (and masking function) will be 
removed. 

Data Reduction 

 
Raw data received from the instrument can be displayed in an analyzed (or reduced) form. The 
reduction process within SoftMax Pro is based on formulas that reduce the raw data to show a single 
number for each well or cuvette. Further analysis of this reduced number then takes place in the 
Group and Graph sections. 

SoftMax Pro performs calculations hierarchically when reducing the optical density information 
collected from the instrument. Calculations in the Plate section or CuvetteSet section are performed in 
the order shown below. If an option has either not been selected in the Instrument Settings dialog 
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box, is not available for the instrument you are using, or has not been defined in the template and/or 
Reduction dialog box, SoftMax Pro starts/continues with the next listed calculation. 

Plate Section 

1. Convert OD to %T (and vice versa) 

2. Pre-read plate blank or plate background constant subtraction (or division for %T) 

3. PathCheck pathlength correction (different equations for OD or RFU/RLU and %T) 

4. Plate blank subtraction 

5. Wavelength reduction 

6. Kinetic or Spectrum reduction 

7. Group blank subtraction 

CuvetteSet Section 

1. Convert OD or RFU/RLU to %T (and vice versa) 

2. Reference is subtracted from the reading (optical density mode) or the read data is divided by 
the reference (%T mode—see Caution below) 

3. Template blank subtraction 

4. Wavelength reduction 

5. Kinetic or Spectrum reduction 

6. Group blank subtraction 

� CAUTION: Separate mathematical calculations are used for handling OD or RFU/RLU and %T 
calculations for Pre-read plate blanking, PathCheck, and Reference because OD or RFU/RLU 
calculations are performed on a linear scale, whereas %T calculations are performed on a 
logarithmic scale. Other calculations, however, are not calculated differently by SoftMax Pro for 
absorbance and %T modes. Because of this, Molecular Devices recommends that %T be used only for 
raw OD, raw OD with Pre-read plate blank subtraction, or PathCheck-corrected raw OD or RFU/RLU 
readings. Use caution when using %T on reduced numbers or any readings that apply other 
calculations since the data may not accurately reflect proper calculations. 

You can access the Reduction dialog box in several ways: by clicking the [Reduction] button in the 
tool bar of the active plate/cuvette section, by choosing Reduction from the Plate/CuvetteSet menu, or 
by clicking the [Reduction] button in the Well Graph display. The appearance of the Reduction dialog 
box will be different depending on the type of read mode you have chosen, and the options you have 
chosen in the Instrument Settings dialog box.  

The PathCheck and pre-read plate reduction parameter checkboxes will not be displayed in the Plate 
section Reduction dialog box unless they have been selected in the Instrument Settings dialog box. 
The figure below shows the Reduction dialog box with the “Use plate blank,” “Use pre-read plate,” 
“Switch normal and pre-read,” and “Apply PathCheck” options available. 
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Above: Example Reduction Dialog Box Showing PathCheck,  
Pre-Read, and Plate Blank Options (absorbance example shown) 

All of the read modes offer one or more predefined choices for reduction. The predefined reductions 
are described below under the appropriate read mode heading. In addition, with any read mode, you 
can create a custom reduction formula to better suit your needs. Since all custom reduction formulas 
are defined the same way, regardless of read mode, they are described together after the individual 
read mode sections. 

� NOTE: In Fluorescence Polarization mode, the plate blank subtraction will be performed on the 
uncalculated raw perpendicular (S) and parallel (P) values and the Polarization (mP) or Anisotropy (r) 
values will be based on the selection. The Polarization (mP) or Anisotropy (r) values will be recalculated 
using the subtracted raw perpendicular (S) and parallel ( P) values. 

Endpoint 
Wavelength Combination 

The default reductions for Endpoint readings are !Lm1, !Pathlength,1 and Custom for all instruments 
when you read at a single wavelength. The !Pathlength reduction reports the pathlength in each well. 
Additional wavelength combinations become available depending on the number of wavelengths 
chosen. For any instrument, you can choose Custom and create different reduction formulas. The 
wavelength combinations available in the drop-down menu show the correct format of the formulas 
that produce these reductions. 
  

PathCheck 
Pathlength correction allows microplate data in Endpoint mode to be normalized to a 1-cm 
pathlength. When PathCheck is turned on in the Instrument Settings dialog box for the plate, “Apply 
PathCheck” appears in the associated Reduction dialog box. 

                                                           
1 The !Pathlength option is applicable to Plate or CuvetteSet sections when using the SpectraMax M2; 
however, the wavelength reduction display is not instrument-dependent in SoftMax Pro, so this 
choice is always shown, regardless of which instrument is connected or chosen in the Preferences. 
Choosing !Pathlength with any other instrument or for CuvetteSet sections in the SpectraMax M2 
will cause an error. The Plate section will not display a reduced number and, consequently, no values 
will be reported in the Group section table. 
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Kinetic 
Wavelength Combination 

The default wavelength combination for Kinetic readings is !Lm1. For the SpectraMax M2 or M5, the 
choices depend on the number of wavelengths chosen (for example, if you will read at two 
wavelengths, choices default to !Lm1 and !Lm2, along with Custom). If you do not wish to use the 
default reduction, you can choose Custom and create a different reduction formula. 

Kinetic Limits 

The Limits settings for the display of Kinetic data are MaxOD, MinOD, Lag Time, and End Time. 

� NOTE: The display of OD or RFU/RLU values is shown relative to the first point measured for each well. 
Negative Kinetic values decrease with time, and limits should be set accordingly (below 0) to view 
negative Kinetic data. Limits define the data that will be viewed and included in data reduction, but do not 
affect data collection. If you alter a limit to show less data, you can always display the “hidden” data 
again by changing the limit. 

MaxOD 

The limit for the maximum value you wish to report. Any values from the reading that are above this 
limit will not be shown and will be excluded from data reduction. The default for MaxOD is 1.0. 

The MaxOD reduction parameter can be used to exclude the non-linear portion of the reaction from 
data analysis. This type of data reduction is most useful in reactions where the initial portion of the 
data is linear. You might also adjust the End Time setting to remove a non-linear portion after a 
certain time point in the reaction. Using MaxOD allows the use of the maximum number of linear 
points to calculate the slope of the line and, thus, to determine the rate for each well. 
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Above: Different Reductions of the Same Data Using Different MaxOD Points 

Both of the Well Graphs shown above display different reductions of the same data (these examples 
use optical density readings). In the figure on the top, the MaxOD is set to 2.0 for the display of wells 
B4, C6, and D8. In the figure on the bottom, the MaxOD has been reset to 0.5. Alternatively, you could 
leave the Maximum OD or RFU/RLU and decrease the number of Vmax Points used to determine the 
slope of the line. 

MinOD 

The limit for the minimum value you wish to report. Any values from the reading that are under this 
limit will not be shown and will be excluded from data reduction. The default is 0 OD or RFU/RLU. 
To display negative Kinetics, the value should be set below 0 (zero).  

Lag Time 

Specifies how many initial data points are excluded from the calculation of Vmax Rate. Lag Time 
truncates the data used in the calculation. It does not prevent data from being collected. The Kinetic 
plots will not display the data collected prior to the set Lag Time. The value for Lag Time can be 
changed after the plate is read. The default is 0. 
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In the figure on the top left, well C5 has a lag time: the data is not linear until approximately 80 
seconds after the start of data collection. Thus, the linear curve fit is not good and the slope of the line 
does not reflect the maximal rate. In the figure on the bottom right, a lag time of 80 seconds has been 
set and the linear curve fit for both wells is good, allowing the slope of the lines to reflect the maximal 
rate in each well. Alternatively, you could leave the Lag Time and decrease the number of Vmax 
Points used to determine the slope of the line. 

End Time 

This setting specifies the time at which you wish to stop showing data in the display. Any values 
occurring after this limit will not be reported in the display. The default setting is the total assay time. 
The value for end time may not be greater than the total assay time. 

Absolute Values 

This setting causes the plots shown in the data display to be drawn at their absolute OD as opposed 
to the default (with the box unchecked) which offsets the first point to the (0,0) coordinate. Enabling 
Absolute Values may cause some data points that do not fall within the default limits for the plots to 
“disappear” (see the figure below). 
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Above: Kinetic Reduction with Absolute Values Enabled. Note that the limits in this example (MinOD=0, 

MaxOD=0.5) do not allow all of the data to be visible. 

To see more data, yet still display absolute values, increase the limits for MinOD and/or MaxOD 
found in the Reduction dialog box. 

 
If you increase the MaxOD setting to be at least as large as the largest absorbance value expected, 
most or all of the data plots should appear in the data display. In the Kinetic Reduction example 
shown above, if the MaxOD value is increased from 0.5 to 2.0, the plots then appear as shown below. 
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Above: Kinetic Reduction with Absolute Values Enabled and MaxOD Value Increased 

Kinetic Reduction 
Kinetic reductions are applied to the list of numbers (the value at each timepoint) after the 
wavelength combination formula is applied. Vmax per min and Vmax per sec reductions are 
available for all instruments that are capable of Kinetics; the default Kinetic reduction is Vmax. Other 
reductions available from the pop-up menu are Time to Vmax, Onset Time, Time at Minimum, Time 
at Maximum, Time at 1/2 Maximum, Slope, Area Under Curve, or you can choose Custom and then 
create a different reduction formula. 

Vmax 

The maximum slope of the Kinetic display of optical density versus time. The default value displayed 
is in milli-optical density units per minute (mOD/min). The rate is calculated with the use of  Vmax 
Points (see below) which determines the number of contiguous points over which Vmax is calculated. 
The number of Vmax Points defaults to the maximum taken during the reading; you can change this 
number in the Reduction dialog box if desired. 

� NOTE: Vmax = Vmax/sec • 60,000 

A linear regression is performed to determine the slope of the line using the equation: 

 y = m*X + B 

where m is the slope of the line. 

The reaction rate is reported in milliOD/min (color change in milliOD per minute of reaction time). 

Vmax Points 

This setting defines the maximum size of the line segment used to determine the slope of the line 
used in calculating the rate of the reaction. The default is the total number of points taken in the 
reading, with the data normalized to a starting point of 0,0 (as opposed to starting from the optical 
density of the first time point). The first slope is calculated for a line drawn beginning at the first 
reading as defined by Lag Time (described below) and ending at a total number of readings equal to 
the Vmax Points setting. The second and any subsequent slopes are calculated beginning at the 
second time point and ending at a total number of readings equal to Vmax Points. The steepest slope 
is reported as Vmax Rate. If the data plot displays fewer time points (data points) than the number of 
time points chosen for Vmax Points, then all of the time points will be used to determine the slope of 
the data. 
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Using Vmax Points (Example) 

 Well 1 Well 2 Well 3 

Time points visible in 
the well (data plot) 25 10 2 

Number of Points Used for Data Analysis: 

Vmax Points set to 25/25 
(default) 25 10 2 

Vmax Points set to 5/25 
Overlapping 
5-point line 
segments* 

Overlapping 
5-point line 
segments1 

2 

 

The progressive slope calculations are repeated until the last included data point is reached (as 
defined by the End Time or MaxOD — see below). The maximum positive or negative slope is 
reported as Vmax (mOD/min). Vmax Points can be set from 2 to the total number of points in the 
curve. The number of Vmax Points can be set before the plate is read and can be changed after the 
plate is read. The data display will update automatically each time. The Vmax Points setting does not 
affect data collection. 

� NOTE: The height of the Y axis in the raw data plots or plate display is controlled using MinOD and 
MaxOD. The default settings are: 
      MinOD = 0 
      MaxOD = 1.0 

The width of the X-axis in the raw data plots or plate display is controlled using Lag Time and End 
Time. If either the MaxOD or End Time setting excludes points such that a total number of readings 
equal to Vmax Points cannot be used, then the maximum included points will be used. 

Time to Vmax 

This is an alternative method for analyzing non-linear Kinetic reactions which reports the elapsed 
time until the maximum reaction rate is reached, rather than reporting the maximum rate itself. Used 
in conjunction with Vmax Points, Time to Vmax is the time to the midpoint of the line defined by 
Vmax Points and used to calculate Vmax. This elapsed time data is useful for applications including 
coagulation chemistry where the changing concentration of the reagents does not change Vmax, but 
rather will change the time at which the reaction reaches the maximum rate. 

                                                           
1 SoftMax Pro will perform a linear regression on as many overlapping 5-point line segments as possible in the 
analysis window. The slope will be determined for each line segment and then the steepest slope will be reported 
as the reaction rate. Thus, in well 2 of the example in the table above, the slope will be determined for line 
segments consisting of time points 1 to 5, 2 to 6, 3 to 7, 4 to 8, 5 to 9, and 6 to 10, and then the slope of the line 
segment with the steepest slope will be reported as the Vmax Rate. 
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Onset Time 

This is another method for analyzing non-linear Kinetic reactions. Onset Time reports the time 
required for a Kinetic reaction to change by a specified optical density (onset OD or RFU/RLU above 
the initial OD or RFU/RLU reading for the well). This elapsed time data is useful for cascade reactions 
including clot formation (endotoxin testing, for example) and clot lysis applications where the change 
in reagent concentration does not affect the maximum optical density change but changes the time 
required for the reaction to reach completion.  

Time at Minimum 

This setting reports the time at the minimum OD, RFU/RLU, or %T that falls within the reduction 
limits. 

Time at Maximum 

This setting reports the time at the maximum OD, RFU/RLU, or %T that falls within the reduction 
limits. 

Time at 1/2 Maximum 

This setting reports the time at the half of the maximum OD, RFU/RLU, or %T that falls within the 
reduction limits. To calculate this reduction, SoftMax Pro first determines the Kinetic point (within 
the reduction limits) that has the maximum signal level (OD or %T). It then scans the Kinetic plot 
from left to right until it finds two points having signals that bracket half of that value. A linear 
interpolation between these two points is used to estimate the Time at 1/2 Maximum. 

Slope 

This setting determines the slope of the combined plot (i.e., the slope of the line using linear 
regression after the wavelength combination reduction). This setting uses all visible time points in the 
reduction window. Slope is the same as Vmax Rate when Vmax Rate is set to the same number of 
points as the run (i.e., the default). Slope is not the same as Vmax Rate if you have modified the Vmax 
Points. 

Area Under Curve 

This reduction estimates the area under the curve as defined by the data plots (within the reduction 
limits). The data plots are treated as a series of trapezoids with vertices at successive data points and 
at the X-axis coordinates of the data points. The areas defined by each of the trapezoids are then 
computed and summed. 

Spectrum 
Spectrum Limits 

The Limits settings for the display of Spectrum data are MinOD or MinRFU/RLU, MaxOD or Max 
RFU/RLU, Starting Wavelength in nm, and Ending Wavelength in nm. 

� NOTE: The display of values is shown relative to the first point measured for each well. Limits define the 
data that will be viewed and included in data reduction, but do not affect data collection. If you alter a limit 
to show less data, you can always display the “hidden” data again by changing the limit. 

MinOD/RFU/RLU 

The limit for the minimum value you wish to report. Any values from the reading that are under this 
limit will not be shown and will be excluded from data reduction. The default is 0 OD or RFU/RLU. 



 Chapter 6: Data Analysis: SpectraMax M2 & M5 

SoftMax Pro User’s Manual  423 

MaxOD/RFU/RLU 

The limit for the maximum value you wish to report. Any values from the reading that are above this 
limit will not be shown and will be excluded from data reduction. The default is 1.0 OD or RFU/RLU. 

Start (Wavelength) nm 

Specifies the limit for the minimum wavelength setting you wish to report. Any values from the 
reading that are under this limit will not be shown and will be excluded from data reduction. 

End (Wavelength) nm  

Specifies the limit for the maximum wavelength setting you wish to report. Any values from the 
reading that are above this limit will not be shown and will be excluded from data reduction. 

� NOTE: The settings for the Start and End wavelength settings cannot be below the lowest wavelength or 
above the highest wavelength entered in the Instrument Settings for the Spectrum reading. 

Spectrum Reduction 
The Spectrum reduction formula is applied to the list of numbers in each well (values at each 
wavelength) after the wavelength combination formula is applied. The default reduction for 
Spectrum readings is Lambda at Maximum. You can choose Lambda at Minimum, Maximum, 
Minimum, or Area Under Curve instead from the pop-up menu, or you can choose Custom and 
create a different reduction formula. 

Maximum 

Reports the maximum absorbance (optical density) or percent transmittance (%T) (within the 
reduction parameters of MinOD and MaxOD. 

Minimum 

Reports the minimum absorbance (optical density) or percent transmittance (%T) (within the 
reduction parameters of MinOD and MaxOD). 

Lambda at Maximum 

Reports the wavelength at which maximum absorbance (optical density) or percent transmittance 
(%T) (within the reduction parameters of MinOD and MaxOD). 

Lambda at Minimum 

Reports the wavelength of minimum absorbance (optical density) or percent transmittance (%T) 
(within the reduction parameters of MinOD and MaxOD). 

Area Under Curve 
This reduction estimates the area under the curve as defined by the data plots (within the reduction 
limits). The data plots are treated as a series of trapezoids with vertices at successive data points and 
at the X-axis coordinates of the data points. The areas defined by each of the trapezoids are then 
computed and summed. 

Data Mode (%Transmittance/Absorbance) 

For all read modes, you can choose whether to view data as %Transmittance or Absorbance (OD). As 
with all reduction or display options, these choices do not affect the raw data acquired from the 
instrument but rather only how it is shown in SoftMax Pro. If %T is chosen, all values including raw 
data are displayed in %T. 

� CAUTION: When the data mode is switched from %T to Absorbance or vice versa, SoftMax Pro 
recalculates all of the values based upon the new data mode. Separate mathematical calculations 
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are used for handling OD or RFU/RLU and %T calculations for Pre-read plate blanking, and 
PathCheck because OD or RFU/RLU calculations are performed on a linear scale, whereas %T 
calculations are performed on a logarithmic scale. However, other calculations are not calculated 
differently by SoftMax Pro for absorbance and %T modes. Therefore, switching from %T to 
Absorbance or vice versa is not recommended. Additionally, Molecular Devices recommends 
that %T be used only for raw OD or RFU/RLU, raw OD or RFU/RLU with Pre-read plate blank 
subtraction, or PathCheck-corrected raw OD or RFU/RLU readings. Use caution when using %T 
on reduced numbers or any readings that apply other calculations since the data may not 
accurately reflect proper calculations 

� NOTE: If you switch from one mode to the other, note that settings for the two modes are not “linked”—
settings chosen for one mode are not reflected if you switch to the other mode. For example, if data from 
a Spectrum scan is displayed with a MinOD of 0 and a MaxOD of 1 (absorbance), and you then switch to 
%Transmittance and change the limits to 0 and 50%, respectively, switching back to absorbance will not 
change the limits set previously (the Min- and MaxOD limits will still be 0 and 1). 

Custom Reduction Formulas 
If the predefined reduction formulas do not meet your needs, you can create one or more different 
reduction formulas for any or all read modes (Endpoint, Kinetic, Spectrum, or Well Scan). Choosing 
“Custom” from any of the menus or dialog boxes causes a Formula button to appear (an example of 
this button in an Endpoint Reduction dialog box is shown in the figure below). Custom reduction 
formulas may contain other operators and terms in addition to wavelengths. 

 
Above: “Custom” Selected Showing Formula Button (Endpoint) 

Clicking the Formula button opens the Calculation dialog box in which you can name and define a 
new reduction formula. 

 
Above: Wavelength Calculation Dialog Box (Endpoint) 
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Examples of some formulas that might be used when combining multiple wavelengths in the 
Calculation dialog box are given in the table below. 

Wavelength Reduction Formula Examples 

2 λ 3 λ 4 λ to 6 λ 

!Lm1 + !Lm2 !Lm1 + !Lm2 + !Lm3 !Lm1 + !Lm2 + ... + !Lmn 

!Lm1 - !Lm2 
(!Lm1 - !Lm3) / (!Lm2 - 
!Lm3) 

(!Lm1 - !Lm6) /(!Lm2 - !Lm5) / 
(!Lm3 - !Lm4) 

!Lm1 / !Lm2 !Lm1 / !Lm3 !Lm1 / !Lmn 

!Lm1 * !Lm2 !Lm1 * !Lm3 !Lm1 * !Lmn 

Log10(!Lm1/!Lm2) Log10(!Lm1/!Lm3) Log10(!Lm1/!Lmn) 

!Pathlength !Pathlength !Pathlength 

!Lmx/constant 
For example, Lm1/1.44 for quantitating a polyclonal 
antibody by measuring the absorbance at A280 with 
PathCheck on. 

Average(!allvalues) 
This formula will average together the optical densities 
for multiple readings at the same wavelength (for 
example, if you read the well six times at 280 nm). 

Min(!allvalues) 
This formula will report the minimum OD or RFU/RLU 
recorded for multiple wavelength readings in each well. 

Max(!allvalues) 
This formula will report the maximum OD or RFU/RLU 
recorded for multiple wavelength readings in each well. 

If(!Lmz<A,makeerr(118), 
(if(!Lmx>B,makeerr(117),!Lm1))) 

This formula will report “low” for any well with an OD 
or RFU/RLU less than A, “high” for any OD or RFU/RLU 
greater than B, and the OD or RFU/RLU of any well that 
lies between A and B. 

Custom reduction formulas utilizing mathematical operators or terms can be used to obtain specific 
types of data. The table below provides some examples of such formulas for Kinetic and Spectrum 
readings. 
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Kinetic and Spectrum Reduction Formula Examples 

Kinetic 

Vmaxcorr(!combinedplot, 
!vmaxpoints,!readinterval) 

Reports Vmax correlation coefficient 
for plots in all 96 wells. 

Vmax(Delta(!combinedplot), 
!vmaxpoints,!readinterval) 

Will report the Vmax Rate of the 
delta between each time point. 

Spectrum or Kinetic 

Nthitem(!Lm1,X) 

Will report the optical density at 
item X in the list of readings. For 
example, if you have a Kinetic run 
with 20 time points and X is 10, it 
will report the OD or RFU/RLU of 
the 10th time point. Similarly, if you 
have a Spectrum scan with 20 
measurements and X is 10, it will 
report the OD or RFU/RLU of the 
10th wavelength measured. 

For a full discussion of custom formulas, see the Formula Reference Guide. 

When you finish your entry in the Calculation dialog box and click [OK], the formula you have 
entered then appears to the right of the word “Custom” and becomes the default selection for the 
Custom option. You may subsequently edit this formula or enter a new one by clicking the Formula 
button again. 

Recalculation Options 

By default, SoftMax Pro performs continuous recalculation of the data when you read plates, create 
or change formulas, and so on. At certain times, it would be useful to disable the recalculation feature 
so that you can make alterations to the experiment without waiting for individual recalculations to be 
completed. Two commands are available in the Edit menu that allow you to modify the way in which 
SoftMax Pro performs recalculation: Suspend Recalculation and Recalculate Now (  =; [CTRL]+[=]). 

Choosing Suspend Recalculation disables the automatic recalculation feature of the program and 
places a checkmark to the left of the command in the menu to indicate that it has been selected. While 
this function is enabled, no recalculation will occur, regardless of what you may change, add, or 
delete from the experiment. This is especially useful when creating or changing column formulas 
within Group sections, for example, as it can speed up the process greatly. 

When recalculation has been suspended, you may wish to see the results of the changes you have 
made but may still not wish to enable continuous recalculation. Choosing Recalculate Now (  =; 
[CTRL]+[=]) from the Edit menu will cause SoftMax Pro to examine all elements of the experiment 
and perform complete recalculation of the data. Choosing this command does not enable continuous 
recalculation but simply causes the program to perform recalculation once. 

To return to continuous recalculation, choose Suspend Recalculation again. The checkmark next to 
the command will disappear, indicating that the function is no longer in use. 
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� NOTE: Recalculate Now (  =; [CTRL]+[=]) can be used to see intermediate results during long Kinetic 
readings. At any time, you can choose Suspend Recalculation to delay calculations until a later time. 

Well Scan 
Wavelength Combination 

The default wavelength combination for Well Scan readings is !Lm1 and is the only choice 
besides Custom which can be used to create a different reduction formula. 

Well Scan Reduction 

Choices are Maximum, Minimum, Average (default), and Custom. Average provides the average 
value for all points in the Well Scan. 

Displaying Data in Group, Graph, and Notes Sections 
Group Sections 

The manner in which data is displayed in a Group section depends on the type of reading that was 
performed (Endpoint, Kinetic, Spectrum, or Well Scan), but can be customized by choices made in the 
data display, reduction settings, and the Edit menu. 

Default displays for Group sections are shown automatically unless you choose a different display 
option. 

The particular font to be used in a Group section table, as well as its size and style, can be changed by 
first selecting one or more columns in the Group section table and then choosing the Text command 
from the Edit menu and making the desired choices from the dialog box that appears. 

Settings from the Plate Section Affect Data Display in Group Section Tables 

Reduction options in the Plate section allow you to display the raw data received from the instrument 
in a reduced (analyzed) form. Which reduction options are available depend on the read mode used 
and reduction settings chosen. Reduced numbers from the read section are displayed in the Values 
column of the Group section tables by default. 

Reduction settings do not affect the raw data but simply cause it to be displayed differently. You can 
change reduction settings without affecting the raw data from the reading in any way. 

Custom reduction formulas require the use of accessors and operators that are understood by 
SoftMax Pro. For a list of these accessors and operators see the Formula Reference Guide. 

Resizing and Hiding Columns 
The columns in a Group section can be resized in several ways. One of the simplest methods is to 
drag the line dividing the columns to another position (moving it horizontally). When you point to a 
line between columns, the cursor changes to a double arrow with a vertical line through it, showing 
that it is ready to move left or right 
. 
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Above: Cursor Positioned on a Line between Columns 

Reducing Column Size and Hiding Columns 

You can reduce a column to a size smaller than the width of its title, in which case the title will not be 
completely visible. You can also hide a column by reducing its size completely (drag one edge of the 
column on top of the other) or by selecting that column and choosing Hide from the Group menu. 

� NOTE: If you hide a column in this way and then wish to view it again, use the Show All command in the 
Group menu. All columns that were hidden will again be visible. There is no way to show only one 
hidden column. 

Enlarging Column Size 

You can enlarge the width of columns to any size. Increasing the size of columns may make the width 
of the Group section increase beyond the page width boundary. If this occurs, the columns will 
“disappear” off the edge of the screen but are really still there. To bring these columns back into 
view, reduce the width of the columns that are still visible until the others reappear. 

 

� NOTE: If the width of a section extends beyond the page width boundary, the portion that is not visible 
will not be printed. 

To size two or more columns to the same width, highlight those columns and then drag one of the 
dividing lines to the desired width. The width of all highlighted columns will be sized the same as 
the column to the left of the dividing line you are moving. 

Columns can also be resized to the minimum amount of space required by choosing Autosize from 
the Group menu. By highlighting the entire table or individual columns and then choosing Autosize, 
the amount of space each column requires will be reduced to the minimum size required by the 
largest piece of text in that column. 

Double-clicking the line dividing two columns causes the single column to the left of the divider to be 
sized according to the largest amount of text in that column. 
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Showing and Editing Existing Column Formulas 
When group sections are first created, the formulas used to calculate the data are not displayed. 

These formulas can be shown (until you choose to hide them again) by making a Group section active 
and then choosing Show Formulas from the Group menu. (Note that the command in the menu 
changes to Hide Formulas after they are shown.) 

 
Choosing this option causes an additional row to appear (beneath the heading for each column) 
which shows the formula used to calculate the data in each column. To see formulas briefly, hold 
down the Shift and [CTRL] keys. 

 
Modifying Column Formulas 

To modify the formula for an existing column, double-click the column or click the column once and 
then click the formula button in the section tool bar. The dialog box associated with the column 
formula will open, allowing you to edit the formula (and the name) associated with the column. 
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For a complete discussion, see the Formula Reference Guide. 

Adding Columns 
You can add a new column to a Group section by clicking the Create Column button in the Group 
Tool Bar or by choosing Create Column from the Group menu which will open the Column Formula 
dialog box. 

 
In the Column Formula dialog box, you can change the name of the new column (from the default 
which simply lists the column by number) to reflect the data that it will contain. 

If no existing column is selected when you click the Create Column button, the new column will be 
created to the right of all existing ones. If you select (highlight) a column and then add a new column, 
it will be positioned to the right of the one you selected. If the table is currently as wide as the sheet of 
paper specified in Page Setup when a new column is added, the columns will “disappear” off the 
right side of the window but are still there. To bring these columns back into view, resize visible 
columns smaller. 

New columns can contain references to other columns, both in the current section or in a different 
one within the same experiment. For example, if you wanted to subtract the mean values in one 
group from those in another, you could create a new column (in either group) to do this. If the two 
groups were named “Group 1” and “Group 2,” for example, and both groups contained a column 
entitled “Mean,” you could create a column within “Group 1” that would subtract the mean values in 
“Group 2” from those in “Group 1.” The column formula needed to do this would be: 
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Mean-Mean@Group2 

Numerous possibilities exist for creating and editing column formulas to display the data you desire. 
For a complete discussion of formulas and operators, see the accompanying Formula Reference Guide. 

� NOTE: To delete a column, highlight it and press the [Delete] key or choose Cut from the Edit menu. 

Adding or Editing a Summary in a Group Section 
To add a summary at the bottom of a Group section, click the Create Summary button in the tool bar 
or choose Create Summary from the Group menu. The Calculation dialog box will appear, allowing 
you to change the name of the summary or hide the name, if desired, as well as to enter a description 
of the summary and to create a formula for it (including the number of decimal places for the result, 
if appropriate). Double-clicking an existing summary causes the same dialog box to appear, allowing 
you to modify summary information. 

 
Information entered in this dialog box will be placed at the bottom of the Group section as follows: 

Name = Description     Formula Result 

You can click the checkbox next to Hide Name, which will change the way the summary appears to 
show: 

Description     Formula Result 
  

� NOTE: The name assigned to a summary is important since you can reference the summary by name in 
other formulas (building one upon another). The summary name can be referenced even if it is hidden. 

   

If you wish to see the formulas associated with summaries without opening the Calculation dialog 
box for each one, you can choose Show Formulas from the Group menu. To see these formulas only 
briefly, hold down the shift and [CTRL] keys while that Group section is active. The summaries will 
“expand” to show the complete formula along with the title. They will resume their previous 
appearance when you release the [Option] key. 

Summaries in Group sections can be moved horizontally, if desired, by dragging them left or right. 
When you position the pointer over a Group summary, the cursor changes to show a double-headed 
horizontal arrow. Clicking once highlights the summary; dragging and then releasing the summary 
leaves it in the position where the mouse button was released. 

To have summaries line up with particular columns in the Group, hold down the [CTRL] key while 
dragging the summary. When you release the control [CTRL] key, the summary will “snap back” so 
that it begins flush to the left side of the column under which it was released. Each summary can be 
positioned in a different place in the Group section, if desired. 
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� NOTE: To delete a summary, highlight it and press the [Delete] key or choose Cut from the Edit menu. A 
summary can also be copied or cut and then pasted in a different location. 

You can also change the format of the text in Group section columns and/or summaries. By selecting 
the column or summary and then choosing Edit and then Text Style ([CTRL]+[T]), you can change the 
font, size, and/or style of the text. 

Notes Sections 
The Notes section allows you to enter text describing the experiment and one or more summary lines 
that contain formulas. To create a summary, click the Create Summary button in the tool bar or 
choose Create Summary... from the Notes menu. 

The Calculation dialog box that appears allows you to enter a description of the summary, accept the 
default title for the summary, change it or hide it, and enter a formula (including the number of 
decimal places the reduction should show, if appropriate). For detailed information regarding 
operators and accessors, see the Formula Reference Guide. 

If you wish to see the formulas associated with the summaries without calling up the Calculation 
dialog box for each one, you can choose Show Formulas from the Notes menu. To see these formulas 
only briefly, hold down the shift and [CTRL] keys while that Notes section is active. The summaries 
will “expand” to show the complete formula along with the other summary information. They will 
resume their previous appearance when you release the [Option] key. 

Graph Section 
The Plot#X Dialog Box 

Whenever you create a new Graph section or add a plot to an existing graph, the Plot#X dialog box 
opens automatically (“X” starts with “1” and increments each time a new plot is added to a Graph 
section). In this dialog box, you can rename the plot, assign specific information to be plotted on the 
X- and Y- axes, and choose which icon and color will be used. If you rename the plot, the title of the 
dialog box will change to show the new plot name. 

All groups that have been created or assigned within the file are listed on the left side of the “Source:” 
field in the Plot#X dialog box. The first group in the file is automatically selected. Other groups can be 
selected by highlighting them. When a group is selected, the pull-down menus in the X-axis and Y-
axis subfields change to show the group columns that are available for graphing. Group columns can 
be assigned for both the values to be plotted and any error bars to be included for both axes. 

Summaries and user-defined formulas can also be graphed. Pushing the  button for either the X-
axis or Y-axis opens a dialog box which allows you to enter formulas. To plot a summary, enter the 
summary name in this dialog box. Formulas can be plotted for comparison with other data. For 
example, if the data is assumed to follow a specific model, the model formula can be entered as a plot 
and then the data can be chosen for another plot within the same graph. You can also use this feature 
to plot Kinetic or Spectrum data in Graph sections. For example, to plot Kinetic data from well A1 in 
a Graph section, you can enter the formula !A1Lm1 for the Y-Axis and the !TimeRun accessor for the 
X-axis. The entered formulas are also shown in the “Source:” field of this dialog box. 

The size, color, and style of the icon used for a plot can be selected on the right side of this dialog box. 
Four sizes, nine colors, and nine styles are available from drop-down menus. 

The Graph Options Dialog Box 

The Graph Options dialog box allows you to change the name of the Graph section, change the height 
of a graph, select the type of graph to be displayed, change the fonts used on the title, legend, and 
axes, access the Plot#X dialog box for editing plots, entering new plots, and/or to delete plots. This 
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dialog box is opened after pressing [OK] in the Plot#X dialog box when a new Graph section is being 

created. This dialog can also be accessed by pressing the Graph Options button  on the Graph 
section toolbar or by choosing Graph Options from the Graph menu. 

Scatter plots, cluster bar charts and stack bar charts can be created. Error bars can be used with all 
graph types. You can also choose whether to connect the points and/or plot the symbols in the graph. 

Each of the plots that have been created for this Graph section are listed in the “Plots:” field of this 
dialog box. Choosing any of these plots provides an indication of the data to be used for the X- and Y- 
axis data points and error bars on the right side of this field. Plots can be deleted by highlighting the 
plot name and clicking the [Delete] button. Clicking the [New] button opens the Plot#X dialog box, 
allowing you to create a new plot for the graph. Existing plots can be edited by highlighting the plot 
name and clicking the [Edit] button which opens the Plot#X dialog box containing all the information 
for the selected plot. 

When creating a new Graph section, the Graph Options dialog box opens after choosing either [OK] 
or [Cancel] in the Plot#X dialog. The new Graph section is not created, however, until you click [OK] 
in the Graph Options dialog box. 

 
Creating Multiple Plots 

SoftMax Pro makes it possible to create multiple plots within a graph. Each plot will represent data 
from a group that has been created in the Template Editor or data from a summary or custom 
formula. You may plot data from any group or from several groups on a graph, even if the groups are 
in separate experiments. It is possible, for example, to plot multiple dilution series of an unknown, to 
graph together a series of patient samples, or to plot several controls that have been run over time. 

Following is a summary of the steps required to create multiple plots within a single graph, after 
which is an example that provides more detail. 

Multiple Plots Step Summary 

 Create all required groups in the Template Editor. 

 Read the microplate to obtain data. 

 Create a graph section. 

 Add plots to the graph and choose the group and the X and Y values to be shown for each plot. 
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Example of Creating Multiple Plots 

This example shows how three groups, all of which are Standards, were plotted on the same graph.  

1. Groups are created in the Template Editor. For this example, four groups are created: three for 
standards (Standard1, Standard2, and Standard3) and one for Unknowns (Unknown1). 

 
Standards and Unknowns Groups Created 

2. The associated Group sections are created using the Standards column format which, by default, 
generates columns for concentration and optical density values. The example below shows the 
Group section for Standard2. 

 
Standard2 Group Section 

3. A new Graph section is created by selecting New Graph from the Experiment menu. This causes 
the Plots dialog box to open automatically. The default name for the first plot, “Plot#1,” is then 
changed (by typing a new name over it) to “Standard#1.” Clicking [OK] opens the Graph 
Options dialog box which allows you to choose the graph type, modify the fonts used for the 
graph, and so on. Choices should be made as follows: Standard1 for the group to be plotted, the 
concentration of Standard1 for the X-axis, and values of Standard1 for the Y-axis. No error bars 
are added. 
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Graph Options Dialog Box with Plot Name Changed to “Standard#1” 

4. A second plot is added to this graph by clicking the [New] button in the Graph Options dialog 
box. After clicking [New], a dialog labeled Plot #2 is opened. The second plot name defaults to 
“Plot#1,” which now shows beneath the first plot. Change this second plot name to 
“Standard#2,” choose Standard2 for the group, and change the X- and Y-axes to show 
concentration and values, respectively, for Standard2. 

 
Graph Options Dialog Box with Second Plot Added for Standard#2 

5. This process is repeated for a third plot, labeled “Standard#3.” 

6. Now that all plots information is complete, clicking [OK] in the Graph Option dialog box will 
close it, and the resulting graph will show the three plots created. 
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Graph Displaying Three Standards Plots 

You can add as many plots to a graph as you wish, and these can be of the same or different types of 
groups. If you create a graph and later wish to add one or more plots to it, simply click the [Graph 
Options] button on the Graph section Tool Bar and then click the [New] button. This will reopen the 
Plots dialog box, allowing you to add or modify the plot information. 

Error Bars 

When data is displayed as a scatter or bar graph, you can choose to display error bars for the plot of 
the data for the X- and/or Y-axis. Error bars are lines that extend beyond a plotted value in either or 
both directions and graphically represent some amount of error in plotted data. 

  
Plot Showing Error Bars 

Choices for displaying error bars relative to a particular axis are the same as those available for 
displaying data on that axis: any column from that group that contains numerical information (not 
columns with text). To display error bars, click and hold the box next to “Error Bars” in the Plot#X 
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dialog and drag to select one of the choices in the menu. To disable error bars, choose “No Error” for 
the X- and/or Y-axis. 

Error bars show both positive and negative error. Depending on the range settings for the graph, 
portions of the error bars may not be visible. 

Curve Fitting 

When you first create a graph of the data, it does not have a fit associated with it. The graph might 
appear something like this: 

 
Graph with No Fit 

You can fit any plot to one of nine curve-fitting algorithms: Linear, Semi-Log, Log-Log, Quadratic, 4-
Parameter (logistic), Log-Logit, Point-to-Point, Exponential, and Cubic Spline. These selections are 
shown in the Fits pop-up menu in the Graph section toolbar (click on the box next to “Fit”). 

Typically, a standard curve refers to the curve fitted to the plot of concentration versus mean value 
for the Standard group. 

Once you have selected a Fit type, SoftMax Pro determines the parameter values that best fit the data. 
The function with these parameters is then drawn on the graph. Ideally, the type of fit used should be 
determined by the underlying chemistry of the assay and could be set before data is read. 

NOTES: A good discussion of curve fitting appears in “Data Analysis and Quality Control of Assays: 
A Practical Primer” by R. P. Channing Rogers in Practical Immuno Assay, edited by Wilfrid R. Butt 
(published by Marcel Dekker, Inc., New York, 1984). 

When a fit is chosen, the Graph section is updated to show the coefficients describing the fit when 
applicable. These values are displayed in the legend at the bottom of the graph. Figures below show 
the same graph with the different fit algorithms applied. Note that the legend information changes 
(along with the formula for the fit) at the bottom of each Graph section for each different fit. 

� NOTE: All plots on a graph must have the same type of fit. 

When a curve fit is chosen, the values for the coefficients of the equation (A, B, C, etc.) will be shown 
as will the square of the correlation coefficient (R^2). The correlation coefficient describes how well a 
change in x values correlates with a change in the y values. The R^2 value should only be used for 
curve fits having linear axes. 
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Linear 

The linear function fits the best straight line to the data. The equation for this fit has the form of: 

Y = A + (B * X) 

where A is the y-intercept of the line and B is the slope. A linear fit should be used whenever the 
values appear to lie on or scattered around a straight line. 

This equation is shown on the screen as: 

y = A + Bx 

A linear fit should be used whenever the standard values appear to lie on or are scattered around a 
straight line. The figure below shows an example of a linear fit. 

 
Graph with Linear Fit 

Semi-Log 

The semi-log function fits the best straight line to a set of data for log(X) plotted against Y. The 
resulting curve displayed will be a straight line with the X-axis drawn in logarithmic scale. The 
equation for a semi-log fit is: 

Y = A + [B * log10(X)] 

and is shown on the screen as: 

y = A + B * log(x) 

where A is the y-intercept of the line and B is the slope (note: log in this equation is the common or 
base-10 logarithm). 
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Graph with Semi-Log Fit 

Log-Log 

The log-log function fits the best straight line to the set of data which consists of the logarithm of the 
readings on the Y-axis (the response) and the logarithm of the dose on the X-axis. The resulting 
display will be a straight line with both axes drawn in logarithmic scale. The equation for the log-log 
fit is: 

log10(Y) = A + [B * log10(X)] 

and is shown on the screen as: 

log(y) = A + B * log(x) 

where A is the log10Y-intercept of the line for log10(X) = 0 and B is the slope (note: log in this 
equation is the common or base-10 logarithm). 

 
Graph with Log-Log Fit 
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Quadratic 

The quadratic function fits the best parabola to the data. The parabola is a curved line based on the 
equation: 

y = A + (B * x) + (C * x2) 

which is shown on the screen as: 

y = A + B*x + C*x^2 

where A is the intercept, B is the slope of the curve at the intercept, and C is the measure of the 
curvature of the parabola. 

The quadratic fit is most appropriate when the standard curve has a tendency to curve up or down. 
An example of a quadratic fit is shown below. 

 
Graph with Quadratic Fit 

4-Parameter Logistic and Log-Logit 

If the standard curve has a sigmoidal shape when plotted on the semi-log axes, it may be appropriate 
to use either the log-logit or 4-parameter fit. Both fits are based on the equation 

 
where D is the Y-value corresponding to the asymptote (i.e., the flat part of the curve) at high values 
of the X-axis and A is the Y-value corresponding to the asymptote at low values of the X-axis. The 
coefficient C is the X-value corresponding to the midpoint between A and D. The coefficient B 
describes how rapidly the curve makes its transition from the asymptotes in the center of the curve. A 
large value of B describes a sharper transition. Typically, B has a magnitude of about 1. 

Both the log-logit and 4-parameter equations are shown on the screen as: 

y = (A - D) / (1 + (x / C) ^ B) + D 
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Graph with 4-Parameter Fit 

 
Graph with Log-Logit Fit 

Some publications show the log-logit equation in another form: 

 
where 

 
A different algebraic expression of these is: 
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The difference between the log-logit fit and the 4-parameter fit are in the way the coefficients A and D 
are calculated. For the log-logit method, the standard values for the lowest and highest values of x are 
used. The corresponding y values are assigned to A and D, respectively. Based on these fixed values 
for A and D, the algorithm then computes values for B and C. This technique works well if there are 
standard points along the upper and lower asymptotes. If this is not true, the log-logit fit should be 
avoided in favor of the 4-parameter logistic. 

� NOTE: The curve-fitting algorithm for the 4-parameter equation was based on the Levenberg-Marquardt 
Method. Discussion of this method can be found in Numerical Recipes in C: The Art of Scientific Computing 
by William H. Press, Brian P. Flannery, Saul A Teukolski, and William T. Vetterling, published by 
Cambridge University Press, New York, 1988. 

Point-to-Point 

A linear equation is fit to each pair of data points. Fit parameters are not given. The point-to-point 
curve fit is a linear fit composed of pieces that assume a linear relationship between each pair of data 
points. The line segment defined by each pair is used to interpolate data between those points. Since 
there are multiple line segments, fit parameters are not shown on the graph. 

 
Graph with Point-to-Point Fit 
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Cubic Spline 

This curve fit generates a fit to a cubic equation between each pair of data points. The general form of 
a cubic equation is: 

y = A + Bx + Cx2 + Dx3 

The equations are computed with the requirement that the first and second derivatives of the 
equations are continuous throughout the range of the data. As multiple curve fits are performed with 
this routine, fit parameters are not shown with the graph. 

 
Graph with Cubic Spline Fit 

Exponential 

The exponential function used to generate this curve fit is: 

y = A + B * (1 - exp^(-x / C)) 

 
Graph with Exponential Fit 

� NOTE: SoftMax Pro does not plot samples with descriptor values of zero (0) on a log axis. Curve fits 
affected by this are the semi-log, log-log, log-logit, and 4-parameter curve fits. 
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Minimum Number of Standards 

The number of standards used in a standard curve depends on the particular curve fit selected and 
on the judgment of the operator. The table below gives the minimum number of standards required 
mathematically by each of the curve fitting algorithms. 

Minimum Number of Standards Required for Curve Fits 

Curve Minimum Number of Standards 

Linear 2 

Quadratic 3 

Semi-Log 2 

Log-Log 2 

Log-Logit 4 

4-Parameter 4 

Point-to-Point 2 

Exponential 3 

Cubic Spline 4 
For optimal results, you should always exceed the minimum number of standards required for any 
given fit. 

There are other requirements on the standards for the log-logit and 4-parameter logistic curves. The 
fits for the 4-parameter logistic curve are based on the assumption that the curve has a high and a low 
asymptote and a certain “steepness” for the linear portion around the inflection point between the 
asymptotes. If a sufficient number of points do not define the inflection point and the asymptotes, 
you will receive a “no fit” error message or an inappropriate fit. For best results, make sure that the 4-
parameter fit is appropriate for your assay and that the entire range of the assay is represented in 
your standards. 

If your standards do not clearly define both a high and low asymptote, the spline fit may be more 
appropriate for your assay. 

Judging a Good Curve Fit 

The correlation coefficient is also known as the goodness of fit value because it shows how good a fit 
exists between the computer curve and the standard data points. It measures the degree to which the 
points fall on the computer curve and may give an indication as to what residuals are to be expected. 
The correlation coefficient is popularly known as R and is between -1 and 1, inclusive. When the data 
points lie on a perfectly straight line with negative slope, then R = -1. If the correlation coefficient is 
not suitably close to 1 or -1 (a perfect fit), you can simply apply one of the other types of curves 
without having to reread the plate.  

For nonlinear curve fits, SoftMax Pro performs transformations that cause the curve to become more 
linear. The correlation coefficients are derived from that transformed data. Because of this, you 
should be cautious about using correlation coefficients as an indicator of goodness of fit. Do not let 
this single value for goodness of fit sway your intuition about which fit is best. Some curve fits may 
seemingly give a good fit (e.g., fit values close to 1) but, when inspected by eye, show a poor fit along 
a major portion of the plot. 
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Graph Options    

Graphs can be customized further through the Graph Options dialog box which is accessed by 

choosing Graph Type... from the Graph menu or by clicking the Graph button ( ) in the section 
tool bar. 

 
Graph Options Dialog Box 

The default options are shown above, but you can alter these as desired: you may change the font and 
type size used for the title, legend, and/or axes of the graph, and you can choose the color and type of 
symbol used on a scatter graph to show the plot. The graphs shown in preceding Figures reflect the 
default graph options. Connecting the points of a scatter graph can be useful in determining the 
closeness of the fit. The figure below shows a scatter graph with points connected compared to a 
linear fit. 

� NOTE: The Connect Points option connects the points in order of appearance by sample name—not the 
appearance of points from left to right on the graph. 

 
Scatter Graph with Points Connected (Linear Fit Applied) 



Chapter 6: Data Analysis: SpectraMax M2 & M5  

446 SoftMax Pro User’s Manual 

Other options in this dialog box allow you to plot the data as a bar graph with data shown in clusters 
or stacked. The figure below shows both of these bar graph options. 

 
Bar Graphs—Cluster and Stack 

� NOTE: Bar graph options for multiple plot graphs are only available when each plot contains the same 
number of data points and has matching X-axis coordinates. 

� NOTE: When choosing the Connect Points option, the order in which points are connected is sample 
name dependent. 

Axes Options    

Double-clicking either graph axis, clicking the X-axis or Y-axis button in the Graph section toolbar, or 
selecting either X-axis... or Y-axis... from the Graph menu opens a dialog box concerning the 
configuration of that axis. The figure below shows the dialog box for the X-axis. 

 
X-Axis Dialog Box 

The default settings are shown in the Figure above. You can change these as desired for either or both 
axes. 
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Axis Settings 

Enabling the Auto-range option causes the graph to be drawn such that all data points are shown (by 
automatically adjusting the minimum and maximum range settings to encompass the data). You can 
disable the Auto-range function by clicking the checkbox or by changing either or both values for the 
Min and/or Max settings. 





  

  

Displaying and Analyzing Data: LMax II, and LMax II384 

Introduction 
Initial display and reduction of the data received from the instrument is performed in the Plate 
section in which the data has been collected. Display and reduction parameters can be set up either 
prior to or after collecting data. The display and reduction parameters may be modified at any time. 

Data analysis and the display of analyzed data is also performed in the Group sections (created when 
wells are assigned to groups in the Template Editor) and the Graph section(s). 

Notes sections may be used in conjunction with any other section to provide text commentary and/or 
a summation of data through the use of summaries. Notes sections are used most commonly to 
provide an introduction to or summary of results for a data file. 

All data files have a minimum of one Plate section with data in it. Multiple Plate sections may be 
present. Most files will have a template and Group, Graph, and Notes sections. However, depending 
upon the particular assay and how you wish to report the data, only some of these sections may be 
(or need to be) present in every file. For example, some simple assays allow you to calculate 
concentration in the Plate sections. In such cases, Group and Graph sections are necessary only if you 
wish to display the data graphically. 

The following diagram shows the relationship between the different sections in SoftMax Pro: 

 

Initial Data Display and Reduction 

� NOTE: Not all settings or features will be available for all instruments. Available features will be based 
on the instrument connected to the computer or chosen in the preferences.  

The manner in which data is displayed in a Plate section depends on the type of reading that was 
performed but can be customized by choices made in the data display and reduction settings. 
Possible display options include: 

 Number or plot displays for raw RLU (relative luminescence units), with or without reduced 
number. 

� NOTE: The number format (use of commas or periods in numeric notation) chosen for the computer 
operating system is reflected in the way that SoftMax Pro displays data. 

 Number, Plot, Threshold, Ranged, or Grayscale (with or without reduced number) 
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 If you have chosen 384-well plates from the Instrument Settings, you can display the wells in 
different ways: Normal, Vertical, Rotated, Large, or Interleaved. 

Default displays are shown automatically unless you choose a different display option. 

Reduction options allow you to display the raw data received from the instrument in a reduced 
(analyzed) form. Which reduction options are available depend on the read mode used; custom 
settings, using formulas you create, are available for all read modes. 

Reduction settings do not affect the raw data but simply cause it to be displayed differently, so you 
may change reduction settings without affecting the raw data in any way. 

Custom reduction formulas require the use of accessors and operators that are understood by 
SoftMax Pro. For a list of such accessors and operators and explanations of their functions see the 
Formula Reference Guide. 

The Data Display 
After a plate has been read, the information sent from the instrument is shown in the data display in 
the active Plate section. The default display for data from Endpoint readings is raw RLU numeric 
values. Data from Kinetic and Fast Kinetic readings is shown in plots format (raw RLU values with 
respect to time or wavelength) and the display updates dynamically to show the data collected so far. 
If the instrument is reading more than one wavelength, plots for the different wavelengths are 
overlaid in each well. 

All choices except those defined in the Instrument Settings affect only the manner in which the data is 
displayed—the raw data is not changed—permitting you to optimize the display after data is 
collected. 

� NOTE: Data reduction changes the way in which data is displayed and also affects the values used in 
calculations within SoftMax Pro. While the raw values remain unchanged, calculations will use reduced 
values, if any, and are, therefore, affected by settings chosen in the Reduction dialog box.  

� NOTE: Data comes from the instrument to SoftMax Pro with four digits to the right of the decimal point. 
Only three of the four digits are displayed in the Plate section for Endpoint data, however: the fourth 
digit is rounded up or down (0.0045 rounds up to 0.005; 0.0044 rounds down to 0.004, for example). You 
can view all four digits of data, if desired, by displaying the raw values in a Group section table and 
increasing the number of decimal places showing. 

The Display Dialog Box 

Before or after a plate has been read, you can click the [Display] button to open the Display 
dialog box which allows you to change the way the data is presented. Choices available in this dialog 
box depend on whether a Plate section is currently active and which read mode you have chosen (for 
example, the choice for “Plots” is not shown if Endpoint mode is selected). The figures below show 
the default Display dialog boxes for the different read modes. 

The Display dialog box is divided into two parts (left and right): the default display, “Raw RLU,” is 
shown to the left of a dividing line; the choices for reduced data displays are shown to the right of the 
dividing line. Note: data reduction itself is performed separately; settings here simply determine how 
the reduced data will be displayed in the Plate section. 

Choices available in this dialog box include displaying the data as a single reduced value (number), 
in threshold, ranged, or gray scale formats, or any combination of display choices with the reduced 
number (the reduced number display choice cannot be used with the reduced number checkbox). 
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Data in the Plate section is displayed in a grid array (microplate format). With all plates other than 
384-well plates, the display is always shown as a standard microplate, with well A1 in the top left 
corner. If you are reading 384-well plates, additional display options can be chosen to make the 
display of data more clear: 

 Normal: shows the data in standard left-to-right format, with well A1 in the upper left corner. 
Columns 1 through 24 are along the top and rows A through P are shown from top to bottom. 
The wells are smaller and data is shown with fewer digits (less precision). 

 Vertical: the plate is shown in the same orientation as Normal except that columns 1 through 12 
(all rows) are shown above columns 13 through 24 (all rows). 

 Rotated: Same as the Normal view except that it is rotated 90 degrees clockwise (well A1 is in 
the upper right corner). 

 Large: Same as the Normal view except larger. This display can be seen in its entirety only if you 
have the page size set for legal paper (8.5 x 14 inches) in landscape orientation (set this in Page 
Setup or Preferences under the File menu). In the example in the figure above, the display is 
shown as it appears if you do not change the page size from letter-size to legal. 

 Interleaved: In this display, the wells are shown in a format that “skips” every other well as 
follows: all odd columns and rows begin in the upper left corner of the plate display and are 
followed by all even columns and rows. So well A1 is still in the upper left corner, but it is 
followed horizontally by well A3, A5, ... A23, A2, A4, etc., and vertically by well C1, E1, ... O1, 
B1, D1, etc. This display is most useful when the 384-well plate is composed of 4 daughter plates 
of 96 wells each. 
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Above: Example Plate Sections. Choices for a 384-well plate display are shown: Normal, Vertical, Rotated, Large, 

and Interleaved. 

Reduced Number 
The reduced number is based on the settings defined in the Reduction dialog box. It is a combination 
of plate blank subtraction in the Plate section, wavelength reduction, or a Kinetic reduction. The 
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information acquired from the instrument is reduced to a single number or value. The reduced 
number will be reported in the Group section when a template has been defined. 

To view by reduced number alone, select the Number option (the first choice to the right of the 
default, just after the dividing line); to see a reduced number as well as another type of display, click 
the box next to the option that says “With reduced number” in the lower left of the dialog box to 
enable it. Changing the reduction parameters after choosing a reduced data display mode will cause 
the display to update accordingly. More information about reduction formulas and how to customize 
them follows later in this chapter.  

Threshold, Ranged, and Gray Scale 
To display Threshold, Ranged, or Gray Scale data, high and low values must be entered. When you 
choose one of these display options, SoftMax Pro provides default values for the high and low limits 
by means of an autoranging function (encompassing all the data from lowest to highest value). You 
can change the high and low limits by highlighting the existing value and entering a new value. An 
example of the Display dialog box for a Kinetic reading (Plate section) with the Threshold display 
option chosen is shown below. 

 
Display Dialog Box 

Threshold 

The Threshold display shows the raw data as a plus (+) for values above the high limit, an asterisk (*) 
for values within the limits, and a minus (-) for values below the low limit. The figure below shows a 
Kinetic reading displayed using the Threshold option along with the reduced number. 
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Threshold Display 
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Ranged 

When the Ranged display is chosen, raw data that falls between the high and low limits is assigned 
proportionally to integer values from 0 through 9. Values above the high limit are displayed as a 
plus (+) and values below the low limit are displayed as a minus (-). The figure below shows reduced 
Kinetic data displayed in Ranged format. 

 
Ranged display 
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Gray Scale 

The Gray Scale option presents the raw data in eight shades of gray, changing from light (for values 
less than or equal to the low limit) to dark (for values greater than or equal to the high limit). The 
figure below shows reduced Endpoint data displayed as Gray Scale. 

 
Grayscale display 

Graphing Wells 

You can enlarge the display of the wells shown with Kinetic or Fast Kinetic modes to get a close-
up view of the data. This is done by either double-clicking the particular well in the data display or 
by selecting the well and then clicking the Well Graph button in the Plate Section Tool Bar.  

Well Graphs 
Well Graphs plot the data for the individual wells in a microplate and show the well ID and 
reduction information, including the goodness of fit (R^2 value), if appropriate.  

Positioning the cursor within a Well Graph shows X and Y values for the cursor location, allowing 
you to determine more precisely the location of data points. 

Well Graph Options 
Along the bottom of each Well Graph dialog box are buttons that perform the following functions: 

 [Print] 
Opens the Print dialog box. 

 [Reduction] 
Opens the Reduction dialog box. 
By default, the ranges on the enlarged plot are set to the limits defined in the Reduction dialog 
box, and the information included near the bottom of the window is based on the reduction 
settings currently in use. You may change these settings (wavelength combination and type of 
reduction used, minimum and maximum value limits, lag time and end time, and number of 
Vmax Points). More information about the reduction options can be found later in this chapter. 
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� NOTE: Changes to the reduction settings made within well graphs will be applied to all wells in the Plate 
section. When viewing Raw data, you can scale the graph to see data outside the reduction limits [line(s) 
are included on the graph indicating the limits and the area outside of them will be shaded slightly]. This 
view should assist you in determining the best limits for the reduced data. 

Show Raw/Show Reduced Button 

 This button toggles the Well Graph between views of raw and reduced data. When the Well Graph is 
opened, the initial view depends on the Display settings for the Plate section. If raw data is being 
displayed in the Plate, the initial view in the Well Graph will be raw data and the button will be set to 
“Show Reduced.” If reduced data is being displayed in the Plate section, the initial view in the Well 
Graph will be reduced data and the button will be set to “Show Raw.” 

Scale to Data/Scale to Limits Button 

This button toggles between a view of the data within the reduction limits and a view of the entire 
data set. Switching between these views helps to visualize how the limit settings affect data 
reduction. If raw data is being viewed in the Plate section, the display in the Well Graph is set 
initially to show the plot scaled to the reduction limits. If reduced data is being viewed in the Plate 
section, the Well Graph display is set initially to show the plot scaled to the data. 

� NOTE: If you are viewing raw data and click the Scale to Data or Scale to Limits button, only the display 
of raw data in the Well Graph will be affected (the button will not affect the view of reduced data). The 
same is true if you click this button while viewing reduced data. To produce comparable scaling of both 
raw and reduced displays, this button must be set to either Scale to Limits or Scale to Data for both raw 
and reduced views of the Well Graph. 

Graph Options button 

Opens the Well Graph Options dialog box which allows you enable or disable connected points or 
plotted symbols the graph. 

 

X-Axis Settings Button  

Y-Axis Settings Button  

Opens the Well Graph Axis Settings dialog box for the particular axis, allowing you to set Auto 
Range parameters, choose the minimum and maximum values for the selected axis, cause the axis to 
be auto-ranged, add or remove gridlines, and add or remove axis tick marks. When a Well Graph is 
opened, the default settings are to show the reduction limits for that axis with Auto Ranging off and 
gridlines and tick marks selected. Only the Well Graph being viewed is affected by changes in these 
dialog boxes. 

 [Done] 
Closes the Well Graph dialog box. 
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Above: Well Graph for a Single Kinetic Microplate Well (Raw Data) 

Multiple wells from the same Plate section can be graphed together in one enlarged window. Select 
the well(s) in the data display (hold the [Shift] key if you are selecting non-contiguous wells; you can 
drag across contiguous wells) and then click the Graph button or double-click in one of the selected 
wells. 

 
Above: Well Graph for Three Kinetic Wells of a Microplate (Raw Data) 

The choices you make for viewing the data in the Plate section also affect the way the Well Graph 
appears. The figures above show Well Graphs for raw data displays. If you display one of the reduced 
options (reduced number, Threshold, Ranged, or Gray Scale), the Well Graph will show the plot with 
an indicator of the reduced value and will include the word “Reduced” in the window title. 
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Zoom Box 
You can enlarge 
the Well Graph 
even further by 
clicking the zoom 
box in the upper 
right-hand corner 
of the window (the 
center box of three 
in the upper right 
corner in 
Windows). 
Clicking the zoom 
box once will 
cause the window 
to fill the total 
display on your 
monitor; clicking 
the zoom box 

again will return the window to its previous size. 

Size Box 
Clicking and dragging the size box located in the lower-right corner (Macintosh) or clicking and 
dragging the lower right corner of the window (Windows) allows you to make the Well Graph any 
size desired. 

Printing the Well Graph 
You can print the Well Graph window, if desired, by clicking the [Print] button at the bottom left 
corner of the dialog box. 

� NOTE: If you enlarge the Well Graph to greater than 12 inches, the graph will not fit on an 8.5- by 11-inch 
page and the printout will be truncated. 

Masking Wells    
If you find data in certain wells (outliers) that should be excluded from the calculations to be 
performed by data reduction, you can mask these wells. Select the well(s) to be masked and then click 
the Mask button in the Plate Section Tool Bar or choose Mask... from the Plate menu. Masked wells 
are shown with an overlay of diagonal lines. 

The masking function can be used as a “what if?” tool. For example, you could suppress or enable 
certain functional groups within the experiment. Suppose you have included a group blank in the 
template and want to see the data with and without the blank. Masking the group blank wells would 
suppress the blanking function; unmasking them would enable it again. 

 
 

To remove masking from one or more wells, highlight the masked well(s) and click the Mask button 
in the Plate Section Tool Bar (toggles masking on and off) or choose Mask... from the Plate menu 
again. The diagonal lines covering those wells (and masking function) will be removed. 
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Data Reduction 

 

� NOTE: Not all settings or features are available for all instruments. Available features depend on the 
instrument connected to the computer or chosen in the preferences.  

Raw data can be displayed in an analyzed (or reduced) form. The reduction process within SoftMax 
Pro is based on formulas that reduce the raw data to show a single number for each well. Further 
analysis of this reduced number then takes place in the Group and Graph sections. 

SoftMax Pro performs calculations hierarchically when reducing the information collected from the 
instrument. Calculations in the Plate section are performed in the order shown below. If an option 
has either not been selected in the Instrument Settings dialog box, is not available for the instrument 
you are using, or has not been defined in the template and/or Reduction dialog box, SoftMax Pro 
starts/continues with the next listed calculation. 

1. Wavelength reduction 

2. Kinetic reduction 

3. Group blank subtraction 

You can access the Reduction dialog box in several ways: by clicking the 
[Reduction] button in the tool bar of the active plate section, by choosing Reduction from the Plate 
menu, or by clicking the [Reduction] button in the Well Graph display. The appearance of the 
Reduction dialog box will be different depending on the type of read mode you have chosen, and the 
options you have chosen in the Instrument Settings dialog box. 

All of the read modes offer one or more predefined choices for reduction. The predefined reductions 
are described below under the appropriate read mode heading. In addition, with any read mode, you 
can create a custom reduction formula to better suit your needs. Since all custom reduction formulas 
are defined the same way, regardless of read mode, they are described together after the individual 
read mode sections. 

Endpoint 
Wavelength Combination 

The default reductions for Endpoint readings are !Lm1 and Custom when you read at a single 
wavelength. Additional wavelength combinations become available depending on the number of 
wavelengths chosen. You can choose Custom and create different reduction formulas. The 
wavelength combinations available in the drop-down menu show the correct format of the formulas 
that produce these reductions. 

Kinetic 
Wavelength Combination 

The default wavelength combination for Kinetic readings is !Lm1. Other selections depend on the 
number of wavelengths chosen (for example, if you will read at two wavelengths, choices default to 
!Lm1 and !Lm2, along with Custom). If you do not wish to use the default reduction, you can choose 
Custom and create a different reduction formula. 

Kinetic Limits 

The Limits settings for the display of Kinetic data are MaxRLU, MinRLU, Lag Time, and End Time. 
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� NOTE: The display of RLU values is shown relative to the first point measured for each well. Negative 
Kinetic values decrease with time, and limits should be set accordingly (below 0) to view negative Kinetic 
data. 
Limits define the data that will be viewed and included in data reduction, but do not affect data collection. If 
you alter a limit to show less data, you can always display the “hidden” data again by changing the limit. 

MaxRLU 
The limit for the maximum value you wish to report. Any values from the reading that are above this 
limit will not be shown and will be excluded from data reduction. The default is 20,000 for RLU. 

The MaxRLU reduction parameter can be used to exclude the non-linear portion of the reaction from 
data analysis. This type of data reduction is most useful in reactions where the initial portion of the 
data is linear. You might also adjust the End Time setting to remove a non-linear portion after a 
certain time point in the reaction. Using MaxRLU allows the use of the maximum number of linear 
points to calculate the slope of the line and, thus, to determine the rate for each well. 

 
Above: Different Reductions of the Same Data Using Different MaxRLU Points 
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Both of the Well Graphs shown above display different reductions of the same Kinetic data. In the 
figure on the top, the MaxRLU is set to 20,000 for the display of wells C4, D6, and E6. In the figure on 
the bottom, the MaxRLU has been reset to 10,000.Alternatively, you could leave the Maximum RLU 
and change the number of Vmax Points used to determine the slope of the line. 

MinRLU 
The limit for the minimum value you wish to report. Any values from the reading that are under this 
limit will not be shown and will be excluded from data reduction. The default is 0 RLU. To display 
negative Kinetics, the value should be set below 0 (zero).  

Lag Time 
Specifies how many initial data points are excluded from the calculation of Vmax Rate. Lag Time 
truncates the data used in the calculation. It does not prevent data from being collected. The Kinetic 
plots will not display the data collected prior to the set Lag Time. The value for Lag Time can be 
changed after the plate is read. The default is 0. 

 
Above: Different Lag Time Settings 
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In the figure on the top left, well C5 has a lag time: the data is not linear until approximately 80 
seconds after the start of data collection. Thus, the linear curve fit is not good and the slope of the line 
does not reflect the maximal rate. In the figure on the bottom right, a lag time of 80 seconds has been 
set and the linear curve fit for both wells is good, allowing the slope of the lines to reflect the maximal 
rate in each well. Alternatively, you could leave the Lag Time and decrease the number of Vmax 
Points used to determine the slope of the line. 

End Time 
This setting specifies the time at which you wish to stop showing data in the display. Any values 
occurring after this limit will not be reported in the display. The default setting is the total assay time. 
The value for end time may not be greater than the total assay time. 

Absolute Values 
This setting causes the plots shown in the data display to be drawn at their absolute RLU as opposed 
to the default (with the box unchecked) which offsets the first point to the (0,0) coordinate. Enabling 
Absolute Values may cause some data points that do not fall within the default limits for the plots to 
“disappear.” To see more data, yet still display absolute values, enlarge the limits for MinRLU and/or 
MaxRLU found in the Reduction dialog box. 

If you increase the MaxRLU setting to be at least as large as the largest luminescence value expected, 
most or all of the data plots should appear in the data display. In the Kinetic Reduction example 
shown above, if the MaxRLU value is increased from 10,000 to 20,000, the plots then appear as shown 
below. 

Kinetic Reduction 
Kinetic reductions are applied to the list of numbers (the value at each timepoint) after the 
wavelength combination formula is applied. Vmax per min and Vmax per sec reductions are 
available for all instruments that are capable of Kinetics; the default Kinetic reduction is Vmax (units 
per sec). Other reductions available from the pop-up menu are Time to Vmax, Onset Time, Time at 
Minimum, Time at Maximum, Time at 1/2 Maximum, Slope, Area Under Curve, or you can choose 
Custom and then create a different reduction formula. 

Vmax 

The maximum slope of the Kinetic plot of relative luminescence units versus time. The default value 
displayed is in relative luminescence units (RLU) per second. The rate is calculated with the use of 
 Vmax Points (see below) which determines the number of contiguous points over which Vmax is 
calculated. The number of Vmax Points defaults to the maximum taken during the reading. You can 
change this number in the Reduction dialog box. 

� NOTE: Vmax = Vmax/sec • 60,000 

A linear regression is performed to determine the slope of the line using the equation: 

   y = m*X + B 

where m is the slope of the line. 

The reaction rate is reported in RLU units/sec. 

Vmax Points 

This setting defines the maximum size of the line segment used to determine the slope of the line 
used in calculating the rate of the reaction. The default is the total number of points taken in the 
reading, with the data normalized to a starting point of 0,0 (as opposed to starting with the first time 
point). The first slope is calculated for a line drawn beginning at the first reading as defined by Lag 
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Time (described below) and ending at a total number of readings equal to the Vmax Points setting. 
The second and any subsequent slopes are calculated beginning at the second time point and ending 
at a total number of readings equal to Vmax Points. The steepest slope is reported as Vmax Rate. If 
the data plot displays fewer time points (data points) than the number of time points chosen for 
Vmax Points, then all of the time points will be used to determine the slope of the data. 

Using Vmax Points (Example) 

 Well 1 Well 2 Well 3 

Time points visible in 
the well (data plot) 25 10 2 

Number of Points Used for Data Analysis: 

Vmax Points set to 25/25 
(default) 25 10 2 

Vmax Points set to 5/25 
Overlapping 
5-point line 
segments* 

Overlapping 
5-point line 
segments* 

2 

* SoftMax Pro will perform a linear regression on as many overlapping 5-point line segments as possible in the 
analysis window. The slope will be determined for each line segment and then the steepest slope will be reported 
as the reaction rate. Thus, in well 2 of the example in the table above, the slope will be determined for line 
segments consisting of time points 1 to 5, 2 to 6, 3 to 7, 4 to 8, 5 to 9, and 6 to 10, and then the slope of the line 
segment with the steepest slope will be reported as the Vmax Rate. 

The progressive slope calculations are repeated until the last included data point is reached (as 
defined by the End Time or MaxRLU — see below). The maximum positive or negative slope is 
reported as Vmax (RLU/sec). Vmax Points can be set from 2 to the total number of points in the curve. 
The number of Vmax Points can be set before the plate is read and can be changed after the plate is 
read. The data display will update automatically each time. The Vmax Points setting does not affect 
data collection. 

� NOTE: The height of the Y axis in the raw data plots or plate display is controlled using MinRLU and 
MaxRLU. The default settings are: 
MinRLU = 0 
MaxRLU = 20,000 
The width of the X-axis in the raw data plots or plate display is controlled using Lag Time and End Time. 
If either the MaxRLU or End Time setting excludes points such that a total number of readings equal to 
Vmax Points cannot be used, then the maximum included points will be used. 

Time to Vmax 

This is an alternative method for analyzing non-linear Kinetic readings that reports the elapsed time 
until the maximum reaction rate is reached, rather than reporting the maximum rate itself. Used in 
conjunction with Vmax Points, Time to Vmax is the time to the midpoint of the line defined by Vmax 
Points and used to calculate Vmax. This elapsed time data is useful for applications including 
coagulation chemistry where the changing concentration of the reagents does not change Vmax, but 
rather will change the time at which the reaction reaches the maximum rate. 
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Onset Time 

This is another method for analyzing non-linear Kinetic readings. Onset Time reports the time 
required for a Kinetic reaction to change by a specified amount (onset RLU above the initial RLU 
reading for the well). This elapsed time data is useful for cascade reactions including clot formation 
(endotoxin testing, for example) or clot lysis applications where the change in reagent concentration 
does not affect the maximum optical density change but changes the time required for the reaction to 
reach completion. 

Time at Minimum 

This setting reports the time at the minimum RLU that falls within the reduction limits. 

Time at Maximum 

This setting reports the time at the maximum RLU that falls within the reduction limits. 

Time at 1/2 Maximum 

This setting reports the time at the half of the maximum RLU that falls within the reduction limits. To 
calculate this reduction, SoftMax Pro first determines the point (within the reduction limits) that has 
the maximum signal level (RLU). It then scans the plot from left to right until it finds two points 
having signals that bracket half of that value. A linear interpolation between these two points is used 
to estimate the Time at 1/2 Maximum. 

Slope 

This setting determines the slope of the combined plot (i.e., the slope of the line using linear 
regression after the wavelength combination reduction). This setting uses all visible timepoints in the 
reduction window. Slope is the same as Vmax Rate when Vmax Rate is set to the same number of 
points as the run (i.e., the default). Slope is not the same as Vmax Rate if you have modified the Vmax 
Points. 

Area Under Curve 

This reduction estimates the area under the curve as defined by the data plots in wells (within the 
reduction limits). The data plots are treated as a series of trapezoids with vertices at successive data 
points and at the X-axis coordinates of the data points. The areas defined by each of the trapezoids 
are then computed and summed. 

Absolute Values 

Choosing this option shows the raw data without any smoothing or other changes in the way it is 
graphed. 

Custom Reduction Formulas 

If the predefined reduction formulas do not meet your needs, you can create one or more different 
reduction formulas for any or all read modes. Choosing “Custom” from any of the menus or dialog 
boxes causes a Formula button to appear (an example of this button in an Endpoint Reduction dialog 
box is shown in the figure below). Custom reduction formulas may contain other operators and terms 
in addition to wavelengths. Clicking the Formula button opens the Calculation dialog box in which 
you can name and define a new reduction formula. 
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Above: Wavelength Calculation Dialog Box 

Examples of some formulas that might be used when combining multiple wavelengths in the 
Calculation dialog box are given in the table below. 
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Wavelength Reduction Formula Examples 

2 λ 3 λ 4 λ to 6 λ 

!Lm1 + !Lm2 !Lm1 + !Lm2 + !Lm3 !Lm1 + !Lm2 + ... + !Lmn 

!Lm1 - !Lm2 
(!Lm1 - !Lm3) / 
(!Lm2 - !Lm3) 

(!Lm1 - !Lm6) /(!Lm2 - !Lm5) / 
(!Lm3 - !Lm4) 

!Lm1 / !Lm2 !Lm1 / !Lm3 !Lm1 / !Lmn 

!Lm1 * !Lm2 !Lm1 * !Lm3 !Lm1 * !Lmn 

Log10(!Lm1/!Lm2) Log10(!Lm1/!Lm3) Log10(!Lm1/!Lmn) 

!Lmx/constant For example, Lm1/1.44 

Average(!allvalues) 

This formula will average together the relative 
luminescence units for multiple readings at the same 
wavelength (for example, if you read the well six times 
at a single wavelength). 

Min(!allvalues) 
This formula will report the minimum RLU recorded 
for multiple wavelength readings in each well. 

Max(!allvalues) 
This formula will report the maximum RLU recorded 
for multiple wavelength readings in each well. 

If(!Lmz<A,makeerr(118),(if(!Lmx
>B,makeerr(117),!Lm1))) 

This formula will report “low” for any well with an 
RLU less than A, “high” for any RLU greater than B, 
and the RLU of any well that lies between A and B. 

Custom reduction formulas utilizing mathematical operators or terms can be used to obtain specific 
types of data.  

The table below provides some examples of such formulas for Kinetic readings. 
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Kinetic Reduction Formula Examples 

Kinetic 

Vmaxcorr(!combinedplot, 
!vmaxpoints,!readinterval) 

Reports Vmax correlation coefficient for plots in all 96 
wells. 

Vmax(Delta(!combinedplot), 
!vmaxpoints,!readinterval) 

Will report the Vmax Rate of the delta between each time 
point. 

Nthitem(!Lm1,X) 
Will report the RLU at item X in the list of readings. For 
example, if you have a Kinetic run with 20 time points and 
X is 10, it will report the RLU of the 10th time point.  

For a list of accessors and operators that may be used in custom reduction formulas, see the Formula 
Reference Guide. 

When you finish your entry in the Calculation dialog box and click [OK], the formula you have 
entered then appears to the right of the word “Custom” and becomes the default selection for the 
Custom option. You may subsequently edit this formula or enter a new one by clicking the Formula 
button again. 

Recalculation Options 
By default, SoftMax Pro performs continuous recalculation of the data when you read plates, create 
or change formulas, and so on. At certain times, it would be useful to disable the recalculation feature 
so that you can make alterations to the experiment without waiting for individual recalculations to be 
completed. Two commands are available in the Edit menu that allow you to modify the way in which 
SoftMax Pro performs recalculation: Suspend Recalculation and Recalculate Now (  =; [CTRL]+[=]). 

Choosing Suspend Recalculation disables the automatic recalculation feature of the program and 
places a checkmark to the left of the command in the menu to indicate that it has been selected. While 
this function is enabled, no recalculation will occur, regardless of what you may change, add, or 
delete from the experiment. This is especially useful when creating or changing column formulas 
within Group sections, for example, as it can speed up the process greatly. 

When recalculation has been suspended, you may wish to see the results of the changes you have 
made but may still not wish to enable continuous recalculation. Choosing Recalculate Now (  =; 
[CTRL]+[=]) from the Edit menu will cause SoftMax Pro to examine all elements of the experiment 
and perform complete recalculation of the data. Choosing this command does not enable continuous 
recalculation but simply causes the program to perform recalculation once. 

To return to continuous recalculation, choose Suspend Recalculation again. The checkmark next to 
the command will disappear, indicating that the function is no longer in use. 

� NOTE: Recalculate Now (  =; [CTRL]+[=]) can be used to see intermediate results during long Kinetic 
readings. At any time, you can choose Suspend Recalculation to delay calculations until a later time. 



 Chapter 6: Data Analysis: LMax II and LMax II384 

SoftMax Pro User’s Manual  469 

Displaying Data in Group, Graph, and Notes Sections 
Group Sections 

The manner in which data is displayed in a Group section depends on the type of reading that was 
performed but can be customized by choices made in the data display, the reduction settings, and the 
Edit menu. 

Default displays for Group sections are shown automatically unless you choose a different display 
option. 

The particular font to be used in a Group section table, as well as its size and style, can be changed by 
first selecting one or more columns in the Group section table and then choosing the Text command 
from the Edit menu and making the desired choices from the dialog box that appears. 

Settings from the Plate Section Affect Data Display in Group Section Tables 

Reduction options in the Plate section allow you to display the raw data received from the instrument 
in a reduced (analyzed) form. Which reduction options are available depend on the read mode used 
and reduction settings chosen. Reduced number from the Plate section is displayed in the Values 
column of the Group section tables by default. 

Reduction settings do not affect the raw data but simply cause it to be displayed differently. You can 
change reduction settings without affecting the raw data from the plate reading in any way. 

Custom reduction formulas require the use of accessors and operators that are understood by 
SoftMax Pro. A list of these accessors and operators is given at the end of this chapter. 

Resizing and Hiding Columns 
The columns in a Group section can be resized in several ways. One of the simplest is to drag the line 
dividing the columns to another position (moving it horizontally). When you point to a line between 
columns, the cursor changes to a double arrow with a vertical line through it, showing that it is ready 
to move left or right (see the figure below). 

 
Reducing Column Size and Hiding Columns 

You can reduce a column to a size smaller than the width of its title, in which case the title will not be 
completely visible. You can also hide a column by reducing its size completely (drag one edge of the 
column on top of the other) or by selecting that column and choosing Hide from the Group menu. 

� NOTE: If you hide a column in this way and then wish to view it again, use the Show All command in the 
Group menu. All columns that were hidden will again be visible. There is no way to show only one 
hidden column. 
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Enlarging Column Size 

You can enlarge the width of columns to any size. Increasing the size of columns may make the width 
of the Group section increase beyond the page width boundary. If this occurs, the columns will 
“disappear” off the edge of the screen but are really still there. To bring these columns back into 
view, reduce the width of the columns that are still visible until the others reappear. 

 

� NOTE: If the width of a section extends beyond the page width boundary, the portion that is not visible 
will not be printed. 

 To size two or more columns to the same width, highlight those columns and then drag one of the 
dividing lines to the desired width. The width of all highlighted columns will be sized the same as 
the column to the left of the dividing line you are moving. 

Columns can also be resized to the minimum amount of space required by choosing Autosize from 
the Group menu. By highlighting the entire table or individual columns and then choosing Autosize, 
the amount of space each column requires will be reduced to the minimum size required by the 
largest piece of text in that column. 

Double-clicking the line dividing two columns causes the single column to the left of the divider to be 
sized according to the largest amount of text in that column. 

Showing and Editing Existing Column Formulas 
When group sections are first created, the formulas used to calculate the data are not displayed. 

These formulas can be shown (until you choose to hide them again) by making a Group section active 
and then choosing Show Formulas from the Group menu. (Note that the command in the menu 
changes to Hide Formulas after they are shown.) 

 
Choosing this option causes an additional row to appear (beneath the heading for each column) 
which shows the formula used to calculate the data in each column. To see formulas briefly, hold 
down the shift and control ([CTRL]) keys. 



 Chapter 6: Data Analysis: LMax II and LMax II384 

SoftMax Pro User’s Manual  471 

 
Modifying Column Formulas 

To modify the formula for an existing column, double-click the column or click the column once and 
then click the formula button in the section tool bar. The dialog box associated with the column 
formula will open, allowing you to edit the formula (and the name) associated with the column. 

 
For a complete discussion, see the Formula Reference Guide. 
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Adding Columns 
You can add a new column to a Group section by clicking the Create Column button in the Group 
Tool Bar or by choosing Create Column from the Group menu which will open the Column Formula 
dialog box. 

 
In the Column Formula dialog box, you may change the name of the new column (from the default 
which simply lists the column by number) to reflect the data that it will contain. 

If no existing column is selected when you click the Create Column button, the new column will be 
created to the right of all existing ones. If you select (highlight) a column and then add a new column, 
it will be positioned to the right of the one you selected. If the table is currently as wide as the sheet of 
paper specified in Page Setup when a new column is added, the columns will “disappear” off the 
right side of the window but are still there. To bring these columns back into view, resize visible 
columns smaller. 

New columns can contain references to other columns, both in the current section or in a different 
one within the same experiment. For example, if you wanted to subtract the mean values in one 
group from those in another, you could create a new column (in either group) to do this. If the two 
groups were named “Group 1” and “Group 2,” for example, and both groups contained a column 
entitled “Mean,” you could create a column within “Group 1” that would subtract the mean values in 
“Group 2” from those in “Group 1.” The column formula needed to do this would be: 

Mean-Mean@Group2 

Numerous possibilities exist for creating and editing column formulas to display the data you desire. 
For a complete discussion of formulas and operators, see the accompanying Formula Reference Guide. 

� NOTE: To delete a column, highlight it and press the [Delete] key or choose Cut from the Edit menu. 

Adding or Editing a Summary in a Group Section 
To add a summary at the bottom of a Group section, click the Create Summary button in the tool bar 
or choose Create Summary from the Group menu. The Calculation dialog box will appear, allowing 
you to change the name of the summary or hide the name, if desired, as well as to enter a description 
of the summary and to create a formula for it (including the number of decimal places for the result, 
if appropriate). Double-clicking an existing summary causes the same dialog box to appear, allowing 
you to modify summary information. 
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Information entered in this dialog box will be placed at the bottom of the Group section as follows: 

Name = Description     Formula Result 

You can click the checkbox next to Hide Name which will change the way the summary appears to 
show: 

Description     Formula Result 

� NOTE: The name assigned to a summary is important since you can reference the summary by name in 
other formulas (building one upon another). The summary name can be referenced even if it is hidden. 

If you wish to see the formulas associated with summaries without opening the Calculation dialog 
box for each one, you can choose Show Formulas from the Group menu. To see these formulas only 
briefly, hold down the shift and control ([CTRL]) keys while that Group section is active. The 
summaries will “expand” to show the complete formula along with the title. They will resume their 
previous appearance when you release the [Option] key. 

Summaries in Group sections can be moved horizontally, if desired, by dragging them left or right. 
When you position the pointer over a Group summary, the cursor changes to show a double-headed 
horizontal arrow. Clicking once highlights the summary; dragging and then releasing the summary 
leaves it in the position where the mouse button was released. 

To have summaries line up with particular columns in the Group, hold down the control ([CTRL]) 
key while dragging the summary. When you release the control ([CTRL]) key, the summary will 
“snap back” so that it begins flush to the left side of the column under which it was released. Each 
summary can be positioned in a different place in the Group section, if desired. 

� NOTE: To delete a summary, highlight it and press the [Delete] key or choose Cut from the Edit menu. A 
summary can also be copied or cut and then pasted in a different location. 

You can also change the format of the text in Group section columns and/or summaries. By selecting 
the column or summary and then choosing Edit and then Text Style ([CTRL]+[T]), you can change the 
font, size, and/or style of the text. 

Notes Sections 
The Notes section allows you to enter text describing the experiment and one or more summary lines 
that contain formulas. To create a summary, click the Create Summary button in the tool bar or 
choose Create Summary... from the Notes menu. 

The Calculation dialog box that appears allows you to enter a description of the summary, accept the 
default title for the summary, change it or hide it, and enter a formula (including the number of 
decimal places the reduction should show, if appropriate). For detailed information regarding 
operators and accessors, see the Formula Reference Guide. 
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If you wish to see the formulas associated with the summaries without calling up the Calculation 
dialog box for each one, you can choose Show Formulas from the Notes menu. To see these formulas 
only briefly, hold down the shift and control ([CTRL]) keys while that Notes section is active. The 
summaries will “expand” to show the complete formula along with the other summary information. 
They will resume their previous appearance when you release the [Option] key. 

Graph Section 
The Plot#X Dialog Box 

Whenever you create a new Graph section or add a plot to an existing graph, the Plot#X dialog box 
opens automatically (“X” starts with “1” and increments each time a new plot is added to a Graph 
section). In this dialog box, you can rename the plot, assign specific information to be plotted on the 
X- and Y- axes, and choose which icon and color will be used. If you rename the plot, the title of the 
dialog box will change to show the new plot name. 

All groups that have been created or assigned within the file are listed on the left side of the “Source:” 
field in the Plot#X dialog box. The first group in the file is automatically selected. Other groups can be 
selected by highlighting them. When a group is selected, the pull-down menus in the X-axis and Y-
axis subfields change to show the group columns that are available for graphing. Group columns can 
be assigned for both the values to be plotted and any error bars to be included for both axes. 

Summaries and user-defined formulas can also be graphed. Pushing the  button for either the X-
axis or Y-axis opens a dialog box which allows you to enter formulas. To plot a summary, enter the 
summary name in this dialog box. Formulas can be plotted for comparison with other data. For 
example, if the data is assumed to follow a specific model, the model formula can be entered as a plot 
and then the data can be chosen for another plot within the same graph. You can also use this feature 
to plot Kinetic data in Graph sections. For example, to plot Kinetic data from well A1 in a Graph 
section, you can enter the formula !A1Lm1 for the Y-Axis and the !TimeRun accessor for the X-axis. 
The entered formulas are also shown in the “Source:” field of this dialog box. 

The size, color, and style of the icon used for a plot can be selected on the right side of this dialog box. 
Four sizes, nine colors, and nine styles are available from drop-down menus. 

The Graph Options Dialog Box 

The Graph Options dialog box allows you to change the name of the Graph section, change the height 
of a graph, select the type of graph to be displayed, change the fonts used on the title, legend, and 
axes, access the Plot#X dialog box for editing plots, entering new plots, and/or to delete plots. This 
dialog box is opened after pressing [OK] in the Plot#X dialog box when a new Graph section is being 

created. This dialog can also be accessed by pressing the Graph Options button  on the Graph 
section toolbar or by choosing Graph Options from the Graph menu. 

Scatter plots, cluster bar charts and stack bar charts can be created. Error bars can be used with all 
graph types. You can also choose whether to connect the points and/or plot the symbols in the graph. 

Each of the plots that have been created for this Graph section are listed in the “Plots:” field of this 
dialog box. Choosing any of these plots provides an indication of the data to be used for the X- and Y- 
axis data points and error bars on the right side of this field. Plots can be deleted by highlighting the 
plot name and clicking the [Delete] button. Clicking the [New] button opens the Plot#X dialog box, 
allowing you to create a new plot for the graph. Existing plots can be edited by highlighting the plot 
name and clicking the [Edit] button which opens the Plot#X dialog box containing all the information 
for the selected plot. 
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When creating a new Graph section, the Graph Options dialog box opens after choosing either [OK] 
or [Cancel] in the Plot#X dialog. The new Graph section is not created, however, until you click [OK] 
in the Graph Options dialog box. 

 
Creating Multiple Plots 

SoftMax Pro makes it possible to create multiple plots within a graph. Each plot will represent data 
from a group that has been created in the Template Editor or data from a summary or custom 
formula. You may plot data from any group or from several groups on a graph, even if the groups are 
in separate experiments. It is possible, for example, to plot multiple dilution series of an unknown, to 
graph together a series of patient samples, or to plot several controls that have been run over time. 

Following is a summary of the steps required to create multiple plots within a single graph, after 
which is an example that provides more detail. 

Multiple Plots Step Summary 

 Create all required groups in the Template Editor. 

 Read the microplate to obtain data. 

 Create a graph section. 

 Add plots to the graph and choose the group and the X and Y values to be shown for each plot. 

Example of Creating Multiple Plots 

This example shows how three groups, all of which are Standards, were plotted on the same graph.  

1. Groups are created in the Template Editor. For this example, four groups are created: three for 
standards (Standard1, Standard2, and Standard3) and one for Unknowns (Unknown1). 
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Standards and Unknowns Groups Created 

2. The associated Group sections are created using the Standards column format which, by default, 
generates columns for concentration and optical density values. The example below shows the 
Group section for Standard2. 

 
Standard2 Group Section 

3. A new Graph section is created by selecting New Graph from the Experiment menu. This causes 
the Plots dialog box to open automatically. The default name for the first plot, “Plot#1,” is then 
changed (by typing a new name over it) to “Standard#1.” Clicking [OK] opens the Graph 
Options dialog box which allows you to choose the graph type, modify the fonts used for the 
graph, and so on. Choices should be made as follows: Standard1 for the group to be plotted, the 
concentration of Standard1 for the X-axis, and values of Standard1 for the Y-axis. No error bars 
are added. 
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Graph Options Dialog Box with Plot Name Changed to “Standard#1” 

4. A second plot is added to this graph by clicking the [New] button in the Graph Options dialog 
box. After clicking [New], a dialog labeled Plot #2 is opened. The second plot name defaults to 
“Plot#1,” which now shows beneath the first plot. Change this second plot name to 
“Standard#2,” choose Standard2 for the group, and change the X- and Y-axes to show 
concentration and values, respectively, for Standard2. 

 
Graph Options Dialog Box with Second Plot Added for Standard#2 

5. This process is repeated for a third plot, labeled “Standard#3.” 

6. Now that all plots information is complete, clicking [OK] in the Graph Option dialog box will 
close it, and the resulting graph will show the three plots created. 
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Graph Displaying Three Standards Plots 

You can add as many plots to a graph as you wish, and these can be of the same or different types of 
groups. If you create a graph and later wish to add one or more plots to it, simply click the [Graph 
Options] button on the Graph section Tool Bar and then click the [New] button. This will reopen the 
Plots dialog box, allowing you to add or modify the plot information. 

Error Bars 

When data is displayed as a scatter or bar graph, you can choose to display error bars for the plot of 
the data for the X- and/or Y-axis. Error bars are lines that extend beyond a plotted value in either or 
both directions and graphically represent some amount of error in plotted data. 

  
Plot Showing Error Bars 

Choices for displaying error bars relative to a particular axis are the same as those available for 
displaying data on that axis: any column from that group that contains numerical information (not 
columns with text). To display error bars, click and hold the box next to “Error Bars” in the Plot#X 
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dialog and drag to select one of the choices in the menu. To disable error bars, choose “No Error” for 
the X- and/or Y-axis. 

Error bars show both positive and negative error. Depending on the range settings for the graph, 
portions of the error bars may not be visible. 

Curve Fitting 

When you first create a graph of the data, it does not have a fit associated with it. The graph might 
appear something like this: 

 
Graph with No Fit 

You can fit any plot to one of nine curve-fitting algorithms: Linear, Semi-Log, Log-Log, Quadratic, 4-
Parameter (logistic), Log-Logit, Point-to-Point, Exponential, and Cubic Spline. These selections are 
shown in the Fits pop-up menu in the Graph section toolbar (click on the box next to “Fit”). 

Typically, a standard curve refers to the curve fitted to the plot of concentration versus mean value 
for the Standard group. 

Once you have selected a Fit type, SoftMax Pro determines the parameter values that best fit the data. 
The function with these parameters is then drawn on the graph. Ideally, the type of fit used should be 
determined by the underlying chemistry of the assay and could be set before data is read. 

NOTES: A good discussion of curve fitting appears in “Data Analysis and Quality Control of Assays: 
A Practical Primer” by R. P. Channing Rogers in Practical Immuno Assay, edited by Wilfrid R. Butt 
(published by Marcel Dekker, Inc., New York, 1984). 

When a fit is chosen, the Graph section is updated to show the coefficients describing the fit when 
applicable. These values are displayed in the legend at the bottom of the graph. Figures below show 
the same graph with the different fit algorithms applied. Note that the legend information changes 
(along with the formula for the fit) at the bottom of each Graph section for each different fit. 

� NOTE: All plots on a graph must have the same type of fit. 

When a curve fit is chosen, the values for the coefficients of the equation (A, B, C, etc.) will be shown 
as will the square of the correlation coefficient (R^2). The correlation coefficient describes how well a 
change in x values correlates with a change in the y values. The R^2 value should only be used for 
curve fits having linear axes. 
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Linear 

The linear function fits the best straight line to the data. The equation for this fit has the form of: 

Y = A + (B * X) 

where A is the y-intercept of the line and B is the slope. A linear fit should be used whenever the 
values appear to lie on or scattered around a straight line. 

This equation is shown on the screen as: 

y = A + Bx 

A linear fit should be used whenever the standard values appear to lie on or are scattered around a 
straight line. The figure below shows an example of a linear fit. 

 
Graph with Linear Fit 

Semi-Log 

The semi-log function fits the best straight line to a set of data for log(X) plotted against Y. The 
resulting curve displayed will be a straight line with the X-axis drawn in logarithmic scale. The 
equation for a semi-log fit is: 

Y = A + [B * log10(X)] 

and is shown on the screen as: 

y = A + B * log(x) 

where A is the y-intercept of the line and B is the slope (note: log in this equation is the common or 
base-10 logarithm). 
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Graph with Semi-Log Fit 

Log-Log 

The log-log function fits the best straight line to the set of data which consists of the logarithm of the 
readings on the Y-axis (the response) and the logarithm of the dose on the X-axis. The resulting 
display will be a straight line with both axes drawn in logarithmic scale. The equation for the log-log 
fit is: 

log10(Y) = A + [B * log10(X)] 

and is shown on the screen as: 

log(y) = A + B * log(x) 

where A is the log10Y-intercept of the line for log10(X) = 0 and B is the slope (note: log in this 
equation is the common or base-10 logarithm). 

 
Graph with Log-Log Fit 
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Quadratic 

The quadratic function fits the best parabola to the data. The parabola is a curved line based on the 
equation: 

y = A + (B * x) + (C * x2) 

which is shown on the screen as: 

y = A + B*x + C*x^2 

where A is the intercept, B is the slope of the curve at the intercept, and C is the measure of the 
curvature of the parabola. 

The quadratic fit is most appropriate when the standard curve has a tendency to curve up or down. 
An example of a quadratic fit is shown below. 

 
Graph with Quadratic Fit 

4-Parameter Logistic and Log-Logit 

If the standard curve has a sigmoidal shape when plotted on the semi-log axes, it may be appropriate 
to use either the log-logit or 4-parameter fit. Both fits are based on the equation 

 
where D is the Y-value corresponding to the asymptote (i.e., the flat part of the curve) at high values 
of the X-axis and A is the Y-value corresponding to the asymptote at low values of the X-axis. The 
coefficient C is the X-value corresponding to the midpoint between A and D. The coefficient B 
describes how rapidly the curve makes its transition from the asymptotes in the center of the curve. A 
large value of B describes a sharper transition. Typically, B has a magnitude of about 1. 

Both the log-logit and 4-parameter equations are shown on the screen as: 

y = (A - D) / (1 + (x / C) ^ B) + D 
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Graph with 4-Parameter Fit 

 
Graph with Log-Logit Fit 

Some publications show the log-logit equation in another form: 

 
where 

 
A different algebraic expression of these is: 
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The difference between the log-logit fit and the 4-parameter fit are in the way the coefficients A and D 
are calculated. For the log-logit method, the standard values for the lowest and highest values of x are 
used. The corresponding y values are assigned to A and D, respectively. Based on these fixed values 
for A and D, the algorithm then computes values for B and C. This technique works well if there are 
standard points along the upper and lower asymptotes. If this is not true, the log-logit fit should be 
avoided in favor of the 4-parameter logistic. 

� NOTE: The curve-fitting algorithm for the 4-parameter equation was based on the Levenberg-Marquardt 
Method. Discussion of this method can be found in Numerical Recipes in C: The Art of Scientific Computing 
by William H. Press, Brian P. Flannery, Saul A Teukolski, and William T. Vetterling, published by 
Cambridge University Press, New York, 1988. 

Point-to-Point 

A linear equation is fit to each pair of data points. Fit parameters are not given. The point-to-point 
curve fit is a linear fit composed of pieces that assume a linear relationship between each pair of data 
points. The line segment defined by each pair is used to interpolate data between those points. Since 
there are multiple line segments, fit parameters are not shown on the graph. 

 
Graph with Point-to-Point Fit 

Cubic Spline 

This curve fit generates a fit to a cubic equation between each pair of data points. The general form of 
a cubic equation is: 

y = A + Bx + Cx2 + Dx3 

The equations are computed with the requirement that the first and second derivatives of the 
equations are continuous throughout the range of the data. As multiple curve fits are performed with 
this routine, fit parameters are not shown with the graph. 
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Graph with Cubic Spline Fit 

Exponential 

The exponential function used to generate this curve fit is: 

y = A + B * (1 - exp^(-x / C)) 

 
Graph with Exponential Fit 

� NOTE: SoftMax Pro does not plot samples with descriptor values of zero (0) on a log axis. Curve fits 
affected by this are the semi-log, log-log, log-logit, and 4-parameter curve fits. 

Minimum Number of Standards 

The number of standards used in a standard curve depends on the particular curve fit selected and 
on the judgment of the operator. The table below gives the minimum number of standards required 
mathematically by each of the curve fitting algorithms. 
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Minimum Number of Standards Required for Curve Fits 

Curve Minimum Number of Standards 

Linear 2 

Quadratic 3 

Semi-Log 2 

Log-Log 2 

Log-Logit 4 

4-Parameter 4 

Point-to-Point 2 

Exponential 3 

Cubic Spline 4 
For optimal results, you should always exceed the minimum number of standards required for any 
given fit. 

There are other requirements on the standards for the log-logit and 4-parameter logistic curves. The 
fits for the 4-parameter logistic curve are based on the assumption that the curve has a high and a low 
asymptote and a certain “steepness” for the linear portion around the inflection point between the 
asymptotes. If a sufficient number of points do not define the inflection point and the asymptotes, 
you will receive a “no fit” error message or an inappropriate fit. For best results, make sure that the 4-
parameter fit is appropriate for your assay and that the entire range of the assay is represented in 
your standards. 

If your standards do not clearly define both a high and low asymptote, the spline fit may be more 
appropriate for your assay. 

Judging a Good Curve Fit 

The correlation coefficient is also known as the goodness of fit value because it shows how good a fit 
exists between the computer curve and the standard data points. It measures the degree to which the 
points fall on the computer curve and may give an indication as to what residuals are to be expected. 
The correlation coefficient is popularly known as R and is between -1 and 1, inclusive. When the data 
points lie on a perfectly straight line with negative slope, then R = -1. If the correlation coefficient is 
not suitably close to 1 or -1 (a perfect fit), you can simply apply one of the other types of curves 
without having to reread the plate.  

For nonlinear curve fits, SoftMax Pro performs transformations that cause the curve to become more 
linear. The correlation coefficients are derived from that transformed data. Because of this, you 
should be cautious about using correlation coefficients as an indicator of goodness of fit. Do not let 
this single value for goodness of fit sway your intuition about which fit is best. Some curve fits may 
seemingly give a good fit (e.g., fit values close to 1) but, when inspected by eye, show a poor fit along 
a major portion of the plot. 

Graph Options    

Graphs can be customized further through the Graph Options dialog box which is accessed by 

choosing Graph Type... from the Graph menu or by clicking the Graph button ( ) in the section 
tool bar. 
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Graph Options Dialog Box 

The default options are shown above, but you can alter these as desired: you may change the font and 
type size used for the title, legend, and/or axes of the graph, and you can choose the color and type of 
symbol used on a scatter graph to show the plot. The graphs shown in preceding Figures reflect the 
default graph options. Connecting the points of a scatter graph can be useful in determining the 
closeness of the fit. The figure below shows a scatter graph with points connected compared to a 
linear fit. 

� NOTE: The Connect Points option connects the points in order of appearance by sample name—not the 
appearance of points from left to right on the graph. 

 
Scatter Graph with Points Connected (Linear Fit Applied) 
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Other options in this dialog box allow you to plot the data as a bar graph with data shown in clusters 
or stacked. The figure below shows both of these bar graph options. 

 
Bar Graphs—Cluster and Stack 

� NOTE: Bar graph options for multiple plot graphs are only available when each plot contains the same 
number of data points and has matching X-axis coordinates. 

� NOTE: When choosing the Connect Points option, the order in which points are connected is sample 
name dependent. 

Axes Options    

Double-clicking either graph axis, clicking the X-axis or Y-axis button in the Graph section toolbar, or 
selecting either X-axis... or Y-axis... from the Graph menu opens a dialog box concerning the 
configuration of that axis. The figure below shows the dialog box for the X-axis. 

 
X-Axis Dialog Box 

The default settings are shown in the Figure above. You can change these as desired for either or both 
axes. 
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Axis Settings 

Enabling the Auto-range option causes the graph to be drawn such that all data points are shown (by 
automatically adjusting the minimum and maximum range settings to encompass the data). You can 
disable the Auto-range function by clicking the checkbox or by changing either or both values for the 
Min and/or Max settings. 





  

  

Displaying and Analyzing Data: Gemini, Gemini XS, Gemini EM 

Introduction 
Initial display and reduction of the data received from the instrument is performed in the Plate 
section in which the data has been collected. Display and reduction parameters can be set up either 
prior to or after collecting data. The display and reduction parameters may be modified at any time. 

Data analysis and the display of analyzed data is also performed in the Group sections (created when 
wells are assigned to groups in the Template Editor) and the Graph section(s). 

Notes sections may be used in conjunction with any other section to provide text commentary and/or 
a summation of data through the use of summaries. Notes sections are used most commonly to 
provide an introduction to or summary of results for a data file. 

All data files have a minimum of one Plate section with data in it. Multiple Plate sections may be 
present. Most files will have a template and Group, Graph, and Notes sections. However, depending 
upon the particular assay and how you wish to report the data, only some of these sections may be 
(or need to be) present in every file. For example, some simple assays allow you to calculate 
concentration in the Plate sections. In such cases, Group and Graph sections are necessary only if you 
wish to display the data graphically. 

The following diagram shows the relationship between the different sections in SoftMax Pro: 

 

Initial Data Display and Reduction 

� NOTE: Not all settings or features will be available for all instruments. Available features will be based 
on the instrument connected to the computer or chosen in the preferences.  

The manner in which data is displayed in a Plate section depends on the type of reading that was 
performed but can be customized by choices made in the data display and reduction settings. Display 
options include: 

 Number or plot displays for raw RLU (relative luminescence units), depending on which was 
chosen as a read type, with or without reduced number. You also have the option to view raw 
data in 1000s (e.g., “20,000” would be shown as “20” to make numbers in wells more easily 
visible). 

� NOTE: The number format (use of commas or periods in numeric notation) chosen for the computer 
operating system is reflected in the way that SoftMax Pro displays data. 
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 Number, Plot, Threshold, Ranged, or Grayscale (with or without reduced number) 

 If you have chosen 384-well plates from the Instrument Settings, you can display the wells in 
different ways: Normal, Vertical, Rotated, Large, or Interleaved. 

Default displays are shown automatically unless you choose a different display option. 

Reduction options allow you to display the raw data received from the  instrument in a reduced 
(analyzed) form. Which reduction options are available depend on the read mode used; custom 
settings, using formulas you create, are available for all read modes. 

Reduction settings do not affect the raw data but simply cause it to be displayed differently, so you 
may change reduction settings without affecting the raw data in any way. 

Custom reduction formulas require the use of accessors and operators that are understood by 
SoftMax Pro. For a list of such accessors and operators and explanations of their functions see the 
Formula Reference Guide. 

The Data Display 
After a plate has been read, the information sent from the fluorescence instrument is shown in the 
data display in the active Plate section. The default display for data from Endpoint readings raw RLU 
numeric values. Data from Kinetic, Spectrum, or Well Scan readings is displayed in plots format (raw 
RLU values with respect to time or wavelength) and the display updates dynamically to show the 
data collected so far. If the instrument is reading more than one wavelength, plots for the different 
wavelengths are overlaid in each well. 

All choices except those defined in the Instrument Settings affect only the manner in which the data is 
displayed—the raw data is not changed—permitting you to optimize the display after data is 
collected. 

� NOTE: Data reduction changes the way in which data is displayed and also affects the values used in 
calculations within SoftMax Pro. While the raw values remain unchanged, calculations will use reduced 
values, if any, and are, therefore, affected by settings chosen in the Reduction dialog box.  

� NOTE: Data comes from the instrument to SoftMax Pro with four digits to the right of the decimal point. 
Only three of the four digits are displayed in the Plate section for Endpoint data, however: the fourth 
digit is rounded up or down (0.0045 rounds up to 0.005; 0.0044 rounds down to 0.004, for example). You 
can view all four digits of data, if desired, by displaying the raw values in a Group section table and 
increasing the number of decimal places showing. 
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The Display Dialog Box 

 Before or after a reading, you can click the [Display] button to open the Display dialog box 
which allows you to change the way the data is presented. Choices available in this dialog box 
depend on whether a section is currently active, which instrument is chosen in the Preferences or is 
connected to the computer, and which read mode you have chosen (for example, the choice for 
“Plots” is not shown if Endpoint mode is selected). The figures below show the default Display 
dialog boxes for the different read modes. 

The Display dialog box is divided into two parts (left and right): the default display, “Raw OD” or 
“Raw RFU/RLU” is shown to the left of a dividing line; the choices for reduced data displays are 
shown to the right of the dividing line. Note: data reduction itself is performed separately; settings 
here simply determine how the reduced data will be displayed in the data section. 

The dialog boxes below show the default display choices for the three modes (if applicable): 

 Raw fluorescence or luminescence values (numbers) for Endpoint; 

 The change in raw RFU/RLU values over time for Kinetic; 

 Raw RFU/RLU values for the range of wavelengths, displayed as a plot, for Spectrum; 

 Raw RFU/RLU values as shades of gray for Well Scan; 

 The change in raw RFU/RLU values over time 

 
Data in the Plate section is displayed in a grid array (microplate format). With all plates other than 
384-well plates, the display is always shown as a standard microplate, with well A1 in the top left 
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corner. If you are reading 384-well plates, additional display options can be chosen to make the 
display of data more clear: 

 Normal: shows the data in standard left-to-right format, with well A1 in the upper left corner. 
Columns 1 through 24 are along the top and rows A through P are shown from top to bottom. 
The wells are smaller and data is shown with fewer digits (less precision). 

 Vertical: the plate is shown in the same orientation as Normal except that columns 1 through 12 
(all rows) are shown above columns 13 through 24 (all rows). 

 Rotated: Same as the Normal view except that it is rotated 90 degrees clockwise (well A1 is in 
the upper right corner). 

 Large: Same as the Normal view except larger. This display can be seen in its entirety only if you 
have the page size set for legal paper (8.5 x 14 inches) in landscape orientation (set this in Page 
Setup or Preferences under the File menu). In the example in the figure above, the display is 
shown as it appears if you do not change the page size from letter-size to legal. 

 Interleaved: In this display, the wells are shown in a format that “skips” every other well as 
follows: all odd columns and rows begin in the upper left corner of the plate display and are 
followed by all even columns and rows. So well A1 is still in the upper left corner, but it is 
followed horizontally by well A3, A5, ... A23, A2, A4, etc., and vertically by well C1, E1, ... O1, 
B1, D1, etc. This display is most useful when the 384-well plate is composed of 4 daughter plates 
of 96 wells each. 
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Above: Example Plate Sections. Choices for a 384-well plate display are shown:  

Normal, Vertical, Rotated, Large, and Interleaved. 

The figure below shows the default displays for Endpoint, Kinetic, and Spectrum modes. The default 
display for Endpoint mode is the raw fluorescence/luminescence. For Kinetic and Spectrum modes, 
the default display is raw RLU shown in plot format: RLU vs. time for Kinetic and RLU vs. 
wavelength for Spectrum scans. Well scan data defaults to a display as shades of gray. 
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Reduced Number 

The reduced number is based on the settings defined in the Reduction dialog box. It is a combination 
of plate blank subtraction in the Plate section, wavelength reduction, and either a Spectrum or Well 
scan, or a Kinetic reduction. The information acquired from the instrument is reduced to a single 
number or value. The reduced number will be reported in the Group section when a template has 
been defined. 

To view by reduced number alone, select the Number option (the first choice to the right of the 
default, just after the dividing line); to see a reduced number as well as another type of display, click 
the box next to the option that says “With reduced number” in the lower left of the dialog box to 
enable it. Changing the reduction parameters after choosing a reduced data display mode will cause 
the display to update accordingly. More information about reduction formulas and how to customize 
them follows later in this chapter.  

Threshold, Ranged, and Gray Scale 
To display Threshold, Ranged, or Gray Scale data, high and low values must be entered. When you 
choose one of these display options, SoftMax Pro provides default values for the high and low limits 
by means of an autoranging function (encompassing all the data from lowest to highest value). You 
can change the high and low limits by highlighting the existing value and entering a new value. An 
example of the Display dialog box for a Kinetic reading (Plate section) with the Threshold display 
option chosen is shown below. 



 Chapter 6: Data Analysis: Gemini, Gemini XS, Gemini EM 

SoftMax Pro User’s Manual  497 

 
Threshold 

The Threshold display shows the raw data as a plus (+) for values above the high limit, an asterisk (*) 
for values within the limits, and a minus (-) for values below the low limit. The figure below shows a 
Kinetic reading displayed using the Threshold option along with the reduced number. 

 
Ranged 

When the Ranged display is chosen, raw data that falls between the high and low limits is assigned 
proportionally to integer values from 0 through 9. Values above the high limit are displayed as a 
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plus (+) and values below the low limit are displayed as a minus (-). The figure below shows reduced 
Kinetic data displayed in Ranged format. 

 
Gray Scale 

The Gray Scale option presents the raw data in eight shades of gray, changing from light (for values 
less than or equal to the low limit) to dark (for values greater than or equal to the high limit). The 
figure below shows reduced Endpoint data displayed as Gray Scale. 
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Graphing Wells 

You can enlarge the display of the wells shown with Kinetic, Spectrum, or Well Scan modes to get 
a close-up view of the data. This is done by either double-clicking the particular well in the data 
display or by selecting the well and then clicking the Well Graph button in the Plate Section Tool Bar.  

Well Graphs 
Well Graphs plot the data for the individual wells in a microplate and show the well ID and 
reduction information, including the goodness of fit (R^2 value), if appropriate.  

Positioning the cursor within a Well Graph shows X and Y values for the cursor location, allowing 
you to determine more precisely the location of data points. 

Well Scan Well Graphs 
Well Graphs in Well Scan mode default to displaying raw data in a grayscale plot. The manner in 
which the data is displayed in a Well Graph for a Well Scan depends on the reduction options that 
have been chosen, the display options (raw or reduced, for example), the number of points read, and 
whether the Well Graph is scaled to the data or to the limits of the entire plate. 

Well Graph Options 
Along the bottom of each Well Graph dialog box are buttons that perform the following functions: 

 [Print] 
Opens the Print dialog box. 

 [Reduction] 
Opens the Reduction dialog box. 
By default, the ranges on the enlarged plot are set to the limits defined in the Reduction dialog 
box, and the information included near the bottom of the window is based on the reduction 
settings currently in use. You may change these settings (wavelength combination and type of 
reduction used, minimum and maximum value limits, lag time and end time, and number of 
Vmax Points). More information about the reduction options can be found later in this chapter. 

� NOTE: Changes to the reduction settings made within well graphs will be applied to all wells in the Plate 
section. When viewing Raw data, you can scale the graph to see data outside the reduction limits [line(s) 
are included on the graph indicating the limits and the area outside of them will be shaded slightly]. This 
view should assist you in determining the best limits for the reduced data. 

Show Raw/Show Reduced Button 

 This button toggles the Well Graph between views of raw and reduced data. When the Well Graph is 
opened, the initial view depends on the Display settings for the Plate section. If raw data is being 
displayed in the Plate, the initial view in the Well Graph will be raw data and the button will be set to 
“Show Reduced.” If reduced data is being displayed in the Plate section, the initial view in the Well 
Graph will be reduced data and the button will be set to “Show Raw.” 

Scale to Data/Scale to Limits Button 

This button toggles between a view of the data within the reduction limits and a view of the entire 
data set. Switching between these views helps to visualize how the limit settings affect data 
reduction. If raw data is being viewed in the Plate section, the display in the Well Graph is set 
initially to show the plot scaled to the reduction limits. If reduced data is being viewed in the Plate 
section, the Well Graph display is set initially to show the plot scaled to the data. 
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� NOTE: If you are viewing raw data and click the Scale to Data or Scale to Limits button, only the display 
of raw data in the Well Graph will be affected (the button will not affect the view of reduced data). The 
same is true if you click this button while viewing reduced data. To produce comparable scaling of both 
raw and reduced displays, this button must be set to either Scale to Limits or Scale to Data for both raw 
and reduced views of the Well Graph. 

Graph Options button 

Opens the Well Graph Options dialog box which allows you enable or disable connected points or 
plotted symbols the graph. 

 

X-Axis Settings button  

Y-Axis Settings button  

Opens the Well Graph Axis Settings dialog box for the particular axis, allowing you to set Auto 
Range parameters, choose the minimum and maximum values for the selected axis, cause the axis to 
be auto-ranged, add or remove gridlines, and add or remove axis tick marks. When a Well Graph is 
opened, the default settings are to show the reduction limits for that axis with Auto Ranging off and 
gridlines and tick marks selected. Only the Well Graph being viewed is affected by changes in these 
dialog boxes. 

 [Done] 
Closes the Well Graph dialog box. 

 
Above: Well Graph for a Single Kinetic Microplate Well (Raw Data) 
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Multiple wells from the same Plate section can be graphed together in one enlarged window. Select 
the well(s) in the data display (hold the [Shift] key if you are selecting non-contiguous wells; you can 
drag across contiguous wells) and then click the Graph button or double-click in one of the selected 
wells. 

 
Above: Well Graph for Three Kinetic Wells of a Microplate (Raw Data) 

The choices you make for viewing the data in the Plate section also affect the way the Well Graph 
appears. The figures above show Well Graphs for raw data displays. If you display one of the reduced 
options (reduced number, Threshold, Ranged, or Gray Scale), the Well Graph will show the plot with 
an indicator of the reduced value and will include the word “Reduced” in the window title. 

Zoom Box 
You can enlarge the Well Graph even further by clicking the zoom box in the upper right-hand corner 
of the window (the center box of three in the upper right corner in Windows). Clicking the zoom box 
once will cause the window to fill the total display on your monitor; clicking the zoom box again will 
return the window to its previous size. 

Size Box 
Clicking and dragging the size box located in the lower-right corner (Macintosh) or clicking and 
dragging the lower right corner of the window (Windows) allows you to make the Well Graph any 
size desired. 

Printing the Well Graph 
You can print the Well Graph window, if desired, by clicking the [Print] button at the bottom left 
corner of the dialog box. 

� NOTE: If you enlarge the Well Graph to greater than 12 inches, the graph will not fit on an 8.5- by 11-inch 
page and the printout will be truncated. 

 Masking Wells    

If you find data in certain wells (outliers) that should be excluded from the calculations to be 
performed by data reduction, you can mask these wells. Select the well(s) to be masked and then click 
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the Mask button in the Plate Section Tool Bar or choose Mask... from the Plate menu. Masked wells 
are shown with an overlay of diagonal lines. 

The masking function can be used as a “what if?” tool. For example, you could suppress or enable 
certain functional groups within the experiment. Suppose you have included a group blank in the 
template and want to see the data with and without the blank. Masking the group blank wells would 
suppress the blanking function; unmasking them would enable it again. 

 
To remove masking from one or more wells, highlight the masked well(s) and click the Mask button 
in the Plate Section Tool Bar (toggles masking on and off) or choose Mask... from the Plate menu 
again. The diagonal lines covering those wells (and masking function) will be removed. 

Data Reduction 

 

� NOTE: Not all settings or features will be available for all instruments. Available features will be based 
on the instrument connected to the computer or chosen in the preferences.  

Raw data received from the fluorescence instruments can be displayed in an analyzed (or reduced) 
form. The reduction process within SoftMax Pro is based on formulas that reduce the raw data to 
show a single number for each well. Further analysis of this reduced number then takes place in the 
Group and Graph sections. 

SoftMax Pro performs calculations hierarchically when reducing the information collected from the 
instrument. Calculations in the Plate section are performed in the order shown below. If an option 
has either not been selected in the Instrument Settings dialog box, is not available for the instrument 
you are using, or has not been defined in the template and/or Reduction dialog box, SoftMax Pro 
starts/continues with the next listed calculation. 

1. Wavelength reduction 

2. Kinetic or Spectrum reduction 

3. Group blank subtraction 
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You can access the Reduction dialog box in several ways: by clicking the 
[Reduction] button in the tool bar of the active plate section, by choosing Reduction from the Plate 
menu, or by clicking the [Reduction] button in the Well Graph display. The appearance of the 
Reduction dialog box will be different depending on the type of read mode you have chosen, and the 
options you have chosen in the Instrument Settings dialog box. The figures below show the 
Reduction dialog boxes for a Plate section in Endpoint, Kinetic, Spectrum, and Well Scan modes, 
along with the default reductions for each of those modes. 

 
All of the read modes offer one or more predefined choices for reduction. The predefined reductions 
are described below under the appropriate read mode heading. In addition, with any read mode, you 
can create a custom reduction formula to better suit your needs. Since all custom reduction formulas 
are defined the same way, regardless of read mode, they are described together after the individual 
read mode sections. 
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Endpoint 
Wavelength Combination 

The default reductions for Endpoint readings are !Lm1 and Custom for all fluorescence instruments 
when you read at a single wavelength. Additional wavelength combinations become available 
depending on the number of wavelengths chosen. You can choose Custom and create different 
reduction formulas. The wavelength combinations available in the drop-down menu show the correct 
format of the formulas that produce these reductions. 

Kinetic 
Wavelength Combination 

The default wavelength combination for Kinetic readings is !Lm1. Other selections depend on the 
number of wavelengths chosen (for example, if you will read at two wavelengths, choices default to 
!Lm1 and !Lm2, along with Custom). If you do not wish to use the default reduction, you can choose 
Custom and create a different reduction formula. 

Kinetic Limits 

The Limits settings for the display of Kinetic data are MaxRLU, MinRLU, Lag Time, and End Time. 

� NOTE: The display of RFU/RLU values is shown relative to the first point measured for each well. 
Negative Kinetic values decrease with time, and limits should be set accordingly (below 0) to view 
negative Kinetic data.  
Limits define the data that will be viewed and included in data reduction, but do not affect data 
collection. If you alter a limit to show less data, you can always display the “hidden” data again by 
changing the limit. 

MaxRFU/MaxRLU 

The limit for the maximum value you wish to report. Any values from the reading thatare above this 
limit will not be shown and will be excluded from data reduction.The default is 20,000 for RFU/RLU. 

The MaxRFU/RLU reduction parameter can be used to exclude the non-linear portionof the reaction 
from data analysis. This type of data reduction is most useful inreactions where the initial portion of 
the data is linear. You might also adjustthe End Time setting to remove a non-linear portion after a 
certain time point inthe reaction. Using MaxRFU/RLU allows the use of the maximum number of 
linear pointsto calculate the slope of the line and, thus, to determine the rate for each well. 
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Above: Different Reductions of the Same Data Using Different MaxRFU Points 

Both of the Well Graphs shown above display different reductions of the same Kinetic data. In the 
figure on the top, the MaxRFU is set to 20,000 for the display of wells C4, D6, and E6. In the figure on 
the bottom, the MaxRFU has been reset to 10,000.Alternatively, you could leave the Maximum RFU 
and change the number of Vmax Points used to determine the slope of the line. 

MinRLU 

The limit for the minimum value you wish to report. Any values from the reading that are under this 
limit will not be shown and will be excluded from data reduction. The default is 0 RLU. To display 
negative Kinetics, the value should be set below 0 (zero).  

Lag Time 

Specifies how many initial data points are excluded from the calculation of Vmax Rate. Lag Time 
truncates the data used in the calculation. It does not prevent data from being collected. The Kinetic 
plots will not display the data collected prior to the set Lag Time. The value for Lag Time can be 
changed after the plate is read. The default is 0. 
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Above: Different Lag Time Settings 

In the figure on the top left, well C5 has a lag time: the data is not linear until approximately 80 
seconds after the start of data collection. Thus, the linear curve fit is not good and the slope of the line 
does not reflect the maximal rate. In the figure on the bottom right, a lag time of 80 seconds has been 
set and the linear curve fit for both wells is good, allowing the slope of the lines to reflect the maximal 
rate in each well. Alternatively, you could leave the Lag Time and decrease the number of Vmax 
Points used to determine the slope of the line. 

End Time 

This setting specifies the time at which you wish to stop showing data in the display. Any values 
occurring after this limit will not be reported in the display. The default setting is the total assay time. 
The value for end time may not be greater than the total assay time. 

Absolute Values 

This setting causes the plots shown in the data display to be drawn at their absolute RLU as opposed 
to the default (with the box unchecked) which offsets the first point to the (0,0) coordinate. Enabling 
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Absolute Values may cause some data points that do not fall within the default limits for the plots to 
“disappear.” 

 
Above: Kinetic Reduction with Absolute Values Enabled.  

Note that the limits in this example (MinRFU=0, MaxRFU=10,000) do not allow all of the data to be visible. 

To see more data, yet still display absolute values, enlarge the limits for MinRFU/RLU and/or 
MaxRFU/RLU found in the Reduction dialog box. 

 
If you increase the MaxRFU/RLU setting to be at least as large as the largest 
fluorescence/luminescence value expected, most or all of the data plots should appear in the data 
display. In the Kinetic Reduction example shown above, if the MaxRLU value is increased from 

10,000 to 20,000, the plots then appear as shown below. 
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Above: Kinetic Reduction with Absolute Values Enabled and MaxRLU Value Increased 

Kinetic Reduction 
Kinetic reductions are applied to the list of numbers (the value at each timepoint) after the 
wavelength combination formula is applied. Vmax per min and Vmax per sec reductions are 
available for all instruments that are capable of Kinetics; the default Kinetic reduction is Vmax (units 
per sec). Other reductions available from the pop-up menu are Time to Vmax, Onset Time, Time at 
Minimum, Time at Maximum, Time at 1/2 Maximum, Slope, Area Under Curve, or you can choose 
Custom and then create a different reduction formula. 

Vmax 

The maximum slope of the Kinetic plot of relative fluorescence/luminescence units versus time. The 
default value displayed is in relative luminescence units (RLU) per second. The rate is calculated with 
the use of  Vmax Points (see below) which determines the number of contiguous points over which 
Vmax is calculated. The number of Vmax Points defaults to the maximum taken during the reading 
for all instruments. You can change this number in the Reduction dialog box. 

� NOTE: Vmax = Vmax/sec • 60,000 

A linear regression is performed to determine the slope of the line using the equation: 

   y = m*X + B 

where m is the slope of the line. 

The reaction rate is reported in RLU units/sec. 

Vmax Points 

This setting defines the maximum size of the line segment used to determine the slope of the line 
used in calculating the rate of the reaction. The default is the total number of points taken in the 
reading, with the data normalized to a starting point of 0,0 (as opposed to starting with the first time 
point). The first slope is calculated for a line drawn beginning at the first reading as defined by Lag 



 Chapter 6: Data Analysis: Gemini, Gemini XS, Gemini EM 

SoftMax Pro User’s Manual  509 

Time (described below) and ending at a total number of readings equal to the Vmax Points setting. 
The second and any subsequent slopes are calculated beginning at the second time point and ending 
at a total number of readings equal to Vmax Points. The steepest slope is reported as Vmax Rate. If 
the data plot displays fewer time points (data points) than the number of time points chosen for 
Vmax Points, then all of the time points will be used to determine the slope of the data. 

Using Vmax Points (Example) 

 Well 1 Well 2 Well 3 

Time points visible in 
the well (data plot) 25 10 2 

Number of Points Used for Data Analysis: 

Vmax Points set to 25/25 
(default) 25 10 2 

Vmax Points set to 5/25 
Overlapping 
5-point line 
segments* 

Overlapping 
5-point line 
segments* 

2 

* SoftMax Pro will perform a linear regression on as many overlapping 5-point line segments as possible in the 
analysis window. The slope will be determined for each line segment and then the steepest slope will be reported 
as the reaction rate. Thus, in well 2 of the example in the table above, the slope will be determined for line 
segments consisting of time points 1 to 5, 2 to 6, 3 to 7, 4 to 8, 5 to 9, and 6 to 10, and then the slope of the line 
segment with the steepest slope will be reported as the Vmax Rate. 

The progressive slope calculations are repeated until the last included data point is reached (as 
defined by the End Time or MaxRFU/MaxRLU — see below). The maximum positive or negative 
slope is reported as Vmax (RFU/sec or RLU/sec). Vmax Points can be set from 2 to the total number of 
points in the curve. The number of Vmax Points can be set before the plate is read and can be 
changed after the plate is read. The data display will update automatically each time. The Vmax 
Points setting does not affect data collection. 

� NOTE: The height of the Y axis in the raw data plots or plate display is controlled using MinRFU/RLU 
and MaxRFU/RLU. The default settings are:  
MinRFU/RLU = 0  
MaxRFU/RLU = 20,000  
The width of the X-axis in the raw data plots or plate display is controlled using Lag Time and End Time. 
If either the MaxRFU/RLU or End Time setting excludes points such that a total number of readings equal 
to Vmax Points cannot be used, then the maximum included points will be used.. 

Time to Vmax 

This is an alternative method for analyzing non-linear Kinetic readings that reports the elapsed time 
until the maximum reaction rate is reached, rather than reporting the maximum rate itself. Used in 
conjunction with Vmax Points, Time to Vmax is the time to the midpoint of the line defined by Vmax 
Points and used to calculate Vmax. This elapsed time data is useful for applications including 
coagulation chemistry where the changing concentration of the reagents does not change Vmax, but 
rather will change the time at which the reaction reaches the maximum rate. 
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Onset Time 

This is another method for analyzing non-linear Kinetic readings. Onset Time reports the time 
required for a Kinetic reaction to change by a specified amount (onset RFU/RLU above the initial 
RFU/RLU reading for the well). This elapsed time data is useful for cascade reactions including clot 
formation (endotoxin testing, for example) or clot lysis applications where the change in reagent 
concentration does not affect the maximum optical density change but changes the time required for 
the reaction to reach completion. 

Time at Minimum 

This setting reports the time at the minimum RFU or RLU that falls within the reduction limits. 

Time at Maximum 

This setting reports the time at the maximum RFU or RLU that falls within the reductionlimits. 

Time at 1/2 Maximum 

This setting reports the time at the half of the maximum RFU or RLU that falls within the reduction 
limits. To calculate this reduction, SoftMax Pro first determines the point (within the reduction limits) 
that has the maximum signal level (RFU or RLU). It then scans the plot from left to right until it finds 
two points having signals that bracket half of that value. A linear interpolation between these two 
points is used to estimate the Time at 1/2 Maximum. 

Slope 

This setting determines the slope of the combined plot (i.e., the slope of the line using linear 
regression after the wavelength combination reduction). This setting uses all visible timepoints in the 
reduction window. Slope is the same as Vmax Rate when Vmax Rate is set to the same number of 
points as the run (i.e., the default). Slope is not the same as Vmax Rate if you have modified the Vmax 
Points. 

Area Under Curve 

This reduction estimates the area under the curve as defined by the data plots in wells (within the 
reduction limits). The data plots are treated as a series of trapezoids with vertices at successive data 
points and at the X-axis coordinates of the data points. The areas defined by each of the trapezoids 
are then computed and summed. 

Absolute Values 

Choosing this option shows the raw data without any smoothing or other changes in the way it is 
graphed. 

Spectrum 
Spectrum Limits 

The Limits settings for the display of Spectrum data are MaxRLU, MinRLU, Starting Wavelength in 
RLU, and Ending Wavelength in RLU. 

� NOTE: The display of values is shown relative to the first point measured for each well. Limits define the 
data that will be viewed and included in data reduction, but do not affect data collection. If you alter a limit 
to show less data, you can always display the “hidden” data again by changing the limit. 

MinRFU/MinRLU 

The limit for the minimum value you wish to report. Any values from the reading that are under this 
limit will not be shown and will be excluded from data reduction. The default is 0 RLU. 

Max RFU/MaxRLU 



 Chapter 6: Data Analysis: Gemini, Gemini XS, Gemini EM 

SoftMax Pro User’s Manual  511 

The limit for the maximum value you wish to report. Any values from the reading that are above this 
limit will not be shown and will be excluded from data reduction. The default is 20,000 RFU/RLU. 

Start (Wavelength) nm 

Specifies the limit for the minimum wavelength setting you wish to report. Any values from the 
reading that are under this limit will not be shown and will be excluded from data reduction. 

End (Wavelength) nm  

Specifies the limit for the maximum wavelength setting you wish to report. Any values from the 
reading that are above this limit will not be shown and will be excluded from data reduction. 

� NOTE: The settings for the Start and End wavelength settings cannot be below the lowest wavelength or 
above the highest wavelength entered in the Instrument Settings for the Spectrum reading. 

Spectrum Reduction 
The Spectrum reduction formula is applied to the list of numbers in each well (values at each 
wavelength) after the wavelength combination formula is applied. The default reduction for 
Spectrum readings is Lambda at Maximum. You can choose Lambda at Minimum, Maximum, 
Minimum, or Area Under Curve instead from the pop-up menu, or you can choose Custom and 
create a different reduction formula. 

Maximum 

Reports the maximum relative fluorescence or relative luminescence (within reduction parameters of 
MinRLU and MaxRLU). 

Minimum 

Reports the minimum relative fluorescence or relative luminescence (within reduction parameters of 
MinRLU and MaxRLU). 

Lambda at Maximum 

Reports the wavelength at which maximum relative fluorescence or luminescence is achieved (within 
reduction parameters of MinRLU and MaxRLU). 

Lambda at Minimum 

Reports the wavelength of minimum relative fluorescence or luminescence is achieved (within 
reduction parameters of MinRLU and MaxRLU). 

Area Under Curve 

This reduction estimates the area under the curve as defined by the data plots in wells (within the 
reduction limits). The data plots are treated as a series of trapezoids with vertices at successive data 
points and at the X-axis coordinates of the data points. The areas defined by each of the trapezoids 
are then computed and summed. 

Well Scan 
Wavelength Combination 

The default wavelength combination for Well Scan readings is !Lm1 and is the only choice 
besides Custom which can be used to create a different reduction formula. 

Well Scan Reduction 

Choices are Maximum, Minimum, Average (default), and Custom. Average provides the average 
value for all points in the Well Scan. 
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Custom Reduction Formulas 
If the predefined reduction formulas do not meet your needs, you can create one or more different 
reduction formulas for any or all read modes. Choosing “Custom” from any of the menus or dialog 
boxes causes a Formula button to appear (an example of this button in an Endpoint Reduction dialog 
box is shown in the figure below). Custom reduction formulas may contain other operators and terms 
in addition to wavelengths. 

 
Above: “Custom” Selected Showing Formula Button (Endpoint) 

Clicking the Formula button opens the Calculation dialog box in which you can name and define a 
new reduction formula. 

 
Above: Wavelength Calculation Dialog Box (Endpoint) 

Examples of some formulas that might be used when combining multiple wavelengths in the 
Calculation dialog box are given in the table below. 
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Wavelength Reduction Formula Examples 

2 λ 3 λ 4 λ to 6 λ 

!Lm1 + !Lm2 !Lm1 + !Lm2 + !Lm3 !Lm1 + !Lm2 + ... + !Lmn 

!Lm1 - !Lm2 
(!Lm1 - !Lm3) / 
(!Lm2 - !Lm3) 

(!Lm1 - !Lm6) /(!Lm2 - !Lm5) / 
(!Lm3 - !Lm4) 

!Lm1 / !Lm2 !Lm1 / !Lm3 !Lm1 / !Lmn 

!Lm1 * !Lm2 !Lm1 * !Lm3 !Lm1 * !Lmn 

Log10(!Lm1/!Lm2) Log10(!Lm1/!Lm3) Log10(!Lm1/!Lmn) 

!Lmx/constant For example, Lm1/1.44 

Average(!allvalues) 

This formula will average together the relative 
fluorescence/luminescence units for multiple readings at the 
same wavelength (for example, if you read the well six times 
at a single wavelength). 

Min(!allvalues) 
This formula will report the minimum RFU/RLU recorded 
for multiple wavelength readings in each well. 

Max(!allvalues) 
This formula will report the maximum RFU/RLU recorded 
for multiple wavelength readings in each well. 

If(!Lmz<A,makeerr(118),(i
f(!Lmx>B,makeerr(117),!L
m1))) 

This formula will report “low” for any well with an 
RFU/RLU less than A, “high” for any RFU/RLU greater than 
B, and the RFU/RLU of any well that lies between A and B. 

 
Custom reduction formulas utilizing mathematical operators or terms can be used to obtain specific 
types of data.  

The table below provides some examples of such formulas for Kinetic and Spectrum readings. 



Chapter 6: Data Analysis: Gemini, Gemini XS, Gemini EM  

514 SoftMax Pro User’s Manual 

Kinetic Reduction Formula Examples 

Kinetic 

Vmaxcorr(!combinedplot, 
!vmaxpoints,!readinterval) 

Reports Vmax correlation coefficient for 
plots in all 96 wells. 

Vmax(Delta(!combinedplot), 
!vmaxpoints,!readinterval) 

Will report the Vmax Rate of the delta 
between each time point. 

Nthitem(!Lm1,X) 

Will report the RLU at item X in the list of 
readings. For example, if you have a 
Kinetic run with 20 time points and X is 
10, it will report the RLU of the 10th time 
point. 

For a list of accessors and operators that may be used in custom reduction formulas, See the Formula 
Reference Guide. 

When you finish your entry in the Calculation dialog box and click [OK], the formula you have 
entered then appears to the right of the word “Custom” and becomes the default selection for the 
Custom option. You may subsequently edit this formula or enter a new one by clicking the Formula 
button again. 

Recalculation Options 
By default, SoftMax Pro performs continuous recalculation of the data when you read plates, create 
or change formulas, and so on. At certain times, it would be useful to disable the recalculation feature 
so that you can make alterations to the experiment without waiting for individual recalculations to be 
completed. Two commands are available in the Edit menu that allow you to modify the way in which 
SoftMax Pro performs recalculation: Suspend Recalculation and Recalculate Now (  =; [CTRL]+[=]). 

Choosing Suspend Recalculation disables the automatic recalculation feature of the program and 
places a checkmark to the left of the command in the menu to indicate that it has been selected. While 
this function is enabled, no recalculation will occur, regardless of what you may change, add, or 
delete from the experiment. This is especially useful when creating or changing column formulas 
within Group sections, for example, as it can speed up the process greatly. 

When recalculation has been suspended, you may wish to see the results of the changes you have 
made but may still not wish to enable continuous recalculation. Choosing Recalculate Now (  =; 
[CTRL]+[=]) from the Edit menu will cause SoftMax Pro to examine all elements of the experiment 
and perform complete recalculation of the data. Choosing this command does not enable continuous 
recalculation but simply causes the program to perform recalculation once. 

To return to continuous recalculation, choose Suspend Recalculation again. The checkmark next to 
the command will disappear, indicating that the function is no longer in use. 

� NOTE: Recalculate Now (  =; [CTRL]+[=]) can be used to see intermediate results during long Kinetic 
readings. At any time, you can choose Suspend Recalculation to delay calculations until a later time. 
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Displaying Data in Group, Graph, and Notes Sections 
Group Sections 

The manner in which data is displayed in a Group section depends on the type of reading that was 
performed (Endpoint, Kinetic, Spectrum, or Well Scan), but can be customized by choices made in the 
data display, reduction settings, and the Edit menu. 

Default displays for Group sections are shown automatically unless you choose a different display 
option. 

The particular font to be used in a Group section table, as well as its size and style, can be changed by 
first selecting one or more columns in the Group section table and then choosing the Text command 
from the Edit menu and making the desired choices from the dialog box that appears. 

Settings from the Plate Section Affect Data Display in Group Section Tables 

Reduction options in the Plate section allow you to display the raw data received from the instrument 
in a reduced (analyzed) form. Which reduction options are available depend on the read mode used 
and reduction settings chosen. Reduced number from the Plate section is displayed in the Values 
column of the Group section tables by default. 

Reduction settings do not affect the raw data but simply cause it to be displayed differently. You can 
change reduction settings without affecting the raw data from the plate reading in any way. 

Custom reduction formulas require the use of accessors and operators that are understood by 
SoftMax Pro. A list of these accessors and operators is given at the end of this chapter. 

Resizing and Hiding Columns 
The columns in a Group section can be resized in several ways. One of the simplest is to drag the line 
dividing the columns to another position (moving it horizontally). When you point to a line between 
columns, the cursor changes to a double arrow with a vertical line through it, showing that it is ready 
to move left or right (see the figure below). 

 
Reducing Column Size and Hiding Columns 

You can reduce a column to a size smaller than the width of its title, in which case the title will not be 
completely visible. You can also hide a column by reducing its size completely (drag one edge of the 
column on top of the other) or by selecting that column and choosing Hide from the Group menu. 

� NOTE: If you hide a column in this way and then wish to view it again, use the Show All command in the 
Group menu. All columns that were hidden will again be visible. There is no way to show only one 
hidden column. 
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Enlarging Column Size 

You can enlarge the width of columns to any size. Increasing the size of columns may make the width 
of the Group section increase beyond the page width boundary. If this occurs, the columns will 
“disappear” off the edge of the screen but are really still there. To bring these columns back into 
view, reduce the width of the columns that are still visible until the others reappear. 

 

� NOTE: If the width of a section extends beyond the page width boundary, the portion that is not visible 
will not be printed. 

   

To size two or more columns to the same width, highlight those columns and then drag one of the 
dividing lines to the desired width. The width of all highlighted columns will be sized the same as 
the column to the left of the dividing line you are moving. 

Columns can also be resized to the minimum amount of space required by choosing Autosize from 
the Group menu. By highlighting the entire table or individual columns and then choosing Autosize, 
the amount of space each column requires will be reduced to the minimum size required by the 
largest piece of text in that column. 

Double-clicking the line dividing two columns causes the single column to the left of the divider to be 
sized according to the largest amount of text in that column. 

Showing and Editing Existing Column Formulas 
When group sections are first created, the formulas used to calculate the data are not displayed. 

These formulas can be shown (until you choose to hide them again) by making a Group section active 
and then choosing Show Formulas from the Group menu. (Note that the command in the menu 
changes to Hide Formulas after they are shown.) 
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Choosing this option causes an additional row to appear (beneath the heading for each column) 
which shows the formula used to calculate the data in each column. To see formulas briefly, hold 
down the shift and control ([CTRL]) keys. 

 
Modifying Column Formulas 

To modify the formula for an existing column, double-click the column or click the column once and 
then click the formula button in the section tool bar. The dialog box associated with the column 
formula will open, allowing you to edit the formula (and the name) associated with the column. 
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For a complete discussion, see the Formula Reference Guide. 

Adding Columns 
You can add a new column to a Group section by clicking the Create Column button in the Group 
Tool Bar or by choosing Create Column from the Group menu which will open the Column Formula 
dialog box. 

 
In the Column Formula dialog box, you may change the name of the new column (from the default 
which simply lists the column by number) to reflect the data that it will contain. 

If no existing column is selected when you click the Create Column button, the new column will be 
created to the right of all existing ones. If you select (highlight) a column and then add a new column, 
it will be positioned to the right of the one you selected. If the table is currently as wide as the sheet of 
paper specified in Page Setup when a new column is added, the columns will “disappear” off the 
right side of the window but are still there. To bring these columns back into view, resize visible 
columns smaller. 

New columns can contain references to other columns, both in the current section or in a different 
one within the same experiment. For example, if you wanted to subtract the mean values in one 
group from those in another, you could create a new column (in either group) to do this. If the two 
groups were named “Group 1” and “Group 2,” for example, and both groups contained a column 
entitled “Mean,” you could create a column within “Group 1” that would subtract the mean values in 
“Group 2” from those in “Group 1.” The column formula needed to do this would be: 



 Chapter 6: Data Analysis: Gemini, Gemini XS, Gemini EM 

SoftMax Pro User’s Manual  519 

Mean-Mean@Group2 

Numerous possibilities exist for creating and editing column formulas to display the data you desire. 
For a complete discussion of formulas and operators, see the accompanying Formula Reference Guide. 

� NOTE: To delete a column, highlight it and press the [Delete] key or choose Cut from the Edit menu. 

Adding or Editing a Summary in a Group Section 
To add a summary at the bottom of a Group section, click the Create Summary button in the tool bar 
or choose Create Summary from the Group menu. The Calculation dialog box will appear, allowing 
you to change the name of the summary or hide the name, if desired, as well as to enter a description 
of the summary and to create a formula for it (including the number of decimal places for the result, 
if appropriate). Double-clicking an existing summary causes the same dialog box to appear, allowing 
you to modify summary information. 

 
Information entered in this dialog box will be placed at the bottom of the Group section as follows: 

Name = Description     Formula Result 

You can click the checkbox next to Hide Name which will change the way the summary appears to 
show: 

Description     Formula Result 

� NOTE: The name assigned to a summary is important since you can reference the summary by name in 
other formulas (building one upon another). The summary name can be referenced even if it is hidden. 

If you wish to see the formulas associated with summaries without opening the Calculation dialog 
box for each one, you can choose Show Formulas from the Group menu. To see these formulas only 
briefly, hold down the shift and control ([CTRL]) keys while that Group section is active. The 
summaries will “expand” to show the complete formula along with the title. They will resume their 
previous appearance when you release the [Option] key. 

Summaries in Group sections can be moved horizontally, if desired, by dragging them left or right. 
When you position the pointer over a Group summary, the cursor changes to show a double-headed 
horizontal arrow. Clicking once highlights the summary; dragging and then releasing the summary 
leaves it in the position where the mouse button was released. 

To have summaries line up with particular columns in the Group, hold down the control ([CTRL]) 
key while dragging the summary. When you release the control ([CTRL]) key, the summary will 
“snap back” so that it begins flush to the left side of the column under which it was released. Each 
summary can be positioned in a different place in the Group section, if desired. 

� NOTE: To delete a summary, highlight it and press the [Delete] key or choose Cut from the Edit menu. A 
summary can also be copied or cut and then pasted in a different location. 
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You can also change the format of the text in Group section columns and/or summaries. By selecting 
the column or summary and then choosing Edit and then Text Style ([CTRL]+[T]), you can change the 
font, size, and/or style of the text. 

Notes Sections 
The Notes section allows you to enter text describing the experiment and one or more summary lines 
that contain formulas. To create a summary, click the Create Summary button in the tool bar or 
choose Create Summary... from the Notes menu. 

The Calculation dialog box that appears allows you to enter a description of the summary, accept the 
default title for the summary, change it or hide it, and enter a formula (including the number of 
decimal places the reduction should show, if appropriate). For detailed information regarding 
operators and accessors, see the Formula Reference Guide. 

If you wish to see the formulas associated with the summaries without calling up the Calculation 
dialog box for each one, you can choose Show Formulas from the Notes menu. To see these formulas 
only briefly, hold down the shift and control ([CTRL]) keys while that Notes section is active. The 
summaries will “expand” to show the complete formula along with the other summary information. 
They will resume their previous appearance when you release the [Option] key. 

Graph Section 
The Plot#X Dialog Box 

Whenever you create a new Graph section or add a plot to an existing graph, the Plot#X dialog box 
opens automatically (“X” starts with “1” and increments each time a new plot is added to a Graph 
section). In this dialog box, you can rename the plot, assign specific information to be plotted on the 
X- and Y- axes, and choose which icon and color will be used. If you rename the plot, the title of the 
dialog box will change to show the new plot name. 

All groups that have been created or assigned within the file are listed on the left side of the “Source:” 
field in the Plot#X dialog box. The first group in the file is automatically selected. Other groups can be 
selected by highlighting them. When a group is selected, the pull-down menus in the X-axis and Y-
axis subfields change to show the group columns that are available for graphing. Group columns can 
be assigned for both the values to be plotted and any error bars to be included for both axes. 

Summaries and user-defined formulas can also be graphed. Pushing the  button for either the X-
axis or Y-axis opens a dialog box which allows you to enter formulas. To plot a summary, enter the 
summary name in this dialog box. Formulas can be plotted for comparison with other data. For 
example, if the data is assumed to follow a specific model, the model formula can be entered as a plot 
and then the data can be chosen for another plot within the same graph. You can also use this feature 
to plot Kinetic or Spectrum data in Graph sections. For example, to plot Kinetic data from well A1 in 
a Graph section, you can enter the formula !A1Lm1 for the Y-Axis and the !TimeRun accessor for the 
X-axis. The entered formulas are also shown in the “Source:” field of this dialog box. 

The size, color, and style of the icon used for a plot can be selected on the right side of this dialog box. 
Four sizes, nine colors, and nine styles are available from drop-down menus. 

The Graph Options Dialog Box 

The Graph Options dialog box allows you to change the name of the Graph section, change the height 
of a graph, select the type of graph to be displayed, change the fonts used on the title, legend, and 
axes, access the Plot#X dialog box for editing plots, entering new plots, and/or to delete plots. This 
dialog box is opened after pressing [OK] in the Plot#X dialog box when a new Graph section is being 
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created. This dialog can also be accessed by pressing the Graph Options button  on the Graph 
section toolbar or by choosing Graph Options from the Graph menu. 

Scatter plots, cluster bar charts and stack bar charts can be created. Error bars can be used with all 
graph types. You can also choose whether to connect the points and/or plot the symbols in the graph. 

Each of the plots that have been created for this Graph section are listed in the “Plots:” field of this 
dialog box. Choosing any of these plots provides an indication of the data to be used for the X- and Y- 
axis data points and error bars on the right side of this field. Plots can be deleted by highlighting the 
plot name and clicking the [Delete] button. Clicking the [New] button opens the Plot#X dialog box, 
allowing you to create a new plot for the graph. Existing plots can be edited by highlighting the plot 
name and clicking the [Edit] button which opens the Plot#X dialog box containing all the information 
for the selected plot. 

When creating a new Graph section, the Graph Options dialog box opens after choosing either [OK] 
or [Cancel] in the Plot#X dialog. The new Graph section is not created, however, until you click [OK] 
in the Graph Options dialog box. 

 
Creating Multiple Plots 

SoftMax Pro makes it possible to create multiple plots within a graph. Each plot will represent data 
from a group that has been created in the Template Editor or data from a summary or custom 
formula. You may plot data from any group or from several groups on a graph, even if the groups are 
in separate experiments. It is possible, for example, to plot multiple dilution series of an unknown, to 
graph together a series of patient samples, or to plot several controls that have been run over time. 

Following is a summary of the steps required to create multiple plots within a single graph, after 
which is an example that provides more detail. 

Multiple Plots Step Summary 

 Create all required groups in the Template Editor. 

 Read the microplate to obtain data. 

 Create a graph section. 

 Add plots to the graph and choose the group and the X and Y values to be shown for each plot. 

Example of Creating Multiple Plots 

This example shows how three groups, all of which are Standards, were plotted on the same graph.  
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1. Groups are created in the Template Editor. For this example, four groups are created: three for 
standards (Standard1, Standard2, and Standard3) and one for Unknowns (Unknown1). 

 
Standards and Unknowns Groups Created 

2. The associated Group sections are created using the Standards column format which, by default, 
generates columns for concentration and optical density values. The example below shows the 
Group section for Standard2. 

 
Standard2 Group Section 

3. A new Graph section is created by selecting New Graph from the Experiment menu. This causes 
the Plots dialog box to open automatically. The default name for the first plot, “Plot#1,” is then 
changed (by typing a new name over it) to “Standard#1.” Clicking [OK] opens the Graph 
Options dialog box which allows you to choose the graph type, modify the fonts used for the 
graph, and so on. Choices should be made as follows: Standard1 for the group to be plotted, the 
concentration of Standard1 for the X-axis, and values of Standard1 for the Y-axis. No error bars 
are added. 
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Graph Options Dialog Box with Plot Name Changed to “Standard#1” 

4. A second plot is added to this graph by clicking the [New] button in the Graph Options dialog 
box. After clicking [New], a dialog labeled Plot #2 is opened. The second plot name defaults to 
“Plot#1,” which now shows beneath the first plot. Change this second plot name to 
“Standard#2,” choose Standard2 for the group, and change the X- and Y-axes to show 
concentration and values, respectively, for Standard2. 

 
Graph Options Dialog Box with Second Plot Added for Standard#2 

5. This process is repeated for a third plot, labeled “Standard#3.” 

6. Now that all plots information is complete, clicking [OK] in the Graph Option dialog box will 
close it, and the resulting graph will show the three plots created. 
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Graph Displaying Three Standards Plots 

You can add as many plots to a graph as you wish, and these can be of the same or different types of 
groups. If you create a graph and later wish to add one or more plots to it, simply click the [Graph 
Options] button on the Graph section Tool Bar and then click the [New] button. This will reopen the 
Plots dialog box, allowing you to add or modify the plot information. 

Error Bars 

When data is displayed as a scatter or bar graph, you can choose to display error bars for the plot of 
the data for the X- and/or Y-axis. Error bars are lines that extend beyond a plotted value in either or 
both directions and graphically represent some amount of error in plotted data. 

  
Plot Showing Error Bars 

Choices for displaying error bars relative to a particular axis are the same as those available for 
displaying data on that axis: any column from that group that contains numerical information (not 
columns with text). To display error bars, click and hold the box next to “Error Bars” in the Plot#X 
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dialog and drag to select one of the choices in the menu. To disable error bars, choose “No Error” for 
the X- and/or Y-axis. 

Error bars show both positive and negative error. Depending on the range settings for the graph, 
portions of the error bars may not be visible. 

Curve Fitting 

When you first create a graph of the data, it does not have a fit associated with it. The graph might 
appear something like this: 

 
Graph with No Fit 

You can fit any plot to one of nine curve-fitting algorithms: Linear, Semi-Log, Log-Log, Quadratic, 4-
Parameter (logistic), Log-Logit, Point-to-Point, Exponential, and Cubic Spline. These selections are 
shown in the Fits pop-up menu in the Graph section toolbar (click on the box next to “Fit”). 

Typically, a standard curve refers to the curve fitted to the plot of concentration versus mean value 
for the Standard group. 

Once you have selected a Fit type, SoftMax Pro determines the parameter values that best fit the data. 
The function with these parameters is then drawn on the graph. Ideally, the type of fit used should be 
determined by the underlying chemistry of the assay and could be set before data is read. 

NOTES: A good discussion of curve fitting appears in “Data Analysis and Quality Control of Assays: 
A Practical Primer” by R. P. Channing Rogers in Practical Immuno Assay, edited by Wilfrid R. Butt 
(published by Marcel Dekker, Inc., New York, 1984). 

When a fit is chosen, the Graph section is updated to show the coefficients describing the fit when 
applicable. These values are displayed in the legend at the bottom of the graph. Figures below show 
the same graph with the different fit algorithms applied. Note that the legend information changes 
(along with the formula for the fit) at the bottom of each Graph section for each different fit. 

� NOTE: All plots on a graph must have the same type of fit. 

When a curve fit is chosen, the values for the coefficients of the equation (A, B, C, etc.) will be shown 
as will the square of the correlation coefficient (R^2). The correlation coefficient describes how well a 
change in x values correlates with a change in the y values. The R^2 value should only be used for 
curve fits having linear axes. 
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Linear 

The linear function fits the best straight line to the data. The equation for this fit has the form of: 

Y = A + (B * X) 

where A is the y-intercept of the line and B is the slope. A linear fit should be used whenever the 
values appear to lie on or scattered around a straight line. 

This equation is shown on the screen as: 

y = A + Bx 

A linear fit should be used whenever the standard values appear to lie on or are scattered around a 
straight line. The figure below shows an example of a linear fit. 

 
Graph with Linear Fit 

Semi-Log 

The semi-log function fits the best straight line to a set of data for log(X) plotted against Y. The 
resulting curve displayed will be a straight line with the X-axis drawn in logarithmic scale. The 
equation for a semi-log fit is: 

Y = A + [B * log10(X)] 

and is shown on the screen as: 

y = A + B * log(x) 

where A is the y-intercept of the line and B is the slope (note: log in this equation is the common or 
base-10 logarithm). 
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Graph with Semi-Log Fit 

Log-Log 

The log-log function fits the best straight line to the set of data which consists of the logarithm of the 
readings on the Y-axis (the response) and the logarithm of the dose on the X-axis. The resulting 
display will be a straight line with both axes drawn in logarithmic scale. The equation for the log-log 
fit is: 

log10(Y) = A + [B * log10(X)] 

and is shown on the screen as: 

log(y) = A + B * log(x) 

where A is the log10Y-intercept of the line for log10(X) = 0 and B is the slope (note: log in this 
equation is the common or base-10 logarithm). 
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Graph with Log-Log Fit 

Quadratic 

The quadratic function fits the best parabola to the data. The parabola is a curved line based on the 
equation: 

y = A + (B * x) + (C * x2) 

which is shown on the screen as: 

y = A + B*x + C*x^2 

where A is the intercept, B is the slope of the curve at the intercept, and C is the measure of the 
curvature of the parabola. 

The quadratic fit is most appropriate when the standard curve has a tendency to curve up or down. 
An example of a quadratic fit is shown below. 

 
Graph with Quadratic Fit 
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4-Parameter Logistic and Log-Logit 

If the standard curve has a sigmoidal shape when plotted on the semi-log axes, it may be appropriate 
to use either the log-logit or 4-parameter fit. Both fits are based on the equation 

 
where D is the Y-value corresponding to the asymptote (i.e., the flat part of the curve) at high values 
of the X-axis and A is the Y-value corresponding to the asymptote at low values of the X-axis. The 
coefficient C is the X-value corresponding to the midpoint between A and D. The coefficient B 
describes how rapidly the curve makes its transition from the asymptotes in the center of the curve. A 
large value of B describes a sharper transition. Typically, B has a magnitude of about 1. 

Both the log-logit and 4-parameter equations are shown on the screen as: 

y = (A - D) / (1 + (x / C) ^ B) + D 

 
Graph with 4-Parameter Fit 
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Graph with Log-Logit Fit 

Some publications show the log-logit equation in another form: 

 
where 

 
A different algebraic expression of these is: 

 
The difference between the log-logit fit and the 4-parameter fit are in the way the coefficients A and D 
are calculated. For the log-logit method, the standard values for the lowest and highest values of x are 
used. The corresponding y values are assigned to A and D, respectively. Based on these fixed values 
for A and D, the algorithm then computes values for B and C. This technique works well if there are 
standard points along the upper and lower asymptotes. If this is not true, the log-logit fit should be 
avoided in favor of the 4-parameter logistic. 

� NOTE: The curve-fitting algorithm for the 4-parameter equation was based on the Levenberg-Marquardt 
Method. Discussion of this method can be found in Numerical Recipes in C: The Art of Scientific Computing 
by William H. Press, Brian P. Flannery, Saul A Teukolski, and William T. Vetterling, published by 
Cambridge University Press, New York, 1988. 

Point-to-Point 

A linear equation is fit to each pair of data points. Fit parameters are not given. The point-to-point 
curve fit is a linear fit composed of pieces that assume a linear relationship between each pair of data 
points. The line segment defined by each pair is used to interpolate data between those points. Since 
there are multiple line segments, fit parameters are not shown on the graph. 
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Graph with Point-to-Point Fit 

Cubic Spline 

This curve fit generates a fit to a cubic equation between each pair of data points. The general form of 
a cubic equation is: 

y = A + Bx + Cx2 + Dx3 

The equations are computed with the requirement that the first and second derivatives of the 
equations are continuous throughout the range of the data. As multiple curve fits are performed with 
this routine, fit parameters are not shown with the graph. 

 
Graph with Cubic Spline Fit 

Exponential 

The exponential function used to generate this curve fit is: 

y = A + B * (1 - exp^(-x / C)) 
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Graph with Exponential Fit 

� NOTE: SoftMax Pro does not plot samples with descriptor values of zero (0) on a log axis. Curve fits 
affected by this are the semi-log, log-log, log-logit, and 4-parameter curve fits. 

Minimum Number of Standards 

The number of standards used in a standard curve depends on the particular curve fit selected and 
on the judgment of the operator. The table below gives the minimum number of standards required 
mathematically by each of the curve fitting algorithms. 

Minimum Number of Standards Required for Curve Fits 

Curve Minimum Number of Standards 

Linear 2 

Quadratic 3 

Semi-Log 2 

Log-Log 2 

Log-Logit 4 

4-Parameter 4 

Point-to-Point 2 

Exponential 3 

Cubic Spline 4 
For optimal results, you should always exceed the minimum number of standards required for any 
given fit. 

There are other requirements on the standards for the log-logit and 4-parameter logistic curves. The 
fits for the 4-parameter logistic curve are based on the assumption that the curve has a high and a low 
asymptote and a certain “steepness” for the linear portion around the inflection point between the 
asymptotes. If a sufficient number of points do not define the inflection point and the asymptotes, 
you will receive a “no fit” error message or an inappropriate fit. For best results, make sure that the 4-
parameter fit is appropriate for your assay and that the entire range of the assay is represented in 
your standards. 
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If your standards do not clearly define both a high and low asymptote, the spline fit may be more 
appropriate for your assay. 

Judging a Good Curve Fit 

The correlation coefficient is also known as the goodness of fit value because it shows how good a fit 
exists between the computer curve and the standard data points. It measures the degree to which the 
points fall on the computer curve and may give an indication as to what residuals are to be expected. 
The correlation coefficient is popularly known as R and is between -1 and 1, inclusive. When the data 
points lie on a perfectly straight line with negative slope, then R = -1. If the correlation coefficient is 
not suitably close to 1 or -1 (a perfect fit), you can simply apply one of the other types of curves 
without having to reread the plate.  

For nonlinear curve fits, SoftMax Pro performs transformations that cause the curve to become more 
linear. The correlation coefficients are derived from that transformed data. Because of this, you 
should be cautious about using correlation coefficients as an indicator of goodness of fit. Do not let 
this single value for goodness of fit sway your intuition about which fit is best. Some curve fits may 
seemingly give a good fit (e.g., fit values close to 1) but, when inspected by eye, show a poor fit along 
a major portion of the plot. 

Graph Options    

Graphs can be customized further through the Graph Options dialog box which is accessed by 

choosing Graph Type... from the Graph menu or by clicking the Graph button ( ) in the section 
tool bar. 

 
Graph Options Dialog Box 

The default options are shown above, but you can alter these as desired: you may change the font and 
type size used for the title, legend, and/or axes of the graph, and you can choose the color and type of 
symbol used on a scatter graph to show the plot. The graphs shown in preceding Figures reflect the 
default graph options. Connecting the points of a scatter graph can be useful in determining the 
closeness of the fit. The figure below shows a scatter graph with points connected compared to a 
linear fit. 
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� NOTE: The Connect Points option connects the points in order of appearance by sample name—not the 
appearance of points from left to right on the graph. 

 
Scatter Graph with Points Connected (Linear Fit Applied) 

Other options in this dialog box allow you to plot the data as a bar graph with data shown in clusters 
or stacked. The figure below shows both of these bar graph options. 

 
Bar Graphs—Cluster and Stack 

� NOTE: Bar graph options for multiple plot graphs are only available when each plot contains the same 
number of data points and has matching X-axis coordinates. 

� NOTE: When choosing the Connect Points option, the order in which points are connected is sample 
name dependent. 
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Axes Options    

Double-clicking either graph axis, clicking the X-axis or Y-axis button in the Graph section toolbar, or 
selecting either X-axis... or Y-axis... from the Graph menu opens a dialog box concerning the 
configuration of that axis. The figure below shows the dialog box for the X-axis. 

 
X-Axis Dialog Box 

The default settings are shown in the Figure above. You can change these as desired for either or both 
axes. 

Axis Settings 

Enabling the Auto-range option causes the graph to be drawn such that all data points are shown (by 
automatically adjusting the minimum and maximum range settings to encompass the data). You can 
disable the Auto-range function by clicking the checkbox or by changing either or both values for the 
Min and/or Max settings. 





  

  

Displaying and Analyzing Data: FlexStation, FlexStation II, FlexStation II384 

Introduction 
Initial display and reduction of the data received from the instrument is performed in the Plate 
section in which the data has been collected. Display and reduction parameters can be set up either 
prior to or after collecting data. The display and reduction parameters may be modified at any time. 

Data analysis and the display of analyzed data is also performed in the Group sections (created when 
wells are assigned to groups in the Template Editor) and the Graph section(s). 

Notes sections may be used in conjunction with any other section to provide text commentary and/or 
a summation of data through the use of summaries. Notes sections are used most commonly to 
provide an introduction to or summary of results for a data file. 

All data files have a minimum of one Plate section with data in it. Multiple Plate sections may be 
present. Most files will have a template and Group, Graph, and Notes sections. However, depending 
upon the particular assay and how you wish to report the data, only some of these sections may be 
(or need to be) present in every file. For example, some simple assays allow you to calculate 
concentration in the Plate sections. In such cases, Group and Graph sections are necessary only if you 
wish to display the data graphically. 

The following diagram shows the relationship between the different sections in SoftMax Pro: 

 

Initial Data Display and Reduction 

� NOTE: Not all settings or features will be available for all instruments. Available features will be based 
on the instrument connected to the computer or chosen in the preferences.  

The manner in which data is displayed in a Plate section depends on the type of reading that was 
performed (Endpoint, Kinetic, Spectrum, Well Scan, or FLEX), but can be customized by choices 
made in the data display and reduction settings. Depending on the type of reading performed, 
display options include: 

 Number or plot displays for raw RFU (relative fluorescence units) or RLU (relative 
luminescence units), depending on which was chosen as a read type, with or without reduced 
number. 

� NOTE: The number format (use of commas or periods in numeric notation) chosen for the computer 
operating system is reflected in the way that SoftMax Pro displays data. 



Chapter 6: Data Analysis: FlexStation, FlexStation II, FlexStation II384  

538 SoftMax Pro User’s Manual 

 Number, Plot, Threshold, Ranged, or Grayscale (with or without reduced number) 

 If you have chosen 384-well plates from the Instrument Settings, you can display the wells in 
different ways: Normal, Vertical, Rotated, Large, or Interleaved. 

 When FLEX mode is selected, the Reduction dialog box will show all of the settings included for 
Kinetic mode but with the minimum kinetic interval of less than one second and have the 
settings for the fluidic (pipetting) events. With FLEX mode, the Reduction dialog box also 
includes a section titled Display Options that includes settings for “Absolute,” "Zero Baseline,” 
and “Percent Increase." 

Default displays are shown automatically unless you choose a different display option. 

Reduction options allow you to display the raw data received from fluorescence instruments in a 
reduced (analyzed) form. Which reduction options are available depend on the read mode and read 
type used; custom settings, using formulas you create, are available for all read modes and read 
types. 

Reduction settings do not affect the raw data but simply cause it to be displayed differently, so you 
may change reduction settings without affecting the raw data in any way. 

Custom reduction formulas require the use of accessors and operators that are understood by 
SoftMax Pro. For a list of such accessors and operators and explanations of their functions see the 
Formula Reference Guide. 

The Data Display 
After a plate has been read, the information sent from the fluorescence instrument is shown in the 
data display in the active Plate section. The default display for data from Endpoint readings is raw 
RFU/RLU numeric values. Data from Kinetic, Spectrum, Well Scan, or FLEX readings is displayed in 
plots format (raw RFU/RLU values with respect to time or wavelength) and the display updates 
dynamically to show the data collected so far. If the instrument is reading more than one wavelength, 
plots for the different wavelengths are overlaid in each well. 

All choices except those defined in the Instrument Settings affect only the manner in which the data is 
displayed—the raw data is not changed—permitting you to optimize the display after data is 
collected. 

� NOTE: Data reduction changes the way in which data is displayed and also affects the values used in 
calculations within SoftMax Pro. While the raw values remain unchanged, calculations will use reduced 
values, if any, and are, therefore, affected by settings chosen in the Reduction dialog box.  

� NOTE: Data comes from the instrument to SoftMax Pro with four digits to the right of the decimal point. 
Only three of the four digits are displayed in the Plate section for Endpoint data, however: the fourth 
digit is rounded up or down (0.0045 rounds up to 0.005; 0.0044 rounds down to 0.004, for example). You 
can view all four digits of data, if desired, by displaying the raw values in a Group section table and 
increasing the number of decimal places showing. 

The Display Dialog Box 

Before or after a plate has been read, you can click the [Display] button to open the Display 
dialog box which allows you to change the way the data is presented. Choices available in this dialog 
box depend on whether a Plate section is currently active and which read mode you have chosen (for 
example, the choice for “Plots” is not shown if Endpoint mode is selected). The figures below show 
the default Display dialog boxes for the different read modes. 
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The Display dialog box is divided into two parts (left and right): the default display, “Raw RFU” or 
“Raw RLU,” is shown to the left of a dividing line; the choices for reduced data displays are shown to 
the right of the dividing line. Note: data reduction itself is performed separately; settings here simply 
determine how the reduced data will be displayed in the Plate section. 

The dialog boxes below show the default display choices for the three modes: 

 Raw fluorescence or luminescence values (numbers) for Endpoint; 

 The change in raw RFU/RLU values over time for Kinetic; 

 Raw RFU/RLU values for the range of wavelengths, displayed as a plot, for Spectrum; 

 Raw RFU/RLU values as shades of gray for Well Scan; 

 The change in raw RFU/RLU values over time. 

Other choices available in this dialog box include displaying the data as a single reduced value 
(number), in threshold, ranged, or gray scale formats, or any combination of display choices with the 
reduced number (the reduced number display choice cannot be used with the reduced number 
checkbox). 
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Data in the Plate section is displayed in a grid array (microplate format). With all plates other than 
384-well plates, the display is always shown as a standard microplate, with well A1 in the top left 
corner. If you are reading 384-well plates, additional display options can be chosen to make the 
display of data more clear: 

 Normal: shows the data in standard left-to-right format, with well A1 in the upper left corner. 
Columns 1 through 24 are along the top and rows A through P are shown from top to bottom. 
The wells are smaller and data is shown with fewer digits (less precision). 

 Vertical: the plate is shown in the same orientation as Normal except that columns 1 through 12 
(all rows) are shown above columns 13 through 24 (all rows). 

 Rotated: Same as the Normal view except that it is rotated 90 degrees clockwise (well A1 is in 
the upper right corner). 

 Large: Same as the Normal view except larger. This display can be seen in its entirety only if you 
have the page size set for legal paper (8.5 x 14 inches) in landscape orientation (set this in Page 
Setup or Preferences under the File menu). In the example in the figure above, the display is 
shown as it appears if you do not change the page size from letter-size to legal. 

 Interleaved: In this display, the wells are shown in a format that “skips” every other well as 
follows: all odd columns and rows begin in the upper left corner of the plate display and are 
followed by all even columns and rows. So well A1 is still in the upper left corner, but it is 
followed horizontally by well A3, A5, ... A23, A2, A4, etc., and vertically by well C1, E1, ... O1, 
B1, D1, etc. This display is most useful when the 384-well plate is composed of 4 daughter plates 
of 96 wells each. 
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Above: Example Plate Sections. Choices for a 384-well plate display are shown:  

Normal, Vertical, Rotated, Large, and Interleaved. 

The figure below shows the default displays for Endpoint, Kinetic, and Spectrum modes. The default 
display for Endpoint mode is the raw fluorescence/luminescence. For Kinetic, Spectrum, and FLEX 
modes, the default display is raw RFU/RLU shown in plot format: RFU/RLU vs. time for Kinetic and 
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fluidics, and RFU/RLU vs. wavelength for Spectrum scans. Well scan data defaults to a display as 
shades of gray. 

 
Reduced Number 

The reduced number is based on the settings defined in the Reduction dialog box. It is a combination 
of plate blank subtraction in the Plate section, wavelength reduction, and either a Spectrum or Well 
scan, or a Kinetic or FLEX reduction. The information acquired from the instrument is reduced to a 
single number or value. The reduced number will be reported in the Group section when a template 
has been defined. 
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To view by reduced number alone, select the Number option (the first choice to the right of the 
default, just after the dividing line); to see a reduced number as well as another type of display, click 
the box next to the option that says “With reduced number” in the lower left of the dialog box to 
enable it. Changing the reduction parameters after choosing a reduced data display mode will cause 
the display to update accordingly. More information about reduction formulas and how to customize 
them follows later in this chapter.  

Threshold, Ranged, and Gray Scale 
To display Threshold, Ranged, or Gray Scale data, high and low values must be entered. When you 
choose one of these display options, SoftMax Pro provides default values for the high and low limits 
by means of an autoranging function (encompassing all the data from lowest to highest value). You 
can change the high and low limits by highlighting the existing value and entering a new value. An 
example of the Display dialog box for a Kinetic reading (Plate section) with the Threshold display 
option chosen is shown below. 

 
Threshold 

The Threshold display shows the raw data as a plus (+) for values above the high limit, an asterisk (*) 
for values within the limits, and a minus (-) for values below the low limit. The figure below shows a 
Kinetic reading displayed using the Threshold option along with the reduced number. 
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Ranged 

When the Ranged display is chosen, raw data that falls between the high and low limits is assigned 
proportionally to integer values from 0 through 9. Values above the high limit are displayed as a 
plus (+) and values below the low limit are displayed as a minus (-). The figure below shows reduced 
Kinetic data displayed in Ranged format. 
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Gray Scale 

The Gray Scale option presents the raw data in eight shades of gray, changing from light (for values 
less than or equal to the low limit) to dark (for values greater than or equal to the high limit). The 
figure below shows reduced Endpoint data displayed as Gray Scale. 
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Graphing Wells 

You can enlarge the display of the wells shown with Kinetic, Spectrum, Well Scan, or FLEX 
modes to get a close-up view of the data. This is done by either double-clicking the particular well in 
the data display or by selecting the well and then clicking the Well Graph button in the Plate Section 
Tool Bar.  

Well Graphs 
Well Graphs plot the data for the individual wells in a microplate and show the well ID and 
reduction information, including the goodness of fit (R^2 value), if appropriate.  

Positioning the cursor within a Well Graph shows X and Y values for the cursor location, allowing 
you to determine more precisely the location of data points. 

Well Scan Well Graphs 
Well Graphs in Well Scan mode default to displaying raw data in a grayscale plot. The manner in 
which the data is displayed in a Well Graph for a Well Scan depends on the reduction options that 
have been chosen, the display options (raw or reduced, for example), the number of points read, and 
whether the Well Graph is scaled to the data or to the limits of the entire plate. 

Well Graph Options 
Along the bottom of each Well Graph dialog box are eight buttons (five when using Well Scan mode) 
that perform the following functions: 

 [Print] 
Opens the Print dialog box. 

 [Reduction] 
Opens the Reduction dialog box. 
By default, the ranges on the enlarged plot are set to the limits defined in the Reduction dialog 
box, and the information included near the bottom of the window is based on the reduction 
settings currently in use. You may change these settings (wavelength combination and type of 
reduction used, minimum and maximum value limits, lag time and end time, and number of 
Vmax Points). More information about the reduction options can be found later in this chapter. 

� NOTE: Changes to the reduction settings made within well graphs will be applied to all wells in the Plate 
section. When viewing Raw data, you can scale the graph to see data outside the reduction limits [line(s) 
are included on the graph indicating the limits and the area outside of them will be shaded slightly]. This 
view should assist you in determining the best limits for the reduced data. 

Show Raw/Show Reduced Button  

This button toggles the Well Graph between views of raw and reduced data. When the Well Graph is 
opened, the initial view depends on the Display settings for the Plate section. If raw data is being 
displayed in the Plate, the initial view in the Well Graph will be raw data and the button will be set to 
“Show Reduced.” If reduced data is being displayed in the Plate section, the initial view in the Well 
Graph will be reduced data and the button will be set to “Show Raw.” 

Scale to Data/Scale to Limits Button 

This button toggles between a view of the data within the reduction limits and a view of the entire 
data set. Switching between these views helps to visualize how the limit settings affect data 
reduction. If raw data is being viewed in the Plate section, the display in the Well Graph is set 



 Chapter 6: Data Analysis: FlexStation, FlexStation II, FlexStation II384  

SoftMax Pro User’s Manual  547 

initially to show the plot scaled to the reduction limits. If reduced data is being viewed in the Plate 
section, the Well Graph display is set initially to show the plot scaled to the data. 

� NOTE: If you are viewing raw data and click the Scale to Data or Scale to Limits button, only the display 
of raw data in the Well Graph will be affected (the button will not affect the view of reduced data). The 
same is true if you click this button while viewing reduced data. To produce comparable scaling of both 
raw and reduced displays, this button must be set to either Scale to Limits or Scale to Data for both raw 
and reduced views of the Well Graph. 

Graph Options Button 

Opens the Well Graph Options dialog box which allows you enable or disable connected points or 
plotted symbols the graph. 

 

 

 

X-Axis Settings Button  

Y-Axis Settings Button  

Opens the Well Graph Axis Settings dialog box for the particular axis, allowing you to set Auto 
Range parameters, choose the minimum and maximum values for the selected axis, cause the axis to 
be auto-ranged, add or remove gridlines, and add or remove axis tick marks. When a Well Graph is 
opened, the default settings are to show the reduction limits for that axis with Auto Ranging off and 
gridlines and tick marks selected. Only the Well Graph being viewed is affected by changes in these 
dialog boxes. 

 [Done] 
Closes the Well Graph dialog box. 
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Above: Well Graph for a Single Kinetic Microplate Well (Raw Data) 

Multiple wells from the same Plate section can be graphed together in one enlarged window. Select 
the well(s) in the data display (hold the [Shift] key if you are selecting non-contiguous wells; you can 
drag across contiguous wells) and then click the Graph button or double-click in one of the selected 
wells. 

 
Above: Well Graph for Three Kinetic Wells of a Microplate (Raw Data) 

The choices you make for viewing the data in the Plate section also affect the way the Well Graph 
appears. The figures above show Well Graphs for raw data displays. If you display one of the reduced 
options (reduced number, Threshold, Ranged, or Gray Scale), the Well Graph will show the plot with 
an indicator of the reduced value and will include the word “Reduced” in the window title. 



 Chapter 6: Data Analysis: FlexStation, FlexStation II, FlexStation II384  

SoftMax Pro User’s Manual  549 

Zoom Box 
You can enlarge the Well Graph even further by clicking the zoom box in the upper right-hand corner 
of the window (the center box of three in the upper right corner in Windows). Clicking the zoom box 
once will cause the window to fill the total display on your monitor; clicking the zoom box again will 
return the window to its previous size. 

Size Box 
Clicking and dragging the size box located in the lower-right corner (Macintosh) or clicking and 
dragging the lower right corner of the window (Windows) allows you to make the Well Graph any 
size desired. 

Printing the Well Graph 
You can print the Well Graph window, if desired, by clicking the [Print] button at the bottom left 
corner of the dialog box. 

� NOTE: If you enlarge the Well Graph to greater than 12 inches, the graph will not fit on an 8.5- by 11-inch 
page and the printout will be truncated. 

Masking Wells    

If you find data in certain wells (outliers) that should be excluded from the calculations to be 
performed by data reduction, you can mask these wells. Select the well(s) to be masked and then click 
the Mask button in the Plate Section Tool Bar or choose Mask... from the Plate menu. Masked wells 
are shown with an overlay of diagonal lines. 

The masking function can be used as a “what if?” tool. For example, you could suppress or enable 
certain functional groups within the experiment. Suppose you have included a group blank in the 
template and want to see the data with and without the blank. Masking the group blank wells would 
suppress the blanking function; unmasking them would enable it again. 
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To remove masking from one or more wells, highlight the masked well(s) and click the Mask button 
in the Plate Section Tool Bar (toggles masking on and off) or choose Mask... from the Plate menu 
again. The diagonal lines covering those wells (and masking function) will be removed. 

Data Reduction 

 

� NOTE: Not all settings or features will be available for all instruments. Available features will be based 
on the instrument connected to the computer or chosen in the preferences.  

Raw data received from the fluorescence instruments can be displayed in an analyzed (or reduced) 
form. The reduction process within SoftMax Pro is based on formulas that reduce the raw data to 
show a single number for each well. Further analysis of this reduced number then takes place in the 
Group and Graph sections. 

SoftMax Pro performs calculations hierarchically when reducing the information collected from the 
instrument. Calculations in the Plate section are performed in the order shown below. If an option 
has either not been selected in the Instrument Settings dialog box, is not available for the instrument 
you are using, or has not been defined in the template and/or Reduction dialog box, SoftMax Pro 
starts/continues with the next listed calculation. 

1. Wavelength reduction 

2. Kinetic or Spectrum reduction 

3. Group blank subtraction 

You can access the Reduction dialog box in several ways: by clicking the 
[Reduction] button in the tool bar of the active plate section, by choosing Reduction from the Plate 
menu, or by clicking the [Reduction] button in the Well Graph display. The appearance of the 
Reduction dialog box will be different depending on the type of read mode you have chosen, and the 
options you have chosen in the Instrument Settings dialog box. The figures below show the 
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Reduction dialog boxes for a Plate section in Endpoint, Kinetic, Spectrum, Well Scan, and FLEX 
modes, along with the default reductions for each of those modes. 
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All of the read modes offer one or more predefined choices for reduction. The predefined reductions 
are described below under the appropriate read mode heading. In addition, with any read mode, you 
can create a custom reduction formula to better suit your needs. Since all custom reduction formulas 
are defined the same way, regardless of read mode, they are described together after the individual 
read mode sections. 

Endpoint 
Wavelength Combination 

The default reductions for Endpoint readings are !Lm1 and Custom for all fluorescence instruments 
when you read at a single wavelength. Additional wavelength combinations become available 
depending on the number of wavelengths chosen. You can choose Custom and create different 
reduction formulas. The wavelength combinations available in the drop-down menu show the correct 
format of the formulas that produce these reductions. 

Kinetic 
Wavelength Combination 

The default wavelength combination for Kinetic readings is !Lm1. Other selections depend on the 
number of wavelengths chosen (for example, if you will read at two wavelengths, choices default to 
!Lm1 and !Lm2, along with Custom). If you do not wish to use the default reduction, you can choose 
Custom and create a different reduction formula. 

Kinetic Limits 

The Limits settings for the display of Kinetic data are MaxRFU/RLU, MinRFU/RLU, Lag Time, and 
End Time. 

� NOTE: The display of RFU/RLU values is shown relative to the first point measured for each well. 
Negative Kinetic values decrease with time, and limits should be set accordingly (below 0) to view 
negative Kinetic data. 
Limits define the data that will be viewed and included in data reduction, but do not affect data collection. If 
you alter a limit to show less data, you can always display the “hidden” data again by changing the limit. 

MaxRFU/MaxRLU 

The limit for the maximum value you wish to report. Any values from the reading that are above this 
limit will not be shown and will be excluded from data reduction. The default is 20,000 for RFU/RLU. 

The MaxRFU/RLU reduction parameter can be used to exclude the non-linear portion of the reaction 
from data analysis. This type of data reduction is most useful in reactions where the initial portion of 
the data is linear. You might also adjust the End Time setting to remove a non-linear portion after a 
certain time point in the reaction. Using MaxRFU/RLU allows the use of the maximum number of 
linear points to calculate the slope of the line and, thus, to determine the rate for each well. 
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Above: Different Reductions of the Same Data Using Different MaxRFU Points 

Both of the Well Graphs shown above display different reductions of the same Kinetic data. In the 
figure on the top, the MaxRFU is set to 20,000 for the display of wells C4, D6, and E6. In the figure on 
the bottom, the MaxRFU has been reset to 10,000.Alternatively, you could leave the Maximum RFU 
and change the number of Vmax Points used to determine the slope of the line. 

MinRFU/MinRLU 

The limit for the minimum value you wish to report. Any values from the reading that are under this 
limit will not be shown and will be excluded from data reduction. The default is 0 RFU/RLU. To 
display negative Kinetics, the value should be set below 0 (zero).  

Lag Time 

Specifies how many initial data points are excluded from the calculation of Vmax Rate. Lag Time 
truncates the data used in the calculation. It does not prevent data from being collected. The Kinetic 
plots will not display the data collected prior to the set Lag Time. The value for Lag Time can be 
changed after the plate is read. The default is 0. 
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Above: Different Lag Time Settings 

In the figure on the top left, well C5 has a lag time: the data is not linear until approximately 80 
seconds after the start of data collection. Thus, the linear curve fit is not good and the slope of the line 
does not reflect the maximal rate. In the figure on the bottom right, a lag time of 80 seconds has been 
set and the linear curve fit for both wells is good, allowing the slope of the lines to reflect the maximal 
rate in each well. Alternatively, you could leave the Lag Time and decrease the number of Vmax 
Points used to determine the slope of the line. 

End Time 

This setting specifies the time at which you wish to stop showing data in the display. Any values 
occurring after this limit will not be reported in the display. The default setting is the total assay time. 
The value for end time may not be greater than the total assay time. 

Absolute Values 

This setting causes the plots shown in the data display to be drawn at their absolute RFU/RLU as 
opposed to the default (with the box unchecked) which offsets the first point to the (0,0) coordinate. 
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Enabling Absolute Values may cause some data points that do not fall within the default limits for 
the plots to “disappear.” 

 
Above: Kinetic Reduction with Absolute Values Enabled. Note that the limits in this example (MinRFU=0, 

MaxRFU=10,000) do not allow all of the data to be visible. 

To see more data, yet still display absolute values, enlarge the limits for  
MinRFU/RLU and/or MaxRFU/RLU found in the Reduction dialog box. 

 
If you increase the MaxRFU/RLU setting to be at least as large as the largest 
fluorescence/luminescence value expected, most or all of the data plots should appear in the data 
display. In the Kinetic Reduction example shown above, if the MaxRLU value is increased from 
10,000 to 20,000, the plots then appear as shown below. 
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Above: Kinetic Reduction with Absolute Values Enabled and MaxRFU Value Increased 

Kinetic Reduction 
Kinetic reductions are applied to the list of numbers (the value at each timepoint) after the 
wavelength combination formula is applied. Vmax per min and Vmax per sec reductions are 
available for all instruments that are capable of Kinetics; the default Kinetic reduction is Vmax (units 
per sec). Other reductions available from the pop-up menu are Time to Vmax, Onset Time, Time at 
Minimum, Time at Maximum, Time at 1/2 Maximum, Slope, Area Under Curve, or you can choose 
Custom and then create a different reduction formula. 

Vmax 

The maximum slope of the Kinetic plot of relative fluorescence/luminescence units versus time. The 
default value displayed is in relative fluorescence units (RFU) per second or relative luminescence 
units (RLU) per second. The rate is calculated with the use of  Vmax Points (see below) which 
determines the number of contiguous points over which Vmax is calculated. The number of Vmax 
Points defaults to the maximum taken during the reading for all instruments except the FlexStation 
which defaults to 5 points. You can change this number in the Reduction dialog box. 

� NOTE: Vmax = Vmax/sec • 60,000 

A linear regression is performed to determine the slope of the line using the equation: 

   y = m*X + B 

where m is the slope of the line. 

The reaction rate is reported in RFU/RLU units/sec. 

Vmax Points 

This setting defines the maximum size of the line segment used to determine the slope of the line 
used in calculating the rate of the reaction. The default is the total number of points taken in the 
reading, with the data normalized to a starting point of 0,0 (as opposed to starting with the first time 
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point). The first slope is calculated for a line drawn beginning at the first reading as defined by Lag 
Time (described below) and ending at a total number of readings equal to the Vmax Points setting. 
The second and any subsequent slopes are calculated beginning at the second time point and ending 
at a total number of readings equal to Vmax Points. The steepest slope is reported as Vmax Rate. If 
the data plot displays fewer time points (data points) than the number of time points chosen for 
Vmax Points, then all of the time points will be used to determine the slope of the data. 

Using Vmax Points (Example) 

 Well 1 Well 2 Well 3 

Time points visible in 
the well (data plot) 25 10 2 

Number of Points Used for Data Analysis: 

Vmax Points set to 25/25 
(default) 25 10 2 

Vmax Points set to 5/25 
Overlapping 
5-point line 
segments* 

Overlapping 
5-point line 
segments* 

2 

* SoftMax Pro will perform a linear regression on as many overlapping 5-point line segments as possible in the 
analysis window. The slope will be determined for each line segment and then the steepest slope will be reported 
as the reaction rate. Thus, in well 2 of the example in the table above, the slope will be determined for line 
segments consisting of time points 1 to 5, 2 to 6, 3 to 7, 4 to 8, 5 to 9, and 6 to 10, and then the slope of the line 
segment with the steepest slope will be reported as the Vmax Rate. 

The progressive slope calculations are repeated until the last included data point is reached (as 
defined by the End Time or MaxRFU/MaxRLU — see below). The maximum positive or negative 
slope is reported as Vmax (RFU/sec or RLU/sec). Vmax Points can be set from 2 to the total number of 
points in the curve. The number of Vmax Points can be set before the plate is read and can be changed 
after the plate is read. The data display will update automatically each time. The Vmax Points setting 
does not affect data collection. 

� NOTE: The height of the Y axis in the raw data plots or plate display is controlled using MinRFU/RLU 
and MaxRFU/RLU. The default settings are: 
MinRFU/RLU = 0 
MaxRFU/RLU = 20,000 
The width of the X-axis in the raw data plots or plate display is controlled using Lag Time and End Time. 
If either the MaxRFU/RLU or End Time setting excludes points such that a total number of readings equal 
to Vmax Points cannot be used, then the maximum included points will be used. 

Time to Vmax 

This is an alternative method for analyzing non-linear Kinetic readings that reports the elapsed time 
until the maximum reaction rate is reached, rather than reporting the maximum rate itself. Used in 
conjunction with Vmax Points, Time to Vmax is the time to the midpoint of the line defined by Vmax 
Points and used to calculate Vmax. This elapsed time data is useful for applications including 
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coagulation chemistry where the changing concentration of the reagents does not change Vmax, but 
rather will change the time at which the reaction reaches the maximum rate. 

Onset Time 

This is another method for analyzing non-linear Kinetic readings. Onset Time reports the time 
required for a Kinetic reaction to change by a specified amount (onset RFU/RLU above the initial 
RFU/RLU reading for the well). This elapsed time data is useful for cascade reactions including clot 
formation (endotoxin testing, for example) or clot lysis applications where the change in reagent 
concentration does not affect the maximum optical density change but changes the time required for 
the reaction to reach completion. 

Time at Minimum 

This setting reports the time at the minimum RFU or RLU that falls within the reduction limits. 

Time at Maximum 

This setting reports the time at the maximum RFU or RLU that falls within the reduction limits. 

Time at 1/2 Maximum 

This setting reports the time at the half of the maximum RFU or RLU that falls within the reduction 
limits. To calculate this reduction, SoftMax Pro first determines the point (within the reduction limits) 
that has the maximum signal level (RFU or RLU). It then scans the plot from left to right until it finds 
two points having signals that bracket half of that value. A linear interpolation between these two 
points is used to estimate the Time at 1/2 Maximum. 

Slope 

This setting determines the slope of the combined plot (i.e., the slope of the line using linear 
regression after the wavelength combination reduction). This setting uses all visible timepoints in the 
reduction window. Slope is the same as Vmax Rate when Vmax Rate is set to the same number of 
points as the run (i.e., the default). Slope is not the same as Vmax Rate if you have modified the Vmax 
Points. 

Area Under Curve 

This reduction estimates the area under the curve as defined by the data plots in wells (within the 
reduction limits). The data plots are treated as a series of trapezoids with vertices at successive data 
points and at the X-axis coordinates of the data points. The areas defined by each of the trapezoids 
are then computed and summed. 

Absolute Values 

Choosing this option shows the raw data without any smoothing or other changes in the way it is 
graphed. 

Spectrum 
Spectrum Limits 

The Limits settings for the display of Spectrum data are MaxRFU/RLU, MinRFU/RLU, Starting 
Wavelength in RFU/RLU, and Ending Wavelength in RFU/RLU. 

� NOTE: The display of values is shown relative to the first point measured for each well. Limits define the 
data that will be viewed and included in data reduction, but do not affect data collection. If you alter a limit 
to show less data, you can always display the “hidden” data again by changing the limit. 
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MinRFU/MinRLU 

The limit for the minimum value you wish to report. Any values from the reading that are under this 
limit will not be shown and will be excluded from data reduction. The default is 0 RFU/RLU. 

Max RFU/MaxRLU 

The limit for the maximum value you wish to report. Any values from the reading that are above this 
limit will not be shown and will be excluded from data reduction. The default is 20,000 RFU/RLU. 

Start (Wavelength) nm 

Specifies the limit for the minimum wavelength setting you wish to report. Any values from the 
reading that are under this limit will not be shown and will be excluded from data reduction. 

End (Wavelength) nm  

Specifies the limit for the maximum wavelength setting you wish to report. Any values from the 
reading that are above this limit will not be shown and will be excluded from data reduction. 

� NOTE: The settings for the Start and End wavelength settings cannot be below the lowest wavelength or 
above the highest wavelength entered in the Instrument Settings for the Spectrum reading. 

Spectrum Reduction 
The Spectrum reduction formula is applied to the list of numbers in each well (values at each 
wavelength) after the wavelength combination formula is applied. The default reduction for 
Spectrum readings is Lambda at Maximum. You can choose Lambda at Minimum, Maximum, 
Minimum, or Area Under Curve instead from the pop-up menu, or you can choose Custom and 
create a different reduction formula. 

Maximum 

Reports the maximum relative fluorescence or relative luminescence (within reduction parameters of 
MinRFU/RLU and MaxRFU/RLU). 

Minimum 

Reports the minimum relative fluorescence or relative luminescence (within reduction parameters of 
MinRFU/RLU and MaxRFU/RLU). 

Lambda at Maximum 

Reports the wavelength at which maximum relative fluorescence or luminescence is achieved (within 
reduction parameters of MinRFU/RLU and MaxRFU/RLU). 

Lambda at Minimum 

Reports the wavelength of minimum relative fluorescence or luminescence is achieved (within 
reduction parameters of MinRFU/RLU and MaxRFU/RLU). 

Area Under Curve 

This reduction estimates the area under the curve as defined by the data plots in wells (within the 
reduction limits). The data plots are treated as a series of trapezoids with vertices at successive data 
points and at the X-axis coordinates of the data points. The areas defined by each of the trapezoids 
are then computed and summed. 

Well Scan 
Wavelength Combination 

The default wavelength combination for Well Scan readings is !Lm1 and is the only choice 
besides Custom which can be used to create a different reduction formula. 
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Well Scan Reduction 

Choices are Maximum, Minimum, Average (default), and Custom. Average provides the average 
value for all points in the Well Scan. 

FLEX 
Vmax 

The maximum slope of the FLEX plot of relative fluorescence units versus time. The default value 
displayed is in relative fluorescence units (RFU) per second. The rate is calculated with the use of 
 Vmax Points (see below) which determines the number of contiguous points over which Vmax is 
calculated. The number of Vmax Points defaults to the maximum taken during the reading for all 
instruments except the FlexStation which defaults to 5 points. You can change this number in the 
Reduction dialog box. 

� NOTE: Vmax = Vmax/sec • 60,000 

A linear regression is performed to determine the slope of the line using the equation: 

   y = m*X + B 

where m is the slope of the line. 

The reaction rate is reported in RFU/sec. 

Vmax Points 

This setting defines the maximum size of the line segment used to determine the slope of the line 
used in calculating the rate of the reaction. The default is the total number of points taken in the 
reading, with the data normalized to a starting point of 0,0 (as opposed to starting from the optical 
density of the first time point). The first slope is calculated for a line drawn beginning at the first 
reading as defined by Lag Time (described below) and ending at a total number of readings equal to 
the Vmax Points setting. The second and any subsequent slopes are calculated beginning at the 
second time point and ending at a total number of readings equal to Vmax Points. The steepest slope 
is reported as Vmax Rate. If the data plot displays fewer time points (data points) than the number of 
time points chosen for Vmax Points, then all of the time points will be used to determine the slope of 
the data. 
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Using Vmax Points (Example) 

 Well 1 Well 2 Well 3 

Time points visible in 
the well (data plot) 25 10 2 

Number of Points Used for Data Analysis: 

Vmax Points set to 25/25 
(default) 25 10 2 

Vmax Points set to 5/25 
Overlapping 
5-point line 
segments* 

Overlapping 
5-point line 
segments* 

2 

* SoftMax Pro will perform a linear regression on as many overlapping 5-point line segments as possible in the 
analysis window. The slope will be determined for each line segment and then the steepest slope will be reported 
as the reaction rate. Thus, in well 2 of the example in the table above, the slope will be determined for line 
segments consisting of time points 1 to 5, 2 to 6, 3 to 7, 4 to 8, 5 to 9, and 6 to 10, and then the slope of the line 
segment with the steepest slope will be reported as the Vmax Rate. 

The progressive slope calculations are repeated until the last included data point is reached (as 
defined by the End Time or MaxRFU — see below). The maximum positive or negative slope is 
reported as Vmax (RFU/sec). Vmax Points can be set from 2 to the total number of points in the curve. 
The number of Vmax Points can be set before the plate is read and can be changed after the plate is 
read. The data display will update automatically each time. The Vmax Points setting does not affect 
data collection. 

� NOTE: The height of the Y axis in the raw data plots or plate display is controlled using MinRFU and 
MaxRFU. The default settings are: 
MinRFU = 0 
MaxRFU = 20,000 
The width of the X-axis in the raw data plots or plate display is controlled using Lag Time and End Time. 
If either the MaxRFU or End Time setting excludes points such that a total number of readings equal to 
Vmax Points cannot be used, then the maximum included points will be used. 

Time to Vmax 

This is an alternative method for analyzing non-linear FLEX readings that reports the elapsed time 
until the maximum reaction rate is reached, rather than reporting the maximum rate itself. Used in 
conjunction with Vmax Points, Time to Vmax is the time to the midpoint of the line defined by Vmax 
Points and used to calculate Vmax. This elapsed time data is useful for applications including 
coagulation chemistry where the changing concentration of the reagents does not change Vmax, but 
rather will change the time at which the reaction reaches the maximum rate. 

Onset Time 

This is another method for analyzing non-linear FLEX readings. Onset Time reports the time required 
for a FLEX reading to change by a specified amount (onset RFU above the initial RFU reading for the 
well). 
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Time at Minimum 

This setting reports the time at the minimum RFU that falls within the reduction limits. 

Time at Maximum 

This setting reports the time at the maximum RFU that falls within the reduction limits. 

Time at 1/2 Maximum 

This setting reports the time at the half of the maximum RFU that falls within the reduction limits. To 
calculate this reduction, SoftMax Pro first determines the point (within the reduction limits) that has 
the maximum signal level (RFU). It then scans the plot from left to right until it finds two points 
having signals that bracket half of that value. A linear interpolation between these two points is used 
to estimate the Time at 1/2 Maximum. 

Peak 

This setting reports the maximum RFU value. It will be adjusted for different smoothing options. 

Max - Min 

This setting represents the difference between the maximum and minimum RFU values. If the 
minimum RFU value is below zero, it will be adjusted so that the minimum is always zero. 

Slope 

This setting determines the slope of the combined plot (i.e., the slope of the line using linear 
regression after the wavelength combination reduction). This setting uses all visible time points in the 
reduction window. Slope is the same as Vmax Rate when Vmax Rate is set to the same number of 
points as the run (i.e., the default). Slope is not the same as Vmax Rate if you have modified the Vmax 
Points. 

Area Under Curve 

This reduction estimates the area under the curve as defined by the data plots in wells (within the 
reduction limits). The data plots are treated as a series of trapezoids with vertices at successive data 
points and at the X-axis coordinates of the data points. The areas defined by each of the trapezoids 
are then computed and summed. 

Mean 

This setting takes the average of all data points and returns that value. 

Smoothing 

 
Smoothing is used to reduce noise in FLEX readings. This setting takes the moving average of the raw 
data and displays the FLEX plot using these averaged values. 

The default is no smoothing (setting of 1 “averaged” point). A setting of “3” provides the least 
amount of smoothing: the value of the center point is added to the values of the points on either side; 
the sum of these points is then divided by three and the resulting value is substituted for the center 
point. A setting of “9” would average the center point with the four points on each side. 

When multiple wavelengths are read, it is important to note that smoothing is performed before 
performing wavelength combination calculations such as ratios or multiplication. For example, if you 
read at two wavelengths and choose to take a ratio of those wavelengths, smoothing would be 
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performed on each individual wavelength and the wavelength ratio would be calculated using 
smoothed data. 

Reduction Baseline Options 
Three choices that are available within this section of the Reduction dialog box affect the way that the 
data is graphed: 

 Absolute: Shows the raw data without any change in the way it is graphed. Raw data is used in 
subsequent reduction calculations. 

 Zero Baseline: This option reduces this interference by offsetting the graph slightly. 

 
  

If you enter “5” for the number of points, for example, the average of the first 5 points will be used as 
the baseline value and all raw data will be subtracted from this value. It is important to note that the 
baseline subtraction is applied only to the reduced data—raw data plots do not change. if you wish to 
view the plot with baseline subtraction, you must choose the [Reduced Plot] button in the Display 
dialog box or click the [Show Reduced] button in a zoomed well graph window. If two or more 
wavelengths are present in a reading and you choose to combine these wavelengths while Zero 
Baseline is selected, the zero baseline will only apply after the wavelength combination. 

 % Baseline with Multiplier: This option has been added to make FLEX data look more like 
FLIPR data. FLIPR data can be imported into SoftMax Pro and this option modifies the plot and 
reduction calculations to make FLEX data comparable to the FLIPR data. 

This method averages the first number of points you specify (the upper box), divides the raw data by 
this average value, and then multiplies by 100 (%). The “Multiplier” section allows you to enter a 
number from 0.0001 to 9999 which is then used to multiply the % Baseline value. 

This calculation also is performed only on the reduced data and only after any wavelength 
combinations are calculated. To see the modified plot, you must choose the [Reduced Plot] button in 
the Display dialog box or click the [Show Reduced] button in a zoomed well graph window. 

Interpolate Raw Data Checkbox 

 
Each individual raw data point has a corresponding read time associated with it. In FLEX mode, each 
data value is logged with its own individual read time which can make it difficult to perform 
wavelength combination calculations correctly. For example, if you desired to take a ratio of two 
different wavelengths in a single well, it would be necessary to take a ratio (Lm1/Lm2) of values that 
have been read at two different points in time. To solve this problem, you may select the “Interpolate 
Raw Data” checkbox in the Reduction dialog box. [Note that this checkbox is shown only when two 
or more wavelengths are present in the reading.] 

Enabling this checkbox causes SoftMax Pro to use quadratic interpolation to calculate the interpolated 
values. This results in the loss of one point at each end of the plot. Prior to beginning the calculation, 
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SoftMax Pro determines the starting point by averaging the initial data points of the separate 
wavelengths. For example, if the first data points of the two wavelengths have time values of 0.3 and 
0.5 seconds, SoftMax Pro will average these and use 0.4 seconds as its initial point for interpolation. 

 
Above, Top: Raw Data without Interpolation; Bottom: Interpolated Data. 

Custom Reduction Formulas 
If the predefined reduction formulas do not meet your needs, you can create one or more different 
reduction formulas for any or all read modes. Choosing “Custom” from any of the menus or dialog 
boxes causes a Formula button to appear (an example of this button in an Endpoint Reduction dialog 
box is shown in the figure below). Custom reduction formulas may contain other operators and terms 
in addition to wavelengths. 
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Above: “Custom” Selected Showing Formula Button (Endpoint) 

Clicking the Formula button opens the Calculation dialog box in which you can name and define a 
new reduction formula. 

 
Above: Wavelength Calculation Dialog Box (Endpoint) 

Examples of some formulas that might be used when combining multiple wavelengths in the 
Calculation dialog box are given in the table below. 
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Wavelength Reduction Formula Examples 

2 λ 3 λ 4 λ to 6 λ 

!Lm1 + !Lm2 !Lm1 + !Lm2 + 
!Lm3 !Lm1 + !Lm2 + ... + !Lmn 

!Lm1 - !Lm2 
(!Lm1 - !Lm3) / 
(!Lm2 - !Lm3) 

(!Lm1 - !Lm6) /(!Lm2 - !Lm5) / 
(!Lm3 - !Lm4) 

!Lm1 / !Lm2 !Lm1 / !Lm3 !Lm1 / !Lmn 

!Lm1 * !Lm2 !Lm1 * !Lm3 !Lm1 * !Lmn 

Log10(!Lm1/!Lm2) Log10(!Lm1/!Lm3) Log10(!Lm1/!Lmn) 

!Lmx/constant For example, Lm1/1.44 

Average(!allvalues) 

This formula will average together the relative 
fluorescence/luminescence units for multiple readings at the 
same wavelength (for example, if you read the well six times 
at a single wavelength). 

Min(!allvalues) 
This formula will report the minimum RFU/RLU recorded for 
multiple wavelength readings in each well. 

Max(!allvalues) 
This formula will report the maximum RFU/RLU recorded 
for multiple wavelength readings in each well. 

If(!Lmz<A,makeerr(118),(if(!L
mx>B,makeerr(117),!Lm1))) 

This formula will report “low” for any well with an 
RFU/RLU less than A, “high” for any RFU/RLU greater than 
B, and the RFU/RLU of any well that lies between A and B. 

Custom reduction formulas utilizing mathematical operators or terms can be used to obtain specific 
types of data.  

The table below provides some examples of such formulas for Kinetic and Spectrum readings. 
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Kinetic and Spectrum Reduction Formula Examples 

Kinetic 

Vmaxcorr(!combinedplot, 
!vmaxpoints,!readinterval) 

Reports Vmax correlation coefficient for plots 
in all 96 wells. 

Vmax(Delta(!combinedplot), 
!vmaxpoints,!readinterval) 

Will report the Vmax Rate of the delta between 
each time point. 

Spectrum or Kinetic 

Nthitem(!Lm1,X) 

Will report the RFU/RLU at item X in the list of 
readings. For example, if you have a Kinetic 
run with 20 time points and X is 10, it will 
report the RFU/RLU of the 10th time point. 
Similarly, if you have a Spectrum scan with 20 
measurements and X is 10, it will report the 
RFU/RLU of the 10th wavelength measured. 

For a list of accessors and operators that may be used in custom reduction formulas, see the Formula 
Reference Guide. 

When you finish your entry in the Calculation dialog box and click [OK], the formula you have 
entered then appears to the right of the word “Custom” and becomes the default selection for the 
Custom option. You may subsequently edit this formula or enter a new one by clicking the Formula 
button again. 

Recalculation Options 
By default, SoftMax Pro performs continuous recalculation of the data when you read plates, create 
or change formulas, and so on. At certain times, it would be useful to disable the recalculation feature 
so that you can make alterations to the experiment without waiting for individual recalculations to be 
completed. Two commands are available in the Edit menu that allow you to modify the way in which 
SoftMax Pro performs recalculation: Suspend Recalculation and Recalculate Now (  =; [CTRL]+[=]). 

Choosing Suspend Recalculation disables the automatic recalculation feature of the program and 
places a checkmark to the left of the command in the menu to indicate that it has been selected. While 
this function is enabled, no recalculation will occur, regardless of what you may change, add, or 
delete from the experiment. This is especially useful when creating or changing column formulas 
within Group sections, for example, as it can speed up the process greatly. 

When recalculation has been suspended, you may wish to see the results of the changes you have 
made but may still not wish to enable continuous recalculation. Choosing Recalculate Now (  =; 
[CTRL]+[=]) from the Edit menu will cause SoftMax Pro to examine all elements of the experiment 
and perform complete recalculation of the data. Choosing this command does not enable continuous 
recalculation but simply causes the program to perform recalculation once. 

To return to continuous recalculation, choose Suspend Recalculation again. The checkmark next to 
the command will disappear, indicating that the function is no longer in use. 
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� NOTE: Recalculate Now (  =; [CTRL]+[=]) can be used to see intermediate results during long Kinetic 
readings. At any time, you can choose Suspend Recalculation to delay calculations until a later time. 

Displaying Data in Group, Graph, and Notes Sections 
Group Sections 

The manner in which data is displayed in a Group section depends on the type of reading that was 
performed (Endpoint, Kinetic, Spectrum, Well Scan, or FLEX), but can be customized by choices 
made in the data display, reduction settings, and the Edit menu. 

Default displays for Group sections are shown automatically unless you choose a different display 
option. 

The particular font to be used in a Group section table, as well as its size and style, can be changed by 
first selecting one or more columns in the Group section table and then choosing the Text command 
from the Edit menu and making the desired choices from the dialog box that appears. 

Settings from the Plate Section Affect Data Display in Group Section Tables 

Reduction options in the Plate section allow you to display the raw data received from the 
FlexStation instrument in a reduced (analyzed) form. Which reduction options are available depend 
on the read mode used and reduction settings chosen. Reduced number from the Plate section is 
displayed in the Values column of the Group section tables by default. 

Reduction settings do not affect the raw data but simply cause it to be displayed differently. You can 
change reduction settings without affecting the raw data from the plate reading in any way. 

Custom reduction formulas require the use of accessors and operators that are understood by 
SoftMax Pro. A list of these accessors and operators is given at the end of this chapter. 

Resizing and Hiding Columns 
The columns in a Group section can be resized in several ways. One of the simplest is to drag the line 
dividing the columns to another position (moving it horizontally). When you point to a line between 
columns, the cursor changes to a double arrow with a vertical line through it, showing that it is ready 
to move left or right (see the figure below). 

 
Reducing Column Size and Hiding Columns 

You can reduce a column to a size smaller than the width of its title, in which case the title will not be 
completely visible. You can also hide a column by reducing its size completely (drag one edge of the 
column on top of the other) or by selecting that column and choosing Hide from the Group menu. 
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� NOTE: If you hide a column in this way and then wish to view it again, use the Show All command in the 
Group menu. All columns that were hidden will again be visible. There is no way to show only one 
hidden column. 

Enlarging Column Size 

You can enlarge the width of columns to any size. Increasing the size of columns may make the width 
of the Group section increase beyond the page width boundary. If this occurs, the columns will 
“disappear” off the edge of the screen but are really still there. To bring these columns back into 
view, reduce the width of the columns that are still visible until the others reappear. 

 

� NOTE: If the width of a section extends beyond the page width boundary, the portion that is not visible 
will not be printed. 

   

To size two or more columns to the same width, highlight those columns and then drag one of the 
dividing lines to the desired width. The width of all highlighted columns will be sized the same as 
the column to the left of the dividing line you are moving. 

Columns can also be resized to the minimum amount of space required by choosing Autosize from 
the Group menu. By highlighting the entire table or individual columns and then choosing Autosize, 
the amount of space each column requires will be reduced to the minimum size required by the 
largest piece of text in that column. 

Double-clicking the line dividing two columns causes the single column to the left of the divider to be 
sized according to the largest amount of text in that column. 

Showing and Editing Existing Column Formulas 
When group sections are first created, the formulas used to calculate the data are not displayed. 

These formulas can be shown (until you choose to hide them again) by making a Group section active 
and then choosing Show Formulas from the Group menu. (Note that the command in the menu 
changes to Hide Formulas after they are shown.) 
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Choosing this option causes an additional row to appear (beneath the heading for each column) 
which shows the formula used to calculate the data in each column. To see formulas briefly, hold 
down the shift and control ([CTRL]) keys. 

 
Modifying Column Formulas 

To modify the formula for an existing column, double-click the column or click the column once and 
then click the formula button in the section tool bar. The dialog box associated with the column 
formula will open, allowing you to edit the formula (and the name) associated with the column. 
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For a complete discussion, see the Formula Reference Guide. 

Adding Columns 
You can add a new column to a Group section by clicking the Create Column button in the Group 
Tool Bar or by choosing Create Column from the Group menu which will open the Column Formula 
dialog box. 

 
In the Column Formula dialog box, you may change the name of the new column (from the default 
which simply lists the column by number) to reflect the data that it will contain. 

If no existing column is selected when you click the Create Column button, the new column will be 
created to the right of all existing ones. If you select (highlight) a column and then add a new column, 
it will be positioned to the right of the one you selected. If the table is currently as wide as the sheet of 
paper specified in Page Setup when a new column is added, the columns will “disappear” off the 
right side of the window but are still there. To bring these columns back into view, resize visible 
columns smaller. 

New columns can contain references to other columns, both in the current section or in a different 
one within the same experiment. For example, if you wanted to subtract the mean values in one 
group from those in another, you could create a new column (in either group) to do this. If the two 
groups were named “Group 1” and “Group 2,” for example, and both groups contained a column 
entitled “Mean,” you could create a column within “Group 1” that would subtract the mean values in 
“Group 2” from those in “Group 1.” The column formula needed to do this would be: 
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Mean-Mean@Group2 

Numerous possibilities exist for creating and editing column formulas to display the data you desire. 
For a complete discussion of formulas and operators, see the accompanying Formula Reference Guide. 

� NOTE: To delete a column, highlight it and press the [Delete] key or choose Cut from the Edit menu. 

Adding or Editing a Summary in a Group Section 
To add a summary at the bottom of a Group section, click the Create Summary button in the tool bar 
or choose Create Summary from the Group menu. The Calculation dialog box will appear, allowing 
you to change the name of the summary or hide the name, if desired, as well as to enter a description 
of the summary and to create a formula for it (including the number of decimal places for the result, 
if appropriate). Double-clicking an existing summary causes the same dialog box to appear, allowing 
you to modify summary information. 

 
Information entered in this dialog box will be placed at the bottom of the Group section as follows: 

Name = Description     Formula Result 

You can click the checkbox next to Hide Name which will change the way the summary appears to 
show: 

Description     Formula Result 

� NOTE: The name assigned to a summary is important since you can reference the summary by name in 
other formulas (building one upon another). The summary name can be referenced even if it is hidden. 

If you wish to see the formulas associated with summaries without opening the Calculation dialog 
box for each one, you can choose Show Formulas from the Group menu. To see these formulas only 
briefly, hold down the shift and control ([CTRL]) keys while that Group section is active. The 
summaries will “expand” to show the complete formula along with the title. They will resume their 
previous appearance when you release the [Option] key. 

Summaries in Group sections can be moved horizontally, if desired, by dragging them left or right. 
When you position the pointer over a Group summary, the cursor changes to show a double-headed 
horizontal arrow. Clicking once highlights the summary; dragging and then releasing the summary 
leaves it in the position where the mouse button was released. 

To have summaries line up with particular columns in the Group, hold down the control ([CTRL]) 
key while dragging the summary. When you release the control ([CTRL]) key, the summary will 
“snap back” so that it begins flush to the left side of the column under which it was released. Each 
summary can be positioned in a different place in the Group section, if desired. 

� NOTE: To delete a summary, highlight it and press the [Delete] key or choose Cut from the Edit menu. A 
summary can also be copied or cut and then pasted in a different location. 



 Chapter 6: Data Analysis: FlexStation, FlexStation II, FlexStation II384  

SoftMax Pro User’s Manual  573 

You can also change the format of the text in Group section columns and/or summaries. By selecting 
the column or summary and then choosing Edit and then Text Style ([CTRL]+[T]), you can change the 
font, size, and/or style of the text. 

Notes Sections 
The Notes section allows you to enter text describing the experiment and one or more summary lines 
that contain formulas. To create a summary, click the Create Summary button in the tool bar or 
choose Create Summary... from the Notes menu. 

The Calculation dialog box that appears allows you to enter a description of the summary, accept the 
default title for the summary, change it or hide it, and enter a formula (including the number of 
decimal places the reduction should show, if appropriate). For detailed information regarding 
operators and accessors, see the Formula Reference Guide. 

If you wish to see the formulas associated with the summaries without calling up the Calculation 
dialog box for each one, you can choose Show Formulas from the Notes menu. To see these formulas 
only briefly, hold down the shift and control ([CTRL]) keys while that Notes section is active. The 
summaries will “expand” to show the complete formula along with the other summary information. 
They will resume their previous appearance when you release the [Option] key. 

Graph Section 
The Plot#X Dialog Box 

Whenever you create a new Graph section or add a plot to an existing graph, the Plot#X dialog box 
opens automatically (“X” starts with “1” and increments each time a new plot is added to a Graph 
section). In this dialog box, you can rename the plot, assign specific information to be plotted on the 
X- and Y- axes, and choose which icon and color will be used. If you rename the plot, the title of the 
dialog box will change to show the new plot name. 

All groups that have been created or assigned within the file are listed on the left side of the “Source:” 
field in the Plot#X dialog box. The first group in the file is automatically selected. Other groups can be 
selected by highlighting them. When a group is selected, the pull-down menus in the X-axis and Y-
axis subfields change to show the group columns that are available for graphing. Group columns can 
be assigned for both the values to be plotted and any error bars to be included for both axes. 

Summaries and user-defined formulas can also be graphed. Pushing the  button for either the X-
axis or Y-axis opens a dialog box which allows you to enter formulas. To plot a summary, enter the 
summary name in this dialog box. Formulas can be plotted for comparison with other data. For 
example, if the data is assumed to follow a specific model, the model formula can be entered as a plot 
and then the data can be chosen for another plot within the same graph. You can also use this feature 
to plot Kinetic or Spectrum data in Graph sections. For example, to plot Kinetic data from well A1 in 
a Graph section, you can enter the formula !A1Lm1 for the Y-Axis and the !TimeRun accessor for the 
X-axis. The entered formulas are also shown in the “Source:” field of this dialog box. 

The size, color, and style of the icon used for a plot can be selected on the right side of this dialog box. 
Four sizes, nine colors, and nine styles are available from drop-down menus. 

The Graph Options Dialog Box 

The Graph Options dialog box allows you to change the name of the Graph section, change the height 
of a graph, select the type of graph to be displayed, change the fonts used on the title, legend, and 
axes, access the Plot#X dialog box for editing plots, entering new plots, and/or to delete plots. This 
dialog box is opened after pressing [OK] in the Plot#X dialog box when a new Graph section is being 
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created. This dialog can also be accessed by pressing the Graph Options button  on the Graph 
section toolbar or by choosing Graph Options from the Graph menu. 

Scatter plots, cluster bar charts and stack bar charts can be created. Error bars can be used with all 
graph types. You can also choose whether to connect the points and/or plot the symbols in the graph. 

Each of the plots that have been created for this Graph section are listed in the “Plots:” field of this 
dialog box. Choosing any of these plots provides an indication of the data to be used for the X- and Y- 
axis data points and error bars on the right side of this field. Plots can be deleted by highlighting the 
plot name and clicking the [Delete] button. Clicking the [New] button opens the Plot#X dialog box, 
allowing you to create a new plot for the graph. Existing plots can be edited by highlighting the plot 
name and clicking the [Edit] button which opens the Plot#X dialog box containing all the information 
for the selected plot. 

When creating a new Graph section, the Graph Options dialog box opens after choosing either [OK] 
or [Cancel] in the Plot#X dialog. The new Graph section is not created, however, until you click [OK] 
in the Graph Options dialog box. 

 
Creating Multiple Plots 

SoftMax Pro makes it possible to create multiple plots within a graph. Each plot will represent data 
from a group that has been created in the Template Editor or data from a summary or custom 
formula. You may plot data from any group or from several groups on a graph, even if the groups are 
in separate experiments. It is possible, for example, to plot multiple dilution series of an unknown, to 
graph together a series of patient samples, or to plot several controls that have been run over time. 

Following is a summary of the steps required to create multiple plots within a single graph, after 
which is an example that provides more detail. 

Multiple Plots Step Summary 

 Create all required groups in the Template Editor. 

 Read the microplate to obtain data. 

 Create a graph section. 

 Add plots to the graph and choose the group and the X and Y values to be shown for each plot. 

Example of Creating Multiple Plots 

This example shows how three groups, all of which are Standards, were plotted on the same graph.  
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1. Groups are created in the Template Editor. For this example, four groups are created: three for 
standards (Standard1, Standard2, and Standard3) and one for Unknowns (Unknown1). 

 
Standards and Unknowns Groups Created 

2. The associated Group sections are created using the Standards column format which, by default, 
generates columns for concentration and optical density values. The example below shows the 
Group section for Standard2. 

 
Standard2 Group Section 

3. A new Graph section is created by selecting New Graph from the Experiment menu. This causes 
the Plots dialog box to open automatically. The default name for the first plot, “Plot#1,” is then 
changed (by typing a new name over it) to “Standard#1.” Clicking [OK] opens the Graph 
Options dialog box which allows you to choose the graph type, modify the fonts used for the 
graph, and so on. Choices should be made as follows: Standard1 for the group to be plotted, the 
concentration of Standard1 for the X-axis, and values of Standard1 for the Y-axis. No error bars 
are added. 
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Graph Options Dialog Box with Plot Name Changed to “Standard#1” 

4. A second plot is added to this graph by clicking the [New] button in the Graph Options dialog 
box. After clicking [New], a dialog labeled Plot #2 is opened. The second plot name defaults to 
“Plot#1,” which now shows beneath the first plot. Change this second plot name to 
“Standard#2,” choose Standard2 for the group, and change the X- and Y-axes to show 
concentration and values, respectively, for Standard2. 

 
Graph Options Dialog Box with Second Plot Added for Standard#2 

5. This process is repeated for a third plot, labeled “Standard#3.” 

6. Now that all plots information is complete, clicking [OK] in the Graph Option dialog box will 
close it, and the resulting graph will show the three plots created. 
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Graph Displaying Three Standards Plots 

You can add as many plots to a graph as you wish, and these can be of the same or different types of 
groups. If you create a graph and later wish to add one or more plots to it, simply click the [Graph 
Options] button on the Graph section Tool Bar and then click the [New] button. This will reopen the 
Plots dialog box, allowing you to add or modify the plot information. 

Error Bars 

When data is displayed as a scatter or bar graph, you can choose to display error bars for the plot of 
the data for the X- and/or Y-axis. Error bars are lines that extend beyond a plotted value in either or 
both directions and graphically represent some amount of error in plotted data. 

  
Plot Showing Error Bars 

Choices for displaying error bars relative to a particular axis are the same as those available for 
displaying data on that axis: any column from that group that contains numerical information (not 
columns with text). To display error bars, click and hold the box next to “Error Bars” in the Plot#X 
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dialog and drag to select one of the choices in the menu. To disable error bars, choose “No Error” for 
the X- and/or Y-axis. 

Error bars show both positive and negative error. Depending on the range settings for the graph, 
portions of the error bars may not be visible. 

Curve Fitting 

When you first create a graph of the data, it does not have a fit associated with it. The graph might 
appear something like this: 

 
Graph with No Fit 

You can fit any plot to one of nine curve-fitting algorithms: Linear, Semi-Log, Log-Log, Quadratic, 4-
Parameter (logistic), Log-Logit, Point-to-Point, Exponential, and Cubic Spline. These selections are 
shown in the Fits pop-up menu in the Graph section toolbar (click on the box next to “Fit”). 

Typically, a standard curve refers to the curve fitted to the plot of concentration versus mean value 
for the Standard group. 

Once you have selected a Fit type, SoftMax Pro determines the parameter values that best fit the data. 
The function with these parameters is then drawn on the graph. Ideally, the type of fit used should be 
determined by the underlying chemistry of the assay and could be set before data is read. 

NOTES: A good discussion of curve fitting appears in “Data Analysis and Quality Control of Assays: 
A Practical Primer” by R. P. Channing Rogers in Practical Immuno Assay, edited by Wilfrid R. Butt 
(published by Marcel Dekker, Inc., New York, 1984). 

When a fit is chosen, the Graph section is updated to show the coefficients describing the fit when 
applicable. These values are displayed in the legend at the bottom of the graph. Figures below show 
the same graph with the different fit algorithms applied. Note that the legend information changes 
(along with the formula for the fit) at the bottom of each Graph section for each different fit. 

� NOTE: All plots on a graph must have the same type of fit. 

When a curve fit is chosen, the values for the coefficients of the equation (A, B, C, etc.) will be shown 
as will the square of the correlation coefficient (R^2). The correlation coefficient describes how well a 
change in x values correlates with a change in the y values. The R^2 value should only be used for 
curve fits having linear axes. 
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Linear 

The linear function fits the best straight line to the data. The equation for this fit has the form of: 

Y = A + (B * X) 

where A is the y-intercept of the line and B is the slope. A linear fit should be used whenever the 
values appear to lie on or scattered around a straight line. 

This equation is shown on the screen as: 

y = A + Bx 

A linear fit should be used whenever the standard values appear to lie on or are scattered around a 
straight line. The figure below shows an example of a linear fit. 

 
Graph with Linear Fit 

Semi-Log 

The semi-log function fits the best straight line to a set of data for log(X) plotted against Y. The 
resulting curve displayed will be a straight line with the X-axis drawn in logarithmic scale. The 
equation for a semi-log fit is: 

Y = A + [B * log10(X)] 

and is shown on the screen as: 

y = A + B * log(x) 

where A is the y-intercept of the line and B is the slope (note: log in this equation is the common or 
base-10 logarithm). 
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Graph with Semi-Log Fit 

Log-Log 

The log-log function fits the best straight line to the set of data which consists of the logarithm of the 
readings on the Y-axis (the response) and the logarithm of the dose on the X-axis. The resulting 
display will be a straight line with both axes drawn in logarithmic scale. The equation for the log-log 
fit is: 

log10(Y) = A + [B * log10(X)] 

and is shown on the screen as: 

log(y) = A + B * log(x) 

where A is the log10Y-intercept of the line for log10(X) = 0 and B is the slope (note: log in this 
equation is the common or base-10 logarithm). 
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Graph with Log-Log Fit 

Quadratic 

The quadratic function fits the best parabola to the data. The parabola is a curved line based on the 
equation: 

y = A + (B * x) + (C * x2) 

which is shown on the screen as: 

y = A + B*x + C*x^2 

where A is the intercept, B is the slope of the curve at the intercept, and C is the measure of the 
curvature of the parabola. 

The quadratic fit is most appropriate when the standard curve has a tendency to curve up or down. 
An example of a quadratic fit is shown below. 

 
Graph with Quadratic Fit 
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4-Parameter Logistic and Log-Logit 

If the standard curve has a sigmoidal shape when plotted on the semi-log axes, it may be appropriate 
to use either the log-logit or 4-parameter fit. Both fits are based on the equation 

 
where D is the Y-value corresponding to the asymptote (i.e., the flat part of the curve) at high values 
of the X-axis and A is the Y-value corresponding to the asymptote at low values of the X-axis. The 
coefficient C is the X-value corresponding to the midpoint between A and D. The coefficient B 
describes how rapidly the curve makes its transition from the asymptotes in the center of the curve. A 
large value of B describes a sharper transition. Typically, B has a magnitude of about 1. 

Both the log-logit and 4-parameter equations are shown on the screen as: 

y = (A - D) / (1 + (x / C) ^ B) + D 

 
Graph with 4-Parameter Fit 
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Graph with Log-Logit Fit 

Some publications show the log-logit equation in another form: 

 
where 

 
A different algebraic expression of these is: 

 
The difference between the log-logit fit and the 4-parameter fit are in the way the coefficients A and D 
are calculated. For the log-logit method, the standard values for the lowest and highest values of x are 
used. The corresponding y values are assigned to A and D, respectively. Based on these fixed values 
for A and D, the algorithm then computes values for B and C. This technique works well if there are 
standard points along the upper and lower asymptotes. If this is not true, the log-logit fit should be 
avoided in favor of the 4-parameter logistic. 

� NOTE: The curve-fitting algorithm for the 4-parameter equation was based on the Levenberg-Marquardt 
Method. Discussion of this method can be found in Numerical Recipes in C: The Art of Scientific Computing 
by William H. Press, Brian P. Flannery, Saul A Teukolski, and William T. Vetterling, published by 
Cambridge University Press, New York, 1988. 

Point-to-Point 

A linear equation is fit to each pair of data points. Fit parameters are not given. The point-to-point 
curve fit is a linear fit composed of pieces that assume a linear relationship between each pair of data 
points. The line segment defined by each pair is used to interpolate data between those points. Since 
there are multiple line segments, fit parameters are not shown on the graph. 
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Graph with Point-to-Point Fit 

Cubic Spline 

This curve fit generates a fit to a cubic equation between each pair of data points. The general form of 
a cubic equation is: 

y = A + Bx + Cx2 + Dx3 

The equations are computed with the requirement that the first and second derivatives of the 
equations are continuous throughout the range of the data. As multiple curve fits are performed with 
this routine, fit parameters are not shown with the graph. 

 
Graph with Cubic Spline Fit 

Exponential 

The exponential function used to generate this curve fit is: 

y = A + B * (1 - exp^(-x / C)) 
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Graph with Exponential Fit 

� NOTE: SoftMax Pro does not plot samples with descriptor values of zero (0) on a log axis. Curve fits 
affected by this are the semi-log, log-log, log-logit, and 4-parameter curve fits. 

Minimum Number of Standards 

The number of standards used in a standard curve depends on the particular curve fit selected and 
on the judgment of the operator. The table below gives the minimum number of standards required 
mathematically by each of the curve fitting algorithms. 

Minimum Number of Standards Required for Curve Fits 

Curve Minimum Number of Standards 

Linear 2 

Quadratic 3 

Semi-Log 2 

Log-Log 2 

Log-Logit 4 

4-Parameter 4 

Point-to-Point 2 

Exponential 3 

Cubic Spline 4 
For optimal results, you should always exceed the minimum number of standards required for any 
given fit. 

There are other requirements on the standards for the log-logit and 4-parameter logistic curves. The 
fits for the 4-parameter logistic curve are based on the assumption that the curve has a high and a low 
asymptote and a certain “steepness” for the linear portion around the inflection point between the 
asymptotes. If a sufficient number of points do not define the inflection point and the asymptotes, 
you will receive a “no fit” error message or an inappropriate fit. For best results, make sure that the 4-
parameter fit is appropriate for your assay and that the entire range of the assay is represented in 
your standards. 
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If your standards do not clearly define both a high and low asymptote, the spline fit may be more 
appropriate for your assay. 

Judging a Good Curve Fit 

The correlation coefficient is also known as the goodness of fit value because it shows how good a fit 
exists between the computer curve and the standard data points. It measures the degree to which the 
points fall on the computer curve and may give an indication as to what residuals are to be expected. 
The correlation coefficient is popularly known as R and is between -1 and 1, inclusive. When the data 
points lie on a perfectly straight line with negative slope, then R = -1. If the correlation coefficient is 
not suitably close to 1 or -1 (a perfect fit), you can simply apply one of the other types of curves 
without having to reread the plate.  

For nonlinear curve fits, SoftMax Pro performs transformations that cause the curve to become more 
linear. The correlation coefficients are derived from that transformed data. Because of this, you 
should be cautious about using correlation coefficients as an indicator of goodness of fit. Do not let 
this single value for goodness of fit sway your intuition about which fit is best. Some curve fits may 
seemingly give a good fit (e.g., fit values close to 1) but, when inspected by eye, show a poor fit along 
a major portion of the plot. 

Graph Options    

Graphs can be customized further through the Graph Options dialog box which is accessed by 

choosing Graph Type... from the Graph menu or by clicking the Graph button ( ) in the section 
tool bar. 

 
Graph Options Dialog Box 

The default options are shown above, but you can alter these as desired: you may change the font and 
type size used for the title, legend, and/or axes of the graph, and you can choose the color and type of 
symbol used on a scatter graph to show the plot. The graphs shown in preceding Figures reflect the 
default graph options. Connecting the points of a scatter graph can be useful in determining the 
closeness of the fit. The figure below shows a scatter graph with points connected compared to a 
linear fit. 
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� NOTE: The Connect Points option connects the points in order of appearance by sample name—not the 
appearance of points from left to right on the graph. 

 
Scatter Graph with Points Connected (Linear Fit Applied) 

Other options in this dialog box allow you to plot the data as a bar graph with data shown in clusters 
or stacked. The figure below shows both of these bar graph options. 

 
Bar Graphs—Cluster and Stack 

� NOTE: Bar graph options for multiple plot graphs are only available when each plot contains the same 
number of data points and has matching X-axis coordinates. 

� NOTE: When choosing the Connect Points option, the order in which points are connected is sample 
name dependent. 
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Axes Options    

Double-clicking either graph axis, clicking the X-axis or Y-axis button in the Graph section toolbar, or 
selecting either X-axis... or Y-axis... from the Graph menu opens a dialog box concerning the 
configuration of that axis. The figure below shows the dialog box for the X-axis. 

 
X-Axis Dialog Box 

The default settings are shown in the Figure above. You can change these as desired for either or both 
axes. 

Axis Settings 

Enabling the Auto-range option causes the graph to be drawn such that all data points are shown (by 
automatically adjusting the minimum and maximum range settings to encompass the data). You can 
disable the Auto-range function by clicking the checkbox or by changing either or both values for the 
Min and/or Max settings. 
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File Creation and Management 

Data Files 
During routine use of SoftMax Pro, you will create, open, and save numerous experiment data files. 
These files contain the raw data collected by your Reader along with any data analysis you may have 
completed. To help organize and manage your experiment data files, you should create custom file 
folders and save your data files in the appropriate folders.  

SoftMax Pro software will automatically look for any connected Reader that is powered on, and 
create all new data files based on the capabilities and features of that Reader (e.g., the software 
window will show fluorescence units on both a Plate section and a CuvetteSet section for a 
fluorescence instrument with a cuvette port, but will only display absorbance units for a Plate section 
for an absorbance instrument with no cuvette port.). 

Protocol Files 
Protocol files are experiment “template” files that contain microplate well layout assignment and all 
other Reader configuration data, but no microplate data. These exist in two basic forms: predefined 
protocols provided with SoftMax Pro software and a personalized Default Protocol that each user can 
create and use. 

Creating a Default Protocol 
If you frequently find yourself adding the same sections (Graph, Group, etc.) in the majority of your 
experiment data files, or if you wish to customize the experiment data file window that is opened 
every time you launch SoftMax Pro software (e.g. to include summaries and/or other information in 
the Notes section), you can create your own Default Protocol file, save it with the exact file name 
“Default Protocol.ppr” and as a “Pro Protocol” file type directly within the SoftMax Pro program 
directory/folder on your computer. Then, every time you launch SoftMax Pro software or create a 
new experiment data file using the File:New menu item, the window that first appears will be based 
on your specified custom information within your new protocol file.  

� NOTE: Molecular Devices recommends that you have only one default protocol. 

� NOTE: If no instrument is connected to the computer or the Reader is turned off and no Default Protocol 
file exists, SoftMax Pro software will use the last instrument chosen in the Preferences dialog to create a 
new experiment data file. 

 

 
Resetting the Default Protocol Folder 

Choose Set Folder… from the Assays menu item to force SoftMax Pro software to look for protocol 
files in a different directory. Simply select the folder/directory you wish to use from the list displayed 
and then click the [Open] or [Select] button to set this as the new default location. The name shown in 
this button will change to reflect the name of the selected folder.  



Chapter 7: File Management and Printing  

592 SoftMax Pro User’s Manual 

 
Set Folder Dialog Box—Macintosh 

 
Select Folder Dialog Box—Windows 

Locate and highlight the folder you wish to use and then click the [Select] button at the right of the 
dialog box to set this folder as the default. 

� NOTE: The Assays menu will also include sub-menus for all subdirectories in the default directory that 
contain protocols. Subdirectories are only shown one level deep, so that only the first subdirectory name 
will appear in the Assays menu.  

Locating Protocol and Data Files 
You may find it useful to create separate folders/subdirectories to store the data files created by 
SoftMax Pro software. In addition, you may want to create and save various protocol files for use as 
“templates” for later readings.  

� NOTE: In a multi-user environment, it is usually helpful to create a directory/file folder for each SoftMax 
Pro user or to create separate folders/subdirectories for different types of experiments. We recommend 
that you consider the way in which you will organize your files before creating too many of them—
otherwise you may find that locating a particular file among the many that fill your hard disk difficult 
and/or time consuming. 
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Creating New Files 
Selecting New ( N; [CTRL]+[N]) from the File menu causes a new experiment data file to open, 
creating a new window named "Untitled." The initial contents of this window are based on the 
default protocol file chosen in the Preferences dialog box. 

� NOTE: You can create and/or open more than one SoftMax Pro file at a time. Subsequently opened files 
will appear in separate windows in a cascading, diagonal order. 

New files can be saved as protocol files at any time, either before or after data is acquired. To create a 
new protocol file, enter all the instrument settings for the reading and then choose Save or Save as... 
from the File menu. The dialog box that appears presents the option of saving a file as either a 
protocol or a data file (the default). On the Macintosh, choose “SoftMax Pro Protocol” from the 
choices in the drop-down menu next to “Format:” and enter a name for the file in the text box (type 
over “Untitled”). In Windows, choose the appropriate format from the list in the box under the 
heading, “Save File as Type:.” Also remember to choose the folder or subdirectory in which to save 
this file. When you have entered all the information, click [Save] or [OK]. 

� NOTE: SoftMax Pro limits the number of characters that can be used in a file name. Macintosh file names 
are limited to 31 characters, and Windows file names are limited to 59 characters for the actual name of 
the file (plus a period and 3-letter extension for a total of 63 characters). Using a PC, it is possible to make 
a file name longer than this by manually changing it in a directory listing or by using the Save As 
command in the software. Files with names exceeding these limits will not be readable by SoftMax Pro 
and will result in an error when you attempt to open them. Attempting to “Save As” a data file with a 
name that exceeds these limits will result in strange characters ( “ÿ,” “ü,” etc.) for any letters that fall after 
the 63rd in the file name. 

� NOTE: If you are creating a protocol file from a file containing data, first use File:Save As and save the file 
as a data file type, and then perform a second File:Save As, but change this file type to “SoftMax Pro 
Protocol” file. Data is not saved with a protocol file. 

Protocol files are similar to stationery pad files—when you choose to open a protocol file, SoftMax 
Pro software opens a copy of the protocol data file and names it “Untitled”. 

 
Save As... Dialog Box—Macintosh 
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Save As... Dialog Box—Windows 

Opening Files 
SoftMax Pro software allows you to open files from all versions of SoftMax and SoftMax Pro 
software. To open a supported protocol or data file simply select the Open ( O; [CTRL]+[O]) 
command from the SoftMax Pro software File menu and select one of the listed files.  

� NOTE: While the current version of SoftMax Pro software will open files saved by all previous versions, 
once you save the file, it will only be readable by the current version. If you need to continue using a 
particular data file with an older version of SoftMax Pro software, make sure you perform a Save As and 
change the file name. Otherwise, the file will be saved using the new version’s file format and will not be 
usable with older versions of SoftMax Pro.  

� NOTE: While SoftMax Pro software opens both SoftMax and SoftMax Pro data files, two specific items do 
not translate completely across the programs: sample blanks and auto range limits (in graph sections). 
The data for sample blanks obtained using SoftMax software will be available when these files are 
opened in SoftMax Pro, but no calculations are performed automatically using this data. Auto range 
limits are not available when SoftMax files are opened using SoftMax Pro, so limits for the display of 
information in graphs must be entered manually. 

Opening SoftMax/SoftMax Pro Files (Earlier Versions) 
SoftMax Pro software allows you to open files from previous versions of SoftMax Pro as well as from 
SoftMax software. From within SoftMax Pro, select the Open ( O; [CTRL]+[O]) command from the 
File menu. The file will open and will function in the same way as a SoftMax Pro file. If you wish, you 
can save the file in SoftMax Pro format by selecting Save As... from the File menu. If you do not 
change the name of the file and save it to the same location, a message box will appear, asking 
whether or not you want to replace the existing SoftMax file with the new SoftMax Pro version. If you 
do not, you can either choose a different location or rename the file. 
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� NOTE: While SoftMax Pro software opens both SoftMax and SoftMax Pro data files, two specific items do 
not translate completely across the programs: sample blanks and auto range limits (in graph sections). 
The data for sample blanks obtained using SoftMax software will be available when these files are 
opened in SoftMax Pro, but no calculations are performed automatically using this data. Auto range 
limits are not available when SoftMax files are opened using SoftMax Pro, so limits for the display of 
information in graphs must be entered manually. 

Cross-Platform Files 
SoftMax Pro files created by either Windows or Macintosh users can be opened on either platform 
without error. 

Transferring Macintosh Files to a Windows-based PC 
The most secure and trouble-free way to share files between Windows and Macintosh users is via a 
local area network (LAN). Files created by either Windows or Macintosh versions of SoftMax Pro 
should be copied to your corporate server, and then downloaded by any interested user. SoftMax Pro 
software will be able to open, view, edit, and save changes - providing full cross-platform 
compatibility between your Macintosh and Windows-based computers. 

Other mechanisms can be used to transfer data and protocol files between Windows and Macintosh 
computers including: email attachments, removable media, CDROM, Zip disks, PC-formatted floppy 
disks, etc. 

Since the Macintosh is able to read both Macintosh- and Windows-formatted media, no special 
software is needed to read media that has been formatted on a Windows-based PC. Third-party 
software is available for the Windows-compatible PC that allows the insertion and reading of media 
formatted originally on the Macintosh.  

Macintosh OS9 users need to ensure that File Exchange is available in System Control Panel folder. 
The process of using File Exchange in OS9.x is described below: 

1.  Select Control Panels:Extensions Manager from the Apple menu. Turn File Exchange on by 
placing a checkmark next to it, then restart your computer. 

2. Depending on the version of Windows being used, you may need to rename the Macintosh files 
you want to transfer so that their names conform to the Windows file naming conventions: no 
more than eight characters, no spaces, and a three-letter extension preceded by a period. The 
table below describes the three-letter extensions that are associated with data and protocol files 
from SoftMax and SoftMax Pro. 

3. Transfer the Windows-created data files created to a folder or drive on the Macintosh computer.  

4. Launch SoftMax Pro and select File:Open to see and open the transferred files. 

� NOTE: Certain special characters will not translate accurately across platforms. Characters that are 
created on the Macintosh using the [Option] key, such as ®, ©, ºC, ™, or • , for example, will be shown on 
most Windows-based PCs as other letters or characters.  
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Transferring Files From  Windows to  Macintosh 

The most secure and trouble-free way to share files is via a local area network (LAN). Simply copy 
files up to your corporate server from a Windows-based PC, and download them with a Macintosh-
based computer. SoftMax Pro software will be able to open, view, edit, and save changes  - providing 
full cross-platform compatibility between your Macintosh and Windows-based computers. 

Saving Files Manually 
Saving Files Manually 

SoftMax Pro software provides users with several ways to save files manually. If the current data file 
has not been saved (i.e. if "Untitled" is listed in the Title Bar), it can be saved under any name. If you 
have opened and modified an existing file, you must save it under the different name to prevent 
overwriting the original information. Unwanted or outdated data files must be manually deleted. 

Saving Files under the Same Name 
If you have made changes to a file and want to save these changes, thereby updating the same file, 
select Save ( S; [CTRL]+[S]) or Save As... from the File menu. If you select Save ( S; [CTRL]+[S]), the 
current version of the file will replace the old one (without notification).  

If you select Save As... and specify a filename that already exists in the destination directory, an alert 
will indicate that a file with that name already exists. This prevents accidental data loss as a result of 
overwriting an existing file with a new file. If you specifically wish to overwrite an existing data or 
protocol file with a new file, you must click the [Replace] button in the warning dialog.  

Saving Files under a Different Name or in a Different Folder 
If you have made changes to a data file and want to save these changes as a new file, or if you wish to 
save the file to a different location, select Save As... from the File menu. A dialog box will be 
displayed allowing you to enter a new name and/or a new location for the file. To choose a different 
location for the file, use the pull-down menu at the top of the dialog box to select a different folder. 
To change the name, edit the existing file name then click [OK] when you are ready to save the file. 

� NOTE: SoftMax Pro limits the number of characters that can be used in a file name. On the Macintosh, file 
names are limited to 31 characters; on the PC, the limit is 59-characters for the actual name of the file (plus 
a period and 3-letter extension for a total of 63 characters). Using a PC, it is possible to make a file name 
longer than this by manually changing it in a directory listing or by using the Save As command in the 
software. A file with a name longer than this limit will no longer be able to be read by SoftMax Pro and 
will return an error when you attempt to open it. File names that are made too long using the Save As 
command will show corrupted characters (such as “ÿ,” “ü,” etc.) for any letters that fall after the 63rd. 
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Autosave 
SoftMax Pro software can be configured to save copies of your data files automatically (Autosave) 
after a reading. This function is enabled in the Preferences dialog box (choose Preferences... from the 
Edit menu). 

 
Click the checkbox next to “AutoSave file” in the Preferences dialog to enable Autosave. This 
activates the text box below it, allowing you to modify the file saving options listed. The default 
destination for Autosaved files is the folder containing the SoftMax Pro program. Other options here 
allow you to specify a custom file name prefix, inclusion of the read time and date in the file name, 
and the file format when data files are Autosaved. SoftMax Pro will automatically check to ensure 
that files can be Autosaved to the user-specified directory before actually attempting a Save.  

Data entered in the File Prefix text field will be added to the beginning of every data file name, and 
can be a maximum of 15 characters. This limitation is imposed to ensure that the data file name does 
not extend beyond 31 characters if the Append Date and/or Append Time options are selected. 

You may also choose to append the date and/or time to the Autosaved file name. Appending the date 
will include the date after any defined File Prefix (e.g., “Data 8-14-01). Choosing Append Time will 
include the time after the any defined File Prefix in hhmmss format, to the file prefix (e.g., “Data 
042136”). Including both date and time will create a file name that looks something like “Data 8-14-01 
042136.” If you do not append the time and perform multiple runs, either on the same day or with 
just a file prefix enabled, SoftMax Pro will append an numeric identifier to the file name, starting 
with “1” and increasing by 1 with each successive reading.  

Automatically appending the date and time to the Autosaved file name ensures that the previously 
saved files will not be accidentally overwritten by a later Autosaved data file. Additionally, 
appending the time may shorten the time required for Autosaving since SoftMax Pro software will 
not have to search for the next number in the index series. The recommended AutoSave settings is to 
use both the date and time if all files are being saved to the same folder. Alternatively, saving files to 
a separate folder for each day’s plate reads may be useful for file organization and management. 

The file type for Autosaved files can be either SoftMax Pro File (proprietary file format) or Text File 
(ASCII). If you select the Text File option, you must then choose either the “Create a New File” or 
“Append to File” option. Create New File creates a separate text file for each plate read, while 
Append to File adds successive plate read data to the same text file. 
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� NOTE: When Autosave is enabled in SoftMax Pro file mode for files containing multiple experiment 
sections, each experiment section will be autosaved to a separate file. 

� NOTE: If you are using SoftMax Pro with RoboMax, you must deselect the Autosave and Autoprint 
functions. RoboMax software automatically saves the SoftMax Pro data file after the plate is read. 

Opening Other Protocol Files 
The top half of the Assays menu item will list all the predefined protocol files that ship with SoftMax 
Pro software. 

The bottom half of the Assays menu item will list and provide a shortcut to all customized protocol 
files that are saved to the folder identified by the user with the Set Folder menu item.  

Printing 
Five printing options are available for experiment data files: 

1. You can print a report at any time by choosing Print... (  P; [CTRL]+[P]) from the File menu. 
You can determine which sections (or whether all sections) will be printed in this report (see 
“The Printed Report,” below). 

2. A copy of the template can be printed while you are in the Template Editor by clicking the 
[Print] button in the bottom left corner. 

3. A report can be printed automatically at the end of a reading. To enable this function, choose 
Preferences... from the Edit menu and select “Autoprint.” 

4. You can print the active section or selection. This option is available within the File menu. If only 
one section is selected, the name shown in the menu will reflect the name of the active section. 
For example, if the active section is named “Plate #1,” the topmost print command in the File 
menu would be Print ‘Plate #1’.... If more than one section is selected, the menu will show Print 
Selection. You can select multiple sections to be printed by holding down the [Shift] key and 
clicking on the section tool bars to make them active. 

5. Enlarged displays (well graphs) of Kinetic, Spectrum, or FLEX data can be printed by clicking 
the [Print] button in the Well Graph window. The size of the printout is dependent on the size of 
the well graph. 

� NOTE: If you enlarge the well graph to greater than 12 inches, the printout will be truncated. 

Regardless of which print option you select, make sure your printer is properly connected to the 
computer and that it is turned on prior to sending the print request. You can verify this by printing a 
document from any other application. If Autoprint is enabled, you must ensure the printer is 
successfully connected powered on prior to performing a plate read. 

If you are using a Macintosh, you can select a printer through the Chooser in the Apple Menu 
Items menu. 

If you are using Windows, you can select a printer by choosing Print Setup from the File menu. 
In the Print Setup dialog box, choose the default printer or select from any other printers have been 
configured for use with Windows. See your Windows documentation for further information. 
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The Printed Report 
You can create customized reports by including or excluding experiments and individual sections, 
changing the order in which sections will print, and adding text describing each experiment in Notes 
sections. You can also create summaries (consisting of reduction formulas and associated text) in 
Notes and Group sections. The size and content of Group sections can also be changed. 

Including or Excluding Sections 

When sections are created, they default to being included in the printed report. You can exclude 
sections from printing by clicking the print setting button on the tool bar of that section (it is a toggle, 
so it will change from enabled  to disabled   or vice versa). 

Changing the print setting option for the experiment will change the state of all sections within that 
experiment. Changing the print setting option for one or more sections within an experiment will 
cause the print setting button for the experiment to change to reflect an “undecided” status with 
regard to the sections within it (  ). Toggling the experiment’s print setting button will override any 
changes made to individual sections and set all of them to printing. 

When Print is chosen from the File menu, selecting Print All will override the print settings made to 
sections or experiments. 

Customizing the Report 
Changing the Section Order 

When sections are created either automatically by SoftMax Pro or by you, their order may not be 
optimized for viewing or printing. The order of sections in the window determines how they will 
print in the report, and you may find that changing the order of sections makes it easier to view the 
data. 

When you create a new section, it is positioned directly after the currently active section. To change 
the order of a section, first make it active by clicking on it, then click in its tool bar and drag it to a 
new position on top of the section you want it to precede. Sections may be open or closed during this 
procedure. 
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Moving a section 

Changing the Text Format 
The text in Notes and Group sections can be formatted to change its appearance. The Format Text 
dialog box, accessible by choosing Text Style... ( T; [CTRL]+[T]) from the Edit menu, provides a 
number of different options (see the figure below). 

 
Formatting Text 

First highlight the text you wish to format. Then choose Text Style...  
( T; [CTRL]+[T]) and select the options you wish to apply to the selected text. You can click on the 
[Apply] button to see the result of the selections you have made, allowing you to select more or 
different options before finally setting the options by clicking on [OK]. 
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Customizing the Report 
In addition to choosing which sections will print in the report by toggling their print status, you can 
choose to print all items in a file or to print only the report from the Print dialog box that appears 
when you choose Print from the File menu. 

 
Printer selection 

Other options regarding the appearance of the printed report can be chosen in this dialog box: you 
can add text to be included in the header on every page of the report (maximum of 100 characters in a 
single row), and you can include or exclude the experiment title (the name of the experiment in the 
file) as well as the name(s) of sections, and you can include the date and time of printing, as well as 
add page numbers to the report which are printed at the bottom right corner of each page. These are 
all enabled, by default, until you disable them by clicking in the box with the checkmark next to each 
option (which will deselect that option). 

� NOTE: If a Notes section is longer than can be printed on one page, a line may be cut off (not printed) at 
the bottom of the first page. To fix this problem, insert a carriage return in the appropriate place (above 
the page break) in the Notes section and print again. 

The Print Dialog Box 
Choosing any of the Print... commands brings up the Print Dialog box. The contents of this box will 
vary depending upon the type of printer you have selected or the particular printing option you have 
chosen, but the basic elements are the same. The dialog boxes shown below represent those displayed 
when you choose the Print... command from Macintosh and Windows-based computers. 
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You can choose to print all of the sections, regardless of whether they are included in the report, by 
clicking the option button next to “Print all” at the bottom left of the Print dialog box. 

 

� NOTE: If more than one printer is available to your computer, make sure you select the desired printer 
prior to selecting one of the Print options in the File menu. If you start to print and discover the wrong 
printer is selected, choose [Cancel] to exit from the Print Dialog box. Select the correct printer (using the 
Chooser for the Macintosh or the Print Setup dialog box for Windows) and then repeat the print process. 

Additional information regarding the general print functions available in these dialog boxes can be 
found in the documentation that accompanies your computer and/or printer. 
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Importing/Exporting Information 

Exporting Information 
The Export... command (a sub-menu of Import/Export located in the File menu) creates a data file 
from the information contained in one or more Plate sections, CuvetteSet sections, and/or Group table 
sections within a SoftMax Pro file.  

 
Exporting information format preference 

The exported data and data format relies on several variables: 

 Export Format options made in the Edit:Preferences dialog box. Within the Preferences dialog 
that appears, choose the settings for the data export: 

 For Plate sections, you can choose either Time (time-based format) which produces a linear 
format for the data, or Plate (plate-based format) which exports data in a matrix format 
corresponding to a microplate grid. CuvetteSet sections are automatically exported as time-
based data. 

 Include Labels: will include microplate column labels for all exported data. This is most 
noticeable with Group section data since the column headings in the Group table will be shown, 
as will any other calculated data in summaries, etc. Labels included with Plate and CuvetteSet 
sections show “1-12” headers for 96-well Plate section data represented as an 8 x 12 matrix; 384-
well plate data will show “1-24” headers; CuvetteSet section labels show “A1,” “A2,” etc., 
representing the same number of cuvettes shown in the CuvetteSet section. 

 Interpolate Wells: is available only for the FlexStation Reader. This interpolation is different 
from that found in the reduction dialog box (see Interpolate Raw Data Checkbox). This checkbox 
is used to “normalize” the kinetic read times of other wells against the read time of the first well 
in each column. Because injection occurs at the same time in all wells of a column but the wells 
are read sequentially, the reaction advances in the other wells while the first is being read. 
Consequently, the data in the other wells must be interpolated against the amount of time that 
has elapsed between injection and reading in order to fairly compare data from one well to 
another (and also to compare data from one run to another). Note that once exported, well-
interpolated data cannot be re-imported into SoftMax Pro software. 

 Append Filename and Date: will include this information with the exported data. 

 You may choose to include "Read by: Name" in the exported data.  

� NOTE: The preference settings chosen for Export Format also affect how data is copied, pasted, and 
Autosaved to ASCII text. 

 All data will be exported based on the display options. If raw data is displayed, raw data will be 
exported; if reduced data is displayed, this reduced data will be exported. 
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 Raw: Show with reduced number 

 Raw: Raw Data in 1000’s 

 Reduced: Display Number – when data is viewed as “Reduced”, data will be exported using 
these reduced numbers. Several display settings here do not affect the data export, and all read 
data will be exported as reduced numbers. These display-only options include:  

 Reduced: Display Grayscale 

 Reduced: Display Ranged  

 Reduced: Display Threshold 

 Reduced: Show with reduced number 

 
Show with reduced number option  in the Reduction Dialog Box 

 After choosing File:Export..., a dialog box will appear and prompt you to choose which sections 
you wish to export. You can choose to export: 

 Selected Plate(s) 

 All Plates 

 Selected CuvetteSet(s) 

 All CuvetteSets 

 Selected Group(s) 

 All Groups  



 Chapter 7: File Management and Printing  

SoftMax Pro User’s Manual  605 

 
Export Dialog Box—Windows and Macintosh 

Exported tab-delimited ASCII data files have a minimum of five lines and, in most cases, will be 
considerably longer. An example of an exported tab-delimited file containing Endpoint data collected 
from a SpectraMax 250 follows. The reading was done at a single wavelength, displayed as raw data 
in a microplate format with labels: 

##BLOCKS= 1  
Plate:     Plate#1     1     PlateFormat     Endpoint     Absorbance     Raw     FALSE     1     300     9     350     
750     10     1     405     1     12     96  
20.80   0.1   0.11052   0.12214   0.13499   0.14918   0.16487   0.18221   0.20138   0.22255   0.24596   0.27183   
0.30042    
0.12214   0.13499   0.14918   0.16487   0.18221   0.20138   0.22255   0.24596   0.27183   0.30042   0.33201   0.
36693    
0.14918   0.16487   0.18221   0.20138   0.22255   0.24596   0.27183   0.30042   0.33201   0.36693   0.40552   0.
44817    
0.18221   0.20138   0.22255   0.24596   0.27183   0.30042   0.33201   0.36693   0.40552   0.44817   0.4953   0.5
4739    
0.22255   0.24596   0.27183   0.30042   0.33201   0.36693   0.40552   0.44817   0.4953   0.54739   0.60496   0.6
6859    
0.27183   0.30042   0.33201   0.36693   0.40552   0.44817   0.4953   0.54739   0.60496   0.66859   0.73891   0.8
1662    
0.33201   0.36693   0.40552   0.44817   0.4953   0.54739   0.60496   0.66859   0.73891   0.81662   0.9025   0.99
742    
0.40552   0.44817   0.4953   0.54739   0.60496   0.66859   0.73891   0.81662   0.9025   0.99742   1.10232   1.21
825    
~End  



Chapter 7: File Management and Printing  

606 SoftMax Pro User’s Manual 

An example of an exported file containing Group table data is shown below: 

 
The first line of an exported ASCII data file includes one field indicating the number of data sets in 
the file. This single field includes the text "##BLOCKS=" followed by a number that equals the 
number of data sets. 

The second line of a file for a Plate or CuvetteSet section includes 19 fields that provide all of the 
information needed to determine the type of test that was run to measure the first data set. The 
following table describes each of these fields. 
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� NOTE: The information for the first Plate or CuvetteSet section is provided in the lines following the 
descriptors. The number of data lines depends on the export format and the type of read that was run. A 
minimum of one data line is exported when the Time format is used with a single wavelength Endpoint 
read. 
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� NOTE: If the instrument you are using has a temperature associated with the data (all Readers except 
EMax, VMax, and UVMax), the temperature at the time of the reading will appear before the first data 
point in the reading. 

The second line of a file for a Group table section includes fields that correspond to the number and 
types of columns found in that section (they are labeled as the table is labeled and look very much 
like the table itself. 

Following the data, a blank line is included and then a line with a single termination field: ~End. 

Each subsequent data set in the file includes the lines described above, a blank line, and a line with 
the termination field. 

Importing Information 
SoftMax Pro imports data in tab-delimited ASCII text format, allowing you to import data collected 
by Criterion Host (Analyst AD/HT/Acquest), Analyst Host (Analyst GT), ScreenPlay (ScreenStation), 
or FLIPR operating software (FLIPR) into SoftMax Pro software. 

� NOTE: Only data that can be displayed in Plate and/or CuvetteSet sections can be imported. 

� NOTE: Import only supports up to 384 well plates ; 1536 well plates only import the top left quadrant of 
collected data. 

Three choices are available for importing information into SoftMax Pro software: 

 
 Import... allows you to bring data from a run that was saved previously using an instrument. 

 Import Analyst... allows you to import verbose reports generated using Criterion Host or 
SCREENPLAY for all instrument modes. 

 Import FLIPR... allows you to import “.fpd” file types exported from FLIPR software v2.x after 
exporting the FLIRP data using the Plug In: SMP Export menu item. 

The Tutorial folder contains examples of exported data from these instruments and the Assays menu 
lists protocols that are specific to these instruments. 

Import... 
Selecting Import... from the Import/Export menu under File causes the Import dialog box to appear. 
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Choose the file you wish to import and click the [Import] button. Note that data to be imported must 
contain the appropriate header information. A new experiment is created in the open SoftMax Pro file for 
the imported data. New Plate sections and/or CuvetteSet sections are created for each data set within 
the file. Plate pre-read and CuvetteSet reference data can also be imported, but data for pathlength 
correction cannot. Note that the time/date stamp for a section containing imported data shows 
“imported data” rather than a date or time. 

Import Analyst... 
Choosing Import Analyst... allows you to import data files generated by Analyst instruments 
(including Analyst, AD/HT/GT, Acquest, and ScreenStation). Files for import must be generated as 
“verbose” reports using Criterion Host 2.0 or ScreenPlay 2.5 for all modes (ABS, FI, FP, Epi ABS, 
Lum, and the dual method) saved as text (*.txt). 

When importing 1536-well data from the Analyst instrument only, the first quadrant of 1536-well 
plate data (the top-left section of 24 by 16 wells) can be imported. This data will be displayed in the 
standard 384-well plate format. 

Instrument parameters for each plate in the text file will be imported into a Notes section (as text) and 
the raw data will be imported into a Plate section. The plate ID from the text file will be used to name 
both the Plate and the Notes sections and the file name will be used to name the Experiment. 

More than one text file can be imported into the same SoftMax Pro file by creating or copying another 
experiment into an existing file. 

Analyst files can be imported into a predefined protocol/template in the Drug Discovery folder under 
Assays in SoftMax Pro. All analysis features of SoftMax Pro can be used to analyze the file. 

Import FLIPR... 
Selecting Import FLIPR... allows you to import *.FPD files that have been generated using FLIPR 
instrument control software (version 2.0 and above). 

Files are exported from the FLIPR software using the Plug Ins > Import/Export > FLIPR import menu 
selection. In order to import FLIPR files, they must be exported by the FLIPR software into the 
specific *.FPD format. Standard FLIPR files of the *.FID and *.FWD formats cannot be imported into 
SoftMax Pro. Files can be imported into a predefined protocol/template in the Drug Discovery folder 
under Assays in SoftMax Pro. All analysis features of SoftMax Pro can be used to analyze the file. 

Importing and Exporting Templates 
Template information, saved as a tab-delimited ASCII text file, can be imported to or exported from 
Plate and/or CuvetteSet sections. A template file consists of seven columns of data separated by tabs. 
Each line of the file provides information for one well in a plate or one cuvette. 
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When template information is exported, the information for well/cuvette A1 is written into the first 
line of the file, information for well/cuvette A2 is written to the second line of the file, and so on, until 
a line has been created in the export file for each well in a plate or all cuvettes. If no template 
information exists for a well in a plate or for a cuvette, that line is left blank. The ASCII file terminates 
with the string “~End”. 

The order for importing template information must match the export order. Similarly, blank lines in 
the file are assigned to a well or cuvette, providing a well/cuvette with no template setting. 

ASCII Template File Columns and Descriptions 

 
The tab-delimited ASCII files are compatible with spreadsheet programs, such as Microsoft Excel, 
which makes it possible export a template from SoftMax Pro, import it into a spreadsheet, and change 
the template. 

� Note: It is not possible to reimport the data from Excel into SoftMax Pro.  

Preparing a template file with another application for use with SoftMax Pro is straightforward if you 
use the parameters given above. 

Exporting Graphs 
Graphs from Graph Sections and Well Graphs are exported in EMF format (Enhanced MetaFile) for 
Windows and PICT format for Macintosh users. Graph sections can be exported by choosing Export 
Graph from the Graph menu. Well Graphs can be exported by choosing Export Graph from the Plots 
menu that appears when a Well Graph is opened. 

Copying and Pasting 
Parts of an experiment data file can be copied within the same SoftMax Pro file, between other 
SoftMax Pro data files, or between other programs using the Copy and Paste menu commands. Plate 
section and CuvetteSet section data, and text and summaries in Notes sections can be copied and 
pasted to other sections within the same or a different experiment within SoftMax Pro or to other 
programs. Virtually any ASCII-formatted text can be copied and pasted into a Notes section. A graph 
can be copied and the resulting picture pasted into another application. Template information can be 
copied and pasted from one part of a template to another (within the same or to different templates 
and from one experiment to another). 
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Copying and Pasting within SoftMax Pro 
Data can be copied from one Plate section to another or from one CuvetteSet section to another 
within SoftMax Pro. Make the source section active by clicking on it and then choose Copy ( C; 
[CTRL]+[C]) from the Edit menu. Create a new section, if necessary, and make the destination section 
active. Choose Paste ( V; [CTRL]+[V]) from the Edit menu to paste the data into this section. 

� NOTE: When copying Plate sections, all well data is copied. It is not possible to copy and paste the data 
from only certain wells. Even if you select only one well prior to choosing the Copy ( C; [CTRL]+[C]) 
command, all plate data will be copied and pasting will replace all data in the destination plate 
(PathCheck data is not copied). It is possible, however, to copy individual cuvettes or groups of cuvettes 
and paste these into other CuvetteSet sections. 

If the Instrument Settings of the target section do not match the settings from the section being 
copied, the Instrument Settings for the target section will be updated appropriately to match. 

Templates can also be copied from one Plate section to another or from one CuvetteSet section to 
another within SoftMax Pro. However, the effects of this action depend on whether you are pasting 
the template to another section in the same experiment from which it was copied or to a section in a 
different experiment. Pasting a template to a section in the same experiment from which it was 
copied is useful for cross-plate analyses since corresponding wells in each plate will be assigned to 
the same group and sample. 

Pasting a template to a section in a different experiment will create new groups in that experiment if 
those groups have not previously been created in that experiment. If you are pasting templates 
between experiments, and groups from the source template do not exist in the destination 
experiment, pasting a template will create them. Existing groups of the same name will not be 
changed by the pasting process. For example, if the template being copied contains the groups 
“Standard” and “Unknown,” and the group “Standard” already exists in the destination experiment, 
the group “Unknown” will be created but all information regarding the group “Standard” in the 
destination experiment will remain unchanged. 

Experiments define a naming scope for the sections within them, which is especially important for 
Group sections: it allows you to have identical groups (name and column format) within two or more 
different experiments in the same file. Having multiple experiments in the same file also provides 
you with quick access to different types of information without having to open or refer to multiple 
files. 

If you are copying cuvette data and the target CuvetteSet section does not contain the appropriate 
cuvettes for the data that is to be pasted, new cuvettes will be created automatically. Please note that 
pasting cuvette data for only some cuvettes will clear the existing data from all other cuvettes in 
that section. For example, if cuvettes A2, A4, and A6 are copied from CuvetteSet#1 and you attempt 
to paste this data into CuvetteSet#2 which contains cuvettes A1 through A12, the data in all twelve 
cuvettes will be cleared and then cuvettes A2, A4, and A6 will receive the pasted data. An alert box 
will ask whether or not you wish to replace all the data before proceeding. 

Copying from Other Programs 
Plate section data, CuvetteSet section data, and Notes section text can be copied from programs other 
than SoftMax Pro and pasted into a Plate section, CuvetteSet section, or Notes section. For Plate 
section data, the format of the copied information must match the Instrument Settings of the target 
Plate section and the settings chosen in the Export Format in the Preferences. Pre-read data cannot be 
pasted into a Plate section. If there is a mismatch between the data to be pasted and the target section, 
SoftMax Pro will attempt to paste the data, but if it cannot do so, an error message will result (an 
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example of such an error message for a Plate section is shown below). After data is pasted into a Plate 
section, the information to the right of the display will show “imported data.” 

 

� NOTE: If you have created a template for a Plate section prior to pasting data, numbers will be shown only 
in the group(s) you have created in the template. Data in other wells will not be reported (but will be 
available if you alter the template). Clearing the template or assigning groups to all wells in the plate will 
show the complete data set. 
Templates for CuvetteSet sections do not change the way the data is shown in the display (all cuvettes will 
show data, regardless of whether or not the template has only certain cuvettes assigned to groups. 

Group Columns 
You can copy a Group column and paste it within another Group in the same experiment or into a 
Group of another experiment. The data included in the pasted columns will be appropriate for the 
target group. 

Highlight the column, select Copy ( C; [CTRL]+[C]) from the Edit menu; then activate the section 
into which you want to paste the column and select Paste ( V; [CTRL]+[V]) from the Edit menu. If 
you highlight a column in the destination section, the column you are pasting will appear to the right 
of the highlighted column. Otherwise it will be appended to the right of all existing columns. 

Columns and summaries in Group sections can also be copied and pasted to other programs. Data 
from other programs cannot be pasted into Group sections within SoftMax Pro, however. 

Copying Formulas and Summaries 
Formulas are used in Group columns, custom reductions, and summaries. Sometimes it is useful to 
copy an existing formula, column, or summary from one area of the program to another, or from one 
experiment to another, rather than taking time to recreate it. Summaries can also be copied and 
pasted within SoftMax Pro. After pasting, both formulas and summaries can be edited. 

� NOTE: Contiguous column formulas may be copied and pasted together. Summaries must be copied and 
pasted individually. 

To copy a formula or summary, highlight it and then select Copy ( C; [CTRL]+[C]) from the Edit 
menu. Activate the area or section in which you would like to paste it; if necessary, with a formula, 
access the particular dialog box into which it will be pasted. After placing the cursor in the correct 
location and highlighting any existing information to overwrite it, select Paste ( V; [CTRL]+[V]) from 
the Edit menu. The pasted formula or summary will appear in the new location. 
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Formulas and summaries can be deleted by highlighting them and pressing the [Delete] key or 
choosing Cut from the Edit menu. 

Duplicate 
All sections and even complete experiments can be duplicated by making the section or experiment 
active and then selecting Duplicate from the Edit menu. All of the information in the section or 
experiment (including data) is copied to the newly created section or experiment. The name of the 
new section or experiment is the same as that of the original with the addition of the word “Copy” 
(e.g., “OldName Copy”). Duplicated sections are created at the end of the experiment. Duplicated 
experiments are created beneath the other experiments. 

Duplicating a CuvetteSet section creates a copy of the previous CuvetteSet section, including the last 
reference that was read. 

Group section tables can also be duplicated. When a Group table is duplicated, its name is added to 
the Template Editor’s list of group names (but the group is not assigned to any wells). 

Graph sections that are duplicated include all settings for plots, fit, etc. 

Notes sections are duplicated exactly, including any summaries and all text. 

New 
New sections and new experiments can be created by selecting New from the Section or Experiment 
menu. If an existing section or experiment is active when this command is chosen, all of the 
information in the section or experiment (except data) is copied to the newly created section or 
experiment. The name of the new section or experiment is the same as that of the original with the 
addition of an incrementing number (e.g., “OldName#2”). A new section is created immediately 
below the active section. A new experiment is created immediately below the active experiment. 

Creating a new CuvetteSet section creates a copy of the previous CuvetteSet section, including the 
template, if any, but this section contains no data. 

New Group section tables can also be created but are devoid of any data. 

New Graph sections include all settings for plots, fit, etc., but contain no data. 

New Notes sections are exact copies of the active Notes section, including any summaries and all text 
(same as duplicated Notes sections except for the name) 
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File Protection 
Individual protocol and experiment data files can be protected from unwanted changes. Two types of 
data protection are available:  

 Password Protection avoids changes being made to a protocol or data file by persons who do 
not know the password and provides an electronic signature with the file; 

 Shielding a Data File preserves the integrity of data in a file by prohibiting any changes to the 
file (with the exception of adding or changing text or summaries in a Notes section). 
Additionally, shielding requires both an author and user name. 

Password Protection 

� NOTE: While password protection is not available in SoftMax Pro Enterprise Edition, both editions will 
support password-protected files generated by older versions of SoftMax Pro. 

� NOTE: Shielded data files will revert to password-protected files with the password scrambled so that 
password protection cannot be removed. 

When a protocol file is password protected, you may read data into the file but may not change it in 
any other way without entering a password. When a data file is password protected, you may view 
the file but are unable to make changes without entering a password. Password protecting a file 
requires that you enter an author’s name and password. The table below shows the actions that are 
protected when a password is assigned to a SoftMax Pro file. 
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Setting and Changing a Password 

Choosing Set Password from the File menu causes the Password dialog to appear. If the active 
document is already password protected, the menu command changes to Change Password. 
Passwords can be from 1 to 8 characters long and can include all characters available from the 
keyboard. You must also enter an Author Name that will be saved and printed with the data. 

 
Set Password/Shielding Dialog Box. Left, no password set previously; right, with previously set password. 

This dialog box appears differently depending upon whether or not you are setting a password for 
the first time or if you are changing/removing a password. If you have not previously set a password, 
the dialog box will appear like that on the left of the figure above. To set a password, type it in both 
boxes (first to set it and then to confirm it). After an Author’s name has been entered, this name will 
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appear at the lower left of the Plate or CuvetteSet section. When a file has been password protected, 
an icon showing a lock will also appear at the top right of the title bar of the SoftMax Pro program 
( ). 

When changing or removing a password, the dialog box will appear as shown on the right of the 
figure above. Before you can change or remove the password, you are required to enter the old 
password in the top text box. After entering the old password, checking the box next to “Remove 
Password” and typing nothing in the rest of the boxes will clear the password from the file when you 
click [OK]. Otherwise, entering a new password and confirming it with a second entry will update 
the password protection. 

Be sure to choose a password that you will be able to remember since the file will be locked to 
changes of nearly any kind should you forget it. If you try to perform an unauthorized action on a 
password-protected file, a dialog box will appear asking you to enter the password. 

� CAUTION: SoftMax Pro provides no means of overriding password protection. If you are 
concerned that you might forget your password, write it down and store it in a safe place for 
future reference. 

 
When this dialog box appears, you must enter the password in order to continue with the action you 
have chosen. Note the Author’s name shown in the lower-left corner of the Plate section. This 
Author’s name and the password are tied together in an electronic signature. Once an Author’s name 
has been entered for a file, it can not be changed unless password protection is removed. 

If you do not remove password protection prior to trying to change the file, every attempt to change 
the file will cause this dialog box to appear. Enabling the Suspend Password option (click the box to 
check it) will stop this repeat prompting. 
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Introduction to Enterprise Edition 
SoftMax Pro Enterprise is a special edition of SoftMax Pro that in addition to all the powerful data 
collection and analysis features available in the standard edition, also includes features that will 
provide data compliance with 21 CFR Part 11 requirements. This program works in conjunction with 
another program – Enterprise Administrator – which manages all SoftMax Pro users and user 
privileges and creates and stores this information in a proprietary Administrator Data File (.edb file 
extension). 

The .edb file contains a listing of all authorized users and associated information including: user 
name, user password, SoftMax Pro access privileges, and electronic signature information. All users 
must have consistent and continual access to a valid Administrator Data File (.edb) in order to use 
SoftMax Pro Enterprise software. This is typically accomplished by placing the .edb file on a shared, 
but secure network location. 

Enterprise Edition of SoftMax Pro 

General Information 
SoftMax Pro Enterprise is a special edition of SoftMax Pro that includes features that provide 21 CFR 
Part 11 compliance in addition to all the powerful data collection and analysis features available in 
the standard edition.  

Identifying the Administrator Data File 
Before SoftMax Pro Enterprise can be used successfully, the administrator must initially locate and 
link  each installed copy of SoftMax Pro Enterprise to a valid Administrator Data File (.edb file 
extension) using the Security:Set Administrative Group menu item.  

This .edb file is created by Enterprise Administrator, a Windows-only application available 
separately from Molecular Devices. While this .edb file can exist on the user’s local computer or on a 
network server, a consistent connection to this file must be in place in order to use SoftMax Pro, as 
this .edb file contains information on all authorized users, including file access and feature privileges 
and electronic signatures. This file is referenced by SoftMax Pro Enterprise during every user login. 

� NOTE: Windows users linking to a .edb file stored on a network volume need to be sure to map the drive 
where this .edb file is located. This will ensure that the file can be properly located by SoftMax Pro 
Enterprise on every launch. Please refer to your Windows operating system Help files for further details 
on mapping a network drive. 

Once this .edb file has been identified using the Set Administrative Group menu item, authorized 
users identified in the .edb file can then use the administrator-assigned features within SoftMax Pro 
in conjunction with their data collection and analysis. 

The combined features of these two software programs provide detailed Audit Trail information on 
every experiment data file. This Audit Trail records all user activities sufficient to recreate each data 
collection effort. User privileges set within the Enterprise Administrator application determine the 
extent of access each user has: which menu choices are available, whether a user can record an 
electronic signature, or even whether a user can perform microplate reads.  
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User Login 
Once the administrator has linked each copy of SoftMax Pro Enterprise to the Administrator Data 
File, all authorized users can now log into SoftMax Pro and begin working. 

� NOTE: New users who have not been added to the Administrator Data File may use SoftMax Pro 
Enterprise as a “Guest”. Guests can only open, view, and print any existing experiment data files or 
protocols. They are not able to modify or save changes to any existing experiment data file or protocol. 

� CAUTION: If someone tries to log in three (3) times using an incorrect User ID/Password 
combination, a security feature in SoftMax Pro will invalidate the file path linking SoftMax Pro 
and the Administrator Data File (.edb). It will not be possible to work with SoftMax Pro or use it 
to operate a microplate reader until the administrator logs in correctly, relocates the .edb file, and 
resets the path. 

Electronic Statements 
Within the Enterprise Edition, a user with sufficient privileges can add an Electronic Statements 
section to an experiment data file. Electronic statements provide a means of designating that an 
experiment has been approved, reviewed, or verified. Privileged users may also apply electronic 
signatures to these statements. Once a statement has been signed, the file may not be modified. 

Electronic statements and signatures are saved with experiment data files and with protocol files, but 
signatures are NOT saved with protocol files. Only one Electronic Statement section is allowed per 
file, and is always the first section displayed for each experiment data file. 

Files created in SoftMax Pro Enterprise will show the filename extensions of ".epr" for protocol files 
or ".eda" for data files and can be opened only by SoftMax Pro Enterprise Edition. Files saved from 
other/older editions of SoftMax Pro (.ppr and .pda files) can be opened by the Enterprise Edition but 
will have no associated Audit Trail. 

Security Menu 
The Security menu within SoftMax Pro Enterprise provides access to most of the features concerned 
with 21 CFR Part 11 compliance.  

 
Set Administrative Group... 

Displays the Open dialog box used to select the Administrator Data File created by Enterprise 
Administrator. This file contains user and password information required by SoftMax Pro Enterprise 
Edition. 

Log On... 
Prompts a user to enter his/her assigned user name and chosen password. All users must Log On if 
they wish to read new microplates or perform any data analysis. 
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Log Out... 
Terminates the user's connection to SoftMax Pro Enterprise. 

Change Password... 
Allows the currently logged in user to change his/her password. 

Show Audit Trail 
Displays a list of all recorded user activities since SoftMax Pro Enterprise was last launched.  

Clear Audit Trail 
Erases all information shown within the Audit Trail window. 

Show Admin Info... 
Displays the privileges available for the current user. 
  

 
User Information 
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E-Statements 
Add Statements 

Add Statements is located under the Experiment menu. 

 
Electronic Statement Setup Screen 

  

This dialog box allows a user to enter a title for the each statement or comment, and to enter a brief 
note for all other users who may be using or accessing a particular experiment data file.  

After the first statement has been created, it will appear as the Statements section at the top of the 
experiment data file, and a new menu item will be available when that section is active 
  

 
Statements Menu 
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Once a statement has been created in the Experiment menu, the Statements menu appears (it replaces 
the other "section" menus such as "Plate," "Notes," etc.). The Statements menu allows the logged in 
user to create or modify statements in the current experiment data file.  

Add Statement...  (Button equivalent: ) 

Allows the current user to create a new statement (if that privilege is available to the currently logged 
in user). 

Modify Statement...  (Button equivalent: double-click the statement) 

Opens the Electronic Statement Setup dialog box, allowing the current user to change the title and 
text of the active statement. 

Remove All Signatures... 

If a statement has been signed, a user with this privilege can remove all signatures from the active 
statement. When all signatures have been removed, the file becomes editable once again. After 
Remove All Signatures... has been selected, you will be prompted to continue. After selecting 
[Continue], you must specify a reason for removing all of the signatures. After you click [Continue], 
you will be prompted for your password.  

Copy Statement 

Copies the contents of the statement onto the clipboard. 

Paste Statement 

Inserts the clipboard contents into a Statement section of the current experiment. 

Sign Statement...  (Button equivalent: ) 

Displays the Sign Statement dialog box. 

 
Sign Statement dialog box 
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Disagree 

Cancels the signature process and closes the dialog box. 

Add A Note 

Allows the user to add a note to the statement prior to signing it.  

Agree 

Prompts the user for a his/her password and then, upon proper entry, signs the document with the 
user name, date, and time.  
  

� NOTE: Once a Statement is signed, the Experiment will be locked and cannot be edited unless signatures 
are removed. Multiple signatures may appear on one statement. Signatures are saved with data files but 
are not saved with protocols. 

   

 
Statements Section 
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Enterprise Administrator 
Pre-Installation Information 

An administrator must be designated prior to installing Enterprise Administrator software. This 
individual will be the primary user of this software and will: 

 Install the Enterprise Administrator software 

 Create the Administrator Data File (.edb) which identifies all authorized users of SoftMax Pro 
Enterprise. 

 Manage the creation and inactivation of new users 

 Manage user privileges that control what features are available to each user. 

 Establishes the link between each copy of SoftMax Pro Enterprise and the Administrator Data 
File. 

 May set the Autosave file path in SoftMax Pro Enterprise to automatically save all experiment 
data files to a central, secure network location. 

Since the administrator is a critical gatekeeper for all users of SoftMax Pro Enterprise, your company 
should consider creating an operating procedure to allow and identify a backup or alternate 
administrator in case the primary administrator is unavailable for any reason. The contact 
information for the administrator and the backup (if designated) should be made readily available to 
all SoftMax Pro users. 

The administrator has a high degree of responsibility. This person will manage the Enterprise 
Administrator Audit Trail which records all activities within this program. The administrator 
manages all user privileges, including the ability for certain individuals to sign E-statements.  
E-Statements allow for electronic signing of documents or experiment data files, and are legally 
binding provided the correct operating procedures are in place.  

� NOTE: SoftMax Pro Enterprise saves the program preferences in each Windows user folder. 

Installation 

� NOTE: While the Enterprise Administrator software is available only as a Windows program, Macintosh 
users of SoftMax Pro Enterprise Edition can connect to and use .edb files generated by Enterprise 
Administrator.. 

To install Enterprise Administrator: 

1. Before installing, disable any antivirus software and ensure that no other applications are 
running. 

2. Insert the Enterprise Administrator CD into the CD-ROM drive. 

3. Open “My Computer” and double-click the CD-ROM icon to display its contents. 

4. Double-click the Setup icon and follow the screen prompts, selecting a custom drive/directory 
where you want the software to be installed if the default is not to your liking. 

Once the software has been installed, the administrator must create the Administrator Data File and 
add SoftMax Pro user information. 

 "Database" – The administrator may create a database that will contain information about users 
of Molecular Devices software. 
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 "User Information" – The administrator may add new users, modify a user's properties, and 
remove existing users. After a new user is added, that user can be allowed to use more than one 
Molecular Devices software program. 

 Groups – Users can be grouped to make assigning privileges easier. 

 "Report" – The administrator may export user information and privileges to a text file and view 
an audit trail of administrator activities. 

 "License" – The administrator may add new licensing information to Enterprise Administrator. 
This information will be used by Enterprise Administrator to control the number of users 
registered to use Molecular Devices software programs. 

The administrator may also set certain global options to make Molecular Devices software more 
secure: 

 Password Aging. 

 Idle Timeout. 

 Forced Password Change – The administrator may set this option globally or individually. 
When set globally, all users will be required to change their password when they first log on. 
For global settings, see the Administrator's Dialog Box. 

 Lock software after three logon attempts. 

How the Programs Work Together 
 The administrator installs Enterprise Administrator (EA) software on his/her Windows-based 

PC. The administrator then creates a new Administrator Data File with EA. Users of SoftMax 
Pro Enterprise are added to the Administrator Data File, and feature privileges are then 
assigned to each user. 

 The administrator then installs SoftMax Pro Enterprise software on individual computers and 
connects each installation of SoftMax Pro Enterprise software to the Administrator Data File. 

 Authorized users can then launch SoftMax Pro Enterprise software, login, and effectively use 
this software to collect and analyze microplate data. 

 Unauthorized users (guests) can open, view, and print experiment data files. This ensures that 
collected and analyzed data is not inadvertently changed, and facilitates FDA review of a file, if 
needed. 

Enterprise Administrator Features 
Enterprise Administrator supports the following major functions: 

 Template Management– Create templates or groups, each with different sets of SoftMax Pro 
Enterprise privileges. This facilitates the creation of multiple users by allowing the administrator 
the ability to assign each user to a template or group instead of repeating the privilege 
assignment for each user separately.  

 User Management – Add new users, modify user privileges, and inactivate or remove existing 
users. 

 File Reporting – Export user information/privileges to a text file. View the Audit Trail of 
administrator activities. 

 License Management – Add new site license information, which will be used by Enterprise 
Administrator to control the number of users registered to use Molecular Devices software 
programs in a legal fashion. 
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 The administrator may also set certain global preferences for enhanced file security: 

 Password Aging – This option requires users to change their password on a regular basis, and 
prevents users from re-using their previous password. 

 Idle Timeout– This option will automatically log users out of SoftMax Pro after a predefined 
period of inactivity. 

 Forced Password Change – When set globally, all users will be required to change their 
passwords when they first log on within SoftMax Pro Enterprise. 

 Lock Software after three logon attempts – This option will invalidate the file path linking 
SoftMax Pro and the Administrator Data File (.edb) after three failed login attempts. It will not 
be possible to work with SoftMax Pro or use it to operate a microplate reader until the 
administrator logs in correctly, relocates the .edb file, and resets the path. 

Templates 
Templates are a collection of user privileges that are defined by the administrator and that can be 
easily and quickly assigned to new or existing users, and can be found in the User Privileges dialog 
box. By taking a few moments to set up user Templates before creating individual users, you stand to 
save considerable time and effort. 

A great example of Template use follows. A particular lab has several graduate students assisting two 
senior researchers and one primary investigator. You could establish the following three Templates 
(Lab Tech, Supervisor, Director) and assign one of these three Templates to each user based on their 
need to access specific features in SoftMax Pro.  

User Templates and Their Abilities in Enterprise Administrator 

Lab Tech Supervisor Director 
Save files & protocols Save files & protocols Save files & protocols 
Read empty plate/cuvette Read empty plate/cuvette Read empty plate/cuvette 
Change instrument settings Change instrument settings Change instrument settings 
Mask/Unmask Wells Mask/Unmask Wells Mask/Unmask Wells 
Change Reduction Settings Change Reduction Settings Change Reduction Settings 
Change Group/Template Change Group/Template Change Group/Template 
 Overwrite plate/cuvette Overwrite plate/cuvette 
 Change Autosave Change Autosave 
 Delete Data Delete Data 
 Add/modify E-statements Add/modify E-statements 
 Add E-signatures Add E-signatures 
  Remove E-signatures 
  Clear Audit Trail 



Chapter 8: Enterprise  

628 SoftMax Pro User’s Manual 

Users 
Modify User 

To modify a user, select that user from the Users list box on the Users Privileges page and then click 
the [Modify User] button. The Modify User dialog box will be displayed. 

 
Modify User Dialog Box 

The Registered software: drop-down box shows all MDC software programs that the displayed user 
may access. If the administrator plans to change user privileges for a specific software program, select 
the software program first in the Registered software: drop-down box. After making changes to the 
user privileges, click the [Apply Change] button. 

Privileges 
After defining a new user name and password, the administrator will be prompted to define 
privileges for each user. A predefined set of privileges can be assigned in one easy step by using the 
Choose Template pull-down menu. Simply select the template that carries the appropriate user 
privileges, and all checked privileges will be immediately assigned to the selected user. The following 
user privileges can be assigned to Templates and Users within Enterprise Administrator and serve to 
regulate the SoftMax Pro features available to different users: 
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User Privileges 
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User Privileges 

User Privilege Allows a user to… 
Save files and protocols Save changes to new or existing experiment 

data files and protocol files. 
Sign e-statements Electronically sign Statement sections. 
Create and modify e-statements Create a Statement section and add text notes 

to the Statement section. 
Clear Audit Trail Erase all tracked and recorded activity from 

the Audit Trail for a specific experiment data 
file. 

Change Autosave parameters Modify the Autosave preferences including 
Append Date/Time, file format, etc. 

Change Group Table / Template settings Edit the Template section settings including 
Samples, Concentrations, Series, and more. 

Change Data Reduction Settings Edit the Reduction settings including 
Wavelength Combination, Limits and more. 

Change Instrument Settings Edit options in the Instrument Setup dialog 
including Read Type, Wells to Read, and 
more. 

Change Notes Text Add or modify the text contained in the 
Notes section of an experiment data file or 
protocol. 

Mask/Unmask Wells Specify which data/wells will be excluded 
from analysis as displayed in the Template 

Read Empty Plate and Cuvette Sections Perform a standard microplate or cuvette 
read for Plate sections that do not contain 
data.  

Overwrite Plate and Cuvette Data Perform a read that replaces data already 
present in a Plate section. 

Remove signatures from e-statements Remove the signatures from a statement, 
making that experiment editable again.  

 

Changing User Passwords 
User passwords require a minimum of 6 characters and an alphabetic and numeric combination. 
While the administrator does not have access to user passwords, they can change a user's password 
by clicking the [Change Password] button from within the Modify User dialog box. 
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New Password Dialog Box 

Checking the Force Password Change checkbox will require users to change their passwords when 
they first log on with SoftMax Pro Enterprise. 

 

More information about Enterprise Administrator  can be found in the Enterprise Administrator User 
Manual.
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Introduction to Remote Control  
SoftMax Pro software can be controlled by other Windows applications with simple ASCII string-
based messages. Using the Win32 “SendMessage” function, SoftMax Pro remote command strings 
such as “ReturnStatus”, “Read” or “SaveAs:myFile” may be sent as a Windows Message to SoftMax 
Pro software for remote process execution. 

Additionally, SoftMax Pro version 4.0.1 or later supports queued processing of remote commands. 
This feature allows the client process to send a block of remote commands and then pause for 
completion as opposed to testing for command completion between each command. The user is 
never blocked or held up while sending remote commands. An additional benefit of this option is 
that, when the client processes the request status, the "ReturnStatus” command is processed 
immediately even if SoftMax Pro software is busy carrying out other tasks. 

 
SoftMax Pro Remote Command Interface 

Notes on Queued Processing 
 To enable queued processing specify “/R” (for Remote) in the program command line when 

launching SoftMax Pro. This option is optional in order to maintain compatibility with previous 
versions that did not include queued processing. 

 After sending a block of remote commands, the caller should wait until the commands have 
been completed by sending the command ReturnStatus which returns the number of remote 
commands in the queue yet to be executed. When “ReturnStatus” returns the message that there 
are zero remote commands waiting, the caller should then check that the reader is idle using the 
Status command. When the queue is empty and the reader is idle, the caller may clear the 
command queue and send another block of commands.  

 The command queue is limited only by the memory capacity of the computer. No SoftMax Pro 
error will be generated when the user has flooded the software with remote commands which 
results in overloading memory. 

 A special command has been created to clear the queue: ClearQueue. This command is 
processed immediately. The Stop command is not queued and processed immediately. 

Send/Receive Remote Commands 
In SoftMax Pro version 4.0.1 or later, the user may choose between sending remote commands using 
windows message (1) WM_SETTEXT or (2) WM_COPYDATA. 

1. The WM_SETTEXT approach. 
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 Call theWin32 RegisterWindowMessage function to register a unique message tag. SoftMax Pro 
uses this tag information when the command is received to distinguish between a Windows 
generated message and an external command. The tag should be a non-zero value. 

UINT tag = RegisterWindowMessage(“SOFTMaxPROMsg”); 

 All messages must be sent to the SoftMax Pro main window. Note that if SoftMax Pro is not 
currently running, this will return a null value, requiring your program to discontinue until 
SoftMax Pro is restarted. 

HWND hwnd = FindWindow(“SOFTMaxPROMainWnd”, “SoftMax Pro”); 

 A complete list of remote commands can be found in SoftMax Pro Commands. Do not forget 
that the tag value, from RegisterWindowMessage above, is sent with the command string. (See 
Microsoft documentation regarding the SendMessage function for more information.) 

SendMessage(hwnd, WM_SETTEXT, tag,  
(LPARAM)remoteCommandString) 

 For example, to send SoftMax Pro a Read command: 
SendMessage(hwnd, WM_SETTEXT, tag, (LPARAM) “Read”) 

• If return data is expected, such as with remote commands Return Status, Return Timing, and 
ReturnData, the data is returned to the clipboard. The advantage of this approach is that it may be 
universally applied to Visual C++ and Visual Basic modules, Excel macros, etc. An example of 
retrieving clipboard data is shown below, where the string data retrieved is finally stored into a 
Microsoft CString object. 

if ( !::OpenClipboard(NULL) ) 
return FALSE; // Error opening clipboard 

HANDLE handle = ::GetClipboardData(CF_TEXT); 
if (handle == NULL) 
   { 
   ::CloseClipboard(); 

return FALSE;         // Error, no data in clipboard 
   } 
// get clipboard data, store in MFC CString object 
CString returnStr = CString ((char *) handle ); 
// close the clipboard 
::CloseClipboard(); 

2. The WM_COPYDATA approach. 

• Call the Win32 RegisterWindowMessage function to register a unique message tag. SoftMax Pro 
uses this tag information when the command is received to distinguish between a Windows 
generated message and an external command. The value returned should be a non-zero value. 

UINT tag = RegisterWindowMessage(“SOFTMaxPROMsg”); 

• Call the Win32 RegisterWindowMessage function to register another unique message tag. Your 
software will use this tag information when the asynchronous windows message is returned, and 
will distinguish between a Windows generated message and an external command. The value 
returned should be a non-zero value. 

UINT replyTag = RegisterWindowMessage(“SOFTMaxPROReplyMsg”); 
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 All messages must be sent to the SoftMax Pro main window. Note, if SoftMax Pro is not 
currently running this will return a null value, thus, requiring your program to discontinue until 
SoftMax Pro is restarted. 

HWND hwnd = FindWindow(“SOFTMaxPROMainWnd”, “SoftMax Pro”); 

 Get your window handle. This is the window to receive the return message. 
HWND MyWnd = GetSafeHwnd()  

 Assign which command you wish to send. Place the command in heap space, which appears to 
be necessary with older Windows operating systems. 

char *cmdStr = “Read”;   // Example remote command  

// to send 

char *msgStr = _strdup(cmdStr); // String duplication, copy 
// command to heap space. 

 Create the Win32 COPYDATASTRUCT message that will be sent. See Microsoft documentation 
regarding this structure for details. 

COPYDATASTRUCT cd;  // This struct is defined in 
// Microsoft include file 

cd.dwData = (DWORD) MyWnd; // Handle to a window 
// receiving return 
// information 

cd.cbData = strlen(msgStr)+1; // Length of message string, 
// adding 1 for null terminator 

cd.lpData = msgStr;  // String pointer to remote  
// command  

  Finally, send the message to SoftMax Pro. A complete of list of remote commands can be found 
in SoftMax Pro Commands. Don't forget that the tag value, from RegisterWindowMessage 
above, is sent with the command string. (See Microsoft documentation regarding the 
SendMessage function for more information.) 

SendMessage(hwnd, WM_COPYDATA, tag, (LPARAM) &cd) 

 Either a completion message or return data is returned. Remote commands Return Status, 
Return Timing, and ReturnData return data. In either case, data is received through an 
asynchronous windows message inside Win32 COPYDATASTRUCT type data packet. 

For example, a typical OnCopyData window callback is shown below, where the string data retrieved is 
finally stored into a Microsoft CString object. Note the use of variable replyTag, discussed above, which 
is used to isolate the correct windows message returned. 
BOOL CUserDlg::OnCopyData(CWnd* pWnd, COPYDATASTRUCT* cd)  
{ 
…. 

   if (cd->dwData == replyTag) 
      { 
         /* String pointing to status */ 
         CString retStatus = (char*) cd->lpData; 
      } 
…. 
} 
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Summarizing Remote Commanding 
SoftMax Pro Software has two groups of remote command instructions:  

1. Remote commands that DO NOT return data.  

Commands that do not receive data are further broken into: 

a. The user wishes to receive a completion message after the command has been sent.  

After receiving a remote command that used the WM_COPYDATA message, SoftMax Pro will send a 
completion message once the command has been executed. An asynchronous window message is 
returned as a window callback, typically an OnCopyData handler, inside the Win32 
COPYDATASTRUCT types data packet. For example, if the “Read” command were sent, an 
“OKRead” text string will be returned after the read is completed.  

b. The user does not wish to receive a completion message.  

Use SendMessage combined with WM_SETTEXT for messages that do not require a completion 
message. The advantage of this approach is that it may be universally applied to Visual C++ and 
Visual Basic modules, Excel macros, etc. 

2. Remote commands that DO return data.  

There are three remote commands that return data: ReturnStatus, ReturnTiming, and ReturnData.  

It the caller has enabled queue operation, the command ReturnStatus is handled immediately, and 
not queued, as are other remote commands. Data is returned in one of two ways: 

a.  After sending the remote command using the WM_COPYDATA message, the caller can look 
for return data through an asynchronous Windows message inside a Win32 
COPYDATASTRUCT type data packet. An asynchronous window message is returned as a 
window callback, typically an OnCopyData handler.  

b. After sending the remote command using the WM_SETTEXT message, the return data will 
be available immediately on the clipboard. The advantage of this approach is that it may be 
universally applied to Visual C++ and Visual Basic modules, Excel macros, etc. 

Programmer Notes 
 COM ports 1-9 can be used for robotics purposes. Molecular Devices recommends using COM1 

or COM2. These are typically the most stable. 

 An Autosaved file from the robotics run can be saved as either a text (.txt) or SoftMax Pro 
experiment data file (.pda). This selection is made in the SoftMax Pro Preferences dialog box 
(choose Edit > Preferences).  

 More random access memory (RAM) will be required to run SoftMax Pro using remote 
commands. Depending on the robotics used and the type of file created with SoftMax Pro 
software, a computer configured with the minimum amount of RAM will restrict the size of the 
file that can be generated.  

An experiment with more than one plate of data could adversely affect SoftMax Pro’s efficiency. If 
increasing the computer’s memory is not an option, Molecular Devices recommends using only one 
plate per file and also ensuring that the computer is dedicated to use for SoftMax Pro (i.e., is not 
being used for other purposes while SoftMax Pro is running). 
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Molecular Devices' Position 
In order to integrate robots from other manufacturers with certain instruments from Molecular 
Devices Corporation, or to automate the export of data from SoftMax Pro to a desired LIMS package, 
Molecular Devices has made available in this chapter the commands enabling the remote control of 
SoftMax Pro. Molecular Devices has tested these commands but does not provide technical support 
for specific integration needs. Molecular Devices strongly recommends that customers consult a 
third-party automation company if internal software resources or expertise are not available. 

All leading automation vendors have integrated SoftMax Pro software and Molecular Devices’ 
instruments with their robotics systems. A partial list of vendors includes: 

 Beckman Coulter (SAGIAN) 

 CRS Robotics Corporation 

 Hudson Control Group 

 QIAGEN Inc. 

If you are a robotics system vendor or an individual integrator and you need more information, 
please contact your local Molecular Devices sales representative or send an email (with the message 
titled “SoftMax Pro & Robotics”) describing your interest to info@moldev.com. 

SoftMax Pro Commands 

ClearQueue 
When queued processing is enabled, this command clears the queue of remote commands that have 
not yet been executed. This command can be useful when you wish to clear the queue (perhaps 
during software development). If queued processing is not enabled, this command does nothing. 

Close 
Close the current document. 

� CAUTION: If the data has not been saved, the document is closed anyway with no user warning. 

CloseCDrawer [FlexStation only]  
Tell SoftMax Pro to close the compound drawer.  

CloseDrawer 
Tell SoftMax Pro to close the instrument drawer.  

CloseTDrawer 
Tell SoftMax Pro to close the tips drawer.  

Copy 
This is equivalent to pressing [CTRL]+[C] or selecting Copy from the Edit menu. 

Notes:  

If a plate section has just been read or is the only selected section, the plate data will be copied to the 
clipboard. 

The data copied will follow the display settings for the current plate (normally Raw Data). 
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Other sections such as Groups can also be copied. The SelectAll command should be used first. 

ExportAs:XXX 
Tell SoftMax Pro to export data in the standard SoftMax Pro format. 

• Attribute available: -a 

The “ExportAs” command without the “-a” attribute overwrites any existing file without warning. 
However, you can choose to append export data to the end of an existing file by specifying the “-a” 
attribute. In addition, this exported file can then be imported and all data can be viewed as a single 
document file. 

Please note that, when using the attribute “-a,” a single space is required between the attribute and 
the following directory and file string. 

Example: 

Without the attribute— ExportAs:c:\SoftMax Pro\exportfile.txt 

With the attribute— ExportAs: -a c:\SoftMax Pro\exportfile.txt 

ImportTemplate:XXX 
Have SoftMax Pro import a template file. The file should comply with SoftMax Pro’s template file 
format. A plate section should be selected prior to importing a template. 

NameCurSection 
This (re)names the current selected section. If no section is selected, nothing happens. 

Notes:  

 This command is used typically to identify different plates in an automated environment. 

 The data copied will follow the display settings for the current plate (normally Raw Data). 

Example: 

“NameCurSection:Plate#002345” 

New 
Have SoftMax Pro send a New command. This creates a new document and reads in the values 
contained in the “Default Protocol.ppr” protocol file. 

NewNotes 
Tell SoftMax Pro to send a New Notes (section) command. This creates a new Notes section within the 
current Experiment. 

NewPlate 
Tell SoftMax Pro to send a New Plate (section) command. This creates a new Plate section within the 
current Experiment. 

OpenAssay:XXX 
Have SoftMax Pro open a protocol file. The file should be in SoftMax Pro’s Assays folder which is set 
using the Assays menu. Protocols can also be stored in subdirectories of the Assays folder. 

Notes:  
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 Only protocol files can be opened. 

 SoftMax Pro will append .ppr to any filename passed in. 

 If the file is not found, SoftMax Pro does nothing. 

Examples: 

“OpenAssay:myFile” 

“OpenAssay:\mySubDirectory\myFile” 

OpenCDrawer [FlexStation only] 
Tell SoftMax Pro to open the compound drawer.  

OpenDF 
Tell SoftMax Pro to open a data file.  

OpenDrawer 
Tell SoftMax Pro to open the instrument drawer.  

OpenTDrawer [FlexStation only]  
Tell SoftMax Pro to open the tips drawer.  

ReturnData 
This command asks SoftMax Pro to send data back from the currently selected plate. Generally this is 
used to send the data directly to the caller instead of using the clipboard. If data is to be returned to 
the clipboard, this command functions like the SoftMax Pro “Copy” command when a plate is the 
currently selected section. 

ReturnStatus 
This command returns the current instrument status. Even if queue operation is enabled, this 
command is not queued and is processed immediately.  

The status is an ASCII string that has  

 Information about the instrument type and version,  

 Whether the instrument is busy or idle,  

 The instrument’s current temperature, and  

 The state of its drawer.  

If queue operation is enabled, the number of remote commands queued is also returned. 

The exact format of this response depends on the type of instrument in use.  

If SoftMax Pro failed to place data in the clipboard, then no return status will be available. 

Example: 

ReturnStatus:<tab><cr> 
ReaderType<tab>Version#<cr> 
State:<tab>[Offline, Busy, or Idle] 
Temperature:<tab>XXX 
Drawer:<tab>[Open or Closed] 
Que:<tab>NumberRemoteCmdsInQueue 
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ReturnTiming 
This command sends back the number of seconds that it would take to read the current plate. For 
multi-plate documents, the plate to be used is chosen in the same way as described in the “Read” 
command. 

SaveAs:XXX 
Have SoftMax Pro save the current document file. The file will be saved in the current SoftMax Pro 
Autosave directory which is set in the Preferences dialog accessed through the Edit menu. Data files 
can also be saved to subdirectories of the Autosave directory.  

Notes: 

SoftMax Pro will append .pda to any filename passed in to it. 

If a file with the same name already exists, SoftMax Pro will automatically overwrite the file with NO 
warning. 

If the subdirectory does not exist, the file will not be saved. 

Examples: 

“SaveAs:myFile” 

“SaveAs:\mySubDirectory\myFile” 

SelectAll 
This is equivalent to pressing [CTRL]+[A] or choosing Select All from the Edit menu. This can be used 
to select data in group tables for copying (not needed for copying plate data). 

SelectSect 
Select a section by name. This can be useful for multi-plate protocols or for selecting Group tables for 
copying. 

Examples: 

“SelectSect:Plate#0023499” 

“SelectSect:Group#1” 

SelectSectNum 
Select a section by its order in the document. This can be useful for multi-plate protocols or for 
selecting Group tables for copying. 

Example: 

“SelectSectNum:3 ” 

SetFolderAs:XXX 
Set the current protocol directory. You must specify the root directory. 

Example: 

“SetFolderAs:c:\SoftMaxPRO\Basic Protocols” 

SetPort:X 
Tell SoftMax Pro to set a serial COM port. 
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SetTemp:XX.X 
Send a command to set the current instrument incubator temperature. 

Setting temperature to zero turns off the incubator.  

SetUserName 
Send a command to set the User name prior to opening a protocol file that has been shielded. 

The User name is not the same as the Author name—it is the name of the person using a shielded 
protocol to gather data. The User name is not used to validate an electronic signature for a password-
protected file. 

Notes: 

 This command tells SoftMax Pro to save the user’s name internally so that when an 
“OpenAssay” command is issued for a shielded protocol, SoftMax Pro will assign this User 
name for the newly created document. 

 This user name remains stored within the program until the SoftMax Pro is terminated. 

 The user name will be ignored if the currently open data file was not generated from a shielded 
protocol. 

Example: 

“SetUserName:John Doe” 

SetUserPassword 
Prepare SoftMax Pro with the protocol password prior to opening a shielded protocol file. 

Notes: 

 This command tells SoftMax Pro to save the protocol password internally so that when an 
“OpenAssay” command is issued using a shielded protocol, SoftMax Pro will use this password 
to open the file. 

 This protocol password remains in use until the program terminates or another protocol 
password is sent. 

 The password is limited to 8 characters. 

Example: 

“SetUserPassword:bop-i-do” 

SoftMax Pro Commands 
SoftMax Pro commands are single words. If parameters are required with a command, a colon is used 
between the command and the parameters.  

Commands may be sent using either the WM_SETTEXT or WM_COPYDATA approach. Completion 
messages or data are returned directly when commands are sent using the WM_COPYDATA 
method. Completion messages or data are placed in the system clipboard when commands are sent 
using the WM_SETTEXT method.  

Stop 
Send SoftMax Pro a command to stop reading. If queue operation is enabled, this command is not 
queued, the queue is cleared, and the command is processed immediately. This is similar to clicking 
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the Stop button on the SoftMax Pro tool bar except the Stop button does not affect remote command 
processing or its queue. 

This command should be sent before any Close or Quit command if there is a possibility that the 
instrument is still reading. 

� CAUTION: If the data has not been saved, the application quits anyway with no user warning. 

Visual Basic (Excel Macro) Example 
' First some housekeeping code:  
Private Declare Function FindWindow Lib “user32” Alias _ 
“FindWindowA” (ByVal lpClassName As String, _ 

ByVal lpWindowName As String) As Long 
Private Declare Function SendMessage Lib “user32” Alias _ 
“SendMessageA” (ByVal hWnd As Long, ByVal wMsg As Long, _ 

ByVal wParam As Long, _ 
ByVal lParam As String) As Long 

Private Declare Function RegisterWindowMessage Lib “user32” Alias _ 
“RegisterWindowMessageA” (ByVal msgName As String) As Long 
'----------------------------------------------------------------------------- 
Const WM_SETTEXT = 12 ' define a windows message value 
Function SendMsgToPRO(ByVal msgStr As String) As Long 
 hWnd = FindWindow(“SOFTMaxPROMainWnd”, “SoftMax Pro”) 
 If hWnd = 0 Then ' one beep means Pro is not running. 
  Beep 
Else 
 ' Pro is running so use the SendMessage API 
 softmaxMsg = RegisterWindowMessage(“SOFTMaxPROMsg”) 
 If softmaxMsg = 0 Then  
   ' This version of PRO does not understand external msgs 
   Beep 
   Beep 
  Else 
     SendMessage(hWnd, WM_SETTEXT, softmaxMsg, msgStr) 
  End If 
 End If 
End Function 
'----------------------------------------------------------------------------- 
' This is an example of how to use the above routine 
Sub SendNewMsgToPRO() 
SendMsgToPRO (“New”) 
End Sub 
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MFC C++ Interface to SoftMax Pro Remote Commands that Return Values 
Some SoftMax Pro software IPC commands return values. By default they put the data in the 
clipboard, but optionally they will use the WM_COPYDATA mechanism to return data directly to 
the caller.  

In order to have the SoftMax Pro response returned in this fashion, the commands must be sent using 
WM_COPYDATA so that SoftMax Pro knows what to send the response to. 

SoftMax Pro will then reply with another WM_COPYDATA message that contains the response. 

MFC Example Code: 
// Global variable used in holding ID determined through RegisterWindowMessage 
// This ID is later used to discriminate between WM_COPYDATA messages  
// received, to understand which WM_COPYDATA coming back has the  
// instrument status. 
unsigned int   gExternalReplyMsgID; 
… 
… 
// Entry point for typical MFC windows program 
int APIENTRY WinMain(HINSTANCE hInstance, 
   HINSTANCE hPrevInstance, 
   LPSTR lpCmdLine, 
   int nCmdShow) 
{ 
… 
… 
 // Perform this initialization early in the program 
        gExternalReplyMsgID=RegisterWindowMessage(“SOFTMaxPROReplyMsg”);  
… 
… 
} 
// Callback for processing windows messages received 
LRESULT CALLBACK WndProc(HWND hWnd, UINT message, WPARAM wParam, LPARAM 
lParam) 
{ 
… 
… 
    // begin processing incoming window messages 
    switch (message)  
    { 
    case WM_COPYDATA: 
      // Windows WM_COPYDATA message received. 
      // Check if this message contains status message expected. 
      COPYDATASTRUCT *cd; 
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      cd = (COPYDATASTRUCT*) lParam; 
      if (cd->dwData == gExternalReplyMsgID) 
      { 
       // length of status message string plus 1 
            unsigned int len = cd->cbData; 
// instrument status message returned 
          char *str = (char*) cd->lpData; 
       // Process return data as you wish 
       …………….       
       } 
 
      case WM_COMMAND: 
          // Windows command to process the application menu selection 
          wmId = LOWORD(wParam);  
          wmEvent = HIWORD(wParam);  
          // Parse the menu selections: 
          switch (wmId) 
          { 
    // For this example, the user has set up a  
    // menu selection to soliciting instrument status from 
    // SOFTMaxPRO application software. 
    // Id IDM_COPYDATA defined in resource. 
               case IDM_COPYDATA: 
                  sendCommand(); 
   
               ….. 
          } 
          ….. 
        } 
…. 
} 
void sendCommand() 
{ 
  // User has selected menu selection to send SoftMax Pro remote  
  // command “ReturnStatus”. See SoftMax PRO User Manual,  
  // chapter 12, Remote Command Language. 
                
  char *cmdStr = “ReturnStatus”;          
  char *msgStr = new char[strlen(cmdStr)+1];    
 
  // Place command in heapspace. Note that a run time error may  
  // occur unless command is copied to heapspace  
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  strcpy(msgStr, cmdStr);       
                
  // This struct is defined in MFC include files 
  COPYDATASTRUCT cd;                   
  // Handle to a window, type HWND. 
  cd.dwData = (DWORD) hWnd; 
  // Length of message string plus 1 
  cd.cbData = strlen(msgStr)+1;          
  // Remote command string is in heapspace 
  cd.lpData = msgStr;                   
              
  // Primary method in sending windows command to SoftMax Pro application. 
     HWND hwnd = FindWindow(“SOFTMaxPROMainWnd”,  
  “SoftMax Pro”); 
    UINT smaxMsg = RegisterWindowMessage(“SOFTMaxPROMsg”); 
       SendMessage(hwnd, WM_COPYDATA, (WPARAM) smaxMsg,  
  (LPARAM) &cd); 
  // Message sent, delete heapspace no longer used. 
    delete msgStr;       
} 
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Introduction 
This information is provided to assist you in resolving problems with SoftMax Pro software. If an 
error occurs for which you do not have a solution, or if you don't know the source of a problem, first 
check to see if the problem is listed here, then follow the troubleshooting steps to resolve it. For your 
benefit, troubleshooting workarounds have been listed by operating system  and functional type. 

If you encounter a problem that is not listed in this section, or if you need additional assistance, in the 
U.S., call Molecular Devices Technical Services at 1-800-635-5577; elsewhere, call your local 
representative. For problems with an instrument that do not relate to the use of SoftMax Pro 
software, please see the instrument manual for more information. 

Troubleshooting Contents 
 General Issues 

 Enterprise Edition Issues 

 Serial / USB Communication Issues 

 Display Issues 

 Printing Issues 

 Windows-specific Issues 

 Macintosh-specific Issues 

 General Message Boxes and Alerts 

 General Error Messages 
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General Issues 

Symptom Possible Solution 
Data from a Cuvette section 
reference reading does not seem 
correct/accurate. 

Check that the cuvette is oriented properly in the cuvette port of the reader. 
If performing an absorbance reading, ensure that the clear (unfrosted) sides 
of the cuvette face right and left (as you face the instrument). Make sure 
clear cuvette surfaces are free of fingerprints or other blemishes. 

SoftMax Pro software runs 
sluggishly, or appears to freeze for 
extended periods of time. 

Random Access Memory (RAM) is likely limited. MDC recommends 
upgrading to at least 256MB RAM. 

SoftMax Pro runs sluggishly, or 
appears to freeze for extended 
periods on systems with sufficient 
(>256MB) RAM. 

Unsuccessful communication attempts. 
1) Check that cable between computer and instrument is connected 
properly. 
2) In the instrument preferences (Edit:Preferences) verify that the cable 
connected to the instrument and the selected Com Port agree. 
File may contain too much data. 
1) Create new experiment data files and do not save more than 20 plate 
sections in each file.  
2) Computers with insufficient RAM and processing power may exhibit 
sluggish performance even before 20 plate sections. Users performing 
kinetic reads with  large plates and/or many data reads/ collected points 
may also experience sluggish performance on slower systems. In these 
situations, do not save more than a few plate sections in each experiment 
data file.  
3) Select File:Save As menu item and save a copy of the file exhibiting 
sluggish performance. Then, delete appropriate plate sections from the 
copy until performance improves. 
Recalculation may be enabled. 
Suspend recalculation by choosing Edit > Suspend Recalculation. Doing 
this will free up resources on your computer.  
Remote commands may be enabled. 
1)  If using remote messaging with a smaller amount of memory, MDC 
recommends using only one Plate or CuvetteSet section per file. 
2)  Dedicate the computer to running SoftMax Pro (do not use it for other 
purposes while SoftMax Pro is in use). 
AutoSaving to network folder with many data files: 
1) Verify with your IT staff that your company’s network is performing as 
expected. A slow company network can dramatically slow down perceived 
performance of SoftMax Pro software.  
2) Selecting “Append Date” and “Append Time” will improve AutoSave 
performance due to directory indexing and a reduced need to check for 
files with existing names.  
3) Selecting a new target directory with fewer files will improve AutoSave 
performance. 
 

Attempting to import tab-delimited 
kinetic data file results in “Pasted 
Text doesn’t match plate settings” / 

Users seeing these error dialogs have likely opened and saved the data file 
in another software program (Excel / Word). While the file may appear 
intact, other software applications have been known to add hidden 
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“Instrument reported error” 
messages. 

characters before saving (such as [Tab] or [CR]) which fundamentally 
changes the integrity of the original data files. It is recommended to import 
tab-delimited kinetic data files directly into SoftMax Pro WITHOUT 
opening these files in any other program. 

Attempting to save an experiment 
data file results in error: Could not 
complete the last command because 
the file was not found. Result Code = 
-43” 

This was frequently seen for users .pda files saved with file names greater 
than 59 characters (in v3.1.2) characters before the '.pda'.  The only 
workaround is to shorten the name to 59-characters or less (including 
spaces). 
 
A second occasional cause of this error is when a customer double-clicks 
the PDA or PPR file to open it, rather than taking the File / Open path from 
within SoftMax Pro.  To resolve that, open the files from within SoftMax 
Pro by clicking open the 'File' menu and selecting 'Open', then using the 
browser to locate the file. 
 
A third cause of the error can be, paradoxically, due to an attempt to save a 
network-stored file when it is open by someone else or in use by some 
other process.  If the file is opened on a network drive, copy it to the local 
workstation and then open and save changes there, then send a copy to the 
network folder.  If the problem was network sharing issues, then saving to 
the local workstation after opening a copy put on the local workstation 
should be error-free. 
 
Errors in drive mapping can also generate this error dialog. 

Attempting to save an experiment 
data file results in error: Could not 
complete the last command because 
there is already a file with this name. 
Result Code = -48” 

Suggested workaround: change the name of the file you are attempting to 
save. 
This –48 error is being generated directly by the OS (most frequently 
Windows NT) to alert the application that while SoftMax Pro is attempting 
to create a new file – this file already exists.  It is the same event that 
triggers a "A file with that name already exists, do you want to overwrite 
the file" message frequently seen when attempting a “Save As” and leaving 
the file name the same.  If there's no user to approve the file overwrite, the 
best SoftMax Pro can do is to present the user with an error dialog so that 
the existing file is not inadvertently overwritten. 

Attempting a plate Read results in 
“1010 error” 

1. For Gemini instruments, this error has been seen when two or more 
wavelengths are specified and “Auto Cutoff” was not checked. Check the 
Control:Instrument Setup dialog box to ensure that only valid parameters 
are entered for  Wavelengths, Timing, etc. Re-select “None” for cutoff filter 
choices. 
2. For UV/Vis instruments, this error has been seen when illegal 
(alphabetical) characters exist in the Wavelength fields. Check the 
Control:Instrument Setup dialog box to ensure that only valid parameters 
are entered for Wavelengths 
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Enterprise Edition Issues 

Symptom Possible Solution 
Strange new files created by 
Enterprise Administrator. 

_LOCK.edb and _TEMP.edb are created while Enterprise Administrator 
application is updating the target .edb Administrator Data File with new 
information. These temporary files are usually removed immediately, but 
may not be deleted if the user does not have adequate Write/Modify 
privileges as defined by the Windows operating system. To correct this: the 
user workstation/NT login MUST have Create and Modify rights to the 
folder where Enterprise Administrator and the .edb file are stored.  

Users unable to connect to the 
Administrator Data File (.edb) ; 
Users unable to change their own 
passwords. 

This problem has been identified as a Windows operating system issue 
pertaining to Windows users and the file permissions / privileges assigned 
to each Windows user. 
 
Every network operating system requires a member PC to provide its PC 
user’s ID and password (network login).  That login is matched to a 
security and privileges profile for the user, and the profile found 
determines what access and activities that user, and therefore that 
computer, will have.  In addition to the global access rights assigned at 
login, other permissions for access or use can be set in localized network 
areas, denying access to certain folders or files for example.   
 
Most of what a given PC, and all of the software programs on it, can do is 
controlled by the rights and permissions assigned to that person who first 
logs into the network.  As an added feature, some programs like SoftMax 
Pro Enterprise require their own user logins so that activities within the 
program can be further directed or defined – as directed by 21 CFR Part 11. 
 
Success in carrying out some of the activities specified within SoftMax Pro 
are dictated by each user’s Windows privileges. For example, a lab director 
acting as the Administrator when using Enterprise Administrator can 
require each SoftMax Pro user to  change their SoftMax Pro password on 
the next login.  Each user can ONLY complete this successfully if they have 
sufficient Windows privileges to Modify or save changes to files – such as 
the Administrator Data File (.edb) being changed with this operation.  If 
the user is unable to change their password, it is more likely than not that 
the user does not have sufficient Windows privileges to save changes to 
this .edb file – something that changing one’s password requires. Please 
consult your IT staff for more details on Windows user permissions. 

SoftMax Pro Enterprise users cannot 
stay connected to a specified 
Administrator Data File (.edb) 

Users connecting to a .edb file stored on a corporate network volume 
MUST map the network drive where this file is stored in order to maintain 
a consistent and valid connection with this user/privilege database. While 
each version of Windows is different, here are guidelines on mapping a 
network drive with Windows 2000: 
1) Double click on “My Computer” icon on the Windows Desktop and 
select Tools:Map Network Drive. 
2) Specify an unused “Drive:” letter/location for the new LAN drive being 
mapped. 
3) Click the [Browse] button and identify the correct server volume in the 
“Browse for Folder” dialog. 
4) Click [OK] when a destination volume/directory is selected. 
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5) Check the “Reconnect at logon” box in the Map Network Drive dialog 
box., and then click [Finish].Map Network Drive dialog box., and then click 
[Finish].  

SoftMax Pro Enterprise users cannot 
successfully complete AutoSaves 
after rebooting their computer. 

Users attempting to AutoSave to a corporate network volume  MUST map 
the network drive where this file is stored in order to maintain a consistent 
and valid connection with this user/privilege database. While each version 
of Windows is different, here are guidelines on mapping a network drive 
with Windows 2000: 
1) Double click on “My Computer” icon on the Windows Desktop and 
select Tools:Map Network Drive. 
2) Specify an unused “Drive:” letter/location for the new LAN drive being 
mapped. 
3) Click the [Browse] button and identify the correct server volume in the 
“Browse for Folder” dialog. 
4) Click [OK] when a destination volume/directory is selected. 
5) Check the “Reconnect at logon” box in the Map Network Drive dialog 
box., and then click [Finish]. 

Creating a new Administrator User 
Data file (.edb) contains template 
information from old .edb file. 

Since Enterprise Administrator stores templates in the mdacdmgr.ini file 
and not the .edb file, simply delete the .ini file to remove these templates 
globally, or manually delete the Templates within the new .edb file. 

 

Serial / USB Communication Issues 

Symptom Possible Solution 
The instrument icon shown in the 
upper left corner of the SoftMax Pro 
window has an “X” through it. 

SoftMax Pro is not actively communicating with the attached reader. 
Follow the following steps: 
1) Is the instrument turned on? 
If it is or if the instrument icon also has the words “No port selected” 
through it, 
2) Launch SoftMax Pro software and verify the Preferences are set to the 
proper serial communications port. This setting must be the actual serial 
port to which the cable from the instrument is physically connected to the 
computer. COM1 or COM2 are recommended for Windows users.  
If the communication settings are correct, the reader is on, and communication is 
still not functioning properly… 
3) Quit SoftMax Pro software, turn off power to both the computer and the 
reader. Ensure the cable connections between the instrument and computer 
are secure. Turn both the reader and computer on again and launch 
SoftMax Pro software. 
If an “X” still appears over the icon, you may be using the wrong serial cable type, 
or may be experiencing a Windows serial port configuration problem. Consult with 
your IT staff for more details. 
FlexStation users: If an “X” still appears over the icon… 
4)  Change the setting for the “Serial Comm Speed” found in the 
Preferences dialog box (choose Edit > Preferences). 
If the setting is currently “9600,” change it to “57600” or vice-versa. FlexStation 
and SoftMax Pro both initially use a baud rate of 9600 to communicate over the 
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serial line. SoftMax Pro boosts the baud rate to 57600 when FlexStation is reading 
in FLEX mode. When the read is finished, SoftMax Pro automatically reduces the 
baud rate to 9600 again. In order to communicate at different baud rates, SoftMax 
Pro sends a command to the FlexStation to change its baud rate also. 
Communication is lost if the baud rates don't match. Under normal operations, it 
shouldn't be necessary to change the communication speed. Should communication 
be lost and other measures do not restore it, you may attempt to reestablish 
communication by resetting the baud rate manually using the baud rate pop up 
menu in the Preferences. The default baud rate shown on the pop-up menu 
indicates the current setting for the computer's serial port. To reestablish a 
connection, the user must set the serial baud rate of the computer to match the 
baud rate of FlexStation (either 9600 or 57600; other baud rates are included but 
should not be used). 

Reader unable to communicate with 
Mac OS 9.0.2 and Keyspan Serial 
Adapter version 1.2 

Keyspan has seen an issue on Macintosh system running OS 9.0.2 where 
Port 1 on the Twin Serial Adapter becomes non-functional after rebooting 
Short term Solution: After the computer boots up, disconnect the adapter 
for 3-5 seconds, and then re-connect it. Because SoftMax Pro keeps the 
serial port continuously open for communication between the software and 
the instrument, make sure to quit the SoftMax Pro application first before 
disconnecting the adapter. If not, the Macintosh will crash.  
Recommended Solution: Update to Apple Macintosh OS9.2.2 immediately. 
This corrects this problem entirely, along with many other 
communications-based issues around serial and USB data conversion. This 
update is available free from Apple at 
http://www.info.apple.com/support/downloads.html 

Problems with Belkin USB-to-serial 
adapters. 

Some users have reported problems with some Belkin adapters and earlier 
releases of Apple’s Macintosh OS that required a lengthy workaround in 
order to get the computer and reader to communicate. To minimize 
problems with USB-to-serial adapters, MDC recommends: 
1) Update to Apple Macintosh OS9.2.2 immediately. 
2) Use validated adapters like all products from Keyspan. 
3) Use the latest released version of SoftMax Pro software. 

All primary buttons and menu items 
appear active, but do nothing. A 
microplate cannot be Read. 

Valid Administrator Data File has not been set: 1) Select Security: Set 
Administrative Group menu item. 2) Locate and select a valid 
Administrator Data File. 
And/Or 
Current user is not properly logged in to SoftMax Pro Enterprise. 1) Select 
Security: Set Administrative Group menu item. 2) Select Security: Log On... 
menu item. 3) Enter a valid username and password, and click [OK]. 
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Display Issues 

Symptom Possible Solution 
Text in the header field of the Print 
dialog box “disappears” if you press 
the Return or [Enter] key. 

The text is still there but is not visible. It will print. If you click in the box 
and drag the mouse to the left, it will reappear. 

The Notes section is longer than one 
page. 

The bottom line of the first page and the top line of the second page are 
partially printed.  
Insert a linefeed or carriage return into the Notes section at the 
appropriate place to manually insert an empty line that will not be 
affected by the print command. 

When printing a well graph, part of it is 
missing. 

If you enlarge the well graph to greater than 12 inches, the graph will 
not fit on an 8.5 by 11-inch page and the printout will be truncated. 
Reduce the size of the graph and print again. 

 

Printing Issues 

Symptom Possible Solution 
Header text “disappears” if the 
[Return] or [Enter] keys are pressed. 

The text is still there, but not visible. This text will print. To refresh the 
screen display, simply click in the box and drag the mouse to the left. 

Text in Notes sections is printed across 
two pages. 

Insert one or more carriage returns in the Notes section where the text is 
being split across two pages. 

Part of a Well Graph does not print. Reduce the size of the Well Graph and print again. If any graph is sized 
greater than 12 inches, it will be cropped when printed.  

 

Windows-specific Issues 

Symptom Possible Solution 
Strange –43/-48/-54 error messages 
generated when attempting to save an 
experiment data file. 

This has been reported as an intermittent problem seen by users 
attempting to open files stored on a network volume. The suggested 
workaround is to: 
1) Copy the file to your local computer and work with it locally. 
2) Save changes to the file, and then copy it back to the network 
location.  

Printshop software launches instead of 
SoftMax Pro when attempting to open a 
.pda file. 

Both Brøderbund’s Printshop and SoftMax Pro use the extension “.pda” 
to identify files. If Printshop is already installed when you install 
SoftMax Pro on your computer, the “.pda” extension will have already 
been registered with Windows as a Printshop file, and SoftMax Pro files 
will appear with the Printshop icon. Double-clicking any file ending 
with the “.pda” extension will launch Printshop instead of SoftMax Pro. 
There are two ways to fix this: 
1) Launch SoftMax Pro software and open the data or protocol file from 
within the program using the File:Open menu item; or 
2) Modify the “default” program that launches when you attempt to 
open a file from the Windows desktop: 
In My Computer or Windows Explorer, click the View menu, and then 
click Options. 
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Click the File Types tab. 
In the list of file types, click Printshop. The settings for Printshop will be 
shown in the File Type Details box (“PDA” will appear as the extension 
used). 
Click [Edit]. 
In the actions box, click [Open]. 
Click [Edit], and then specify SoftMax Pro as the program you want to 
open files that have this extension. To do this, click the [Browse...] 
button and locate the SoftMax Pro executable file. The default location is 
c:/Program Files/SoftMax Pro, unless a different installation destination 
was specified by the user installing this software. 
Doing this will cause “.pda” files to be associated with SoftMax Pro 
instead of Printshop.  
In order to open Printshop files, you will need to open the Printshop application 
and open “.pda” files relating to Printshop from within that application 
(double-clicking a “.pda” file will now launch SoftMax Pro software). 

  

 

Macintosh-specific Issues 

Symptom Possible Solution 
SoftMax Pro is not a native OSX application. SoftMax Pro has been tested both with OS9.2.2 and the latest 

versions of OSX, and it performs and works as expected. OSX 
users can use SoftMax Pro software running in the Classic 
environment without incident. 

SoftMax Pro crashes in OS 9.0.4 Existing problems in older versions of the Apple Macintosh 
OS (pre 9.2) have required MDC to update our minimum 
system requirements to OS9.2. If you are running an older 
release of OS9 – particularly 9.0.2 and 9.0.4, it is 
recommended that you upgrade to OS9.2.2 immediately to 
resolve these intermittent crashes. This OS update is available 
free from Apple at 
http://www.info.apple.com/support/downloads.html 

Random system crashes or sluggish performance. Quit other applications that may be running (using RAM) and 
increase the available RAM allocated for running SoftMax 
Pro: 
OS9 users: 
1) Ensure that your Macintosh has enough RAM to be 
running SoftMax Pro (256MB is recommended) by selecting 
the Apple:About this Computer menu item. The value to the 
right of “Built-in Memory” must be at least 128MB. 
2) With the SoftMax Pro application selected, select the 
File:Get Info menu item.  
3) Click the “General Information” pull-down and select 
“Memory”. 
4) Change both the Minimum and Preferred Sizes to a value 
5,000kb over the current settings. 
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OSX users: 
1) Ensure that your Macintosh has enough RAM to be 
running SoftMax Pro (256MB is recommended) by selecting 
the Apple:About this Mac menu item. The value to the right 
of “Memory” must be at least 256MB since part of this 
memory must be used by OSX to launch and run the Classic 
environment. 
2) With the SoftMax Pro application selected, select the 
File:Get Info menu item. 
3) Click on the triangle next to “Memory” and change both 
the Minimum and Preferred Sizes to a value 5,000kb over the 
current settings. 

Macintosh users cannot open some .pda / .ppa / 
.eda files generated by SoftMax Pro Windows. 

This problem was addressed in v4.6. Users can also transfer 
files over corporate LANS/networks to avoid the loss of file 
format information that is frequently lost when files are sent 
via email. 

Macintosh OS 9.0.4 users experiencing difficulty 
opening SoftMax Pro Help files.  

This problem was addressed in v4.6. It is also recommended 
that you upgrade to OS 9.2.2 immediately to resolve other 
related problems. This OS update is available free from Apple 
at http://www.info.apple.com/support/downloads.html 

Application crashes while performing Kinetic 
data reads with many data points 

Quit other applications that may be running (using RAM) and 
increase the available RAM allocated for running SoftMax 
Pro: 
Follow the steps listed above, but increase the Minimum and 
Preferred Sizes to a value 10,000kb over the current settings. 

Serial-to-USB adapter problems Refer to the Serial/USB Communication Issues section earlier in 
this chapter for details. 

Not enough serial ports to read and print at the 
same time (single serial port computers). 

Some older Apple Macintosh systems were only configured 
with a single 8-pin DIN serial port, serving both as the printer 
and modem port. SoftMax Pro can either communicate with 
the Reader or print through this serial port, but both printer 
and Reader cannot remain connected to the serial port at the 
same time.  
To avoid repeatedly changing the cable connected to the 
single serial port, you must either connect to an Ethernet-
based printer (allowing you to dedicate the serial port for 
your reader), or use an A/B switch box (one 8-pin DIN input 
port with two 8-pin DIN output ports). This switch box can 
then be attached to the single serial port of the computer. The 
A/B switch of the switch box is used to physically switch the 
connection between the reader and the printer. 
Because of the limitations of the single serial port Macintosh, the 
Autoprint feature of SoftMax Pro cannot be used for serial-based 
printers. 

SoftMax Pro files do not display the custom file 
icon ; SoftMax Pro files do not launch into 
SoftMax Pro when double-clicked. 

MacOS9 users should rebuild the Macintosh Desktop file by 
1) Selecting the Special: Restart menu item, 2) holding down 
the [Apple]+[Option] keys simultaneously UNTIL a dialog is 
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displayed prompting the user to rebuild the desktop. 3) Click 
[OK]. 
Mac OS X users should rebuild the Classic environment 
Desktop file by 1) Selecting the Apple Menu Item: System 
Preferences, 2) click on the System:Classic item, 3) click on the 
Advanced tab, and 4) click on the Rebuild Desktop button. 

Macintosh crashes while launching SoftMax Pro. Existing problems in older versions of the Apple Macintosh 
OS (pre 9.2) have required MDC to update our minimum 
system requirements to OS9.2. If you are running an older 
release of OS9 – particularly 9.0.2 and 9.0.4, it is 
recommended that you upgrade to OS9.2.2 immediately to 
resolve these intermittent crashes. This OS update is available 
free from Apple at 
http://www.info.apple.com/support/downloads.html 
If you are still experiencing crashes while launching SoftMax 
Pro with OS 9.2 or greater: 
Ensure a printer is selected in the Chooser 
Disable all Extensions during the next restart by holding 
down the [Shift] key while the Macintosh starts up and 
keeping it depressed until you see a screen message 
indicating that “Extensions are off”. 
Attempt to launch SoftMax Pro after restarting with 
Extensions off. If SoftMax Pro does launch and work 
successfully, you are experiencing an Extension conflict with 
some other third party extension and will need to 
troubleshoot this by selecting the Apple Menu Item: Control 
Panels: Extensions Manager. 

 
Message Boxes and Alerts 

Message boxes appear to inform you that the action you are attempting needs adjustment in some 
way. Message boxes contain only an [OK] button that you can click to remove the message after you 
have read the information. 

Alerts inform you that the action you are about to take will have consequences that may not be 
reversible or may make a significant change within the program. Alerts are indicated by an alert 

symbol ( ). Alerts occurring in the Instrument Settings dialog box generally must be corrected 
before you are able to close the box and begin the assay. Other alerts may not prevent an action from 
continuing but may cause errors after the run is started. 

Instrument Settings Alerts 
One example of an alert appears when you are defining instrument settings for a Kinetic assay and 
the read interval is not long enough to allow the required actions to occur. The message might look 
like this: 
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Example of an Alert Message 

Setting a longer read interval removes the message and allows you to continue. 

Other examples of alert messages that appear in the Instrument Settings dialog box are found with 
the FlexStation instrument. These are: 

 

 

 

 

SoftMax Pro Software Alerts 
The Alerts that follow are presented alphabetically by first line of the alert message. 

#Low or #Sat Messages (Plate Section Data) 

 

� NOTE: These reports may appear in the Plate section of fluorescent-reading instruments during Endpoint 
mode. 

The error #Sat appears when the well is saturated (i.e., too much signal). Try lowering the PMT 
setting and re-read the data. If the well is still saturated after the PMT is set to “Low,” try diluting the 
sample. 

The error #Low appears if the flash lamp missed the flash for that well. Reread the affected well(s). 
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A plate descriptor used by this file is for another instrument. 

 
This error message appears if you have one type of instrument connected to the computer (or chosen 
in the Preferences) and open a file that was created using a different instrument. 

Checksum: Failed (Plate Section Data) 

 

� NOTE: This report appears in the Plate section of the FlexStation instrument only. 

The checksum feature checks for accuracy of data received from the FlexStation instrument. 

The message alerts you to the fact that a plate descriptor for the instrument that is connected (or 
chosen) has been used instead of that saved with the file. If you save the file, the new descriptor will 
be saved instead of the old. If you wish to retain the old descriptor, save the file under a new name. 

Error Messages 

Error messages contain a stop graphic ( or ) and text explaining the error, if the software can 
report it. Some errors, such as an obstruction of the drawer of the microplate reader, report the 
problem, allow you to correct it, and then proceed with the assay. Other errors are not recoverable 
and require that you perform the action or assay again. 
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Instrument communication problem 

 
This error appears when the cable connection between the computer and the instrument is not 
functioning properly. Clicking [OK] will stop the run. 

This error appears if the cable has been disconnected, but it could also occur with a bad cable, serial 
port, or communications board. 

Instrument reported a fatal error 

 
This error appears when the instrument experiences a hardware failure or if a jam occurs (in the tip 
box, for example). The run in progress is not recoverable. Call Molecular Devices Technical Support 
to receive information that is pertinent to the particular situation that led to receiving this error 
message. 
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Pasted text doesn't match plate settings 

 
You have attempted to paste values from an external file containing ASCII tab-delimited data into a 
Plate section or CuvetteSet section, but the number of fields of data that you have copied does not 
match those required by the setup of that Plate section or CuvetteSet section. 

For Plate section data, the format of the copied information must match the Instrument Settings of the 
target Plate section and the settings chosen in the Export Format in the Preferences. Check that all the 
required fields are present and that you have highlighted all of these fields prior to copying the data 
and try pasting again. 

Recover will reset FlexStation 

 

� NOTE: This message appears with the FlexStation instrument only. 

This message appears after you choose Recover from the Control menu. Choosing the Recover 
command may be necessary after a power failure (or after shutting down a run prematurely) or if a 
jam should occur with the tips, for example. Detailed instructions regarding the procedure to be 
followed can be found in the FlexStation Operator’s Manual. 
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There is no assay plate 

 
You have tried to start a reading without inserting a plate in the microplate drawer. Insert the plate 
and press the [Read] button again 
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Introduction 
This Appendix lists enhancements and bug fixes made to SoftMax Pro in previous releases.  

SoftMax Pro 3.1 Update Specification 

SpectraMax Plus384 support 
The SpectraMax Plus384 was added to the Reader list in the Preferences dialog. The Instrument 
Settings dialog for this new instrument is very similar to that for the SpectraMax Plus with the 
exception that a Plate Type options was included. The Plate Type selections include a standard 96-
well plate and a standard 384-well plate. 

Gemini XS support 
The Gemini XS was added to the Reader list in the Preferences dialog. The Instrument Settings dialog 
for this new instrument is very similar to that for the Gemini. A new Plate Type table was provided 
for this instrument. The Plate Type selections include standard 96-well, 384-well, 48-well, 24-well, 12-
well, and 6-well plates. Also, the Automatic setting for PMT Sensitivity is available for Spectrum 
reads with this instrument. 

When performing an excitation scan with this instrument, the user can select to have no excitation 
filter present or to have the default excitation filter present. This setting defaults to having no filter 
present. 

Well Scanning Read Mode 
A new read mode is provided for a Well Scan. This read mode provides the ability to take readings at 
more than one location within a well. The Well Scan read mode is available for both the Gemini and 
Gemini XS instruments. In the Instrument Settings dialog, all the options that are included for 
Endpoint reads are available for Well Scans. One additional option is available, the Well Scan Editor 
shown in Figure 1. 

The Well Scan Editor allows the user to specify how a Well Scan is performed. Four patterns are 
provided: a horizontal line, a vertical line, a cross (which is a combination of a horizontal and vertical 
line), and a grid pattern. The user also specifies a density setting, which determines the number of 
points read in the line patterns or the maximum number of horizontal and vertical points included in 
the grid pattern. With the grid pattern, points that land too close to the edges of the well are 
excluded. All points that land within 2.8 mm of an edge are excluded. 

Only odd numbers of points are included in density settings. The minimum number of points is 3 for 
all plate sizes. The maximum number of points depends on the well diameter. To determine the 
maximum number of points included in density settings, 5.6 mm is subtracted from the well 
diameter, the remainder is divided by 0.8 mm and the largest odd integer that is less than this 
number used. 

The Well Scan Editor provides information on the number of points to be read, the point spacing and 
the approximate read time depending on the pattern and density settings. Point spacing is 
determined by subtracting 5.6 mm from the well diameter and dividing the remainder by the density. 
The minimum point spacing is 0.8 mm. 
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Well Scan Editor option 

In the Display dialog for Well Scan plates, the user can choose between a gray scale display, showing 
reduced values or showing both. With multiple wavelength pair Well Scans, the user can choose 
between viewing the data from different wavelengths separately or together. The default reduction is 
the average of all points in a scan. The minimum value, maximum value, and Custom reductions are 
included as in the reduction drop-down list. 

Plate Sections default to presenting the points read in a Well Scan in gray scale. For multiple 
wavelength pair Well Scans, the readings from different wavelength pairs are shown in different 
colors. The first wavelength pair is shown in black. The second wavelength pair is shown in blue. The 
third wavelength pair is shown in read. The fourth wavelength pair is shown in yellow. For each 
position in a Well Scan, the color for the wavelength pair with the highest reading is shown. Well 
scan data can also be viewed in well graphs. 

The SoftMax Pro export format has been extended to include Well Scans. Well scan has been added to 
the read mode field (field 5). The number of points read is reported in field 9. The Well Scan pattern 
is reported in field 10. The Well Scan density is reported in field 11. The data from each position is 
output in subsequent rows or plates starting with the top, left point and proceeding with horizontal 
priority. 

Apple OS 9 Navigation Services 
The methods for finding, opening, and saving files have changed with OS 9 from Apple. Macintosh 
Navigation Services have been updated in SoftMax Pro to incorporate these changes. Compatibility 
with earlier operating systems has been maintained. 

Interprocess Messaging 
A command for exporting data has been added to Interprocess Messaging. The ExportAs command 
saves files to the Autosave directory or to subdirectories of the Autosave directory. The “.txt” 
extension is automatically appended to these files. Also, the GetTiming command for determining the 
length of time needed to read a plate has been updated to provide more accurate information. 

Instrument Settings Changes 
The ability to choose between wavelength and column priority reads has been added to Endpoint 
and Spectrum modes in the SpectraMax Plus and SpectraMax Plus384. The ability to use Speed Read 
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for Endpoint reads has been added to the SpectraMax Plus, SpectraMax Plus384, SpectraMax 190, 
SpectraMax 340PC and VersaMax. 

Password Protection 
Password protection has been updated to use a new encryption scheme. Compatibility with older 
files has been maintained.  

Minimum Kinetic Interval 

Minimum Kinetic interval calculations have been updated to include the SpectraMax Plus384 and the 
Gemini XS. The calculations for large-well plates have also been updated. 

Autosave Changes 
The Autosave option in the Preferences dialog has been enhanced so that the file creation date can be 
appended to the file name when files are saved in sequence. An Append Date checkbox is used to 
activate this feature. The names of the files created when Append Date is activated begin with the file 
prefix, followed by the date, the iteration number, and the file extension. 

If the file prefix field is left blank in the Preferences dialog, the autosaved files will use the protocol 
creation date as the file prefix. 

Autoprint Changes 
When Autoprint and Autosave are both selected in the Preferences dialog, the name used in the 
footer of the printed document will match the name of the correspondingly saved file rather than the 
on-screen document name. If Autoprint is used without Autosave, the on-screen document name is 
used. 

SoftMax Pro 3.1.1 Update Specification 

Correction of Problems in SoftMax Pro 3.1 
 Several problems were found in SoftMax Pro 3.1 that were corrected in SoftMax Pro 3.1.1. 

 Password protected files from version 3.0 did not open correctly in version 3.1. 

 In the Display dialog, displaying raw data in 1000s could not be deactivated after it was 
activated. 

 Well scan files with custom plates were not defaulting to the correct plate type. 

 Wavelength settings for Gemini Spectrum reads were not being correctly verified. Problems 
occurred with Start wavelengths higher than Stop wavelengths. 

 The wrong error message appeared when the number of Kinetic reads was set higher than 
10,000. 

 AutoPMT was available in Kinetic mode on a fluorescence reader when an absorbance Kinetic 
protocol was opened. Also, AutoPMT was available on the Gemini for spectra when an 
absorbance Spectrum file was opened. 

New Interprocess Messaging Features 

The NewPlate command creates a new Plate section in the currently selected Experiment. The plate 
will be named following the normal rules for SoftMax Pro. This plate name will be Plate#X, where X 
is the lowest number not already being used for a section. 
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The NewNotes command creates a new Notes section in the currently selected Experiment. The notes 
will be named following the normal rules for SoftMax Pro. This notes name will be Notes#X, where X 
is the lowest number not already being used for a section. 

The SaveAs, OpenAssay, ExportAs and ImportTemplate commands have been modified to allow full 
pathnames. The file path can be fully redirected by beginning the filename with a partition letter and 
a colon (D:\mySubDirectory\myFile, for example). 

SoftMax Pro 3.1.2 Update Specification 

New and Revised Interprocess Messaging Features 

New and Modified Features for Robotic Integration 
Expanded COM ports selection (0–9). 

Extended communication response timeout value and removed the time-out warning dialog during 
remote command operation. 

Added SetFolderAs:XXX command. 

User can set the current protocol directory using this remote command. User has to specify the 
directory or file path. 

Example: SetFolderAs:c:\SoftMax Pro 3.1.2\Basic Protocols 

Added a parameter to the ExportAs:XXX command (append data to an existing export file and 
import the file as a single document). 

The ExportAs command without the –"a" attribute overwrites any existing file without warning. 
However, user can choose to append export data to the end of an existing export file by specifying 
the –"a" attribute. In addition, this export file can then be imported and all data can be viewed as a 
single document file. 

Please note that a single space is required between the attribute and the following directory and file 
string (XXX). 

Example: ExportAs: -a c:\SoftMax Pro 3.1.2\exportfile.txt 

SoftMax Pro 3.2 Update Specification 

FlexStation Features 
 Supports all the features of the new FlexStation instrument including a new read mode (also 

called “FlexStation”). New tabs are included in the Instrument Settings dialog box for the new 
read mode. 

 The Plate section for FlexStation instruments shows which wells have been selected for transfers: 
small, color-coded triangles in the corners of the wells show first and subsequent transfers.  

 Information about the transfer settings and compound sources is shown beneath the Plate 
display. 

 Because intervals between readings are not predictable in FLEX mode, SoftMax Pro collects and 
stores a time tag for each reading made in FLEX mode. This time tag is used in analysis and 
graphing of the resulting data. 

 When SoftMax Pro is connected to a FlexStation instrument, additional items are available in the 
Control menu: 
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• Open/Close Tip Drawer 

• Open/Close Compound Drawer 

• Set Air Gap: Allows you to set the distance (from 0 to 200 milliliters) between the tip 
of the pipette and the bottom of the plate well. 

Bottom Read allows the FlexStation instrument to take readings upward from the bottom of a 
microplate instead of downward from the top. 

New Accessors 
New accessors have been created to accommodate the new instrument settings included for FLEX 
mode. These include accessors for transfer volumes, transfer rates, transfer timing, pipetter heights, 
and source types for each transfer. Accessors for transfer areas, source areas, and tip types are also 
available. 

Checksum 
The checksum feature has been activated for the FlexStation instrument to check for accuracy of 
received data. 

Import/Export 
SoftMax Pro can now export a tab-delimited time-tagged file from FlexStation data. SoftMax Pro is 
also able to re-import the time-tagged file data. 

A tab-delimited text file with time-interpolated data can be exported from SoftMax Pro. Such data 
can facilitate analysis using third-party software (such as Microsoft Excel). Time-interpolated files 
cannot be re-imported into SoftMax Pro. 

The import feature has been expanded to include the ability to import a tab- delimited text file 
exported from FLIPR®. 

Autoread 
This new feature is included for all instruments (not available in Kinetic and FLEX read modes). 
Autoread enables the sequential reading of multiple plates within an experiment. You can set 
intervals between plate reads, if desired. 

Reduction Modifications 
A new Kinetic reduction dialog box is available for FlexStation read mode that adds special display 
options: Raw Values, Baseline Offset Values, and % Increase Values. These display options are used 
to alter the way in which the data is graphed. Additionally, for Slope and Area Under the Curve cal-
culations for curve fitting, the raw data is smoothed using a simple moving average. You can choose 
the period of this moving average from a popup menu. 

Additional reduction formulas are available in the FlexStation Kinetic reduction dialog box: Time at 
Minimum, Time at Maximum, Time at 1/2 Minimum, Peak, and Max-Min. 

SoftMax Pro 4.0/4.01 Update Specification 

GLP/GMP Support 
New levels of file protection have been added: 

 In addition to standard password protection of a file, you may now add an author’s name to a 
file. This name is saved with the file, will print with the report, and is shown on the screen. 
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 To prevent any and all changes to a file, including saving it under a different name or 
accidentally overwriting it with a file of the same name, you may choose to shield a file. The 
author of the file must include his/her name and password, as well as a new shielding name and 
password as part of the file protection. 

 Exported files now show the date, author, and file name. 

 Printed pages now show the file name, date, author, and Molecular Devices copyright 
information. 

Analyst System Files 
Import Analyst... has been added to the Import menu. This selection allows you to import verbose 
reports generated using Criterion Host or ScreenPlay software for all instrument modes. 
After import, the data from the Analyst System file can be viewed and analyzed just as if it had been 
generated by SoftMax Pro. 

FLIPR Files 
Import FLIPR... has been added to the Import menu. This selection allows you to import “FPD” files 
exported from FLIPR software. 
After import, the data from the FLIPR file can be viewed and analyzed just as if it had been generated 
by SoftMax Pro. 

Robotics 
Autosaving a file now saves time with seconds. 

New robotics commands have been added to automate opening and closing the tip and compound 
drawers of the FlexStation instrument. 

COM port switching for multiple instruments is now available. 

STATUS has been clarified (application vs. instrument busy status). 

A user name and password can be entered to open a password-protected file. 

FlexStation Enhancements 
384-well plates are now supported for both reading and for use as a compound source 

Well Scan Mode 
Blank subtractions now include all points in the well, and are averaged. This average is subtracted 
from the average of all sample points. 

Export Function Updates 
Notes sections are now exported with data from Plate sections 

Molecular Devices copyright information added to the bottom of exported data 

Exported information is formatted with tabs between items so that it can be opened and viewed 
using Excel and the data will parse properly into columns 

Multithreading of Serial Input (PC only) 
PC serial input/output uses a separate thread for enhanced serial communication performance. 
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Macintosh Communications Toolbox Support 
Macintosh serial communications through a USB-to-serial port have been enhanced. 

Gemini and Gemini XS Enhancements 
Ability to read a single well in Gemini  and Gemini XS 

Enhanced 4-Parameter Fit 
The 4-Parameter curve fit has been enhanced to be more robust. 

Documentation & Software Enhancements 
 A robotics program example has been added to the CD files provided. 

 Added examples to the Formula Reference Guide. The results of these examples are included as 
PDA files that can be used as tutorials. 

 Life Cycle Documentation for SoftMax Pro 4.0 is included in the SoftMax Pro 4.0 Validation 
Manual. 

 A feature request plan and testing plan are included in the SoftMax Pro 4.0 Validation Manual. 

Specifications 
 Added support for Windows ME. 

 Dropped support for Windows 95 and Mac OS below 8.6. 

 Increased minimum required computer hardware and software specifications when FlexStation 
and/or robotics are used. 

SoftMax Pro 4.1 Specification 

Specifications 
Added support for the Gemini EM instrument. The Instrument Settings dialog box for the Gemini 
EM includes choices for “Bottom Read” and a 325-nm additional cutoff filter (total of 16 cutoff filters 
for the Gemini EM; the other Gemini instruments have 15). The choice for Time-Resolved 
Fluorescence has been removed from the settings for the Gemini EM. 

SoftMax Pro 4.3 Specification 

Separate Editions and Enterprise Administrator 
 Three different editions of SoftMax Pro are now available: 

 Life Science (LS) Edition, for life science use (shipped with all Life Science instruments) 

 Drug Discovery (DD) Edition, for drug discovery analysis (shipped with FlexStation) 

 Enterprise Edition (EE), for customers who require 21 CFR Part 11 compliance and validation 
(contains features from both the Life Science and Drug Discovery editions as well as new 
compliance features). The Enterprise Edition of SoftMax Pro links with a separate software 
package, Enterprise Administrator, through a menu choice in SoftMax Pro. 

 Enterprise Administrator (EA) software is a separate software module (for Windows only) that 
links with the The Enterprise Edition of SoftMax Pro. Enterprise Administrator provides the 
capability to assign multiple users (up to 175) and multiple permissions/privileges and 
electronic signature capability. 
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21 CFR Part 11 Compliance 
Enterprise Administrator software allows an administrator to assign user levels and permissions 
regarding the use of SoftMax Pro Enterprise Edition. 

A full audit trail showing all user activities is included as part of the Enterprise Edition of SoftMax 
Pro when coupled with the Enterprise Administrator software. 

Password Protection  
Password protection continues to be available with all but the Enterprise Edition of SoftMax Pro. 
While the Enterprise Edition will respect password-protected files generated from other versions, the 
option to password-protect a file is not available in Enterprise Edition. 

Shielding  
Shielding is no longer offered. Shielded data files will revert to password-protected files with the 
password scrambled so that password protection cannot be removed. Shielded protocols will simply 
have the shielding removed. 

Electronic Statements  
Electronic statements ("E-Statements") provide a way of signing SoftMax Pro files electronically (with 
the Enterprise Edition only). A new menu item under Experiments allows the user to add an 
Electronic Statements section to a document. Electronic statements allow those with permission to do 
so to sign a statement stating that a document has been approved or reviewed, for example. Once a 
statement has been signed, the document may not be modified. Statements and electronic signatures 
are saved with the document. Statements are NOT saved with protocols. 

New File Extensions for Enterprise Edition 
File extensions for the Life Science and Drug Discovery editions of SoftMax Pro remain unchanged. 
New file extensions are created by Enterprise Edition software, however: .EDA (data) and .EPR 
(protocol). These new file extensions will be recognized only by Enterprise Edition software, 
prohibiting opening or modification of such files by other editions of SoftMax Pro. This helps to 
ensure that the integrity of the 21 CFR Part 11 compliant features of the Enterprise Edition is 
maintained. 

The Enterprise Edition can open all file extensions from all other versions. 

User Access in Enterprise Edition 
User access to the Enterprise Edition of SoftMax Pro is tied to a database created and saved with 
Enterprise Administrator. User privileges are set within Enterprise Administrator and these 
privileges determine which menu choices are available to that user within SoftMax Pro. A user may 
also log in to the Enterprise Edition as a “guest.” That user will be able to open/view files but may not 
make any modifications to the documents and save them under the same name, although they may 
be able to save them as a new file name. A guest user may create new files and may also view the 
audit trail. 
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SoftMax Pro 4.6 Specification 

Edition Simplification 
SoftMax Pro is now available as two functionally distinct editions: 

 Standard Edition is designed to provide powerful yet easy data collection and analysis for life 
science and drug discovery users. This edition is currently shipping with all MDC  instruments. 

 Enterprise Edition is designed for customers who require 21 CFR Part 11 compliance and 
validation, in addition to all data collection and analysis features found in the Classic edition. 
SoftMax Pro Enterprise is linked to an Administrator Data File (.edb) containing authorized 
users and privileges. This .edb file is generated by Enterprise Administrator, a separate software 
application.  

 Enterprise Administrator software is a separate application (for Windows users  only) that 
manages all users, electronic signature capability and privilege information for up to 175 
SoftMax Pro Enterprise users. 

Support for SpectraMax M2  
SoftMax Pro v4.6 provides full instrument support for the new SpectraMax M2 product line. 

Support for LMax II / LMax II384 
SoftMax Pro v4.6 provides full instrument support for the new LMax II / LMax II384 product line. 

New Software Installer 
The Windows installer for SoftMax Pro v4.6 software supports two notable user and IT options. Users 
can now select what type of installation they wish to complete, including Recommended, Minimal, 
and Custom. IT professionals can take advantage of the new silent setup mode, allowing the IT user 
to perform automated installs of SoftMax Pro software 

Improved Data File Audit Trail 
SoftMax Pro Enterprise audit trail has been extended past 32 KB to a new limit of 2 GB. Additionally, 
more user events and actions are now recorded in the Audit Trail maintained on each experiment 
data file including: Delete commands, Removal of Signature with reason for removal. 

Enhanced File Format Support 
All past SoftMax and SoftMax Pro file formats can be opened, viewed, and used with v4.6. 

Extended Path Names 
Path names within SoftMax Pro software have been extended from 63 to 255 characters, allowing 
users to properly use the OpenAssay command to remotely open assay protocol files. 

Improved Enterprise Administrator Audit Trail 
More user events and actions are now recorded in the Audit Trail maintained on each experiment 
data file including: Delete commands,  

New Robotics Interface Command 
Users can now open experiment data files (.pda / .eda) in addition to protocol files (.ppa / .epa) using 
the new OpenDF <Filename> command. 
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Automation Examples 
A new sample program to help provide more information on remote commands can be found in the 
Automation Examples\RemoteCmdApp subfolder within your installed SoftMax Pro folder.  This 
executable can be run to test SoftMax Pro software’s remote commands and source code in Visual 
C++, and can also be used to make similar remote command client programs.  This folder also 
contains a document that briefly describes how to use this application. Additional sample code 
examples are located in the Automation Examples subfolder. 

Documentation Enhancements 
 Extensive User Manual edits to File Management & Printing, Enterprise, Troubleshooting 

chapters. 

 New Automation samples are provided and available via the Custom install option. 

Specification Changes 
 Dropped support for Windows NT  

 Dropped support for Macintosh OS8 

 Increased minimum system requirements for improved performance. 

Fixed Defects 
SoftMax Pro software includes many bug fixes for issues with end-user visibility, as detailed below: 

 Overall software stability and reliability have been improved. 

 Save As menu item no longer overwrites previously saved files, thus preventing data loss for 
users with no Windows Write permission. 

 Improved File:Open functionality for Macintosh users allowing better cross-platform file 
exchange. 

 Autosave now “pre-flights” saving to target directory before attempting to save a file. 

 Improved USB/Serial conversion for Mac customers providing better stability with adapters. 

 The “/R” command line parameter for message queuing now properly allows users to launch 
SoftMax Pro software. 

 The “CopyData” command line parameter for message queuing now properly generates a reply 
of “OKRead” when the read is completed. 

 Correct file and program icons are now displayed for protocol and data files. 

 SoftMax Pro Help can now be accessed successfully by certain Mac OS 9.x users. 

 Graph title and axis labels now print properly for Macintosh users. 

 AutoRead for SpectraMax Plus384 now supports Kinetic mode. 

 Failed login option now properly supported. 

 Incorrect/mismatched group color patterns when plate templates are printed has been fixed. 

 [Hide Name] button now behaves properly if [Spacebar] is depressed. 

 “Manual” PMT bug has been fixed. 
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SoftMax Pro 4.7 Specification 

New Reader Support: 
 SpectraMax Gemini XPS 

Support for SpectraTest Validation Plates 
 All past instruments can now use the absorbance test plates with special customized protocols. 

The only readers currently supporting the SpectraTest FL1 (fluorescence) Validation Plate are the 
SpectraMax M2 and the Gemini XPS. 

TRF as Secondary Detection Mode 
 TRF is now supported by all fluorescence instruments (Gemini XS, Gemini EM, Gemini XPS, 

SpectraMax M2, and FlexStation) as a secondary detection mode. 

Fixes 
General 

 New Accessor: WellLmXXVals (i.e., WellLm1XVals) to access the x-values for FLEX (time-tagged) 
data. 

 Instrument Settings: Entered values for Automix and AutoRead times are now checked for valid 
range/format. 

 TRF information display bug fixed. 
 Two new plate descriptions are available for Gemini EM, Gemini XPS, SpectraMax M2, 

FlexStation, and FlexStation II:  
• BD Falcon HTS 96-multiwell insert 
• BD Falcon HTS FluoroBlok 24-multiwell insert 

 Auto Cutoff wavelength default issue when opening old absorbance protocols in fluorescence 
readers has been fixed. 

 SpectraMax M2: Wavelength (Standard and Spectrum, Luminescence) values now checked for 
valid range/format. 

 SpectraMax M2: The cuvette minimum kinetic intervals for fluorescence and absorbance are now 
identical. 

 SpectraMax M2, Well Scan read mode: Single well read coordinate problem fixed. 
 SpectraMax M2: Absorbance spectrum wavelength value change problem has been fixed. 
 SpectraMax M2: Instrument boot-up problem while connected to SoftMax Pro has been fixed. 
 LMax II: Fast Kinetic read mode button icon is fixed to show the selected state. 
 LMax II: Checksum error text has been removed. 
 LMax II: A hidden "Lock" (plate positioning for shipping) command has been added. 
 Analyst HT: Absorbance data import problem has been fixed. 

Other 
 Navigational problems in SoftMax Pro Online Help files have been resolved. 
 Formula Reference Guide has been included in SoftMax Pro Online Help system. 

 



Glossary of Terms  

680 SoftMax Pro User’s Manual 

SoftMax Pro 4.7.1 Specification 

LMax II 384: 
 “!PValue” incorrectly accessed the RLU value for second injection in 4.6/4.7. “!PValue” now 

correctly returns the RLU value for P (first) injection when using dual read mode. 
 “!MValue” incorrectly accessed the RLU value for first injection in 4.6/4.7. “!MValue” now 

correctly returns the RLU value for  the M (second) injection when using dual read mode. 
 P data is now displayed above M data in the Plate section when using dual read mode. 

FlexStation: 
 Tip/microplate clearance was increased by 1 mm for all compound plates, correcting a plate 

format error which caused tips to contact well bottoms. The change does slightly increase the 
residual volume in the compound plates, but improves precision of aspirated volumes on some U 
and V-bottom well plates. 

SoftMax Pro 4.8 Specification 

New Reader Support 
 SoftMax Pro v4.8 is required to operate the new SpectraMax® M5 reader and its five read types: 

Fluorescence, Absorbance, Luminescence, Time-Resolved Fluorescence (TRF) and Fluorescence 
Polarization. Three data types for FP read types are also being introduced with v4.8: the 
calculation of Polarization (mP), Anisotropy (r) and Raw (S&P).  

Modifications 
 A Plate Type Editor has been added for some readers. Accessible from the “Plate/Edit Plate 

Type…” menu item, this feature allows users to modify five primary microplate measurements 
(the distance from the left edge of the plate to the center of well A1, the distance from the top 
edge of the plate to the center of well A1, the horizontal distance between wells, the vertical 
distance between wells and the well diameter), and to save these custom plate types. More 
details can be found in Chapter 5 of the SoftMax Pro User Manual. 

 Modification of Plate Blank subtraction for FP: the plate blank subtraction will be done on the 
uncalculated raw perpendicular (S) & parallel (P) fluorescence polarization data, respectively. 

 File/Set Password menu item has been changed to support the notation of both the Author 
Name and Password to allow users of SoftMax Pro Standard edition to protect any single 
experiment file. 

 SpeedRead and Column/Wavelength Priority options have been added for Kinetic read mode 
for SpectraMax® Plus 384 users. 

 The Formula textbox limit in the Calculation dialog has been increased from 200 to 255 
characters. 

 A Settling Time option has been added. Users can enable/disable the Settling Time option and, if 
enabled, specify the duration of settling between 100 and 1000 milliseconds.  In FP read mode, 
the settling time specify the well-to-well delay for FP read type, and column-to-column delay for 
all other read types.  

Enterprise Edition Changes 
 The saved file path recorded in the Audit Trail has been corrected and no longer truncates.  
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 Save As… no longer allows users to modify a protocol. 

 Selected Statement sections now print properly (some did not print in specific cases previously). 

Fixed Bugs 
 Highlighted summary lines now properly appear on the printed copy. 

 Crashing bug has been fixed whereby expanding a Cuvette section when the plate template 
includes a 384-well specific group previously caused a crash. 

 Pasting data into Cuvette section no longer erases the current Template setting. 

 Exporting “All” Group sections now properly includes the Note section delimiter (~End), which 
also facilitates proper re-importing of Note section(s) back into SoftMax Pro software. 

 The default kinetic interval can no longer be less than the minimum kinetic interval.  

 SpectraMax M2 – Instrument Settings | fluorescence read | Spectrum.  A range check was added 
to the Excitation text box to now accept only valid numbers. 

 SpectraMax M2 – Instrument Settings | Column Wavelength Priority now allows the user to 
properly select either Column Priority or Wavelength Priority for multi-wavelength reads.  

 SpectraMax M2 – The Step text box in Spectrum read mode now checks for a valid Step value 
within the limits of the scan (i.e., if 350-370, step values can be between 1-20; no greater than a 
max of 490.) 

 LMax™ II & LMax™ II 384 – Instrument settings | Wells to Read.  The option text now properly 
updates when well selection changes. 

 LMax II & LMax II 384 – Plate section now displays the correct reader information after a read is 
completed. 

 LMax II – now displays the correct error message for the Integration Time value. 

 LMax II – users are no longer able to open the drawer when washing or priming is in progress. 

 SpectraMax Plus 384 – SpeedRead is now functioning properly. 

 FlexStation™ II and FlexStation™ II 384 – the Cutoff Filter manual setting value no longer 
decrements in its menu window from the previously selected value in Wavelength Setup menu. 

 All Gemini readers – the Step text box in Spectrum read mode now checks for a valid Step value 
within the limits of the scan (i.e. if 350-370, step values can be between 1-20). 

 Gemini EM – PMT info has been added to the plate section. 

New Protocols 
 M5 Assays folder: LDL Determination 

This protocol is used to determine the Lower Detection Limit from a dilution series or 
calibration curve of a fluorophore read in fluorescence intensity; to be used with M5 or other 
SpectraMax fluorescence readers. 

 M5 Assays folder: Basic FP 
This fluorescence polarization protocol allows subtraction of average raw background signals 
from eight (8) matched sample wells before mP is calculated; to be used with SpectraMax M5 
only. 

 M5 Assays folder: FPIA 
This fluorescence polarization protocol is used to set up a calibration curve and assign groups 
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needed to determine binding in a Fluorescence Polarization (FP)-based immunoassay (e.g., 
TKXtra); to be used with SpectraMax M5 only. 

 M5 Assays folder: G Factor Determination 
This protocol is used to determine the correct "G factor" for a given fluorophore for fluorescence 
polarization (FP) assays; to be used with SpectraMax M5 only. 

 M5 Assays folder: HTRF 
This time-resolved FRET protocol performs two TRF readings on a plate, then calculates the 
ratio of donor and acceptor signals and performs CISbio International’s patented deltaF% 
calculations for controls; to be used with SpectraMax M5 only. 

  ADME folder: MultiScreen PAMPA 
The Parallel Artificial Membrane Permeability Assay (PAMPA) determines the rate at which a 
compound in an aqueous solution passes from the donor compartment to the acceptor 
compartment through a chemically treated filter membrane. 

Modified Protocols 
 Basic Protocol folder: All Kinetic ODs for Export 

Missing columns were added back to the RowA Group Section. 

 LAL Kinetic Chromogenic folder: Routine Testing simple 
This protocol is now is properly set as Kinetic read type. 

 LAL Kinetic Chromogenic folder: Routine Testing complete 
This protocol is now is properly set as Kinetic read type. 

New Formula Accessors 
 !StdDevPlateBlank – returns the standard deviation value of the plate blank group. 

 !StdDevPlateBlankLmX – specifies the wavelength LmX (i.e., Lm1, Lm2) of the plate blank group. 

 !WellLmXSRaw (i.e., !WellLm1SRaw) – returns perpendicular polarized data of specific 
wavelength LmX (i.e., Lm1 or 1st wavelength set) for a given Template group. (in Group 
Section) 

 !WellLmXPRaw (i.e., !WellLm2PRaw) – returns parallel polarized data of specific wavelength 
LmX (i.e., Lm2 or 2nd wavelength set) for a given Template group. (in Group Section)  

 !WellIDLmXSRaw (i.e., !A2Lm1SRaw) – returns perpendicular (or an array of perpendicular) 
data for the specified wavelength LmX (i.e., Lm1 or 1st wavelength set) in the specified WellID 
(i.e., A2). 

 !WellIDLmXPRaw (i.e., !B1Lm2PRaw) – returns parallel (or an array of parallel) for the specified 
and wavelength LmX (i.e., Lm2 or 2nd wavelength set) in the specified WellID (i.e., B1). 

 !Gfactor – returns the current G factor value set in the Display dialog. 

 !PlateBlankS and !PlateBlankLmXS (i.e., !PlateBlankLm1S) – returns perpendicular (or S) plate 
blank raw value(s) for the given wavelength LmX in a plate section (i.e., Lm2 or 2nd wavelength 
set). 

 !PlateBlankP and !PlateBlankLmXP (i.e., !PlateBlankLm1P) – returns parallel (or P) plate blank 
raw value(s) for the given wavelength LmX in a plate section (i.e., Lm1 or 1st wavelength set). 
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%Transmittance, T 
The ratio of transmitted light to the incident light (for absorbance readings). 

%T = (I/I0) x 100 

Absolute Values 
Choosing this option shows the raw data without any smoothing or other changes in the way it is 
graphed. 

Absorbance, A 
The amount of light absorbed by a solution. To measure absorbance accurately, it is necessary to 
eliminate light scatter. In the absence of turbidity, absorbance = optical density - reflection. 

A = log [I0/I]  

I0 = incident light  

I = transmitted light 

the terms absorbance and optical density are used interchangeably.  

Active 
The window or icon that you are currently using or that is currently selected. 

ANSI Character Set 
The American National Standards Institute 8-bit character set. It contains 256 characters. 

Area Under Curve 
Reduction formula for a Kinetic or Spectrum scan that determines the area under the Kinetic or 
Spectrum plot, or under a plot in a Graph section. First the area under the curve is divided into a 
series of trapezoids, then the area defined by each trapezoid is computed, and all areas are summed. 

ASCII Character Set 
The American Standard Code for Information Interchange 7-bit character set. It consists of the first 
128 (0–127) characters of the ANSI character set (and most other 8-bit character sets). The ASCII 
character set is the most universal character-coding set. 

Author Name 
The Author Name is entered from the password dialog box at the time when file shielding is turned 
on. The Author Name is different from the User Name in that it may be the name of the author of a 
protocol file that is later used to read data. 

AutoCalibrate 
For absorbance instruments, an air reference reading is taken before runs (and sometimes between 
Kinetic readings during a run) as determined by the type of instrument and read settings. For 
fluorescence instruments, measurement occurs before reads (and sometimes between Kinetic reads if 
the interval is long enough). Calibration data is stored in volatile memory and is used by SoftMax Pro 
until the instrument is powered down or the wavelength is changed. Autocalibration can be turned 
off. 

Automix 
The Automix function determines how often, if at all, automated shaking of the microplate is 
performed during a reading. This feature is covered by U.S. Patent Number 5,112,134. 
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AutoRead 
This feature enables automatic reading of subsequent Plate sections in the order in which they appear 
within an experiment. You can set intervals (delay times) between the plate readings, if desired. 

Baud 
A data transmission rate (measured in bits/second) for communication devices. 

Blanking—CuvetteSet Section 
Three types of blanking are available in the CuvetteSet section for the SpectraMax M2, Plus, or 
Plus384: Ref Blanking, Template Blanking, and Group Blanking. 

 A Ref Blank is created when you click the [Ref] button or choose Ref from the Control menu. 
This command causes the SpectraMax M2, Plus, or Plus384 to read the cuvette in the cuvette port 
and applies this reading as a reference for all cuvettes in the CuvetteSet section. 

 Template Blanks are created by entering a Blank group in the CuvetteSet section template. 
After a reading, the average of the blank values obtained from the Blank group is subtracted 
from all cuvettes. 

 Group-Associated Blanks are created by placing blank cuvettes within a group in the template. 
The values of group blanks are averaged and subtracted from the values of the cuvettes within 
that group only. 

Blanking—Plate Section 
Three types of blanking are available in the Plate section: Pre-Read Blanking, Plate Blanking, and 
Group Blanking. 

Pre-Read Blanking subtracts background signal caused by the microplate itself, as well as by 
solvents, reagents, or samples. The individual blank reading from each well can be subtracted from 
the final reading from the same individual wells (choose “Pre-read plate” from within the Instrument 
Settings dialog box). This is usually used for measurement in the deep UV or for pathlength 
correction. 

� NOTE: Pre-read blanking is not available with all instruments and also is generally not used with Kinetic 
assays. If used with Kinetics, it will complete a pre-read Kinetic run and then subtract these values on a 
point-by-point basis from the “normal” Kinetic run. 

Plate Blanks are created by entering a Blank group in the template. After a reading, the average of 
the blank values obtained from the Blank group is subtracted from all wells in the plate. 

Group-Associated Blanks are created by placing blank wells within a group in the template. The 
values of group blanks are averaged and subtracted from the values of the wells within that group 
only. 

Bottom Read 
Available in the Instrument Settings, this selection causes instruments with bottom-read capability to 
read up through the bottom of the microplate rather than down from the top. 

Checkbox 
A small, square box that appears in a dialog box and that can be selected or cleared. When the 
checkbox is selected, an X appears in the box. A checkbox represents an option that you can turn on 
or off. 
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Clear 
Within the Template Editor, Clear removes information that was designated previously for selected 
wells. By highlighting wells and then choosing Clear, any information regarding those wells will be 
erased (the wells will return to their default status of empty). Note that if you clear the entire 
template, the groups themselves will not be deleted and are still selectable. Keeping the groups 
allows you to reassign wells without having to recreate groups. 

Click 
You click an object on the screen by pressing and quickly releasing the mouse button while the 
pointer is on that object. When you click once on an object, such as an icon or file name, it becomes 
highlighted, which means it is selected. Whatever action you choose next will affect a selected object. 

Clipboard 
A temporary storage location within the operating system used to transfer data within and between 
files and applications. 

Compound and Tip Columns 
A selected tip column and compound column are assigned for fluid transfer to a specific assay plate 
column. 

Compound Source 
Compounds are transferred from the compound source plate to the assay plate. 

Compound Transfer 
Microplate fluid transfer from the compound source to assay plate. 

Concentration 
The amount of a substance present per unit volume. Used as the default sample descriptor for a series 
of samples. 

Control 
A sample that is run as an internal check of the assay. The control has a predictable or known assay 
result against which other results can be compared. 

Control Menu Box (Windows) 
The icon that opens the Control menu for the window. It is located at the left of the SoftMax Pro title 
bar. The Control menu can be activated by clicking in this box with the mouse or by pressing ALT, 
SPACEBAR. 

Copy 
A function common to most software applications that duplicates the selected text or item and places 
this duplicate on the clipboard. The copy function is enabled by pressing C on the Macintosh and 
[CTRL]+[C] in Windows. 

Copy-and-Paste 
A method of copying selected text or graphics from one location and pasting them to a different 
location in the same file or into another file (which could be in an application other than SoftMax 
Pro). 
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Criterion™ 
Molecular Devices’ Analyst line of instrumentation is specifically designed to address the microplate-
based assay detection needs of Life Science and Drug Discovery laboratories. 

Cubic Spline (Curve Fit) 
This curve fitting option generates a fit to a cubic equation between each pair of data points. The 
cubic equations are computed such that these equations and their first two derivatives are continuous 
everywhere. 

Curve Fit 
Specifies the type of curve (linear, logarithmic, quadratic, and so on) that is applied to the data points 
in a plot. The curve is a graphic representation of the mathematical relationship between the data 
points in the plot.  

Cut 
A function common to most software applications that removes a selection of text or graphics and 
places it on the clipboard. The cut function is enabled by pressing X on the Macintosh or 
[CTRL]+[X] in Windows. 

Cut-and-Paste 
A method of moving selected text or graphics from one location to a different location in the same file 
or into another file (which could be in an application other than SoftMax Pro). 

Cutoff 
A filter used to condition the light entering or exciting the monochromators. In automatic mode, the 
instrument sets the cutoffs automatically based upon the wavelength(s) chosen for reading; with 
some read modes and types, however, you can choose a different filter wavelength (manual setting) 
for the emission monochromator. 

CuvetteSet Section 
The CuvetteSet sections determine how the cuvettes will be read, display data as it is acquired from 
the instrument, and define how the data will be displayed and used in reduction. CuvetteSet sections 
can display samples in three different ways: three samples per row, one sample per row, and in a grid 
of cells which corresponds to a microplate format. 

Data Display 
Located in the Plate section or CuvetteSet section, the data display is a grid that corresponds to the 
layout of the wells in the microplate. This display can show the results of the reading in various 
formats [for example: raw signal data (OD, RFU, RLU), raw %Transmittance (for absorbance 
instruments only), reduced data (number or plot), Threshold, Ranged, and Gray Scale]. 

Data File 
Contains the raw data collected from the instrument, as well as any associated sections or settings 
(Notes, Graphs, Groups, Instrument Setup, Display Options, and Data Reductions). 

Data Mode 
Reduction option to view absorbance data as OD (absorbance) or %Transmittance, fluorescence data 
as RFU (relative fluorescence units), or luminescence data as RLU (relative luminescence units). 
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Default Protocol 
A protocol file, included with the SoftMax Pro program or created by a user, that resides in the 
default folder. The Default Protocol file defines the initial information that will appear when you 
open SoftMax Pro or when you create a new file from within the program. Both Macintosh and 
Windows versions of this file are called "Default Protocol" but Windows versions append the 3-
character “.ppr” extension. 

Desktop 
The background on which windows and icons appear. 

Dialog Box 
A rectangular window that appears temporarily to request information. Some dialog boxes have 
options you must choose before SoftMax Pro can carry out a command and must be closed before 
you can continue in the software. 

Dilution Factor 
Specifies the amount of dilution for a given sample. This factor can be multiplied against interpolated 
values to determine concentration of undiluted sample. 

Dimmed 
Unavailable or disabled. A dimmed button or command is displayed in light gray instead of black 
and it cannot be chosen. 

Double-Click 
To rapidly press and release the mouse button twice while the pointer is on an object. Double-clicking 
carries out an action, such as opening an icon. 

Drag 
To move an object on the screen by clicking it, holding down the mouse button, and then moving the 
mouse. Also to select an item in a list by dragging through the list or to select multiple items by 
dragging across them. 

Duplicate 
A command available in the Edit menu that allows you to create identical copies (except data) of all 
sections and experiments. The name of the duplicated item will be the same as the previously active 
item with the word “Copy” appended. 

Emission Spectral Scan 
Measures fluorescence or luminescence across a spectrum of wavelengths for emitted light for a fixed 
excitation wavelength. The default value reported for each well is the wavelength of maximum 
emission (either fluorescence or luminescence). 

End Time 
Reduction parameter used to omit the end of a Kinetic, Spectrum, or FLEX run from data reduction. 

Endpoint 
A single reading made at one or more wavelengths. 

Enterprise Administrator Reference 
For more information on this topic, see the help file or documentation for Enterprise Administrator.  
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Excitation Spectral Scan 
Measures fluorescence at a single emission wavelength across a spectrum of excitation wavelengths. 
The default value reported for each well is the excitation wavelength of maximum fluorescence. 

Exponential (Curve Fit) 
The exponential function used to generate this curve fit is: 

y = A + B * (1 - exp^(-x / C)) 

Export 
Data from SoftMax Pro is copied to a new file and formatted so that it can be opened by another 
program such as a spreadsheet or word processing application. Data from some or all Plate, 
CuvetteSet, or Group sections may be exported. Text exported from SoftMax Pro is tab-delimited. 

FLEX 
A read mode using fluorescence that is available with the FlexStation instrument. You can specify 
compound additions and trituration for individual wells. Data is collected over time, with readings 
taken at regular intervals (that can be less than one second—FLEX runs are measured in seconds and 
fractions of seconds). FLEX readings can be single- or multiple-wavelength (up to four).  

FLIPR 
Molecular Devices’ FLIPR Fluorometric Imaging Plate Reader system was developed to perform cell-
based, high-throughput screening (HTS) assays. 

Fluorescence 
The light emitted by certain substances resulting from the absorption of incident radiation. To 
measure fluorescence accurately, it is necessary to reduce light scatter. 

The governing equation for fluorescence is: 

Fluorescence = extinction coefficient * concentration * quantum yield * excitation intensity * 
pathlength * emission collection efficiency 

Fluorescence Polarization 
By using a fluorescent dye to label a small molecule, its binding to another molecule of equal or 
greater size can be monitored through its speed of rotation. 

SpectraMax M5 Fluorescence Polarization read type returns three different “raw” data types: Raw 
(S&P), Polarization (mP), and Anisotropy (r).   

Fluorophore 
A material that absorbs light energy of a characteristic wavelength, undergoes an electronic state 
change, and instantaneously emits light of a longer wavelength. 

Four Parameter Logistic (Curve Fit) 
The equation used to generate this curve fit is: 

y = ((A - D) /(1 + (x /C)B)) + D 

G-Factor 
(Grating factor) is used in fluorescence polarization to correct polarization data for optical artifacts, 
converting relative mP data to theoretical mP data. Optical systems, particularly with reflective 
components, pass light of different polarization with different efficiency. G factor corrects this 
instrumental bias.   
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Gain 
The amount of increase in signal power expressed as the ratio of output to input for a photomultiplier 
tube. 

Gray Scale Data Display 
Raw or reduced data is displayed proportionally in a plate format using seven shades of gray, 
ranging from light shading at the low end to dark shading at the high end, based on user-defined 
high and low limits. 

Group 
Wells can be assigned to group types using the Template Editor. Depending on the default protocol 
used, certain group types (such as Standard or Unknown) may be created automatically; you may 
create others as required. 

Highlight 
Selecting an object or piece of text is selected so that it will be affected by your next action. 
Highlighted text appears in reverse video or in color. Highlighted objects may change color or be 
surrounded by a selection cursor. 

Icon 
A graphical representation of an element of the computer or software such as a disk drive, 
application, or file. 

Import 
Bringing information or data from another application into SoftMax Pro. Information can be brought 
into SoftMax Pro in two ways: by copying tab-delimited text to the clipboard and then pasting this 
information into the Plate section or CuvetteSet section within SoftMax Pro; or by using the Import 
command under the File menu to import ASCII text files having specific formats. 

Incubator 
Choosing Incubator from the Control menu or clicking the incubator button opens a dialog box 
allowing you to start or stop temperature regulation and to select an elevated temperature for the 
microplate chamber on instruments that have temperature control capability. 

Instrument Icon 
Located in the status bar, the instrument icon shows the status of the connection between the 
computer and the instrument. If the icon has an “X” through it, the connection is not functioning or 
no instrument is connected; if the instrument icon appears without an “X,” the connection is working 
properly. 

Instrument Setup 
Defines the parameters (mode, wavelengths, automatic mixing, run time, read interval, etc.) used to 
read the microplate or cuvette. 

Interleaved Display 
A display choice in which the wells are shown in a format that “skips” every other well as follows: all 
odd columns and rows begin in the upper left corner of the plate display and are followed by all even 
columns and rows. This display is most useful when the 384-well plate comprises four daughter 
plates of 96 wells each. 
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Interprocess Messaging (Windows only) 
Messages that can be sent to and received from other applications. This feature is very useful for 
interfacing instrument with robotic systems and for sending and receiving data from LIMS systems.  

Keyspan Adapter Installation Instructions 
Startup in native OS X mode. Insert the Keyspan driver CD. The CD should show up on the desktop 
immediately.  

� NOTE: Any install choice on the CD should be for the Classic OS 9.x driver set, not the OS X set.  The 
install will be started in Native mode even though the driver chosen is for Classic. 

When the install is finished, the Keyspan Serial Assistant utility should be found.  In Native mode, it 
is usually installed inside the System Folder in OS X..  The utilities are also named Keyspan USA 
[xxx] Manager.  When in Classic mode, the utility is found in the Apple Menu / Control Panel.  When 
the Assistant utility is started, the first window shows USB status and adapter status in two smaller 
panes.  When the adapter is attached and recognized by the Mac, an "Advanced" button allows a 
Detail and Settings menu to be opened.  The Advanced menu allows checks or adjustment of some 
settings required for proper communication with SpectraMax.   

Once the Advanced menu is open, there is a small arrow menu named “Port” in the upper left (it 
should be set to “#1”).  Below, and to the right of it is a small Port Name box, which can be used to 
type in “Printer Port USB”, since the initial name is not always descriptive.  Below the Port Name 
area are some check boxes.   

� NOTE: Make sure that the box titled, “Emulate Printer Port” is checked.   

The Status window below the check boxes should indicate that things are working or are “Available”. 
  

Because the driver Port was set to #1 in the step above, the reader cable should be plugged into socket 
#1 (not 2) when setting up the 28-X adapter with the two DIN sockets.  The sockets have numbers on 
the sides of the adapter that show which is which.  The 19-W adapter only has one port.  

Kinetic 
During Kinetic readings, data is collected over time, with multiple readings made at regular intervals 
(measured in seconds). The values calculated based on raw Kinetic data are Vmax, Vmax per Sec, 
Time to Vmax, and Onset Time. Kinetic readings can be single- or multiple-wavelength readings (up 
to six, if using a SpectraMax instrument other than the Gemini or Gemini XS which have a maximum 
of four, or the FlexStation which also has four). 

Lag Time 
Lag time in a Kinetic assay is the period of very slow growth (microorganisms) or the rate of reaction 
that may precede the rapid/linear phase of reaction. When a lag time is specified in SoftMax Pro, data 
collected prior to the lag time is not included in data reduction. 

Large Display 
A display choice available with 384-well plates. This setting is useful when looking at large numbers 
if you are using a monitor that is 17-inches or larger. 

Linear (Curve Fit) 
The linear function fits the best straight line to the data. The equation for this fit has the form of: 

y = A + Bx 
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where A is the y-intercept of the line and B is the slope. A linear fit should be used whenever the 
values appear to lie on or scattered around a straight line. 

Log-Logit (Curve Fit) 
The Log-Logit is also called a two-parameter curve fit. The equation used to generate this curve fit is: 

y = ((A - D) / (1 + (X /C)B)) + D 

Luminescence 
The emission of light by processes that derive energy from essentially non-thermal changes, the 
motion of subatomic particles, or the excitation of an atomic system by radiation. 

Mask 
Lets you “hide” the data in selected wells of the Plate or cuvettes in a CuvetteSet display so that the 
data stored there will not be used for calculations and will not be reported. The Mask function is 
commonly used to suppress outliers. 

Maximize Button (Windows) 
The small box containing an up arrow at the right of the title bar. Mouse users can click the Maximize 
button to enlarge a window to its maximum size. Keyboard users can use the Maximize command on 
the Control menu. 

Maximum 
Reduction for a Spectrum scan that reports the maximum signal within the reduction parameters. 

MaxOD, MaxRFU, or MaxRLU 
The limit for the maximum value you wish to use for displaying and analyzing Kinetic or Spectrum 
data. Any values above these limits will not be shown and will be excluded from data reduction. 

Menu 
A list of items, most of which are commands. Menu item names appear in the menu bar at the top of 
the window. To choose an item in a menu, place the pointer on the menu heading and drag to the 
selection you desire and then release the mouse button. 

Menu Bar 
A list of items, most of which are commands. Menu item names appear in the menu bar (the 
horizontal bar that appears below the title bar at the top of the window). 

Minimize Button (Windows) 
The small box containing a down arrow at the right of the title bar. Mouse users can click the 
Minimize button to reduce a window to its icon. Keyboard users can use the Minimize command on 
the Control menu. A minimized application continues running and you can select the icon to make it 
the active application. 

Minimum 
Reduction for a Spectrum scan that reports the minimum signal within the reduction parameters. 

MinOD, MinRFU, or MinRLU 
The limit for the minimum value you wish to use for display and analysis of Kinetic or Spectrum scan 
data. Any values that are under this limit will not be shown and will be excluded from data 
reduction. The default is 0. To display negative Kinetics, the value should be set below 0 (zero). 
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Modem Port (Macintosh) 
A serial communication port on some Macintosh models that is marked with the icon of a telephone 

handset . 

Normal Display 
The default display for 384-well plates in the Plate section. 

NVRAM 
Non-Volatile Random Access Memory of the instrument. Information stored in the NVRAM is not 
lost when power to the instrument is turned off. 

Onset OD, Onset RFU, or Onset RLU 
The change in signal required to compute the onset time (for Kinetic readings). 

Onset Time 
The time it takes for a given increase in signal, called the onset OD (or RFU or RLU) to occur. 

Open/Close Triangle 
A small triangle located on the left-hand side of section and experiment tool bars. Used to open/close 
sections and experiments within a SoftMax Pro le.fi 

Optical Density, OD 
The amount of light passing through a sample to a detector relative to the total amount of light 
available. Optical Density includes absorbance of the sample plus light scatter from turbidity. 

Option Button (Radio Button) 
A small, round button that appears in a dialog box or window. Within a group of related option 
buttons, you can select only one. 

Parallel Port (Windows) 
A connection on a computer, usually LPT1, to plug in the cable for a parallel printer. Windows 
supports parallel ports LPT1 through LPT3. 

Paste 
A function that copies the contents of the clipboard and inserts this copied information at the current 
selection or cursor position. The paste function is enabled by pressing V on the Macintosh and 
[CTRL]+[V] in Windows. 

Path (Windows) 
Specifies the location of a file within the directory tree. For example, to specify the path of a file 
named ASSAY.BAT located in the SOFTMAX directory on drive C, you would type 
c:\softmax\assay.bat. 

PathCheck 
Instrument setup option within SoftMax Pro for the SpectraMax M2, M5, Plus, Plus384, 190, or 340PC 
that allows data collected in a Plate section to be normalized to a 1-cm pathlength. PathCheck is 
covered by U.S. Patent Number 5,959,738. 

Photomultiplier Tube (PMT) 
A vacuum tube that detects light especially from dim sources through the use of photoemission and 
successive instances of secondary emission to produce enough electrons to generate a useful current. 
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Pipette Tips (FlexStation only) 
The FlexStation instrument requires the use of pipette tips which are kept in a separate instrument 
drawer. Molecular Devices suggests that you load a complete set of pipette tips each time you make a 
run to ensure that sufficient tips are always available. Please see the instrument manual for the 
FlexStation regarding the types of tips that can be used and how they should be loaded. 

Plate Section 
The Plate section is used to display data, to specify how microplates will be read, and to define how 
the data received from the instrument should be reduced. The data display in this section is a matrix 
that corresponds to the well format of the microplate in use. 

Plate Type 
A choice in the Instrument Settings dialog that determines the type of microplate being read. The 
specification of the plate type depends on the well format and manufacturer of the microplate. 

Plate Type Editor 
Allows the customization of a microplate.  

Point-to-Point 
This curve-fitting option fits a linear equation to each pair of data points. 

Point (Using the Mouse) 
You point to an object on the screen by moving the mouse so that the pointer is positioned on that 
object. When the pointer is an arrow, the tip of the arrow must be on the object. 

Point Count/Number of Reads per Well 
The number of integrations performed on a single well in Fast Kinetic mode. 

Port 
A connection or socket on the computer. Ports are common used for connecting devices, such as 
printers or monitors, to your computer, and for sending information to and/or from your computer to 
such devices. 

Protocol File 
Contains the template(s), instrument settings, and reduction parameters. Protocol files are useful if 
you repeat a particular type of assay frequently. 

Quadratic (Curve Fit) 
A mathematical description of a parabola: 

y = A + Bx + Cx2 

RAM (Random Access Memory) 
The memory that can be used by applications to perform necessary tasks while the computer is on. 
When you turn the computer off, all information in RAM is lost. 

Ranged Data Display 
Raw or reduced data is assigned proportionally to integer values from 0 through 9 based on user-
defined limits. Values above the high limit are displayed as plus (+) and values below the low limit 
are displayed as minus (-). 
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Raw Data 
Signal reported from the instrument with no alteration. This will be reported as OD, RFU, or RLU, 
depending on the instrument type. 

Read Button or Command 
Starts the reading process and shows the Endpoint, Kinetic, Spectrum, Well Scan, or FLEX data in the 
data display of the Plate or CuvetteSet section. 

Read Interval 
The interval of time between the start of one reading and the start of the next reading during a 
Kinetic or FLEX run. 

Read Mode 
The method used to read the microplate or cuvette: Endpoint, Kinetic, Spectrum, Well Scan, or FLEX. 
Note that not all modes are available with all instruments. 

Read Type (Fluorescence Instruments Only) 
The type of reading performed in the instrument: choose fluorescence, time-resolved fluorescence, or 
luminescence. 

Reading 
Acquiring data from a plate or cuvette if often called reading. 

Readings per Well 
The number of times (programmable by the user) that readings are taken on a well in fluorescence 
and time-resolved fluorescence modes. This setting also determines the amount of time that data is 
collected in luminescence mode. 

Reduced Data 
Data reduction causes the raw signal values reported by the instrument to be calculated and 
displayed according to user-defined formula settings. 

Reduction Limits 
Sets limits on data to be included in reduction for Kinetic, Spectrum, Well Scan, or FLEX readings. 

Reference 
A reading of buffer or water taken in the cuvette that is used as I0 to calculate Absorbance or 
%Transmittance of sample read in the cuvette port. 

Relative Fluorescence Units 
Fluorescence is the light emitted by certain substances resulting from the absorption of incident 
radiation. The governing equation for fluorescence is  

Fluorescence = extinction coefficient * concentration * quantum yield * excitation intensity * pathlength * 
emission collection efficiency 

To measure fluorescence accurately, it is necessary to reduce light scatter.  

Relative Luminescence Units 
Luminescence is the emission of light by processes that derive energy from essentially non-thermal 
changes, the motion of subatomic particles, or the excitation of an atomic system by radiation. 
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Restore Box (Windows) 
The small box containing both an up and a down arrow at the right of the title bar. The Restore box 
appears only after you have enlarged a window to its maximum size. Mouse users can click the 
Restore box to return the window to its previous size. Keyboard users can use the Restore command 
on the Control menu. 

Rotated Display 
A display option for 384-well plates that shows the plate rotated 90 degrees. 

Scroll 
To move up, down, right, or left through text or graphics in order to see parts of the file or list that 
cannot fit on the screen. A scroll bar appears at the bottom and/or right edge of a window whose 
contents are not entirely visible. Each scroll bar contains a scroll box and two scroll arrows. A scroll 
box is a small box that shows the position of information currently in the window or list box relative 
to the contents of the entire window. A scroll arrow is an arrow on either end of a scroll bar that you 
can use to scroll through the contents of the window or list box. 

Semi-Log (Curve Fit) 
The semi-log function fits the best straight line to a set of data for log(X) plotted against Y. The 
resulting curve displayed will be a straight line with the X-axis drawn in logarithmic scale.  

Serial Port (PC/Windows) 
A connection on a computer, usually COM1, where you plug in the cable for a serial device such as a 
plate reader, a printer, or a modem. Serial, asynchronous, and RS232 interfaces are all the same type 
by which the computer sends single bits of information to the connected device, one after the other. 
Windows supports COM1 through COM10. Instruments require COM1 or COM2. 

Series 
The Series function allows you to work with groups of wells in the Template so that the standard 
value or dilution factor increases or decreases in specified steps. The name can be incremented as 
well. 

Slope 
A reduction option that determines the slope of the combined plot (i.e., the slope of the line using 
linear regression after the wavelength combination reduction). This reduction uses all timepoints 
visible in the reduction window. Slope is the same as Vmax Rate when Vmax Rate is set to the same 
number of points as the run (i.e., the default). Slope is not the same as Vmax Rate if you have 
modified the number of Vmax Points. 

Spectrum 
This read mode allows you collect absorbance or fluorescence data across a spectrum of wavelengths. 
This data is displayed as OD, RFU, or RLU versus wavelength. The default reduction displays the 
wavelength that corresponds to the maximum signal. 

Standard Curve 
A mathematically idealized representation of the relationship between the concentration of a 
standard calibrator (X-value) and the OD/RFU/RLU (Y-value). The standard curve may be set to a 
linear, semi-log, log-log, quadratic, 4-parameter logistic, log-logit (2-parameter logistic), exponential, 
cubic spline, or point-to-point curve fits. 
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Status Bar 
Shown above the SoftMax Pro window, the Status Bar contains the instrument icon, the current 
temperature within the microplate chamber of the instrument, and buttons allowing you to activate 
the Read function, the incubator, Automix, and to open or close the drawer(s) of the instrument (note: 
not all functions are available with all instruments). 

Stokes Shift 
The difference between the wavelengths of the excitation and emission peaks. 

Template Editor 
A representation of the microplate or a set of cuvettes shown as a grid of wells that can be used to 
designate the location of blanks, standards, controls, unknowns, empty wells, or to assign wells to 
other groups you create. The template is a map of the microplate. It tells the software what is in the 
various wells of the microplate or cuvette. 

Threshold Data Display 
Data is displayed as plus (+) for values above, asterisk (*) for values within, and minus (-) for values 
below user-defined limits. 

Time-Resolved Fluorescence 
Most fluorescence substances are not suitable for this type of reading. However, the fluorescence 
emitted by lanthanide dyes is delayed long enough to measure fluorescence after the lamp is turned 
off. Time-resolved fluorescence is used to reduce the amount of background noise which interferes 
with fluorescence. The excitation lamp flashes and, after it is off, the delayed emission is collected for 
a set period of time before the lamp flashes again. 

Time at Half Maximum 
Reduction for a Kinetic or FLEX run that reports the time at half the maximum signal within the 
reduction limits as follows: SoftMax Pro first determines the point (within the reduction limits) that 
has the maximum signal level. It then scans the plot from left to right until it finds two points that 
have signals bracketing one-half of that signal value. A linear interpolation between these two points 
is used to estimate the Time at Half Maximum. 

Time at Maximum 
Reduction for a Kinetic or FLEX run that reports the time at the maximum signal within the reduction 
limits. 

Time at Minimum 
Reduction for a Kinetic or FLEX run that reports the time at the minimum signal within the reduction 
limits. 

Time to Vmax 
The elapsed time until the maximum reaction rate of a Kinetic or FLEX reading is reached, reported 
in seconds. 

Title Bar 
The horizontal bar (at the top of a window) that contains the title of the window or dialog box. On 
many windows within the Windows environment, the title bar also contains the Control-menu box 
and Maximize and Minimize buttons. On the Macintosh, the title bar also contains the Close box and 
Zoom box. 
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Triturate (FlexStation only) 
To mix a solution by means of aspirate and dispense cycles. 

Undo 
Cancels the previous operation (if possible). The undo function is enabled by choosing Undo from the 
File menu, pressing Z on the Macintosh, or pressing [CTRL]+[Z] in Windows. 

USB (Universal Serial Bus) Port 
A serial communications port found on some Macintosh and PC computers. An adapter may be 
required to connect your computer to this port. 

User Name 
The User Name is the name of the person who reads data into the shielded file. The User name is 
entered after the [Read] button is pressed but before the reading begins. 

Vertical Display 
A display option for 384-well plates which shows the plate as two 8 x 12 arrays stacked vertically. 

Vmax 
The rate reported as signal/min (milli-OD, RFU, or RLU units per minute) for a Kinetic or FLEX 
reading. It is calculated using a linear curve fit, y = Ax + B. A creeping iteration is performed using 
Vmax Points and the slope of the steepest line segment is reported as Vmax Rate. It may also be 
reported as units per second (the default for fluorescence and luminescence). 

Vmax Points 
The number of points in the Kinetic or FLEX curve included in each of a series of regressions to 
calculate the maximum rate, Vmax, or the time segment used to calculate the Time to Vmax. 

Wavelength(s) 
Specifies the wavelength(s) that will be used to read the microplate. 

Well Graph 
One or more wells in a plate section having data shown in plots format may be expanded by selecting 
them and clicking the Graph button on the Plate Section Tool Bar. This selection is valid only with 
data shown in plots format. 

Well Scan 
Some applications involve the detection of whole cells in large-area tissue culture plates. Well Scan 
mode can be used with such microplates to allow maximum surface area detection in whole-cell 
assays. Since many cell lines tend to grow as clumps or in the corners of microplate wells, you can 
choose from several patterns and define the number of points to be scanned to work best with your 
particular application. 

Zoom Box (Macintosh) 
A small box containing a smaller box at the right of the title bar. You can click the Zoom box to return 
the window to its previous size. 
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